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Basics

The Basics section shows Episerver Campaign  features and upgrade options of software 
and services. 

 l Introduction. Introduction to this document and information about the security func-
tions.

 l Getting started. Learn more about Episerver Campaign and create a campaign.
 l Logging in. Work with the Episerver Campaign user interface, including logging in 

and out.

 o Menu bar
 o Start menu
 o Lists and folders

 l Users. Set up user accounts and permissions.

 o Permissions
 o Roles

 l Clients. Layout of the Episerver Campaign working environment.
 l Deliverability basics. Information and best practices for a successful deliverability of 

emails.
 l Exclusive IP addresses. Information on dedicated IP addresses.
 l ISO 27001 certification. Gives you the guarantee that Episerver's safety management 

for operation, service and development of email marketing platform complies with 
internationally recognized standards regarding data and information security.

 l Service description. Overview of standard functions and upgrade options.

Introduction

Online help describes the features and functionality of the Episerver Digital Experience 
platform and covers CMS for content management, Episerver Commerce for e-com-
merce functionality, Episerver Campaign for omnichannel campaigns, Episerver Search 
& Navigation (formerly Episerver Find) for extended search, Episerver Visitor Intelligence 
(formerly Episerver Insight) for visitor profiles and customer segments, Product and Email 

https://www.episerver.com/products/platform/all-episerver-products/
https://www.episerver.com/products/platform/all-episerver-products/
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Product Recommendations, and Triggered Messages for personalized product recom-
mendations, and Episerver add-ons. 

You access the online help from within the Episerver platform or from Episerver World. 
The online help is also available in PDF format for users who prefer PDF or want to print 
the documentation. 

This PDF describes the features and functionality of Episerver Campaign, which you can 
find on Episerver World. Developer guides and technical documentation also are found 
on Episerver World.

The user guide is intended for  editors, administrators, marketers and merchandisers, 
working with tasks as described in Roles and tasks. 

Features, licenses and releases
The user documentation is continuously updated and covers the latest releases for the 
Episerver platform.

Episerver CMS is the core part  of the Episerver platform providing 
advanced content creation and publishing features for all types of 
website content. CMS features are available in all Episerver install-

https://world.episerver.com/userguides
https://world.episerver.com/userguides
https://world.episerver.com/
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ations.

Episerver Commerce adds complete e-commerce capabilities to the 
core functionality in CMS. It requires a specific installation and license.

Episerver Campaign lets you orchestrate omnichannel campaigns 
from a single screen, and send triggered emails based on real-time 
behavior. Campaign requires additional license activation.

Episerver Search & Navigation adds advanced search functionality to 
websites. It is included in the Episerver Cloud services; for on-premises 
installations it requires a specific installation and license.

Episerver Visitor Intelligence is a user interface for viewing and filtering 
visitor profiles, and creating customer segments that can be used in 
omnichannel marketing campaigns. It requires a specific installation 
and license.

Product Recommendations lets you create and configure a mer-
chandising campaign with personalized product recommendations 
from the personalization portal. It requires a specific installation and 
license.

Email Product Recommendations lets you include personalized 
product recommendations in any email, including cart abandonment 
and retargeting emails, from the personalization portal. You can also 
work with behavioral triggers to detect on-site behaviors and act upon 
them through automated, personalized emails. It requires a specific 
installation and license.

Add-ons  extend the Episerver capabilities with features like advanced 
search, multi-variate testing, and social media integration. Some add-
ons are free, others require license activation. Add-ons by Episerver 
are described in the online help.

Note: Due to frequent feature releases, this user guide may 
describe functionality that is not yet available on your website. See 
What's new to find out in which area and release a specific feature 
became available.

Images and screenshots
The Episerver user guide uses images and screenshots to visually guide you through the 
features of the Episerver platform. Due to different versions, continuous updates, and 
specific system permissions, images and screenshots may differ from the actual appear-
ance.
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Notes
Three types of notes are color marked throughout the user guide: tips, notes and warn-
ings.

Tip: Green indicates tips that might show you an easier way to per-
form a task.

Note: Yellow indicates important information that may affect your 
work and should not be missed.

Warning: Red indicates warnings. If these warnings are ignored, ser-
ious errors or problems may occur.

Copyright notice
© Episerver 1996–2020. All rights reserved.

All information and content within this document is the sole copyright of Episerver. 
Changes to the contents, or partial copying of the contents, may not be done without 
permission. The document may be freely distributed in its entirety, digitally or in printed 
format, to all users of Episerver Software. Episerver assumes no liability or responsibility for 
any errors or omissions in the content of this document. Episerver reserves the right to 
alter functionality and technical system requirements. Episerver is a registered trade-
mark of Episerver AB. Ektron is a registered trademark of Episerver Inc.

What's new?
This user guide describes functionality available in the latest release of a standard imple-
mentation of the Episerver platform software and services. New features are con-
tinuously made available. See Episerver updates.

Note: Due to frequent feature releases, this user guide may 
describe functionality that is not yet available to you. Contact 
your system administrator for information about products and ver-
sions in your Episerver implementation.

https://www.episerver.com/
https://www.episerver.com/
https://world.episerver.com/Releases/
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This release of the Episerver User Guide describes features available in Episerver as of 
April 23, 2020. See release notes (below) for update history. See Archived doc-
umentation in the online version of the user guide for previously released user guides 
and for older release notes.

Release notes 2020

Released Area Features and updates

2020-04-23 Campaign

You can change the URL of the confirmation 
page the unsubscribe link points to. See Unsub-
scribers.

See Deliverability basics for information about 
email authentication and encryption.

2020-04-16 Commerce
Customer service representatives can process a 
return authorization and create a refund for a 
customer. (update 311)

2020-04-16 Campaign

In the Episerver Campaign start menu, the 
Episerver Reach menu item has been renamed 
to Personalization Portal. The Personalization 
Portal lets you access Episerver Product Recom-
mendations and Episerver Email Product Recom-
mendations. The Episerver Insight menu item has 
been renamed to Visitor Intelligence. Episerver 
Visitor Intelligence lets you view and filter website 
visitor profiles, and create customer segments. 
(update 312)

2020-03-20 Add-ons

The ExactTarget Marketing Automation con-
nector is now Salesforce Marketing Cloud 
(ExactTarget) and the Silverpop Marketing Auto-
mation connector is now Watson Marketing (Sil-
verpop).

2020-03-20 Campaign

The new Opt-in processes feature lets you create 
and manage opt-in processes and its opt-in 
emails (registration confirmations). (update 308)

You can use the Block node in transactional 
mails to exclude recipients who are on a cus-
tom blacklist. (update 308)

https://world.episerver.com/releases/episerver---update-311/
https://world.episerver.com/releases/episerver---update-312/
https://world.episerver.com/releases/episerver---update-308/
https://world.episerver.com/releases/episerver---update-308/
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Released Area Features and updates

2020-03-20 Add-ons Marketing Automation has a new Delivra con-
nector. (update 306)                     

2020-03-20 Commerce
The scheduled job Collect orders per promotion 
statistics reworks the collection of order statistics 
to improve performance. (update 305) 

2020-03-20 Search & Navigation

The product Episerver Find has been renamed to 
Episerver Search & Navigation throughout this 
user guide. Note that the old product name 'Find' 
can still occur in the user interface.

2020-03-20 Campaign
In the Advanced node of the Marketing Auto-
mation, you can filter recipients by Insight seg-
ments. (update 306)

2020-03-20 Commerce You can now process an order return. See Order 
returns. (update 305)

2020-03-20 Personalization

Email Product Recommendations: You can add 
an email product description that has a trans-
parent background. When you use a top-up or 
fallback, a preview appears. (update 306)                         

Product Recommendations: In generated 
HTML, you can define the default image size 
that is sent for empty images that have no 
products. (update 306)

Triggered Messages: You can fire triggers 
based on locale so you can send emails to cus-
tomers in the correct language. When  you use 
the AddToGroup or RemoveFromGroup 
ESP actions, there is no limit to the number of 
triggers fired by Contact frequency. You can set 
a limit for campaigns using the SendMessage 
ESP action. (update 306)

2020-02-20 Episerver platform

A new section, User scenarios, has been added 
to the user guide describing common cross-plat-
form user scenarios, such as working with 
products, optimizing search results, or using visitor 
groups for personalization.

https://world.episerver.com/releases/episerver---update-306/
https://world.episerver.com/releases/episerver---update-305/
https://world.episerver.com/releases/episerver---update-306/
https://world.episerver.com/releases/episerver---update-305/
https://world.episerver.com/releases/episerver---update-306/
https://world.episerver.com/releases/episerver---update-306/
https://world.episerver.com/releases/episerver---update-306/
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Released Area Features and updates

2020-02-20 Campaign

When configuring a Mobile Push message in 
Smart Campaigns, you can now upload an 
image or specify an external image URL. (update 
304)

2020-02-20 Campaign
In the Advanced node of the Marketing Auto-
mation you can limit the number of recipients to 
whom the mailing is to be sent. (update 302)

2020-02-20 Commerce On the Order Management screen, you can now 
view returns. (update 299)

2020-02-20 Personalization You can now prioritize Triggered Messages cam-
paigns.

2020-01-20 Campaign

The new feature SMS processes lets you create 
and manage SMS processes such as unsub-
scribing from marketing SMS by sending the 
keyword Stop or requesting help by sending the 
keyword Help.  (update 304)

2020-01-20 Search & Navigation

A new topic, Using Personalized Search 
& Navigation, provides information about the Per-
sonalized Search & Navigation product: its bene-
fits, how it works, and how to enable it.

2020-01-20 Campaign

Several updates to the Microsoft Dynamics CRM 
integration: You can assign Episerver Campaign 
test lists to check the mailing content before dis-
patch. The process of preparing the campaign 
activity for dispatch has been revised. (update 
298)                      

Several updates to the Magento 2 
integration: Screenshots and names have 
been adjusted to the new version 1.3.5. 
(update 298)

In the API overview, you can find information 
about the Episerver Campaign REST API. 
(update 298)

https://world.episerver.com/releases/episerver---update-304/
https://world.episerver.com/releases/episerver---update-304/
https://world.episerver.com/releases/episerver---update-302/
https://world.episerver.com/releases/episerver---update-299/
https://world.episerver.com/releases/episerver---update-304/
https://world.episerver.com/releases/episerver---update-298/
https://world.episerver.com/releases/episerver---update-298/
https://world.episerver.com/releases/episerver---update-298/
https://world.episerver.com/releases/episerver---update-298/
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Archived documentation
If your Episerver implementation is not on the latest version, you can access previous ver-
sions of the Episerver User Guide under Archived documentation in the online version of 
the user guide.

Getting started

This topic introduces Episerver Campaign and explains how to get started with simple 
campaigns and mailings, to get a basic understanding of campaign management. The 
information is intended for users that are new to marketing and Episerver Campaign.

What is a campaign?
In Episerver Campaign, a campaign is the structure, relations, and process flow of ele-
ments like recipients, email message, and actions like wait or limit. With Smart Cam-
paigns, you can easily create and visualize one-shot-campaigns using drag-and-drop 
functionality.
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Setting up Episerver Campaign
Episerver Campaign is a service set up by Episerver. The onboarding setup involves con-
figuring one or more clients, adapted recipient lists, and a feature set depending on 
your service contract. Furthermore, your marketeers will get user accounts, including per-
sonalized permission setups.

To send emails via Episerver Campaign using the sender domain of your hosted website 
or online shop, see Setting up your domain for Episerver Campaign on Episerver World.

When the setup is done, you can log in to Episerver Campaign and start creating cam-
paigns.

Campaign preparations
Usually a campaign is preceded by significant preparations. You need to plan the mes-
sage, the target groups, the channels to use, and revenue goals if any. Use the Smart 
Campaign feature to visualize the different steps in your campaign. Creating landing 
pages in Episerver CMS may also be part of the preparations, as well as preparing asso-
ciated products, if you have Episerver Commerce.

If you use other analytic tools for monitoring campaign performance, KPIs (key per-
formance indicators) for these may need to be configured for the specific campaign.

You can tailor campaign messages for selected target groups, to create a more enga-
ging experience and increase conversion. Use visitor groups in Episerver CMS, to per-
sonalize campaign content. With Triggered Messages, you can also configure mailings 
to trigger on certain recipient actions.

Campaign basics
Smart Campaigns is a powerful tool for visualizing the campaign flow, and orchestrating 
messages, channels and actions. A message can be distributed using multiple chan-
nels. Email is the most common, but you can also use, for example, SMS and push mes-
sages.

These are the fundamentals of a mailing:

 l Recipients.  The target group for the campaign message mailing.
 l Email. The content message with conversion links leading to desired actions.
 l Campaign. The elements and actions required to distribute the message.
 l Analytics. The tools to monitor and follow-up on campaign performance.

https://world.episerver.com/documentation/developer-guides/campaign/setting-up-a-domain/
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When working with mailings, it is important to consider best practices regarding deliv-
erability, to ensure high delivery and opening rates for your campaigns.

Campaign process flow
Below is an example procedure when preparing and launching a campaign with 
Episerver Campaign.

 1. Recipient data. Define your message audience from recipient lists. These are pre-
configured during the setup process, and usually get their data by imports or form 
collections. Ensure your recipients have given a consent for receiving mailings with 
advertising content.

 2. Email message. Create the email design and content. Use a copy of an existing mail-
ing, the Template Kit delivered with Episerver Campaign or your own layout.

 3. Create the campaign using the Smart Campaigns flow visualization. You can update 
the campaign as needed, when working with the associated elements.

 4. Test mailing. Test and validate email design and content, send out mailing to selec-
ted test recipients.

 5. Start campaign. Activate and send the campaign to launch a full sendout on time, 
monitor statistics, bounces and replies.

 6. Analyze result. Evaluate campaign KPIs, visualize click-tracking, and generate 
reports.

 7. Post-launch work. clean-up recipient lists, manage blacklists, and responses.

Many campaign elements can be reused in future campaigns, thereby reducing the 
amount of preparation work, and speeding up the creation process.

Creating a simple campaign
In this scenario we assume that we have a website with Episerver CMS and Episerver 
Commerce, and want to make customers aware of our upcoming "Fall Fashion" sales. 
We have prepared a set of content, products in Commerce and a landing page in 
CMS. These associated content items have been scheduled to be published just before 
the email, with links to the landing page, is sent out.

We will create a simple mailing campaign with a recipient list, and an email message. 
We will test the mailing and launch it, and then follow-up on the result.

 1. Create the campaign structure.

 a. Open the start menu and select Campaigns > Smart Campaigns. In the next win-
dow, click Create and select Empty draft. Confirm by clicking Apply.
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 b. Drag and drop the Recipients node into the campaign area, and select a recip-
ient list.

 c. The campaign can be of different types depending on channels. To add an email 
message, drag and drop an Email node into the campaign area, and give it an 
intuitive name.

 d. Connect both nodes and click Save. Give the campaign an appropriate name 
and click Save in the validation dialog box. This will display missing details, if any. 
As long as the validation finds missing details, the campaign will be stored in 
Incomplete state.
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 2. Adapt the email message.

 a. In the campaign area, select edit for the Email node, and click Edit content. 
Select a template in the displayed list, to use for the mailing, and click Next.

 b. To modify the sender and subject, click Sender, subject, attachments to the upper 
left, update the information in the section to the right, and click Apply.

 c. To adapt content (text, images and links), click on a paragraph's name and 
update it in the right area, then click Apply.

 d. To add images via a Text/Image paragraph, select the tab Image and upload 
the file. You can also add assigned links. Links in the message will automatically 
be included in the default tracking, to follow-up on clicks and page openings 
when the campaign has been launched.
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 e. You can preview the output using different options in the top menu, for example 
Mobile or Online version.

 3. Test the email message prior to launch.

 a. The mailing can be tested using predefined test users. Click Test message, select 
a test group, or individual recipients, and click Send email.
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 b. You can also send HTML-only or text versions. Test messages can also be sent from 
the message node in the campaign area, or from the Smart Campaigns overview.

 4. Launch the campaign.

When all message items are correctly configured, and you are comfortable with the 
incoming test emails, you can launch the campaign. Campaigns must be activated 
before they can be started. Campaigns with a specified sending time are sent auto-
matically once activated.

 a. Save the campaign, and go to Campaigns > Smart Campaigns.
 b. Select the campaign in the list and click Activate. The campaign and all asso-

ciated elements will receive the status Activated.
 c. To start the campaign, click Start, and Start campaign to confirm. The sending of 

the mailing to the associated recipient list starts, and the campaign status 
changes to Sending. When completed, the status changes to Sent.

 5. Analyze the results (example reports)

After sending, you can begin monitoring the campaign to see how many emails 
were opened, number of clicks on links, and bounce rates. You can create reports, 
and visualize links clicked in the email message.

 a. Go to Smart Campaigns in the Campaign overview, select the campaign, and 
click Analysis to see a result summary including rates for bounces, clicks and 
opened emails.
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 b. With Deep Analytics you can generate reports with your KPIs. Reports can be cre-
ated manually or automatically. You can use existing report templates, or create 
your own.

 c. You can visualize clicked links as heat maps in the message. The image can be 
saved, for inclusion in reports. Select Visual link analysis under Analytics to access 
this feature.
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More features
There are many more features in Episerver Campaign that you can work with to further 
extend, automate, and optimize your campaigns. Below are a few examples.

 l A/B test. Optimize your message by sending variants of an email, and comparing key 
figures to determine which one works the best.

 l Send time optimization. Customize the sending time of your mailing, automated for 
each individual recipient, to increase the chances of the email being opened.

 l Template Kit. Use your corporate design styles and turn these directly into mailings, 
without any special knowledge of graphic design or composition.

 l Marketing Automation. Create multi-step campaigns with action and event-based 
mailings by using the drag and drop graphical interface.

 l Target groups. Define the recipients of your campaigns by specific rules and con-
ditions, and personalize the mailing content.

 l Click profiles. Define recipient groups based on click behavior in previous mailings.
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 l Recipient history. Analyze the entire timeline of individual recipients, to see which 
messages you have sent to whom, and in which format.

Log in and out

Activating the user account

Note: Before your first login, activate your account by referencing 
two emails from Episerver: an activation email containing your per-
sonal activation key and a second confirmation email.

 1. Open the activation email and click Activate user account.
 2. Enter the activation key provided in the second email, then click Continue.
 3. Complete the fields and click Continue.
 4. Create a password and a PIN and click Save.

After you complete the entries, you receive another email asking you to confirm 
your activation.

 5. In that email, click Confirm activation. 

You can now log into Episerver Campaign at http://www.campaign.episerver.net/.

Login
Use the login screen to verify your identity and prevent malware intrusion.

 1. Go to www.campaign.episerver.net.
 2. Enter your user name and password.
 3. Into the row labeled PIN, enter digits of your PIN in the open positions by clicking 

numbers on the onscreen keyboard.

Note: The virtual keyboard's numbers are in random order.

For example, if your PIN is 123456 and the login screen appears as below, enter 1 into 
the first position (from the left) and 3 into the third position. Notice that positions 2 
and 4-6 are filled with black dots, indicating you do not need to enter those char-
acters.

http://www.campaign.episerver.net/
http://www.campaign.episerver.net/
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 4. Click Log in.

If your browser or the network from which you are accessing Episerver Campaign does 
not support SSL, contact customer support.

If you forget your user name, password or PIN, contact the person at your company from 
whom you received your login data or Episerver customer support.

Logout
End each session by clicking Logout to prevent third parties from accessing the system.

Menu bar

The menu bar lets you navigate Episerver Campaign.
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 l Menu. Click Menu to open the Start menu.
 l Window chooser.

 o A stack icon displays the number of open windows.
 o A drop-down list lets you choose among open windows.

Note: Do not use the forward and back buttons in your 
browser because  any unsaved work may be lost; use the win-
dow chooser to navigate among windows.

 l Help. To access context-sensitive help in the Episerver User Guide, click .
 l Change client. A drop-down list lets you switch among clients set for your account.

 l Profile area. Click the red circle with your initial to manage user settings, such as the 
following:
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 o Click Login notifications to enable or disable login notifications, which inform you 
about login attempts.

 o Click Change password to change it. An email confirmation is sent to you.
 o Click Change PIN to change it.  An email confirmation is sent to you.
 o Click the displayed language to change it to German (Deutsch), English, Dutch 

(Nederlands), Polish (Polski) or French (Français).

Warning: Save your work before changing the language. 
Unsaved changes are lost if you change the language of 
Episerver Campaign.

 o Click Change next to the time zone to change it. Select a time zone from the 
drop-down list.     

Note: System time
If the time zone support is not activated in your client, the 
profile area shows the system time of the Episerver data cen-
ter. This corresponds to central European time (CET), which 
may be different from time at your location.
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For example, if you are in London (one hour behind CET) 
and set a dispatch time of 17:00, then Episerver Campaign 
sends the message at 18:00 your time. On the other hand, if 
you are in Istanbul (one hour ahead of CET) and set a dis-
patch time of 17:00, Episerver Campaign sends your mes-
sage at 16:00  your time.
Also, daylight savings time may vary by an additional hour 
compared to your time zone.
Dates are entered in the format YYYY-MM-DD and cor-
respond to the ISO 8601 international standard. Example: 
15th May 2017 is displayed as 2017-05-15.

Warning: Save your work before logging out. Unsaved 
changes are lost when you confirm the logout.

 o Click Logout to end your session.

Start menu

The start menu groups related areas as an overview. To return to the start menu at any 
time, click Menu.

Note: Start menu features are based on your user account, the 
package, and your permissions.

 l Campaigns. Tools for creating campaigns, Smart Campaigns, Marketing Auto-
mation, and so on. 

 l Recipients. Manage your recipients and target groups.
 l Responses. Manage and act upon direct replies from your recipients, auto-respon-

ders, and bounces.
 l Blacklist. Manage recipients who no longer want to receive messages.
 l Analytics. Access reporting tools.
 l Administration. Manage user roles and permissions, your APIs, and field functions.
 l Special. Access online help, and special features such as e-commerce integrations 

and the coupon system.
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Current mailings
The Current mailings area provides quick access to the last four campaigns. Select any 
campaign and click Edit.

Below quick access to your recent campaigns, you find information about your last four 
mailings.

The following information is provided for each campaign:

 l Number of recipients (49)
 l Bounce rate (0.00%)
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 l Unsubscribe rate (0.00%)
 l Opening rate (80.80%)
 l Click rate (83.67%)

Lists and folders

In many areas of Episerver Campaign, information is displayed in lists and organized in 
folders, such as mailings from Campaigns > Smart Campaigns.

Note: You need permission to display all records of a recipient list, 
response list or blacklist list; otherwise, only the first 60 records 
appear.

All lists in Episerver Campaign work in the same way. A status bar at the bottom shows 
the number of elements on the page, the number of selected elements, and your cur-
rent list position (for example, Page 2 of 10). 

By default, each page displays up to 20 elements, although this is adjustable. If a list has 
more than 20 elements, display other pages by clicking Next  and Previous   in the 
status bar.

Customizing the list view
 l Change column width. Drag the separator between columns to change column 

width.
 l Show and hide columns. Click the down arrow  in the upper right corner to determ-

ine which columns appear.
 l Arrange columns. Click a column header and drag the column  to the desired pos-

ition.
 l Sort elements. Click a column header to change its sorting from ascending to des-

cending order. Text fields are sorted alphabetically; numeric fields by value, date 
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fields by date.

Tip:  If multiple selection is possible in a list and at least one ele-

ment is selected, you can use the Sort by selection   button 
to sort the selected elements to the top of the list .

Exporting records
To export records from a list to a CSV file, click Download  in the status bar and select 
the destination folder.

Note: To export recipients, responses, or blacklists, you need appro-
priate permission.

Opening CSV files with Microsoft Excel

Note: Episerver Campaign creates CSV files in UTF-8 without BOM. 
Microsoft Excel incorrectly interprets the format as ISO-88591.

To correctly open a CSV file in Excel, follow these steps.

 1. Open a blank Excel spreadsheet.
 2. Click the Data tab.
 3. Select Get Data > From File > From Text/CSV. 
 4. Select the file downloaded in Export records and click Import.
 5. Set the File Origin to Unicode (UTF-8) and select Semicolon as Delimiter. 
 6. Click Load.

Updating lists
If several people are making changes to Episerver Campaign, you can update any list 
by clicking the Refresh button on the status bar.

Modifying elements
If you select an element, it is highlighted, indicating that you can edit or delete it.
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 l Select multiple elements. You can select multiple list elements if  a check box 
appears next to each item and in the header.

 l Add element. Many lists have a button to add elements, for example Create recipient. 
Click this button to create a new row. Click a field to enter data. Click Submit when 
finished. Each new data record is automatically sorted into its correct position.

 l Edit element. Click edit element to modify it. Click  Submit to save changes. You can 
also double click a row to edit it.

 l Delete element. Click delete element to do that. 

Printing lists
To print a list, click the printer icon in the status bar. 

Note: To print recipients, responses, or blacklists, you need appro-
priate permission.

Using folders
In some parts of Episerver Campaign, such as Smart Campaigns  and target groups, a tree 
hierarchy appears to the left of a main list. The additional hierarchy lets you organize 
elements  into folders.

Drag or double click the separator bar between the two screen areas to show or hide 
the folders. If you hide them, the main list occupies the width of the screen.

Initially, the folder area contains only the All folder,  a meta- folder showing existing ele-
ments. You cannot delete the All folder.

Each folder displays the number of elements in it; the number does not include sub-
folder elements.
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 l Create new folder. Click Add   , enter a folder name, and click Submit .
 l Delete folder. Select the folder and click Delete  .
 l Rename folder. Select the folder and click Rename  .
 l Move folder. Select a folder and drag it to the folder to which you want to move it.
 l Move one or more list elements to a folder. Select an element, click Move selection    

and click the folder to which you want to move it.

Users

The user administration tool lets you set up and manage user accounts, and can grant 
user permissions. User permissions apply to clients and or sub-clients. You can grant to 
the same user different permissions for different sub-clients (if sub-clients are being 
used).

Managing users by clients
To manage users by clients, open the start menu and select Administration > Users. The 
Manage users window appears.

Creating a user
 1. In the Client drop-down list, select the client you want to create a user for.
 2. Click Create user. The Manage permissions window appears.
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 3. Enter the user's email address (which serves as the user name), language, gender, 
first name, last name, and telephone number.

 4. Optional: To send an activation email to the user (or to reset a user's password and 
PIN), select Send activation email.

Note: To enable this feature, contact customer support.
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 5. Click Manage permissions.

 6. In the Assign roles area, you can assign one or more roles to the user.

 a. In the Available roles list, on the left side of the screen, click the roles you want to 
assign to the user and then click >.

The following roles are available:
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Role Properties

Administrator Has all available permissions (except for additional functions) and 
can create additional users.

Editor Standard user including permission to manage recipient lists and 
recipient history.

Author Editor without sending rights.

Assistant 
Author Editor without sending, export and import rights.

Report Analyst Can create and output reports with Deep Analytics. Has no other 
permissions.

Interface Pro-
grammer Has access to all relevant areas for working with Episerver's APIs.

Note: You can only see and assign roles if you have all per-
missions for this role. You can create your own roles under 
Administration > Roles. You cannot assign or revoke roles that 
contain permissions that you do not have yourself.

 b. In the Assigned roles list, select the role that you just assigned and, in the Valid 
from and Valid to boxes, specify the period during which the role is effective. If 
the role is to be assigned for an indefinite period, check the Non-expiring box.

 7. In the Assign permissions area, click the permissions you want to grant to the user.

 l You can grant ( ), revoke ( ), or inherit ( , ) permissions that you possess.
 l You cannot grant or revoke permissions that you do not possess. Such restricted 

permissions are marked with the ( ) icon.
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Tip: Use inheritance to expedite the process by granting or 
revoking permissions at a higher level; by default, subordinate 
permissions inherit this status.
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 8. Click Confirm. A summary appears.
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 9. Click Finish.

An overview of the assigned user permissions appears.

 10. The new user must activate the user account with a personal activation key. To get 
the activation key contact customer support.
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Editing users
 1. Open the Manage users window.
 2. In the Client drop-down list, select the client whose user you want to edit.
 3. Select one or more users and click Manage permissions.

Note: You can only assign roles when editing multiple users. You 
cannot grant or revoke individual permissions.

 4. In the Assign roles area, you can assign one or more roles to the user.

 a. In the Available roles list, on the left side of the screen, click the roles you want to 
assign to the user and then click >.

 b. In the Assigned roles list, select the role that you just assigned and, in the Valid 
from and Valid to boxes, specify the period during which the role is effective. If 
the role is to be assigned for an indefinite period, check the Non-expiring box.

 5. In the Assign permissions area, click the permissions you want to grant to the user.

 l You can grant ( ), revoke ( ), or inherit ( , ) permissions that you possess.
 l You cannot grant or revoke permissions that you do not possess. Such restricted 

permissions are marked with the ( ) icon.
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Tip: Use inheritance to expedite the process by granting or 
revoking permissions at a higher level; by default, subordinate 
permissions inherit this status.
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 6. Click Confirm.
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 7. Click Finish.

Managing clients for users
To manage clients for users, open the start menu and select Administration > Users. The 
Manage users window appears.
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To display the clients for which a specific user is authorized, open the Clients for users tab 
and click the appropriate user in the Users list.

Tip: To assign a new client to a user, click Assign new client. The Man-
age permissions window opens.

To edit an existing client, select one or more client check boxes  that you want to assign 
to the user.

Tip: You can only assign roles when editing multiple clients. You 
cannot grant or revoke individual permissions.

 1. Click Manage permissions.
 2. In the Assign roles area, you can assign one or more roles to the user.    

 a. In the Available roles list, on the left side of the screen, click the role you want to 
assign to the user and then click >.

Note: You cannot assign or revoke roles that contain per-
missions you do not possess yourself.

 b. In the Assigned roles list, select the role that you just assigned and, in the Valid 
from and Valid to boxes, specify the period during which the role is effective. If 
the role is to be assigned for an indefinite period, check the Non-expiring box. 
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 3. In the Assign permissions area, click the permissions you want to grant to the user.

 l You can grant ( ), revoke ( ), or inherit ( , ) permissions that you possess.
 l You cannot grant or revoke permissions that you do not possess. Such restricted 

permissions are marked with the ( ) icon.

Tip: Use inheritance to expedite the process by granting or 
revoking permissions at a higher level; by default, subordinate 
permissions inherit this status.

 4. Click Confirm. A summary appears.
 5. Click Finish. A summary appears.

Revoking user permissions for a client
 1. In the Client drop-down list, select the client you want to revoke the user permissions 

for.
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Note: Check whether the user is an API user. If you revoke  per-
missions for a client from an API user, your API connection no 
longer has access to the client. To display all API users, select All 
users with API access in the selected client in the Filter user drop-
down list.
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 2. In the Filter user drop-down list, select All users with at least one permission in the selec-
ted client.
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 3. In the User list, select a user and click Revoke permissions.

Note: You can revoke permissions for a user, but you cannot delete 
a user. To delete a user, contact customer support.

Permissions

You can customize permissions for individual modules, functions, and activities. The fol-
lowing list includes the most important individual permissions:

 l Create mailings
 l Edit mailings
 l Dispatch mailings
 l Import recipients
 l Clear recipient lists during import
 l Export active recipients
 l Export responses
 l Export unsubscribers
 l Export blacklist

Customer support can inform you about and set up further permissions.

If you require additional permissions for your work with Episerver Campaign, or if you 
need permissions for additional clients or sub-clients, contact an administrator or cus-
tomer support.
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To change the permissions of other users, see Managing users by client and Managing cli-
ents for users.

See Managing permissions in the Episerver User Guide for more information about how 
to manage access rights for other parts of the Episerver platform.

Roles

A role is a permission profile you can assign to individual users. A role may contain the 
same permissions as an individual user. Permissions cannot be inherited, as in user man-
agement.

In your client, you can define roles for specific tasks or projects to simplify the process of 
managing individual users. After defining a role, you can assign it to a user permanently 
or for a specified period of time, for example, for holiday replacements or temporary 
users.

Note: Permissions in roles do not apply if

 l A permission is explicitly revoked from the user.
 l A main permission is explicitly revoked from the user, and this is inherited 

to the sub-permissions.
 l A main permission, that is inherited to the current client, is explicitly 

revoked from the user in a main client.

To manage roles, open the start menu and select Administration > Roles.
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Creating a role

Tip: If you create roles in a client with sub-clients, these roles auto-
matically apply to the sub-clients.
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 1. Click Create.

 2. In the Role name box, enter a name for the role.
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 3. In the Permissions area, click the permission you want to assign to this role.

Tip: You can only assign permissions, not revoke them. In other 
words, roles contain only positive permissions.

 4. Click Create.

Editing a role

Note: If you change a role that is assigned to one or more users, the 
change immediately affects those users.
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 1. In the list, click the role you want to edit.
 2. Click Edit.

 3. In the Permissions area, click the permission you want to assign to this role.

Tip: You can only assign permissions, not revoke them. In other 
words, roles contain only positive permissions.
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 4. Click Save. 

Deleting a role

Note: You can delete a role only if no users are assigned to it. To see 
how a role is being used, click Show usages.
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 1. In the list, click the role you want to delete.
 2. Click Delete. A confirmation window opens.

 3. Click OK.

Showing usages
 1. In the list, click the role you want to view.
 2. Click Show usages. The Role usage window opens, displaying a list of users who are 
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assigned this role.

Tip: You can also use this window to edit a user's permissions. To do 
so, click the user and then Edit user permissions. Next, follow the 
steps described in Users.

Clients

A client is the working environment of Episerver Campaign; a stand-alone and closed 
system that organizes your mailings. You can use one or more clients.
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Client hierarchy
When using multiple clients, you can assign each to a different tier or organize them 
hierarchically.

Coordinated clients
If you set up multiple clients on a single tier, you should create a main client for rights 
management purposes. This setup lets you centrally control user access rights to clients.

Subordinated clients
You can organize clients hierarchically. Each client inherits access rights and any black-
list from its parent clients. 
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Single versus multiple clients
Each user has client-wide permissions, which enable the user to view and edit the cli-
ent's mailings and recipient lists. 

If you publish several newsletters and different editors work on them, create different cli-
ents so that editors can only change content for which they are responsible.

The following tables list the advantages and disadvantages of working with single versus 
multiple clients.

User

Theme Single client Multiple clients

User
If you manage several brands in a single client, a 
user working on one brand can access mailings 
for other brands within the client.

If you manage each brand in a dif-
ferent client, users working on a 
brand only see its mailings.
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Theme Single client Multiple clients

User 
rights

Apply to entire client. Depending on the scenario, 
you can allow or prevent access to recipient lists 
or mailings.

Inherited by sub-clients. To define 
user rights separately for each user, 
contact customer support.

Recipients

Theme Single client Multiple clients

Recipient lists
You can send different newsletters using different 
recipient lists. For example, a recipient list can rep-
resent a brand, country, or business unit.

The possibilities increase 
accordingly with multiple cli-
ents.

Blacklists Blacklist entries apply to an entire client. This func-
tionality cannot be changed.

Blacklist entries are inher-
ited by, and apply to, sub-cli-
ents. This functionality 
cannot be changed.

Subscription 
cancellations

Subscription cancellations apply to the entire cli-
ent. To adjust this functionality so that cancellations 
only apply to the recipient lists concerned, contact 
customer support.

Cancellations generally 
apply to individual clients.

Bounces
Recipients that exceed the bounce limit are 
removed from future sending attempts for the 
entire client. This functionality cannot be changed.

Also applies if multiple cli-
ents are in use.

Domain

Theme Single client Multiple clients

Sending 
domain

You can use only one sending domain in a client by default (for 
example, @example.de). To modify this functionality to use 
many sending domains  (with a tracking domain), contact cus-
tomer support.

Each client can use 
its own domain with 
a respective track-
ing domain.

Tracking 
domain

In principle, you can only use one tracking domain per client. 
This functionality cannot be changed.

You can use an addi-
tional tracking 
domain for each 
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Theme Single client Multiple clients

additional client.

Mailing

Theme Single client Multiple clients

Field 
functions

Field functions can 
be used by default.

Field functions can be inherited by sub-clients by default. To 
adapt each field function separately, contact customer sup-
port.

Deep 
Analytics

You can create 
reports from within a 
client.

You can create reports from within a master client for sub-cli-
ents.

Client setup
The client setup includes the following tasks and topics:

 l Recipient lists
 l Users
 l Templates
 l Field functions
 l Report templates
 l Bounce handling
 l Dispatch domain
 l Opt-in processes
 l Unsubscribe link
 l Web forms
 l API (application programming interface) access
 l Post-click tracking
 l ...customizations and add-ons

For each new client, Episerver runs a mandatory, random check of recipient records. 
The dispatch is only enabled after this check, but you can use other client functions 
before the check is finished.
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Setting up sub-clients and additional clients
If you have a Episerver Campaign client and want to set up another client (or sub-cli-
ent), contact customer support to discuss which settings can be inherited or copied from 
the existing client to speed up the process.

Deliverability basics

This section provides basic information and best practices for a successful deliverability. 

Email can be personalized, automated, tested, measured and more. Email marketing is 
still one of the most effective options to marketers, especially when they tap into the 
best practices for enhancing deliverability.

Delivery vs. deliverability
Email delivery refers to the successful delivery of an email to the receiving server.

Email deliverability refers to the ability to deliver email to the intended recipient’s inbox.

It’s possible to have good delivery but poor inbox placement, because the email lands 
in the spam folder rather than the inbox.

Key figures of deliverability
An email is bounced when the receiving server, mostly the ISP (internet service 
provider), rejects it. Based on the error message the receiving server sends back, the 
rejection can either be a soft bounce, which is a temporary error, such as mailbox full, 
spam related, or time out; or a hard bounce, which is a permanent error, such as the 
email address is no longer valid.

Episerver Campaign has an overall delivery rate of 99.8%. Without knowing what per-
centage of emails arrives in the inbox and what percentage in the spam folder, 
Episerver can make inferences by analyzing key metrics for the emails.

The following measures give marketers insight about the reaction and engagement of 
their audience.
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 l Bounce rate

     Bounces
 =    -------------------------  x 100%
        Number of sent emails 

Tip: Depending on the business model, it is recommend to 
keep the bounce rate under 3%.

 l Open rate

    Number of opened emails
 =    -------------------------------  x 100%
  Number of delivered emails 

 l Unsubscribe rate

     Number of unsubscribes
 =    -------------------------------  x 100%
  Number of delivered emails

Tip: Generally, an unsubscribe rate below 0.5% is good for an 
email campaign.

 l Click-trough rate

    Number of click-throughs
 =    -------------------------------  x 100%
  Number of delivered emails

An email click-through is defined as the number of recipients who click links in an 
email and land on the sender's website, blog, or other desired destination.

 l Spam complaints: Reports made by email recipients against emails they don't want 
in their inbox.

 l Spam trap hits

 o Recycled spam traps are email addresses that were used by a person and then 
abandoned. Typically, if an email address has been dormant for the last year, 
many ISPs convert it into a spam trap.

Sending to recycled spam traps shows that you have poor list hygiene, or you 
are not removing unengaged users.

 o Pristine spam traps are set up by ISPs and anti-spam organizations in order to 
catch spammers. No one should be sending email to those addresses.
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Marketing opt-in
There is a big difference between having a list of email addresses and having permission 
to email to that list. There are three types of permissions:

 1. Single Opt-in (SOI): the interested party leaves his email address in a form, which is 
considered explicit consent to receive email newsletters regularly.

 2. Confirmed Opt-in (COI): after a single opt-in, an email is sent to subscriber’s email 
address as confirmation of the registration.

 3. Double Opt-in (DOI): after single opt-in, an email with a confirmation link is sent. To 
complete the subscription process, the subscriber must verify the registration by 
clicking the link.

Sending email to non-permission-based lists results in high bounce rates, low open rates, 
high unsubscribe rates, high spam complaints and high spam trap hits, all of which indic-
ate an unsuccessful email.

For more information on the opt-in method, see Opt-in.

Sender reputation
Having the ideal ratio of text to images, considering the placement of the content ele-
ments, using an eye-catching font, personalizing the content for the target audience, 
and selecting the optimum sending frequency are all key factors in a successful email. 
However, all that effort is wasted if the intended audience never opens the email 
because it does not reach their inbox.

Filtering mechanisms are becoming increasingly sophisticated in determining if an 
email is important, junk or spam. Some check the content, while others focus on the 
recipients’ engagement. However, from an ISP’s perspective, the sender’s reputation 
plays a greater role in the analysis.

Here are typical factors that determine a sender’s reputation:

 l Total number of emails sent
 l Number of emails sent to invalid email addresses
 l Number of recipients who mark the emails as spam
 l Domain from which the emails are sent
 l Whether this domain has authentication records
 l IP address from which the emails are sent
 l whether the IP address is blacklisted anywhere
 l whether the IP address is dedicated
 l whether the IP address has authentication records
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Email authentication
Authentication allows the mailbox provider to confirm that the sender is the one who he 
pretends to be. There are four primary methods of authentication:

 1. Reverse DNS, which implies determining which host and domain name belong to a 
given IP address. If a Reverse DNS Lookup returns a no domain associated, the email 
will likely bounce to the sender, or be deleted or filtered. This entry is set by default 
on the Episerver sending infrastructure.

 2. SPF is Sender Policy Framework, which states which IPs are authorized to send on 
behalf of the "From" domain. SPF allows the receiver's host to verify that the email is 
being sent from the server it asserts it's sent from.

 3. DKIM is Domain Keys Identified Mail. The recipient uses this to determine that the 
message has not been altered in transmission. The public and private keys must 
match to ensure that nothing happened to the message in transit.

 4. DMARC is Domain-Based Message Authentication, Reporting, and Conformance. 
DMARC ensures that the legitimate email is properly authenticating against estab-
lished DKIM and SPF standards, and that fraudulent activity appearing to come from 
domains under the organization’s control (active sending domains, non-sending 
domains, and defensively registered domains) is blocked.

List management and hygiene
Marketers must ensure their emails are sent to an interested audience and, at the same 
time, care about the audience experience.

It’s important to nurture new subscribers and make them feel welcome, while also 
rewarding active subscribers and maintaining their interest.

It’s also important to regularly check in with less active subscribers and give them the 
opportunity to re-engage or opt out. If left unchecked, the number of inactive people 
will grow. Continuing to send emails to them will negatively affect the sender’s repu-
tation and impact deliverability, even to active subscribers.

So, the best way to segment the recipient list is by engagement level.

 l Sending to highly engaged recipients frequently, even on a daily base.
 l Sending less frequently to less engaged recipients.
 l Using reactivation campaigns to recipients who have not been engaged for 3-6 

months.
 l Blacklisting recipients who complained that the email was spam.
 l Deactivating recipients who did not engage within a certain amount of time (1 

year, 20 months and so on). Do this once a year.
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Constantly monitoring the activity and engagement level of subscribers allows mar-
keters to better understand what the subscriber wants and tailor emails to cater to their 
needs.

For more information and best practices, see:

 l Deliverability best practices
 l Email content best practices
 l CSA guidelines
 l IP warming
 l Email authentication and encryption

Deliverability best practices
Good deliverability is no coincidence. High delivery and open rates are mainly a result 
of the general email marketing strategy and the associated adherence to industry best 
practices. After all, what is the point of fancy features if the email is not delivered and 
the recipient never sees it? The following is an overview of best practices as represented 
by internet service providers (ISPs) and valid in the email sector.

Clean contact acquisition process 
Use contacts who actively signed up to receive your promotional mailings. This is legally 
required and provides the best delivery rates, as you would expect the best user 
engagement from them.

Avoid recipient sources such as purchased lists, lead generation, or affiliate marketing 
partners, as the quality of contacts is often poor, legally non-compliant, and negatively 
impacted by lack of concrete opt-ins and questionable acquisition methods.

Clear expectations from the beginning
 l At the time of collecting his email address, is the recipient aware of what kind of 

commercial emails you will send?
 l Lack of clarity can lead to poor open rates and spam complaints.
 l Let the recipient actively manage preferences and desired frequency, for example 

by means of a preference center.
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Double opt-In 
A double opt-in process is the only way to protect your database from unauthorized 
third-party registrations, as recipients are actively verified by clicking the activation link 
in their email account. Spam traps can be prevented from being introduced into the 
database as no confirmation click is expected from them. Storage and documentation 
of the complete registration data as required by the GDPR (general data protection 
regulation) legislation can only be guaranteed by a double opt-in process.

For more information on the double opt-in process and how to implement it with 
Episerver Campaign, see Opt-in.

Registration forms with Captcha
Captcha is the best way to protect your registration forms against misuse. Especially in 
the age of bot and list bombing attacks, it has become indispensable. Integrating a 
Captcha protects your database from malicious addresses and the systems involved 
against DDOS attacks. 

Your recipients attach great importance to data protection and will understand this as 
a confidence-building security measure.

User-friendly unsubscription process
An easy-to-find unsubscribe link should be present in every commercial email. A recip-
ient's opt-out request of should be respected. You should allow the unsubscription from 
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any marketing communication through a maximum of two clicks: on the link itself and, 
if necessary, a second time in a preference center. 

Refrain from requesting additional logins or sending unsubscribe confirmation emails, as 
these may lead to frustration and spam complaints.

List hygiene
 l Each contact should be sent to at least once every 6 months to sustainably clean 

up the database and avoid a high number of hard bounces. 
 l Exclude recipients who were not active in the newsletter in the last 12 months from 

regular mailings. These email accounts might be converted into spam traps by the 
ISPs after that amount of time.

 l Legacy data often results in low open rates and, related to that, a loss of good deliv-
erability performance.

Focus on engaged recipients
Your email marketing activities should focus on your active recipients because they are 
responsible for good open and delivery rates, and also form the basis of your revenue 
generation. These include contacts who were recently active in your emails, on your 
website and other channels; recipients who opened and clicked several times; and 
users who browsed your website and bought products from your shop. Only they should 
receive email from you regularly.
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Exclude and reactivate inactive users
Exclude from the regular newsletter contacts who do not open for a long period of 
time. Lack of feedback leads ISPs to believe that your emails are uninteresting or even 
unintentional to the major part of your recipients, and they may punish you with spam 
folder delivery.

Inactive recipients, however, may occasionally be sent to with winback campaigns. 

Relevant content through segmentation and personalization
 l Take advantage of Episerver Campaign's segment feature  and work with as many 

target groups as possible.
 l You can generally apply filtering to many areas, such as user engagement, regions, 

interests, purchased products and age groups.
 l Do not only send the same mailings exclusively to the complete database. Variation 

leads to more relevant content and thus better email performance KPIs.
 l Irrelevant content causes poor open rates, unsubscriptions, and spam complaints in 

the long term.

Transparent mailing content
Your emails aim to build a relationship of trust with your brand. Therefore, they should 
contain an unsubscribe link, a link to the privacy policy, and a full legal imprint. 
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Email content should look trustworthy not only to the recipient but also to the ISP and its 
spam filter. Therefore, make sure your emails are not empty, do not contain any phish-
ing-like links, and that you have an appropriate HTML / text ratio and identical HTML and 
text versions.

Tip: To learn how email content affects your email deliverability 
and  how you can improve your content strategy, see Email content 
best practices.

Adequate frequency
Adjust the sending frequency to your business model, but do not overwhelm your recip-
ients. Bombarding recipients with emails can lead to high levels of spam complaints, 
unsubscriptions, and public complaints in anti-spam forums,  which have a negative 
impact on your sender reputation and deliverability. 

Be clear about how often your newsletter will be sent, comply with it, and give your 
recipients the opportunity to adjust frequency according to their needs.

Stable sending volume
Heavily changing sending volume is a typical characteristic of spammers. Since the 
emails of ordinary senders might be also misclassified in such cases, avoid large irreg-
ularities of the volume sent. If you need to send much larger quantities of emails due to 
seasonal requirements, a slow and steady increase is recommended.
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Email content best practices
Creating good email content increases the general success of the ability to maintain 
good inbox placement. ISPs (internet service providers) protect their users by using 
spam content filters, which work by analyzing a message before it is sent to the recip-
ient’s inbox. 

Spam filters are used by ISPs to score incoming messages based on algorithms that find 
thousands of characteristics, misspellings, the similarity of words that occasionally show 
up within the spam folder. Legitimate emails can end up into the spam folder if their 
messaging contains any similar characteristics or commonly used tactics by spammers.

Refining your content to industry standards will allow you to stand a more robust chance 
of reaching the inbox.

This topic describes how content affects your email deliverability and provides insights 
into how you can improve your content strategy. Following some best practices can 
facilitate a successful email campaign, some smart rules include:

HTML syntax errors
Using out-of-date or invalid code will influence if your emails are accepted by domains 
like Hotmail, Gmail and AOL are blocked or delivered to the spam folders.

Your finished email might render well among these ISPs but if the hypertext mark-up lan-
guage email doesn’t comply with  W3C standards  (World Wide Web Consortium) you 
may find deliverability problems. HTML syntax and formatting errors are common tricks 
spammers use to get past content filters.

Text image ratio
ISPs often block emails that contain only images as a means to fight against spam. 
Image only emails have been known to have higher abuse complaints, higher bounces, 
lower email engagement. The most common used guideline is no more than 40% image 
and a minimum of 60% text.

Unsubscribe link
Including an unsubscribe link within your email is a fundamental rule for email mar-
keting. The unsubscribe link should be clearly visible, with a one or two click process, 
allowing the recipient to remove themselves from the database instantly. If a recipient 
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is unable to find your unsubscribe link, they are more likely to click the “this is spam” but-
ton, which can lead a mark being left on your sender reputation.

Privacy policy page and imprint URL
A privacy policy is a legal requirement for all websites that collect or use personal 
information from users. Adding a privacy policy link to the intended recipient des-
tination shows ISPs that you are a sender that complies with regulatory guidelines.

Adding an imprint to your email template maintains transparency, it is recommended 
to include name of the authorized sender, email address, phone number, postal 
address and business registration number to the footer of your emails.

Attachments
Adding email attachments as a bulk sender are prohibited, doing so will flag your emails 
as spam. Attachments are often used to hide malware and viruses. ISP tend to block 
emails containing attachments to protect recipients and infrastructure.

Avoid spammy words and phrases
ISPs have become smarter about how they distinguish a spam email from a legitimate 
email by scanning spam words and phrases. As an email marketer doing adequate test-
ing before a send and removing common spam words from your copy such as Click 
here! or Free can assist in better inbox placement. A good way of knowing what to 
exclude is to review the content within your personal spam folder.

An example of spammy content include:

 l Excessive use of exclamation points
 l Dear Friend
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 l Order Now, Risk-Free
 l Discount
 l Offer
 l Sale, Buy, Free, Cheap
 l Keep the following signs to a minimum: ?, %, $
 l Exclude the use of ALL CAPS
 l The use of bright red/green colored fonts

Link shorteners
Link shorteners are appealing since they make your links more manageable, but in real-
ity, using such tools increases the chance of your emails being flagged as spam. The 
reason behind this is that link shorteners mask your destination URL, this technique is 
often used by spammers to prevent recipients and the ISPs from knowing your actual 
website domain.

Avoid mismatched URLs
Mismatched URLs are a clear sign of a phishing attempt, avoid looking like a phisher by 
removing unintentionally mismatched URLs. This occurs when the link text is a URL and 
does not match the URL in the link HREF that the recipient is directed to.

Remove blacklisted URLs
Domains listed on blacklists should not be used. If it is a client’s domain, then the client 
should investigate with his domain host. If it is a third-party domain the client links to (for 
example tumblr.com), it should not be used anymore due to a bad reputation.

Plain text version
There are many good reasons to include a text version of an email, in the event that 
HTML version is not accepted or cannot be rendered, the message will still be able to 
be displayed in text format. Text versions should be identical with the HTML version in 
terms text content and links.

Bad content creates low engagement
The messaging within your emails also has an influence on your inbox placement, it is 
essential to ensure that you are sending email content that your recipients want to 
read. ISPs will analyze how engaged your recipients are by looking at opens, clicks, 
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bounce rates, unsubscribes, and spam complaints. Low performing emails are usually 
sent to the spam folder. Good practices to keep your recipients engaged include 
providing personalizing content based on your recipient’s needs, adding CTA (call-to-
action) points, keeping subject lines short, content messaging less salesy, segments, per-
sonalization, and dynamic content.

A/B testing is an important technique that can help you understand, how your recip-
ients respond to different content, and which campaigns are most effective with 
engagement metrics. See Sending a split mailing and  A/B testing in the Episerver CMS 
section.

Other recommendations
 l An email message size should be less than 200 KB in general. Redundant code, 

increased image sizes, template height /width can influence the overall size of your 
email. (Email size to Gmail should be a maximum of 102 KB.)

 l The subject line should have a maximum length of 50-60 characters.
 l Add a comment to your emails, requesting your recipients to add your email 

address to their safe senders list.
 l Remove any iframes from your templates.

In conclusion, we have seen that content influences not only the value to your recip-
ients, but following the above tips, improves your ability to gain better inbox placement 
and a better performing sender reputation as ISPs start to trust you as a bulk sender.

CSA guidelines
Episerver is a partner of the Certified Senders Alliance (CSA) and takes part in their 
whitelisting program, which complies with GDPR (general data protection regulation) 
and ensures legal conformity of the sender's email marketing processes. CSA whitel-
isting offers preferred delivery and better inbox placement at participating Internet Ser-
vice Providers. Participation in the program involves technical and legal standards that 
are decisive pillars of the program, which must be fulfilled by each sender. The following 
sections provide an overview of the CSA’s legal standards and how to implement them.
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Opt-in requirements

Newsletters based on GDPR article 6

Generally, marketing emails that contain any type of advertising and aim at a sale 
need the recipient's consent. Double opt-in (DOI) is a requirement for Episerver Cam-
paign to comply with GDPR and CSA documentation requirements because it is the 
only procedure that grants traceability to ensure that only authorized user can sub-
scribe.

Product recommendations based on EU directive 2002/58/EC (41)

Alternatively, recommendations about similar products and services may be sent to cus-
tomers who made a purchase without their explicit consent. However, because this 
type of email is usually a source of spam complaints, stricter formal requirements apply.

Newsletter registration form requisites

Must haves

 l Consent must be given actively; pre-checked checkboxes are not allowed.
 l Consent must not be coupled with subscriptions to other services.
 l It must be clear from whom the subscriber is going to receive what content.
 l A remark indicating that unsubscription is possible at any time and by which meth-

ods, at least an Unsubscribe link and email address, must be clearly visible when the 
email address is collected.

 l A maximum of 10 third parties, including sponsors, must be explicitly named.
 l The email address is the only mandatory field; all other fields must be optional. (This 

refers to pure newsletter registration forms only; account registration or checkout 
forms may have more mandatory fields.)

Nice to haves

 l A link to the privacy policy  in every contact acquisition form.
 l The recipient should be informed about the newsletter frequency.
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Newsletter content

 l A full legal imprint needs to be in the email footer including: physical address, email 
address, phone number, authorized representative and business registration num-
ber.

 l Unsubscribe and privacy policy links need to be in the email footer.

Customer relationship requisites for checkout acquisition forms

Must haves

 l The address was acquired through a purchase; a transaction was made, and the 
product was not returned.

 l The address is used for direct advertising of own similar goods or services.
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 l The customer has not objected to this use, meaning there was no previous unsub-
scribe from commercial emails.

 l A remark stating that emails about similar products or services will be sent must be 
clearly visible when the email address is collected.

 l The form must contain information that one can unsubscribe at any time “without 
costs other than the transmission costs pursuant to the basic rates being incurred in 
this regard” or similar and by which methods, at least unsubscribe link and email 
address.

Nice to haves

 l Include a link to the privacy policy every contact acquisition form.
 l Inform the recipient about the newsletter frequency.
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Product recommendation content

 l The products advertised need to be similar to the product purchased. “Similar” 
means they have the same sense and can be used in the same way. No other 
advertising must be included.

 l A full legal imprint is in the email footer: physical address, email address, phone num-
ber, authorized representative and business registration number.

 l Unsubscribe and privacy policy links are in the email footer.
 l The email also contains information that one can unsubscribe from it “without costs 

other than the transmission costs pursuant to the basic rates being incurred in this 
regard”.

Imprint requisites
 l An imprint page must be present on the website and easily accessible.
 l The imprint page must contain: physical address, email address, phone number, VAT 

identification number, and authorized representative.

Privacy policy requisites

Must haves

 l A privacy policy page must be present on the website and easily accessible.
 l The recipient must be informed from which sender he or she is going to receive 

which type of emails.
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Newsletter

 l A remark must be present that indicates that unsubscription is possible at any time 
and by which methods (at least unsubscribe link and email).

 l A maximum of 10 third parties, including sponsors, must be explicitly named.

Customer relationship

 l A remark stating that emails about similar products or services will be sent must be 
clearly visible.

 l The privacy policy must contain the information that one can unsubscribe at any 
time “without costs other than the transmission costs pursuant to the basic rates 
being incurred in this regard” or similar and by which method, at least unsubscribe 
link and email address.

Nice To haves

 l The recipient should be informed about the frequency of the newsletters or product 
recommendations.

Unsubscribe requisites
 l Unsubscription must be easy and requires no more than two clicks.
 l Unsubscription must be free.
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 l No further login must be required.
 l No persuasive language must be used.

Registration data requisites

Must haves

 l Context of contact acquisition (newsletter, customer relationship and so on).
 l URL / screenshot of online registration form or scan of offline registration form / con-

tract.
 l Type of opt-in given, if applicable (double opt-in, single opt-in and so on).
 l Date and time of registration, and DOI confirmation.

Newsletter

 l Declaration of consent as presented when email address is collected.

Customer relationship

 l Remark informing recipient that contradiction to this type of advertising is possible 
at any time as presented .

 l Purchase data.

Nice to haves

 l IP address of registration and of DOI confirmation

IP warming
New sending IPs (Internet Protocol address) have no sending history and are considered 
a cold IP. At this point, they need to acquire a good reputation with ISPs (internet ser-
vice providers).

Hotmail, Yahoo!, AOL, Gmail need to see that you are sending important, consent-
based messages to permit your mailings into your recipient's inbox.

IP warming is the process used to build a good reputation with ISPs. ISPs monitor your IP 
to track your sending behavior and are likely to accept your messages based on a 
good sending reputation.
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The IP warming process includes sending consistent, low volume email campaigns, 
gradually increasing this volume over time until you reach your full volume capacity. 
ISPs then gain confidence in you as a sender.

It can take 4-6 weeks to complete the IP warming phase. This depends on your volume 
amount and how well your recipients engage with your messaging.

During the warming process, ISPs set receiving limits on your IP until you meet their stand-
ards of good reputation.

Getting started with IP warming
 l Whitelist the Episerver sending IP with your internal corporate network to ensure 

emails are not blocked by your internal spam filter.
 l Ensure your IT team updates your DNS authentication records.
 l Clean your data using segment and email validation tools. Warm your most active 

users only during IP warming phase. Active emails addresses consist of those who 
have recently opened, clicked an email in the last 9 months or opted-in to your mail-
ings using a double opt-in database. Focus primarily on recipients who are less likely 
to report spam complaints. Never send to a bought or an old, unverified email list.

 l If you don’t have engagement data to identify active email address, focus on 
recent signup data.

 l Create email content that encourages recipient engagement and that is specific 
to the recipient's interests. See also: Email content best practices.
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 l Send a welcome email to your recipients. This  reminds your recipients that they 
have opted-in and generates engagement for your first send out.

 l As a new sender, it is normal to see some blocking and bulking in the first instance of 
sending. ISPs are trying to determine your legitimacy. As you continue to send to 
good, active email addresses and increase user engagement, bulking should end.

 l Review your engagement data (opens, clicks). A decrease in engagement can 
lead to your messages being bulked by the ISP. Remove recipients from your mar-
keting campaigns who are consistently not engaging.

 l Frequency is important. ISPs like to see consistency in your sending and user engage-
ment metrics.

 l Reputation systems store reputation history for 30 days. Ensure that you do not go 
without 30 days of sending from an IP. Doing so may require restarting the warming 
process.

IP warming schedule
Following an IP warming schedule assists in gradually establishing a reputation with ISPs 
as a legitimate email sender. Start with small email volumes, and gradually increase 
volume each day  according to the two-week set schedule. The following schedule sug-
gests a maximum of 40 percent to 100 percentage increase in volume per day. This how-
ever greatly depends on factors including list hygiene, how engaged your recipients 
are, and spam complaints among other things.
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Day Daily sending volume

1 500

2 1000

3 2500

4 5000

5 10000

6 20000

7 40000

8 60000

9 100000

10 150000

11 200000

12 250000

13 300000

14 400000

  Continue to double your volume until you have reached your target daily volume.

Tips during the IP warming process
 l Ensure that you are sending consistently and keep to that frequency.
 l ISPs (internet service providers) like AOL want to see spam complaints less than 0.2%. 

Review email engagement on each send and remove recipients who are not open-
ing.
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 l Once your IP (Internet Protocol address) exceeds the threshold set by the ISPs, the 
ISP may start to soft bounce the emails. If you experience a higher than normal soft 
bounce rate, stop sending and re-start the send later in the day.

 l Start the day with recipients who are very likely to open your emails.

What can cause delivery issues during IP warming
 l High spam complaints. This occurs when a recipient clicks "this is spam" button which 

is shown within the email client.
 l Invalid email addresses (hard bounce).
 l IP address and domain blacklistings on RBLs (public blacklists).
 l Spam traps located within your data list.
 l Unexpected volume increases.

What ISPs like to see
 l Consistent opens and clicks
 l Consistent email frequency
 l Email best practices are  in place, as detailed in Deliverability best practices.
 l Emails are authenticated (SPF, DKIM, DMARC)

Warming a sending domain
A sending domain requires a good sending reputation for messages to enter your recip-
ients’ inboxes. Domain warming is similar to IP warming, as it represents mailing prac-
tices and volume. The same warming approach mentioned above can be applied to 
warming up sender domains. The difference however is that domain warming focuses 
on recipient engagement, which is the key factor to focus on.

Email authentication and encryption
Online abuse may occur in many ways, this includes spoofing of sender domains or 
email content and the sending of spam messages on behalf of someone else. In order 
to prevent this from happening, Episerver applies a number of email authentication and 
encryption techniques.
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Email authentication
A major aspect of the email delivery is the email authentication. ISPs (Internet Service 
Providers) and most email servers, in general, decide the credibility and authenticity of 
your email based on the email security policies that you have in place. Furthermore, 
email authentication is a technical method for identifying spam and verifying that an 
email is actually sent by the sender, which refers to technical standards. ISPs and organ-
isations use these technical standards to block harmful emails such as phishing and 
spam.

IP-based authentication

Episerver adheres to email technical standards to ensure we provide the utmost deliv-
ery of emails, this includes the authentication of our sending IP infrastructure. Our 
authentication standards are intended to improve security and trust when sending 
emails using the Simple Mail Transfer Protocol (SMTP).

Reverse DNS (rDNS or PTR)

The Reverse DNS record, also called PTR record, resolves an IP address to a host name. It 
adds tracing to the origin of an email and thus, credibility to an outbound email server. 
If the Reverse DNS lookup returns a ‘no domain associated’, the email will likely be 
filtered, bounced or deleted by the receiving ISP.

Tip: Reverse DNS (PTR) records are set by default. No further action 
from your side is required.

Domain-based authentication

To help keep deliverability at its best, Episerver requires that each sending domain is 
configured to enable Episerver to send verified messages on behalf of your chosen 
domain. Records are added to your DNS managed by your IT administrator.

Tip: For information on domain delegation and setting up sending 
domains, including the required DNS records, see Episerver World.

Sender Policy Framework (SPF)

The SPF record prevents email spam by recognising email spoofing. The domain pub-
lished in the “include” record contains all Episerver sending IP ranges. Confirming the 
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sender's IP addresses, SPF enables the domains administrators to determine which hosts 
are permitted to send emails on behalf of the given domain.

The SPF record is created as a TXT record on the technical return path domain like t.ex-
ample.com.

Mandatory Episerver SPF record

Type: TXT 
Value: v=spf1 include:spf.srv2.de -all

DomainKeys Identified Mail (DKIM)

DKIM utilises the information published by the domain proprietor. The information per-
mits the accepting server to check if the email message was sent by the proprietor of 
the domain. Using a digital signature, the receiver also verifies that the message was 
not changed during transmission. 

For digitally signing a message, two keys are necessary. A private key that is stored in our 
infrastructure and signs outgoing messages, and a public key that is published in the 
DNS settings of a sender domain to be used. The domain of the Episerver DKIM record 
contains this public key.

The DKIM record is set up as a CNAME record on both your technical return path like t.ex-
ample.com and visible sender domain example.com.

Mandatory Episerver DKIM record:

Type: CNAME 
Value: dkim.srv2.de

Domain-Based Authentication Reporting and Conformance (DMARC)

The DMARC record tells the receiving server which email authentication methods were 
used by the sender, and what an ISP should do with a message if it fails those authen-
tication methods.

Possible DMARC policies:

 l p=reject tells the receiver to reject an email that cannot authenticate with SPF and 
DKIM (Recommended)

 l p=quarantine tells the receiver to quarantine an email that cannot authenticate 
with SPF and DKIM

 l p=none tells the receiver to apply no special policy to an email that cannot authen-
ticate with SPF and DKIM
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Using the reject policy, emails that an unauthorized third party tries to send on your 
behalf as part of a spam attack would simply be blocked by the ISP. Furthermore, 
DMARC allows a sender to set up a reporting mechanism. Like that you will be notified 
each time an authentication failure and potential abuse of your domain is taking 
place.

The DMARC record is stored as TXT record in a sub domain of your visible sender domain 
named _dmarc.

Example domain: _dmarc.example.com

Example DMARC record: v=DMARC1; p=reject; pct=100; rua=mailto:dmarc@example.com; ruf-
f=mailto:dmarc@example.com

Note: DMARC is an optional setting. To use DMARC, contact cus-
tomer support.

Brand Indicators for Message Identification (BIMI)

BIMI uses a text record which is stored on your DNS server and works together with 
DMARC to indicate to participating email clients that you are the true sender. The dif-
ference between BIMI and other authentication methods is that it uses front end visu-
alisation by having the email provider show your branded logo within the users inbox. 
When a message is sent, the recipients ISP will look for the BIMI text file. When the ISP has 
successfully located the file for verification, your company’s logo is shown in the recip-
ient’s inbox. Currently participating mailbox providers include Gmail, Comcast, and Ver-
izon (Yahoo, AOL, etc.).

A BIMI setup currently has the following requirements:

 l DMARC record with either reject or quarantine policy
 l Logo to be displayed as .svg file (Scalable Vector Graphic)

The BIMI record is stored as TXT record in a sub domain named _bimi. Furthermore, the 
domain starts with the BIMI selector, for now this is limited to the value default.

Example domain: default._bimi.example.com

Example BIMI record: v=BIMI1; l=https//www.example.com/logo.svg; a=;

Note: BIMI is an optional setting. To use BIMI, contact customer sup-
port.
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Email encryption
Encryption is a security mechanism for converting information into code in order to pre-
vent access to this information through unauthorized third parties. It is also used to pro-
tect data in transit. To protect it, the information itself and/or the transport of it are 
converted into a ciphertext and only authorized parties will be able to translate it back 
into plain, readable information. This is also how email encryption works.

Transport Layer Security (TLS)

Transport Layer Security (TLS) is the upgrade of Secure Sockets Layer (SSL), a protocol 
that used to communicate securely over computer networks. TLS Record Protocol 
secures a connection security, then using TLS Handshake, the protocol authenticates 
both sending and receiving servers. This prevents snooping during message transmission, 
protecting the content from being read by unauthorized third parties.

Based on the TLS protocol, there is the STARTTLS email protocol command, that tells the 
receiving server that for the transmission of the email an existing insecure connection 
shall be turned into a secure one. 

With the opportunistic TLS mechanism that Episerver is using, the recipient server is 
asked during transmission if it is able to process TLS encrypted messages and if the 
answer is yes, then the email gets sent using TLS encryption. If it’s not possible, the email 
is sent without encryption. Episerver uses TLS version 1.2 by default as it offers the 
strongest encryption, unless it is necessary to use a lower version in specific cases.

Tip: TLS encryption is enabled by default. No further action from 
your side is required.

Digital signature
Using DKIM, you already have one digital signature mechanism in place. DKIM sig-
natures are applied by Episerver’s sending server and verified by the receiving server of 
the ISPs. They guarantee the authenticity of your sending domain.

Additionally, it is possible to also sign emails in order to verify the actual sender and not 
only the domain. To do this, you can set up an S/MIME certificate that will then be visible 
to and verified by your recipients.
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Secure/Multipurpose Internet Mail Extensions (S/MIME)

Secure multipurpose internet mail extension is an email signing protocol used to 
improve email signing, by enabling you to prove the actual sender of an email through 
a timestamped digital signature and to encrypt and decrypt the content of their 
emails. S/MIME helps ensure that files stay authentic and protected when sending 
between networks.

Remark: Digital signatures only ensure data integrity and do not apply to confidentiality. 
Emails protected with a digital signature are still sent as plain text. Message encryption 
of the S/MIME standard is not supported.

See Sending S/MIME-signed emails.

Note: S/MIME encryption is an optional feature. To use S/MIME, con-
tact customer support.

Exclusive IP addresses

Note: To enable this feature, contact customer support.

If you want to send mailings from exclusive IP addresses instead of the default Episerver 
IP address pool, you can lease one or more IP addresses. These addresses are reserved 
to send mailings exclusively from your client. Within 30 days, a reputation trend is visible. 
The dispatches of other clients have no influence on the reputation of your IP addresses.

Tip: A Return Path certification requires exclusive IP addresses.
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ISO 27001 certification

Episerver Campaign's safety management
The ISO/IEC 27001:2013 certification by TÜV Süd gives you as a user the guarantee that 
Episerver's safety management for operation, service and development of email mar-
keting platform complies with internationally recognized standards regarding data and 
information security.

In external, multi-stage audits, processes sensible to set up, implement, execute, con-
trol, maintain and optimize information security are evaluated.

In addition to the evaluation of the technical and organizational processes, the hand-
ling of information within the company was scrutinized, for human error has to be taken 
into account and made safe.

Your advantages
The internationally recognized certification for information systems according to 
ISO/IEC 27001:2013 gives you safety and comparability with other systems when choos-
ing the email marketing service provider that suits you best. With this certification, you 
can be sure that your data is hosted, stored and protected against unauthorized access 
at Episerver according to defined, approved standards. The certification also covers 
the operation and support of Episerver's dispatch infrastructure. In these 
aspects, Episerver Campaign scores with a highly available, fail-safe and powerful sys-
tem.

What does ISO/IEC 27001:2013 mean?
ISO/IEC 27001:2013 is a standard for an information security management system that 
checks and evaluates the following areas and assets:

 1. Information security management. Information security management evaluates pro-
cesses, their functionality and infrastructure of Episerver Campaign by identifying 
possible threats, risk handling and responsibilities. It represents the current state and 
serves as a base for the PDCA guidelines for continuous improvement of information 
security.

 2. PDCA guidelines for continuous improvement of information security. These guidelines 
for the Plan-Do-Check-Act process define in four phases the suitable measures to 
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determine and evaluate information security; the measures to be implemented 
and realized; how these measures and their effectiveness can be verified con-
stantly; and finally how these measures can be maintained, improved and fixed dur-
ing operation.

 3. Inventory sheet. Assets of the company are registered here. Each asset is evaluated 
regarding its priority for information security. Next, a procedure directory is created, 
which contains and describes all processes related to this asset.

 4. Risk measure matrix. In this matrix, all implemented security measures are correlated 
to a concrete risk. With this matrix, the remaining risk can be determined and thus 
assured that only a minimal acceptable remaining risk will occur at any time in any 
process.

 5. Compliance. This aspect ensures that all processes are defined within the legal range 
and in compliance with the standards set by the legislature.

Who certifies all this and how is the process conducted?
The certification is a multi-stage process and is executed by an external service pro-
vider. The certification of Episerver Campaign was executed by TÜV Süd. The cer-
tification process involves the following steps and phases:

 1. Assessment for certifiability. Done prior to the actual certification. 
 2. Certification audits by TÜV Süd. Multi-stage audits in all security relevant areas and divi-

sions of the company. 
 3. Verification audits. Yearly audits, which guarantee the compliance with all stand-

ards. These audits also verify that the information security management is being 
improved and developed further. This is a requirement for the certification.

 4. Recertification. Every three years, the certification is renewed in an audit similar to 
the certification audit (see number 2).

Service description

Episerver Campaign lets you run dialog marketing campaigns on channels and send pro-
fessional marketing messages by email, Mobile Push, or SMS from a single software pack-
age.

Episerver Campaign comes fully integrated with the tools for one-to-one dialogs with 
your customers: 

 l Omnichannel marketing campaigns
 l One-shot campaigns

http://www.tuev-sued.de/home_en
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 l Marketing Automation
 l Transactional mails
 l Easy creation of professional mailings
 l Opt-in processes
 l Recipient management
 l Powerful segmentation and analysis tools that let you analyze the success of your 

mailings  for  each recipient, and generate reliable data for your marketing research.

 Episerver Campaign communicates with your webshop, customer relations man-
agement system or web analytics service provider to do the following: 

 l Automatically display products from your webshop in your messages
 l Create target groups
 l Create personalized product recommendations
 l Consolidate your customer relationships through successful closed-loop marketing

Episerver Campaign is TÜV-certified as compliant with ISO 27001 and a member of the 
Certified Senders Alliance (CSA).

Omnichannel marketing
Reach your customers on channels with flexible tools for successful omnichannel mar-
keting – using a single provider.

 l Email campaigns
 l SMS campaigns 
 l Push campaigns
 l Multi-channel campaign automation
 l Separate blacklist management for each channel

Email
Episerver Campaign virtually sends your emails in real time. Episerver Campaign also 
comes with deliverability management, which significantly increases deliverability 
rates.

Range of features

 l Sending speeds of up to 50 million emails per hour; more than 90% of emails 
delivered within the first minute.
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 l Comes with email throttling to let you, for example, avoid unusually high traffic to 
your website and stagger customer visits for campaigns that are likely to attract a 
lot of interest (such as special offers, prize draws, or surveys)

 l Enhanced HTML layout for ensuring emails are correctly displayed in webmailers and 
email programs

 l Mobile Fusion provides responsive design for optimized display on mobile end 
devices

 l Auto generated text version
 l Auto generated online version
 l Landing pages
 l Can be personalized
 l Web forms for allowing recipients to register and recipient management
 l SWYN (share with your network) provides sharing email content on social networks 

(Facebook, Twitter, Xing, Myspace).

SMS
SMS provides seamless integration of messaging to reach your customers.

 l Supports GSM and UCS2 coding for international character sets
 l Capable of sending multi-part SMS (concatenated SMS)
 l Direct message routing to 12 countries
 l Standard number-based sender identification
 l Speed-dial number-based sender identification
 l Alphanumeric character-based sender identification
 l Can be personalized

Mobile Push 
Mobile Push sends automated push messages and reaches every customer who has your 
app on their smart phone or tablet.

 l Available for Android and iOS
 l App-based opt-in methods
 l Can be personalized
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 Episerver Campaign management

Smart Campaigns 
Smart Campaigns have a convenient front-end for one-shot campaigns. Navigation 
paths and click paths are optimized for maximum efficiency.

 l Create campaigns with drag and drop
 l A/B tests (split tests) and automatic send function for the best performing message
 l Six criteria for selecting the best split
 l Allows campaigns to be worked on by several users simultaneously
 l Designed for creating email, SMS  and push campaigns
 l Create campaigns from message templates
 l Reuse successful campaigns with a single click
 l Integrated pre-campaign recipient-path-analysis
 l Integrated post-campaign reporting
 l Select send dates and delayed delivery in line with A/B test results
 l Send messages to specific target groups or a limited number of recipients
 l Episerver Campaign throttling

Marketing Automation
Marketing Automation lets you automate frequently recurring customer dialogs, such 
as welcome and happy birthday messages, reactivation campaigns, abandoned cart 
emails, and much more. Marketing Automation event and date-triggered mailings 
increase conversion rates and let you analyze recipient flows and activities in real time. 
Marketing Automation furthermore comes with an automated feature for changing 
recipient data and moving or copying recipients to different recipient lists.

 l Create Marketing Automation campaigns with drag and drop
 l Omnichannel. Send out  email, SMS and Mobile Push messages to different end 

devices and target groups from a single Marketing Automation campaign
 l Create automatic lifecycle marketing campaigns
 l Send out activity and event-based mailings from a single campaign
 l Actively run multiple campaigns simultaneously 
 l Link multiple campaigns, for example, by automatically assigning recipients from 

one campaign to another
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 l Modify campaigns while active
 l Post-click-triggered campaigns
 l Integrated campaign recipient-management (updating, moving and copying 

recipients/recipient data)
 l Integrated campaign reporting for active campaigns – monitor the number of recip-

ients who passed the individual campaign nodes at any time

Transactional mails 
Transactional mails are triggered by recipient actions or events, such as an anniversary. 
Episerver Campaign sends transactional mails using a high-performance API (applic-
ation programming interface). Transactional mails can be activated in Marketing Auto-
mation or sent through the REST, SOAP or HTTP API.

 l Sent through Marketing Automation
 l Can be sent as email or SMS
 l Sent in real time using high-performance interfaces
 l Can be personalized
 l Can send personalized attachments (HTTP API only)

Registration confirmations
Registration confirmations manage your  double opt-in mailings with Episerver Campaign 
and make them reflect your corporate design. The integrated reporting feature lets you 
check the number of recipients who completed the registration process.

 l Administration of multiple opt-in mailings in your Episerver Campaign client
 l Sent in real time using the transaction API
 l Edit contents while the registration confirmation is active
 l Can be personalized

Content management
Our intuitive content management system (CMS) lets you create appealing, ready-to-
send mails in no time. The modular design makes it easy to insert text and images. You 
can preview content on different devices (email, web, mobile) while editing. The con-
tent management system also can be used to define personalized and group-specific 
content.
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 l WYSIWYG (what you see is what you get) editor
 l Source text editing
 l Import mailings as zip archives
 l Automatic text version generator
 l Create, manage, and change landing pages
 l Content reports for link validation
 l Automatic link extensions for click tracking
 l Manage HTML, text, and mobile link tracking
 l Personalized and target group-specific subject lines
 l Automatically creates online version
 l Attachments

Note: The following features are optional. Contact customer sup-
port for more information.

 l Send images with offline HTML
 l Personalized attachments (only when used with transactional mails and the HTTP API) 

Template Kit 
Template kit lets you define the layout and appearance of the elements in your mailing, 
to which you can copy or move content blocks via drag and drop. The basic mailing 
elements (such as, sender information) are predefined to create new mailings and 
make them less error-prone.

 l Predefined pre-header, header, body and footer sections                     
 l Grouping paragraphs for creating flexible layouts (1- or 2-column) 
 l Paragraph types                          for essential applications 
 l Target groups and click profiles for use at paragraph level                    
 l Nine fonts to choose from 
 l RSS feed integration
 l Content interface 
 l Add links to social networks (SWYN)
 l Mobile Fusion for responsive web design – to ensure that your mailings are optimally 

displayed on mobile devices, with a preview function for conventional device 
formats

 l Separately edit HTML, text, and mobile mail versions
 l Click2Go is a button generator for adding buttons or call-to-action elements in a 

design-consistent layout, conveniently and directly to your template
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 l Easy edit – split-screen view for previewing the mailing
 l Inline editing – edit your texts directly in the mailing preview
 l Easy Copy lets you copy and paste individual elements from other mailings or clients 

Note: The following features are optional. Contact customer sup-
port for more information.

 l Install additional standard web fonts
 l Custom fonts – install user-defined fonts

Custom mailing content templates
Custom content templates are set up by customer support on request. Custom templates 
are based on your corporate design and style guide and ensure that your newsletters 
appear exactly as intended on recipient devices.

 l Template with your corporate design
 l Template modules designed in line with your design specifications
 l Layout and design principles based on your style guide
 l Available features in the Template Kit can be integrated into individual templates

Coupon system
Coupon system lets you reward mailing recipients with promo coupons. Adding a 
machine-readable bar code to your mailings will allow your customers to redeem 
coupons at their local store.

 l Upload static coupon blocks – if you want to define the structure of individual codes 
and number of codes per block

 l Dynamically generated coupon blocks – if you want Episerver Campaign to auto-
matically generate a new, unique coupon code for every email

 l Bar code blocks with editable layouts (width, height, line weight) based on EAN 13
 l Static block thresholds for triggering mails
 l Delete unused codes from static blocks
 l Download coupon code assignments

Countdown timers
Countdown Timers display the days, hours, minutes and seconds remaining to when your 
offer ends to increase the attention of your recipients and conversion rate.
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 l Supports static and animated countdown timers
 l Editor for designing, editing, and managing countdown timers
 l Field function for mailing integration

Segmentation

Target groups 
Successful dialog marketing: Target, attract, inform and engage your customer seg-
ments with custom content. Episerver Campaign helps you define target groups to 
ensure that your mailing content and subject lines are relevant to every one of your 
recipients.

 l Recipient-based filter criteria, which can be based on any  recipient list field
 l Action-based criteria, such as clicks, open, hard and soft bounces, and post-clicks
 l Campaign-based criteria for linking several marketing automation campaigns
 l Use of operators: contains, starts with, ends with, equals
 l Use of mathematical operators for numeric fields
 l Use of time-based operators for date fields
 l Boolean operators (true or false)
 l Instant target group analyses
 l Ad-hoc target groups created from Live Analytics segments with a single click

Click profiles 
Categorize your recipients’ clicking behavior with click profiles. Rule-based click profiles 
provide information about your campaign's performance, instead of complex indi-
vidual mailing and campaign analyses.

 l Cross-campaign click profiles
 l Manually assign click profiles
 l Rule-based click profile assignments based on wildcards
 l Rule-based click profile assignments based on regular expressions
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Analysis tools

Performance Dashboard (Beta)
The Performance Dashboard (Beta) lets you display KPIs using charts for visually appealing 
presentations of your mailing activities.

 l Various charts available: KPI chart, basic chart and bubble chart
 l Time-based and mailing-based analysis
 l Individually customizable

Live Analytics
Live Analytics lets you generate recipient-based reports and create real-time RFM ana-
lyses to boost your campaigns’ profitability and return on investment (ROI).

 l Analyze data by recipient lists, list fields, and target groups
 l Edit analysis fields in real time in the detail view
 l RFM analyses for boosting your sales
 l Graphical representations and segment
 l Funnel analysis segments of a diagram with a single click
 l Create target groups with a single click

Deep Analytics 
Deep Analytics provide in-depth and highly detailed mail-based reports about your cam-
paigns’ success to effectively targeting your recipients and further develop your omni-
channel marketing. 

 l User-friendly report builder with graphical interface
 l Create reports with drag and drop
 l Choose from up to 28 analysis measures
 l 13 groupings
 l Predefined basic reports for campaign and progression-based analyses
 l Automatic raw data analyses for reports based on high-performance database 

algorithms
 l Post-click analyses with external web analytics tools
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 l Global report parameters based on clients, time intervals, target groups, mailings 
and mailing types

 l Choose from different diagrams (bar charts, line charts, regional and pie charts)
 l Aggregation of comprehensive reports in pivot tables
 l Seamless integration with Microsoft Excel
 l Configurable report templates in your corporate design
 l Automatic report generation and distribution by email

Deliverability preview
The deliverability preview lets you check your mailing before dispatch, whether the con-
tents are displayed correctly and whether your mailing has been classified as spam by 
the most common email providers.

 l Preview how the graphics and fonts in your mailing are displayed by the most com-
mon email providers and browsers

 l Check spam suspicion with the most common email providers

Post click tracking
Post-click tracking lets you analyze actions by email recipients on your website, like 
clicks on products or canceling of orders.  Use Deep Analytics to analyze and display the 
generated data.

 l Filter by date or time range
 l Import mailing-independent customer actions
 l Integrate external web analytics software

Visual link analysis 
Visual link analysis instantly shows the number of times the links in a mailing were clicked. 
The analysis is performed directly inside the mailing itself, which means that you can see 
whether links in particular locations are clicked more or less frequently.

 l Analyzes absolute and unique clicks
 l Proportional analysis based on recipients or clicks
 l Visual link analysis of post-clicks
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Attention analysis 
Attention analysis let you assess the impact of your mailings, templates, and landing 
pages’ layout on viewers. Based on eye-tracking, this tool graphically represents ana-
lysis results which indicate if the most crucial elements of your mailing (logo, offer price 
and period, call-to-action) are located to effectively attract the viewer’s attention.

 l Perception map analyzes which features of a mail a viewer focuses on first
 l Attention map for analyzing which elements in your mail attract the most attention
 l Visual attention prediction for predicting the order in which mailing elements 

attract attention
 l Analysis of draft layouts of existing mailings or screen shots means layouts can be 

optimized during the design phase

Activity overview 
Activity overview shows mailings for a defined period in a single, clearly laid-out screen. 
This lets you obtain information relevant for evaluating your marketing activities, such as 
which customer dialogs you have sent, are currently sending, and are about to send.

 l Evaluate multiple clients at once
 l Filter by mailing types, media types and mailing status
 l Transactional mails and registration confirmations are supported

Integrations and additional functions
Episerver Campaign seamlessly integrates all major web analytics, e-commerce and 
CRM systems. You can use programming interfaces (APIs) and extend Episerver Cam-
paign with various additional functions. In addition, Episerver constantly develops new 
custom features for you.

Web analytics integration
Episerver Campaign seamlessly integrates commonly available web analytics tools. 
Benefit from bi-directional data exchange: The most important statistics are sent to the 
analytics software, and segments relevant for your Episerver Campaign remarketing 
campaigns are available in the feedback channel.

https://world.episerver.com/add-ons/
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Adobe Analytics

When using Adobe Analytics integration, tracking data from your online shop is sent to 
Episerver Campaign. User actions and product data from Adobe Analytics are avail-
able for creating remarketing campaigns in Episerver Campaign. Bi-direction data 
exchange also sends mailing and campaign parameters and recipient actions to 
Adobe.

 l Bi-directional data exchange
 l Tracking of standard actions: product purchase, product view, and abandoned 

shopping carts
 l Tracking of standard variables: item number, order, quantity, and price
 l Freely configurable user-defined variables for sending additional data, such as 

reviews and registrations
 l Grouping of mailings within a campaign for aggregated post-click evaluation

Google Analytics

You can use Google Analytics to monitor the success of your marketing campaigns and 
further optimize them. Episerver Campaign sends mailing and campaign parameters to 
Google Analytics. The Google Analytics dashboard gives you access to campaigns and 
an overview of the costs and revenues related to your campaign.

 l Unidirectional data exchange
 l Mailing ID, mailing name and description, mailing type, and dispatch date are trans-

mitted
 l Recipient list fields are transmitted
 l Time and campaign-based analyses available in Google Analytics

Google Tag Manager

With  Google Tag Manager you can implement tracking codes and conversion pixels on 
your website and create data about user actions. By using the integration you can trans-
fer this data to Episerver Campaign.

 l Identification of customers/recipients via the RecipientID
 l Data transfer to Episerver Campaign
 l Creation of target groups in Episerver Campaign
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intelliAd

IntelliAd integration for Episerver Campaign lets you evaluate your email campaigns 
using intelliAd.

 l Unidirectional data exchange
 l Link tracking using link extension
 l Analysis of clicks over time for just the email channel or together with other mar-

keting activities in the intelliAd dashboard

E-commerce integration
Securely send order and dispatch notifications, double-opt-in emails, or entire cam-
paigns. Seamless and automatic E-commerce integrations with Episerver Campaign 
matches recipient data and recipient status and imports product data directly into 
your newsletter template. You further benefit from the performance and reputation of 
Episerver's dispatch infrastructure.

Magento 1 integration and Magento 2 integration

Take advantage of the performance available from Episerver Campaign in com-
bination with the Magento e-commerce platform. The Integration includes syn-
chronization of recipient data including logins and logouts, export of the product 
catalog, and sending transactional mails via SMTP and HTTP.

 l Available for Magento CE 1.7 to 1.9, Magento EE 1.12 to 1.14, Magento CE 2.0 to 2.1
 l Processing of subscriptions and unsubscriptions via Episerver Campaign
 l Synchronization of recipient status between the shop system and Episerver Cam-

paign
 l Transfer of further recipient data from the shop to Episerver Campaign to per-

sonalize your mailings
 l Adaptability of the data model for data exchange
 l Multi-client capability through support of subshops and storefronts
 l Sending transaction mails via the SMTP API
 l Sending transaction mails via the HTTP API using the templates in Episerver Cam-

paign
 l Export of the product catalog as CSV file for use during mailing creation
 l Configurable confirmation pages
 l Transfer of further data fields from the web shop to Episerver Campaign for further 

personalization of your mailings
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CRM integration
Bi-directional CRM integration lets you send campaigns to your contacts and leads using 
Episerver Campaign. Personally address your customers with customized content and 
evaluate the success of your campaigns directly from within your CRM system.

MS Dynamics CRM

Plan, start, evaluate successful campaigns in MS Dynamics CRM and benefit from the 
power and above-average delivery rates of Episerver Campaign: Use your com-
prehensive CRM database to create email and SMS newsletters with high conversion 
rates. Use your data to generate extensive and original customization. Delivery and a 
perfect layout are guaranteed. The bi-directional connection means you can monitor 
success directly from within your CRM system.

 l Available for MS Dynamics CRM and On-Premises
 l Supports MS Dynamics CRM versions 2013, 2015 and 2016
 l Omnichannel campaigns via email and SMS
 l High-performance dispatch infrastructure with excellent delivery rates
 l Precisely measure the success of CRM campaigns
 l Transfer personal data from the CRM such as salutation, name, city and post code
 l Import response data in your CRM such as openings, clicks, returned emails, can-

celed subscriptions and bounces

Salesforce

Plan, start, evaluate successful campaigns in Salesforce and benefit from the power and 
above-average delivery rates of Episerver Campaign: Use your comprehensive CRM 
database to create email and SMS newsletters with high conversion rates. Use your 
data to generate extensive and original customization. Delivery and a perfect layout 
are guaranteed. The bi-directional connection means you can monitor success from 
within your CRM system.

 l Available for Enterprise Edition, Unlimited Edition, and Performance Edition
 l Omnichannel campaigns via email and SMS
 l Export standard segmentation and personalization fields from Salesforce into 

Episerver Campaign
 l Export additional customer-specific fields to Episerver Campaign
 l Multi-stage campaigns in Salesforce
 l Automatic response data synchronization
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APIs
Smart and flexible: Episerver Campaign offers a range of comprehensive programming 
interfaces (APIs) to automate your marketing activities.

REST-API

The REST API is a convenient alternative to the SOAP API that lets you manage and con-
trol Episerver Campaign features from external systems by using HTTPS requests. In con-
trast to the SOAP API, you can also manage Smart Campaigns. In total, Episerver 
provides more than 200 operations in over 16 different web services for this purpose. You 
can retrieve data from and send data to Episerver Campaign via REST API. See the 
Episerver Campaign SOAP API documentation for information.

 l Bi-directional secure data exchange
 l Almost all features of Episerver Campaign can be executed
 l Over 16 web services and more than 200 operations available
 l Supports multiple languages and formats such as HTTPS, JSON, URI and XML

SOAP API

The SOAP API lets you control Episerver Campaign from external systems using a variety 
of programming languages and environments. More than 250 operations in 18 different 
web services are provided for this purpose. The interface is bi-directional. Data can be 
both retrieved from and sent to Episerver Campaign. See the Episerver Campaign 
SOAP API documentation for information.

 l Bi-directional secure data exchange
 l Almost all features of Episerver Campaign can be executed
 l 18 web services and more than 250 operations available
 l Episerver Campaign provides pre-configured programming libraries for Java and 

PHP to make connecting external systems easier

HTTP API

The HTTP API can be used to register new recipients, manage blacklists and subscription 
cancellation lists, for personalized tracking and for sending trigger and transactional 
mails – also with personalized attachments. The HTTP API operations can be embedded 
into emails, web forms and online shops. See the Episerver Campaign HTTP API doc-
umentation for information.

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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 l Secure integration and data exchange
 l Easy to configure API calls
 l Confirmation of execution is returned for each operation
 l Can be used in emails and web forms
 l Transfer personal data for sending personalized transactional mails
 l Personalized attachments (for example PDFs)
 l High-performance transactional API for high volume dispatch

SMTP API

The SMTP API offers a simple solution for sending campaigns via the high-performance 
infrastructure and lets you benefit from the reputation of the Episerver Campaign server. 
After setting up a special SMTP client, you can continue to create your mailings using 
your usual software package. Mailings are sent via Episerver's high-performance server 
that is recognized by major providers. You benefit from the reputation and per-
formance of Episerver Campaign with minimal modifications.

 l Above-average high email delivery rate and sender reputation
 l Monitor the mailing process using Episerver's deliverability experts
 l Seamless integration into existing system architectures
 l Mailing creation and recipient management continue to be carried out in your cur-

rent system—no need to retrain staff

Additional interfaces

Content interface

Link external product databases to the content interface or content management sys-
tem to display your shop products in your mailings. Just a few clicks are needed to cre-
ate your product offer: the Episerver Template Kit provides pre-configured paragraphs 
for linking and creating layouts for product data according to your corporate design 
guidelines.

 l Product paragraph for embedding individual products
 l Content interface paragraph for embedding several grouped products
 l Up to 10 text elements per article
 l Up to 3 links per article
 l Up to 6 images per article
 l XML and CSV formats
 l HTML/CSS formatting

https://world.episerver.com/documentation/developer-guides/campaign/smtp-api/
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Translation interface

The translation interface from Episerver Campaign lets you send the texts for your mailing 
to a translation service provider. The service provider returns the translated content. 
Your mailing templates apply the relevant language to ensure that a localized mailing 
is sent to each target market.

 l Data exchange using standard XML format
 l Link to practically all translation providers
 l Automatic creation of mailings in target language
 l Automatic requests for the status of a translation ensures that mailings are only sent 

when the translation is complete

Closed-loop Interface

The bi-directional and flexible closed-loop interface lets you integrate data from your 
data warehouse or campaign management system into Episerver Campaign. The 
import module is used to send selected recipients and personal data to Episerver Cam-
paign. A mailing filled with this data is then sent. The export module provides send and 
response data for the feedback channel. This data is automatically fed back to your sys-
tem.

 l Secure data exchange over SFTP or SOAP API
 l Import and export using the standard CSV format
 l Referencing of content, for example, image stored on remote systems possible
 l Import personalization information and product recommendations
 l Automatically generate a send log and response data (openings, clicks, returned 

emails, canceled subscriptions) for export to the feedback channel

FTP interface

This high-performance and universal interface lets external data storage systems to 
securely synchronize with Episerver Campaign.

 l Import and export large amounts of data in CSV format
 l Secure data transfer via an SFTP connection
 l Import data at regular intervals or when changes are made
 l Automatic further processing of data by clients
 l Import and export recipients, canceled subscribers, blacklists and multiplier lists
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Dispatch and deliverability

Dispatch
You can send messages (even high volumes of messages) immediately or use delayed 
dispatch. You can also split messages and send different content to different target 
groups. 

In addition, you can test every message before sending it. To do so, select a number of 
test addresses and lists, start separate tests for text, HTML, and multi-part messages, and 
simulate the messages’ dispatch to the different groups.

 l Sending speeds of up to 50 million emails per hour
 l Throttled dispatch (for example, for campaigns likely to drive a high level of traffic 

to your online shop). Throttled dispatch lets you control and manage follow-up 
traffic.

 l email can use international ISO-8859-1, ISO-8859-2 or UTF8-compliant character sets
 l SMS message routing to 12 countries

 o SMS delivery using international GSM and UCS2 data coding

Note: The following features are optional. Contact customer 
support for more information.

 o Target group-based SMS delivery to specific regions using telephone dialing 
codes

 o SMS delivery with sender recognition using individual short codes (on request, 
exclusive code) or long codes

Send time optimization
Customize the time your messages are sent. The send time optimization identifies when 
your recipients interact with their inbox, and sends your message when they are most 
attentive.

 l Available for Smart Campaigns
 l Available for A/B tests
 l Self-learning algorithm, continuously adapts to recipient behavior
 l Very flexible, virtually infinitely adjustable for up to 7 days
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 l Analysis function evaluates individual dispatch times
 l Fallback time  for new recipients for whom behavior data is not yet available

Deliverability management
Episerver’s deliverability team monitors mail delivery and takes proactive action to 
ensure high sending rates. This includes collaborating with providers and organizations 
to develop optimal strategies for improving deliverability – regardless of the growing 
complexities of spam filters. See also Best practices for good deliverability.

 l Active deliverability management and monitoring
 l On-boarding deliverability – Episerver's deliverability team performs an advance 

analysis of the requirements for ensuring the deliverability of your messages
 l Episerver is a member of the Certified Senders Alliance (CSA)
 l Provider relations and Episerver server whitelisting ensure high delivery rates
 l Mails comply with formatting standards for email headers and HTML
 l Automatic steering of the optimal sending speed – ensuring that emails are accep-

ted by providers
 l Automatic server switch in case of delivery problems to prevent email loss during 

sending
 l Blacklist monitoring – Episerver's deliverability team constantly monitor the blacklists 

of major providers and takes immediate action if an Episerver IP is accidentally lis-
ted there

 l 24/7 open and click rate monitoring and provider comparisons for messages

Note: The following features are optional. Contact customer sup-
port for more information.

 l Progression analysis of open and click rates in your clients to identify and resolve 
deliverability issues

 l SSL certificate for your sending domain
 l Multiple sending domains for your use
 l Dedicated IP pool for your exclusive use

Security and availability
You benefit from maximum data safety and consistent Episerver software and service 
availability.
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 l ISO 27001 certified by TÜV to guarantee the security of the operation, service, and 
development of the software 

 l Hosted in a Tier IV, high-security data center
 l Redundant server structure
 l Continually updated firewall hardware for blocking hackers
 l SSL-encrypted connections
 l Split-second main database replication
 l Daily data backup
 l Automatic application and service availability monitoring
 l 24/7 system administrator helpline

Recipient management
Systematically collecting and analyzing customer data is key to running effective email 
and omnichannel campaigns. Episerver Campaign comes with a number of options for 
processing different data sources and using these to boost your performance.

 l Easy-to-use list-based recipient management
 l Unlimited number of potential recipients
 l Unlimited number of recipient lists 
 l Recipient list fields in the data types string, integer, float, date and boolean
 l Manual recipient import using standard CSV 
 l Automatic duplicate identification during import
 l Automatic data validation during import (mandatory fields, correct email addresses 

and so on)
 l Download of duplicates and faulty datasets for reviewing and archiving purposes
 l Export complete and filtered recipient lists
 l Integrated subscription process based on  double opt-in or confirmed opt-in emails
 l Tracking-opt-out option that enables recipients to disable personal data tracking in 

accordance with statutory regulations. This does not impact anonymized cam-
paign-specific data tracking.

 l Integrated unsubscribe request management in accordance with statutory reg-
ulations

 l Fully integrated unsubscribe links in mailing templates
 l Records subscriptions, opt-ins, and unsubscribe requests with IP and time stamp for 

your records
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 l Recipient data enrichment with third-party system data, such as web analytics, 
CRM, e-commerce, recommendation engines, and other data sources using high-
performance automated interfaces

 l Recipient history: Entire message history for each recipient in an easy-to-read format, 
including action data (opens and clicks) 

Note: The following features are optional. Contact customer sup-
port for more information.

 l Automatically import and export recipients using FTP protocol and standard CSV file
 l Recipient data encryption
 l Subscription form
 l Preference Center form
 l Delayed subscription confirmation emails
 l Separate recipient list data storage available on request
 l Development of an individual data management concept by Episerver consultants

Blacklist 
Recipients whose email addresses are on the blacklist are no longer sent any mails. This 
also applies if these recipients subscribe to emails again later, even if they do so mul-
tiple times.

 l Client-wide blacklist
 l Blacklist inheritable by sub-clients
 l Manually add recipients to the blacklist
 l Manually import blacklisted recipients from a CSV
 l Search the blacklist for datasets
 l Delete datasets from the blacklist
 l Use of wildcards to block entire domains or email addresses using key words
 l Global blacklist with email addresses that may not be contacted
 l Automatic feedback-loop recognition and addition to blacklist
 l Automatic external blacklist cross-checks via interfaces or linked databases

Responses and bounce management 
Regardless of whether they are hard or soft bounces, or genuine replies, Episerver Cam-
paign automatically filters and processes responses by category.
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 l Integrated response  management with a display function for viewing responses  or 
responses  associated with a specific mailing

 l Automatic response  analysis using more than 150 filter rules
 l Automatic hard bounce, soft bounce, autoresponder, genuine reply/other, sus-

pected spam categorization
 l Create special categories using defined rules, for example, returned emails that 

contain the word order
 l On request, responses from selected categories can be forwarded to freely select-

able email addresses
 l Content display and print function for responses or genuine replies
 l Integrated bounce management divided by hard and soft bounces
 l Recipients are disabled when reaching the specified bounce limit to protect the 

reputation of your mailings
 l Individually adjustable bounce limits for hard and soft bounces
 l Bounce statistics for email and SMS

System user and permission management
As the administrator of your client, you can create new users and define user per-
missions down to the smallest detail.

 l Assign each user up to 214  permissions
 l Easy-to manage user roles
 l Assign permissions and user roles for specific periods
 l Assign each user permissions for every client
 l Assign each user a number of user roles for every client
 l User permissions are inheritable by sub-clients
 l Assign permissions separately for every channel/media type (email, Push, SMS)
 l Password and PIN-protected user logins
 l Users can change passwords

User interface
Smart and intuitive: Easy to use despite its wide variety and depth  of functions.
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 l User interface available in five languages (German, English, French, Dutch and Pol-
ish)

 l Can be accessed from any computer with internet connectivity
 l Supports standard browsers (Internet Explorer/Edge, Firefox, Chrome, Safari) and 

operating systems (Microsoft Windows, macOS)
 l Intuitive buttons
 l Single sign-on for clients
 l Capable of performing features and actions in parallel
 l Users can switch between features
 l Fast response times thanks to innovative technologies (such as AJAX)

Service
Working with Episerver Campaign means benefiting from the advantages of powerful 
and intuitive software, and comprehensive customer service and support services.

 l Expert customer services delivered by project managers, engineers, and strategy-ori-
ented marketing experts

 l Multilingual customer services in German, English and Polish.
 l Helpline team available Mon-Fri, 9 AM - 6 PM CET, by telephone, email and fax
 l Free regular webinars
 l Manuals, specialist documentation, and best practice guides
 l Manuals available offline as PDFs

Note: The following services are optional. Contact customer sup-
port for more information.

 l Full-service campaign package. On request, Episerver offers complete project man-
agement of your newsletter mailing campaign – from creating to analyzing your 
campaign

 l Customized campaign strategies, designs and analyses with Episerver consulting
 l Knowledge transfer in practice-oriented seminars and workshops

https://www.timeanddate.com/time/zones/cet
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Campaigns

This section shows how to create, edit, or test campaigns and send out mailings through 
channels: email, text messages and push messages. It includes the steps involved in put-
ting together one-shot campaigns or a Marketing Automation system.

 l Smart Campaigns. Create, edit, and send one-shot campaigns.
 l Omnichannel campaigns. Special notes for Mobile Push and SMS.
 l Marketing Automation. Automate campaigns.
 l Transactional mails. Set up and edit transactional mails.
 l Confirmations. Manage opt-in emails.
 l Message templates. Create and edit message templates.
 l Sending a split mailing. Set up and execute A/B tests.
 l Send time optimization. Deliver your message at the exact moment when recipients 

open their inbox and read their email.
 l Validate mailing prior to dispatch. Information on the automatic parameter test 

before dispatch.
 l Send automatic notification after dispatch. Information on automatic notification 

after dispatch.
 l Mailings Classic. Information about the classic, one-shot campaign. (This feature is 

deprecated and replaced by functions of Smart Campaigns)

Smart Campaigns

Smart Campaigns is a tool for sending out one-shot-campaigns, such as a monthly news-
letter. In Smart Campaigns, you can send messages via all channels: email,  Mobile Push, 
and SMS.

Use Smart Campaigns to create, start, monitor and evaluate regular campaigns. You 
create and edit these campaigns on a graphic desktop, and access the elements that 
make up a campaign (recipients, target groups, A/B test and the message) from the 
tool list in the left panel.

To use Smart Campaigns, open the start menu and select Campaigns > Smart 
Campaigns.



© Episerver 2020

120 | Episerver Campaign User Guide 2020-04-23

A list of Smart Campaigns appears in the top half of the window. The Status column 
shows whether a campaign was activated or sent. The lower half of the screen displays 
the selected campaign.

Because a Smart Campaign's elements and parameters are displayed visually, you can 
easily control and optimize it. After you activate a campaign,  the Smart Campaigns 
working area displays feedback on it.

Campaigns and messages
Every Smart Campaign must have at least one message. Both campaigns and mes-
sages appear in the Campaign Overview in the Smart Campaigns window. A message 
begins with three dots (...) and is located below its campaign. The following conditions 
and relationships apply:

 l A message must belong to a campaign.
 l To send a campaign, you must include a message.
 l A message's media type (email or SMS) must match its campaign's media type.
 l If your campaign uses the A/B test (split test) node, you must create two versions of 

the message. See Sending a split mailing.
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Campaign type
You can select from the following campaign types, each of which is sent via different 
channels. A Smart Campaign's recipient list must be compatible with its delivery chan-
nel.

 l Email. Sends email to recipient of type Email or a multiple list.
 l SMS. Sends SMS message to recipient of type SMS or a multiple list.
 l Mobile Push. Sends push messages to the Android or iOS device to a recipient of 

type Push or a multiple list.

Campaign status
 l Incomplete. Elements are missing or necessary parameters are not defined. You can-

not activate or start a campaign in this status.
 l Activation required. Contains necessary elements and parameters. To send cam-

paigns manually, activate the campaign before starting it.
 l Activated. The campaign is activated and can be started (sent). Campaigns with a 

specified sending time are sent automatically when activated. 
 l Sending. A campaign 's messages are being sent.
 l Paused. The sending process is paused manually, or the splits of an A/B test with 

manual optimization are ended. Click Start to restart the campaign or Cancel to 
end it.

 l Canceled. The campaign is canceled and cannot be restarted.
 l Sent. The campaign is sent.

Actions
Use the buttons below the campaign overview to perform these actions:

 l Create
 l Copy
 l Edit
 l Delete
 l Start/Activate
 l Copy to client
 l Analysis

Note: Some  actions are not available for incomplete or sent 
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campaigns. 

Create
Creates a new campaign. See Creating and editing a campaign.

Copy
 1. Click on a campaign in the list.
 2. Click Copy.

Use Copy if you regularly send similar campaigns. You can quickly make minor adjust-
ments to values in the copied campaign. Campaign elements (recipients, target 
groups, messages, and so on) are applied.

Note: Limitations

 l Individual messages in the list cannot be copied.
 l Messages are not stand-alone; they belong to a campaign.
 l You can reuse messages by selecting a message in the Selecting the type 

of content step.

Note: To migrate Mailings Classic mailings to Smart Campaigns, see 
Mailings Classic.

Edit
To edit a campaign:

 1. Click on a campaign in the list.
 2. Click Edit.

See also Creating and editing a campaign.

To edit a message:

 1. Click on a message in the list. 
 2. Click Edit.



© Episerver 2020

Campaigns | 123

Note: Limitations

 l Sent campaigns cannot be edited.
 l Individual messages cannot be copied.
 l Messages  belong to a campaign.

Delete
To delete a campaign:

 1. Click on a campaign in the list.
 2. Click Delete.

To delete a message:

 1. Click the campaign to which the message belongs. 
 2. Click Edit.

 3. Hover over the message node and click .

Note: Limitations

 l Sent campaigns cannot be deleted.
 l Individual messages cannot be deleted.
 l Messages belong to a campaign.

Start/Activate
After a campaign is completely defined, its status changes to Activation required, and 
the Activate button appears. 

Before you can start a campaign, you first need to activate it. 

 1. Select the campaign and click Activate.

Warning: After you activate a campaign, messages linked to a 
Wait node are automatically started at the specified time.
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 2. Click Activate campaign in the dialog box. The button changes to Start. 

Tip: When activated, the campaign is validated along with 
parameters (recipients, target groups, message).

 3. Click Start to begin sending a campaign's messages  with the specified parameters 
(target groups, reductions in sending speed, and so on).

 l You can activate campaigns only, not messages.
 l Incomplete campaigns cannot be activated or started.
 l You can start either a campaign or its associated messages.

A/B tests on starting/activating a campaign

If a campaign includes an A/B test, you will be able to start the splits for this campaign 
individually.

If you have selected the Start optimization manually option in the A/B test, then select all 
campaign splits after the campaign has been sent, and then click Optimize to send the 
optimized message to the rest of the distribution list.

Copy to client

Note: To enable this feature, contact customer support.

Copy campaigns to other clients. Recipient lists and target groups are not transferred to 
the target client.

Note: Prerequisites

 l The registered user must have permission to create mailings in the target 
client.

 l The target clients must have the template used in the campaign that 
you want to copy.

 1. In the Campaign Overview, select the campaign and click Copy to client. The Copy 
campaign to client window opens.

 2. In  the New campaign name in the target client field, enter the name for the copy of 
the campaign in the target client.
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 3. In the Target clients area, select the client to which you want to copy the campaign.

Tip: To select all available target clients, check the box in the 
menu bar.

 4. Click Copy.

Analysis
 1. In the Campaign Overview, click a campaign then Analysis. The Campaign analysis 

window opens.

At the top right, a summary of the campaign is displayed. Additionally, the number 
of recipients is displayed for each individual node.

 2. To update the analysis, click Start new analysis.
 3. To view the Send time optimization overview (additional feature), click the cor-

responding Wait node or A/B test node.

Message preview

To preview a message, click the corresponding message node. The content preview 
opens.

The following options are available in the preview:
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 l . Displays available subject lines. 
 l Target groups. When active, select one or more target groups and click Submit selec-

tion to display only the paragraphs assigned to the selected target groups.

 l  and  . The buttons only become active when you use a target group in at least 
one paragraph.

 o Click   to show the respective assigned target groups in the individual para-
graphs.

 o Click   to deactivate the display of assigned target groups.

If you do not want to enable or disable the display of target groups, but rather just 

the display of a single target group, click the relevant paragraph .

 l Container paragraph. Paragraphs that contain several sub-paragraphs with their own 
target groups are marked in the content preview as container paragraphs. Container 
paragraphs are highlighted with a yellow border.
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Note: The target groups applied in container paragraphs are 
automatically carried over to sub-paragraphs included. If you 
hide target groups in container paragraphs using the button tar-
get groups, not only is the container paragraph hidden, but also 
the sub-paragraphs it contains.

Note: Paragraphs that contain several sub-paragraphs without 
their own target groups are not marked as container paragraphs 
or highlighted in yellow, but instead are displayed with a simple 
gray banner. However, the target groups for these paragraphs 
are also carried over to sub-paragraphs.

 l Recipient selection for personalized view. To display a personalized preview with the 
data of a specific recipient, in the left column, select a recipient list. Then, in the 
right column, select the recipient.
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 l Change view. The tab bar on the upper left border includes the HTML, mobile and 
text message previews. In the HTML preview, the mailing appears as it will later 
appear in the recipients’ inboxes. Under the Mobile tab, you can view the message  
as it appears on mobile devices. The Text tab displays the automatically-generated 
text version of the mailing.

 l Save result as image or Save result as PDF. Click to save the content template as an 
image.

Creating and editing a campaign
This topic describes how to create and edit a campaign in Smart Campaigns. A cam-
paign consists of campaign elements (nodes) that you configure and connect together. 
Also learn how to use campaign drafts.
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Creating a campaign
 1. Open the start menu and select Campaigns > Smart Campaigns.            
 2. Click Create.

 3. In the Select campaign draft window, in the Draft drop-down list:

 l To create a new campaign, click ---Empty draft--- then Apply.
 l To edit an existing draft, select one from the drop-down list and click Apply.

 4. Drag the nodes from the left action area to the working area on the right. See Edit-
ing nodes.

 5. Click  Save or Save and close.
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 6. In the dialog box, enter a name for the campaign and click Save.

If you neglect to insert elements or parameters, a notification appears. To save the 
campaign anyway and complete the missing details later, click Force save, or  Keep 
editing and complete the missing details. The new campaign is displayed in the 
Smart Campaigns overview.               

Editing a campaign
To edit an existing campaign, select the required campaign from the list   in the Cam-
paigns window and click Edit. Proceed as described from step 4 in the Creating a cam-
paign section.

Editing nodes
The campaign modules for Smart Campaigns are called nodes, and they appear in the 
left action area. 
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Required elements: 

 l  Recipients

 l  Message (Email, SMS,  or Mobile Push)

Optional elements: 

 l  Wait

 l  Block

 l  Throttle

 l  Limit

 l  Segment

 l  Target groups

 l  A/B test

Tip: For details, see Smart Campaign nodes and elements.

Editing options for nodes and connections include:
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 l Insert. Drag and drop a node to the working area.

 l Connect. Click the node and draw a connection to the target node. Each node has 
connection points at the right, left, upper, and lower side and in the middle.

Note: A campaign node must connect other nodes.
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 l Delete. Hover over the item and click . Alternatively,  select the item and press 
[Del].
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 l Properties. Hover over the  item and click . Alternatively, double click the item.

Editing tools

 l  Undo (CTRL + Z) . Revoke the last action. Every additional click revokes another 
action.

 l  Redo (CTRL + Y). Restore previously-revoked action. Every additional click restores 
another action.

 l  Cut (CTRL + X). Cut out selected items and temporarily copy them to the clip-
board.

 l  Copy (CTRL + C). Copy selected items to the clipboard.

 l  Paste (CTRL + V). Insert elements you previously cut out or copied.
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Navigating tools

 l  Zoom in. Zoom in the working area. Each click magnifies the working area to the 
next zoom level.

 l  Zoom out. Zoom out the working area. Each click reduces the working area to 
the next zoom level.

 l  Actual size. Restore original view.

 l  Fit on screen (Show all). Display all items in the working area.
 l Minimap. Navigate a campaign by dragging the yellow rectangle in the left action 

area to the place you want to go to. To zoom in or out of the working area using the 
minimap, click and drag the bottom right corner of the yellow rectangle either to 
the left (zoom in) or right (zoom out).

Campaign drafts
When you create or edit a Smart Campaigns, a draft version is saved periodically. If the 
campaign is closed unintentionally, you can retrieve the latest version. To do that, click 
Create and select the draft from the Select campaign draft window.

Note: Drafts are saved with the date and time. You can use the 
timestamp to find even unnamed campaigns that have not been 
manually saved.

Smart Campaigns nodes
This topic describes required and optional elements in Smart Campaigns. Nodes define 
those elements and transfer them to the connected node. By connecting nodes in a 
logical manner, you define the sequence of activities that make up a campaign. 

For example, use the Recipients node to select one or more recipient lists and transfer 
their recipients to the message node. When you start the campaign, this message is 
sent to the transferred recipients.

Grayed out node
A node may be grayed out for several reasons.
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 l A campaign already used one media type. For example, if you drag an Email node 
to the desktop, the Print and SMS nodes  are deactivated.

 l You already used that node type. The Recipients, Limit, Target groups and A/B test 
nodes can only be used once per campaign.

 l You lack permissions. For example, you have permission to send email campaigns 
but not SMS campaigns.

 l The media type is not configured in your client.

Required elements
A campaign must include a Recipients node and a message node (Email, SMS, Mobile 
Push), before you can start it.

 Recipients

Parameter Description

Recipient lists

Select one or more recipient lists to which to send the messages.                        

Note: The recipient list type must be compatible with 
the message type  being sent. For example, you can 
only send a print message to a print recipient list (or a 
multiple recipient list).

 Email

Parameter Description

Name Enter a name for the message. This name is only used internally.

Description Enter an optional message description.

Edit con-
tent

Click to add content, then perform the steps described in Editing message content.

Test email
 1. Click to start a test dispatch. The Send test message window opens.
 2. In the Recipient list drop-down list, select a list with test recipients.
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Parameter Description

 3. If you want to simulate a target group, select a target group in the Simulate tar-
get group drop-down list.        

Note: The test recipients selected in the next step can 
also belong to other target groups.

 4. In the list, select one or more test recipients.
 5. Click Send email to send the test messages in multi-part format, or click Send 

HTML version or Send text version if you want to test only one format.

 SMS

For more information, see SMS.

Parameter Description

Name Enter an internal name for the message.

Description Enter an optional message description.

Edit content Click to add content, then perform the steps described in Editing message content.

Test SMS

 1. Click this button to start a test dispatch. The Send test SMS window opens.
 2. In the Recipient list drop-down list, select a recipient list with test recipients.
 3. In the list, select one or more test recipients.
 4. Click Send SMS to start the test dispatch.

 Mobile Push

For more information, see Mobile Push.

Parameter Description

Name Enter an internal name for the message.

Description Enter an optional message description.
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Parameter Description

Edit content
Click to add content, then perform the steps described in Editing message 
content.

Mobile Push test mes-
sage

 1. Click this button to start a test dispatch. The Send test message win-
dow opens.

 2. In the Recipient list drop-down list, select a recipient list with test 
recipients.

 3. In the list, select one  to five test recipients.
 4. Click Send push message to start the test dispatch.

Tip: Um sicherzustellen, dass Ihr Print-Mailing alle Voraussetzungen 
für den maschinenlesbaren Versand erfüllt, gehen Sie wie folgt vor:

 1. Erstellen Sie im Fenster Inhalt bearbeiten mithilfe der Schaltflächen Brief 
DIN A4 (PDF), Postkarte DIN A6 (PDF), Postkarte DIN lang (PDF), Postkarte DIN 
lang im Umschlag (PDF) oder Postkarte Maxi (PDF) eine Test-PDF-Variante 
Ihres Briefes, die Sie testweise ausdrucken können. So können Sie vor 
dem Versand das Layout Ihres Briefes testen.    

Warning: Der Testdruck ist nicht geeignet, um die 
Farbwiedergabe und Haptik des fertigen 
Druckerzeugnisses zu beurteilen. Randloser Druck 
von Hintergrundgrafiken ist mit üblichen Druckern 
nicht möglich.
Wenn Sie z. B. Postkarten mit ganzflächigen Hin-
tergrundbildern im Testdruck ausdrucken, entsteht 
dabei in der Regel ein Rand und die Größe des Aus-
drucks wird an die Papiergröße abzüglich des 
Randes angepasst.

 2. Führen Sie immer einen Testversand durch, um sicherzustellen, dass ein 
Print-Mailing auch tatsächlich zugestellt werden kann und um das fertige 
Druckergebnis zu begutachten.

Optional elements
You can include the following elements in a campaign.
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 l Wait
 l Block
 l Throttle
 l Limit
 l Segment
 l Target groups
 l A/B test

 Wait

Specifies a message's start time. You can manually activate a campaign containing a 
Wait node. If you do, the messages are sent at the specified time.

Note: Limitations

 l Wait is not available for transactional mails or confirmations.

Tip: Use Wait in combination with an A/B test to define the sending 
time of each split.

Parameter Description

Wait until... Specify the date on which a message or split is sent.

at ... Specify the time when a message or split is sent.

Wait until import has 
finished

If you are using the closed-loop interface, activate this option to send the 
messages after the recipient import.                         

Note: If you enable this option, do not activate the 
campaign.

Start at ... after 
import has been fin-
ished

If you are using the closed-loop interface, activate this option to send the 
messages after the recipient import at the time specified here.                        

Note: If you enable this option, do not activate the 
campaign.
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Note: If you use Send time optimization, you must also specify a Wait 
option in the Send date area as a time reference point. Also, the 
fallback time is determined for recipients for whom there is not 
enough behavioral data to determine an optimal send time. See 
Configuring send time optimization in the Wait node. 

Parameter Description

Send time optimization
Select the check box to enable automatic send time optim-
ization.

24 hours/7 days (only when the selec-
ted wait option is Wait until ...)

Select the period of time during which the send time can 
be optimized.

Date slider
Use the date slider or the arrow keys to change the start 
and end times of the send time optimization.

 Block

Note: Limitations

 l Block is not available for confirmations.
 l Block is only available for email.
 l Block only works with custom blacklists. 

Suspend recipients on custom blacklists from a mailing. Place the Block node in your 
campaign and click Properties  . Then, select one or more custom blacklists from the 
drop-down list. The recipients on those blacklists will not get a message.

 Throttle

Note: Throttle is not available for transactional mails,  or confirmations.

Specify the dispatch rate. Sometimes you should select a lower dispatch rate, such as 
when you send a coupon in email. Unless you reduce the dispatch rate, your online 
shop may get overloaded.
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Parameter Description

Decrease the dis-
patch rate

Specify the dispatch rate per hour for messages. The lowest rate is 1000 
messages per hour.

 Limit

Note: Limit is not available for transactional mails or confirmations.

Specify how many recipients (percentage or absolute value) you want to contact. 
Place the Limit element in front of the message node.

Parameter Description

Percent

Specify the percentage (1 to 100) of recipients to be contacted. The number of recip-
ients is calculated on the global number of recipients from recipients lists selected in 
the Recipients node (=100 %). Other limiting elements, like target groups, are not con-
sidered.

Recipients
Specify the actual number (absolute value) of recipients to be contacted.      If this value 
is higher than the number of possible recipients, all recipients are contacted.

 Segment

Note: Limitations

 l This node is not available for transactional mails or confirmations.
 l To make Visitor Intelligence segments available in Episerver Campaign, 

you first have to create segments in Episerver Visitor Intelligence 
(formerly Episerver Insight). See Creating a marketing segment.

Use marketing segments from Episerver Visitor Intelligence as a target group for your 
campaign.

To add an Visitor Intelligence segment to your campaign, drag and drop the Segment 
node onto the desktop. To edit this node, click Properties   and select the desired seg-
ment from the drop-down list.
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 Target groups

Note: Target groups is not available for transactional mails or con-
firmations.

Limit the selection of recipients based on additional criteria (see Target group 
definition). Place Target groups between the Recipients node and the Messages node. 

Target groups contains no additional parameters. To specify a target group, create an 
outgoing connection, click it, and define a target group or select an existing one.

Parameter Description

Target 
group

Enter an internal name for the target group and the target group definition. See Target 
group definition.

 A/B test

Optimize the dispatch of your message. In an A/B test, two variants (A and B) of an 
email are sent, which differ in a factor (such as the subject line). By comparing key fig-
ures (such as the opening rate when testing the subject line), you can  determine which 
variant worked better. See Sending a split mailing.

Note: Limitations

 l A/B test is not available for transactional mails, confirmations or print mes-
sages.

 l If you add an A/B test to the campaign, you must create at least two ver-
sions of the message. The more successful version (automatically selec-
ted by one of these criteria – open, click, bounce or unsubscribe rate, or 
revenue, or manually selected) is sent.

You configure the A/B test in two steps:
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 1. Activate automatic optimization in the A/B test node.

Parameter Description

Activate 
automatic 
optimization

Enable to select the most successful message in the splits based on one of 
the criteria in the following line.

Type of 
optimization

Select one.

 l Best effective click rate. Sends message with best ratio of unique open-
ings to unique clicks.        

 l Best unique click rate. Sends message that generated the highest per-
centage of clicks from individual recipients.        

 l Best unique open rate. Sends message  opened by highest percentage 
of recipients.        

 l Lowest unique unsubscribe rate. Sends message that generated the low-
est percentage of unsubscriptions from individual recipients.        

 l Lowest bounce rate. Sends message that generated the lowest per-
centage of return messages.        

 l Highest turnover. Sends message that generated the most turnover. 

Note: This option is only available if you are using 
Post-click tracking, or either web analytics or e-com-
merce integrations.

Sending 
date for the 
optimized 
message

If you activated the automatic optimization function, select an option to trig-
ger the sending of the optimized message to the rest of the recipients.

 l Date and time. Send your optimized message at a specified time; for 
example,  you always send messages at 3 PM on Thursdays, and your 
recipients are used to receiving your messages at this time.

 l Delay after last split. Ensure that your recipients have enough time to 
open a message and to click the links (regardless of when you start the 
optimization). You can draw conclusions from this for the optimization of 
your campaign. For example, if your recipients read a message and 
click links in the first two days following receipt.

 l Manual. Send the optimized message when you want. Then, once splits 
are complete, click Optimize to start the optimization process in the 
Campaigns window.

 2. Create the split mailings and connect them with the A/B test node.

A/B test also lets you branch the path of your campaign. For example, to send dif-
ferent messages to different target groups.
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Parameter Description

Priority
Specify to which target group is to be sent first. The branches are processed 
hierarchically. The branch with the lowest number has the highest priority and 
is executed first.

Number of 
recipients

Specify the number of recipients to which the connected split is to be sent:

 l Percent. Specify the percentage of recipients to be contacted.
 l Recipients. Specify the number of recipients to be contacted.
 l No limit. Do not limit the number of recipients.

Target 
group

Optionally specify which target group is  used by referring to an existing target 
group:

 a. In the box under Target group, enter a name.
 b. In the Target group list on the right, select the desired target group. 

If you create a new target group, define the filters (see Target group defin-
ition).

 c. Click Save target group  . The message is sent only to recipients of the 
selected target group.

 l If you filter a target group by actions over a period of time and set an A/B 
test with different send times, unexpected numbers of recipients may 
occur. Recipients are always calculated at the actual send time of each 
A/B test message.

 l When you use the send time optimization, you must also specify a date 
and time or select the Manual option under Sending date of the optimized 
message. See Configuring send time optimization in the A/B test node.

Editing message content
To configure a message and add content, move the cursor to the message you want to 

edit, click Properties  > Edit content. The Edit content window opens, and you can per-
form the following steps:

 1. Selecting the type of content
 2. Configuring the message
 3. Adjusting layout settings and content
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Step 1. Selecting Content Type

Select the source or template from which you want to create the message:

 l Email
 l SMS
 l Mobile Push

Email

If you edit an email for the first time, select a template:

 1. From the Template drop-down list, select one of these options.

 l New. Creates a message from a template (for example, the Episerver Template 
Kit) or enter your own HTML into the free-text template.

 l Message. Applies content from existing message you select from the list. You 
can select new or sent messages.

 l Message template. Send messages regularly with the same sender number (such 
as "Our offers of the week"). Select the required template from the list. The sub-
ject, sender information and attachments are already configured in the mes-
sage templates. If you select this option, go to Configuring the message. See also 
Message templates.

 2. Click Next.

SMS

To edit an SMS message, see Configuring the message.
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Mobile Push

To edit a Mobile Push message, see Configuring the message.

Step 2. Configuring the message

To send a message, it must be configured. Depending on the selected delivery chan-
nel, you need to define sender information and additional parameters.

Email

 l Sender information

 1. Open the Edit content window. Click Sender, subject, attachments.
 2. Sender area. Enter the name and email address that you want mailing recipients  

to see.
 3. Reply to area. Enter the reply-to name to be displayed  in the recipient's email 

program. 

Tip: You can use field functions to adapt the sender and 
reply-to address to specific values in the recipient list. 
Example: You want customers to reply to the branch of your 
company where they are registered. For more information, 
see field functions.

 l Subject

 o In the Subject area, enter a subject for your message.
 o You can use personalizations in the subject line, and send messages to target 

groups with different subject lines.

 n To create personalized subject lines, click Insert field function  and select 
the required recipient list field or the required field function from the list.

 n To add a target-group-specific subject line, click  Add subject and enter the 
text into the new field. Then, select a target group for whom you want to use 
this subject line. You can add as many additional subject lines and target 
groups as you like.
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 l Attachments

Select one of the following attachments to messages.

 o Attach a previously-uploaded file

 a. Open the Attachments tab. Available attachments are displayed in a list.
 b. Click the file that you want to send.
 c. Click Apply. You attached the selected file to your message. The name and 

size of the file are shown below the message's subject.
 o Upload files from your hard drive

 a. Open the Attachments tab and click New.
 b. Select the option Upload from hard drive if not already selected.
 c. In the Select file area, click Browse....
 d. Go to the file you want to upload and confirm your selection. The File name 

field in the Properties area shows the file name. You can change the file 
name.

 e. In the Properties area, in the Description field, enter a description.
 f. Click Save.

Tip: Episerver Campaign creates a copy of your file. If 
you delete the file from your hard drive, the copy 
remains in Episerver Campaign.

 g. To attach the uploaded file to your message, select it and click Apply.

The file name and size are appear below the message's subject.

 o Link to an externally stored file

 a. Open the Attachments tab and click New.
 b. Select the Use URL option.
 c. In the File selection area, in the URL field, enter the URL that refers to the file.
 d. In the Properties area, in the File name field, enter the file name.
 e. In the Properties area, in the Description field, enter a description.
 f. Click Save. The file to which you linked is displayed in the Attachments area.

 g. To attach the linked file to your message, select the file and click Apply. The 
name and size of the externally stored file appears under your message's sub-
ject. Episerver Campaign loads the linked file from the external source 
shortly before sending and attaching it to your message.
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 l Tracking

Openings and links are tracked as standard in both the HTML and text versions of a 
message. You can apply these settings globally or configure the tracking function 
for each link in a message. To configure the tracking of openings and clicks, follow 
these steps.

 1. In the Edit content window, select More > Edit tracking links.
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 2. To globally deactivate the tracking of opens or clicks, clear the Track opens or 
Track clicks check boxes.

 3. To deactivate the tracking of links for the HTML version or the text version of the 
message, click Tracking disabled next to Default setting for HTML links or Default set-
ting for text links.

 4. To configure tracking for individual links, click the link in the Edit tracking links list 
then Edit link.

 5. In the Track in HTML column, select one of the following options:

 o Default setting. Applies the global settings to this link.
 o Enabled. Activates tracking for this link, even if tracking is globally deac-

tivated.
 o Disabled. Deactivates tracking for this link, even if tracking is globally activ-

ated.

 6. Proceed in the same way in the Track in text column.
 7. Modify the automatically-generated link descriptions in the Description column 

to help decide whether to allocate a link URL to a topic or a landing page.
 8. The Occurrences column indicates how frequently a link appears in the mes-

sage.
 9. You can enter a click profile for this link in the Click profiles column. You can also 

assign click profiles automatically in a rule-based manner.
 10. Click Apply.

Note: Using HSTS

If you use HSTS in your web server (to which the links refer), 
either disable HSTS  in your web browser or create an SSL cer-
tificate.

For this, provide the following information:

 o Domain. The domain (such as, "example.com") for which 
the certificate needs to be created.

 o IT contact person. A contact person from your IT depart-
ment (First name, last name, company name, address, 
postal code, phone number, email address, and fax num-
ber).
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 o Organizational contact person. An organizational contact 
(First name, last name, company name, address, postal 
code, phone number, email address, and fax number).

 o Administrative email address. An email address that you 
use to manage the certificate. An email address that is 
assigned to your domain is required for this purpose. For 
example, if you use the domain "news-
letter.example.com", the email address must be either 
"admin@example.com", "administrator@example.com", 
"hostmaster@example.com", or "web-
master@example.com". Only the local parts "admin", 
"hostmaster", "webmaster" or "administrator" may be 
used.

 l Encoding

Specify the character set with which you want to encode your mailing. In addition 
to standard characters (Latin letters, numbers, punctuation characters), the char-
acter set also includes special characters (such as German umlauts). Characters 
that would be displayed incorrectly or not at all on the recipient's computer can be 
correctly interpreted in this way. To configure the message encoding, follow these 
steps.

 1. At the top right side of the Edit content window, click  More. Then, in the menu, 
click Encoding/Offline HTML.

 2. Select the required character set.

 o ISO-8859-1. For recipients in German-speaking regions, Western European 
countries, and North America.
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 o ISO-8859-2. For recipients in Central/South-Eastern European countries, for 
example in Poland, Croatia or Slovakia.

 o UTF-8. The UTF-8 format supports most of the special characters found in all 
languages. Select this encoding if you are contacting recipients in other 
parts of the world, for example, in Eastern Europe or Turkey.

 3. To complete the encoding configurationClick  Apply.

SMS

 1. If multiple telephone numbers are configured as sender information in your client, in 
the Edit content window, select a number from the Sender number drop-down list. If 
just one sender number is configured, you need not select anything here.

 2. In the Limitation of SMS messages drop-down list, select the maximum number of mes-
sages to be sent to ensure that the content is not longer than the selected limit. You 
receive a warning message if the content exceeds the limit. See also: SMS.

 3. In the Content box, enter the message text.

 4. To enter personalized text, click Insert field function   and select the recipient list 
field or the required field function from the list.

Warning: You can use personalizations to add the name of the 
recipient to the message (for example "Hello John Doe..."). 
When using personalized text, the maximum specified message 
count may be exceeded if the added text (for example, name 
of recipient) is too long. In this case, the message is sent in full, 
but charges may be incurred for more SMS messages per recip-
ient than specified in the setting for the message limit.

 5. Click Save.

Mobile Push

See also: Mobile Push

 1. Title. Enter the title of the push message. To create a personalized title, click Insert 
field functions   and select the required recipient list field or the required field func-
tion from the list.

Note: This title is displayed on Android devices only. iOS devices 
show the name of your app. Nevertheless, enter a title.
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 2. Content Enter the message text. To enter personalized text, click Insert field functions 
 and select the required recipient list field or the required field function from the 

list.
 3. Add an image to be displayed in the push message. You can use the image upload 

or specify an external image URL.

Note: To display images on Apple devices, you must integrate 
the iOS SDK. See Mobile Push iOS integration on Episerver World.

 l Image upload. Upload an image using drag and drop or file upload.

Note: The following formats are supported: .jpg, .png and 
.gif. Maximum file size is 1 MB.

 l External image URL. Enter the URL that points to the image file.
 4. Deep link. Define what should happen after the message is opened, such as  landing 

pages to be opened in your app. Combine several actions such as opening a page 
along with playing a specific sound stored in your app by clicking + to add inform-
ation. To insert personalized deep links, click Insert field functions   and select the 
required field function from the list.

Note: Reserved deep links and prefixes
Do not use the following reserved  deep links:

 l from
 l dry_run
 l restricted_package_name
 l delivery_receipt_requested
 l delay_while_idle
 l content_available
 l message_id
 l notification_key
 l registration_ids

Also, do not use the following prefixes in deep links:

 l google
 l gcm

 5. Expiry date. Define the validity of the message (for example, to promote time-lim-
ited special offers) .

https://world.episerver.com/documentation/developer-guides/campaign/mobile-push/ios-integration/
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 l On. Specify the last date to deliver the message to the recipient's device. After 
this date, the message is not delivered. For example, if you define 2020-03-12 but 
the recipient activates his/her end device on 2020-03-13, the message is not dis-
played on the recipient's device.

 l Non-expiring. Select this option to deliver this message for an unlimited period.

Note: On Android devices, the maximum validity period is 
four weeks.

 6. Preview. Switch between Android and iOS and Banner and Lockscreen to display a 
preview of your message on the respective device.

 7. Click Save.

Step 3. Adjusting layout settings and content

Depending on the selected message type, you can adjust the layout and add 
content elements.

Email

See Edit mailing content. If you are using the Template Kit, see Template Kit.

SMS

In SMS messages, you can only send text-only messages. Enter the text in the Content 
box. See SMS.

Mobile Push

With Mobile Push, you can send messages to mobile devices and trigger predefined 
actions. Enter the text in the Content box and optionally upload an image. See Mobile 
Push.

Omnichannel campaigns

This section contains special notes for the following channels:
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 l SMS
 l Mobile Push

Mobile Push
A Mobile Push message is delivered from a software application to a mobile device, 
and appears on the device without a specific request from the recipient. With Episerver 
Campaign, you can make Mobile Push messages part of your campaign.

 l Automated dispatch through Smart Campaigns and Marketing Automation.
 l Customize Mobile Push messages by setting time limits and fields for individual tar-

get links. See Configuring a Mobile Push message.
 l Add an image and personalize the Mobile Push message by using field functions.
 l Integrated preview function.
 l Episerver Campaign integrations for Mobile Push are available for Android and iOS 

operating systems.

For information on setting up Mobile Push, see Episerver World.

SMS
Mobile marketing offers high potential for reaching new target groups. with Episerver 
SMS, you can prominently reach customers on their mobile devices. 

In most countries where this is possible, Episerver SMS uses direct routes to network oper-
ators and offers exceptional quality, speed, and availability. Thus, Episerver SMS is suited 
to the delivery of transactional and commercial messages. 

Send appointments, PINs, billing, delivery or order information directly to your cus-
tomer's SMS inbox, for example, the latest personal and customized special offers. For 
interactive direct communication with customers, use it to receive incoming SMS. 
Episerver's portfolio includes generation of short codes and standard numbers for two-
way, mobile customer communication.

A personalized message is possible at all times. For effective international SMS com-
munication, Episerver supports relative character sets and data formats, which support 
country-specific characters.

Note: The sending of SMS messages requires a special opt-in.

http://world.episerver.com/documentation/developer-guides/campaign/mobile-push/
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Text length and number of characters
SMS messages are pure text messages. The maximum number of characters per mes-
sage depends on the coding and special characters. Modern mobile phones can 
receive SMS messages which are too long (concatenated SMS) with no problem, and 
display these as a single message. 

GSM character set
The GSM 7-Bit default alphabet was developed for sending and receiving SMS via the cel-
lular mobile network. This standard contains a simple character set for sending SMS mes-
sages of up to 160 characters. The following characters are available:

"#$%&'()*+,-./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz_
¡£¤¥§¿ÄÅÆÇÉÑÖØÜßàäåæèéìñòöøùü

...plus the following non-visible characters:

 l space
 l new-line
 l carriage return

The GSM standard character set includes an extension. Each character in the extension 
requires two characters:

^[]{}\|€~

UCS2 character set
The sending of SMS via Episerver Campaign also supports the UCS2 character set. This 
set covers most modern languages, as defined in International Standard ISO/IEC 10646. 
See Universal Coded Character Set.

Note: When UCS2 is used, an SMS message cannot exceed 70 char-
acters because each character requires 16-bits; more than double 
the storage required by a character in the GSM 7-bit default alpha-
bet.

https://en.wikipedia.org/wiki/GSM_03.38
https://en.wikipedia.org/wiki/Universal_Coded_Character_Set
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Determining which character set is used 
The characters in an SMS message determine if it is GSM-coded (7-bit) or UCS-coded 
(16-bit). Each SMS can have only one encoding, which is performed automatically. If an 
SMS uses one 16-bit encoded character, the entire message is 16-bit encoded, even if 
other characters can be encoded using 7-bit.

Country-specific features
The sending of SMS, subject to country-specific regulations, primarily includes these 
functions:

 l Sender identifier
 l Sending length (multi-part) SMS
 l Supported character sets

Moreover, as the customer, you are likewise subject to restrictions which vary by coun-
try. For example, you must comply with country-specific regulations on consent to 
advertising, privacy and competition regulations. 

Note: Limitations

 l Episerver does not support the delivery of binary content, such as ring-
tones or images.

 l Episerver does not support certain mechanisms in language tables for Por-
tuguese, Turkish, Bengali and Hindi, the locking-shift or single-shift tables 
in GSM standard.

 l Not every character is available in every country.
 l In some countries, the characters used are restricted by law or network 

operators. Moreover, especially among discount telephone operators, 
the characters in an SMS may not be delivered correctly. This can lead to 
display errors.

Multipart SMS (concatenated SMS)
You can send a message with more than 160 or 70 characters (depending on character 
set), but the text is sent as multiple, individual SMS messages. Modern devices may dis-
play these SMS messages as a single SMS. The previous procedure corresponds to the 
GSM protocol Concatenated SMS. For longer texts, several individual SMS messages are 
used and counted for billing purposes.
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The maximum number of characters per SMS is reduced for concatenated SMS mes-
sages. Thus, only 153 or 67 characters (respectively) per SMS are available. The max-
imum lengths appear in the following table:

SMS encod-
ing

max char-
acters per 1 

message

max char-
acters per 2 
messages

max char-
acters per 3 
messages

max char-
acters per 4 
messages

each addi-
tional

GSM 7-bit 
(default 
alphabet)

160 306 459 612
each plus 
153 char-
acters

UCS2 70 134 201 268
each plus 
67 char-
acters

Note: Recommended maximum number of characters
Do not send more than 10 SMS messages 1,530 characters) for a 
Concatenated SMS. If you send more than 10 SMS, or 1,530 char-
acters, a multiple part message may not be sent or received cor-
rectly.

Note: Field functions and placeholders in SMS
If you use field functions and placeholders in an SMS message, the 
text length of the SMS sent cannot be calculated in advance.  If 
placeholder text is replaced by personalized content (for 
example, the recipient name), SMS messages may become multi-
part messages and incur higher costs. So, before sending, check 
how many characters are included in your datasets and how long 
an SMS can be. You can also read the example in the Per-
sonalizations section.

Checking costs

Billing is calculated per SMS sent. For example, for a two-part SMS mailing, two text mes-
sages (SMS) are billed per recipient.

For a cost overview, Episerver Campaign lets you enter the number of SMS messages – 
and thus the maximum number of characters – you want to send. If the text is too long 
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for the selected setting (for example, 160 characters (1 part)), an error message is dis-
played.

Sender identification
SMS is implemented based on phone provider. In addition to telephone numbers, you 
can use up to 11 alphanumeric character strings as sender identification.  with Episerver 
SMS, you can use the following sender identification formats:

 l Alphanumeric sender identification. String of letter and number characters. The 
sender identification must begin with a letter. Avoid the use of umlauts and special 
characters. Alphanumeric sender identifications can only be used to send (not 
receive) SMS. 

 l Exclusive short codes. Short sequences of numbers, for example 23232, for direct two-
way customer communication. See German Federal Telecommunication Network 
Agency (Bundesnetzagentur) for the short code format  for Germany. You can use 
exclusive short codes only within the country where they were assigned. Inter-
national routing is not possible.

 l Non-exclusive short code. A short code is simultaneously used by multiple service pro-
viders. You may provide keywords for response capability. You receive only for-
warded messages that contain the keyword you provided.

 l Long code. A long code is a customary mobile number that you can route inter-
nationally. For example, +4915112345678. The advantages of a standard number are 
cost and international usability.

Personalizing messages
You can insert placeholders for recipient list fields (such as "Hello {first name}!") or field 
functions (for example, salutation logic) into SMS messages. Upon delivery, these are 
replaced by the corresponding name (such as Hello Andrea!) or salutation format (Dear 
Mr. Miller). 

If you use placeholders or field functions, the display of used/remaining characters can-
not provide precise results. This is because Episerver Campaign can only determine mes-
sage length after the placeholder or field function is replaced by the individual value, 
which occurs directly after sending. So, a message intended to be sent as a single SMS 
might be divided into two messages, which results in higher delivery charges.

Example

The following message contains a placeholder for the recipient 's first name and has 163 
characters:

http://www.bundesnetzagentur.de/cln_1432/DE/Sachgebiete/Telekommunikation/Unternehmen_Institutionen/Nummerierung/TechnischeNummern/KWNummernMobilfunk/KWNummernMobilfunk.html
http://www.bundesnetzagentur.de/cln_1432/DE/Sachgebiete/Telekommunikation/Unternehmen_Institutionen/Nummerierung/TechnischeNummern/KWNummernMobilfunk/KWNummernMobilfunk.html
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Hello {firstname}! Have you checked out our current holiday deals
 at www.example.com yet? They are only available today (before 
 midnight) in our online shop. Act fast!

When sending, the placeholder is replaced with the recipient’s name, and could look 
like this:

1) Hello Max! Take a look at our current holiday deals at www.example.com! Only avail-
able today (before midnight) in our online shop. Act fast!

2)Hello Maximilian! Take a look at our current holiday deals at www.example.com! Only 
available today (before midnight) in our online shop. Act fast!

In the first example, the sent message has 145 characters and is sent as a single SMS. In 
the second example, the message has 162 characters and is divided into two SMS mes-
sages, so two SMS messages are billed.

Analyzing bounces
You can analyze bounces from SMS recipients. A bounce is generated when:

 l the mobile phone is switched off or unreachable during dispatch
 l the mobile phone's inbox is full
 l the number is invalid or no longer in use

Blocking numbers with a blacklist
If you want to send SMS mailings via your client, the client's blacklist is adjusted accord-
ingly. You can block complete numbers or specific parts of numbers (such as area 
codes). You should block satellite phone numbers, because the cost for such a mes-
sage is substantially more expensive (more than 1 euro per SMS). 

SMS processes
SMS processes enable your customers to request or stop a service by sending an SMS 
with a predefined keyword. For example, your customers can send an SMS with the 
keyword Help to request help or Stop to unsubscribe from promotional SMS. For more 
information, see SMS processes.
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SMS processes

SMS processes enable your customers to request or stop a service by sending an SMS 
with a predefined keyword. For example, your customers can send an SMS with the 
keyword Help to request help or Stop to unsubscribe from promotional SMS.

Prerequisites

To use SMS processes, you need one or more inbound numbers. Inbound numbers are 
telephone numbers or short codes that forward incoming messages to a target system. 
To set up an inbound number at a telephone provider and configure it for your clients, 
contact customer support.

You can choose from up to three types of inbound numbers depending on the country 
you are in:

 l Long code. A customary mobile number, for example +4915112348765. 
 l Exclusive short codes. A short sequence of numbers, for example  11221 .
 l Non-exclusive short code.  A short code that you can use for several clients (shared 

code). The telephone provider assigns several provider keywords to a short code, for 
example 11221 / kids and 11221 / baby. Depending on the provider keyword, SMS 
are delivered to different Episerver Campaign clients.

Note: For non-exclusive short codes, senders must enter in the 
SMS both the provider keyword and the service keyword , e.g. 
baby stop. 

  For further information about the different code types, see the chapter SMS under Sender 
identification.

Note: Depending on the type of inbound number selected, the 
costs for setup and operation by the telephone provider vary.

Tip: In some countries you have to purchase inbound numbers your-
self. If you are a resident of the USA, you can obtain inbound num-
bers from the website https://usshortcodes.com/.

https://usshortcodes.com/


© Episerver 2020

Campaigns | 161

SMS process overview

To open the SMS process overview, open the start menu  and select Administration > SMS 
processes.

In the SMS process overview you can find information about all created SMS processes, 
such as process type, name and mailing ID. You can also view the current status of each 
SMS process:

 l New. A new process that has not yet been started.
 l Started. The process has been started and is running.

Note: If you edit a started process and click Save and Close, your 
changes are immediately applied to the running process.

 l Paused. The process was paused and is not running.
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SMS process actions

Note: Some actions are not available for new or incomplete SMS 
processes.

 l Create. Create a new SMS process. See Creating an SMS process.
 l Edit. Edit an  SMS process. See Editing an SMS process.
 l Delete. Delete an SMS process to permanently remove it.
 l Start. Start an SMS process. The process changes its status to Started and is running.  

Inbound SMS from your customers can then be covered by the SMS process.
 l Pause. Pause an SMS process. Your customers' inbound SMS messages are then no 

longer covered by the process. You can restart paused SMS processes at any time.
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Creating an SMS process

 1. Click Create in the SMS process overview. The Create SMS Process window opens.       

 2. Select one of the following process types from the Type drop-down list:

 l Unsubscribe. The sender is added to the internal unsubscribe list for the SMS chan-
nel and no longer receives advertising SMS.

 l Help. The sender receives the message that you select under Message.

Note: You can only create one unsubscribe and one help  SMS 
process for each inbound number / provider keyword. This is to 
ensure a distinct assignment for every SMS process.

 3. Enter an internal name for the SMS process under Name. 
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 4. Select an inbound number from the Inbound Number / Provider Keyword drop-down 
list. If you use a non-exclusive inbound number, the keyword assigned by the pro-
vider will also be displayed (e.g. 11221 / Baby).

 5. Optional: Under Custom keywords, enter a keyword that is to be added to the pre-
defined default keywords. Click the Add button to add the new keyword.

Note: Custom keywords must not contain numbers, special char-
acters or spaces.

 6. Under Message, select the message to be sent automatically to the sender of the 
inbound SMS. To do this, create a transaction mail of type SMS. See Transactional 
Mails.

Note: The sending of a message is mandatory for SMS processes 
of type Help, optional for processes of type Unsubscribe.

Warning: Depending on the country of the recipient, sending a 
confirmation SMS after successful unsubscription is either man-
datory, optional or even prohibited.  Before starting an unsub-
scribe process, inform yourself about the respective country 
regulations and separate SMS processes according to the des-
tination country.

 7. Click Save and Close.
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Editing an SMS process

 1. Select an SMS process and click Edit.

 2. Modify the SMS process as described in Creating an SMS Process.

Marketing Automation

Develop multi-step campaigns with action- and event-based mailings;  perfectly adap-
ted to a highly diverse set of target groups using fully automated distribution cycles. You 
can create campaigns  based on your customer database, then refine them once the 
campaign is up and running. You have access to the entire platform, so you can con-
centrate on the ad message design.

 l Lifecycle marketing made easy via drag and drop.
 l Sustainable, automated cultivation of customer relations.
 l Effective dialog marketing through customized triggered emails.
 l Higher revenues through automated cross and upselling campaigns.

To create and manage Marketing Automation campaigns, open the start menu and 
select Campaigns > Marketing Automation.
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Marketing Automation campaigns for a better customer 
engagement
Using Episerver's Marketing Automation, it’s easy to analyze potential customers, pro-
motions, and your customer contact histories then incorporate that information into 
your campaigns. Optimize your customer dialog through a process that lets you 
improve and refine your marketing strategy. Information gathered during a campaign 
can be used to augment an existing database. This, in turn, lets you more accurately 
define segments then roll out more finely-tuned campaigns.
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Campaign examples
 l Welcome mailings. Welcome new subscribers through targeted welcome mailings. 

These are based on a multi-stage campaign aimed to introduce potential pur-
chasers to your brand and what it has to offer. First impressions are very important in 
campaigns of this kind. It’s an ideal phase for introducing your line of products and 
opening a dialog. Ask new subscriber to complete their data and to enter their 
interests and preferences. In this way, you know early on whether an addressee 
would be interested in special promotional offers. And the Preference Center (pro-
file self-administration) lets you inquire whether the subscriber prefers to be con-
tacted on a weekly or monthly basis. Under certain circumstances, it may be 
worthwhile to include a sweepstakes mailing as part of the series of welcome mail-
ings – to turn an interested consumer into a new customer.

 l Trigger and transactional mails. Trigger mails  help nurture existing customer rela-
tionships, ensure consistent sales, and initiate new customer relationships. Dis-
tribution is triggered by a special event relating to the subscriber – with Episerver 
Campaign automatically sending out trigger mails according to predefined criteria 
or at a specified point-in-time. In campaigns created with Marketing Automation, 
each node through which mailings are sent is a trigger mail. This provides a simple 
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tool for automatically contacting customers individually under a variety of scen-
arios. Transactional mails, on the other hand, are emails sent out subsequent to an 
order, a purchase, or similar customer action (transactions). See also Triggers in the 
Triggers User Guide.

If you use post-click tracking, you can use Episerver's Marketing Automation to send 
transactional mails. See also Post-click tracking.

 l Cross and upselling offers. Product recommendations offer enormous potential. 
These mailings are prompted by a purchase, a registration or similar action, with 
contents automatically adapted accordingly. The goal is to encourage follow-up 
purchases, the purchase of higher-quality and higher-priced goods, or a wider vari-
ety of purchasing choices. Cross- and upselling recommendations are made avail-
able through a database and content interface or via established web-analysis 
software in Episerver Campaign.

 l Customer care. Establish an ongoing dialog with regular customers through a pro-
active approach to customer care that goes beyond regular communications. You 
can measure customer satisfaction, for instance, by means of statistical analyses 
based on scorings. Ideally, this lets you predict the likelihood of cancellation on a 
case-by-case basis. Specially incentivised customer-binding mails are sent when cer-
tain tolerance limits are exceeded. Concurrently, you can also include targeted 
customer satisfaction surveys that solicit suggestions on how to improve your ser-
vices. 

Also, be sure to closely track changes to customer status. If a customer has a 
change of address, for example, you can send a mailing with information and pro-
motions tailored to the new location. If you know your customer's age, select mail-
ings with content appropriate to his or her age-bracket. React to the first signs of 
inactivity by inquiring whether the customer elects to suspend mailings for a time or 
prefers receiving them less frequently. Contact Episerver with any requests.

 l Reactivation. Reactivation by email is an important component of effective life-
cycle marketing. Successful reactivation depends on the effective monitoring of 
subscribers. Early detection of sagging interest or excessive contact frequency helps 
to avoid customer inactivity and, ultimately, customer withdrawal.

First, define at what point a customer is to be considered inactive. Set a timeframe 
to indicate when a customer fails to open or click your emails to determine his or 
her status. Possible indicators include not only failure to open or click mails but also 
a failure to log in to user accounts and communities, or user data not being 
updated. The timeframe you employ depends on the natural lifespan of your 
products, services and promotions. Successful re-activations are normally the result 
of multi-stage campaigns. For example, you may want to request that the 
addressee update his or her customer information. Those who click the link receive 
a shopping coupon. And you can incentivise addressees who did not respond your 
first email by sending a second one.
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Tip: Marketing Automation guide
See helpful information, tips, tricks, and examples for successful 
Marketing Automation campaigns in Marketing Automation guide.

Marketing Automation packages (only DACH)

Note: The various Marketing Automation packages are only avail-
able for customers in the DACH region. For non-DACH customers, 
all services of the Ultimate package are available.

Episerver's Marketing Automation contains three packages. If a node is grayed out 
(deactivated) when creating or editing a campaign or you cannot add nodes to a 
campaign, you have not licensed that package. To upgrade your package, contact 
customer support.

 l Starter package. Contains everything you need to set up the most relevant cam-
paigns using Marketing Automation (for example, welcome message series, birth-
day mailing, reactivation campaign). A maximum of 50 start or branching points 
(nodes) can be in use per client.

 l Advanced package. Includes the Starter package plus the following services:

 o Up to 250 start or branching points (nodes).
 o Using the A/B test node, you can split campaign recipients  by percentage then 

distribute them to various mailing routes, allowing you to easily optimize your 
campaign.

 o Using the Change recipient, Copy recipient and Move recipient nodes, you can 
change the recipients' data and copy or move recipients to other recipient lists.

 l Ultimate package. Includes the Advanced package plus the following services:

 o Multiple start or branching points (nodes).
 o The Start in and From campaign nodes are two more powerful nodes with which 

you can combine multiple campaigns.

Node Starter Advanced Ultimate

Recipient new ✓ ✓ ✓
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Node Starter Advanced Ultimate

Open ✓ ✓ ✓

Click ✓ ✓ ✓

Reply ✓ ✓ ✓

Post-click ✓ ✓ ✓

Advanced ✓ ✓ ✓

From MA campaign ✘ ✘ ✓

Wait ✓ ✓ ✓

Send message ✓ ✓ ✓

Switch ✓ ✓ ✓

A/B test ✘ ✓ ✓

Change recipient ✘ ✓ ✓

Copy recipient ✘ ✓ ✓

Move recipient ✘ ✓ ✓

Start in ✘ ✘ ✓

Done ✓ ✓ ✓

Total number of active nodes per client max. 50 max. 250 unlimited

Creating and editing a campaign
This topic describes how to create and edit a Marketing Automation campaign. Also 
learn how to start and pause a campaign, delete campaign drafts and delete a 
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campaign permanently.

Creating a campaign
 1. Open the start menu and select Campaigns > Marketing Automation.
 2. Click Create.

 l To create a new campaign, select New from the drop-down list.
 l To use an existing campaign as a template, click From existing, choose your cli-

ent and campaign, and click Apply.



© Episerver 2020

172 | Episerver Campaign User Guide 2020-04-23

 3. Drag the nodes from the left action area to the working area on the right.

 4. Connect the nodes and enter the desired settings. See Editing nodes and Marketing 
Automation nodes.

 5. Click Save draft.
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 6. In the dialog box, enter a name for the campaign and click Save.

Tip: If you already saved a draft of a campaign and want to display 
the running or paused version of it, open the campaign report. See 
Marketing Automation campaign report.

Warning: Marketing Automation does not guarantee that mailings 
are sent in real time. Note the following hints on sending Marketing 
Automation messages.

 l Use the HTTP API for time-sensitive mailings (for example, order con-
firmations or password reminders), because Marketing Automation mail-
ings cannot always be processed in real time.

 l Target groups within the same campaign that check on the dispatch of 
the message in a node may give false results because the mailing may 
not be sent. If you use such target groups behind the Send message node, 
there may be undesirable effects, as the target groups may not work. To 
avoid this, place a Wait node, which delays the execution of the action, 
in front of such nodes.

 l If you place a Send message node behind a Move recipient node, you also 
should place a Wait node in front of the Move recipient node. Otherwise, 
the recipient may be removed from the recipient list before the mes-
sage is sent.

https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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Editing a campaign
To edit an existing campaign, select the required campaign from the list in the Mar-
keting Automation window and click Edit. Proceed as described from step 3 in the Creat-
ing a campaign section.

Starting or pausing a campaign
To start a Marketing Automation campaign in the Marketing Automation window, select 
the campaign and click  Start. Next, Episerver Campaign validates the campaign's con-
tent. If errors are found, correct them by editing the campaign.

To pause a campaign, in the Marketing Automation window, select the campaign and 
click Pause. To resume the campaign, click Start.

Note: If your Marketing Automation campaign contains a Wait 
node and you pause the campaign, the time specified in the node 
is not paused. That is, if the waiting time of the node elapses during 
pausing, the next action is executed as soon as the campaign is 
restarted.

Deleting a draft
To delete a version of a running or paused Marketing Automation campaign, in the Edit 
campaign window, click  Delete draft. 

Warning: Deleting a draft reverts the current changes and all 
changes made since the start of the campaign. To revert the cur-
rent changes, close the Edit campaign window.
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Deleting a campaign
To delete a Marketing Automation campaign in the Marketing Automation window, 
select the campaign and click Delete.

Marketing Automation nodes
The process of a campaign is defined by nodes that determine when a recipient passes 
through the campaign, and what actions are executed for the recipient. With the help 
of connections, you can link the nodes and specify the process of your campaign. The 
arrow at the end of each connection points to the succeeding node and the asso-
ciated action.

Tip: For the DACH region, a licensing model applies. If a node is 
grayed out (disabled), the Marketing Automation package has 
not been licensed. See Marketing Automation packages.

Start nodes define events that initiate the process of a campaign for a recipient. The fol-
lowing start nodes are available:

 l Recipient new
 l Open
 l Click
 l Reply
 l Post click
 l From MA campaign
 l Advanced

Action nodes specify which actions are executed during a campaign. The following 
action nodes are available:

 l Wait
 l Send message
 l Switch
 l A/B test
 l Change recipient
 l Copy recipient
 l Move recipient
 l Start in
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 l Limit
 l Done

Start nodes

 Recipient new

Starts the process of the campaign for a recipient added to the recipient list.

Parameters Description and values

Starts the Marketing Auto-
mation campaign

Specify which recipients are passing through the campaign                         

 l if recipient never passed through this MA campaign: Recipients 
pass through the campaign if they

 o are newly added to the recipient list.
 o are not currently passing through the campaign.
 o never passed through the campaign.

 l if recipient is not currently passing through this campaign: 
Recipients pass through the campaign if they are 

 o newly added to the recipient list.
 o not currently passing through the campaign.

Note: Recipients who already passed 
through a campaign but are newly 
added to the recipient list may pass 
through the campaign again.

 l always: Anyone newly added to the recipient list passes 
through the campaign.

Start only for recipients in 
(mandatory)

Only recipients of this recipient list(s) are passing through this campaign.
                         

Note: To start the campaign, you must specify 
a recipient list here.
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Parameters Description and values

Start only for Only recipients of this target group are passing through this campaign.

Note: Recipients moved from one recipient list to another are con-
sidered new unless both recipient lists have been set up as opt-in 
lists. In this special case, the Recipient-new node would not include 
the moved recipients.

 Open

Starts the process of the campaign for a recipient who opened the message.

Parameters Description and values

Starts the Marketing Auto-
mation campaign

Specify which recipients are passing through the campaign.                         

 l if recipient never passed through this MA campaign: Recipients 
pass through the campaign if they 

 o opened the message.
 o are not currently passing through the campaign.
 o never passed through the campaign.

 l if recipient is not currently passing through this MA 
campaign:Recipients pass through the campaign if they       

 o opened the message.
 o are not currently passing through the campaign.

Note: Recipients who already passed 
through the campaign and who open the 
message again may pass through the 
campaign again.

 l always: Any recipient who opens the message pass through the 
campaign.

Mailings
Specify the mailings in which recipients must click a link. You can

 l specify a mailing, or 



© Episerver 2020

178 | Episerver Campaign User Guide 2020-04-23

Parameters Description and values

 l limit the mailing selection to 

 o a mailing type. 
 o a folder that contains the mailings. 
 o the mailing's send date.

Start only for Only recipients of this target group are passing through this campaign.

 Click

Starts the process of the campaign for a recipient who clicked a link in the message.

Parameters Description and values

Starts the Marketing Auto-
mation campaign

Specify which recipients are passing through the campaign.                         

 l if recipient never passed through this MA campaign: Recipients 
pass through the campaign if they                         

 o clicked a link in the message.
 o are not currently passing through the campaign.
 o never passed through the campaign.

 l if recipient is not currently passing through this MA campaign: 
Recipients pass through the campaign if they 

 o clicked a link in the message.
 o are not currently passing through the campaign.

Note: Recipients who already passed 
through the campaign and who click a 
link in the message again may pass 
through the campaign again.

 l always: Any recipient who clicks a link in the message pass 
through the campaign.

Mailings Specify the mailings in which recipients must click a link. You can
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Parameters Description and values

 l specify a mailing, or 
 l limit the mailing selection to 

 o a mailing type. 
 o a folder that contains the mailings. 
 o the mailing's send date.

Links
Specify the links the recipients must click to pass through the cam-
paign.

Click profile
Specify the click profiles whose links the recipients must click to pass 
through the campaign.

Start only for Only recipients of this target group are passing through this campaign.

 Reply

Starts the process of the campaign for a recipient who replied to the message or to 
whom the message could not be delivered.

Parameters Description and values

Starts the 
Marketing 
Automation 
campaign

Specify which recipients are passing through the campaign.                         

 l if recipient never passed through this MA campaign: Recipients pass through 
the campaign if they                         

 o replied to the message or created a bounce.
 o are not currently passing through the campaign.
 o never passed through the campaign.

 l if recipient is not currently passing through this MA campaign: Recipients pass 
through the campaign if they                         

 o replied to the message or created a bounce.
 o are not currently passing through the campaign.

Note: Recipients who already passed through the cam-
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Parameters Description and values

paign and who reply to the message or create a 
bounce again may pass through the campaign again.

 l always: Any recipient who replied to the message or created a bounce pass 
through the campaign.

Mailings

Specify the mailings in which recipients must click a link. You can

 l specify a mailing, or 
 l limit the mailing selection to 

 o a mailing type. 
 o a folder that contains the mailings. 
 o the mailing's send date.

Type Select one ore more response categories of the reply.

Start only for Only recipients of this target group pass through this campaign.

Minimum 
interval

Select an interval that checks whether the recipient already passed this campaign 
(triggered by this start node). If the recipient has passed through the campaign since 
the last check, the recipient will not pass through the campaign until the next check.                     

 Post click

Starts the process of the campaign for a recipient that created a post-click.

Parameters Description and values

Starts the 
Marketing 
Automation 
campaign

Specify which recipients are passing through the campaign.                         

 l if recipient never passed through this MA campaign: Recipients pass through 
the campaign if they                         

 o created a post-click.
 o are not currently passing through the campaign.
 o never passed through the campaign.

 l if recipient is not currently passing through this MA campaign: Recipients 
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Parameters Description and values

pass through the campaign if they                         

 o created a post-click.
 o are not currently passing through the campaign.

Recipients that already passed through the campaign and that create a 
post-click again may pass through the campaign again.

 l always: Any recipient that created a post-click pass through the campaign.

Mailings

Specify the mailings in which recipients must click a link. You can

 l specify a mailing, or 
 l limit the mailing selection to 

 o a mailing type. 
 o a folder that contains the mailings. 
 o the mailing's send date.

Post click
Select the post-click service. This is either the proprietary Post-click tracking or the 
web analytics software you are using.

Start only for Only recipients of this target group pass through this campaign.

Include 
imported 
post-clicks 
without recip-
ient list

Select this check box if you want to evaluate imported post-clicks the recipients of 
which cannot be assigned to any recipient list in Episerver Campaign. This is, for 
example, the case when post-clicks are imported from external sources or the recip-
ient is logged in the online shop at the time of the post-click, but has not registered for 
the newsletter. This setting does not apply to post-clicks that can be uniquely alloc-
ated to recipients in existing recipient lists.                         

With such post-clicks, in which the email address is known, Episerver Campaign 
checks whether this corresponds to a recipient in the replacement recipient list. 
Select the replacement recipient list in the next step. If the email address is found 
in this recipient list, this recipient is considered in the further course of the Mar-
keting Automation campaign and can receive messages (provided that the 
other conditions are met).

Select 
replacement 
recipient list

Select the recipient list here to which the recipients of the imported post-clicks are 
compared. Post-clicks that could not be assigned to a recipient from any existing 
recipient list at the time of their capture (see the previous parameter) are com-
pared to this recipient list and are assigned with the matching email addresses. 
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Parameters Description and values

Imported post-clicks that cannot be assigned to any recipient of this list are dis-
carded.                         

Note: You should create a Standard recipient list that con-
tains the registered recipients and select this recipient list 
here. As a result, there is a high possibility that a post-click 
can be assigned to a recipient.

 From MA campaign

Starts the process of this campaign for a recipient from another Marketing Automation 
campaign.

Parameters Description and values

Starts the Marketing Auto-
mation campaign

Specify which recipients are passing through the campaign.                         

 l if recipient never passed through this MA campaign: Recipients 
pass through the campaign if they                         

 o come from another campaign.
 o are not currently passing through the campaign.
 o never passed through the campaign.

 l if recipient is not currently passing through this MA campaign: 
Recipients pass through the campaign if they                         

 o come from another campaign.
 o are not currently passing through the campaign.

Note: Recipients that already passed 
through the campaign and that come 
from another campaign again may pass 
through the campaign again.

 l always: Any recipient that comes from another campaign pass 
through the campaign.

Start only for Only recipients of this target group pass through this campaign.



© Episerver 2020

Campaigns | 183

 Advanced

Starts the process of the campaign for a recipient that matches specific criteria.

Parameters Description and values

Starts the Marketing 
Automation cam-
paign

Specify which recipients are passing through the campaign.                         

 l if recipient never passed through this MA campaign: Recipients pass 
through the campaign if they                         

 o match the criteria of this node.
 o are not currently passing through the campaign.
 o never passed through the campaign.

 l if recipient is not currently passing through this MA campaign: Recip-
ients pass through the campaign if they                         

 o match the criteria of this node.
 o are not currently passing through the campaign.

Note: Recipients that already passed through 
the campaign and that matches the criteria of 
this node again may pass through the cam-
paign again.

 l always: Any recipient that matches the criteria of this node pass 
through the campaign.

Start only for recip-
ients in (mandatory)

Only recipients of this recipient lists are passing through this campaign.                         

Note: To start the campaign you have to specify a 
recipient list here.

Limit the number of 
recipients to

Specify the maximum number of recipients to be contacted. If this value is 
higher than the number of possible recipients, all recipients are contacted.

Note: The maximum number of recipients depends 
on the defined interval. Example: If you limit the 
maximum number of recipients to 1000 and define 
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Parameters Description and values

a weekly interval, a maximum of 1000 recipients 
are contacted each week.

Interval

Specify how often the criteria should be checked. You can set a daily, 
weekly or monthly interval. Episerver Campaign then checks at the specified 
time which recipients meet the criteria—these recipients then pass through 
the campaign.

Start only for (man-
datory)

Only recipients of this target group pass through this campaign.                        

Note: To start the campaign you have to specify a 
target group here.

Note: The examination of the criteria may take time 
to complete, so the following actions may be 
delayed.

Filter by recipients 
included in all selec-
ted Visitor Intel-
ligence segments

Only recipients that are included in the selected Visitor Intelligence seg-
ments are passed through this campaign. 

Note: To make Visitor Intelligence segments avail-
able in Episerver Campaign, you first must create 
segments in  Episerver Visitor Intelligence (formerly 
Episerver Insight). See  Creating a marketing seg-
ment.

Action nodes

 Wait

During this time no action is taken.
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Parameters Description and values

Waiting time
Specify how long no action is taken. After this time, the following action is 
executed.

Wait only if target 
group is

For recipients of this target group, no action is taken during this time. Remaining 
recipients skip this action.

 Send message

Sends a message to the recipient.

Warning: For performance reasons, messages are sent asyn-
chronously to the course of the recipient in the campaign.
Note the following hints on sending Marketing Automation mes-
sages. 

 l Target groups within the same campaign, that check on the dispatch of 
the message in this node, may give false results because the mailing may 
not be sent. If you use such target groups behind the Send message node, 
there may be undesirable effects, as the target groups may not work. To 
avoid this, place a Wait node, which delays the execution of the action, 
in front of such nodes.

 l If you place a Send message node behind a Move recipient node, you also 
should place a Wait node in front of the Move recipient node. Otherwise, 
the recipient may be removed from recipient list before the message is 
sent.

Parameters Description and values

Mailing

Select the message to be sent to the recipient. Messages that you link here need to 
be created beforehand. Two functions are available for this purpose:                         

 l If you are working with Mailings Classic: Open the Start menu and select Cam-
paigns > Mailings Classic and create a mailing of the type Special/API.

 l If you are working with Smart Campaigns: Open the Start menu and select 
Campaigns > Transactional emails, and create a new message.

Send only 
to

A message is sent only to recipients of this target group. Remaining recipients skip this 
action.
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 Switch

Allows the branching of a campaign based on target groups. The branches are pro-
cessed hierarchically. That is, the lowest numbered branch  has the highest priority and is 
executed first.

Parameters Description and values

Target 
group

Create a connection to the node whose action must be executed for a specific tar-
get group and specify this target group. You can connect  nodes using different tar-
get groups.                         

Note: If a recipient matches a target group, the cor-
responding action is executed. Episerver Campaign does 
not check if the recipient matches another target group.

All remain-
ing recip-
ients

Create a connection to the node whose action will be executed for remaining recip-
ients.

 A/B test

Allows the branching of the campaign based on predefined probabilities.

Parameters Description and values

Percentage
Create a connection to the node whose action has to be executed for the recip-
ients, and specify the probability of recipients passing through this node. You can con-
nect nodes using different probability values.

All remain-
ing recip-
ients

Create a connection to the node whose action has to be executed for the remain-
ing recipients.

 Change recipient

Changes a recipient's data. To use this node, you need the permissions that let you eval-
uate action-based data at user level.
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Parameters Description and values

Recipient 
list

Select the recipient list where you want to change recipient data.

Changes

Specify the changes that have to be made.                         

 1. In the first list, select a recipient list field.
 2. In the second list, select the action to be performed. 

 l set value to: Replace current value with new value.
 l append suffix: Append value to existing value.
 l prepend prefix: Prepend value to existing value.
 l toggle: Toggle between current and counter value.

Tip: This option is only available for boolean fields. These 
fields contain two values: true and false. If, for 
example, the "male" field contains the value true, it is 
replaced with the value false.

 l time of pass-through: Replace the current value with the time of the pass-
through. The value is set to the time when the recipient passes through this 
node.

 l increment value by: Increment the current value by a certain value.
 l decrement value by: Decrement the current value by a certain value.
 l clear: Delete the current value.

 3. In the last text field, enter a value. To change multiple recipient list fields, click  
+ and repeat the steps.

Perform 
action only 
for

Changes are made only for recipients of this target group. Remaining recipients skip 
this action.

 Copy recipient

Copies the recipient into another recipient list. To use this node, you need the per-
missions that let you evaluate action-based data at user level.

Parameters Description and values

Copy to (man-
datory) Select the recipient list to which to copy this recipient.
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Parameters Description and values

Overwrite exist-
ing recipient

Check the box to overwrite the recipient in the target recipient list (if the recip-
ient is already contained in this recipient list).

Copy only
Only recipients of this target group are copied to the recipient list. Remaining 
recipients skip this action.

 Move recipient

Moves a recipient to another recipient list. To use this node, you need the permissions 
that let you evaluate action-based data at user level.

Note: Moving a recipient to another recipient list deletes any  
double opt-in data for this recipient.

Parameters Description and values

Move to (man-
datory) Select the recipient list to which to move the recipient.

Overwrite exist-
ing recipient

Check this box to overwrite the recipient in the target recipient list (if the recip-
ient is already contained in this recipient list).

Move only
Only recipients of this target group are moved to the recipient list. Remaining 
recipients skip this action.

 Start in

Starts the process of another campaign for a recipient. The recipient remains in the cur-
rent campaign and passes though the other campaign in parallel. The other campaign 
must contain the From campaign start node.

Parameters Description and values

Episerver Cam-
paign (mandatory) Select the campaign that the recipient has to pass through.

Beforehand copy to
Optionally select if the recipient must be copied to another recipient list 
before he passes through the campaign.
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Parameters Description and values

Overwrite existing 
recipient

Check this box to overwrite the recipient in the target recipient list (if the 
recipient is already contained in this recipient list).

Perform action only 
for

Only recipients of this target group are passing through the other campaign. 
Remaining recipients skip this action.

 Done

Marks the end of the campaign. This is an optional node.

Campaign report
To view the campaign report, access the Marketing Automation window, click a run-
ning or paused campaign,  and click Report.

The Marketing Automation campaign report lets you evaluate the success of your cam-
paign. To accomplish this, it shows the number of successful, current/active, and failed 
runs of the campaign. The report then breaks down this information for each campaign 
node.

Additionally, the openings, clicks, and the corresponding rates are displayed for the 
Message action node, and the currently-waiting recipients are displayed for the Wait 
action node.

Note: If a recipient did not receive the message via a Send Message 
action node (for example, because he/she is blacklisted or cre-
ated a bounce), this event appears as an error for the node.
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Marketing Automation guide
Create more effective email marketing using a graphic interface with drag-and-drop 
functions to develop multi-step campaigns based on action- and event-based mailings. 
These campaigns are perfectly adapted to a highly diverse set of target groups, using 
automated distribution cycles. 

Episerver Campaign's graphic editor lets you create elaborate campaigns for your cus-
tomer database, then refine them after the campaign is running. This guide provides 
actual examples that you can use "as is" or with minor adjustments.

Benefits

 l Lifecycle marketing made easy via drag and drop
 l Sustainable, automated cultivation of customer relations
 l Maximum flexibility of campaign design
 l Increased revenue through automated cross-selling and upselling campaigns
 l Optimal visibility and precise timing; supports several parallel campaigns
 l Focused on   individual recipients and simple content filtering options
 l Practical real-time analyses by overlay

What is lifecycle marketing?
Email content should be oriented to a recipient's interests and personal circumstances. 
Lifecycle marketing shapes each customer relationship by communications that pass 
through a series of phases. Each phase is characterized by changing expectations that 
can be divided into segments, such as new customer, regular customer, and inactive cus-
tomer.

You want to draw potential consumers to your company’s brand and products, and  
transform general interest into a willingness to purchase, supported by appropriately tar-
geted inducements. When a consumer becomes a customer or a long-term regular cus-
tomer, you want to provide new impulses through well-defined and properly-dosed 
emails. By applying the right analysis strategy to an ever-expanding database, you can 
obtain a better picture of your customers and target measures such as periodic incent-
ives or post-profiling. When you win back inactive customers, the lifecycle marketing 
strategy is complete.
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Cultivating customer lifetime value
Lifecycle marketing tries to  cultivate customer lifetime value (CLV) into a viable 
concept that benefits your company and its products. To do this, Episerver Campaign 
creates a series of automated mailings for  events and target groups. CLV is the profit 
contribution that a customer realizes during his "lifetime" as a customer. In addition to 
past revenue, it considers anticipated future revenue and customer potential. CLV thus 
exceeds conventional campaign performance measurements. Moreover, this indicator 
includes customer sales trends, allowing for targeted email marketing aimed at gen-
erating appropriate purchasing inducements.
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You want to  find a profitable means of addressing a variety of customer scenarios over 
the long term. For example, an automated reactivation campaign is preferable to a 
one-time effort at winning back regular-but-currently inactive customers. Such a cam-
paign systematically solicits this customer group over an extended time period. This 
approach also helps ensure that no customer “falls through the cracks,” preserving cus-
tomer value. Marketing managers can devote considerably more time to the content 
of their promotions and continued development of campaigns.

Marketing Automation for every need
Maintaining customer relationships is more complex than winning over new customers. 
Customer care in lifecycle marketing means consistently addressing the customer 
according to their status and interests. A contact strategy should be evolutionary, meth-
odical, and forward-looking. Direct prompts and incentives toward obtaining desired 
responses and targeted feedback are initiated. Effective Marketing Automation 
improves customer care. Successful campaigns produce higher customer satisfaction 
and provide for targeted responses to the needs of regular customers.

While conventional approaches can support a few standard segments and customer 
lifetime phases, Episerver Campaign makes more effective use of your customer data 
to customize implementation. You can decide to display an entire customer lifetime 
cycle in a central campaign, or roll out several individual campaigns.

From concept to the campaign
A user-friendly interface lets you turn an idea into a campaign. Use your computer 
mouse to mark starting and ending points. Then, with the aid of nodes and branches, 
retrieve your parameters in Episerver Campaign and incorporate them into a cam-
paign.
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Each node stands for an action or event (such as sending birthday email as trigger-
mail), or for filtering addressees by target group. By linking two nodes, you create a 
sequencing plan that anyone can follow. You can assign parameters to any node, such 
as click profiles, target groups or individual mailings. The campaign editor checks link 
logic among nodes and verifies that no nodes lead to dead ends.

You can add partial or intermediate steps for specific addressee groups. For example, if 
you want to communicate with only addressees who opened their discount mailing 
three weeks earlier, select the appropriate target group as parameter. Other address-
ees in your distribution list are unaffected but may be considered for a different dis-
count mailing. As you get to know you customers better through additional campaigns 
and analyses, you can create additional segments and reconfigure the way you com-
municate benefits.

Developing the perfect campaign takes time and analysis. You can modify and refine a 
campaign to properly align your marketing goals while moving toward perfection. You 
can save modifications as drafts then transfer them to a running campaign with no 
downtime.
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Campaign building blocks

Blocks Description

Start node

Defines the action or event that triggers 
by the campaign, such as a registration, a 
clicked link, or a post-click. Also defines 
recurring events, such as an addressee’s 
birthday.

Start nodes use blue icons.

Prerequisites

Set each campaign so it runs once or sev-
eral times. You can also specify that an 
addressee cycles through a campaign 
only once at any given time.

Action nodes

A campaign may contain multiple action 
nodes. Each action node stands for one 
action.

You can send out mailings, segment tar-
get groups, or set it to wait. If an action 
node is assigned to a target group, the 
action goes to addressees in that group 
only; other addressees skip this node and 
continue to the next node.
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Blocks Description

Loop

Campaigns may contain loops that an 
addressee cycles through several times 
until a criterion set for that loop either 
applies or no longer applies. The built-in 
campaign validation function evaluates 
whether an endless loop is inadvertently 
included in the campaign. If so, it pre-
vents that campaign from being initiated.

Promoting on anniversaries

Anniversaries are opportunities to contact your customers and maybe include a 
coupon. You can use the dates of registering with your site, newsletter signup, or a birth-
day, provided in an optional form field.

For example, set up a target group formatted as recipient list field: birthday: is 
anniversary. You may want to include a coupon in a birthday mailing. Create three mail-
ings: 

 l one with an image for men
 l one with an image for women 
 l one (labeled "fallback" in the image below) with a neutral image for recipients 

whose gender is unknown

The following steps set up this example.

 1. Use the Advanced node as the starting node. This queries target groups at set inter-
vals. With birthday mailings, a target group should be screened daily for has birthday.

 2. Create a branch node to sort recipients by gender.
 3. Each group receives the appropriate birthday mailing.
 4. Recipients whose gender is unknown receive the third mailing.

Tip: You may set up an anniversary campaign in the same manner. 
Change the target group to has anniversary.
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After-sales recommendations

Prompt customers who made previous purchases to order more products through after-
sales recommendations.

The following example uses customers of an online drugstore who purchased sunscreen 
the previous year.  You want to contact customers whose last purchase is more than 10 
months ago, remind them of the sunscreen's expiration date, and suggest they obtain a 
fresh supply.

For this campaign, first incorporate Post-click tracking in the drug store's online shop. 
This provides information about when a customer purchased a product in the category 
sunscreen. Next, set up a target group with the filter: recipient purchased a product in the 
category sunscreen exactly 300 days ago. This group generates a mailing that includes a 
notification about the expiration date, product recommendations, and a coupon for 
sunscreen. This mailing is called Has your sunscreen expired? – Buy now and save!

To set up this campaign, follow these steps.

 1. Because this campaign responds with a time delay rather than a transaction, use an 
Advanced start node rather than a Post-click node. The parameter for the node is the 
previously-specified target group. The campaign is started daily.

 2. Recipients filtered by this node receive the previously-created mailing.
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Reactivation campaigns

Along with taking care of active customers, you should also consider the potential of 
customers who recently ignored your promotions. Reactivating inactive customers 
offers multiple means for increasing revenue while maintaining and cultivating your cus-
tomer master list.

A reactivation campaign should investigate reasons for inactivity, offer incentives to 
become an active customer again, and allow those interested to confirm their interest 
in your newsletter. A recipient who does not respond, that is, does not renew his opt-in, 
is preferable to a recipient who remains inactive. You may also want to offer inactive 
recipients an option to receive your newsletter less frequently (for example, monthly 
rather than weekly) or temporarily suspend receipt.

A reactivation campaign should consider these factors and provide flexible responses 
that correspond to customer reactions. The point at which a recipient is considered 
inactive varies depending on the product being advertised in the newsletter. For a 
travel agency, you can presume a 12-month purchasing cycle. That is, you expect a 
recipient to make large-scale travel plans once a year and seek suitable offers accord-
ingly. For other business sectors, the cycle may be considerably shorter.

Based on this definition of an inactive recipient, you would create a target group with 
two qualifiers, one of which should apply in each case:

 l Addressee has not clicked on any mailing in the past 730 days (2 years)

OR
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 l Addressee has not opened a mailing in the past 365 days.

Planning a multi-stage campaign

When planning a multi-stage campaign, several mailings are necessary.

 l Haven’t heard from you in a while. Contains the latest travel offers.
 l How can we serve you better?. Requests that the recipient update his or her user 

information.
 l Receive our newsletter once a month. Lets recipients switch newsletter frequency 

to monthly rather than weekly. Another button is Suspend newsletter for 6 months.

Both buttons are linked to a landing page that confirms the change. You can also 
configure a preference center with these features.

 l A coupon for you. Recipients who clicked an item during the first reactivation cam-
paign receive a coupon.

 l Thanks for your feedback! Recipients who click the link to the preference center 
receive this mailing.

 l Please confirm your subscription. Lastly, recipients  who responded to none of the 
previous mailings should be prompted to renew their opt-in. The mailing should 
include an opt-in link.

Note: Mailings used in conjunction with Marketing Automation must 
be set up as Transactional mails and be in Send status.

Setting a reactivation campaign

 1. Start with an Advanced node. 

 l This node type inquires once a week whether a recipient is in the Inactive recip-
ient target group. 

 l In the node, select the qualifier Addressee has never cycled through the 
campaign, because each recipient should cycle through the campaign only 
once.

 2. The mailing Haven’t heard from you in a while is sent out, then wait 7 days. The Wait 
node is assigned the target group has not responded to 1st reactivation, so recipients 
who click that mailing are directed to the next node.

 3. Recipients who click an offer in the mailing Haven’t heard from you in a while 
receive a coupon for other compatible offers. The reactivation campaign is over for 
these recipients.
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 4. Recipients who did not respond to the first reactivation campaign (neither opened 
nor clicked) receive the second reactivation campaign, How can we serve you bet-
ter?, then wait another 7 days. The Wait node is assigned to the has not responded to 
the 2nd reactivation target group, so recipients who click the preference center link 
in this mailing are directed to the next node.

 5. Addressees who clicked the link to the preference center in the second react-
ivation mailing also receive a coupon for offers suitable to their preferences.

 6. The recipients’ preferences are modified in accordance with their selection: For 
those recipients who clicked the link Receive newsletter monthly, the frequency recip-
ient list field is set to monthly. A confirmation mail is sent regarding the mailing fre-
quency change.

 7. For recipients who clicked the suspend delivery for 6 months link, the suspend recip-
ient list field is set to true. Insert a Wait node with a value of 6 months. Then, the sus-
pend recipient list field is reset to false, and a Welcome back message is sent to the 
recipient.

 8. Other recipients who have not responded to a reactivation mailing receive the 
Please confirm your subscription mailing. Insert a Wait node with a waiting period of 
7 days. The Wait node is associated with a target group has not responded to 3rd react-
ivation, so recipients who confirm their opt-in are immediately directed to the next 
node.

 9. Recipients who click the opt-in link also receive a Thank you for your feedback mail-
ing, along with a coupon. Other recipients are marked as unsubscribed.
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Multi-stage series of welcome messages

A series of welcome emails can help develop customer value. Use multistage cam-
paigns to acquaint new subscribers with your products and services. Recipients are par-
ticularly receptive to receiving a newsletter immediately after registration. This series of 
emails should comprise welcome messages followed by email with relevant content. 
Of most importance is a sustained, persuasive effort in the form of individual, premium 
offers.

The following example uses a travel service’s online portal for which you want to estab-
lish trust by recipients and learn more about their specific interests. To this end, begin by 
creating suitable mailings, click profiles, target groups, and coupons for the campaign.

The initial mailing should be a welcome mail without promotional content that sum-
marizes the portal's products and services. The mailing includes test/user ratings and 
short statements from other rating portals that give the recipient a better understanding 
of what the portal offers. This mailing might be called Welcome to Travel Deluxe.

A second mailing, to be sent two days after the Welcome to mail, includes an incentive 
in the form of a coupon and additional information about travel preferences. So, you 
can offer several coupons, each tied to a different travel destination.

In addition, click profiles are created for secondary links that divide the offer into three 
categories: Hiking & Nature, All inclusive and Culture. This is placed under a mailing 
named Our Gift to You.

Note: Mailings to be used with Marketing Automation must be set 
up as Transactional mail and be in Send status.

When these steps are taken, review how this campaign looks in association with Mar-
keting Automation. The campaign should begin via the Recipient new start node for 
recipients newly added to the main recipient list (either through self-registration or 
import).

 1. A multi-stage series of welcome mails begins via the start node Recipient new. This 
ensures that only recipients who are new newsletter subscribers  and recently added 
to the recipient list are cycled through this campaign.

 2. Drag the Send message action node into the workspace, select the type of mailing 
to be distributed in the node's Properties field, then link the start node to it.

 3. After the recipient receives the first welcome email, he gets a short breather using 
the  Wait action node. The duration is set in the properties window of the Wait node 
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once it is linked to the previous node. In this example, the count is 3, and the unit is 
days. So, the recipient waits 3 days before the next action is carried out.

 4. Select the subsequent mailing using the Send message action node. This mailing con-
tains the coupon offers including click profiles, as described above. This sends out 
individual, follow-on emails with reinforcing messaging. To do this, drag the action 
node into the workspace, select the mailing, and link the node.

 5. To give the recipient sufficient time to read and click, drag the Wait node to the 
workspace and set up 3 days.

 6. This step is essential for distributing the follow-up mailings. The action node Switch 
lets the recipient receive different mailings based on target groups. In this case, four 
mailings will be employed following the branch. These mailings are placed behind 
the Switch node with the aid of the Send message node, as shown in the diagram. 
Next, individual branches are set and linked to the nodes. One target group is alloc-
ated to each branch.

In this case, three branches are assigned to target groups, while one branch is 
defined for recipients who correspond to none of the target groups. If a target 
group does not match the Send message node with which it is associated, it skips 
over this node, and the mailing is not sent to the recipient.

 7. As required, the recipient should receive a feedback mailing 28 days after regis-
tering. If you subtract the 2x3 days employed by the wait-nodes from this 28 day 
period, you should place a Wait node with a value of 22 days.

 8. After being on the recipient list for 28 days, by using an additional Send message 
node, the recipient receives this campaign's final mail.
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Cross- and upselling

Lifecycle marketing builds increased interest and purchasing incentives through cam-
paign emails, trigger mails, and themed mailings. It provides added value by supplying 
the customer with relevant and helpful  purchase or reservation information. 

For example, while booking a flight, provide recommendations for hotel, car rental, 
area restaurants, and other activities.  On returning from the trip, offer a photo album 
that can be purchased online to use for vacation snapshots.

To use cross- and upselling offers, set up post-click tracking in your online shop to  
provide the following data:

 l Which product did the customer purchase?
 l Was the purchase completed?
 l Arrival and departure dates
 l Optionally, the value of the order

Tip: To set up post-click tracking, contact customer support.

Allocating target groups and mailings

To later select the correct mailing with corresponding hotel and rental agency recom-
mendations, allocate a target group to each destination. The target group definition 
would be: Addressee generated a post-click in the category flight with the value Mal-
lorca / Grand Canary Islands / Sardinia / Athens / Antalya / and so on.



© Episerver 2020

Campaigns | 203

An additional target group checks if the date-of-return matches the current date. 

Next, allocate a mailing to each travel destination (or create a mailing with a para-
graph about each destination) and associate it with a target group. In the following 
example, a paragraph is included in the mailing for each target group set up during the 
previous step. To keep promotions up-to-date, this paragraph is linked to a content inter-
face. You also need a mailing to distribute when a customer returns home, which looks 
the same to all recipients:

 l Before you fly: Our hotel recommendations
 l Welcome back! Here's a place to put your vacation pictures

Note: Target groups compiled with the help of post-click data look 
different depending upon the configuration of the post-click track-
ing or the web-analysis software. For instance, with some web-ana-
lysis products, you can select the product purchases category then 
specify greater detail. The example here is based on a post-click 
configuration tracking where a post-click is produced only after an 
order is completed, eliminating the need for that pre-selection.

The following image shows how to create the Before you fly: Our hotel recom-
mendations mailing.

 1. Use the Post-click node and set the parameter category same as flight.
 2. The selection of destination, and corresponding hotel accommodations, in the mail-

ing occurs by target group. So, choose this mailing and send it to the recipients.
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To expand this campaign to include other promotions, such as for rental cars, 
modify the mailing and the paragraphs within it.

 3. Incorporate a loop that inquires daily whether the return date equals that day’s 
date. A Wait node is set with a value of  1 day and, after it, a branch that filters the tar-
get group return date is today. This group receives the mailing, Welcome Back: Now 
here’s a place to put your pictures with a coupon to order the photo album. Other 
recipients are reset to the Wait node.

Dealing with canceled transactions

Customers abort orders, purchases, and other transactions for many reasons. If a cus-
tomer places a product in a shopping cart, that usually indicates interest in that 
product. A targeted campaign can give the customer an incentive to complete the 
transaction. 

In the example below, customers who abort transactions are sent a coupon and recom-
mendations for related items. Web analysis filters out recipients who put a trip/tour in a 
shopping cart but did not complete the transaction. You can use a web-analysis tool to 
transfer records of sales/reservation cancellations directly to Episerver Campaign. 

Tip: Web-analysis tools let you simultaneously generate suitable 
recommendations for transaction cancellations, transfer those to 
Episerver Campaign, then create a campaign aimed at this group-
ing. Contact customer support about connecting web-analysis 
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software to your client.

Using categories and target groups,  create paragraphs in a mailing that describe trips/-
tours similar to the canceled one. Send this mailing to those who canceled trans-
actions. 

Recipient generated a post-click in service "Analytics" with a value of "Mallorca" /
 "Grand Canary Islands" / "Sardinia" / "Athens" / "Antalya" / in the category
 "Transaction cancellation".

You must assign a target group to each destination.

The campaign is carried out in two steps, requiring two mailings: a coupon mailing, and 
a mailing containing recommendations:

 l May we recommend
 l Book now and redeem your coupon

A separate paragraph is inserted into the mailing for each target group created in the 
previous step. 

The target groups for this campaign are the same used for the cross- and upselling cam-
paign, except that the transaction cancellations category is tracked. Using web-analysis 
software, the target group looks something like this:

 1. Addressee generated a post-click
 2. In the service Analytics
 3. In the transaction cancellation category
 4. Using the word

 l Mallorca
 l Gran Canary Islands
 l Sardinia
 l Athens
 l Antalya
 l ...

The following steps show how to create a campaign for transaction cancellations.

 1. Use a Post click node. The Analytics service and the transaction cancellations  target 
group are set as parameters for the node.

 2. Filter recipients by this node to get recommendations relating to the trip/tour pre-
viously considered. Target groupings determine the recommendations in the mail-
ing.

 3. Set a Wait node to a value of 3 days.
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 4. Set a branch. For each target group, recipients who purchased a trip/tour are 
filtered out using the has purchased target group created previously. For these recip-
ients, the campaign is concluded.

 5. Recipients who did not make a purchase get a coupon mailing.

Multi-stage campaigns

This type of campaign introduces regular recipients to products and services. It requires 
little effort to execute because the mailing content remains essentially the same. By 
modifying the subject lines and the order of paragraphs in a mailing, you can highlight a 
product's benefits and characteristics.

Use post-click tracking to conduct a multistage campaign, which uses target groups to 
filter recipients who generated a conversion.

Note: Alternatively, you can configure target groups that filter 
recipients who clicked the registration link for your online shop in 
an email. This type of target group produces less precise results 
because it includes recipients who clicked a link but did not com-
plete the registration or purchasing process.
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Prerequisites

For multi-stage campaigns you need various mailings and target groups:

Mailings

 l Principal mailing (type: regular) with two split mailings, each with a modified subject 
line (re: A and B).

 l 2 copies of the principal mailing (type: special), each with a different subject line 
(attract interest, call-to-action) (re: C and D).

 l Alternate version of the principal mailing (type: special) with the content 
rearranged or modified to shift the mailing's focus   (re: E).

 l Copy of this variant (type: special) with a different subject line urging call-to-action 
(re: F).

Target groups

 l Recipients who received the principal mailing or one of the split mailings.
 l Recipients who did not open the principal mailing.
 l Recipients who did not open the second mailing.
 l Recipients who did not open the third mailing.
 l Target group that analyzes post-clicks and matches recipients who generated a 

conversion (for example, completed registration or purchase).
 l Recipients who opened a mailing but did not generate a conversion.

Creating a subject line split mailing

The first stage of the campaign consists of a classic A/B split test, used to determine the 
subject line that generates the greatest number of openings or clicks. The mailing that 
performs best is then sent to the remaining recipients. The automated campaign begins 
24 hours later, when recipients are sent additional mailings in several stages.

 1. Create a principal mailing with desired content.
 2. Prepare a split mailing from the principal mailing, with subject line version A.
 3. Prepare a second split mailing from the principal mailing, with subject line version B.
 4. Go to Automatic selection of best split for principal mailing and select best unique open-

ing rate or best unique click rate, and set a 1-day delay for automated distribution of 
the principal mailings.

 5. Save the settings.
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 6. Launch the split mailings, either manually or automatically.

Note: The following campaign must be created before the split 
mailing is launched, and mailings in this campaign must be set 
as Transactional mail.

Following up with automated distribution mailings

Create a campaign that launches after the principal mailing is sent out. 

 1. Start with an Advanced node to filter recipients who received the principal mailing 
or one of the two split mailings. Initially, the standby time is set to four days to 
provide recipients sufficient time to respond.

 2. Recipients who have not opened this mailing and have not completed registration 
receive the modified subject line C. They are given another 4 days to respond.

 3. Recipients who open the first mailing during this period, but have not generated a 
conversion, do not receive mailing C. Instead, they are sent the two-stage reminder 
that concludes the campaign. The campaign terminates for recipients who gen-
erate a conversion.

 4. Recipients who have not opened mailing C are sent another mailing with subject 
line D.

 5. As in step 3, recipients who opened mailing C during this period, but who have not 
generated a conversion, are sent the two reminder mailings. The campaign ter-
minates for recipients who generated a conversion.

 6. After another 4 days, recipients who completed registration are filtered. For them, 
the campaign terminates. Recipients who opened mailing D but did not generate a 
conversion receive the first reminder mailing. This mailing, with subject line E, con-
tains content from the principal mailings in a different order or with a different focus. 
Recipients who have not yet opened any mailings are disregarded from this point 
on.

 7. After a week, recipients who did not open the first reminder receive a second 
reminder. This mailing is identical to the first, but contains another version of the sub-
ject line with a call-to-action. The campaign then terminates.
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Transactional mails

Transactional mails are sent automatically as a result of actions or events. There are two 
scenarios for transactional mails.

 l API mails. Result from an API call, such as placing an order from the online shop. For 
this type of transactional mail, you need the REST API, SOAP API or HTTP API.

 l Episerver Campaign mails. Used in a Marketing Automation campaign. While editing 
the Send message node, select the appropriate transactional mail in the Marketing 
Automation  function.

When started, transactional mails remain in Sending status. Transactional mails are sent 
in real-time via the Episerver Campaign transaction API.

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/


© Episerver 2020

210 | Episerver Campaign User Guide 2020-04-23

Transactional mails overview
Open the start menu and select Campaigns > Transactional mails.

The mails appear in the top half of the window.

Viewing status
The Transactional mail overview displays the status of each transactional mail.
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 l New. Fully configured but not started.
 l Incomplete. Elements are missing or necessary parameters are not defined. Com-

plete the configuration then start the transactional mail.
 l Sending. Active and sending mails.
 l Canceled. Sending was canceled and cannot be restarted.

Transactional mail actions
Use the following buttons to perform the actions for transactional mails.

Note: Some  actions are not available for new or incomplete trans-
actional mails.

 l Create. Create a new transactional mail. See Creating a transactional mail.
 l Copy. Select a transactional mail and click Copy. Elements (recipients, target 

groups, messages, and so on) are applied.
 l Edit. Select a transactional mail and click Edit. See Editing a transactional mail.
 l Delete. Select a transactional mail and click Delete. You can delete only new or 

incomplete transactional mails. 
 l Start. Select a transactional mail and click Start. Confirm the start by clicking Start 

mailing.
 l Copy to client. If this feature is enabled, you can copy transactional mails to other cli-

ents. Recipient lists and target groups are not transferred to the target client.

Note: Prerequisites

 o The registered user has permission to create mailings in the target cli-
ent.

 o The target clients have the same template used in the transactional 
mail that you want to copy.

 1. To copy a transactional mail to other clients, in the campaign overview, select 
the transactional mail you want to copy. The Copy to client button is activated.

 2. Click Copy to client. The Copy campaign to client window opens.
 3. In the Campaign area, in the New campaign name in the target client field, enter 

the name for the copy of the transactional mail in the target client.
 4. In the Target clients area, check the box next to the client to which you want to 

copy the transactional mail.
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Tip: To select all available target clients, check the box in 
the menu bar.

 5. Click Copy. When the copy process completes, Copy process completed is dis-
played.

 6. Click Close.
 l Analysis. Select an active transactional mail (in Sending status) and click Analysis to 

check how many mails were already sent via an ongoing transactional mail. You 
can also see additional parameters such as opens, clicks, bounces, or unsubscribers.

Creating a transactional mail
 1. Click Create.
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 2. From the left action pane, drag the Recipients node into the workspace.

 3. In the Recipient lists drop-down list in the context menu, select your transaction recip-
ient list.     

Note: Customer support has set up a separate transaction recip-
ient list for you. Make sure you use this transaction recipient list, 
instead of a regular recipient list. To see if a recipient list is a 
transactional recipient list, check the column Transaction API.
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 4. Optional: From the left sidebar, drag the Block node into the workspace. Click Prop-

erties   and select one or more custom blacklists from the drop-down list. The 
recipients on those blacklists do not get a message.

Note: The Block node only works with custom blacklists and is only 
available for the email media type.

 5. From the left sidebar, drag the message node for the desired media type into the 
workspace. The delivery channel must be compatible with recipient list type.

You can select the following media types for transactional mails:

Delivery 
channel

Delivers Required recipient list type

Mail email Mail or  multiple list 

SMS SMS SMS or multiple list

Mobile Push push message to a mobile 
device Push or multiple list

 6. In the Name box in the context menu, enter a name for your transactional mail (for 
example Order confirmation).     

 7. In the context menu for the messages node, click Edit content.
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 8. In the Template list, select the desired template and confirm your selection by click-
ing Next.

 9. Configure  the template for the transactional mail according to your requirements. 
For more information, see Editing mailing content.

 10. Click Apply.
 11. Click Close.
 12. Connect the Recipients node with the message node.

 13. Click Save and close.
 14. Select the mailing in the overview and click Start to activate your transactional mail 

and to start the sending process.
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Editing a transactional mail
 1. Click Edit to edit an existing transactional mail.      

 2. Follow the steps under Creating a transactional mail.

Confirmations

Registration confirmations (opt-in emails) are sent in real-time via the Episerver Cam-
paign transaction API (application programming interface) when a recipient registers 
for your newsletter. Once started, registration confirmations remain in Sending status. 

To open the overview, open the start menu and select Campaigns > Confirmations. Regis-
tration confirmations appear in the top half of the window.

Selecting a media type
You can select the following media types for registration confirmations, each of which 
are sent via different channels. The recipient list for a confirmation must be compatible 
with the delivery channel.
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Delivery chan-
nel

Sends registration confirmation via Required recipient list type

Mail email Mail or  multiple list 

SMS SMS SMS or multiple list

Viewing status
The overview displays a status for each registration confirmation.

 l Sending. Confirmation is active and sending opt-in emails to newly registered recip-
ients.

 l Canceled. Confirmation is canceled and cannot be restarted.

Note: To resume the sending process, contact customer support.

Registration confirmation actions
You can perform the following actions for registration confirmations.

 l Edit. To modify a registration confirmation, select it and click Edit. See Creating and 
editing campaigns.

 l Cancel. To cancel the sending of an active registration confirmation (in Sending 
status), select it and click Cancel.             

Note: You cannot restart canceled registration confirmations. 
To resume the sending process, contact customer support.

 l Analyze. Select an active registration confirmation and click Analysis to check how 
many opt-in mails were sent via a registration confirmation. You can also see addi-
tional parameters such as openings, clicks, bounces or unsubscribers.

Opt-in processes

Note: To enable this feature, contact customer support.

Using opt-in processes, you can create and manage registration confirmations (opt-in 
emails).
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To open the opt-in process overview, open the start menu and select Campaigns > Opt-
in processes.

Creating an opt-in process
 1. Click Create.

 2. Drag the Recipients node from the left action area to the working area on the right.
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 3. Select one or more recipient lists you want to send the opt-in email to.

Note: You can only use recipient lists of the Opt-in type.

 4. Drag the Opt-in email message node from the left action area to the working area 
on the right.
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 5. Double-click the message node and configure the opt-in process.

 l Type. In the drop-down list, select the opt-in type. Double is selected by default.

Tip: For information on the different opt-in methods, see 
Opt-in.

 l Name. Enter a name for the opt-in process.
 l Description. Optional: Enter a description for the opt-in process.
 l Confirmation page URL. Enter the URL of the confirmation page.

Note: The confirmation page URL is required for opt-in pro-
cesses of the Double type.

 o Optional: You can append the parameters bmrecipientid, bmrecipientlistid 
and mailing to the confirmation page URL and use them for tracking and ana-
lysis. To do this, select the respective check box.

 6. Edit the opt-in email by clicking Edit content. See Editing mailing content.

Note: Opt-in emails for opt-in processes of the Double type  must 
contain a double opt-in link (using the field function {Double Opt-
in Link}).
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 7. Connect the nodes.

 8. Click Save and close.

Tip: Newly created opt-in processes start automatically and are in 
Sending status. If you want to cancel a running opt-in process, 
select it in the opt-in process overview and click Cancel. See Opt-in 
process actions.

Editing an opt-in process
 1. Select an opt-in process and click Edit.
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 2. Modify the opt-in process as described in Creating an opt-in process.
 3. Click Save and close.

Opt-in process actions
In the opt-in process overview, you can perform the following actions:

 l Start. Start a previously canceled opt-in process. The opt-in process must be in Can-
celled status.

Tip: You can view the opt-in process status in the Status column 
of the opt-in process overview.

 l Cancel. Cancel an active opt-in process. The opt-in process must be in Sending 
status.              

 l Analyze. Check how many opt-in emails were sent. You can also see additional 
information such as openings, clicks, bounces or unsubscribers.

 l Send test message. Send a test message to check the appearance of the mailing 
before the actual dispatch. See Test message.

Message templates

Use message templates to create messages quickly and easily for sending via Smart 
Campaigns and skip the configuration steps.

You can create message templates and configure these by yourself with sender inform-
ation, recipient lists, and other parameters. You can create a message template by 
using a content template, directly via HTML code or by using an existing message as 
basis.
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To open the template overview, open the start menu and select Campaigns > Message 
templates.

Template actions

New
 1. To create a new message template, click New.
 2. From the drop-down list, select an option.

 l New. Create a new message template based on a free-text template or 
another content template. Click New in the left column, then select a content 
template from the list on the right.

Note: The selected content template must support the tar-
geted dispatch channel, for example email.

 l Message. Apply content from an existing message to this message template. 
Click Message in the left column then select a message from the list on the right.

Tip: Messages you created with Mailings Classic are also 
available.

 l Message template. Apply the content and configuration of an existing message 
template. Click Message template in the left column, then select the template 
from the right.

 3. Click Next to edit the message template.

Copy
 1. To create a new message template and apply the content and configuration from 

an existing message template, click a message template in the list that has para-
meters that you want to apply.

 2. Click Copy.
 3. The message content appears on the screen. Modify as needed the click Save.

Edit
To edit an existing message template, click a message template in the list, then Edit.
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Note: If you save the message template under a different name 
after editing, the message template is renamed when you save it. 
No automatic copy is created.

Delete
To delete a message template, click a message template in the list, then Delete.

Configuring message templates
A message template usually contains sender information, a personalized subject line 
and other parameters such as character sets that can be reused. For information how to 
configure messages, see Configuring the message.

For information how to add content to the message template that you want to reuse in 
messages (for example, header and disclaimer), see:

 l Email message templates. See Edit mailing content. If you are using the Template Kit, 
see Template Kit.

Sending a split mailing

With split dispatch, you can test a mailing in different variants on a small portion of the 
recipient list before you start the actual dispatch. The variant that performs best in the 
criteria you defined is then sent to the remaining recipients. 

Split mailings usually differ only in few parameters from another. The most common vari-
ations include:

 l Subject line. Test how different subject lines affect the opening rate.
 l Header image, title, intro paragraph. Test various headers, titles and introductory para-

graphs.
 l Target group-specific testing. Test a mailing or a mailing variant to different target 

groups (for example, male and female recipients).
 l Time of dispatch. Test the optimal time to send the master mailing.
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Split dispatch in Smart Campaigns
To start a split dispatch in Smart Campaigns, follow these steps:

 1. Drag an A/B test node from the left action area and drop it onto the desktop.

 2. Add a Recipients node and select one or more recipient lists.
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 3. Connect the Recipients node to the A/B test node.

 4. Drag a message node (Email or Mobile Push) onto the desktop. Create a new mes-
sage or edit an existing message.

 5. Drag another message node of the same type onto the desktop. Select the mes-
sage that you used for the first message node and change the content according 
to the criteria that you want to test.
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 6. Add further message nodes if necessary and follow the description in point 5.
 7. Connect each message node to the A/B test node.

 8. In the A/B Test node, optionally activate Activate Automatic Optimization and/or 
Send time optimization. For example, you can configure that the mailing with the 
best unique opening rate is automatically sent to the rest of the recipient list two 
days after the dispatch of the split mailings. For more information, see  A/B test node 
and Configuring send time optimization in the A/B test node.
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 9. In the Edit menu   of the respective connection, you can set, among other things, 
how many recipients should receive the split mailing. For example, if you select 10% 
for two split mailings, the mailing will be sent to the remaining 80% of the recipient 
list after the A/B test has been completed. For more information, see A/B test node.

 10. To complete the editing, click Save and Close. After the successful validation, your 
A/B test campaign is ready to be activated.
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Split dispatch in Mailings Classic
A split mailing (also called split-run testing, A/B testing, or bucket testing) in Mailing Clas-
sics is a variation of a regular mailing where a subset of recipients is "split off." You can 
edit every split mailing like a regular mailing and can also have a completely different 
look to the master mailing.

Note: A split mailing is associated with a master mailing, even if the 
master is moved to another folder.

 1. In the Mailings window, select the desired mailing – which is called the master mail-
ing – and click Split. The Split dispatch window opens.

 2. You have two options.

 l Click  Add split (master mailing) to create an exact copy of the master mailing 
with the same content. Edit this mailing by changing content elements, subject 
line, and so on.

 l Click  Add split (new mailing) to create a new mailing with no content. Add the 
desired content as described in Mailings-Classic.

In the Splits area, you can see the new split and existing splits of the selected master 
mailing. You can edit some parameters in the Split section of the Split dispatch win-
dow, including:

 l Name. This name is used internally. By default, the split receives the same name 
as the master mailing.

 l Subject. Enter your desired variation to test different subject lines against one 
another.

 l Maximum number of recipients. Specify the number of recipients  whom the split 
should be sent (relative  to master mailing recipients, in absolute numbers or a 
percentage).

 l Target groups. Select up to three target groups for the split. See Target groups.
 l Sending date. Set the dispatch date for each split. See Dispatch order.

 3. Click  Save settings. The split is displayed in the mailing list. 

In the list, splits appear indented below the master mailing they belong to. In the 
Type column, they are designated as Split. 

Recipients
To perform an A/B test, during which the best option between split A and B is selected 
and sent out as master mailing, splits are typically sent to a subset of total recipients. 
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Each split can be sent to an absolute number of recipients, or a percentage of total 
recipients. If percentage is selected, it is based on the number of master mailing recip-
ients. This principle also applies if a split uses a recipient list other than the master mail-
ing.

For selecting a subset of recipients from a recipient list:

 l Percentage. Enter a percentage in the Maximum recipients field. The number of recip-
ients is based on the total number of master mailing recipients. 

Or, enter an absolute value. If the split contains the corresponding number of recip-
ients, it is sent to exactly that number.

 l Random. Recipients are randomly selected from the list. If you do not use this option, 
emails are sent to split recipients according to their order on the list.

In both instances, recipients who receive one split email will not be sent another. Sim-
ilarly, recipients who are on several lists only receive one email. Episerver Campaign 
monitors email addresses during dispatch to ensure that each recipient only receives 
one email (split or master mailing).

Recipient lists

In most cases, the same recipient lists are used for the master mailing and splits. 
However, for a split, you can use a recipient list other than master mailing. 

Note: The master mailing recipient list is the basis for calculating the 
number of split recipients.

To use different recipient lists for the master and split mailing, in the Split dispatch win-
dow, select off from the Automatically use  the best split for the master mailing drop-down 
list.

If you are using different recipient lists in combination with recipient data-based target 
groups,  be aware of potential conflicts between the different recipient lists. See Target 
groups.

Calculating recipients

The total number of recipients (master mailing and splits) is calculated every time 
before a mailing – including individual splits – is sent. The following illustration shows how 
subsets of recipients and the total number of recipients are calculated during dispatch.
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Recipient calculation

 l The  symbol  signifies that a subset of the total is being created.
 l If a percentage is given for the number of split recipients, discrepancies between 

individual splits are possible, as cancellations and bounce overflows are taken into 
account for each case. This reduces the number of possible total recipients and the 
correspondingly calculated percentages.

 l The number of possible recipients also considers the master mailing's target groups. 
If a target group with the recipient list of the master mailing contains fewer 
addresses than the same target group with the recipient list of the split, the number 
of recipients to be sent emails is the number calculated for the target group and 
recipient list of the master mailing.

 l If the total recipient number is reached during the dispatch of a split, the sub-
sequent splits and the master mailing are not be sent (see example 1 and example 
2).
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Target groups
Target groups used in the master mailing are inherited by the split mailings. You can add 
target groups to split mailings by linking with the target groups of the master mailing 
using AND logic. 

The number of matches of a target group in the recipient list of the master mailing fur-
thermore determines the maximum possible number of recipients for this target group. If 
the recipient list of a split contains more matching recipients for this target group, the 
total number of recipients sent an email will not exceed the number previously cal-
culated on the basis of the target group and recipient list of the master mailing.

Warning: Master mailing vs. split target groups
Avoid target groups in the main and split mailings that exclude 
each other (for example, "Male" and "Female"), because no recip-
ients will be selected for the split.

Note that the creation of target groups using recipient-based criteria can only apply 
when the corresponding criteria is also defined as a list box. Furthermore, if using a dif-
ferent recipient list for the split than for the master mailing, ensure that it incorporates 
the same data structure as the master mailing list – or at least that the list boxes for the 
master mailing target group  can also be found in the split. The description of the cor-
responding list boxes must be an exact match, including capitalization.

Example

If a target group is used in the master mailing with the criteria Recipients with interest 
"Football", the recipient lists of both the master mailing and the split must contain a com-
mon corresponding field, such as Interests.

Dispatch
To send a split mailing in the Split window, click  Start split or select the check box below 
Mailing schedule and specify a dispatch date using the calendar.

Dispatch order

Set the order of splits in the lower section of the Split mailing window via arrow keys to 
the right of each split. Splits associated with a master mailing are part of a hierarchy, 
which is determined by the order of the splits. This split hierarchy is referenced when cal-
culating recipients of splits and the master mailing.
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Note: Split hierarchy vs. sending order
When individual splits are manually started, the split hierarchy 
applies, without regard for dispatch order. For example, if the last 
split in a list is sent first, the recipients for the split and master mail-
ings are calculated on the basis of the overall split hierarchy.
Under certain circumstances, this may lead to a split being sent to 
fewer or even no recipients despite having started first. This is 
because the splits higher up on the list are allocated the complete 
number of recipients, and no recipients remain for the subordinate 
split. For more information, see Recipient calculation examples.
If the split dispatch is started automatically, the split mailings are 
sent in the order of the split hierarchy.

Optimizing and sending the master mailing
Split sending lets you analyze each split's performance and send the best performing 
variation as a master mailing.

Episerver Campaign also offers an automatic optimization. To activate it, select one of 
the following criteria from the Automatically use the best split for the master mailing drop-
down list. This criterion determines which split is chosen for the master mailing.

Note: Which criterion you use depends on mailing type, the quality 
of recipient data, and your marketing goals.

 l Best unique open rate. Split most opened by recipients (percentage).
 l Best unique click rate. Split most clicked by recipients.
 l Best effective click rate. Split with the best unique opens/unique clicks rate.
 l Lowest unique unsubscribe rate. Split that created the fewest unsubscribes.
 l Highest turnover. Split that created the highest revenue. This criterion only delivers 

valid results if Post-click tracking was configured for your client; otherwise splits have 
the result 0.

 l Lowest bounce rate. Split that created the fewest bounces.

There are three options to start the master mailing.

 l Save mailing and start it manually later. Start the master mailing manually by clearing 
the check boxes and selecting the default option  when editing the mailing in the 
Options tab. 
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 l Sending date for the master mailing. Set a sending date for the master mailing and 
select the check box to activate this option. Use this option if you usually send your 
newsletter at a certain day and time.

 l Sending delay for the master mailing after the last split mailing has been sent. Set a 
delay between the sending of the last split mailing and the master mailing. Select 
the check box to activate this option. 

Use this option to get reliable opens and click rates based on the split mailings, 
because not all recipients open and click the mailing immediately upon receiving 
it.

Split mailing examples
The following examples to help you understand the split module by showing recipient 
calculations and their results. They illustrate the hierarchies and dependencies of the 
master mailing and splits.

In all examples, it is assumed that recipients are valid (that is, no one is blocked, has can-
celed, or exceeded the bounce limit).

Example 1

The master mailing and splits are sent to the same recipient list. A limit on the recipient 
number is set in the master mailing. The splits comprise A/B testing (split A against split B) 
with different target groups. The recipient list contains 100 recipients (40 male, 40 
female, 20 unspecified). 

Mailing Recipient list Max. number of recipients Target group Sent emails

Master mailing A 28% (= 28 recipients) — 0

Split 1 A — male 28

Split 2 A — female 0

Result: The total number of recipients, as defined in the master mailing, was reached dur-
ing the dispatch of split 1. No emails are sent to Split 2 and the master mailing.

Example 2

Master mailing and splits are sent to different recipient lists. A limit for the total number 
of recipients is defined in the master mailing. Recipient list A (master mailing) contains 
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200 recipients (60 male, 60 female, 80 unspecified). Recipient list B (splits) contains 100 
recipients (40 male, 40 female, 20 unspecified). 

Mailing Recipient list Max. number of recipients Target group Sent emails

Master mailing A 28% (= 56 recipients) - 0

Split 1 B — male 40

Split 2 B — female 16

Result: The total number of recipients is determined by recipient list A and the limit of 
recipients defined in the master mailing. Split 1, only sent to male recipients with no 
sending limit, is sent to male recipients in list A. Split 2 is subsequently sent to 16 female 
recipients from the same list. At this point, the total number of recipients limit is 
reached.

Example 3

The master mailing and splits are sent to the same recipient list. Recipient list A contains 
100 recipients (20 male, 20 female, 60 unspecified). Three splits are created. 

 l Split 1 has the target group "male"
 l Split 2 "female"
 l Split 3 has the target group "male OR female" (so gender must be specified).

The master mailing does not define a target group.  Split 3 is to be sent first.

Mailing Recipient list Max. number of recipients Target group Sent emails

Master mailing A — — 60

Split 1 A 10% female 10

Split 2 A 10% male 10

Split 3 A 10% unspecified 0

Result: While the first two target groups are subsets of the master mailing target group, 
the target group for split 3   and the master mailing group exclude one another. To select 
recipients who did not specify gender, the target group of the master mailing should be 
"males OR females OR blank field".
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Send time optimization

Send time optimization detects when recipients actually check their inbox, and sends 
your message to each individual at a time that matches the rhythms of their life. As a res-
ult, your email appears at the top of the inbox. Send time optimization ensures that your 
mailing is received during key, attention-grabbing minutes, and does not get lost at the 
bottom of the inbox with a bunch of other messages. 

Send time optimization can increase the open rate for your messages by up to 25 per-
cent.  As a marketer, you benefit from the undivided attention of your recipients, which 
increases your return on investment.
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Why should you automate optimization?
Many marketers follow three simple rules to determine the best send time for their cam-
paigns, based on the findings of various studies.

 l Tuesday is the best day to send out mailings. Thursdays and Wednesdays are the 
next best days (the response rate by recipients is the highest in most industries on 
these days).

 l Around 10 AM is better than early morning, afternoon, or evening (recipient 
responses are the highest at this time for most industries).

 l Workdays are better than weekends.

Although the rules are based on many studies and billions of data sets, they are derived 
from average values, and do not consider each recipient's preferences (and also do 
not apply to every industry). Do not rely on average values or the assumption that "one 
size fits all" – rather, learn about the particular lifestyles of your customers. Adjust your 
send times to accommodate the preferences of your recipients.
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How it works
Send time optimization creates a personal profile for each recipient then analyzes their 
response behavior. Machine learning: The longer the customer relationship, the more 
accurate the optimized send time. And, if a recipient changes their behavior, their pro-
file is updated accordingly.

The self-learning algorithm also analyzes click behavior and message opens, because 
opens by themselves do not provide sufficient evidence of whether a recipient is inter-
acting with their inbox.

Around 70 percent of users now own a smart phone, and reach for it an average of 88 
times a day to check their inbox or open a message, if only to reduce their unread mes-
sage count to zero. When users check messages, they are much less likely to read 
emails in depth or to follow interesting links. Therefore, send time optimization considers 
the click behavior of recipients to determine when they are focused and responsive, 
not just clicking off a notification.

Benefits
 l Increase the open rate for your emails by up to 25 percent. 
 l Decrease likelihood that your message will go unnoticed. 
 l Your advertising messages are perceived as less obtrusive. 
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 l The service adjusts to the recipient's behavior, and changes the send time when a 
recipient changes habits.

 l Send time optimization is automated. 
 l It has a low learning curve. The feature integrates with the familiar, standard fea-

tures of Episerver Campaign. 
 l Virtually infinitely adjustable for up to 7 days.
 l A fallback time can be set for new recipients for whom behavioral data is not yet 

available.
 l Available for Smart Campaigns (including A/B tests). 
 l Analysis function to evaluate individual send times. 

Tip: Send time optimization is available only for the Email channel.

Setting up time optimization
To set up send time optimization, contact customer support. The feature as an extension:

 l in the Wait node for Smart Campaigns
 l in the A/B test node for Smart Campaigns
 l in the campaign analysis

Configuring send time optimization in the Wait node
This topic describes how to enable and configure the send time optimization in the 
Wait node within Smart Campaigns.

Once configured, your message is sent to recipients with sufficient behavioral data at a 
personalized send time. Recipients who lack sufficient behavioral data receive your 
message at the fallback time.

 1. Under Send date, specify a fallback.
 2. Enable send time optimization.
 3. Select the maximum length of time for the send time optimization.
 4. Adjust the start and end times of the send time optimization and, if necessary, 

shorten the preset maximum length.
 5. Check your settings in the info area.
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Specifying a fallback time
If there is insufficient data about individual recipients to determine a personalized send 
time, your message is sent to these recipients at the set fallback time. To specify a fall-
back time, perform the following steps:

 1. In the Create campaign window or the Edit campaign window within Smart Cam-
paigns, drag a Wait node from the left action pane into the workspace between the 
Recipients node and the Email node.

A context menu opens.
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 2. Under Send date, select an option and specify the fallback time.

Option The fallback time is set to Configuration

Wait until ... A fixed time. Specify a date 
and a time.

Wait until import has been 
finished

Immediately after the recipient 
import is completed.

No configuration  
needed

Start at ... after import has 
been finished

A fixed time after the recipient import 
is completed. Specify a time.
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Note: The Wait until import has been finished and Start at ... after 
import has been finished options are only available if the closed-
loop interface is configured in your client. If the closed-loop 
interface is not configured, only the Wait until ... option is avail-
able.

Warning: If the Wait until import has been finished or Start at ... after 
import has been finished option is selected, you cannot enable 
the campaign.

Enabling send time optimization
In the context menu, select the check box next to Send time optimization.

The Wait node's context menu includes:

 l options for maximum length (24 hours or 7 days)
 l a date slider
 l an info area
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Setting maximum length of time
Click 24 hours or 7 days.

Adjusting start and end times
You can adjust the start and end times of the send time optimization in 15-minute incre-
ments.  If you make no changes, the start and end times are set so that the fallback 
date is the midpoint of the selected maximum length of time.
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To adjust the start and end times without changing the maximum length of time, click 
the arrow keys on the sides of the date slider or adjust the slider using the computer 
mouse.

To adjust the start and end times and reduce the maximum length of time, click and 
grab the corresponding date tab with the computer mouse.
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Tip: You can adjust the 24 hours and 7 days defaults downwards and 
shorten the maximum length of time from 7 days to 3 days. You 
may want to do this for editorial purposes or short-term promotions.

Checking settings in the info area
Your current send time optimization settings appear in the info area. After completing 
the configuration, verify your settings in the info area, and change them if necessary.
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Configuring send time optimization in the A/B test 
node
If the Send time optimization feature is enabled in your client, additional options are avail-
able in the A/B test node within Smart Campaigns. This topic describes how to enable 
and configure the send time optimization in the A/B test node.

Note: The send time optimization feature is available only for the 
Email channel.

Send time optimization in the A/B test node is used only to determine the personalized 
send time of the optimized message (the main mailing). To optimize the time of sending 
of individual split mailings, use a separate Wait node for each split mailing and configure 
the send time optimization in the Wait node.

Tip: The end of this topic shows examples with figures illustrating 
which node you need for which scenario (an A/B test node and/or 
a Wait node):
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 1. Configure send time optimization only for the optimized message (the 
main mailing).

 2. Configure send time optimization only for split mailings.
 3. Configure send time optimization for both split mailings and the optim-

ized message.

To configure send time optimization in the A/B test node, follow these steps.

 1. Under the Send date specify a Fallback time.
 2. Enable the send time optimization.
 3. Select the maximum length of time for the send time optimization.
 4. Adjust the start and end times of the send time optimization and, if necessary, 

shorten the preselected maximum length.
 5. Check your settings in the info area.

Specifying a fallback time
If there is insufficient data about individual recipients to determine a personalized send 
time, your optimized message is sent to these recipients at the fallback time. To specify 
a fallback time:
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 1. In the Create campaign window or the Edit campaign window within Smart Cam-
paigns, drag an A/B test node from the left action pane to the workspace, between 
the Recipients node and the Wait node/Email node.

A context menu opens.

 2. To enable automatic optimization, select the check box next to Activate automatic 
optimization.
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 3. In the drop-down list, select the type of optimization.

 4. Under Sending date of the optimized message, select an option and specify the fall-
back time.         
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Option The fallback time is set to Configuration

Date and time A fixed time. Specify a date and a time.

Delay after last split Immediately after the delay. Specify the delay time.

Manual The manual start time. No configuration step needed.

Enabling send time optimization
Enable the send time optimization feature after setting the fallback time.

In the context menu, select the check box next to Send time optimization.
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You have enabled send time optimization. The context menu now includes:

 l options for the maximum length of time (only for the fallback Date and time)
 l a date slider
 l an info area

Setting maximum length of time
Set the maximum length of time that Episerver Campaign can use to optimize the send-
ing of optimized messages/main mailings:

Click 24 hours or 7 days.
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Adjusting start and end times
You can adjust the start and end times of the send time optimization in 15-minute incre-
ments. If you make no changes, the start and end times are set so that the fallback 
date is the midpoint of the selected maximum length of time.

To adjust the start and end times without changing the maximum length of time, click 
the arrow keys on the sides of the date slider or adjust the slider using the computer 
mouse.
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To adjust the start and end times and reduce the maximum length of time, click and 
grab the corresponding date tab with the computer mouse.
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Tip: You can adjust the 24 hours and 7 days defaults downwards and 
shorten the maximum length of time from 7 days to 3 days. For 
example, for editorial purposes or short-term promotions.

Checking settings in the info area
Your current send time optimization settings appear in the information area.

Check your specified configuration in the info area, and change your settings if neces-
sary.
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A/B test node examples
You can configure send time optimization in one of three ways for an A/B test:

 1. Only for the optimized message (main mailing)
 2. Only for split mailings
 3. For both split mailings and for the optimize message

Only optimized message/main mailing

To only configure the send time optimization for the optimized message or the main 
mailing, configure the send time optimization in the A/B test node only. 
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Only split mailings

If you want to send split mailings using a send time optimization, use a separate Wait 
node for each split mailing, and configure the send time optimization in each Wait 
node. 
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Both split mailings and optimized message or main mailing

If you want to configure a send time optimization for both split mailings and the optim-
ized message or main mailing, configure the send time optimization in the A/B test node 
and in the Wait node of the split mailing.

For information about the Smart Campaigns node and the split dispatch, see Smart Cam-
paigns nodes and Sending a split mailing.

Analyzing mailing send times
If send time optimization is set up in your client, you will have access to the Send time 
optimization overview, an additional analysis feature of Smart Campaigns, The overview 
analyzes the distribution of mailing send times and peak send times. The overview also 
displays the number of recipients to whom your message is sent at the fallback time 
because there was insufficient data to determine a personalized send time.

To generate and view the send time optimization overview, follow these steps.

 1. Open the start menu and select Campaigns > Smart Campaigns. The Smart Cam-
paigns window opens.
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 2. Select the campaign to generate an analysis and view the Send time optimization 
overview.

 3. Click Analysis. The Episerver Campaign analysis window opens.
 4. Click New analysis.

A new campaign analysis containing the Send time optimization overview is created. 
Next,  you see context menus with data about recipients and the campaign nodes.

Note: It may take a few minutes to generate the analysis.



© Episerver 2020

Campaigns | 259

 5. To view the Send time optimization overview, click the corresponding Wait node or A/B 
test node. The overview appears.

 6. The Send time optimization overview display the distribution of mailings, peak send 
times, and number of recipients to whom your message was sent at the fallback 
time.    

 l To zoom in on the graphic, click and drag the computer mouse over the desired 
time window.



© Episerver 2020

260 | Episerver Campaign User Guide 2020-04-23

 l To return to the default view, click Reset zoom.

 7. To close the Send time optimization overview, click Close   in the upper right corner.

Validating mailing prior to dispatch

Note: To enable this feature, contact customer support.

This add-on validates whether predefined parameters of a mailing are met. The val-
idation is carried out prior to dispatch or when the mailing is saved. You can configure 
this automatic test for virtually any parameter of a mailing. You can validate against a 
defined value or check if a parameter is set.

Examples
 l Mailing must contain an attachment
 l Maximum number of emails per hour is set for dispatch and lies within a defined 

range
 l Target group is selected
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Sending automatic notification after dis-
patch

Note: To enable this feature, contact customer support.

This add-on sends a notification to an email address after a mailing is sent. The noti-
fication contains sending date and time, number of recipients, and additional mailing 
details.

Sending S/MIME-signed emails

Send S/MIME signed emails via Episerver Campaign and increase your recipients’ con-
fidence. Thanks to your digital signature, your recipients can rest assured that the mes-
sages were sent by you, and the content was not subsequently manipulated. The digital 
signature includes components of an email, for example, attachments.

Note: Digital signatures only ensure data integrity and do not apply 
to confidentiality. Emails protected with a digital signature are still 
sent as plain text. Message encryption of the S/MIME standard is 
not supported.

Note: Prerequisites
To send S/MIME-signed emails via Episerver Campaign, you need 
the following:

 l S/MIME certificates feature
 l S/MIME certificate issued by a certification body, which certifies the 

authenticity of the respective email address, for each email address 
used to send messages
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Setting up S/MIME certificates

Note: To enable this feature, contact customer support.

Open the start menu and select Administration > S/MIME certificates.

To get an S/MIME certificate for your email, contact the certification body.

Importing S/MIME certificates
To import one or several S/MIME certificates, perform the following steps.

Note: The certificate file must be in PKCS12 format. If it is not avail-
able that format, convert the file to that required format.

 1. Open the start menu and select Administration > S/MIME certificates. The S/MIME cer-
tificates window opens.

https://www.digicert.com/client-certificates/
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 2. Click Import PKCS12 keystore. The Import PKCS12 keystore dialog box appears.    

 3. Click Browse... and select the certificate file to upload.
 4. In the Password box, enter the backup password for your certificate file.
 5. Click Import.

You can find the certificate file in the list in the overview. See the list for information 
about the associated email address, the certificate's validity date, the creation and 
modification dates, and when the certificate is uploaded or changed.

Tip: If you stored a S/MIME signature for your sender address, the 
notification signed with S/MIME is displayed in the Edit content 
window above your sender address any time you edit a mes-
sage.
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Deleting S/MIME certificates
To delete a S/MIME certificate, perform the following steps:

 1. Open the start menu and select Administration > S/MIME certificates. The S/MIME cer-
tificates window opens.

 2. Select the S/MIME certificate you want to delete.
 3. Click Delete. A confirmation window opens.
 4. Click Delete certificate.

Mailings Classic

Note: This feature is deprecated and its functions are part of Smart 
Campaigns.

Tip: To migrate Mailings Classic mailings to Smart Campaigns and 
edit them there, follow these steps.
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 1. Open the start menu and select Smart Campaigns, select a Mailings Clas-
sic mailing from the list and click Copy. The selected mailing is duplic-
ated and displayed as a campaign in the Smart Campaigns editing 
window.

 2. Edit the campaign if necessary.
 3. Click Save and close. The Save campaign dialog box opens.
 4. Enter a new name if required.
 5. Click Save.

The Mailings window shows mailings that were created with this client/account. 

 l Status. Indicates whether the mailing was sent, is being sent, or is still being worked 
on (status = new). 

 l Start date. Only filled in if a date is set for a mailing.
 l Type. If your account is authorized to display the type, the corresponding column dis-

plays the specific type of each mailing. Types may be selected from the following:     

 o Regular: Standard mailings.
 o Special/API. Mailings that are unique  and activated using an interface (API) or an 

event. For example, a prepared mailing that every recipient receives once 
each year, such as on his or her birthday.

 o Registration confirmation. Prepared greeting mails are sent to new recipients.
 o Templates. Pre-configured mailings that contain sender information or content 

to simplify new mailing creation. Mailings of this type cannot be started.

Mailing action buttons
The buttons below the mailing list start one of these actions.

 l Create. Create a new mailing and configure the mailing within a few steps. If your cli-
ent is configured for different media types, you can create emails and short mes-
sages.

 l Duplicate.  Copy an existing mailing. The entry fields (subject, content, recipient list 
and so on) are filled with the same values as the source mailing.

 l Edit. Change the values in a mailing, only if sending is not started.
 l Delete. Delete a mailing that was not sent.
 l Start. Start a mailing.
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 l Abort sending. Cancel the sending of a mailing.

Note: You cannot restart an aborted mailing.

 l Split: See Sending a split mailing.
 l Preview.  Display a personalized preview of a mailing with the following steps:     

 1. In the Mailing drop-down list, select a mailing.
 2. Click Preview.
 3. In the Recipient list drop-down list, select a recipient list then a recipient.
 4. Click Show.

Information area
The area in the below half of the screen offers information about your mailings. Select a 
mailing from the  list above.

 l Details.  Displays data about the selected mailing, such as ID, name, creation date, 
sending date, recipient list(s) and target groups.

 l Report: Displays the most important report data for the mailing. Until the mailing is 
started, fields are empty or zero. 

Note: Some fields show two values. The italic value indicates a 
unique value, such as a unique user action. If a recipient clicks 
one link several times, this counts as one unique click because 
the same recipient clicked the same link.
If percentages for Gross-... are indicated, the value is related to 
the total number of recipients for a mailing. If the Gross-... prefix 
is not used, the value relates to the number of Recipients w/o 
bounces. The latter is the more practical count, because it 
refers to recipients who received the mailing and could react, 
either in the form of opens or clicks.

The following values are displayed in the summary:

Tip: The following list is only a summary of the most important core 
indicators. More comprehensive reports can be found under 
Reports.

 l Recipients. Number of recipients to whom Episerver Campaign attempted to send a 
mailing.
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 l Recipients w/o bounces. Number of recipients whose email addresses did not pro-
duce a bounce (message of non-deliverability).

 l Recipients skipped. Number of recipients to whom the mailing could not be sent 
because their addresses were false.

 l Recipients in queue. Only applies to mailings currently being sent. Number of recip-
ients who were not sent a mailing.

 l Bounces. Number of non-deliverability messages received by Episerver Campaign 
after a mailing.

 l Bounce rate. Percentage of bounces.
 l ... of which are hard bounces. Percentage of hard bounces.
 l ... of which are soft bounces. Percentage of soft bounces.
 l Unique opens. If a recipient opens a mailing several times, this option only counts 

them as one unique open.
 l Opens. Number of opens.
 l Unique open rate. Percentage of unique opens in relation to the number of recip-

ients w/o bounces.
 l Open rate. Percentage of opens in relation to the number of recipients w/o 

bounces.
 l Unique gross open rate. Percentage of unique opens in relation to the number of 

recipients.
 l Gross open rate. Percentage of opens by recipients.
 l Unique clicks. Number of unique recipients that clicked an arbitrary link in a mailing. 

It does not matter how often and which link was clicked.
 l Clicks. Number of clicks.
 l Unique click rate. Percentage of unique clicks in relation to the number of recipients 

w/o bounces.
 l Click rate. Percentage of clicks in relation to the number of recipients w/o bounces.
 l Unique gross click rate. Percentage of unique clicks in relation to the total number of 

recipients.
 l Gross click rate. Percentage of clicks of recipients.
 l Effective unique click rate. Percentage of unique clicks in relation to the unique 

opens.
 l Unique unsubscribes. Number of clicks on the unsubscribe link.
 l Unique unsubscribe rate. Percentage of clicks on the unsubscribe link in relation to 

the number of recipients w/o bounces.
 l Unique gross unsubscribe rate. Percentage of clicks on the unsubscribe link in relation 

to the total number of recipients.
 l Content preview. Displays the mailing and its subject line.
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Step 1. Name and description

Note: This data is used internally by Episerver Campaign. It is not 
part of emails sent to mail recipients.

Enter a name to identify your mailings, such as "Customer Newsletter from May 23, 2018" 
or "Product Information for Ball Bearing 234/3 Rollout".

The Description field is optional. Content here shows up in the Overview menu item.

Select a mail format.

 l Text only. Use for most personal emails. You cannot include images, colors, or bold 
text.

 l HTML only. Use to mail  in HTML. Be aware that recipients may receive unreadable 
emails if they have older email software that cannot display HTML.

 l Multipart. Contains content in text and HTML formats. The HTML version is shown to 
most recipients. If the recipient's email software cannot display HTML, the text ver-
sion is displayed.

Tip: Some people prefer HTML mail because of additional features 
and information (images, color highlighting and so on), while oth-
ers prefer text email to read without graphical distractions. Con-
sider letting recipients choose between text and HTML format 
when subscribing to your newsletter, and save this information in 
your database.

Step 2. Recipients and sender

Recipients
You can select one or more recipient lists for mailing by enabling the associated check 
boxes. Episerver Campaign ensures that recipients on several lists only receive the mail-
ing once.
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You can select a target group to address a subset of a recipient list.  Use target groups 
to guarantee that each test mailing is addressed to different recipients, and no recip-
ient will receive two mailings. To do this:

 1. Send the first test mailing.
 2. Create a target group with the definition Recipient did not receive [name of the first 

test mailing]. 
 3. When sending the second mailing, select this target group.
 4. When sending the mailing to the remainder of the list, continue in this manner.

In this case, the target group should be defined as Recipient did not receive [name of the 
first test mailing] AND Recipient did not receive [name of the second test mailing].

To display the number of recipients, click Calculate the number of possible recipients.

Determining the order of recipients in a mailing

By default, recipients are addressed in the order in which they were entered into the list. 
To use a random selection of available recipients, select the Random selection check 
box.

Testing different versions of a mailing

 1. In the Maximum number of recipients box, specify  a number of recipients. 
 2. Copy the mailing.
 3. Modify one or more parameters (subject, content, and so on).
 4. Send that version to a different part of your list. 
 5. Compare results (clicks, openings, and so on).
 6. Copy the mailing with the best performance to be sent to the remaining recipients.

Sender
You can specify which sender address should appear in the recipient's email software 
when your message is received. 

 l Email address. Enter the address section of the sender in this field. The domain sec-
tion (behind the @) is fixed and cannot be changed.

 l Name. This is typically your company name.

For example, "Example Inc. [info@example.com]": "Example Inc." is the name and 
"info@example.com" is the email address.
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Tip: Be consistent in your sender address. Changing your email 
address or name may cause the recipient's email program to treat 
your mailings differently, and negatively impact your mailing's suc-
cess.

Step 3. Subject and content

Editing content
Content management system (CMS), the Episerver template kit or HTML code: read 
about editing tools for your mailings in Editing message content.

Subject
Your mailing's subject line appears next to the sender address in the recipient's email 
program. The sender and subject most strongly influence a mailing's open rate. 

You should limit the subject's length, such as 45-60 characters, because some email pro-
grams might cut off longer lines. 

Content templates
The content of your mailing is created using content templates in Episerver Campaign. 
Use the Free Text template if you create your mailings externally (outside of Episerver 
Campaign), for example, through your agency or yourself using an HTML editor. This tem-
plate lets you copy prepared text and HTML content directly.

However, if your mailings will have the same appearance (as is usually the case for news-
letters), you can save time using specially-prepared content templates. The templates 
are designed to your specifications by Episerver. Or, you can use the Template Kit.

Using content templates, you can create the content of your mailing using predefined 
modules. When creating a new mailing, just enter the text and upload images. Episerver 
Campaign creates a completely formatted mailing. No knowledge of HTML is needed.

To use a template for your mailing, select it and click Edit.

Tip: About templates
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See Designing a newsletter about email design using templates. 
Get tips and instructions for design and examples and suggestions 
from template developers.

Content attachments
To send attachments with a mailing, click the Attachments tab. If you have already sent 
mailings with attachments, the attachment files appear in the overview. To send one of 
these files as an attachment to the current mailing, select the check box next to the file 
description. 

To send a new file as an attachment, follow these steps.

 1. Click New. The assistant for uploading attachment opens.
 2. Select whether to upload a file from your computer, or a URL that links to a file. If you 

choose Upload from hard drive, a copy of the file is created in the Episerver Cam-
paign server. If you choose Use URL, make sure that the file is available when the mail-
ing is sent.

 3. Click Next.
 4. Click  Browse... and select the file to be uploaded. If you link a file using a URL, enter 

the full URL.
 5. Click Next.
 6. Complete the File name and Description boxes. Episerver Campaign uses the name 

and description  for internal management of the attachments, but not for the send-
ing.

 7. Click  Save to make the file available as an attachment. After you upload or link the 
file, it appears in the list and can be sent as attachment for current and future mail-
ings.

Note: Special characters in file names of attachments
Do not use an umlaut and ß in the file name. Some email clients 
remove special characters from the file name. Nevertheless, the 
recipients can still open and save the attachments. Only the name 
is changed.

Warning: Do not delete files from the list of attachments even if they 
only were attached to a single mailing. If you the file from the file 
server, it will no longer be available to recipients when they open 
the email.
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Note: Send attachments in offline HTML mode
Attachments sent in this mode are loaded immediately upon 
receipt of the email. So, do not send large files in this mode, as this 
may delay the receipt of the email.
Due to a bug in the Apple email client, attachments sent in HTML 
offline mode do not appear in Apple Mail and on iPhones. If you 
send attachments in standard mode, there is no such problem.            

Personalized Attachments

Use Personalized Attachments to send attachments to particular recipients. Before 
sending the email, you must transmit such attachments to  Episerver Campaign using 
HTTP API. The uploaded attachments can be used when sending transaction emails. For 
example, you can send invoices and order confirmations to your recipients. See the 
HTTP API manual.

Character set

Use the drop-down list Character set ("Encoding") to select the character set to be used 
for encoding your mailing. 

 l ISO-8859-1. For recipients in German-speaking, Western European and North Amer-
ican countries.

 l ISO-8859-2. For recipients in Central-South-Eastern Europe, for example in Poland, 
Croatia or Slovakia.

 l UTF-8. Supports most special characters of all languages. Select this encoding if you 
are writing to recipients in other regions of the world, such as Eastern Europe or Tur-
key.

Step 4. Tracking
Specify settings that affect the measurement of important parameters, which determ-
ines the success of your mailings.

Opens
If you check the Track opens box, Episerver Campaign monitors how many recipients 
opened your mailing. This number is available in a report generated later.

https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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When sending a mailing, Episerver Campaign inserts at the bottom of each email a ref-
erence as a 1x1 pixel, transparent graphic. This reference contains a unique ID for each 
recipient. When the recipient opens the email, the program loads the graphic from the 
Episerver server. Episerver Campaign then receives the recipient ID, so it can track that 
the user opened the email.

This measurement is only possible if the user opens an HTML mail (text mail does not sup-
port graphics) and is online at that time. So, you should perceive the rate of opens as rel-
ative, not absolute. If, for example, the open rate doubles from one mailing to the next, 
you probably selected an enticing subject line.

Clicks
If you check the Enable link tracking box, clicks on links in the mailing are recorded. This 
number can be retrieved in a subsequent report.

Episerver Campaign displays a list that includes links you used. In the Occurrence 
column, you can see how many times each link is used in the text or HTML section. The 
Description column better identifies the link in subsequent reports. 

Because URLs can be long and cryptic, you can enter a clear label for each link here. 
To do that:

 1. Mark the line you want to modify.
 2. Click Edit link. 
 3. In the description field, enter the name for the linked page (such as Homepage, 

Order form and so on). 
 4. Click Apply.

The HTML on or Text on column lets you determine whether to record clicks for each link 
and content type (Text/HTML). Normally, it is useful to track each link in HTML email. But 
in plain text email, you may want to keep URLs clean and readable instead of trans-
forming them into cryptic tracking links. For example, in "For information, click www.ex-
ample.com," the link is more likely to be clicked than a tracking link consisting of 
symbols and numbers.

Click profiles
In the Click profiles column, you can assign a link to a click profile. To do so:

 1. Select a link.
 2. Click Edit link.
 3. Click the Profile field. 
 4. In the Assign click profile window, select one or more profiles and click OK.
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Rule-based click profiles are displayed without having them assigned to the respective 
link, because they are assigned automatically. You may add more profiles, though, to 
rule-based profiles. 

Rule-based profiles cannot be removed from a link to which they are assigned. But, you 
can assign a link that does not match the rule to the profile based on the rule.

Step 5. Test email
Before sending any mailings, send a test mail. This topic explains the test lists configured 
for your account. Normally, there is one list of people who can receive a test mail (you, 
your co-workers, superiors and so on). 

When you select a test list, its recipients are displayed below.  To add a recipient, click 
Add recipient.

To send a test email, select recipients by checking the box and clicking either

 l Send email. Sends a multi-part message
 l Send HTML version. Sends a HTML message
 l Send text version. Sends a text message

If the format is Text or HTML, you cannot send a multi-part test email. If your default 
format is Multipart, you should test all three options  because your email client does not 
let you decide whether you want to receive a multi-part email as plain text or HTML.

Click Test email to target group to open a wizard that helps you send target group-based 
versions of your mailing, even if they do not match the target group criteria.

Tip: If you use a personalized subject line, make sure that your test 
list contains the same fields used for personalization (for example, 
name). Otherwise, the test emails have the default subject line, 
because no personalization field is available to create a per-
sonalized subject line.

If you want to change the mailing after receiving test email, go back to step 3, change 
the content, then send a new test mail.
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Step 6. Sending options
In the Options tab, select the mailing's sending time and speed. Furthermore, you can 
select a folder in which to save your mailing. 

Whether you send your mailing now or later, it is saved in this step. If you select the 
option Save mailing and start it at the following date and time or Save mailing and start it 
manually later, you can edit your mailing until it is sent. But mailings that start imme-
diately cannot be changed. 

Saving mailing and starting it manually later
Use this option if you, for example, are waiting for a release for your mailing, or if you 
know that changes need to be made, or if the sending time is not determined. Any time 
after saving the mailing, you can use the Overview menu item to call up and change it.

Saving mailing and starting it at a later date and time
If your mailing is to be sent at a predetermined time, set the desired start date and time 
in this Mailings window field.  To do so, click the arrow next to the current date. A cal-
endar opens, from which you can select the mailing date and time. You can also 
change the mailing after it is saved (and before the specified starting time). 

Saving mailing and  delaying start after all split mailings are sent
This option lets you set a delay between the sending of last split mailing and the main 
mailing. It is helpful, for instance, to get reliable opens or click rates, because not all 
recipients open and click a mailing upon receiving it. The delay should be from a 
couple of hours to a couple of days.

Starting mailing immediately
Use this option if you tested your mailing and want to send it immediately. Be aware 
that the mailing starts immediately after clicking Save. Afterward, you cannot make cor-
rections.
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Saving mailing in a folder
To choose a folder in which you want to save your mailing, click the Folder field and 
select a folder. Alternatively, click the plus icon + in the status bar to create a new 
folder.

Setting the sending rate
Episerver Campaign sends up to 50 million emails  per hour. In some cases, this is too fast. 
For example, you have a large mailing list, and the mailing encourages recipients  to 
call a telephone number. Your call center could get overloaded. In such a case, set a 
maximum number of mails to send per hour. The minimum is 1,000 per hour.

If you leave the field blank, your mailing is sent at maximum speed.

Offline HTML
This option attaches images and style sheets directly to the email. This option may 
provide a better representation of your mailing in a recipient's email client, but may 
also result in a worse deliverability of your email.

Also, offline HTML may increase the price because the overall size of every email grows. 
In addition, open tracking is disabled (clicks are counted as opens anyway).
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Managing content

The Episerver Campaign’s content management system lets you  create, edit and man-
age mailing content, and design interactive and personalized content.

 l Edit mailing content. Use the integrated content editor.
 l The Template Kit. Create and edit mailings with the mailing kit.
 l Field functions. Script and use field functions.
 l Coupon system. Create coupon blocks and embed coupons in mailings.
 l Countdown timers. Create countdown timers and embed them in mailings.
 l Click2Go. Create call-to-action buttons and embed them in mailings.
 l Easy Copy. Copy mailing content.
 l Mobile Fusion. Optimize mailings for mobile display.
 l Attachments. Upload and edit attachments.
 l Prefix or suffix subject line. Enable text to be automatically added to subject lines.
 l Uploading files. Upload files manually.
 l Updating mailing content prior to dispatch. Update content before dispatch via the 

content interface.
 l Publish mailing. Copy mailings to other clients.
 l Video emails. Embed videos in mailings.
 l Designing a newsletter. Layout tips for newsletter design.

Editing mailing content

Whether you use the Episerver Template Kit or a custom template to edit your mailings, 
the integrated CMS Easy edit provides a comfortable and intuitive rich text editor that 
displays the mailing as it will look when sent. Editable content elements have a menu bar 
with buttons for editing, moving, copying and deleting.



© Episerver 2020

278 | Episerver Campaign User Guide 2020-04-23

Depending on your template configuration, you might be able to, for example, edit 
some elements, but not move or delete them. In this case, the menu bar shows only the 

Edit button .

Tip: Click Tour next to the action buttons at the upper right edge of 
the editor window for an interactive tour of the Template Kit.

Tip: On the left side above is the sender, subject, attachments area. 
You must enter a sender, a sender email address and a reply-to 
email address  to be able to send the mailing. For more inform-
ation, see Smart Campaigns Step 2. Configuring the Message.

Paragraphs
On the left side, you can find a preview of your mailing template with its paragraphs 
(content elements). Paragraphs can contain various content types (text, images, ban-
ners, lists, and so on). In a template, content is included as a paragraph. You can 
add,import, edit, move, copy, and delete paragraphs.

Add
The New: ... button appears wherever you can insert a new paragraph. Click it to insert 
one. Depending on the complexity of your template, you must select a sub-type of the 
inserted paragraph in the next step. Click  Save to add the new element to your mailing.
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Import
 1. Click New: ....
 2. Click  Import paragraph and select the source.
 3. In the Source client drop-down list, select a client. If you only use one client, it is 

already selected.
 4. In the Source content drop-down list, select a message or message template and 

click Next. Importable paragraphs from the source are shown.
 5. Check the boxes of paragraphs you want to import.
 6. Click  Import paragraphs.

Edit

To edit a paragraph click Edit . The edit area opens in a new layer on the right side.

You can edit texts by using the rich text editor.

Paragraph types contain several tabs and input fields for entering content, setting the 
layout, and assigning target groups or click profiles. See Template Kit.

Inline editing

Instead of using the rich text editor, you can edit texts directly by clicking on the text 
below a paragraph. The editor toolbar with buttons for text formatting appears.
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Tip: The rich text editor has an additional Source button that lets 
you edit the text's HTML code.

Move

Note: You can only add new paragraphs at the end of a content 
section (header, footer, paragraph group and so on).

To move a paragraph, click Move  and move the cursor where you want to insert it. 
When the message Click here to move the selected paragraph above this paragraph 
appears, click again.
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Tip: Some paragraphs cannot be moved everywhere, or can only 
be moved within a certain section.

Copy

To copy a paragraph, click Copy  then move the cursor to the position where you 
want to insert it. When the message Click here to copy the selected paragraph above this 
paragraph appears, click again to drop and insert the copied paragraph.

Delete

To delete a paragraph, click Delete .

Tip: Some paragraphs cannot be deleted.

Working with the rich text editor
For any text input (except headlines, subtitles or links), templates provide a rich text 
editor. The rich text editor opens in the right side configurations window when clicking 
on the name of a paragraph or when creating a new content paragraph with optional 
text.
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The editor toolbar has buttons for simple text formatting similar to those in text pro-
cessing software.

Change the content and click Apply; a preview appears on the left side. You can 
change the view mode to HTML, mobile, text and online preview of the mailing.

Change background color
When working in the rich text editor with a white font or very light font, change the 
editor background color to make editing easier. Click Change background color  in 
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the toolbar of the relevant text field. Click the button again to change the background 
back to white.

Field functions

In the editor toolbar, click Insert field function  to insert a field function. Field functions 
can insert the content of a recipient list field, a personalization algorithm, or other per-
sonalized content.

Tip: Personalized links
You also can use field functions to create personalized links in your 
mailings. You can use field function placeholders in the domain 
part or path of a URL and in URL parameters. The link tracking of per-
sonalized links works as in regular links.

Images

You can insert images directly into the text field by clicking Image .

Some paragraph types also let you insert an image, either in the General tab or in Image 
tab. If an image can be inserted, you find a  Browse... button and an Alternative URL field. 

Images can either be uploaded from your computer or referenced via a URL. If you 
choose the latter option, make sure the image is available at the indicated server when 
the mailing is being sent. Otherwise, the sending cannot be done. 

 l Image files can be formatted as .jpg, .jpeg, .png or .gif.
 l Images used in a mailing are automatically scaled to the size defined in the tem-

plate. For the best image quality, however, you should resize images to fit before 
uploading them.

To delete an image, click  Delete then Save.

Changing view
You can change the view mode of the mailing preview to HTML, Mobile, Text and Online 
version. To change the view mode, click one of the tabs at the top left.

 l In HTML preview mode, menu bars and buttons are hidden, and you see the mailing 
as it will appear to recipients.

 l The Mobile tab displays a preview of your newsletter on several mobile devices and 
with various display modes. See also: Previewing on a mobile device.
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 l The Text tab shows the text-only version of the mailing.
 l The Online version tab shows the mailing as recipients will see it when they click the 

online version link on top. 

Previewing on a mobile device
The Mobile tab lets you preview your mailing on mobile devices. If you use a template 
with integrated mobile version/Mobile Fusion, the optimized layout for each device is 
automatically shown. If you do not use a Mobile Fusion template, the HTML version 
appears and scales to fit the display of the selected mobile device.

Note: The preview of a mailing serves only to test content and lay-
out of the mobile version. The actual appearance on the devices 
may differ due to software versions and settings. To implement a 
preview for a mobile device not listed here, contact customer sup-
port.

To test different devices and display modes, perform the following steps:

 1. In the list above the preview, click a mobile device. The mailing preview for this 
device is displayed.

 2. Hover over the mailing preview; the arrow changes to a hand icon. 
 3. Click and move the mailing to scroll down and up in the preview.



© Episerver 2020

Managing content | 285

 4. Click Rotate device  to switch between portrait and landscape mode.
 5. Move the slider on the right to change the scale of the preview.

Action buttons
 l Target group. Does not become active until at least one content element uses a tar-

get group. Click, select one or more target groups, and click  Submit selection to see 
only content elements assigned to the selected target groups.

 l Landing pages. Create a landing page from the mailing. The layout of landing pages 
is the same as for the mailing. You can edit landing pages the same way you can 
edit the associated mailing.

To create a link to a landing page, in the URL box, enter the placeholder {Landing 
page:n°}. In this placeholder, substitute the n° element with the landing page number 
(for example, {Landing page:1}).

To find out a landing page's number, click  Landing pages to open a list of landing 
pages and their numbers.
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 l Test message. Send a test message to check the appearance of the mailing before 
the actual dispatch. For a test email, do the following:

 1. In the top toolbar in the editor, click Test message.
 2. In the Recipient list drop-down list, select a test list.

Note: Only use test lists and no real customer data. See also 
Recipient lists.

 3. If you want to simulate a target group, select a target group in the Simulate tar-
get group drop-down list.

Note: The test recipients selected in the next step can also 
belong to other target groups.

 4. In the Recipients drop-down list, select one or more recipients.

To create a new test recipient, click Create recipient and enter the necessary 
recipient data. Then click Submit.

 5. Click Send email to send the test messages in multi-part format, or click Send 
HTML version or Send text version if you want to test only one format.

Tip: If you want to send a test message of type SMS or Mobile 
Push, see Nodes and elements.

 l More. Contains the menu items Content Report, Print, HTML (PNG), Retrieve RSS feeds 
and Edit directly.

Note: The rich text editor cannot be used after the Edit directly 
option is enabled.

Tip: Closing the editor window automatically saves changes.

Edit directly (HTML)

Warning: If you activate the Edit directly mode, the original tem-
plate cannot be edited afterwards. If you switch back from the Edit 
directly mode to the template editor, changes made in this mode 
are lost.
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Instead of editing a template, you can edit the mailing's HTML source code. In the 
editor window's top toolbar, click the action button More > Edit directly. Now, edit the 
HTML source code or the text version of your mailing. Select the tab to edit the desired 
version. Before you save changes, select the Activated check box.

Editing tools
When editing HTML code, click Format content. The code is reformatted, inserting line 
breaks and indenting the tags.

Before saving, click  Compress content to remove the line breaks and indented tags. This 
removal ensures that velocity elements in the HTML code (for example, field functions) 
work correctly.

Template Kit

Note: Mailings created with the Template Kit are displayed cor-
rectly by the most common email clients and web browsers. 
Episerver regularly checks compatibility, but individual email cli-
ents may cause display errors.

The generic Template Kit provides a flexible way to create newsletters. You can use it 
out-of-the box and with your corporate design style guide. Optionally, you can add 
Mobile Fusion to the Template Kit to optimize mailings for mobile devices
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 l Transferring design specifications into the Template Kit

If your company works with design specifications, use the Template Kit to turn these 
directly into mailings with no special knowledge of graphic design or composition. 
Studies show that most design specifications can be mapped using the Template 
Kit. The layout of structural and content elements follows a logical pattern found in 
most newsletters. Episerver uses standard terminology for the individual elements, so 
you can work with the Template Kit whether you are a graphic designer, editor, or 
project manager.

 l Content inherits basic settings

When basic preferences (such as text, background colors, spacing, and so on) are 
set, they are applied to content matter. This provides a consistent layout without 
needing to set additional preferences for content elements.  The principle of hier-
archical acquisition guarantees a layout-compliant/CI-compliant newsletter 
without the need to define each parameter. But If you need a different layout, 
whether at a structural or a content level, you can design each element.

 l Separation of structure and content

When developing the Template Kit, Episerver implemented the systematic sep-
aration of structural and content elements. This feature provides the highest level of 
flexibility when designing newsletters.

 l Configuration paragraphs for organizing your newsletter

Configuration paragraphs greatly expand your design options. Each configuration 
paragraph functions like a section of the newsletter, which you supply with its own 
layout and content. Header and footer segments are also set up as configuration 
paragraphs.

 l Flexible tables of contents

The table of contents is the recipient's point-of-entry to your newsletter's content, 
and greatly impacts conversion rate. The Template Kit provides full control over the 
table of contents. Each configuration paragraph can have its own table of con-
tents.

 o Single or two-column grids

Episerver provides multiple column layouts.  You can set column width, position 
and spacing. You can set the configuration paragraphs individually, whether 
they are part of a single or two column layout.

If your mailing needs both layouts, be sure to use them efficiently and rationally. 
For example:
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 n A two column editorial with a table of contents in a sidebar: Make the most 
important content visible immediately without having to scroll, and place it 
in a prominent position next to the editorial, where references can be made 
to them.

 n A single column product area: A sidebar is not needed in the product area. 
Use a single column layout to take maximum advantage of the newsletter's 
full width.

 l Fully equipped and seamlessly integrated

You can assign each element to a target group. You can also design pre-headers 
and newsletter headers and footers for specific target groups.

 o Click profiles

The assignment of click profiles is integrated into the elements, so you can 
obtain valid data about recipient click behavior.

 o Sharing content via social networks

You control what content is shared (SWYN), and the layout of share buttons and 
redirection.

 o Create landing pages

You can create landing pages with a single click, edit them in the template 
editor, and link them to the desired location. Using the SWYN feature, landing 
pages are created and linked automatically.

 o Use pre-headers for a personalized approach

You can include a greeting, a special offer, or a keyword specifically tailored to 
a target group. 

 o Integrate your favicon

Favicons are small icons, logos or symbols (such as your company logo) of 16×16 
or 32×32 pixels. Typically, browsers display them in the address bar, on tabs, next 
to bookmarks, or in your history. You can integrate a favicon  into the online ver-
sion of your message with Episerver Campaign.

Designing a newsletter
Using templates, you can create mailings in a CI-compliant layout – with no graphics or 
HTML skills required. Templates offer you the flexibility you need by letting you design 
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each element individually. And you do not have to worry about losing your overall lay-
out, because templates store settings inherited from higher-level elements. Benefit: Text 
and mobile versions of your HTML mailings  are generated automatically and can be 
edited subsequently.

Tip: Lacking inspiration? Episerver can create your newsletter for you.
Episerver can design your content template. On request, we can 
also implement your content template into Episerver Campaign. 
For more information, contact customer support.

Layout fundamentals
Each paragraph in a template and even the template itself provides a range of design 
options that can affect the layout of your newsletter:

 l Background color of the newsletter and newsletter background
 l Background color or images incorporated into individual paragraphs
 l Width of the newsletter
 l Number of columns
 l Margins and spacing of individual paragraphs

Examples and comments

 l Pre-Header. The pre-header contains a link to the online version. You can add pre-
headers to display information prominently so that it is likely to catch the reader's 
eye.

 l Header. The header contains an image and the newsletter's title. You can insert addi-
tional elements, such as date and issue. A graphics editor lets you incorporate elab-
orate text effects.
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 l Sidebar. The sidebar produces a two-column layout. In this example, the sidebar is 
given a different color to set it apart from the main body of the newsletter. If you 
choose this type of layout, set an inner margin to create a space between the box 
and the text. Similarly, set a margin between the sidebar and the main body of the 
newsletter so that the text/image block in the main body does not "cling" to the 
sidebar.
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 l Main area. The main area has the same color as the entire newsletter. The tex-
t/image paragraph runs across the total available width and does not require an 
inner margin. The image is centered between the title and the text. A teaser text 
links to a landing page.

 l Table of contents. The table of contents is a separate type of paragraph and can be 
placed anywhere in the template. You can set a table of contents in a fixed pos-
ition in individual mailing templates. You can enter the text that the table of con-
tents displays into the individual paragraphs – or use the paragraph headings 
(standard).

 l Image position. Here, the image is positioned on the left next to the heading. Larger 
images should be scaled down to 50 % of the available width. Images are positioned 
relative to text, link and heading. If you choose to position an image to the left 
below the heading, as opposed to the position shown here, then the heading will 
not be incorporated, which means it will appear across the full width of the para-
graph.

 l Inline block. Paragraphs with narrower widths are placed next to one another until 
the maximum width is filled. This way, you can create a layout with consecutive, vari-
able columns. If the width is set to a particular portion of the total available width, 
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then the individual blocks fill out the space precisely as indicated, generating a 
column layout.

 l Empty column. In contrast to a single column layout, the sidebar is left blank, if no 
content is to be entered.

 l Single column. With a single-column layout, a paragraph spans the entire width of 
the newsletter. To create a template with a variety of layouts (for example single-
column or two-column), you will need to use paragraph outlines or special para-
graphs.

 l Background color. A single background color (the same as used for the sidebar) is 
chosen for these paragraphs. Set an inner margin to add space between the text 
block and the paragraph frame.

 l Variable footer. A footer can contain multiple paragraphs. You can treat footer para-
graphs the same as content paragraphs.

 l Fixed footer. This footer contains the site notice and contact information for the 
newsletter. This usually also includes the unsubscribe option required by law. The 
paragraph is permanently stored and normally does not need to be adapted or 
edited further.
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 l Newsletter width. The ideal newsletter width depends on the recipient's device 
(responsive design):

 o Desktop version.  600 to 650 pixels.
 o Mobile version. 480 pixels (see Mobile Fusion).

Supported Fonts
The Template Kit supports the following fonts.

 l Arial
 l Comic Sans
 l Courier New
 l Georgia
 l Lucinda Sans Unicode
 l Tahoma
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 l Times New Roman
 l Trebuchet MS
 l Verdana

You can store other fonts as an image in the Template Kit. Texts used this way cannot be 
edited with the  Template Kit. 

Note: Images in the mailing are visible only after loading.

Design options
You cannot display color and background gradients and shadowing, but you can round 
off edges. If you want to create the content template in Episerver Campaign yourself, 
do this in the relevant grouping paragraphs using the Border option.

Mobile Fusion
The Template Kit lets you preview your mailing on selected smart phones and tablets. 
So, you can check the vertical and horizontal mobile appearance of your newsletter. 

Mobile content elements appear below one another, so a mobile reader does not 
have to scroll sideways, but can scroll up and down. And, you can specify whether 
images or text is shown first in content areas. You also have the option to show or hide 
content areas on the desktop versus the mobile version. 

For more information, see Mobile Fusion.

General settings
Click Settings on the top border of the template editor to define fonts, basic grid, color 
schemes and other settings that affect the template. The assistant for these settings 
opens in a new layer with the tabs described in this topic.

General
These settings affect the general layout of the newsletter and content, unless you over-
write them in Content paragraphs. For example, use general settings to adapt your com-
pany's corporate design to this template.
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Parameter Description

Newsletter title

Text                             Appears in the browser window title of the online version.

Layout

Width of the 
content 
area                             

Enter between 100 to 650 pixels to ensure that most email clients display the news-
letter properly. If you set a greater value, test the newsletter with the deliverability pre-
view.                                

Alignment Set the alignment for the entire newsletter. But, you define the alignment of content 
elements in each content paragraph.

Margin Specify up to 1/8 of the total newsletter width; larger margin distance negatively 
affects the layout.

Padding
Specify up to 1/8 of the total newsletter width to define space between borders and 
content (text or images). Padding is only effective if different background colors or 
images are defined for the newsletter and content elements. 

Space 
between 
grouping 
paragraphs

If no other pixel value is set here, the Padding value is used. 

Space 
between 
texts and 
images 

Specify up to 20 pixels.

Favicon

URL If desired, enter the URL of an externally-stored favicon  for the online version of your 
message.

Inherit

Header
The inherit header value affects landing pages, including automatically generated 
ones. To enter content different from the newsletter header in the respective areas 
of your landing pages, clear this check box.
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Footer
The inherit value affects landing pages, including automatically generated ones. To 
enter content different from the newsletter footer in the respective areas of your 
landing pages, clear this check box.

Font settings
Define font types, size and line height for headings, text and links.

Parameter Description

Headings

Font type
Define several font types in a comma-separated list. The browser or email client tries to 
use the first font in this list. If this font is not installed on the system, the next is tried. The last 
option should define a generic font.

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Size Define the size (integer) of heading text. 

Line height You can set an integer value greater than the font size; the default integer value is set 
by recipient's web browser or email client. 

Underline Select to underline headings.

Bold Select to bold headings.

Text

Font type
Define several font types in a comma-separated list. The browser or email client tries to 
use the first font in this list. If this font is not installed on the system, the next is tried. The last 
option should define a generic font.

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
depiction of non-hex web colors may vary from the original, depending on the 
browser. 
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Size Define the size (integer) of the text. 

Line height You can set an integer value greater than the font size; the default integer value is set 
by recipient's web browser or email client. 

Links

Font type
Define several font types in a comma-separated list. The browser or email client tries to 
use the first font in this list. If this font is not installed on the system, the next is tried. The last 
option should define a generic font.

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Size Define the size of link text. 

Line height You can set an integer value greater than the font size; the default integer value is set 
by the web browser or email client of the recipient. 

Underline Select to underline links.

Bold Select to bold links.

Table of contents with links to paragraphs

Font type 
Define several font types in a comma-separated list. The browser or email client tries to 
use the first font in this list. If this font is not installed on the system, the next is tried. The last 
option should define a generic font.

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Size Define the size of TOC links. 

Line height You can set an integer value greater than the font size; the default integer value is set 
by the web browser or email client of the recipient. 

Underline Select to underline TOC links.
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Bold Select to bold TOC links.

Menu items in the navigation menu

Font type 
Define several font types in a comma-separated list. The browser or email client tries to 
use the first font in this list. If this font is not installed on the system, the next is tried. The last 
option should define a generic font.

Color

To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
depiction of non-hex web colors may vary from the original, depending on the 
browser.  If you leave the field blank, the color you specified in the Links area is dis-
played.

Size Enter the font size for the menu item labels in pixels. If you leave the field blank, the font 
size you specified in the Links area will be used.

Line height Enter the row height for the menu item labels in pixels. If you leave the field blank, the 
line height is automatically set by the  email client of the recipient. 

Underline Select to underline menu items.

Bold Select to bold menu items.

Custom fonts

Note: To enable this feature, contact customer support. When set-
ting up, provide the path (URL) to your custom fonts. This can be 
your own server or the server of a font provider (e.g. Google Fonts). 
If you want to use a server from Episerver, Episerver needs the font 
files. Episerver itself cannot provide fonts.

Custom fonts are special fonts (such as your corporate font) that are downloaded from 
an external source when the email is opened. If you have configured custom fonts in 
your client, you can find an overview of the available fonts in the yellow box at the top 
of the edit area. To use custom fonts, copy the font name in the desired input field in 
the Font settings tab. Additionally set alternative fonts.
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Outlook fallbacks

Outlook does not support custom fonts. Define in the Custom fonts tab fallbacks to 
determine which alternative fonts Outlook can use. You can find an overview of the 
defined Outlook fallbacks in the yellow box at the top of the edit area.

Parameter Description

Outlook fallbacks

Headings Set Outlook fallbacks for Headings.

Text Set Outlook fallbacks for Text.

Links Set Outlook fallbacks for Links.

Table of contents with 
links to paragraphs Set Outlook fallbacks for Table of contents with links to paragraphs.

Menu items in the nav-
igation menu Set Outlook fallbacks for Menu items in the navigation menu.

Buttons Set Outlook fallbacks for Buttons.

Note: Outlook only uses the defined fallbacks (except for Buttons) if 
you have set a custom font in the corresponding area in the Font 
settings tab.  If you set a custom font without defining a fallback, 
Outlook uses an alternative font.

Color settings
Define general background colors or images and border colors in this tab. You can over-
write these settings in each content block.

Parameter Description

Newsletter background

Color To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
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depiction of non-hex web colors may vary from the original, depending on the 
browser.  If you leave the field blank, the color you specified in the Links area is dis-
played.

Image

Because email clients do not support the display of background images, they should 
not contain important information.                                 

If you use a background image, the parameters Alignment and Repeat become 
effective.

Be aware that a background image is only visible at border areas and free spaces, 
being masked by content and other backgrounds.

Alignment Only effective if a background image is uploaded. Sets alignment for the entire news-
letter. Alignment of the content elements is defined in the content paragraphs.

Repeat Only effective if a background image is uploaded. Repeats the background image.

Content area background

Color

To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
depiction of non-hex web colors may vary from the original, depending on the 
browser.  If you leave the field blank, the color you specified in the Links area is dis-
played.

Border

Show Check to apply a border around the paragraph.

Border 
width

Enter an integer value in pixel. If you set this value to 0, no border will be displayed. The 
default border thickness is 1 pixel.

Color

To define the color, enter a hexadecimal value preceded by # (such as #000000). The 
depiction of non-hex web colors may vary from the original, depending on the 
browser.  If you leave the field blank, the color you specified in the Links area is dis-
played.

Layout Specify whether the newsletter should be displayed with or without pre-header, 
header and footer.
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Parameter Description

Options

List type

To use a simple bullet, under List type, select Bullet list.                         

To use a custom bullet character, upload an image and, under List type, select List 
with custom bullet character.

Custom 
bullet char-
acter

Upload a bullet character or, in the Alternatively external URL field, enter an image URL 
pointing to the image source. The bullet character can be up to 30-pixels wide. Wider 
graphics are proportionally reduced to this size.

Separator
Use separator paragraphs to structure your newsletter and group paragraphs. Separ-
ators may contain a top link for a simple navigation, a separator line, the top link, an 
image, and free space. You can activate each elements individually in each separator 
paragraph.

Parameter Description

Separator line

Width
The maximum width equals the total newsletter width minus padding. If a top link 
icon with text is set on the separation line, the width of the line is reduced by the 
width of this element.

Alignment The alignment parameter is only effective if the width is smaller than the total avail-
able width.

Border width Enter an integer value in pixel.

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile
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Width of the 
separator Set the width (in percent) of the separator line for the mobile version.

Top link

Icon

You can replace the default icon with an uploaded custom icon. The maximum 
width equals the maximum width of the newsletter minus padding. Be aware that if 
you use wide graphics, the separator line, if used, is proportionally smaller.                                 

Graphics larger than the maximum width are scaled down.

Text The text is shown. If the recipient's email client does not display the icon, the recip-
ient sees only the text.

Text position Select the position of the link text relative to the icon.

Position Select the vertical position of the top link (text AND icon) relative to the separator 
line. By default, the top link is placed on the separator line.

Alignment Select the horizontal position of the top link (text AND icon).

Image

Image Upload an image from your computer or enter an image URL in the Alternatively 
external URL field that points to the image file. 

Alternative 
text

This text appears if a recipient blocks or disables images in his/her email client, or if 
the image cannot be displayed for another reason. You should  enter an altern-
ative text containing a short description of the image.

Link You can link the image to a landing page or a page from your website. If you 
entered a text link in this paragraph, use the same link for the image.

Position
Specify the positioning of the image relative to the separator line and the top link. 
This positioning affects only the appearance if at least one or both of these ele-
ments are selected in a separator.

Alignment Select the horizontal position of the image. If the image occupies the entire width, 
this parameter has no effect.
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Spacing

Above sep-
arator

You can optionally add this space later in each separator paragraph to improve 
the clarity of the newsletter. 

Between top 
link and sep-
arator line 
and/or icon 

You can optionally add this space later in each separator paragraph to improve 
the clarity of the newsletter. 

Below sep-
arator

You can optionally add this space later in each separator paragraph to improve 
the clarity of the newsletter. 

Button template
See Click2Go.

SWYN
If you use the share function for social networks (SWYN), define the general appearance 
of your newsletter's SWYN. 

Parameter Description

Introduction

Text

Enter an introduction text that is shown together with the network icons. This text may 
contain a call-to-action for recipients to share content in their networks.                                 

Each paragraph for which the SWYN function is activated displays this text and the 
network icons.

Icons

Note: SWYN must be enabled for any icon in a paragraph for the icon to 
display. Maximum 30 pixels for all icons.

Facebook Upload a custom Facebook icon or enter a URL pointing to your custom Facebook 
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icon. 

Twitter Upload a custom Twitter icon or enter a URL pointing to your custom Twitter icon. 

MySpace Upload a custom MySpace icon or enter a URL pointing to your custom MySpace icon. 

Xing Upload a custom Xing icon or enter a URL pointing to your custom Xing icon. 

Products
This paragraph type contains common fields to enter product details, such as old/-
current price, product category, description, and so on. You can define the order of 
these fields. 

By default, no formatting is used in the designated fields. To format the text entered in 
these fields, use the editor's formatting tools.  Or, if you use a content interface, commit 
HTML formatting tags.

Parameter Description

Order

Position 1 Enter a product name or title.

Position 2 Enter the product category, article group or genre. If you do not enter anything here, 
this position is not displayed.

Position 3 Enter an author, artist or manufacturer of the product or work. If you do not enter any-
thing here, this position is not displayed.

Position 4 Enter a description of the product or work. If you do not enter anything here, this pos-
ition is not displayed.

Position 5 Use this field in combination with the field Current Price for price reductions, bargains, 
special offers, and so on.

Position 6 Enter the current or new price here.
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Content interface
This tab lets you define up to five alternative layouts for content of the content inter-
face by freely inputting HTML or text. You can select the required layout from within the 
content interface paragraph.

Source text entered here is adopted into the newsletter with no additional checks.

Text and link formatting must be prepared in HTML format. You need HTML knowledge, 
particularly HTML in email, to create new layouts or edit the default one. Using corrupt 
or unsupported code may cause severe errors in the newsletter display.

Parameter Description

Layout 1-5

Desktop version Enter the source text for the desktop version.

Mobile version Enter the source text for the mobile version.

Text version Enter the source text for the text version.

Inserting content

The following Velocity variables are available:

 l Status. Information on current item paragraphs
 l Present. For using queries that check for the presence of an element
 l Value. For issuing the content

Notes for the creation of new layouts

 l Font definitions. If you are using an alternative layout variant, font definitions must 
exist in the HTML you entered. The texts are not formatted by the Template Kit to 
give you complete freedom in visual design.

 l Widths. Specify a fixed width or a width in percent. You should enter a percentage, 
because this prevents elements from sticking out of the layout.

 l Danger of display errors. If you edit the layouts without in-depth knowledge of HTML, 
serious display errors may occur in your mailings.
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$first Boolean true if it is the first item in the content interface paragraph; otherwise 
false.

$index Integer The  position of the item within the content interface paragraph as a num-
ber (1 for the first item, 2 for the second item...).

$last Boolean true if it is the last item in the content interface paragraph; otherwise 
false.

Variable Type Description

$text1Present Boolean true if content is present for the Text 1 field;  otherwise 
false.

$text2Present Boolean true if content is present for the Text 2 field;  otherwise 
false.

$text3Present Boolean true if content is present for the Text 3 field;  otherwise 
false.

$text4Present Boolean true if content is present for the Text 4 field;  otherwise 
false.

$text5Present Boolean true if content is present for the Text 5 field;  otherwise 
false.

$text6Present Boolean true if content is present for the Text 6 field;  otherwise 
false.

$text7Present Boolean true if content is present for the Text 7 field;  otherwise 
false.

$text8Present Boolean true if content is present for the Text 8 field;  otherwise 
false.

$text9Present Boolean true if content is present for the Text 9 field;  otherwise 
false.

$text10Present Boolean true if content is present for the Text 10 field;  otherwise 
false.
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$link1TextPresent Boolean true if content is present for the Text field in the Link 1 
group;  otherwise false.

$link1UrlPresent Boolean true if content is present for the URL field in the Link 1 group;  
otherwise false.

$link2TextPresent Boolean true if content is present for the Text field in the Link 2 
group;  otherwise false.

$link2UrlPresent Boolean true if content is present for the URL field in the Link 2 group;  
otherwise false.

$link3TextPresent Boolean true if content is present for the Text field in the Link 3 
group;  otherwise false.

$link2UrlPresent Boolean true if content is present for the URL field in the Link 3 group;  
otherwise false.

$image1ImageUrlPresent Boolean true if content is present for the Image field in the Image 1 
group in the Images tab;  otherwise false.

$image1AltTextPresent Boolean true if content is present for the Alternative text field in the 
Image 1 group in the Images tab;  otherwise false.

$image1LinkPresent Boolean true if content is present for the Link field in the Image 1 
group in the Images tab;  otherwise false.

$image2ImageUrlPresent Boolean true if content is present for the Image field in the Image 2 
group in the Images tab;  otherwise false.

$image2AltTextPresent Boolean true if content is present for the Alternative text field in the 
Image 2 group in the Images tab;  otherwise false.

$image2LinkPresent Boolean true if content is present for the Link field in the Image 2 
group in the Images tab;  otherwise false.

$image3ImageUrlPresent Boolean true if content is present for the Image field in the Image 3 
group in the Images tab;  otherwise false.

$image3AltTextPresent Boolean true if content is present for the Alternative text field in the 
Image 3 group in the Images tab;  otherwise false.
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$image3LinkPresent Boolean true if content is present for the Link field in the Image 3 
group in the Images tab;  otherwise false.

$image4ImageUrlPresent Boolean true if content is present for the Image field in the Image 4 
group in the Images tab;  otherwise false.

$image4AltTextPresent Boolean true if content is present for the Alternative text field in the 
Image 4 group in the Images tab;  otherwise false.

$image4LinkPresent Boolean true if content is present for the Link field in the Image 4 
group in the Images tab;  otherwise false.

$image5ImageUrlPresent Boolean true if content is present for the Image field in the Image 5 
group in the Images tab;  otherwise false.

$image5AltTextPresent Boolean true if content is present for the Alternative text field in the 
Image 5 group in the Images tab;  otherwise false.

$image5LinkPresent Boolean true if content is present for the Link field in the Image 5 
group in the Images tab;  otherwise false.

$image6ImageUrlPresent Boolean true if content is present for the Image field in the Image 6 
group in the Images tab;  otherwise false.

$image6AltTextPresent Boolean true if content is present for the Alternative text field in the 
Image 6 group in the Images tab;  otherwise false.

$image6LinkPresent Boolean true if content is present for the Link field in the Image 6 
group in the Images tab;  otherwise false.

Variable Type Environment Description

$text1Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 1 field.

$text1FormattedValue String Desktop, 
mobile

The  edited content from the Text 
1 field.

$text1FormattedAsHeadlineValue String Desktop, 
mobile

The  edited content from the Text 
1 field. The text is provided in the 
formatting for headings, and is 
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linked to the URL for Link 1.

$text2Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 2 field.

$text2FormattedValue String Desktop, 
mobile

The  edited content from the Text 
2 field.

$text3Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 3 field.

$text3FormattedValue String Desktop, 
mobile

The  edited content from the Text 
3 field.

$text4Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 4 field.

$text4FormattedValue String Desktop, 
mobile

The  edited content from the Text 
4 field.

$text5Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 5 field.

$text5FormattedValue String Desktop, 
mobile

The  edited content from the Text 
5 field.

$text6Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 6 field.

$text6FormattedValue String Desktop, 
mobile

The  edited content from the Text 
6 field.

$text7Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 7 field.

$text7FormattedValue String Desktop, 
mobile

The  edited content from the Text 
7 field.

$text8Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 8 field.
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$text8FormattedValue String Desktop, 
mobile

The  edited content from the Text 
8 field.

$text9Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 9 field.

$text9FormattedValue String Desktop, 
mobile

The  edited content from the Text 
9 field.

$text10Value String Desktop, 
mobile, text

The  unchanged content from 
the Text 10 field.

$text10FormattedValue String Desktop, 
mobile

The  edited content from the Text 
10 field.

$link1TextValue String Desktop, 
mobile, text

The  unchanged content from 
the Text field in the Link 1 group.

$link1UrlValue String Desktop, 
mobile, text

The  unchanged content from 
the URL field in the Link 1 group.

$link1FormattedValue String Desktop, 
mobile

The  edited content from the Text 
field in the Link 1 group. The text 
is provided in the formatting for 
links, and is linked to the URL for 
Link 1.

$link2TextValue String Desktop, 
mobile, text

The  unchanged content from 
the Text field in the Link 2 group.

$link2UrlValue String Desktop, 
mobile, text

The  unchanged content from 
the URL field in the Link 2 group.

$link2FormattedValue String Desktop, 
mobile

The  edited content from the Text 
field in the Link 2 group. The text 
is provided in the formatting for 
links, and is linked to the URL for 
Link 2.

$link3TextValue String Desktop, 
mobile, text

The  unchanged content from 
the Text field in the Link 3 group.
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$link3UrlValue String Desktop, 
mobile, text

The  unchanged content from 
the URL field in the Link 3 group.

$link3FormattedValue String Desktop, 
mobile

The  edited content from the Text 
field in the Link 3 group. The text 
is provided in the formatting for 
links, and is linked to the URL for 
Link 3.

$image1ImageUrlValue String Desktop, 
mobile The  image address of Image 1.

$image1AltTextValue String Desktop, 
mobile, text

The  unchanged content from 
the Alternative text field in the 
Image 1 group.

$image1LinkValue String Desktop, 
mobile, text

The  unchanged content from 
the Link field in the Image 1 
group.

$image1FormattedValue String Mobile

The  complete HTML source text 
from Image 1 with alternative 
text and link. The image width is 
set to 100% (available width).

$image1FullFormattedValue String Desktop

The  complete HTML source text 
from Image 1 with alternative 
text and link. The maximum 
image width is the available 
paragraph width.

$image1HalfFormattedValue String Desktop

The  complete HTML source text 
from Image 1 with alternative 
text and link. The maximum 
image width is half of the avail-
able paragraph width.

$image2ImageUrlValue String Desktop, 
mobile The  image address of Image 2.

$image2AltTextValue String Desktop, 
mobile, text

The  unchanged content from 
the Alternative text field in the 
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Image 2 group.

$image2LinkValue String Desktop, 
mobile, text

The  unchanged content from 
the Link field in the Image 2 
group.

$image2FormattedValue String Mobile

The  complete HTML source text 
from Image 2 with alternative 
text and link. The image width is 
set to 100% (available width).

$image2FullFormattedValue String Desktop

The  complete HTML source text 
from Image 2 with alternative 
text and link. The maximum 
image width is the available 
paragraph width.

$image2HalfFormattedValue String Desktop

The  complete HTML source text 
from Image 2 with alternative 
text and link. The maximum 
image width is half of the avail-
able paragraph width.

$image3ImageUrlValue String Desktop, 
mobile The  image address of Image 3.

$image3AltTextValue String Desktop, 
mobile, text

The  unchanged content from 
the Alternative text field in the 
Image 3 group.

$image3LinkValue String Desktop, 
mobile, text

The  unchanged content from 
the Link field in the Image 3 
group.

$image3FormattedValue String Mobile

The  complete HTML source text 
from Image 3 with alternative 
text and link. The image width is 
set to 100% (available width).

$image3FullFormattedValue String Desktop
The  complete HTML source text 
from Image 3 with alternative 
text and link. The maximum 
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image width is the available 
paragraph width.

$image3HalfFormattedValue String Desktop

The  complete HTML source text 
from Image 3 with alternative 
text and link. The maximum 
image width is half of the avail-
able paragraph width.

$image4ImageUrlValue String Desktop, 
mobile The  image address of Image 4.

$image4AltTextValue String Desktop, 
mobile, text

The  unchanged content from 
the Alternative text field in the 
Image 4 group.

$image4LinkValue String Desktop, 
mobile, text

The  unchanged content from 
the Link field in the Image 4 
group.

$image4FormattedValue String Mobile

The  complete HTML source text 
from Image 4 with alternative 
text and link. The image width is 
set to 100% (available width).

$image4FullFormattedValue String Desktop

The  complete HTML source text 
from Image 4 with alternative 
text and link. The maximum 
image width is the available 
paragraph width.

$image4HalfFormattedValue String Desktop

The  complete HTML source text 
from Image 4 with alternative 
text and link. The maximum 
image width is half of the avail-
able paragraph width.

$image5ImageUrlValue String Desktop, 
mobile The  image address of Image 5.

$image5AltTextValue String Desktop, 
mobile, text

The  unchanged content from 
the Alternative text field in the 
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Image 5 group.

$image5LinkValue String Desktop, 
mobile, text

The  unchanged content from 
the Link field in the Image 5 
group.

$image5FormattedValue String Mobile

The  complete HTML source text 
from Image 5 with alternative 
text and link. The image width is 
set to 100% (available width).

$image5FullFormattedValue String Desktop

The  complete HTML source text 
from Image 5 with alternative 
text and link. The maximum 
image width is the available 
paragraph width.

$image5HalfFormattedValue String Desktop

The  complete HTML source text 
from Image 5 with alternative 
text and link. The maximum 
image width is half of the avail-
able paragraph width.

$image6ImageUrlValue String Desktop, 
mobile The  image address of Image 6.

$image6AltTextValue String Desktop, 
mobile, text

The  unchanged content from 
the Alternative text field in the 
Image 6 group.

$image6LinkValue String Desktop, 
mobile, text

The  unchanged content from 
the Link field in the Image 6 
group.

$image6FormattedValue String Mobile

The  complete HTML source text 
from Image 6 with alternative 
text and link. The image width is 
set to 100% (available width).

$image6FullFormattedValue String Desktop
The  complete HTML source text 
from Image 6 with alternative 
text and link. The maximum 
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image width is the available 
paragraph width.

$image6HalfFormattedValue String Desktop

The  complete HTML source text 
from Image 6 with alternative 
text and link. The maximum 
image width is half of the avail-
able paragraph width.

$editBar String Desktop, 
mobile

Inserts the paragraph button 
bar. This is required to integrate 
the button bar into the table, 
such as when implementing 
adjacent items. If this variable is 
not available, the button bar is 
placed above the item.

Examples of alternative layout variants

The examples show the source text for the standard layout and can be adapted for 
alternative layout variants.

Remove HTML comments, blank lines and spaces when transferring HTML into the Tem-
plate Kit. If you do not do this, then these elements are included when sending, and will 
cause the newsletter source text to "swell". 

<table width="100%" border="0" cellpadding="0" cellspacing="0">
     <tr>
         <td width="100%">
             #set($displaySeparator = false)
             #if("$text1Present" == "true")
                 $text1FormattedAsHeadlineValue
                 #set($displaySeparator = true)
             #end
              
             #if("$image1ImageUrlPresent" == "true")
                 #if("$text1Present" == "true")
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                     #set($displaySeparator = false)
                 #end
                 <table border="0" cellspacing="0" cellpadding="0" align="right">
                     <tr>
                         <td width="10"></td>
                         <td>
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                             #if("$image1LinkPresent" != "true" && "$link1UrlPresent" == "true")
                                 <a href="$link1UrlValue" target="_blank">
                             #end
                             $image1HalfFormattedValue
                             #if("$image1LinkPresent" != "true" && "$link1UrlPresent" == "true")
                                 </a>
                             #end
                         </td>
                     </tr>
                 </table>
             #end
              
             #if("$text2Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text2FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text3Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text3FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text4Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text4FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text5Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text5FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text6Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
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                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text6FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text7Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text7FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text8Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text8FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text9Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text9FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$text10Present" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $text10FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$link1TextPresent" == "true" && "$link1UrlPresent" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
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                     </table>
                 #end
                 $link1FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$link2TextPresent" == "true" && "$link2UrlPresent" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $link2FormattedValue
                 #set($displaySeparator = true)
             #end
              
             #if("$link3TextPresent" == "true" && "$link3UrlPresent" == "true")
                 #if($displaySeparator)
                     <table width="10" border="0" cellpadding="0" cellspacing="0">
                         <tr>
                             <td width="10" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $link3FormattedValue
                 #set($displaySeparator = true)
             #end
         </td>
     </tr>
     <tr>
         <td width="100%" height="10"><!-- --></td>
     </tr>
 </table>

#set($displaySeparator = false)
 #if("$text1Present" == "true")
     $text1FormattedAsHeadlineValue
     #set($displaySeparator = true)
 #end
 #if("$image1ImageUrlPresent" == "true")
     #if("$text1Present" == "true")
         <div style="height: 10px;"></div>
         #set($displaySeparator = false)
     #end
     <div style="float: right; margin-left: 10px; max-width: 50%;">
         #if("$image1LinkPresent" != "true" && "$link1UrlPresent" == "true")
             <a href="$link1UrlValue" target="_blank">
         #end
         $image1FormattedValue
         #if("$image1LinkPresent" != "true" && "$link1UrlPresent" == "true")
             </a>
         #end
     </div>
 #end
 #if("$text2Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text2FormattedValue
     #set($displaySeparator = true)
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 #end
 #if("$text3Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text3FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$text4Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text4FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$text5Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text5FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$text6Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text6FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$text7Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text7FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$text8Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text8FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$text9Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text9FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$text10Present" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $text10FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$link1TextPresent" == "true" && "$link1UrlPresent" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $link1FormattedValue
     #set($displaySeparator = true)
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 #end
 #if("$link2TextPresent" == "true" && "$link2UrlPresent" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $link2FormattedValue
     #set($displaySeparator = true)
 #end
 #if("$link3TextPresent" == "true" && "$link3UrlPresent" == "true")
     #if($displaySeparator)
         <div style="height: 10px;"></div>
     #end
     $link3FormattedValue
     #set($displaySeparator = true)
 #end
 <div style="clear: both; height: 10px;"><!-- --></div>

#set($displaySeparator = false)#if("$text1Present" == "true")#if($displaySeparator)
 #end$!{null}$text1Value#set($displaySeparator = true)#end$!{null}#if("$text2Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text2Value#set($displaySeparator = true)#end$!{null}#if("$text3Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text3Value#set($displaySeparator = true)#end$!{null}#if("$text4Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text4Value#set($displaySeparator = true)#end$!{null}#if("$text5Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text5Value#set($displaySeparator = true)#end$!{null}#if("$text6Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text6Value#set($displaySeparator = true)#end$!{null}#if("$text7Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text7Value#set($displaySeparator = true)#end$!{null}#if("$text8Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text8Value#set($displaySeparator = true)#end$!{null}#if("$text9Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text9Value#set($displaySeparator = true)#end$!{null}#if("$text10Present" == 
"true")#if($displaySeparator)
 #end$!{null}$text10Value#set($displaySeparator = true)#end$!{null}#if("$link1TextPresent" == 
"true" && "$link1UrlPresent" == "true")#if($displaySeparator)
 #end$!{null}$link1TextValue
 $link1UrlValue#set($displaySeparator = true)#end$!{null}#if("$link2TextPresent" == "true" && 
"$link2UrlPresent" == "true")#if($displaySeparator)
 #end$!{null}$link2TextValue
 $link2UrlValue#set($displaySeparator = true)#end$!{null}#if("$link3TextPresent" == "true" && 
"$link3UrlPresent" == "true")#if($displaySeparator)
 #end$!{null}$link3TextValue
 $link3UrlValue#set($displaySeparator = true)#end$!{null}#if("$image1ImageUrlPresent" == "true" 
&& "$image1AltTextPresent" == "true" 
     && ("$image1LinkPresent" == "true" || "$link1UrlPresent" == "true"))#if($displaySeparator)
 #end$!{null}$image1AltTextValue
 #if("$image1LinkPresent" == "true")$image1LinkValue$!{null}#else$!{null}$link1UrlValue#end#end$!
{null}

RSS feeds
You can define one or more layout variants for RSS feed articles. Within the RSS feed 
paragraph you can select the layout to be used.
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Source code entered in this tab is rendered into the newsletter without further check-
ing. The formatting of text and links must be written in HTML code.

Warning: You need knowledge of HTML and particularly of HTML in 
emails to setup this paragraph. Using corrupt or not supported 
code in a layout may cause severe errors in the newsletter display.

Parameter Description

Placeholder for the RSS feed URL

Value for {place-
holder1}...Value for 
{placeholder1} 

In the RSS feed paragraph, open the RSS feed tab and insert the place-
holder {placeholder1}, {placeholder3} or {placeholder3} in the URL box. 
Before the RSS feed is retrieved, this placeholder is replaced with the value 
entered here.

Order (standard layout)

Position 1 Select the content to be displayed here.

Position 2 Select the content to be displayed here.

Position 3 Select the content to be displayed here.

Position 4 Select the content to be displayed here.

Layout 1-5

Desktop version Enter the source code for the desktop version of your newsletter.

Mobile version Enter the source code for the mobile version of your newsletter.

Text version Enter the source code for the text version of your newsletter.

Inserting content

Content from an RSS feed is present as velocity variables and can be inserted in the 
source text this way. These include 

 l status variables (information on current article paragraphs)
 l present variables (for using queries that check the presence of an element) 
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 l value variables (for releasing content)

Note: Important notes

 l Font definitions. When using alternate layout options, font definitions must 
be set in your HTML. The Template Kit does not format the text, allowing 
you to choose a design. Conversely, this means that links in continuous 
text (if used) must be formatted accordingly in the RSS feed.

 l Width specifications. RSS feed paragraphs may vary in width. When using 
an alternate layout, you should preferably only work with percentages, 
or not apply width specifications. Otherwise, you can work with fixed 
widths as long as the RSS feed paragraph is used in the same con-
figuration, or a separate layout variant is defined for each different para-
graph width.

 l Aspect ratio. The Template Kit can only edit images to a limited degree if 
an alternative layout option is used (whatever content width is present is 
applied as the maximum width). You should provide images with the 
required width. Also, you can also scale the image by setting a specified 
width in HTML. This is not recommended, however, because some applic-
ations (such as Microsoft Outlook) ignore this information and display the 
image in its original size.

 l Link alignment/Image position. These options are inoperative when using 
an alternative layout. The arrangement/positioning of elements is set by 
the HTML

 l Risk of display errors. When manually entering HTML for desktop and 
mobile versions, make sure that the content displays properly in a variety 
of email programs and web mailers. Otherwise, this can lead to serious 
display errors.

Variable Type Description

rssItemFirst Boolean Is true, if it is the first article of the RSS feed paragraph, otherwise false.

rssItemIndex Integer Shows the position of the article within the RSS feed paragraph as a num-
ber (1 for the first article, 2 for the second article and so on).

rssItemLast Boolean Is true, if it is the last article of the RSS feed paragraph, otherwise false.

Variable Type Description

rssTitlePresent Boolean Contains true, if content is present for the Title box, oth-
erwise false.
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Variable Type Description

rssTextPresent Boolean Contains true, if content is present for the Text box, oth-
erwise false.

rssAuthorPresent Boolean Contains true, if content is present for the Author box, 
otherwise false.

rssDatePresent Boolean Contains true, if content is present for the Date box, oth-
erwise false.

rssCategoriesPresent Boolean Contains true, if content is present for the Categories 
box, otherwise false.

rssLinkTextPresent Boolean Contains true, if content is present for the Text box in 
the Link group, otherwise false.

rssLinkUrlPresent Boolean Contains true, if content is present for the URL box in the 
Link group, otherwise false.

rssCommentsLinkTextPresent Boolean Contains true, if content is present for the Text box in 
the Link to the comments group, otherwise false.

rssCommentsLinkUrlPresent Boolean Contains true, if content is present for the URL box in the 
Link to the comments group, otherwise false.

rssImageUrlPresent Boolean Contains true, if content is present for the Image box 
(Upload file) in the Image tab, otherwise false.

rssImageAltTextPresent Boolean Contains true, if content is present for the Alternative 
text box in the Image tab, otherwise false.

rssImageLinkPresent Boolean Contains true, if content is present for the Link box in 
the Image tab, otherwise false.

Variable Type Description

rssTitleValue String Text for the Title box.

rssTextValue String Text  for the Text box.

rssAuthorValue String Text  for the Author box.
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Variable Type Description

rssDateValue String Text  for the Date box.

rssCategoriesValue String Text  for the Categories box.

rssLinkTextValue String Text  for the Text box in the Link group.

rssLinkUrlValue String Text  for the URL box in the Link group.

rssCommentsLinkTextValue String Text for the Text box in the Link to the comments group.

rssCommentsLinkUrlValue String Text  for the URL box in the Link to the comments group.

rssImageUrlValue String Image URL (Upload Image) for the Image tab.

rssImageAltTextValue String Text  for the Alternative Text for the Image tab.

rssImageLinkValue String Text for the Link box for the Image tab.

editBar String

Inserts the button bar for the RSS feed article.                                 

This is necessary when placing articles side-by-side, for 
example, to integrate the button bar into the table. If this 
variable is not present, the button bar is placed above 
the article.

Example for an alternative layout

The example creates a two-columned layout using a width of 580 pixels.

Note: Remove HTML comments, whitespaces, and blank lines when 
copying the HTML to the Template Kit. They may be sent along with 
the newsletter and, thus, expand the newsletter source code.

<!-- This query ensures that content is only displayed if the contents used for this layout are 
available. -->
 #if($rssTitlePresent || $rssImageUrlPresent || $rssAuthorPresent || $rssDatePresent || $rssTex-
tPresent || ($rssLinkTextPresent && $rssLinkUrlPresent))
     <!-- To enable the two-column layout, a border table is opened in the first RSS feed art-
icle. -->
     #if($rssItemFirst)
         <table border="0" cellpadding="0" cellspacing="0">
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             <tr>
     #end
       
     <!-- For every article, a table cell with half the width is created. This table cell con-
tains the entire contents of the RSS feed item. -->
     <td width="280" align="left" valign="top">
       
         <!-- The button bar is placed here so it is displayed above the corresponding RSS feed 
article. -->
         $editBar
         #if($rssTitlePresent)
             <font size="2" face="Arial, sans-serif" color="#000001" style="font-size: 14px;"><b>
                 #if($rssLinkUrlPresent)
                     <a href="$rssLinkUrlPresent" style="color: #000001; text-decoration: none;" 
target="_blank">
                 #end
                     <font size="2" face="Arial, sans-serif" color="#000001" style="font-size: 
14px;"><b>$rssTitleValue</b></font>
                 #if($rssLinkUrlPresent)
                     </a>
                 #end
             </b></font>
             <table width="100%" cellspacing="0" cellpadding="0" border="0">
                 <tr>
                     <td width="100%" height="10"></td>
                 </tr>
             </table>
         #end
           
         #if($rssImageUrlPresent)
             #if($rssImageLinkPresent)
                 <a href="$rssImageLinkValue" target="_blank">
             #end
             #if(!$rssImageLinkPresent && $rssLinkUrlPresent)
                 <a href="$rssLinkUrlValue" target="_blank">
             #end
             <!-- An image width of 130 pixels is specified. You should provide an image that 
already have the required width. Otherwise it will be stretched or compressed. -->
             <img src="$rssImageUrlValue" alt="$rssImageAltTextValue" width="130" border="0" 
align="right" style="display: block; float: right;" />
             #if($rssImageLinkPresent || $rssLinkUrlPresent)
                 </a>
             #end
         #end
           
         #if($rssAuthorPresent || $rssDatePresent || $rssTextPresent)
             <font size="1" face="Arial, sans-serif" color="#666666" style="font-size: 11px;">
                 #if($rssDatePresent || $rssAuthorPresent)
                     <span style="font-size: 10px;">
                         $rssDateValue
                         #if($rssDatePresent && $rssAuthorPresent)
                             |
                         #end
                         $rssAuthorValue
                     </span>
                     <table width="100%" cellspacing="0" cellpadding="0" border="0">
                         <tr>
                             <td width="100%" height="10"></td>
                         </tr>
                     </table>
                 #end
                 $rssTextValue
             </font>
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         #end
           
         #if($rssLinkTextPresent && $rssLinkUrlPresent)
             <font size="1" face="Arial, sans-serif" color="#666666" style="font-size: 11px; 
line-height: 11px;">
                 &ndash;
                 <nobr>
                     <a href="$rssLinkUrlValue" style="line-height: 11px; color: #666666; text-
decoration: underline;" target="_blank">
                         <font size="1" face="Arial, sans-serif" color="#666666" style="font-
size: 11px;">
                             <u>$rssLinkTextValue</u>
                         </font>
                     </a>
                 </nobr>
             </font>
         #end
     <!-- After every first (left-aligned) RSS feed article, the table cell is closed and a new 
one is opened. -->
     #if($rssItemIndex % 2 == 1)
         </td>
         <td width="20"></td>
     <!-- After every second (right-aligned) RSS feed article, the above opened table is closed, 
some space is inserted and a table is opened. -->
     #else
                 </td>
             </tr>
         </table>
         #if(!$rssItemLast)
             <table width="580" border="0" cellpadding="0" cellspacing="0">
                 <tr>
                     <td width="580" height="20"></td>
                 </tr>
             </table>
         #end
         <table border="0" cellpadding="0" cellspacing="0">
             <tr>
     #end
               
     <!-- After the last RSS feed article the table is closed. -->
     #if($rssItemLast)
             </tr>
         </table>
     #end
       
 #end

Facebook
The Facebook paragraph contains a standard layout for the visual design of Facebook 
articles. If you want, you can store up to 2 additional layouts as HTML code. You can 
select custom layouts from a drop-down list in the Facebook paragraph (see Facebook 
layouts).

Warning: If you lack knowledge of HTML, CSS, and Velocity, contact 
customer support to edit the alternative layouts. If you edit them 
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without in-depth knowledge, serious display errors may occur in 
your mailings.

Parameter Description

Order (standard layout)

Position 1–
3

Specify where to display the date, author, and text by selecting the desired option 
from the drop-down list. To specify distance between them, in the General tab under 
Layout, change the value of Space between texts and images.

Layout 1 and 2

Desktop 
version Enter the source code for the desktop version.

Mobile ver-
sion Enter the source code for the mobile version.

Text ver-
sion Enter the source code for the text version.

Twitter
The Twitter paragraph contains a standard layout for the visual design of your Tweets. If 
you want, you can store up to 5 additional layouts as HTML code. You can select cus-
tom layouts from a drop-down list in the Twitter paragraph. (See Twitter layouts).

Warning: If you lack knowledge of HTML, CSS, and Velocity, contact 
customer support to edit the alternative layouts. If you edit them 
without in-depth knowledge, serious display errors may occur in 
your mailings.

Parameter Description

Order (standard layout)

Position 1 – 
3

Specify where to display the date, author, and text by selecting the desired option 
from the drop-down list. To specify the distance between these information, in the Gen-
eral tab under Layout, change the value of the Space between texts and images box.
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Parameter Description

Layout 1 and 2

Desktop 
version Enter the source code for the desktop version.

Mobile ver-
sion Enter the source code for the mobile version.

Text ver-
sion Enter the source code for the text version.

Navigation menu
The navigation menu paragraph contains a standard layout for the visual design of nav-
igation menu. If you want, you can store up to 5 additional layouts as HTML code. You 
can select custom layouts from a drop-down list in the navigation menu paragraph. 
(see Navigation menu layouts).

Warning: If you lack knowledge of HTML, CSS, and Velocity, contact 
customer support to edit the alternative layouts. If you edit them 
without in-depth knowledge, serious display errors may occur in 
your mailings.

Parameter Description

Layout 1-5

Desktop version Enter the source code for the desktop version.

Mobile version                     Enter the source code for the mobile version.

Text version                     Enter the source code for the text version.

Structured data
Add structured data to your mailing to present the email more prominently and attract-
ively in the recipient's inbox or to add additional functions. The recipient's email 
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program must support structured data for this. If this is not the case, the structured data 
is ignored and the email is displayed regularly in the recipient's inbox.

Select the checkbox in the Gmail Promotions tab section to place the email prominently 
in the Gmail Promotions tab using structured data. Depending on the provided con-
tent, Gmail will add a company logo, an image banner, a coupon code and a timer to 
the email preview.

Note: The structured data generated by Episerver Campaign is in 
conformance with Gmail's specifications.  However, Episerver has 
no influence on how the structured data is ultimately interpreted in 
Gmail's inbox. For more information on the Gmail Promotions tab, 
see  Gmail developer website.

Alternatively, you can enter structured data directly as JSON-LD script in the JSON-LD 
source code section. Note that no validation takes place and that even a small error in 
the JSON-LD source code can result in the structured data not being read. In any case, 
test the display in advance using a test dispatch.

Parameter Description

Gmail Promotions tab

Activate

Check to add structured data to your mailing. By clicking Apply, a yellow box at the 
top of the edit area labeled Structured data is activated for this mailing appears. Click 
Display to display the JSON-LD script in the head section of the HTML code.

Tip: If you have knowledge of JSON-LD, you can use the 
code preview to review, copy, and modify the code in the 
JSON-LD source code section. 

Start date
To promote a limited time offer, you must specify a start date. The start date must lie 
before the mailing's send date to ensure that Gmail considers the structured data. Use 
the indicated date format.

Start time                    Define a start time. Use the time format hh:mm:ss.

End date
From the end date and end time, Gmail calculates the timer until the end of the offer. 
The end date must lie after the mailing's send date to ensure that Gmail considers the 
structured data. Use the indicated date format.

End time Define the end time of the offer. Use the time format hh:mm:ss.

https://developers.google.com/gmail/promotab/
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Parameter Description

Time zone
Select the time zone to which your time specifications refer. Gmail uses this to cal-
culate the end time for the recipient's time zone. Example: An offer that ends at 10:00 
AM in the UK ends at 6:00 PM in Japan.

Logo
Upload your company logo. The logo will be displayed next to the mailing preview. 
Alternatively, you can enter an external URL where the logo can be found. Use a 
square image format with an image size of at least 40 x 40 pixels.

Coupon 
description Enter a description to your coupon code. Example: 30% discount.

Coupon 
code

Insert a coupon code or placeholder depending on how you generate the coupon 
code. For information on how to create and include coupon codes with Episerver 
Campaign, see Coupon system.

Image
Upload an image that will be displayed below the text in the email preview. Altern-
atively, you can enter an external URL where the logo is to be found. Use a rect-
angular image format with an image size of at least 324 x 83 pixels.

Tracking
You can extend outgoing links with tracking parameters. With the help of web analytics 
software, you can use these parameters to analyze click behavior. You can define up to 
five tracking parameters. Each consists of a key (parameter name) and value.

Parameter Description

Parameter 1-5

Key Enter the name of the parameter.

Value                     Enter the value of the parameter (integer or string).

Text version
If you do not want to use the automatically generated text version, created from con-
tent you enter in the template editor, enter a text version for the complete newsletter. 
If you enable this option, no content is converted automatically into the text version.
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Parameter Description

Alternative text version

Activated
By default, this check box is cleared, and the text version is created automatically. If 
you check this box, you must enter a text version manually in the field below. Other-
wise, no text version is sent with your mailing.

Text
Enter the newsletter text. You cannot use HTML or other formatting in the text version. 
Only line breaks and special characters (such as ****** or ++++++) can be used to struc-
ture the newsletter.

Mobile
Activate an optimized version of your mailing for mobile devices. This version is sent 
together with the desktop version and displayed on smart phones and tablets.

Parameter Description

General

Activate 
mobile ver-
sion

Check to create a mobile version of the newsletter. By default, newsletter content is 
included in the mobile version. For each paragraph, you can define whether it is dis-
played or omitted in the mobile version. Note that the size of each email that contains 
a mobile version will increase by approximately 50-100 KB.

Click pro-
file

Select a click profile that is assigned to each recipient who clicks in the mobile version. 
Use the click profile to analyze the usage of the mobile version or to create target 
groups containing mobile users.

Activate 
link exten-
sion 

If you want to track mobile version links separately so that they are available in 
advanced reports, check this box. If you do, an additional parameter mobile with a 
value of 1is appended to mobile newsletter links.                                 

You can also use click profiles to achieve more convenient reporting.
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Setting the pre-header
The pre-header is the first text part of a newsletter, positioned above the content. In 
most cases, the pre-header presents a link similar to If this message is not displayed cor-
rectly, click here, which redirects to the online version of the newsletter. This is useful as 
many email programs and providers (such as Outlook, Hotmail, Gmail) block images by 
default. Other examples of pre-headers are an unsubscribe link, or a hint about adding 
the sender to the recipient's address book. 

To insert a pre-header, click  New: Pre-Header in the template editor. You can use several 
pre-headers and assign them to target groups to restrict the pre-header to certain recip-
ient segments.

Change the settings described below as desired and confirm by clicking Apply.

General         

Parameter Description

Content

Text Enter the pre-header text, such as a reference and link to the online version. 

Show in 
online ver-
sion

Select to include this paragraph in the online version.

Show in 
desktop 
version                     

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion                     

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in 
text ver-
sion

Select to show the paragraph in the text version of the mailing.
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Options         
Use these settings to define a pre-header layout that is from the default newsletter set-
tings.

Parameter Description

Layout

Width Enter an integer value in pixels.

Alignment Select a value from the drop-down list.

Background 
color

To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding Enter an integer value.

Mobile

Width Enter the width of the mobile newsletter in percentage.

Click profiles         

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles.  See 
Click profiles.

Target groups         

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.
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Setting up a pre-header for emails

If a subscriber clicks the link to the online version or reloads the newsletter images (that 
is, right-mouse clicks the blocked images), these steps may result in a premature closing 
of the newsletter by deleting it or marking it spam.

During the first weeks of subscription, use a pre-header to ask recipients to add your mail-
ing address to their email address book. If they do, email sent from known addresses is 
immediately displayed in full, including images, by many email programs and providers 
(such as Gmail, Hotmail, Outlook). Such recipients also see your newsletter in email pre-
view.

Adding your mailing address to a subscriber's address book also improves deliverability, 
since the email program classifies your newsletter as trustworthy. This is also very import-
ant with regard to "smart mailboxes" that some email providers are using. 

To implement a pre-header into your emails, select recipients, adapt the email's HTML 
code, and create a filter.

Selecting recipients

You should only send  a pre-header  to new subscribers. Recipients who have received 
your newsletter for a time may have already updated their address book, or might not 
want to. So, create a filter for the pre-header that selects recipients who registered for 
the newsletter in the last three to four weeks. Adjust the time period to the sending fre-
quency of your newsletter. Send on a monthly basis instead of every week, or try 60 
days.

Adapting the email

The pre-header should contain a short text, asking the recipient to take action:

Please add our mailing address "newsletter@example.com" to your address book!

Creating a filter

To show this text to newly-registered recipients only, create a new Field function using 
the filter, or use a script. For example, many email marketing programs support the Velo-
city scripting language, which lets you add logic to HTML code to perform recipient-
dependent dynamisations.

http://velocity.apache.org/engine/1.7/user-guide.html
http://velocity.apache.org/engine/1.7/user-guide.html
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Depending on how flexibly the pre-header is supposed to be used, fixed filters could be 
linked, or the filter and/or the registration period for the filter could be designed as 
selectable.

Adapting the text version

In the first line of the text version of the newsletter, you should also prompt subscribers to 
add the mailing address to their address book.         

Testing your changes

 1. Create an email address for testing. 
 2. Send an email to the address whose opt-in date falls within the relevant time period. 

Setting the header
By default, the header contains a text/image paragraph with a logo and issue number. 
Complete this information and upload your company logo. 

 l The newsletter contains only one header element. 
 l The header can contain several paragraphs.
 l You can select the same paragraph types as in the content section. 
 l You can remove the header if not needed. 

To add a new paragraph in the header, click Header; see  Content paragraphs.

To define the layout and select other options, click Header; see Grouping paragraphs.

Setting the footer
The footer usually contains contact and legal information and an imprint. 

 l You can add more paragraphs to the footer. 
 l The newsletter contains only one footer element. 
 l You can remove the footer if not needed. 

To add a new paragraph in the footer, click New: Footer paragraph; see Content para-
graphs.
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To define the layout and select other options in the footer, click Footer; see Grouping 
paragraphs.

Grouping paragraphs
Grouping paragraphs serve to structure the newsletter, but do not contain any content. 
From a high-level perspective, a newsletter only contains pre-header, header, footer, 
and grouping paragraphs. You can add to a mailing several grouping paragraphs, then 
insert content paragraphs into them. 

Each grouping paragraph can contain its own table of contents, or you can create one 
table of contents for all grouping paragraphs. Grouping paragraphs provide additional 
layout options, such as a sidebar.

 l To add a grouping paragraph, click  New: Paragraph then Grouping paragraph. Con-
figure it as described below. 

 l To add content to a grouping paragraph, click New: Content paragraph, click a para-
graph type, and edit it; see Content paragraphs.

 l To add a new separator, click New: Paragraph then Separator. Configure the sep-
arator; see Separator paragraph. To add the separator to the newsletter, click Apply.

Main area

Parameter Description

Layout

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Space Specify the space (vertical and horizontal) between content paragraphs within a 
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Parameter Description

between 
content 
paragraphs

grouping paragraph.

Border

Show Select if you want to apply a border around the grouping paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel on 

the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Rounded 
corners

Show must be selected for this parameter to be effective. The radius value is the 
same as the padding value set for this paragraph. If no padding value is set, a value 
of 10 pixels is assumed.              

If you select this option, only a single value for border width is used. If more than 
one value is defined, only the first one is used for all sides.

Background

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Image

The correct display of background images is not supported by all email clients. So, the 
background image should contain no important information.              

If you use a background image, the parameters Alignment and Repeat become 
effective. Note that background images are only visible at the border areas and 
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Parameter Description

at free spaces. Otherwise, they are covered by content and other backgrounds.

Alignment Only effective if a background image is uploaded. Sets the alignment for the whole 
newsletter. Alignment of the content elements is defined in the content paragraphs.

Repeat Only effective if a background image is uploaded. Repeats the background image.

Sidebar
Optionally, grouping paragraphs can be displayed in a two-column layout, with a main 
area and a sidebar. The sidebar can contain the same content paragraphs as the main 
area.

Parameter Description

Layout

Show Select  to show a sidebar in this grouping paragraph.

Width The value cannot exceed the total width of the content area.

Position The sidebar may appear to the left or the right of the main area.

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Space 
between 
content 

Specify the space (vertical and horizontal) between content paragraphs within a 
grouping paragraph.
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Parameter Description

paragraphs

Space 
between 
sidebar and 
main area

Specify the space between the sidebar and the main area.

Mobile

Position

In the mobile version, the sidebar is positioned above or below the main area, due to 
the reduced available space. Select the desired position from the drop-down list.             

This option is only in effect if the mobile version is activated in the general settings. 

Border

Show Select if you want to apply a border around the entire paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel on 

the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Rounded 
corners

Show must be selected for this parameter to be effective. The radius value is the 
same as the padding value set for this paragraph. If no padding value is set, a 
value of 10 pixels is assumed. 

If you select this option, only a single value for border width is used. If more than 
one value for border width be defined, only the first one is assumed for all sides.
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Parameter Description

Background

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Image

The correct display of background images is not supported by all email clients. So, the 
background image should contain no important information.              

If you use a background image, the parameters Alignment and Repeat become 
effective. Note that background images are only visible at the border areas and 
at free spaces. Otherwise, they are covered by content and other backgrounds.

Alignment Only effective if a background image is uploaded. Sets the alignment for the whole 
newsletter. Alignment of the content elements is defined in the content paragraphs.

Repeat Only effective if a background image is uploaded. Repeats the background image.

Options

Parameter Description

Layout

Background 
color (outer 
area)

To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles.  See 
Click profiles.
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Target groups

Parameter Description

Target 
groups                     

To show this paragraph to one or more target groups only, select them. If more 
than one target group is selected, just one must match (OR logic). See Target 
groups.

Note: For paragraphs in the header and footer you cannot 
select target groups, because these elements are con-
sidered mandatory in every mailing.

Content paragraphs
Within your mailing's Grouping paragraphs, you can insert the following types of content 
paragraphs and fill them with content. To do this, click New: Content paragraph and 
select the desired type.

 l Product paragraph. Adds a paragraph with predefined fields for product details. See 
also: General settings.

 l Product paragraph with content interface. Imports product data, such as offer texts 
and product images, from your webspace or server into the Template Kit.

 l Content interface paragraph. Add items from your online shop to a mailing.
 l Source code paragraph. Enter HTML and a separate text version.
 l Text or image paragraph. Contains a text area and an image, which you can place 

relative to a text block and headline.
 l Table of contents paragraph. Automatically creates a table of contents from the 

headlines of content paragraphs or a grouping paragraph. It is placed in content 
paragraphs in the newsletter. Content paragraphs excluded from the table of con-
tents are ignored.

 l Image bar paragraph. Create a vertical or horizontal image bar with up to 10 
images. The images are scaled down automatically; so, the more images you 
include, the smaller each image is displayed.

 l Separator paragraph. Only for structuring purposes; contains no content.
 l RSS feed paragraph. Load content from an RSS feed into your mailing. 
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 l Recommendations paragraph. Adds automatically generated individual  
recommendations for each recipient through a URL. You need a software that gen-
erates recommendations based on a recipient's actions. 

 l Facebook paragraph. Integrate current Facebook posts into your message.
 l Twitter paragraph. Integrate current tweets into your message. 
 l Navigation menu. Creates navigation bars with links to landing pages or deep links.

Product paragraph

Use the product paragraph to add items from your online shop to a mailing. The para-
graph contains input fields for:

 l Product name
 l Description
 l Category
 l Old price
 l Current price
 l Manufacturer

Define the order of the fields in the general settings. You can use your own categories 
instead of the standard categories. In this case, contact customer support before setting 
up the template.

Product paragraph fields have no formatting by default. To manually edit the para-
graph, use the editor. Or, when using a content interface paragraph, use HTML, which 
can be transferred together with the contents.

Tip: Content interface
The product paragraph is prepared for use by the Content inter-
face, which you can use to automatically complete content 
fields, for example, with product data from your inventory man-
agement system.

Creating a product paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.
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Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 

 2. Click Product. The configuration window for the selected paragraph type opens.
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 3. Click Apply. The new product paragraph appears in the preview window on the left.

Configuring a product paragraph

 1. On the left, in the menu bar of the product paragraph, click Product. The con-
figuration window opens on right.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Image
 l Button
 l SWYN
 l Options
 l Click profiles
 l Target groups
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General

Parameter Description

Content

Heading Enter a heading for this paragraph.

Name Enter a product title or a work title.

Category Enter a product category or a genre.

Author/Artist/Manufacturer Enter the name of the author, artist, or manufacturer.

Text Enter a product description or an abstract of a work.

Old price If you want to create a promotional campaign, a bargain, or a spe-
cial offer, enter product's old price.

Current price Enter the product's current price.

Show in desktop version Select  to include this paragraph in the desktop mailing.
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Parameter Description

Show in mobile version
Select  to show the paragraph in the mobile version of the mailing. The 
Activate mobile version setting in the general settings must be activ-
ated for this option to take effect. 

Show in text version Select to show the paragraph in the text version of the mailing.

Link

Text Text entered here is linked to the URL below.

URL This could be a landing page or a product details page from your 
online shop.

Alignment The link can be aligned right, left, or center.

Image

Parameter Description

Image Upload an image or enter an image URL in the field Alternatively external URL that 
points to the image file.

Alternative 
text

This text is displayed if a recipient blocks or disables images in the email client, or if the 
image cannot be displayed for another reason.

Enter alternative text containing a short description or title for the image.

Link You can link the image to a landing page or a page on your verbosity you entered a 
text link in this paragraph, you should use the same link for the image.

Subtitle Enter an optional image subtitle.

Position

You can place the image in a separate column next to the heading and text block, or 
in a separate column next to the text block but below the headbanging most cases, 
these positions are recommended.

If you use large images that cover the entire width of a paragraph or area, center 
them below the heading, the text, or the link.
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Button

See Click2Go.

SWYN

You can enable the SWYN function for social networks individually for each paragraph. 
To allow sharing of these paragraphs in a social network, select the Show check box for 
the network in which you want them to appear.

Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image
Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed. 

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard text is displayed. 
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Parameter Description

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard image is displayed. Larger images 
are scaled down to this size.

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

Twitter

Show Lets recipients share the paragraph via their Twitter account.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed. 

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

MySpace

Parameters for MySpace are identical to Facebook's.

Xing

Parameters for Xing are identical to Twitter's.

Options

For each content paragraph, you can define a layout that is different from the general 
newsletter layout.

Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smaller 
than this value, then the entered value is ignored.
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Parameter Description

Height
By default, the paragraph is displayed over the available height, considering the con-
tent. Alternatively, you can specify a fixed height. If the content exceeds this height, 
the value is ignored, and the content is displayed at the default height.

Background 
color

To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Border

Show Check to apply a border around the paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 
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Parameter Description

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on 
top of each another with the assigned widths.

Table of contents

Show in 
Table of 
Contents

Select to display the paragraph in the table of contents for the section.

Alternative 
Table of 
Contents 
Entry

Enter a heading to be displayed for this section in the table of contents. If you enter 
nothing, the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles. See 
Click profiles.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.

Product paragraph with content interface

Note: To enable this feature, contact customer support. You must  
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specify the directory on your webspace or your server where you 
will store your product data.
This directory must allow HTTP requests. If the product data dir-
ectory is only accessible with authentication, disable the authen-
tication. If desired, you can only allow specific IP addresses to 
access product data.

The product paragraph with content interface imports product data, such as offer texts 
and product images, from your webspace or server to the Template Kit. It lets you cre-
ate product offers in your merchandise management system then transfer them to the 
Episerver Template Kit. You can recommend products, offer discounts, provide noti-
fications of new releases, create a new product paragraph, and import product offers 
with just a few clicks.

You can store product data statically as XML files on your server, have your server 
dynamically generate XML files as requested by the content interface. Episerver Cam-
paign retrieves your product data and makes it available to your messages.

Configuring the content interface

When the feature is enabled, a new button with a folder icon  appears on the menu 
bar of the product paragraph.
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Product paragraph with content interface default values

The product paragraph can load the following product data through the content inter-
face:

 1. unique ID
 2. name
 3. category
 4. authors/performers/manufacturers/providers
 5. description
 6. old price
 7. current price
 8. URL link to the product, such as in your web shop
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 9. text label for the URL link, for example, "Book now"
 10. an image URL, for displaying a product image

The following image shows the individual components of a sample product offer.

Making product data available as XML

An HTTP request is used to load product data from your webspace or server to the Tem-
plate Kit and start the import into Episerver Campaign. 

When the request is made, your product data must:

 l exist on your webspace or server as an XML file (static product data)

or

 l be generated dynamically in an XML format (dynamic product data)

Tip: Your company's environment determines whether you import 
static or dynamic product data. Contact your system admin-
istrator to learn which implementation is in use.
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Saving static product data as XML on the server

To save product data statically as XML files on your webspace or server, each product 
must be saved in an XML file. You cannot group multiple products into a single XML file. 
To save a product as an XML file, perform the following steps.

 1. Open a text editor, such as Notepad (Windows) or Textedit (macOS/OS X).
 2. Create a new document.

Warning: Set your text document to use UTF-8 character encod-
ing.  If you use another encoding, the text may not be rep-
resented properly.

 3. Copy the following code into the document.             
 Code sample

<element>
 <property name="id"><![CDATA[123456]]></property>
 <property name="name"><![CDATA[Name]]></property>
 <property name="category"><![CDATA[Category]]></property>
 <property name="manufacturer"><![CDATA[Author/Artist/Manufacturer]]></property>
 <property name="text"><![CDATA[Product description]]></property>
 <property name="oldPrice"><![CDATA[<s>EUR 29.99</s>]]></property>
 <property name="currentPrice"><![CDATA[<b>EUR 19.99 EUR</b>]]></property>
 <property name="linkText"><![CDATA[Add to shopping cart]]></property>
 <property name="linkUrl"><![CDATA[http://www.example.com/product/123456]]></property>
 <property name="imageUrl"><![CDATA[http://img.ex-
ample.com/product/123456.jpg]]></property>
 </element>

Tip: The following steps guide you through customizing this code 
for your setup. Only product ID (in code, the property id) and 
product name (in code, the property name) are mandatory. 
Other values are optional. Delete any unused values.
Example: You do not want to specify product manufacturer, so 
delete the following line:

<property name="manufacturer"><![CDATA[Author/Artist/Man-
ufacturer]]></property>

Alternatively, leave unneeded lines of code empty. For 
example, you want to enter the information later. If you do not 
want to specify the product manufacturer and want to leave 
the code in the document, the line looks like this:

<property name="manufacturer"><![CDATA[]]></property>
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Tip: You can use HTML source code in these properties: name, 
category, manufacturer, text, oldPrice, currentPrice. For example, 
you want to insert links into the product description.

 4. In the first property row, enter the product ID between the square brackets after 
CDATA.

Example: The product ID is ParisTrip01.

<property name="id"><![CDATA[ParisTrip01]]></property>

Note: Use only alphanumeric characters (letters and numbers) 
in the product ID. If you use special characters, you may 
encounter problems importing product data.

 5. In the second property line, enter the product name between square brackets after 
CDATA. 

<property name="name"><![CDATA[Unwind in Paris]]></property>

 6. In the third property line, enter the product category  between square brackets 
after CDATA.

<property name="category"><![CDATA[City travels]]></property>

 7. In the fourth property line, enter the product manufacturer (or, depending on 
product, author, artist, operator, manufacturer, and so on) between square brack-
ets after CDATA.

<property name="manufacturer"><![CDATA[Sun Worshipers Travel]]></property>

 8. In the fifth property line, enter the product description, for example text and a web-
site link, between the square brackets after CDATA.

<property name="text"><![CDATA[Eiffel Tower, Champs-Élysées, Louvre: Treat yourself to 
some time out in Paris!”]]></property>

 9. In the sixth property line, enter the product 's old price between <s> and </s>.

<property name="oldPrice"><![CDATA[<s>EUR 399</s>]]></property>

Note: The old price is crossed out by default. To omit the 
strikethrough in your communications, delete <s> and </s>.
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 10. In the seventh property line, enter your product's current price between <b> and </b>.

<property name="currentPrice"><![CDATA[<b>EUR 299</b>]]></property>

Note: By default, the current price is displayed in bold. To omit 
the bold, delete <b> and </b>.

 11. In the eighth property line, enter a text label for a product link between the square 
brackets after CDATA.

<property name="linkText"><![CDATA[Book now]]></property>

 12. In the ninth property line, enter the URL link to your product between the square 
brackets after CDATA.

<property name="linkUrl"><![CDATA[http://www.sonnenhungrig.com/paris]]></property>

 13. In the tenth property line, enter the URL to your product image between the square 
brackets after CDATA.

<property name="imageUrl"><![CDATA[http://www.sonnen-
hungrig.com/eiffeltower.jpg]]></property>

 14. Save the text document. For the file name, use the product ID (the value you inser-
ted for the id property). For file type. use .xml.

 15. Delete the document's file extension. For example, if the document is named Par-
isTrip01.xml,  rename the file as ParisTrip01.

Warning: If you do not remove the file extension, your product 
data cannot be loaded.

 16. Save the document in your webspace or on your server in the directory that you 
communicated for the setup of the product paragraph with content interface.

Warning: Do not change the location of the product description 
documents without consulting customer support. If you change 
directories without consulting customer support, you cannot  
load product data using the content interface.

After saving these documents, you can access your product offer in the Template 
Kit. Follow the steps in Load and edit product data to upload your product offer into 
the Template Kit using the content interface.
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Generating dynamic product data on the server

XML files are not prepared manually, but are loaded from a database when requested 
(by HTTP request) via the content interface and automatically generated as XML. If you 
want to generate dynamic product data, see your system administrator.

Loading and editing product data

After product data is made available as XML files in your webspace or on your server, 
and customer support has stored your data source in your client, you can load product 
data into the Template Kit. After the import is complete, you can edit the data in the 
Template Kit using the content interface.

Loading product data 

 1. In the Template Kit, click New: Content paragraph.
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 2. Click Product. The configuration window for the selected paragraph type opens.

 3. Do not change settings in the configuration window. Click Apply. The new product 
paragraph appears on the left, in the preview window.
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 4. In the menu bar of the new product paragraph, click Content interface  .

 5. In the Content element box, enter the ID of the product offer that you want to load 
into the Template Kit.

 6. On the bottom right of the window, click Apply. When the import is completed, the 
product offer appears on the left of the preview window.



© Episerver 2020

Managing content | 361

Editing product data

If product offers were loaded from your webspace or server via the content interface 
into the Template Kit, you can edit them  there. The steps for doing this are the same as 
those processing product paragraphs needing an extension through the content inter-
face. See Product paragraph.

Tip: If you use product paragraphs with an extension through the 
content interface, you should make changes to product offers in 
your system and update the product paragraphs in the Template 
Kit by loading the changes. This ensures that your product offers 
are up to date and that no outdated, modified content is loaded 
into the Template Kit later. To update a product paragraph, click 

Content interface   in the menu bar of the product paragraph, 
then Apply.

Warning: The product paragraph with the content interface can be 
configured by customer support so that your product offers are auto-
matically updated on the ship date. This option is useful if your 
products' prices often change between the time of message cre-
ation and shipping. If this option is configured for you, any changes 
to your product offers must be made on your system. If you only per-
form changes in the Template Kit, they are overwritten on the ship-
ping date with the old content from your webspace or server.

Editing HTML layouts

The product paragraph with the content interface provides a standard layout for 
formatting offer text and images. 

Note: To receive an alternate layout customized to your products 
and services, contact customer support.
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Standard layout

You can change the order of components in your product offer in the standard layout. 
For example, you can determine whether the current price should be shown first fol-
lowed by the old one, or whether the product manufacturer should appear before the 
product category.

To change the order of product offer components  in a standard layout, perform the fol-
lowing steps:

 1. In the Template Kit, click Settings. The settings window opens on the right.

 2. Click the Products tab.
 3. In the Order area, determine the order of product offer components by selecting 
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from drop-down lists.

Standard layout example
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Alternate Layout

If  customer support sets up an alternate layout, product offers are formatted according 
to its specifications. You cannot change the order of components in an alternate lay-
out. To change an alternate layout, contact customer support.

Tip: If an alternate layout is set up, you cannot access the standard 
layout.

Alternate layout example

Troubleshooting product paragraph with content interface

Issue Possible cause                     Solution                     

Product data not load-
ing                     

Product ID is entered incor-
rectly.                     Enter the correct product ID.                                        

Product data not load-
ing                     

XML file has a file exten-
sion.                     Remove the file extension.                    

Product data not load-
ing                     

Corresponding product 
offer no longer exists on 

Save the product offer again on your 
webspace or server.                    
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Issue Possible cause                     Solution                     

your webspace or server.                     

Product data not load-
ing                     

Product data saved in 
wrong directory on server 
or webspace.                     

Transfer the product data you are trying 
to load to the directory indicated when 
setting up the content interface.                     

Product data not load-
ing                     

Directory in which the 
product data is stored is 
not available.                     

 l Check whether the directory is 
reachable only after prior authen-
tication and disable authentication.

 l Check whether there is a problem 
with your server or webspace. Try 
loading product data again later.

Some content not load-
ing. For example, the 
product image is miss-
ing.                     

Error in XML code you gen-
erated.                    Correct the XML code.                     

Special characters not 
displayed correctly, 
such as German 
umlauts.                     

Incorrect character 
encoding in XML.                    Set encoding of XML file to UTF-8.                     

Tip: If the problem continues after you try all suggested solutions, 
contact customer support.

Content interface paragraph

The content interface paragraph imports product data, such as offer texts and product 
images, from your e-commerce system into the Template Kit. Whether Episerver Cam-
paign, Magento,  in-house software development by your company, or another system, 
the content interface paragraph is flexible and supports a variety of data sources.

Note: To learn about importing Episerver Campaign data, see 
Importing and exporting a catalog in the Episerver User Guide.
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The technical implementation supports the open XML standard and CSV file format  – 
many data sources support both formats.

Export product data from your data source and let Episerver Campaign process it. In the 
Template Kit, create a new content interface paragraph with individual items, then 
import your current product offering with just a few mouse clicks.

Your data source can handle product data either by:

 l saving it as static XML files on your webspace or server
 l your server generating dynamic XML files when queried
 l saving product data as a CSV file on the server (both manually or automatically)

Tip: The content interface paragraph is related to the Product para-
graph with a content interface. However, the content interface 
paragraph is more flexible as it supports both CSV and XML formats. 
You can use both file formats together. To learn which solution is 
better for you, contact customer support.

Static and dynamic content

The content interface paragraph supports static and dynamic content.

 l Static content. Product data is loaded  when you create the mailing. The data can 
then be edited. If you integrate static content, all recipients receive the same con-
tent.

 l Dynamic content. The content is loaded   when the message is being sent. You can-
not edit content in advance. However, you can send different product recom-
mendations to each recipient. For more information, see Dynamic CSV and XML 
articles.

Tip: You can use static content with dynamic content in the same 
mailing. Customer support can advise you about combining con-
tent types.

Four paragraph types

There are four paragraph types. Only types enabled in your client appear in the Tem-
plate Kit.

 l Static CSV article
 l Static XML article
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 l Dynamic CSV article
 l Dynamic XML article                 

Setting up the content interface paragraph

To set up the content interface paragraph, contact customer support and provide the 
following information:

 l XML or CSV, or XML and CSV together: Which format do you want for product data?

 o XML. In which directory on your webspace or server will you store product data? 
That directory must allow HTTP requests. If the directory is only accessible with 
authentication, disable it. You can restrict access to product data  to specific IP 
addresses.

 o CSV. What will you call the CSV file to which your product catalog is saved? If 
you update the product catalog later, you must save that version of the CSV 
under the name given when setting up the content interface.

 l Static content, dynamic content or a combination of both content types: Do you 
want to send the same content or customized product recommendations to your 
recipients?

After setup, the content interface paragraph type is available in the Template Kit.
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Standard values of a product offer

The content interface paragraph can load the following product data:

 1. the product’s unique ID (not displayed in the message)
 2. up to 10 text elements per product offer, in which you can enter the heading for a 

product offer, the product description, or the product price
 3. up to 3 text links per product offer, such as calls to action (Buy now, Learn more, and 

so on)
 4. up to 6 product images per product offer (by entering a URL)

 l up to 6 links to product images (one link per image) that direct the recipient to 
additional information by clicking on the image

 l up to 6 alternative texts for product images in case a recipient cannot load 
product images  and to support accessible messages

Note: You can also transfer up to 20 additional datasets as 
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metadata for HTML layout program logic.

The following image shows the components of your product offer.

Exporting product data with a CSV file

If you select CSV format, your product data is prepared in two steps: 

 1. Export product data from your e-commerce system or another data source into a 
CSV file.

 2. Move the CSV file to your personal directory on the server.  Episerver Campaign 
retrieves the CSV file then makes its product data available in the Template Kit.

Tip: If you have a personal directory on the server but no login 
information, contact customer support to set up a user account.

Export product data from your system as a CSV file. CSV files exported from different sys-
tems can differ widely. For example, names and column heading order  can be dif-
ferent. Such differences can create problems when importing product data. If no 
information is provided about what the dataset columns contain (for example, the 
column that contains the product name), Episerver Campaign cannot read the CSV file 
properly nor correctly classify the individual datasets. 
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But, if you use an Episerver integration for one of these e-commerce systems, the con-
tent interface can recognize CSV files with different structures and process them cor-
rectly :

 l Magento

If you use Episerver integration with one of these systems, you can export product data 
using the Episerver plug-in with no adjustment.

Note: If you do not use an Episerver integration, you must use 
Episerver Campaign's generic CSV structure.

Generic CSV structure

Episerver Campaign's generic CSV structure  standardizes the structure and naming of 
column headings in CSV files, ensuring the correct import of product data. 

If your system/your data source has a feature that supports the export of datasets to a 
CSV file (such as a plug-in), configure the CSV file with the following structure and 
column headings:

"id";"name";"category";
 "text1";"text2";"text3";"text4";"text5";
 "text6";"text7";"text8";"text9";"text10";
 "link1Text";"link1Url";
 "link2Text";"link2Url";
 "link3Text";"link3Url";
 "image1ImageUrl";"image1AltText";"image1Link";
 "image2ImageUrl";"image2AltText";"image2Link";
 "image3ImageUrl";"image3AltText";"image3Link";
 "image4ImageUrl";"image4AltText";"image4Link";
 "image5ImageUrl";"image5AltText";"image5Link";
 "image6ImageUrl";"image6AltText";"image6Link";
 "additionalData1";"additionalData2";"additionalData3";"additionalData4";"additionalData5";
 "additionalData6";"additionalData7";"additionalData8";"additionalData9";"additionalData10";
 "additionalData11";"additionalData12";"additionalData13";"additionalData14";"additionalData15";
 "additionalData16";"additionalData17";"additionalData18";"additionalData19";"additionalData20"; 

Tip: Configuring an export feature generally requires programming.

Warning: When configuring the export feature,  observe the fol-
lowing:

 l The CSV file must be RFC-compliant. Technical notes are contained in 
RFC 4180.

 l Set character encoding for the CSV file to UTF-8 without BOM.

https://www.ietf.org/rfc/rfc4180.txt
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 l Use the semicolon (;) as a separator.
 l If some product data includes quotation marks (inverted commas), mask 

them with escape characters. Use the quotation mark " as the escape 
character. If you do not mask quotation marks,  they are misinterpreted 
as code, and the product data import fails. 

Example: You surround a word or a word group with quotation marks, 
such as "Savoir Vivre." In your CSV file, wrap the quoted text with double 
quotation marks: ""Savoir Vivre"". The outer quotation marks are recog-
nized as escape characters so are not displayed in the message text.

Creating a CSV file manually

If your system/your data source does not have a feature for exporting product datasets 
to a CSV file, and you want to manually create a CSV file with product data, perform 
the following steps: 

 1. Download the  template for the generic CSV structure here: template generic struc-
ture.csv

 2. Open the template using a spreadsheet program, such as Microsoft Excel or LibreOf-
fice Calc.

https://world.episerver.com/globalassets/downloads/episerver-campaign/episerver-campaign-generic-structure.csv
https://world.episerver.com/globalassets/downloads/episerver-campaign/episerver-campaign-generic-structure.csv
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Note: When opening the template, if you need to enter a sep-
arator, select semicolon. If you need to specify character 
encoding, use UTF 8 without BOM. Some programs, such as 
Microsoft Excel, do not provide UTF-8 without BOM. In that case, 
select UTF-8.

Warning: When filling out the template in the generic CSV struc-
ture, you must observe the following:
If some product data includes quotation marks (inverted com-
mas), mask them with escape characters. Use the quotation 
mark " as the escape character. If you do not mask quotation 
marks,  they are misinterpreted as code, and the product data 
import fails. Example: You surround a word or a word group with 
quotation marks, such as "Savoir Vivre." In your CSV file, wrap 
the quoted text with double quotation marks: ""Savoir Vivre"". 
The outer quotation marks are recognized as escape char-
acters so are not displayed in the message text.

 3. Begin entering product data in row 2. Enter the data for each product side by side 
(see image).      

Warning: Do not change the column headings or their order in 
row 1. If you do, your product data cannot be loaded into the 
Template Kit.

To add another product offer, insert the data again side-by-side in the next row (see 
image). 
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Template 
column heading

Product data to enter

id
Enter the unique product ID. It is not shown in your messages. You may 
only enter a product ID in the document once.

name
Enter a name for your product offer. Later, in the Template Kit, you can 
select the product offer by its name to include it in your messages (static 
CSV article only). It is not shown in your messages.

category

Enter the product category. It is not shown in your messages.  With the 
product category, you can create overview category trees in the Tem-
plate Kit and compile related products together to find specific 
products (static CSV article only). Enter the subcategories in this field, 
separated by hash symbols. Example: Medi-
terraneantravel#Italy#Sicily

Note: A category may have up to 10 sub-cat-
egories.

text1 – text10

Up to 10 text fields are available. Enter one piece of information in each 
field. For example:          

 l the heading for your product offer, such as text1 in the text field 
 l the name of the product to be shown in your message, such as text2 

in the text field 
 l the description of your product, such as text3 in the text field 
 l the old price of your product, such as text4 in the text field 
 l the current price of your product, such as text5 in the text field 
 l the supplier/manufacturer of your product, such as text6 in the text 

field 

You can choose what you want to enter in the text fields. Adapt the con-
tent according to your wants and the requirements of your pro-
duct/your service.

It may be best to organize product offer components sequentially from 
text1 through text10, which is how they are shown from top to bottom in 
the finished product offer. If you are not sure of the best order, contact 
customer support.

The formatting (text size and text color) of the text field content is set 
later using an HTML layout.
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Template 
column heading

Product data to enter

link1Text – 
link3Text

Enter the heading for the link or links to your product offer.

For example: Offer, More Information or Buy Now.

link1Url – link3Url
Enter links to pages to which recipients are directed if they click a link 
(such as the corresponding product page in your webshop).

image1ImageUrl 
– 
image6ImageUrl

Enter the URLs for the corresponding product images. The images are 
loaded by Episerver Campaign and displayed in your messages.

image1AltText – 
image6AltText

Enter alternative text for images. This text appears if an image cannot be 
loaded.

image1Link – 
image6Link

Enter a link to the product image. If the image is clicked, the recipient is 
forwarded to the link target. This can be your webshop or another 
address that you want to connect to the image.

Avoid mixing up ImageLink with ImageURL, which indicates the saved 
location of the image.

additionalData1 
– addi-
tionalData20

Enter additional data records that you can use, such as metadata for 
the program logic of the HTML layouts.

 4. Save and rename the file.

Warning: Give the file the name you entered for your CSV file 
when setting up content interface paragraphs. If you use a dif-
ferent name, the product data import will fail.  If you forgot the 
name, contact customer support.

Note: When saving the file, make sure the spreadsheet program 
does not assign a new file type. The file must have the file type 
CSV or file extension .csv.

https://en.wikipedia.org/wiki/Wikipedia:Manual_of_Style/Accessibility/Alternative_text_for_images
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Transferring the CSV file to the Episerver server

After you save the completed and renamed CSV template,  transfer it to your personal 
directory on the Episerver server.

Tip: If you use an Episerver integration for Magento, or OXID, the 
transfer is automatic. If you do not use an Episerver integration, but 
want to automate the transfer, use a script. Consult your system 
administrator or software service provider for a programming solu-
tion.

To transfer the completed and renamed Episerver template in your directory to the 
Episerver server, perform the following steps:

 1. Log in to the Episerver server with your user data.

Tip: If you do not have a user account for the Episerver server, 
contact customer support. See FTP API (Windows) for information 
about logging in to the Episerver server; see FTP API (macOS/OS 
X) for macOS.

 2. Upload the Episerver template to your personal directory on the Episerver server.

Warning: If you have multiple directories  on the Episerver server, 
save the template in the directory set up for your CSV files dur-
ing the configuration of the content interface. If you save the 
template to another directory, your product data import fails.

After you load the completed and renamed template into the correct directory, 
your current product offers are available in the Template Kit for integration into your 
messages.

Note: It can take some time for your product offers, transferred 
as a CSV file, to be available in the Template Kit. You should 
automatically perform the data transfer at night.
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Loading and editing static CSV product data

If you saved product data as a CSV file in your personal directory on the Episerver server, 
you can load product offers into your messages and edit them as necessary in the Tem-
plate Kit (within a content interface article). See general settings to change content 
interface paragraph settings. To integrate dynamic product data into the Template Kit, 
see Dynamic CSV and XML articles.

Loading product data 

 1. While editing a message in the Template Kit, click New: Content paragraph. A win-
dow for selecting paragraph type opens on the right.
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 2. Click Content interface. Its configuration window opens.

 3. Change no settings in the configuration window. Click Apply. The new paragraph 
appears on the left in the preview window, and the Content interface article button 
appears below the new paragraph.

Tip: Your product offers are created as content interface art-
icles, which are subparagraphs of the content interface para-
graphs.
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 4. Create a new content interface article by clicking Content interface article on the 
left. The configuration window for that article opens.

 5. Change no settings in the configuration window. Click Apply. To the left of the pre-
view window, the menu for the content interface article expands to include the but-

ton Content interface  .
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 6. Click Content interface  . The Load content window opens on the right.

 7. In the list, select the product offer to load into your message and click Apply.  When 
the loading is complete, the product offer appears on the left of the preview win-
dow.

Tip: To load additional product offers, create a new content 
interface article for each additional offer.

Editing product data in content interface article 

Once your product offer is loaded into your message, you can edit the offer in the Tem-
plate Kit. To do this, perform the following steps: 

 1. On the left of the preview window, in the menu for the corresponding content inter-
face article, click Static CSV article.                 The configuration window for that article opens.
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 2. Make your changes and click Apply.

Warning: Do not change the layout template if you lack 
advanced HTML and CSS skills. Doing so can lead to errors, 
which means that your product offers will not display properly. If 
you want to modify the layout template but lack HTML and CSS 
skills, contact customer support.

Edit the content of your product offers in the CSV file. Then, re-upload the modified 
CSV file to the server. This ensures that your product offers are up-to-date and that 
no old, subsequently modified content in the CSV file is loaded into the Template 
Kit. 

To update an existing content interface article, go to the article's menu bar, click 

Content interface  , select the appropriate product offer again, and click Apply.

Warning: Customer support can configure the content interface 
paragraph so that product offers are updated at dispatch by 
comparing it with your CSV file. If this option is configured, 
changes to product offers must be made in the CSV file. If you 
only make changes in the Template Kit, they are overwritten at 
dispatch with old content from the CSV file.
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Using XML

You can use the XML format for the content interface paragraphs.  If you choose XML 
(Extensible Markup Language), do not save your product data with the CSV solution on 
the Episerver server. Instead, Episerver Campaign retrieve product data from your web-
space or server using a HTTP request. 

When the request is made, your product data must:

 l exist on your webspace or server as an XML file (static product data)

or

 l be generated dynamically in an XML format (dynamic product data)

Tip: Your company's environment determines whether you import 
static or dynamic product data. Contact your system admin-
istrator to learn which implementation is in use.

Saving static product data on the server 

To save product data statically as XML files on your webspace or server, each product 
must be saved in an XML file. You cannot group multiple products into a single XML file. 
To save a product as an XML file, perform the following steps.

 1. Open a text editor, such as Notepad (Windows) or Textedit (macOS/OS X).
 2. Create a new document.

Warning: Set your text document to use UTF-8 character encod-
ing.  If you use another encoding, the text may not be rep-
resented properly.

 3. Copy the following code into your document.
Code to copy

<?xml version="1.0" encoding="UTF-8"?>
 <element>
 <property name="id">123456</property>
 <property name="text1"><![CDATA[<b>Text field 1</b>]]></property>
 <property name="text2"><![CDATA[Text field 2]]></property>
 <property name="text3"><![CDATA[Text field 3]]></property>
 <property name="text4"><![CDATA[Text field 4]]></property>
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 <property name="text5"><![CDATA[Text field 5]]></property>
 <property name="text6"><![CDATA[Text field 6]]></property>
 <property name="text7"><![CDATA[Text field 7]]></property>
 <property name="text8"><![CDATA[Text field 8]]></property>
 <property name="text9"><![CDATA[Text field 9]]></property>
 <property name="text10"><![CDATA[Text field 10]]></property>
 <property name="link1Text"><![CDATA[Text for link 1]]></property>
 <property name="link1Url"><![CDATA[URL for link 1]]></property>
 <property name="link2Text"><![CDATA[Text for link 2]]></property>
 <property name="link2Url"><![CDATA[URL for link 2]]></property>
 <property name="link3Text"><![CDATA[Text for link 3]]></property>
 <property name="link3Url"><![CDATA[URL for link 3]]></property>
 <property name="image1ImageUrl"><![CDATA[Image URL for image 1]]></property>
 <property name="image1AltText"><![CDATA[Alternative text for image 1]]></property>
 <property name="image1Link"><![CDATA[Link for image 1]]></property>
 <property name="image2ImageUrl"><![CDATA[Image URL for image 2]]></property>
 <property name="image2AltText"><![CDATA[Alternative text for image 2]]></property>
 <property name="image2Link"><![CDATA[Link for image 2]]></property>
 <property name="image3ImageUrl"><![CDATA[Image URL for image 3]]></property>
 <property name="image3AltText"><![CDATA[Alternative text for Image 3]]></property>
 <property name="image3Link"><![CDATA[Link for image 3]]></property>
 <property name="image4ImageUrl"><![CDATA[Image URL for image 4]]></property>
 <property name="image4AltText"><![CDATA[Alternative text for image 4]]></property>
 <property name="image4Link"><![CDATA[Link for image 4]]></property>
 <property name="image5ImageUrl"><![CDATA[Image URL for image 5]]></property>
 <property name="image5AltText"><![CDATA[Alternative text for image 5]]></property>
 <property name="image5Link"><![CDATA[Link for image 5]]></property>
 <property name="image6ImageUrl"><![CDATA[Image URL for image 6]]></property>
 <property name="image6AltText"><![CDATA[Alternative text for image 6]]></property>
 <property name="image6Link"><![CDATA[Link for image 6]]></property>
 <property name="additionalData1"><![CDATA[Additional information 1]]></property>
<property name="additionalData2"><![CDATA[Additional information 2]]></property>
<property name="additionalData3"><![CDATA[Additional information 3]]></property>
<property name="additionalData4"><![CDATA[Additional information 4]]></property>
<property name="additionalData5"><![CDATA[Additional information  5]]></property>
<property name="additionalData6"><![CDATA[Additional information 6]]></property>
<property name="additionalData7"><![CDATA[Additional information 7]]></property>
<property name="additionalData8"><![CDATA[Additional information 8]]></property>
<property name="additionalData9"><![CDATA[Additional information 9]]></property>
<property name="additionalData10"><![CDATA[Additional information 10]]></property>
<property name="additionalData11"><![CDATA[Additional information 11]]></property>
<property name="additionalData12"><![CDATA[Additional information 12]]></property>
<property name="additionalData13"><![CDATA[Additional information 13]]></property>
<property name="additionalData14"><![CDATA[Additional information 14]]></property>
<property name="additionalData15"><![CDATA[Additional information 15]]></property>
<property name="additionalData16"><![CDATA[Additional information 16]]></property>
<property name="additionalData17"><![CDATA[Additional information 17]]></property>
<property name="additionalData18"><![CDATA[Additional information 18]]></property>
<property name="additionalData19"><![CDATA[Additional information 19]]></property>
<property name="additionalData20"><![CDATA[Additional information 20]]></property>
 </element>

Note: The following steps guide you through customizing this 
code for your setup. Only product ID (in code, the property id) 
is mandatory. Other values are optional. Delete any unused val-
ues.

 4. In the first property row, enter the product ID . Insert your product ID between the 
brackets.
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Example: Your product has the product ID "FR123". <property name="id">FR123</property>

Note: Use only alphanumeric characters (letters and numbers) 
in the product ID. If you use special characters, you may 
encounter problems importing product data.

Tip: In all steps below, you insert the value between brackets, 
after CDATA.

 5. In the 2nd through 11th property rows (text1 through text10), enter up to ten text ele-
ments for your product offer. "Text field 1", "Text field 2", "Text field 3" and so on are 
entered as placeholders for your text elements.

The text elements can include things such as the heading for the product offer, the 
product name, the product category, the product description, the old price, the 
current price, the manufacturer/supplier, and so on. Adapt the content to your 
needs and your product or service's requirements.

Example: The header of the product offer is: Relax in Paris. <property name="text1"><!
[CDATA[Relax in Paris]]></property>

Tip: It is best to organize product offer components  sequen-
tially, from text1 through text10, which is how they are shown in 
the finished product offer. If you are not sure what order is best 
for you, contact customer support. The formatting (text size and 
text color) of the text field content is set separately using an 
HTML layout.

 6. In the 12th property row, enter the heading for the link to your product offer. For 
example: Offer, More Information or Buy Now.  

Example: The link text is: Book now. <property name="link1Text"><![CDATA[Book now]]></-
property>

 7. In the 13th property row, enter the URL that leads to the product page in your web-
shop. 

Example: The URL of the product page is http://www.sonnenhungrig.com/paris: 
<property name="link1Url"><![CDATA[http://www.sonnenhungrig.com/paris]]></property>

 8. In the property rows 14 through 17, if your product offer needs more than one link, 
enter two additional links and link texts. Enter the information as specified in steps 6 
and 7.
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Tip: Example: Next to the link to the booking page for the Paris 
trip, another link leads to the current weather in Paris.

 9. In the 18th property row enter the URL to the product image. Episerver Campaign 
loads the product image using that URL and shows it in your message.  

Example: The URL of the product image is "http://www.sonnen-
hungrig.com/eiffeltower.jpg". <property name="image1ImageUrl"><![CDATA
[http://www.sonnenhungrig.com/eiffeltower.jpg]]></property>

 10. In the 19th property row, enter the alternative text for your product image. An altern-
ative text is the text that is shown when an image cannot be loaded. Enter altern-
ative texts, because visually impaired people can read these using special 
programs, promoting an accessible Internet.

Example: The alternative text for your product is "The Eiffel Tower in Paris in spring-
time". <property name="image1AltText"><![CDATA[The Eiffel Tower in Paris in spring-
time]]></property>

 11. In the 20th property row, enter a URL for the product image. If a recipient clicks on 
the image, he or she is led to the associated URL. This can be your webshop or also 
any other address that you want to connect to the image. 

Warning: To display the image in messages, be certain that you 
are using the ImageURL, which indicates the image's saved loc-
ation. The ImageLink, on the other hand, directs the recipient 
to the link target, which has additional information.

Example: The URL associated with your product image is: "http://www.sonnen-
hungrig.com/sightsinfrance". <property name="image1ImageUrl"><![CDATA[http://www.sonnen-
hungrig.com/sightsinfrance]]></property>

 12. In the property lines 21 through 35, up to five additional URLs for the locations where 
the product images are stored can be entered, and five additional alternative texts 
and five additional links that direct the recipient to the link target when clicked. This 
means: Up to six product images, each with an alternative text and a link can be 
associated with each product offer. Enter the information as specified in steps 9 and 
11 of this manual.

 13. In the property lines 36 to 55, enter additional data records that you can use, such as 
metadata for the program logic of the HTML layouts.

 14. Save the text document. For the file name, use the product ID (the value you inser-
ted for the id property). For file type, use .xml.

 15. Delete the document's file extension. For example, if the document is named Par-
isTrip01.xml,  rename the file as ParisTrip01.
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Warning: If you do not remove the file extension, your product 
data cannot be loaded.

 16. Save the document in your webspace or on your server in the directory that you 
communicated for the setup of the product paragraph with content interface.

Warning: Do not change the location of the product description 
documents without consulting customer support. If you change 
directories without consulting customer support, you cannot  
load product data using the content interface.

When you have saved your text document in your webspace or on your server, you 
can access your product offer in the Template Kit. Follow the individual steps in the 
Static XML article section to upload your product offer into the Template Kit using the 
content interface.

Generating dynamic product data on the server

The preparation of dynamic product data generally follows the same scheme as static 
product data, but the XML files are not prepared manually. Instead, they are loaded 
from a database when called (by HTTP request) via the content interface and auto-
matically generated as XML. Your company needs to program this process. To generate 
dynamic product data, consult your system administrator. 

Note: When performing the configuration:

 1. The XML feed must be UTF-8 encoded.
 2. The product ID must be positioned at the end of the URL. 

Correct:  http://request.example.com/product?id=123456789

Incorrect: http://request.example.com/product/123456789/data

Loading and editing static XML product data

When your product data is available as XML files in your webspace or on your server, you 
can load the data into the Template Kit, then edit it. See general settings to change con-
tent interface paragraph settings. If you want to integrate dynamic product data into 
the Template Kit,  see Dynamic CSV and XML articles.
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Loading product data 

 1. In the Template Kit, click New: Content paragraph. 

 2. Click Content interface. The configuration window for the selected paragraph type 
opens.
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 3. Do not change settings in the configuration window. Click Apply. The new para-
graph appears on the left, in the preview window.

Tip: Product offers are created as content interface articles, 
which are subparagraphs of content interface paragraphs.
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 4. Create a new content interface article by clicking Content interface article on the 
left of the preview window. The configuration window  opens.

 5. Change no settings in the configuration window. Click Apply. On the left side of the 
preview window, the menu bar for the content interface article expands to include 

the button Content interface  .
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 6. Click Content interface  . The Load content window opens on the right. 

 7. In the Content element box, enter the ID of the product offer that you want to load 
into the Template Kit. 
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 8. On the bottom right of the window, click Apply. Your product data is loaded via the 
content interface from your webspace or your server into the Template Kit. When 
the import is complete, the product offer appears on the left of the preview win-
dow. 

Editing XML product data in content interface article 

If your product offer is loaded into your message, you can later edit it  directly in the Tem-
plate Kit. To do this, perform the following steps: 

 1. On the left side of the preview window, in the menu bar for the corresponding con-
tent interface article, click Static XML article. On the right, a window for selecting the 
paragraph type opens.

 2. Make changes and confirm them by clicking Apply.

Warning: Do not change the layout template if you lack advanced 
HTML and CSS skills. Doing so can lead to errors, which means that 
your product offers will not display properly. If you want to modify 
the layout template but lack HTML and CSS skills, contact customer 
support.

If you update the content of product offers in the XML file, you can re-upload the mod-
ified file to the server. This ensures that your product offers are up-to-date and that no 
old, subsequently-modified content in the XML file is loaded into the Template Kit. 



© Episerver 2020

Managing content | 391

To update an content interface article, open the article's menu bar, click Content Inter-

face  , enter the corresponding product ID, and click Apply.

Warning: Customer support can configure the content interface 
paragraph so that product offers are updated at dispatch by com-
paring it with your CSV file. If this option is configured, changes to 
product offers must be made in the CSV file. If you only make 
changes in the Template Kit, they are overwritten at dispatch with 
old content from the CSV file.

Dynamic CSV and XML articles

You can send personalized product recommendations with dynamic CSV and XML art-
icles. Product data is loaded from the CSV or XML source for each individual recipient 
while sending.

Note: URLs that reference image files are dynamically inserted into 
the mailing during dispatch. Ensure that your server can handle a 
large number of requests when the mailing is sent.

Prerequisites

 l Dynamic CSV articles and/or XML items are enabled in your client.
 l For CSV product data source, see Exporting product data with a CSV file. For  XML 

source, see Using XML.

Creating a mapping reference

When sending the message, Episerver Campaign uses the product ID from the mapping 
reference to load product data from the data source. This loads different products into 
the message for each recipient.

To send a different product to each recipient, create a mapping reference that lists 
product recommendations for each recipient using the product ID. There are two ways 
to create a mapping reference:

 l Recipient list. Import the product IDs to be mapped into a recipient list field in your 
recipient list.
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 l Mapping file. Create a CSV file that contains the recipient ID of each mailing recip-
ient on a separate line. Add to each recipient ID an additional column  that spe-
cifies the product ID to be mapped.

Structure of the mapping file

A B

recipient1@example.com ProductID001

recipient2@example.com ProductID002

recipient3@example.com ProductID003

and so on and so on

Warning: If you enter several product IDs, leave no space after the 
separator.
Wrong: 001, 002, 003
Correct: 001,002,003

Using a recipient list as a mapping reference
 1. To set up the recipient list field for mapping product IDs, contact customer support. 

Up to 256 characters may be transferred to the recipient list field. If you want more, 
tell customer support.

Several methods (including CSV file import and SOAP API) are available for import-
ing recipient-specific product IDs to recipient lists.

 2. Transfer product IDs to the recipient list.

Using a mapping file as a mapping reference
 1. Create a CSV file whose first column contains recipient IDs. Each ID must be on a 

new line.
 2. In the second column, enter the product IDs for each recipient.
 3. Transfer the mapping file to the server, in the mapping file location specified   when 

you set up dynamic articles.
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Tip: Alternatively, use the Upload file feature, located in the 
start menu under Special. (To enable this feature, contact cus-
tomer support.)

Creating dynamic CSV and XML articles

 1. To create a dynamic CSV or XML article, in the Template Kit, create a new content 
paragraph by clicking New: Content paragraph. 
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 2. Select the content interface paragraph type  by clicking Content interface. 

 3. Click Apply. A new content paragraph of type content interface is created. On the 
left of the preview is the Content interface article button.

 4. Click Content interface article. A new content interface article is created. The con-
figuration window for the article opens.



© Episerver 2020

Managing content | 395

Configuring dynamic CSV and XML articles

After you create a dynamic CSV or XML article, configure it by following these steps:

Recipient list as the mapping reference

 1. On the right of the content interface article configuration window, open the Recip-
ient list tab.

 2. In the Recipient list field box, enter the name of the recipient list field that contains 
the product ID. Enclose the name with curly brackets: {Name}.

 3. If multiple product IDs are contained in the recipient list field, enter the separator 
used between product IDs.

Note: If you enter nothing, a comma is assumed.

 4. If the recipient list field contains multiple product IDs, enter the position number of 
the product to be loaded.

For example, your recipient list field contains three comma-separated product IDs: 
"001,002,003." To select the product with the ID "003", enter position number "3," 
because the product ID "003" is in the third position. If you do not enter a position 
number, the product in the first position is selected automatically.

 5. Click Apply. To the left of the preview, you see configuration data on the content 
interface article. When the message is sent, product data is loaded from the data 
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source using this configuration.

Mapping file as a mapping reference  

 1. On the right of the content interface article configuration window, open the Map-
ping file tab. 

 2. In the File name box, enter the name of the mapping file.
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 3. In the Recipient list field that contains the recipient ID (internal name) box, enter the 
internal name of the recipient list field. If you do not know the internal name, con-
tact customer support.

 4. If the mapping file in the product ID column contains multiple product IDs, enter the 
position number of the product to be loaded.

For example, Your recipient list field contains three comma-separated product IDs: 
"001,002,003." To select the product with the ID "003", enter position number "3," 
because the product ID "003" is in the third position. If you do not enter a position 
number, the product in the first position is selected automatically.

 5. Click Apply. To the left of the preview is the configuration data on the content inter-
face article. When the message is sent, product data is loaded from the product 
data source using this configuration.

General settings

You create individual product offers as content interface articles, which are sub-
paragraphs of the content interface paragraphs. Within a single message, you can cre-
ate multiple content interface paragraphs, using multiple lower-level content interface 
articles. To apply changes to a higher-level content interface paragraph, perform the 
following steps:
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 1. In the left side of the preview, click Content Interface in the menu bar of the content 
interface paragraph. On the right side, the configuration window for general set-
tings for the content interface paragraphs open.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

General

Parameter Description

Content

Heading Enter a heading for the paragraph.

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in Select to show the paragraph in the text version of the mailing.
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Parameter Description

text ver-
sion

Link

Text Enter text to describe the link.

URL Enter a link (such as a landing page for the product group).

Alignment You can position the link on the right, the left or center.

Button

See Click2Go.

SWYN

You can activate sharing via social networks (SWYN) for each content paragraph. To 
allow sharing of these paragraphs in a social network, select the Show check box for the 
network in which you want them to appear.

Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
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Parameter Description

paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed. 

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard text is displayed. 

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard image is displayed. Larger images 
are scaled down to this size.

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

Twitter

Show Lets recipients share the paragraph via their Twitter account.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed. 

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

MySpace

Parameters for MySpace are identical to Facebook's.

Xing

Parameters for Xing are identical to Twitter's.
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Options

You can give each content paragraph a different appearance from the general lay-
out. To do so, use the layout configuration in this tab.

Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smaller 
than this value, then the entered value is ignored.

Height

The paragraph is displayed over the entire height as standard, taking into account 
the content. Alternatively, you can specify a fixed height value here. If the content 
exceeds this height, the value is ignored and the content displayed at the cor-
responding height.

Background 
color

The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Spacing 
between 
the articles

A space with this height is placed between articles. By default, the first number in the 
Padding option is used. This option is enabled only when using the standard layout.

Layout Set the general settings for the article layouts in the general settings.If there is no con-
tent available for the selected layout, the default layout is used.

Border
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Parameter Description

Show Select if you want to apply a border around the paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile

Width

Set the width (in percent; 100% default) of the paragraph in the mobile view. If you 
want two paragraphs to be displayed next to one another in the mobile view, set 
their widths so they combine to 100%. Otherwise, the two paragraphs are displayed 
on top of one another with the allocated widths.

Table of contents

Show in 
table of con-
tents

Select to display the paragraph in the table of contents for the section.

Alternative 
table of con-
tents entry

Enter a heading to be displayed for this section in the table of contents. If you enter 
nothing, the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles. See 
Click profiles.
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Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic) .See Target groups.

HTML layouts

The content interface paragraph has a standard layout for formatting offer texts and 
images. To receive up to 5 custom layouts, contact customer support. 

If you have advanced HTML and CSS skills, you can set up alternate HTML layouts your-
self. If no alternate layouts are saved for the mobile and text versions, the standard lay-
out is used.

Note: In some cases, some text elements will not be in the desired 
order.

Sample standard layout
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Sample alternate layout 

Selecting a layout

 1. To select a standard or alternate layout, while editing a message in the Template Kit, 
look at the left side of the preview. On the content interface paragraph to which 
your product offer belongs, click Content interface. The configuration window opens 
on the right.
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 2. Open the Options tab. 

 3. In the Layout area, in the Layout drop-down list, select the layout you want to use. 

 4. Click Apply. On the left side of the preview, the formatting of your product offer 
changes accordingly.
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Editing a layout

You can edit alternate layouts at any time. You cannot change the standard layout.

Warning: Editing alternate layouts without advanced HTML and CSS 
skills can lead to severe errors in your messages.

 1. On the left side of the preview, click Settings. The configuration window opens.

 2. Open the Content interface tab. Each layout has source text fields for the desktop, 
mobile, and text version.
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 3. Edit the layout source code as desired.
 4. Click Apply.

 Troubleshooting CSV and XML

CSV troubleshooting

Issue Possible cause Solution

Product data does not load 
or loads incorrectly

Semicolons were not used as 
separators.

Change the separating char-
acters in your CSV file to semi-
colons.

Product data does not load 
or loads incorrectly

Quotation marks in texts were 
not masked with an escape 
character and were erro-
neously interpreted as code.

Mask quotation marks in texts 
with the escape character " (with 
an additional quotation mark for 
each quotation mark).

Product data was loaded 
incorrectly

The CSV file is not encoded as 
UTF-8 without BOM.

Encode the CSV file as UTF-8 
without BOM or UTF-8.
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Issue Possible cause Solution

Product data was loaded 
incorrectly

One or more HTML layouts con-
tain incorrect source text.

Correct the source text. If you do 
not have advanced HTML and 
CSS skills, contact customer sup-
port.

Product data is not loading The CSV import is not (yet) per-
formed.

Contact customer support so that 
they can review the CSV import.

Product data is not loading The CSV file is saved in the 
wrong directory on the server.

Transfer the CSV file to the dir-
ectory you indicated when set-
ting up the content interface.

Product data is not loading 
and a server error message 
appears.

The CSV file path is incorrect. Contact customer support.

The content interface para-
graph type is not available. The feature was not activated. Contact customer support.

Components of a product 
offer are not being shown. 
For example, a product 
image is not displayed.

The source text of the HTML lay-
out contains invalid code. For 
example, a tag is not closed.

Contact customer support. If you 
have advanced HTML and CSS 
skills, correct the source text.

Links are not being tracked You entered the link into a 
standard text field.

Enter the link in a link field. Links 
placed into a standard text field 
cannot be tracked.

XML troubleshooting

Issue
Possible 

cause
Solution

Product 
data is not 
loading

The 
product ID 
is entered 
incorrectly.

Enter the correct product ID.

Product 
data is not 
loading

The saved 
XML file has 
a file exten-

Remove the file extension.
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Issue
Possible 

cause
Solution

sion.

Product 
data is not 
loading

The cor-
responding 
product 
offer no 
longer 
exists on 
your web-
space or 
server.

Save the product offer again on your webspace or server.

Product 
data is not 
loading

The 
product 
data is 
saved in 
the wrong 
directory 
on the 
server or 
webspace.

Transfer the product data you are trying to load into the directory that 
you indicated when setting up the content interface.

Product 
data is not 
loading

The 
product ID 
is not posi-
tioned at 
the end of 
the URL.   

Change your system configuration so that the product ID is positioned 
at the end of the URL.                         

Correct: https://www.example.com/products/?id=123456789

Incorrect: https://www.ex-
ample.com/products/?id=123456789?param1=XY?param2=abc

Some con-
tent is not 
loading. 
For 
example, 
the 
product 
image is 
missing.

Error in the 
XML code 
you gen-
erated.

Correct the XML code.

The con-
tent inter-

The feature 
has not Contact customer support.
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Issue
Possible 

cause
Solution

face para-
graph 
type is not 
available.

been activ-
ated for 
you.

Com-
ponents 
of a 
product 
offer are 
not being 
shown. 
For 
example, 
a product 
image is 
not dis-
played.

The source 
text of the 
HTML layout 
contains 
invalid 
code. For 
example, a 
tag is not 
closed.

Correct the source text. If you do not have advanced HTML and CSS 
skills, contact customer support.

Links are 
not being 
tracked

You 
entered 
the link into 
a standard 
text field.

Enter the link in a link field. Links placed into a standard text field cannot 
be tracked.

Source code paragraph

You can enter HTML code in the source code paragraph. Email programs do not show 
HTML to the full extent, so code entered here may lead to a faulty layout in your mailing.

The source code paragraph can be used by the Content interface paragraph, which you 
can use to automatically fill in the content fields.

Creating a source code paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph.A window for selecting the paragraph type opens on the right side.
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Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 

 2. Click Source code. The configuration window for that paragraph type opens.
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 3. Click Apply. The newly created source code paragraph will appear on the left side 
in the preview window.

Configuring a source code paragraph

 1. On the left side of the preview, in the menu bar of the source code paragraph, click 
Source code.The configuration window opens on the right-hand side.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l HTML
 l Mobile
 l Text
 l Options
 l Click profiles
 l Target groups
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HTML

Parameter Description

Source code Enter HTML source code. Do not enter the HTML declaration, meta, or body tags.

Mobile

Parameter Description

Source 
code

Enter an alternative source code for the mobile version of the mailing. For this option to 
take effect, you must activate the setting Activate mobile version in the general 
settings.If the mobile version is activated and you enter nothing here, the HTML tab's 
source code is used for the mobile version.

Text

Parameter Description

Text
Enter the text for the text version of this paragraph. Do not use HTML or other format-
ting. However, you can insert line breaks and special characters for separator ele-
ments (for example ***** or ++++++).
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Options

You can define an individual layout, different from the general newsletter layout, for 
each content paragraph.

Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smaller 
than this value, then the entered value is ignored.

Height
By default, the paragraph is displayed over the available height, considering the con-
tent. Alternatively, you can specify a fixed height. If the content exceeds this height, 
the value is ignored, and the content is displayed at the default height.

Background 
color

To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Border

Show Check to apply a border around the paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:
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Parameter Description

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on 
top of each another with the assigned widths.

Table of contents

Show in 
Table of 
Contents

Select to display the paragraph in the table of contents for the section.

Heading Enter a heading to be displayed in the table of contents. If you leave the field blank, 
the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
file

Clicks on any link in this paragraph are allocated to the selected click profiles. See Click 
profiles.
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Target groups

Parameter Description

Target 
group

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic)see Target groups.

Loading content via the content interface

If the content interface is activated for the source code paragraph in your client, you 
can provide the content of the HTML, mobile, and text version in a CSV file and import 
them into the source code paragraph. The CSV format cannot be changed.

Format the CSV file as follows:

 id;name;html;mobile;text 1;Source code 1;
    <div class="html-version" style="background-color: #ff0000;">HTML version</div>;
 "   <div class="mobile-version" style="background-color: #ff0000;">Mobile version</div>";
    Text version 

To integrate the content in the source code paragraph, click the menu bar of the para-

graph Open    and select the desired content in the right column.

Hints

 l The id and name columns are only used internally. Enter a name to help you identify 
the paragraph in the editor.

 l The html, mobile and text columns can contain HTML source code that is added 
unchanged to the source code paragraph.

 l Values must be CSV-compliant.
 l To format the content, you must have strong HTML knowledge, particularly of email. 

The use of invalid or non-supported HTML code may lead to major display errors in 
the mailing.

Text or image paragraph

Use the text/image paragraph to add a text block or image to your mailing. You can 
also position the elements relative to one another.
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Creating a text/image paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 
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 2. Click Text/image. The configuration window for the selected paragraph type opens.

 3. Click Apply. The newly created text/image paragraph appears on the left of the pre-
view window.
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Configuring a text/image paragraph

 1. On the left side of the preview, in the menu bar of the text/image paragraph, click 
Text/image. The configuration window opens on the right side.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Image
 l Button
 l SWYN
 l Options
 l Click profiles
 l Target groups

General

Parameter Description

Content

Heading Enter a heading for the paragraph.
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Parameter Description

Text
Enter text using the Rich Text Editor. You can use additional formatting, for example 
insert breaks, create lists and tables and use other text decorations and colors. For 
formatting purposes, use the Rich Text Editor toolbar.

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in 
Text Ver-
sion

Select to show the paragraph in the text version of the mailing. You might do this, for 
example, with an image bar paragraph, because images are not displayed in the text 
version. Alternative text is displayed there instead.

Link

Text This text is linked to the URL entered below.

URL Enter a target URL here, for example a landing page.

Alignment Alignment can be right, left or centered.

Image

Parameter Description

Image Upload an image from your computer or enter an image URL in the Alternative external 
URL field that points to the image file.

Alternative 
text

This text is displayed if a recipient blocks or disables the display of images in his/her 
email client, or if the image cannot be displayed for another reason. Enter a short 
image description or title.

Link You can link the image to a landing page or a page from your website. If you entered 
a text link in this paragraph, you should use the same link for the image.

Subtitle Enter an optional image subtitle here.
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Parameter Description

Position

You can place the image in a separate column next to heading and text block, or in a 
separate column next to the text block and below the heading. These positions are 
recommended in most cases.

If you use large images that cover the entire width of a paragraph or area, place 
them centered below the heading, text, or the link. If you select the Below the 
heading right aligned or Below the heading left aligned options, the text floats 
around the image.

Button

See Click2Go.

SWYN

You can enable the SWYN function for social networks individually for each paragraph. 
To allow sharing of these paragraphs in a social network, select the Show check box for 
the network in which you want them to appear.

Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image
Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.
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Parameter Description

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed. 

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard text is displayed. 

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard image is displayed. Larger images 
are scaled down to this size.

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

Twitter

Show Lets recipients share the paragraph via their Twitter account.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed. 

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

MySpace

Parameters for MySpace are identical to Facebook's.

Xing

Parameters for Xing are identical to Twitter's.

Options

You can define an individual layout, different from the general newsletter layout, for 
each content paragraph.
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Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smaller 
than this value, then the entered value is ignored.

Height
By default, the paragraph is displayed over the available height, considering the con-
tent. Alternatively, you can specify a fixed height. If the content exceeds this height, 
the value is ignored, and the content is displayed at the default height.

Background 
color

To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Border

Show Select if you want to apply a border around the entire paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
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Parameter Description

sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on 
top of each another with the assigned widths.

Table of contents

Show in 
table of con-
tents

Select to display the paragraph in the table of contents for the section.

Alternative 
table of con-
tents entry

Enter a heading to be displayed for this section in the table of contents. If you enter 
nothing, the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles. See 
Click profiles.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.
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Table of contents paragraph

Use the table of contents paragraph to create a table of contents for your mailing. You 
can control the display of items in the table of contents by including only certain areas.

 l List paragraphs instead of the header and footer
 l List paragraphs including the header, except for the footer
 l List paragraphs including the footer, except for the header
 l List paragraphs including the header and footer
 l Only list the paragraphs of a grouping paragraph

Tip: To exclude content paragraphs from the table of contents, 
edit the corresponding content paragraph. In the content para-
graph's configuration window, edit the Options tab > Table of con-
tents setting and enter the desired value.

Creating a table of contents paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 
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 2. Click Table of contents. The configuration window for the selected paragraph type 
opens.
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 3. Click Apply. The new table of contents paragraph appears on the left.

Configuring a table of contents paragraph

 1. On the left side of the preview, in the menu bar of the table of contents paragraph, 
click Table of contents. The configuration window opens on the right.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Options
 l Target groups



© Episerver 2020

428 | Episerver Campaign User Guide 2020-04-23

General

Parameter Description

Content

Heading Enter a title for the table of contents.

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in 
text ver-
sion

Select to show the paragraph in the text version of the mailing.
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Options

You can define an individual layout, different from the general newsletter layout, for 
each content paragraph.

Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smaller 
than this value, then the entered value is ignored.

Height
By default, the paragraph is displayed over the available height, considering the con-
tent. Alternatively, you can specify a fixed height. If the content exceeds this height, 
the value is ignored, and the content is displayed at the default height.

Area Select the paragraph areas to be included in the table of contents.

Background 
color

To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Border

Show Select if you want to apply a border around the entire paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 
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Parameter Description

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on 
top of each another with the assigned widths.

Lists

List type You can layout the table of contents in a default CSS style. Use a custom label or no 
label.

Custom list 
item label

If you want to use a custom list item label, upload a graphic. The maximum width is 30 
pixels.Larger images are scaled down to this size.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.
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Image bar paragraph

Create a horizontal or vertical image bar that contains up to ten images. Uploaded 
images are automatically scaled and adapted to the available width.

Creating an image bar paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 
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 2. Click Image bar. The configuration window for the selected paragraph type opens.

 3. Click Apply. The new image bar paragraph appears on the left side in the preview 
window.



© Episerver 2020

Managing content | 433

Configuring an image bar paragraph

 1. On the left side of the preview, in the menu bar of the image bar paragraph, click 
Image bar. The configuration window opens on the right-hand side.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Button
 l SWYN
 l Options
 l Click profiles
 l Target groups

General

Parameter Description

Content

Heading Enter a heading for the paragraph.

Show in Select  to include this paragraph in the desktop mailing.
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Parameter Description

desktop 
version

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in 
text ver-
sion

Select to show the paragraph in the text version of the mailing.

Image 1-10

Image Upload an image from your computer or enter an image URL in the field Alternatively 
external URL that points to the image file.

Alternative 
Text

This text is displayed, if a recipient has blocked or disabled the display of images in the 
email client, or if the image cannot be displayed for any other reason. Enter an altern-
ative text that may contain a short image description or title.

Link
You can link the image to a landing page or a page from your website. If you have 
entered a text link in this paragraph, we recommend that you use the same link for the 
image.

Button

See Click2Go.

SWYN

You can enable the SWYN function for social networks for each paragraph. To allow 
sharing of these paragraphs in a social network, select the Show check box for the net-
work in which you want them to appear.

Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.
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Parameter Description

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image
Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed.

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard text is displayed.

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard image is displayed. Larger images 
are scaled down to this size.

Twitter

Show Lets recipients share the paragraph via their Twitter account.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed.

MySpace

Parameters for MySpace are identical to Facebook's.
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Parameter Description

Xing

Parameters for Xing are identical to Twitter's.

Options

On the Options tab, define an individual layout, different from the general newsletter 
layout, for each content paragraph.

Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smal-
ler than this value, then the entered value is ignored.

Height
By default, the paragraph is displayed over the available height, considering the 
content. Alternatively, you can specify a fixed height. If the content exceeds this 
height, the value is ignored, and the content is displayed at the default height.

Separation 
space Enter an integer value (pixels) to create a space between the images.

Arrangement By default, a horizontal image bar is created. Alternatively, you can laid out the 
image bar vertically.

Alignment Select how the image bar is to be positioned. If you have a horizontal image bar 
that uses the entire available width, changing this value does not affect the display.

Background 
color

To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:
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Parameter Description

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Border

Show Select if you want to apply a border around the entire paragraph.

Border width

Enter the thickness of the border. You can set thickness for each side indi-
vidually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as #000000). 
The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed 
on top of each another with the assigned widths.

Separation 
space Enter an integer value (pixels) to create a space between the images.

Table of contents

Show in table Select to display the paragraph for the section in the table of contents .
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Parameter Description

of contents

Alternative 
table of con-
tents entry

Enter a heading to be displayed for this section in the table of contents. If you enter 
nothing, the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles. See 
Click profiles.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.

Separator paragraph

You can use the separator paragraph either at the main level for visually separating mul-
tiple grouping paragraphs or the second level for separating content paragraphs.

Creating a separator paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 
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 2. Click Separator. The configuration window for the selected paragraph type opens.
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 3. Click Apply. The new separator paragraph appears on the left.

Configuring a separator paragraph

 1. On the left side of the preview, in the menu bar of the separator paragraph, click 
Separator.The configuration window opens on the right.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Target groups
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General

Parameter Description

Layout

Show sep-
arator line Define the layout of the horizontal line in the general settings.

Show top 
link Define the layout of the top link in the general settings.

Show 
image Upload a custom top link icon in the general settings.

Show spa-
cing

Define the spacing above and below the horizontal line, and above and below the 
top link in the general settings.

Content

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.
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Parameter Description

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Target groups

You can assign separator paragraphs to a target group.Test the newsletter layout for tar-
get groups using the action button Target group at the upper right of the window.

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.

RSS feed paragraph

Note: To enable this feature, contact customer support.

You can use an RSS feed to publish information in a standardized format, effectively 
providing a type of interface for third-party providers. The Template Kit can access this 
interface and incorporate its content into a newsletter. You can edit texts or reposition 
content after it is retrieved.

The Template Kit may contain several RSS feed paragraphs, each of which accesses a 
different feed.

You can insert RSS feed paragraphs into header and footer spaces and in structural 
paragraphs. Also, a supplementary tab is activated in the Template Kit's general 
settings, where you can set content order in standard layout. You can define alternative 
layouts by entering HTML/text via the Options tab.

Formatting the RSS feed

For the RSS feed to be processed correctly, it must meet the RSS 2.0 specification. The 
required information for the channel node is not processed by the Template Kit, but it 
must still be available. Only the subnodes of the item node are used.

Sample Rss feed

http://validator.w3.org/feed/docs/rss2.html
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<?xml version="1.0"?>   
 <rss version="2.0">   
   <channel>   
     <title>RSS Feed</title>   
     <link>http://www.example.com/</link>   
     <description>Text</description>   
       <item>   
         <title>Title 1</title>    
         <description>Text</description>   
         <enclosure url="http://www.example.com/image2.png" length="12345" type="image/png" />   
         <link>http://www.example.com/title1</link>   
         <comments>http://www.example.com/title1/comments</comments>   
         <category>News</category>   
         <author>author@example.com</author>   
         <pubDate>Sun, 19 May 2002 15:21:36 GMT</pubDate>   
       </item>   
       <item>   
         <title>Title 2</title>   
         <description>Text</description>   
         <enclosure url="http://www.example.com/image2.png" length="23456" type="image/png" />   
         <link>http://www.example.com/title2</link>   
         <comments>http://www.example.com/title2/comments</comments>   
         <category>News</category>   
         <author>author@example.com</author>   
         <pubDate>Sun, 19 May 2002 15:21:36 GMT</pubDate>   
       </item>   
     </channel>   
 </rss> 

Creating an RSS feed paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 
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 2. Click RSS feed. The configuration window for the selected paragraph type opens.

 3. Change no settings in the configuration window. Click Apply.The new RSS feed para-
graph appears on the left in the preview window.
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Configuring the RSS feed paragraph

 1. On the left side of the preview, in the menu bar of the RSS feed paragraph, click RSS 
feed.

 2. See the following tables to set options. Click Apply to confirm your settings.

 l General
 l RSS feed
 l Button
 l SWYN
 l Default values
 l Options
 l Click profile
 l Target groups
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General

Parameter Description

Content

Heading Enter a heading for the paragraph.

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in 
text ver-
sion

Select to show the paragraph in the text version of the mailing.

Link

Text This text is subsequently linked in the mailing.
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Parameter Description

URL Enter the RSS feed landing page (for example) or another URL.

Alignment Position the link to the right, left, or center.

RSS feed

Parameter Description

URL Enter the URL of the RSS feed from which the content is loaded.

Maximum 
number of 
entries

The maximum value is 20 entries.

If you do not specify a value, 10 entries (if available) are retrieved from the RSS 
feed and inserted into the newsletter. If more entries are available in the RSS feed, 
they are ignored.

If you enter 0, the default value of 10 entries is retrieved.

This option is only applicable for the retrieval of RSS feeds. Changing this number 
does not affect the posts that have been loaded. Note that the Category filter 
option is only applied after the entries are retrieved, so that fewer entries may be 
displayed.

Date 
format

This option is only applicable for the retrieval of RSS feeds. Changing the date format 
does not affect the posts that have already been loaded.

Category 
filter

Entries in the RSS feed are displayed by default. If your RSS feed is divided into different 
categories, you can filter them by a specific term, which is supplied in the Categories 
field of the RSS feed.

Button

See Click2Go.

SWYN

You can enable the SWYN function for social networks individually for each paragraph. 
To allow sharing of these paragraphs in a social network, select the Show check box for 
the network in which you want them to appear.
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Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image
Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed. 

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard text is displayed. 

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard image is displayed. Larger images 
are scaled down to this size.

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

Twitter

Show Lets recipients share the paragraph via their Twitter account.
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Parameter Description

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed. 

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

MySpace

Parameters for MySpace are identical to Facebook's.

Xing

Parameters for Xing are identical to Twitter's.

Default values

These values are inherited from the RSS feed items integrated with this paragraph. When 
the RSS feed is retrieved, existing paragraphs are removed, and available entries are 
created as new paragraphs. These values can be overwritten if items are manually 
edited later.

Parameter Description

Link

Text This text is subsequently linked in the mailing.

Alignment You can position the link to the right, left, or center.

Link to comments

Text This text is subsequently linked in the mailing.

Alignment You can position the link to the right, left, or center.

Image

Position
The image can be positioned in a separate column next to the heading where it fol-
lows the text, or in a separate column under the heading but next to the text. These 
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Parameter Description

positions are recommended in most cases. If you are using large images that take up 
the entire available width, you can position them centered under the heading, under 
the text, or below the link.

Options

Parameter Description

Layout

Width

The maximum available width is used as standard. This is 
based on the internal spacing and also depends on 
whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum 
available width is smaller than this value, then the entered 
value is ignored.

Height

By default, the paragraph is displayed over the available 
height, considering the content. Alternatively, you can spe-
cify a fixed height. If the content exceeds this height, the 
value is ignored, and the content is displayed at the default 
height.

Background 
color

To define the color, enter a hexadecimal value preceded 
by # (such as #000000). The depiction of non-hex web col-
ors may vary from the original, depending on the browser. 

Padding

Specify white space around the paragraph content. You 
can set white space separately for each page. 

Enter the values in pixels (integer values) based on the fol-
lowing example, using spaces to separate multiple pixel 
entries:

 l 10 = sides are uniform with 10 pixels of white space 
for the content

 l 10 20 = 10 pixels on the top and bottom, 20 pixels on 
the left and right

 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the 
right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
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Parameter Description

Space between 
the items

To create height between the items, enter an integer value 
(pixels). By default, the first number in the Padding option is 
used.

This option is only enabled when using the standard lay-
out.

Layout
In the RSS feeds Tab in the general settings, specify the lay-
outs for the RSS feed items. If there is no content available 
for the selected layout, the default layout is used.

Border

Show Check to apply a border around the paragraph.

Border width

Enter the thickness of the border. You can set thickness 
for each side individually. 

Enter values in pixels (integer values) based on the fol-
lowing example, using spaces to separate multiple pixel 
entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the 

left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel 

on the bottom, 4 pixel on the left.

If you leave the field blank, the border has a thickness of 
1 pixel (uniform on all sides).

Color
To define the color, enter a hexadecimal value preceded 
by # (such as #000000). The depiction of non-hex web col-
ors may vary from the original, depending on the browser. 

Mobile  

Width

Set the paragraph width (in percent; 100% default) for 
mobile view. To display paragraphs next to each another in 
mobile view, make sure that the widths of two consecutive 
paragraphs combine to 100%. Otherwise, the paragraphs 
are displayed on top of each another with the assigned 
widths.



© Episerver 2020

452 | Episerver Campaign User Guide 2020-04-23

Parameter Description

Table of contents  

Show in Table of 
Contents

Select to display the paragraph in the table of contents for 
the section.

Area
Select whether the table of contents should display the 
heading of the RSS feed paragraph or the titles of individual 
articles in the RSS feed.

Alternative table 
of contents entry

Optional: If you select the option Show the heading of the 
RSS feed paragraph in the table of contents under Area, you 
can change the heading of the RSS feed paragraph dis-
played in the table of contents.

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles. See 
Click profiles.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them more than one 
target group is selected, just one must match (OR logic). See Target groups.
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Retrieving an RSS feed

 1. In the menu bar of the RSS feed paragraph, click the RSS symbol .

An information window opens. You are asked to confirm the retrieval of the RSS 
feed.

Note: If you previously retrieved the RSS feed, the previously 
loaded and possibly edited content is overwritten with the cur-
rent RSS feed content.

 2. Click Next. The loaded RSS feed items are displayed to the left in the preview.

Editing an RSS feed

 1. In the menu bar of the corresponding RSS feed item, click RSS feed. On the right side, 
a window for editing the content of the RSS feed item opens.

 2. Edit to the RSS items as desired.
 3. Click Apply. The updated content is displayed to the left .

Note: If you click RSS  in the menu bar of the RSS feed para-
graph, the RSS feed is retrieved again, and any edited feed articles 
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are overwritten with the current feed content. So, if you modify RSS 

feed articles, only click RSS  if you want to reset the changes.

Recommendations paragraph

Recommendation generators let you send individualized recommendations in real time 
mailings, any time a recipient accesses a mailing. Recommendations are based on 
recipient history and algorithms and retrieved via a URL. Depending on the provider, 
one or more URLs are made available to each recipient, which they can use to access 
a variety of elements:

 l Product pictures
 l Name of a product and other text (shown as graphics)
 l Link to a product landing page

The recommendation paragraph contains input fields for these URLs for multiple recom-
mendations, providing you with additional layout options. You can place a recom-
mendation paragraph within the header and footer area and inside grouping 
paragraphs. The Template Kit can contain multiple recommendation paragraphs. 
However, the recommendation provider can only provide a limited number of recom-
mendations for a recipient.

Note: Fallback for new recipients and incomplete URLs
Store a fallback for your provider so new recipients with no history 
are shown a recommendation and so URLs with missing or incorrect 
parameters can be compensated for. Otherwise, an empty image 
placeholder might appear in the mailing, because no graphic 
could be retrieved from the recommendation server.

Formatting recommendation URLs

URLs for recommendations include multiple parameters that identify a customer, recip-
ient, layout, type (text, image, or link), and number of recommendations (for more than 
one). A recommendation is only generated if parameters are generated correctly.

The following URL structure is an example. See the provider you have selected for 
details.
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http://host:port/rde_server/res/[NL-RDE-ID]/newsletter/recomm/[Name-of-newsletter-template]/usr/
[User-ID] ?requestType=textImage&recoIndex=[Index]&channel=NL

 l NL-RDE-ID. Your customer ID; you receive this from the recommendation provider.
 l Name-of-newsletter template. The template determines the recommendation stored 

for the recommendation provider.

Note: You cannot modify the first two parameters.

 l User ID. The recipient ID, used to generate individual recommendations.
 l Index. Process multiple recommendations for each recipient. Use this parameter to 

select the corresponding, consecutive paragraph number.

Creating a recommendations paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 

 2. Click Recommendations. The configuration window for the selected paragraph type 
opens.
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 3. Click Apply. The new recommendation paragraph appears on the left.    

Configuring a recommendation paragraph

 1. On the left side of the preview, in the menu bar of the recommendation paragraph, 
click Recommendations.The configuration window opens on the right.
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 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Button
 l Text
 l SWYN
 l Options
 l Click profiles
 l Target groups

General

Parameter Description

Contents

Heading Enter a paragraph caption.

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.

Show in Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
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Parameter Description

mobile ver-
sion version setting in the general settings must be activated for this option to take effect. 

Show in 
text ver-
sion

Select to show the paragraph in the text version of the mailing.

Recommendation 1-5

Image URL
Enter the URL used to generate the product image that appears in a mailing. The 
height and width of the graphic is set by the recommendation provider and cannot 
be adjusted to fit the template.

Text URL
Enter the URL used to generate the product name that appears in a mailing. The text is 
displayed as a graphics file. The height and width of the graphic is set by the recom-
mendation provider and cannot be adjusted to fit the template.

Link
Enter the URL used to generate a link to the product landing page that appears in a 
mailing. The layout of the links (color, text and so on) is set by the recommendation pro-
vider and cannot be adjusted to fit the template.

Button

See Click2Go.

Text

Recommendations are incorporated into mailings as graphics and are not displayed in 
the text version – except for the caption, if one is provided. Instead, you can enter a sub-
stitute text to use in the text version of the mailing. If you do not want the paragraph to 
appear in the text version, disable the Show in text version option in the General tab.

Parameter Description

Text Enter alternate text to use in the text version of a mailing. Recommendations will not 
appear in the text version, except for the caption.
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SWYN

You can enable the SWYN function for social networks individually for each paragraph. 
To allow sharing of these paragraphs in a social network, select the Show check box for 
the network in which you want them to appear.

Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image
Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed.

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard text is displayed.

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard image is displayed. Larger images 
are scaled down to this size.
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Parameter Description

Twitter

Show Lets recipients share the paragraph via their Twitter account.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed.

MySpace

Parameters for MySpace are identical to Facebook's.

Xing

Parameters for Xing are identical to Twitter's.

Options

Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal 
spacing and also depends on whether you are using a sidebar and, if so, on 
the width of the sidebar. Enter a different value in pixels. If the maximum avail-
able width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering 
the content. Alternatively, you can specify a fixed height. If the content 
exceeds this height, the value is ignored, and the content is displayed at the 
default height.

Recommendation 
layout

Images and text used in a recommendation can be placed next to or on top 
of each other. Bear in mind the available width when changing the layout.

Space between 
image and text

Specify (in pixels) how much space there should be between image and text 
in a recommendation.

Space between 
the recom-

Specify (in pixels) how much space there should be between multiple recom-
mendations. This value is irrelevant if you are only inserting one recom-
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Parameter Description

mendations mendation.

Arrangement

Indicate whether multiple recommendations should be placed next to each 
other in one paragraph (for example, in the main body of the text space) or on 
top of each other (for example, in the sidebar next to the main body of the 
text space). This value is irrelevant if you are only inserting one recom-
mendation.

Alignment
Specify how the recommendations should be arranged in a paragraph. This 
value is only applied if the width of recommendations is less than the width 
available in the main body of the text space.

Background color
The background color is given as a Hex code.To define the color, enter a hexa-
decimal value preceded by # (such as #000000).  The depiction of non-hex 
web colors may vary from the original, depending on the browser. 

Padding

Specify white space around the paragraph content. You can set white 
space separately for each page. 

Enter the values in pixels (integer values) based on the following example, 
using spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the 

bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Image

Width Enter the width of the product image. If you do not enter anything here, the 
image's original width is used.

Height Enter the height of the product image. If you do not enter anything here, the 
image's original height is used.

Product description

Width Enter the width of the product description. If you do not enter anything here, 
the text's original width is used.
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Parameter Description

Height Enter the height of the product description. If you do not enter anything here, 
the text's original height is used.

Border

Show Select if you want to apply a border around the entire paragraph.

Border width

Enter the thickness of the border. You can set thickness for each side indi-
vidually. 

Enter values in pixels (integer values) based on the following example, 
using spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 

pixel on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on 
all sides).

Color
To define the color, enter a hexadecimal value preceded by # (such as 
#000000). The depiction of non-hex web colors may vary from the original, 
depending on the browser. 

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display 
paragraphs next to each another in mobile view, make sure that the widths of 
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs 
are displayed on top of each another with the assigned widths.

Maximum width of 
the text image

The maximum width is entered as a percentage. It only takes effect if the text is 
positioned to the left or the right of the image.

The value must be between 10 and 90. By default, a maximum width of 50 % 
is used.

Table of contents

Show in table of 
contents Check to display the paragraph in the table of contents for the section.
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Parameter Description

Alternative table 
of contents entry

Enter a heading to be displayed for this section in the table of contents. If you 
enter nothing, the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
file

Clicks on any link in this paragraph are allocated to the selected click profiles. See Click 
profiles.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.

Facebook paragraph

Note: To enable this feature, contact customer support.

Use the Facebook paragraph to integrate up to 25 current Facebook posts into a mes-
sage. Keep recipients up-to-date with exciting topics from your social network.

Decide whether Episerver Campaign updates the Facebook paragraph every time you 
send a message and automatically loads the latest posts from your Facebook timeline, 
or whether Episerver Campaign only displays Facebook posts you defined when cre-
ating or modifying the campaign.

 l Dynamic integration. Displays your latest social media activities. However, you can-
not permanently delete or edit posts in the Facebook paragraph. If you remove or 
edit Facebook timeline posts from the Facebook paragraph, those posts are 
reloaded into the Facebook paragraph when the mailing is sent.

 l Static integration. Provides more control over posts that appear in the Facebook 
paragraph. When creating a message, you can manually update which posts to 
integrate. You can delete individual posts. When the mailing is sent, Episerver 
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Campaign does not update the Facebook paragraph from your Facebook timeline. 
Changes can be made but do not happen automatically.

Tip: By default, Episerver Campaign integrates Facebook posts stat-
ically. To use dynamic integration, contact customer support to 
change the default integration.

Creating a Facebook paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph. A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 
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 2. Click Facebook. The configuration window for the selected paragraph type opens.

 3. Click Apply. The new Facebook paragraph appears on the left side in the preview 
window.

Configuring a Facebook paragraph

 1. On the left side of the preview, in the menu bar of the Facebook paragraph, click 
Facebook. The configuration window opens on the right side.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Settings
 l Button
 l SWYN
 l Default values
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 l Options
 l Click profiles
 l Target groups

General

Parameter Description

Content

Heading Enter a heading for the paragraph.

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in 
text ver-
sion

Select to show the paragraph in the text version of the mailing.

Link

Text This text is subsequently linked to in the mailing.

URL Enter a link , such as the starting page or your public Facebook profile.

Orientation Position the link on the right, left, or center.
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Settings

Parameter Description

Account 
name

Enter your public Facebook user name, which is the name used in the web address 
for your Facebook timeline. It is the last part of the URL: https://facebook.com/User 
name.

Warning: If the display of your Facebook page is limited to 
specific countries, Facebook posts will not load if you or 
your recipients are located outside of the countries for 
which the display is allowed.

Maximum 
number of 
entries

Enter the maximum number (up to 25) of Facebook posts to be displayed in your mes-
sage.

Tip: If you enter 0 or leave this field blank, a default value 
of 10 Facebook posts are used. If fewer than 10 posts are 
available in your Facebook account, fewer posts are 
retrieved and displayed.

Also, if you are using static integration, changing this value 
has no effect on any posts already retrieved. You must 
manually update the Facebook paragraph for the new 
number of posts to take effect.

Date 
format

In the drop-down list, select a date format to be displayed next to your Facebook 
posts.

Tip: If using static integration, changing the date format 
has no effect on Facebook posts that have already been 
retrieved. You must manually update the Facebook para-
graph for a date format change to take effect.

Button

See Click2Go.
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SWYN

You can enable the SWYN function for social networks individually for each paragraph. 
To allow sharing of these paragraphs in a social network, select the Show check box for 
the network in which you want them to appear.

Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image
Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed. 

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard text is displayed. 

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard image is displayed. Larger images 
are scaled down to this size.

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
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Parameter Description

enable, the link redirects recipients to the URL specified in the General tab.

Twitter

Show Lets recipients share the paragraph via their Twitter account.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed. 

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

MySpace

Parameters for MySpace are identical to Facebook's.

Xing

Parameters for Xing are identical to Twitter's.

Default values

Parameter Description

Link

Text

Facebook posts in your messages are automatically linked to the original Facebook 
post.

To clarify this for your recipients and to highlight links, add additional text, such as 
More information on our Facebook page or Go to original post on Facebook.

Enter your text into the airfield you do not want to point out that the Facebook post 
in your mailing will lead to your Facebook page, leave the field blank.

Tip: Text entered here is added to Facebook posts and 
appears with each Facebook post in the message.



© Episerver 2020

470 | Episerver Campaign User Guide 2020-04-23

Parameter Description

Orientation The text can be aligned to the right, left or center.

Image

Position

From the drop-down list, select the position where images associated with your Face-
book post will display.

Tip: If your Facebook post contains several images, the first 
image from the post is assiduous cannot display sub-
sequent images.

Options

You can give each content paragraph a different appearance from the general lay-
out.

Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smaller 
than this value, then the entered value is ignored.

Height
By default, the paragraph is displayed over the available height, considering the con-
tent. Alternatively, you can specify a fixed height. If the content exceeds this height, 
the value is ignored, and the content is displayed at the default height.

Background 
color

The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
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Parameter Description

 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-
tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Space 
between art-
icles

A space with this height is placed between individual admissible default, the first num-
ber in the Padding option is osteopathic option is only enabled when using the stand-
ard layout.

Layout

Select a layout for your Facebook posts.

You can choose between the supplied standard layout and up to two user-
defined absolutist use a custom layout, set it up in advance in the general settings 
in the Facebook evadable you select a user-defined layout list that you have not 
configured, the standard layout is automatically asceticism Facebook Layouts.

Border

Show Select if you want to apply a border around the entire paragraph.

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on 
top of each another with the assigned widths.
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Parameter Description

Table of contents

Show in 
table of con-
tents

Select to display the paragraph in the table of contents for the section.

Alternative 
table of con-
tents entry

Enter a heading to be displayed for this section in the table of contents. If you enter 
nothing, the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click professionalize 
Click profiles.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them more than one 
target group is selected, just one must match (OR logic). See Target groups.
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Loading Facebook posts

 1. In the menu bar of the Facebook paragraph, click Load Facebook posts .

 2. Confirm that you want to load your Facebook posts by clicking Continue.

 3. 
Warning: If the display of your Facebook page is limited to spe-
cific countries and you are located outside of these countries, 
Facebook posts will not load successfully.

Updating Facebook posts manually

 1. To manually update your Facebook posts, in the menu bar of the Facebook para-

graph, click Load Facebook posts .

 2. Click Continue.
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Editing Facebook posts

You can edit your Facebook posts individually after loading them into your mailing.

 1. In the menu bar of the corresponding Facebook post, click Facebook entry.The con-
figuration window opens on the right.

 2. Change the settings according to your needs. Confirm by clicking Apply in the lower 
right corner.

Note: If you manually update posts in the Facebook paragraph, 
the posts are reloaded from your Facebook timeline, over-
writing any manual changes to the Facebook posts. If you are 
using dynamic integration, manual changes to Facebook posts 
are overwritten when the mailing is sent.

Deleting Facebook posts

 1. In the menu bar of the Facebook post you want to delete, click Delete  .
 2. Confirm your selection by clicking OK.

Note: If you manually update posts in a Facebook paragraph, pre-
viously deleted posts are reloaded unless they were also deleted 
from your Facebook timeline. If you are using dynamic integration, 
deleted Facebook posts are automatically reloaded into your mes-
sage when the mailing is sent.

Facebook layouts

This topic describes:

 l how customer support sets up alternative HTML layouts
 l how to select alternative layouts in the Facebook paragraph
 l how to edit alternative layouts using knowledge of HTML, CSS, and Velocity

To receive up to 2 alternative layouts, contact customer support.

To create HTML layouts, set up alternative layouts for mobile and text versions also. If no 
alternative layouts are saved for those versions, the standard layout is used.



© Episerver 2020

Managing content | 475

Note: In some cases, some text elements will not be in the order 
that you want.

Selecting a layout

 1. To select a standard layout or an alternative layout, while editing a message in the 
Template Kit, on the left side of the preview, in the menu bar of the Facebook para-
graph, click Facebook.                  The configuration window opens on the right side.
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 2. Click the Options tab.

 3. In the Layout area, in the Layout drop-down list, select the layout you want to use.

 4. Click Apply. On the left side of the preview, the formatting of your Facebook para-
graph changes accordingly.
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Editing a layout

You can edit alternative layouts but not the standard layout.

Warning: If you lack knowledge of HTML, CSS, and Velocity, contact 
customer support to edit the alternative layouts. If you edit them 
without in-depth knowledge, serious display errors may occur in 
your mailings.

 1. To edit alternative layouts, in the preview on the left, click Settings. The con-
figuration window opens on the right.

 2. Open the Facebook tab. Each layout has source text fields for the desktop, mobile, 
and text versions.
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 3. Edit the source text of the corresponding layout according. Under Inserting content, 
read how to place the various content items.

Note: Set up alternative layouts for mobile and text versions 
also. If no alternative layouts are stored for these versions, the 
standard layout is used.

 4. Click Apply. On the left, the formatting of your Facebook paragraph changes 
accordingly.

Inserting content

Access the content of the Facebook paragraph using Velocity variables and format the 
transferred content using HTML style attributes.

The following Velocity variables are available:

 l Status. Information on current item paragraphs
 l Present. For using queries that check for the presence of an element
 l Value. For issuing the content

Notes for the creation of new layouts

 l Font definitions. If you are using an alternative layout variant, font definitions must 
exist in the HTML you entered. The texts are not formatted by the Template Kit to 
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give you complete freedom in visual design.
 l Widths. Specify a fixed width or a width in percent. You should enter a percentage, 

because this prevents elements from sticking out of the layout.
 l Danger of display errors. If you edit the layouts without in-depth knowledge of HTML, 

serious display errors may occur in your mailings.

Status variables

Variable Type Description

$facebookItemFirst Boolean Is true if it is the first post in the Facebook paragraph, or is oth-
erwise false.

$facebookItemIndex Integer
Contains the position of the post within the Facebook para-
graph as a number (1 for the first post, 2 for the second post 
and so on).

$facebookItemLast Boolean Is true if it is the last post in the Facebook paragraph, or is oth-
erwise false.

Present variables

Variable Type Description

$facebookTextPresent Boolean Contains true if  there is content for the Text box, or 
otherwise false.

$facebookAuthorPresent Boolean Contains true if there is content for the Author box, 
or otherwise false.

$facebookDatePresent Boolean Contains true if there is content for the Date box, or 
otherwise false.

$facebookLinkTextPresent Boolean Contains true if there is content for the Text box in 
the Link area, otherwise false.

$facebookLinkUrlPresent Boolean Contains true if there is content for the URL box in 
the Link area, otherwise false.

$facebookImageUrlPresent Boolean Contains true if there is content for the Image box in 
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Variable Type Description

the Image tab, otherwise false.

$facebookImageAltTextPresent Boolean Contains true if there is content for the Alternative 
text box in the Image tab, otherwise false.

$facebookImageLinkPresent Boolean Contains true if there is content for the Link box in 
the Image tab, otherwise false.

Value variables

Variable Typ Description

$facebookTextValue String Contains the content of the Text box.

$facebookAuthorValue String Contains the content of the Author box.

$facebookDateValue String Contains the content of the Date box.

$facebookLinkTextValue String Contains the content of the Text box in the Link area.

$facebookLinkUrlValue String Contains the content of the URL box in the Link area.

$facebookImageUrlValue String Contains the image URL from the Image tab.

$facebookImageAltTextValue String Contains the content of the Alternative text box in the 
Image tab.

$facebookImageLinkValue String Contains the content of the Link box in the Image tab.

$editBar String

Inserts the paragraph's button bar. This is required to 
integrate the button bar into the table, such as when 
implementing adjacent items. If this variable is not avail-
able, the button bar is placed above the item.
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Twitter paragraph

Note: To enable this feature, contact customer support.

Use the Twitter paragraph to integrate up to 20 current tweets into your messages. Keep 
your recipients up-to-date with exciting topics from your social network.

Decide whether Episerver Campaign updates the Twitter paragraph every time you 
send a message and automatically loads the latest tweets from your Twitter timeline, or 
if  Episerver Campaign only displays tweets you defined when creating or modifying the 
campaign.

 l Dynamic integration. Displays your latest social media activities. However, you can-
not permanently delete or edit individual tweets in the Twitter paragraph. If you 
remove or edit tweets in the Twitter paragraph which are still present in your Twitter 
timeline, the removed or edited tweets are reloaded when the mailing is sent and 
inserted into the Twitter paragraph.

 l Static integration. Provides more control over the tweets in the Twitter paragraph. 
When creating a mailing, you can select which of your current tweets should be 
integrated. You can delete individual tweets. When the mailing is sent, Episerver 
Campaign does not update the Twitter paragraph from your Twitter timeline. 
Changes can still be made, but do not happen automatically. When using static 
integration, you can update tweets manually.

Tip: By default, Episerver Campaign integrates your tweets stat-
ically. To use dynamic integration, contact customer support.

Creating a Twitter paragraph

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph.A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 
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 2. Click Twitter. The configuration window for the selected paragraph type opens.
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 3. Click Apply. The new Twitter paragraph appears on the left.

Configuring a Twitter paragraph

 1. On the left side of the preview, in the menu bar of the Twitter paragraph, click 
Twitter. The configuration window opens on the right.

 2. See the following tables to set options in the corresponding tabs. To confirm your set-
tings, click Apply.

 l General
 l Settings
 l Button
 l SWYN
 l Default values
 l Default values
 l Options
 l Click profiles
 l Target groups
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General

Parameter Description

Content

Heading Enter a heading for the paragraph.

Show in 
desktop 
version

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate mobile 
version setting in the general settings must be activated for this option to take effect. 

Show in 
text ver-
sion

Select to show the paragraph in the text version of the mailing.

Link
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Parameter Description

Text This text is subsequently linked to in the mailing.

URL Enter a link here (for example, the landing page for the product group).

Orientation Position the link on the right, left, or center.

Settings

Parameter Description

Account 
name

Enter your public Twitter user name, the name used in the web address for your Twitter 
timeline. It is the last part of the URL: https://twitter.com/User name.

Maximum 
number of 
entries

Enter the maximum number of tweets that should be displayed in your message. The 
maximum value for this is 20 tweets.

If you enter 0 into this field or leave it empty, a default value of 10 tweets is used (if 
fewer than 10 tweets are available in your Twitter account, those tweets are dis-
played).

Also, when using static integration, changing this value has no effect on any tweets 
already retrieved. You must manually update the Twitter paragraph for the new 
number to take effect.

Date 
format

In the drop-down list, select a date format to be used next to your tweets. Changing 
the date format has no effect on tweets that already were retrieved when using static 
integration. You must manually update the Twitter paragraph for the date format 
change to take effect.

Button

See Click2Go.

SWYN

You can enable the SWYN function for social networks individually for each paragraph. 
To allow sharing of these paragraphs in a social network, select the Show check box for 
the network in which you want them to appear.
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Parameter Description

General

Alignment Links (symbols and text) and the introduction text are right-aligned.

Position Links (symbols and text) and the introduction text are positioned at the bottom edge 
of the paragraph.

Default values

Title Displays up to 50 characters in the user's profile if the user shares the paragraph over a 
social network, as long as no other title is indicated for that network.

Text Displays up to 250 characters in the user's profile if the user shares the paragraph over 
a social network, as long as no other text is specified for that network.

Image
Displays up to 100 x 100 pixels in the user's profile next to the text if the user shares the 
paragraph over a social network, as long as no other image is specified for that net-
work. Larger images are scaled down to this size.

Facebook

Show Lets recipients share the paragraph via their Facebook profile.

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here, the standard title is displayed. 

Text Displays up to 250 characters if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard text is displayed. 

Image
Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her Face-
book profile. If you enter nothing here,  the standard image is displayed. Larger images 
are scaled down to this size.

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

Twitter

Show Lets recipients share the paragraph via their Twitter account.
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Parameter Description

Title Displays up to 50 characters if the recipient shares the paragraph on his or her Twitter 
profile. If you enter nothing here, the standard title is displayed. 

Redirect Creates a landing page that displays the content of the linked paragraph. If you 
enable, the link redirects recipients to the URL specified in the General tab.

MySpace

Parameters for MySpace are identical to Facebook's.

Xing

Parameters for Xing are identical to Twitter's.

Default values

Parameter Description

Link

Text

Tweets in your message are automatically linked to the original tweet on your Twitter 
page.

To clarify this and highlight links, add additional text, for example, "More inform-
ation on our Twitter page" or "View original tweet". That text appears with each 
tweet in your message.

Orientation The text can be aligned to the right, left or center.

Image

Position From the drop-down list, select the position where an image associated with your 
tweet (if any) should be displayed.

Options

To give each content paragraph a different appearance from the general layout, use 
the layout configuration in this tab.
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Parameter Description

Layout

Width

The maximum available width is used as standard. This is based on the internal spa-
cing and also depends on whether you are using a sidebar and, if so, on the width of 
the sidebar. Enter a different value in pixels. If the maximum available width is smaller 
than this value, then the entered value is ignored.

Height
By default, the paragraph is displayed over the available height, considering the con-
tent. Alternatively, you can specify a fixed height. If the content exceeds this height, 
the value is ignored, and the content is displayed at the default height.

Background 
color

The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Space 
between art-
icles

A space with this height is placed between individual items. By default, the first num-
ber in the Padding option is used.This option is only enabled when using the standard 
layout.

Layout

Select a Twitter layout.

You can choose between the standard layout and up to two user-defined lay-
outs. To use a custom layout, set it up in advance in the general settings in the Twit-
ter tab. If you select a user-defined layout that is not configured, the standard 
layout is used.

Border

Show Select if you want to apply a border around the entire paragraph.
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Parameter Description

Border 
width

Enter the thickness of the border. You can set thickness for each side individually. 

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on 
top of each another with the assigned widths.

Table of contents

Show in 
table of con-
tents

Select to display the paragraph in the table of contents for the section.

Alternative 
table of con-
tents entry

Enter a heading to be displayed for this section in the table of contents. If you enter 
nothing, the heading from the General tab is displayed.

Click profiles

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles. See 
Click profiles.

Alternatively, you can allocate individual links to a click profile in the Tracking set-
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Parameter Description

tings for the mailing creation wizard.

Target groups

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.

Loading Tweets

 1. In the menu bar of the Twitter paragraph, click Load Tweets .

 2. Click Continue.

Updating tweets manually

You can manually update your tweets in the Twitter paragraph and reload them from 
your Twitter timeline.
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 1. In the menu bar of the Twitter paragraph, click Load Tweets  .

 2. Click Continue.

Editing tweets

You can edit tweets individually after loading them into your mailing.

 1. In the menu bar of the corresponding tweet, click Twitter entry.The configuration win-
dow opens on the right.

 2. Change the settings as needed and confirm your entries by clicking Apply.

Tip: If you manually update tweets in the Twitter paragraph, the 
posts are reloaded from your Twitter timeline, overwriting any 
manual changes to the tweets. If you are using dynamic integ-
ration, manual changes to tweets are overwritten when the 
mailing is sent.

Deleting tweets

 1. In the menu bar of the tweet you want to delete, click Delete  .
 2. Click OK.
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Twitter layouts

This topic describes:

 l how customer support sets up alternative HTML layouts
 l how to select alternative layouts in the Twitter paragraph
 l how to edit alternative layouts using HTML, CSS, and Velocity

To receive up to two alternative layouts, contact customer support.

To create HTML layouts, set up alternative layouts for mobile and text versions also. If no 
alternative layouts are saved for those versions, the standard layout is used.

Note: In some cases, some text elements will not be in the order 
that you want.

Selecting a layout

 1. To select a standard layout or one of up to 2 alternative layouts, while editing a mes-
sage in the Template Kit, on the left side of the preview, in the menu bar of the Twit-
ter paragraph, click Twitter.                  The configuration window opens on the right.
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 2. Click the Options tab.

 3. In the Layout area > Layout drop-down list, select the layout you want to use.

 4. Click Apply.
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Editing a layout

You can edit alternative layouts, but not the standard layout.

Warning: If you lack knowledge of HTML, CSS, and Velocity, contact 
customer support to edit the alternative layouts. If you edit them 
without in-depth knowledge, serious display errors may occur in 
your mailings.

 1. In the preview on the left, click Settings. The configuration window opens on the 
right.

 2. Open the Twitter tab. Each layout has source text fields for the desktop, mobile, and 
text versions.
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 3. Edit the source text of the corresponding layout as needed. Under Inserting content, 
read how to place the various contents.

 4. Click Apply.

Inserting content

Access the content of the Twitter paragraph using Velocity variables and format the 
transferred content using HTML style attributes.

The following Velocity variables are available:

 l Status. Information on current item paragraphs
 l Present. For using queries that check for the presence of an element
 l Value. For issuing the content

Notes for the creation of new layouts

 l Font definitions. If you are using an alternative layout variant, font definitions must 
exist in the HTML you entered. The texts are not formatted by the Template Kit to 
give you complete freedom in visual design.

 l Widths. Specify a fixed width or a width in percent. You should enter a percentage, 
because this prevents elements from sticking out of the layout.

 l Danger of display errors. If you edit the layouts without in-depth knowledge of HTML, 
serious display errors may occur in your mailings.
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Status variables

Variable Type Description

$twitterItemFirst Boolean Is true if it is the first tweet in the Twitter paragraph, or is otherwise 
false.

$twitterItemIndex Integer Contains the position of the post within the Twitter paragraph as a 
number (1 for the first tweet, 2 for the second tweet and so on).

$twitterItemLast Boolean Is true if it is the last tweet in the Twitter paragraph, or is otherwise 
false.

Present variables

Variable Type Description

$twitterTextPresent Boolean Contains true if there is content for the Text box, or oth-
erwise false.

$twitterAuthorPresent Boolean Contains true if there is content for the Author box, or 
otherwise false.

$twitterDatePresent Boolean Contains true if there is content for the Date box, or oth-
erwise false.

$twitterLinkTextPresent Boolean Contains true if there is content for the Text box in the 
Link area, otherwise false.

$twitterLinkUrlPresent Boolean Contains true if there is content for the URL box in the 
Link area, otherwise false.

$twitterImageUrlPresent boolean Contains true if there is content for the Image box in the 
Image tab, otherwise false.

$twitterImageAltTextPresent Boolean Contains true if there is content for the Alternative text 
box in the Image tab, otherwise false.

$twitterImageLinkPresent Boolean Contains true if there is content for the Link box in the 
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Variable Type Description

Image tab, otherwise false.

Value variables

Variable Type Description

$twitterTextValue String Contains the content of the Text box.

$twitterAuthorValue String Contains the content of the Author box.

$twitterDateValue String Contains the content of the Date box.

$twitterLinkTextValue String Contains the content of the Text box in the Link area.

$twitterLinkUrlValue String Contains the content of the URL box in the Link area.

$twitterImageUrlValue String Contains the image URL from the Image tab.

$twitterImageAltTextValue String Contains the content of the Alternative text box in the Image 
tab.

$twitterImageLinkValue String Contains the content of the Link box in the Image tab.

$editBar String

Inserts the paragraph's button bar. This is required to integ-
rate the button bar into the table, such as when imple-
menting adjacent items. If this variable is not available, the 
button bar is placed above the item.

Navigation menu

Note: To enable this feature, contact customer support.

Navigation menu example
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With this paragraph type, you can create navigation bars with links to landing pages or 
deep links. And, you can add and edit menu items with no HTML knowledge.

Range of functions

 l Can design each menu item individually: Text and background color, as an image 
or with an icon.

 l Create up to 10 menu items.
 l Store up to five user-defined layouts and apply them to the navigation menu.
 l In the mobile version, you can display navigation in two or three columns or as a 

hamburger menu.The hamburger menu offers the following advantages:

 o simple/minimalistic; can be used almost anywhere in the layout
 o navigation can be folded in and out
 o space-saving display for small screens

Creating a navigation menu

 1. While editing the content of a mailing in the Template Kit, click New: Content para-
graph.A window for selecting the paragraph type opens on the right side.

Tip: You can also use the paragraph in the header and footer 
area by clicking Header or Footer. 



© Episerver 2020

Managing content | 499

 2. Click Navigation menu. The configuration window for the selected paragraph type 
opens.

 3. Click Apply. The newly created navigation menu appears on the left, in the preview 
window.
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Configuring a navigation menu

 1. Click Navigation menu on the left side of the preview in the menu bar of the nav-
igation menu. The configuration window opens on the right.

 2. See the following tables to set options in the corresponding tabs. Click Apply to con-
firm your settings.

 l General
 l Separator lines
 l Hamburger menu
 l Options
 l Click profiles
 l Target groups
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General

Parameter Description

Content

Show in 
desktop ver-
sion

Select  to include this paragraph in the desktop mailing.

Show in 
mobile ver-
sion

Select  to show the paragraph in the mobile version of the mailing. The Activate 
mobile version setting in the general settings must be activated for this option to take 
effect. 

Show in text 
version Select to show the paragraph in the text version of the mailing.

Menu item 1-10

Text
Enter the caption of the menu item. To use an image for the menu item instead of a 
caption, enter a caption anyway. In this case, the caption is used as the image's 
alternative text.
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Parameter Description

Tip: You can display an image with or without a caption 
for the menu item. These settings are in the Options tab 
under Menu items > Image position.

URL Enter a URL to which the menu item should refer. If a recipient clicks this menu item, 
he/she is directed to the specified URL.

Text color
Specify the text color for the menu item caption. If you leave the field blank, the text 
color specified in general settings > Menu items in the navigation menu > Font settings 
> Color is used.

Background 
color

Specify a background color for . The setting only affects the selected menu item.

To use the same color for all menu items, configure a global background color. 
These settings are in the Options tab > Menu items > Background color.

Image

Upload an image. Click Browse... and select an image in the file browser. Altern-
atively, in the Alternatively external URL field, you can enter an image URL that refers 
to the image source.

Tip: You can display the image together with or without 
the caption of the menu item. The corresponding settings 
are in the Options tab under Menu items > Image position.

Note: The image size of the uploaded image is not 
reduced. So, only upload images that match the size of 
the menu item.

If you select a multi-column layout for the mobile version, 
before sending, use mobile preview to check if the nav-
igation menu displays correctly with these settings.

Show in 
mobile ver-
sion

Select to show the menu item in the mobile version of the mailing.
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Separator lines

Parameter Description

Content

Show vertical sep-
arator lines in the 
desktop version

Select to insert vertical separator lines between menu items in the desktop ver-
sion.

Show vertical sep-
arator lines in the 
mobile version

Select to insert vertical separator lines between menu items in the mobile ver-
sion.

Show horizontal 
separator lines in 
the mobile ver-
sion

Check this box to show horizontal separator lines between menu items in the 
mobile version.

This option only takes effect if you are using the default layout and configure 
it so that menu items in the mobile version are displayed below each other 
(see the Options tab under Layout > Default layout).

Layout

Thickness
Enter the thickness of separator lines between menu items in pixels (integer 
value) .If you leave the field blank, the lines are displayed with a 1 pixel thickness. 
To show no separator lines, enter 0.

Color
Enter the color of the separator lines. If you leave the field blank, the color you 
specified in the general settings in the Font settings tab under Menu items in the 
navigation menu > Color is used.

Hamburger menu

To save space for display on smart phones and tablets, you can use a hamburger menu 
to reduce the navigation menu to an icon.Recipients can expand and collapse the nav-
igation menu by clicking the icon.

Note: The hamburger menu is only available for the mobile version. 
In addition, Google’s Gmail app does not support this feature and 
shows menu items expanded.
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Parameter Description

General

Display Select to activate the hamburger menu in the mobile version of your mailing.

Menu bar

Heading Enter the caption of the hamburger menu. The caption displays next to the ham-
burger menu icon.

Padding Configure the size of the menu bar by specifying the area around the hamburger 
menu symbol. Enter the value in pixels (integer values).

Background 
color Enter the background color for the hamburger menu's menu bar.

Image

Image

Upload an image to replace the menu bar label with an image. Click Browse... and 
select an image in the file browser.

Alternatively, in the Alternatively external URL box, enter an image URL that refers 
to the image source. If the uploaded image is too wide for the menu bar, the 
image is adjusted to the maximum available width.

Alternative 
text

Enter an alternative text that displays if a recipient blocks the download of images, 
or the image cannot be displayed for any other reason. The alternative text should 
contains a brief description of the picture.

Link

Enter the URL of a landing page, beginning with the http:// or https:// protocol.

If you already created a landing page for the mailing, a list of those landing 
pages appears.

Icon

Position Select the position of the hamburger menu icon.

Color
Enter the color for the hamburger menu icon. If you leave the field blank, the color 
specified in the general settings in the Font settings tab under Menu items in the nav-
igation menu > Color is used.
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Parameter Description

Background 
color Enter the background color of the hamburger menu icon.

Rounding 
contours Check this box to round the contours of the hamburger menu icon.

Options

Parameter Description

Layout

Width

Enter at least 30 pixel width. The setting only affects the desktop version. If you leave 
the field blank, the paragraph is displayed across the entire width available in the 
mailing. If you want to change the available width in the mailing, open the general set-
tings, open the General tab and make your changes in the Layout area.

Height

Enter the height of the paragraph in pixels. The setting only affects the desktop ver-
sion. If you leave the field blank, the height will automatically be adjusted to fit the 
content of the paragraph.

Note: If you select a height that is insufficient for the con-
tent of the paragraph, the value you enter is ignored, and 
the height is adjusted automatically.

Alignment Specify how to position the navigation menu.

Background 
color Enter the background color of the navigation menu.

Padding

Specify white space around the paragraph content. You can set white space 
separately for each page. 

Enter the values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 10 = sides are uniform with 10 pixels of white space for the content
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels on the left
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Parameter Description

If the value is set to 0, then there will be no padding.

Layout

Select a layout for your navigation menu. You can select between the supplied 
default layout and up to five custom user-defined layouts. To use a user-defined lay-
out, set it up in advance in the general settings in the Navigation menu tab. If you 
choose to enter a user-defined layout from the drop-down list that you have not con-
figured, the default layout is used instead. See Navigation menu layouts.

Default lay-
out

Select the arrangement of menu items for the mobile version of the default layout.

Note: If you use a custom layout, the option selected here 
is ignored.

Background image

Image

To upload a background image that covers menu items, click Browse... and select an 
image in the file browser. In the Alternatively external URL box, you can also enter an 
image URL that refers to the image source.

Note: If you specify a background image, it is used instead 
of the selected background colors for menu items.

Note: Not all email programs and web mailers support 
background images. You should only upload background 
images that contain unimportant information.

Alignment Specify how to position the background image.

Repeat Specify whether and how the background image is repeated.

Menu items...

Background 
color

Specify a global background color for the menu items.

Note: If you specify an individual background color for a 
menu item, this is used instead of the global background 
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Parameter Description

color. To use the global background color for a menu 
item, delete the color value in the General tab under 
Menu item # > Background color.

Width 
(desktop 
version)

Enter the width of the menu items in pixels.

Tip: The recommended width for the menu items is shown 
in the preview on the left if you hover over ?Help.

Padding

Configure the size of the menu items by specifying the area around the caption.

You can set each side of the area individually. Enter the values in pixels (integer 
values) based on the following example, using spaces to separate multiple pixel 
entries:

 l 10 = sides of the area a uniform distance of 10 pixels away from the label
 l 10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
 l 10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bot-

tom, 25 pixels to the left

Text align-
ment Specify how to position the captions of the menu items.

Text position 
(next to the 
image)

Specify where to position captions of menu items next to an image.

Note: This option applies in the following cases:

 l If an image is used in the menu item, and the caption is activ-
ated.

 l If the caption of a menu item wraps to several lines; the caption 
of the other menu items is positioned according to the option 
selected here.

 l You can set images for each menu item in the General tab 
under Menu item # > Image.

 l Activate the caption with the following Image position option.

Image pos- Specify whether and where the images next to the captions of the menu items are 
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Parameter Description

ition

displayed.

Tip: If you select Centered (no label), the stored caption is 
not displayed but is used for the image's alternative text.

Menu items (mobile version)

Width

Enter the width of the menu items in percent.

Tip: This option only takes effect if you use the default lay-
out, and it is set so that individual menu items in the mobile 
version are displayed next to each another (see the 
Options tab under Layout > Default layout).

Text align-
ment Specify how to position the captions of the menu items.

Text position 
(next to the 
image)

Specify how to position the captions of the menu items next to the image.

Note: This option applies in the following cases:

 l If an image is used in the menu item and the caption is activated
 l If the caption of a menu item wraps to several lines; the caption 

of the other menu items is positioned according to the option 
selected here

 l You can set images for each menu item in the General tab 
under Menu item # > Image.

 l Activate the caption in the Options tab under Menu items 
(desktop version) > Image position.

Border

Show Select to add a border to the paragraph. Do not forget to specify a color for the bor-
der when you activate the option.

Border Enter the thickness of the border. You can set thickness for each side individually. 
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Parameter Description

width

Enter values in pixels (integer values) based on the following example, using 
spaces to separate multiple pixel entries:

 l 1 = sides uniform with 1 pixel
 l 1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right
 l 1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel 

on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all 
sides).

Color The depiction of non-hex web colors may vary from the original, depending on the 
browser. 

Mobile...

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display para-
graphs next to each another in mobile view, make sure that the widths of two con-
secutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on 
top of each another with the assigned widths.

Click profiles tab

Parameter Description

Click pro-
files

Clicks on any link in this paragraph are allocated to the selected click profiles. See 
Click profiles.

Target groups tab

Parameter Description

Target 
groups

To show this paragraph to one or more target groups only, select them. If more than 
one target group is selected, just one must match (OR logic). See Target groups.

Note: If more than one target group is selected for a paragraph, it is 
displayed if only one of them matches. Be aware also that para-
graphs that do not occupy the whole width of the newsletter (for 
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example, a sidebar) may cause unwanted gaps in the newsletter. 
Test the newsletter with target groups using the Target groups but-
ton in the top menu of this window and the Send test email to target 
group function.

Adjusting font settings

To change general font settings (for example, font, font color, font size and so on), 
adjust the options in the general settings in the Navigation menu tab under Menu items in 
the navigation menu.

Navigation menu layouts

This topic describes:

 l how customer support sets up alternative HTML layouts
 l how to select alternative layouts in the navigation menu
 l how to edit alternative layouts using in-depth knowledge of HTML, CSS, and Velocity

To receive up to five alternative layouts,  contact customer support to set up alternative 
layouts.

To create HTML layouts, set up alternative layouts for mobile and text versions also. If no 
alternative layouts are saved for those versions, the standard layout is used.

Note: In some cases, some text elements will not be in the order 
that you want.

Selecting a layout

 1. To select a standard layout or up to five alternative layouts, while editing a message 
in the Template Kit, on the left side of the preview, in the menu bar of the navigation 
menu, click Navigation menu. The configuration window opens.
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 2. Open the Options tab.
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 3. In the Layout area, in the Layout drop-down list, select the layout you want to use.

 4. Click Apply.

Editing a layout

You can edit alternative layouts but not the standard layout.

Warning: If you lack knowledge of HTML, CSS, and Velocity, contact 
customer support to edit the alternative layouts. If you edit them 
without in-depth knowledge, serious display errors may occur in 
your mailings.

 1. In the preview on the left, click Settings. The configuration window opens on the 
right.
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 2. Open the Navigation menu tab. Each layout has source text fields for the desktop, 
mobile, and text versions.

 3. Edit the source text of the corresponding layout as needed. See Insert content to 
learn how to retrieve and place the various content items.
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Note: Set up alternative layouts for mobile and text versions 
also. If no alternative layouts are created for these versions, the 
standard layout is used.

 4. Click Apply.

Inserting content

Access the content of the navigation menu using Velocity variables and format the 
transferred content using HTML style attributes.

The following Velocity variables are available:

 l Status. Information on current item paragraphs
 l Present. For using queries that check for the presence of an element
 l Value. For issuing the content

Notes for the creation of new layouts

 l Font definitions. If you are using an alternative layout variant, font definitions must 
exist in the HTML you entered. The texts are not formatted by the Template Kit to 
give you complete freedom in visual design.

 l Widths. Specify a fixed width or a width in percent. You should enter a percentage, 
because this prevents elements from sticking out of the layout.

 l Danger of display errors. If you edit the layouts without in-depth knowledge of HTML, 
serious display errors may occur in your mailings.

Status variables

Variable Type Description

$separatorDesktopEnabled Boolean

Contains true if the Show vertical sep-
arator lines in desktop version check 
box in the Content section of the Separ-
ator lines tab is selected, otherwise 
false.

$separatorDisplayVerticalInMobileVersion Boolean

Contains true if the Show vertical sep-
arator lines in mobile version check box 
in the Content section of the Separator 
lines tab is selected , otherwise false.

$separatorDisplayHorizontalInMobileVersion Boolean Contains true if the Show horizontal sep-
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Variable Type Description

arator lines in mobile version check box 
in the Content section of the Separator 
lines tab is selected , otherwise false.

$hamburgerMenuEnabled Boolean
Contains true if the Show check box in 
the General section of the Hamburger 
menu tab is selected, otherwise false.

$hamburgerMenuIconRounded Boolean

Contains true if the Rounding contours 
check box in the Icon section of the 
Hamburger menu tab is selected, oth-
erwise false.

$navigationItemsAmountValue Integer

Contains the number of menu items 
that are displayed. Menu items are only 
displayed if a link and either the text or 
the image are specified.

$navCurrentParagraphId Integer

Contains the ID of the respective nav-
igation menu paragraph. This ID is par-
ticularly important for the mobile 
version, because the CSS classes use 
this ID as a suffix in the name.

Present Variables

Variable Type Description

$item1TextPresent – $item10TextPresent Boolean

Contains true if there is con-
tent for the Text box in the 
Menu item # area, otherwise 
false.

$item1LinkUrlPresent – $item10LinkUrlPresent Boolean

Contains true if there is con-
tent for the URL box in the 
Menu item # area, otherwise 
false.

$item1ImageUrlPresent – $item10ImageUrlPresent Boolean
Contains true if there is con-
tent for the Image box in the 
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Variable Type Description

Menu item # area, otherwise 
false.

$item1ColorPresent – $item10ColorPresent Boolean

Contains true if there is con-
tent for the Text color box in 
the Menu item # area, oth-
erwise false.

$item1BackgroundColorPresent – $item1Back-
groundColorPresen Boolean

Contains true if there is con-
tent for the Background color 
box in the Menu item # area, 
otherwise false.

$navigationLinkColorPresent Boolean

Contains true if there is con-
tent for the Color box in the 
general settings under Font set-
tings > Menu items in the nav-
igation menu, otherwise false.

$separatorLayoutThicknessPresent Boolean

Contains true if there is con-
tent for the Thickness box 
under Separator lines > Layout, 
otherwise false.

$separatorLayoutColorPresent Boolean

Contains true if there is con-
tent for the Color box under 
Separator lines > Layout, oth-
erwise false.

$hamburgerMenuMenuBarHeadlinePresent Boolean

Contains true if there is con-
tent for the Heading box 
under Hamburger menu 
> Menu bar, otherwise false.

$hamburgerMenuMenuBarPaddingPresent Boolean

Contains true if there is con-
tent for the Padding box 
under Hamburger menu 
> Menu bar, otherwise false.

$hamburgerMenuMenuBarBackgroundColorPresent Boolean

Contains true if there is con-
tent for the Background color 
box under Hamburger menu 
> Menu bar, otherwise false.
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Variable Type Description

$hamburgerMenuMenuBarImagePresent Boolean

Contains true if there is con-
tent for the Image box under 
Hamburger menu > Image, 
otherwise false.

$hamburgerMenuMenuBarImageAltTextPresent Boolean

Contains true if there is con-
tent for the Alternative text box 
under Hamburger menu 
> Image, otherwise false.

$hamburgerMenuMenuBarImageLinkPresent Boolean

Contains true if there is con-
tent for the Link box under 
Hamburger menu > Image, 
otherwise false.

$hamburgerMenuIconColorPresent Boolean

Contains true if there is con-
tent for the Color box under 
Hamburger menu > Icon, oth-
erwise false.

$hamburgerMenuIconBackgroundColorPresent Boolean

Contains true if there is con-
tent for the Background color 
box under Hamburger menu 
> Icon, otherwise false.

$navigationBackgroundImageUrlPresent Boolean

Contains true if there is con-
tent for the URL box under 
Options > Background image, 
otherwise false.

$navigationItemDesktopBackgroundColorPresent Boolean

Contains true if there is con-
tent for the Background color 
box under Options > Menu 
items, otherwise false.

$navigationItemDesktopWidthPresent Boolean

Contains true if there is con-
tent for the Background color 
box under Options > Menu 
items, otherwise false.

$navigationItemDesktopPaddingPresent Boolean
Contains true if there is con-
tent for the Padding box 
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Variable Type Description

under Options > Menu items, 
otherwise false.

$navigationItemMobileWidthPresent Boolean

Contains true if there is con-
tent for the Width box under 
Options > Menu items (mobile 
version), otherwise false.

$item1DisplayInMobileVersion – $item10Dis-
playInMobileVersion Boolean

Contains true if the Show in 
mobile version check box 
under General > Menu item # is 
selected, otherwise false.

Value-Variables

Variable Type Environment Description

$item1TextValue – $item10TextValue String Desktop, 
Mobile, Text

Contains the 
unformatted 
content of the 
Text box from 
the Menu item # 
area.

$item1TextFormattedValue – $item10Tex-
tFormattedValue String Desktop, 

Mobile

Contains the 
formatted con-
tent of the Text 
box from the 
Menu item # 
area.                         

The text is 
formatted 
using the font 
settings from 
the general set-
tings and the 
text color from 
the menu item 
itself.
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Variable Type Environment Description

$item1LinkUrlValue – $item10LinkUrlValue String Desktop, 
Mobile, Text

Contains the 
unformatted 
content of the 
URL box from the 
Menu item # 
area.

$item1LinkFormattedValue – $item10LinkFor-
mattedValue String Desktop, 

Mobile

Contains the 
formatted con-
tent of the URL 
box from the 
Menu item # 
area.                         

The text is 
formatted 
using the font 
settings from 
the general set-
tings and the 
text color from 
the menu item 
itself.

Note: If you 
have uploaded 
an image for 
the menu item 
and positioned 
it to the right or 
left of the text, 
the link is dis-
played includ-
ing text and 
image.

$item1ImageUrlValue – $item10ImageUrlValue String Desktop, 
Mobile, Text

Contains the 
content of the 
Image box from 
the Menu item # 
area.

$item1ColorValue – $item10ColorValue String Desktop, 
Mobile

Contains the 
content of the 
Text color box 
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Variable Type Environment Description

from the Menu 
item # area.

$item1BackgroundColorValue – $item10Back-
groundColorValue String Desktop, 

Mobile

Contains the 
content of the 
Background 
color box from 
the Menu item # 
area.

$navigationLinkColorValue String Desktop, 
Mobile

Contains the 
content of the 
Color box from 
the general set-
tings > Font set-
tings tab > Menu 
Items in the Nav-
igation Menu 
area.

$separatorLayoutThicknessValue String Desktop, 
Mobile

Contains the 
content of the 
Thickness box 
from the Separ-
ator lines tab > 
Layout area.

$separatorLayoutColorValue String Desktop, 
Mobile

Contains the 
content of the 
Color box from 
the Separator 
lines tab > Lay-
out area.

$hamburgerMenuMenuBarHeadlineValue String Mobile

Contains the 
unformatted 
content of the 
Heading box 
from the Ham-
burger menu 
tab > Menu bar 
area.
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Variable Type Environment Description

$hamburgerMenuMenuBarHeadlineFormattedValue String Mobile

Contains the 
formatted con-
tent of the Head-
ing box from the 
Hamburger 
menu tab > 
Menu bar area.

$hamburgerMenuMenuBarPaddingValue String Mobile

Contains the 
content of the 
Padding box 
from the Ham-
burger menu 
tab > Menu bar 
area.

$hamburgerMenuMenuBarBackgroundColorValue String Mobile

Contains the 
content of the 
Background 
color box from 
the Hamburger 
menu tab > 
Menu bar area.

$hamburgerMenuIconPositionValue String Mobile

Contains the 
content of the 
Position box 
from the Ham-
burger menu 
tab > Icon area.

$hamburgerMenuIconColorValue String Mobile

Contains the 
content of the 
Color box from 
the Hamburger 
menu tab > Icon 
area.

$hamburgerMenuIconBackgroundColorValue String Mobile

Contains the 
content of the 
Background 
color box from 
the Hamburger 
menu tab > Icon 
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Variable Type Environment Description

area.

$hamburgerMenuMenuBarImageUrlValue String Mobile

Contains the 
content of the 
Image box from 
the Hamburger 
menu tab > 
Image area.

$hamburgerMenuMenuBarImageAltTextValue String Mobile

Contains the 
content of the 
Alternative text 
box from the 
Hamburger 
menu tab > 
Image area.

$hamburgerMenuMenuBarImageLinkValue String Mobile

Contains the 
content of the 
Link box from 
the Hamburger 
menu tab > 
Image area.

$navigationAlignmentValue String Desktop, 
Mobile

Contains the 
content of the 
Alignment box 
from the Options 
tab > Layout 
area.

$navigationBackgroundImageUrlValue String Desktop, 
Mobile

Contains the 
content of the 
Image box from 
the Options tab 
> Background 
image area.

$navigationBackgroundImageAlignmentValue String Desktop, 
Mobile

Contains the 
content of the 
Alignment box 
from the Options 
tab > Back-
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Variable Type Environment Description

ground image 
area.

$navigationBackgroundImageRepeatValue String Desktop, 
Mobile

Contains the 
content of the 
Repeat box from 
the Options tab 
> Background 
image area.

$navigationItemDesktopBackgroundColorValue String Desktop, 
Mobile

Contains the 
content of the 
Background 
color box from 
the Options tab 
> Menu items 
area.

$navigationItemDesktopWidthValue String Desktop, 
Mobile

Contains the 
content of the 
Width (desktop 
version) box 
from the Options 
tab > Menu 
items area.

$navigationItemDesktopPaddingValue String Desktop, 
Mobile

Contains the 
content of the 
Padding box 
from the Options 
tab > Menu 
items area.

$navigationItemDesktopAlignmentValue String Desktop, 
Mobile

Contains the 
content of the 
Text alignment 
box from the 
Options tab > 
Menu items 
area.

$navigationItemDesktopVerticalAlignmentValue String Desktop, 
Mobile

Contains the 
content of the 
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Variable Type Environment Description

Text position 
(next to the 
image) box 
from the Options 
tab > Menu 
items area.

$navigationItemImageBehaviorValue String Desktop, 
Mobile

Contains the 
content of the 
Image position 
box from the 
Options tab > 
Menu items 
area.

$navigationItemMobileWidthValue String Mobile

Contains the 
content of the 
Width box from 
the Options tab 
> Menu items 
(mobile version) 
area.

$navigationItemMobileAlignmentValue String Mobile

Contains the 
content of the 
Text alignment 
box from the 
Options tab > 
Menu items 
(mobile version) 
area.

$navigationItemMobileVerticalAlignmentValue String Mobile

Contains the 
content of the 
Text position 
(next to the 
image) box 
from the Options 
tab > Menu 
items (mobile 
version) area.
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Field functions

Dynamic Rendering (ODR) and Velocity let you create your own field functions for your 
mailings.  Dynamic Rendering is an XML-based script language for field functions; Velo-
city is a Java-based language. You should have some knowledge of HTML/XML or Java 
because this documentation provides only the basics of using Dynamic Rendering or 
Velocity. 

Note: Dynamic Rendering and Velocity classes and operations
The special feature, Edit field functions, provides a wide range of 
personalization options for your mailings. However, only classes, 
operations, and parameters documented in this manual are per-
mitted for the creation of field functions. Velocity or Dynamic Ren-
dering code not documented here may interfere with or damage 
your mailing templates and affect the sending of mailings.
Read this documentation thoroughly.
Always test user-defined field functions with the personalized pre-
view. If you have any questions or doubts about the code and its 
correct utilization, contact customer support.     

Adding a field function to a mailing

In the context of a mailing (paragraph, subject, and so on), you insert field functions 
using a placeholder in curly brackets { }. To add a field function to a paragraph, follow 
these steps when editing a mailing.

 1. In the editor toolbar, click Insert field function .
 2. In the dialog box, select the desired field.
 3. Click OK.

Tip: If you know the name of a field function, insert the name 
between curly brackets wherever you want it to appear in a 
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mailing. When the mailing is sent, the field function placeholder is 
replaced by the content for which the field function stands.

Field function use cases
Field functions replace or personalize content. The field function definition generates a 
string (some text) and inserts it in the mailing. Some field functions are a simple replace-
ment, for example they set the name or a date. Others can distinguish among different 
cases and replace the content accordingly. Also, field functions can be defined 
through target groups. These only generate text if the recipient matches the target 
group. The following list gives examples of field functions:

 l Date. The current date is inserted.
 l Salutation. A salutation usually contains one for males, another for females, and neut-

ral term for recipients whose name and gender are unknown.
 l Subject line. For example, the name or other personalization strings.

Tip: Personalized links
You can use field functions to create personalized links in your mail-
ings. You also can use field function placeholders in the domain 
part or path of a URL and in URL parameters. The link tracking of per-
sonalized links works as in regular links.

Editing field functions
To edit a field function, select Administration > Field functions. The overview shows edit-
able field functions. If you are working in a sub-client, the list also shows field functions 
inherited from the main client but these cannot be edited. Select a field function from 
the list and click Edit. 

To create a new field function, click Add. If you delete a field function, make sure it is 
not used in an active mailing.

 l Inheritable. Select if you want to make the field function available in sub-clients. 
Users logged into a sub-client can use inherited functions, but not edit them.

 l Type. Select which rules are applied for validation and execution of a field function:

Note: Do not change the type if you are not sure of what you 
are doing.
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 o JSPX. This type accepts only valid XML code.
 o Velocity. This type accepts only Velocity code.

 l Example. Shows a replacement example. Enter an actual example or a description 
of the field function that explains the field function.

 l Content. Enter the field function definition using either Dynamic Rendering or Velo-
city for each mailing type, media type or content type. This may be static text, 
dynamic text or both. To create dynamic content, enter commands and queries 
that are executed when the mailing is sent.

 o Default replacement. Contains a fallback that is applied if a field function is not 
defined. Also, if you do not want to specify different field functions for each 
email type, media type, and element type, use this field and leave the others 
empty.

 o Text. Write the code and text for the field function used in the text version of a 
mailing.

 o HTML.  Write the code and text of a field function used in the HTML version of a 
mailing.

 o SMS.  Write the code and text of a field function used in SMS mailings.
 o Subject.  Write the code and text of a field function used in the subject line of a 

mailing.

Template engines
Template engines are software tools to process a field function. That is, they read the 
commands in a field function, query the database, and create an output string. 
Episerver Campaign provides two template engines: the proprietary Dynamic Ren-
dering engine, and the Velocity engine. The following paragraph introduces these two 
and lists available classes and functions.

ODR – Dynamic Rendering
If your are familiar with XML and HTML tags, you can learn how to write field functions in 
the Dynamic Rendering language. The following example shows a salutation logic writ-
ten in Dynamic Rendering.

Sample code

<odr:choose>
  <odr:when test="%{not empty user.data.firstname and not empty user.data.lastname and user-
.data.salutation == 'Mrs.'}">
   <odr:out value="Dear Mrs. %{user.data.firstname} %{user.data.lastname}," /> 
  </odr:when> 
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  <odr:when test="%{not empty user.data.firstname and not empty user.data.lastname and user-
.data.salutation == 'Mr.'}">
   <odr:out value="Dear Mr. %{user.data.firstname} %{user.data.lastname}," />
  </odr:when>
  <odr:otherwise> 
   <odr:out value="Dear Sir or Madam," />
  </odr:otherwise>
 </odr:choose>

Tip: Remarks

 l Line 1. The choose tag initiates a query of several parameters. It contains 
no attributes.

 l Lines 2 and 7. The when tag initiates the query of a single parameter. 
Attributes are the parameter itself and the values. In the example, the 
tag checks whether the fields first and last name in the recipient list are 
not empty and whether the field Salutation contains Mrs. or Mr..

 l Lines 4 and 8. The out tag contains the output string. This is static or 
dynamic text or both, like in the example.

 l Line 12. The otherwise tag defines the output string for cases that do not 
match a previous tag. It contains no attributes

Line breaks, blank spaces and formatting with Dynamic Ren-
dering
Line breaks and blank spaces between Dynamic Rendering tags are escaped during 
the rendering. You can insert blank spaces in the running text inside the quotation 
marks. HTML tags inside the Dynamic Rendering expressions (i.e., inside the quotation 
marks) must be written as entities. Use the following entities to escape the respective 
characters:

 l &lt;. (< less than)
 l &gt; (> greater than)
 l &quot; (" quotation mark)
 l &amp; (& ampersand)

For information about the logic and rules of XML, see http://en.wikipedia.org/wiki/Xml.

Velocity
Velocity is a Java-based template engine. Velocity algorithms can appear within HTML 
in a mailing or a website. An algorithm may contain conditions and fallbacks, which 
generate some text if true and another text or no text if false.

http://en.wikipedia.org/wiki/Xml
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Velocity references are initiated with a $ sign, followed by a class and a function. Two 
examples are below.

Example: Insert first and last name of a recipient in a salutation

Dear ${user.data.firstname} ${user.data.lastname}!

You also can use the expression ${user.data.[field_name]} to address any field in the recip-
ient list by replacing [field_name] with the field name.

If your recipient list contains recipients whose first name is unknown, because it is usually 
not a mandatory field, the expression shown above needs to be extended. Otherwise, it 
could produce a salutation like "Dear Smith!". With Velocity, you can define an altern-
ative expression, using "Dear Mrs." or "Dear Mr." plus the recipient's last name.

Example: Salutation with complete name and fallback
To consider possible cases, write an if-then algorithm. This algorithm is initiated with a 
pound sign (#) and the command if. Below, the different cases and an alternative (else) 
are formulated. The algorithm ends with #end:

#if("$!{user.data.lastname}" != "" &&"$!{user.data.gender}" != "")Dear
 #if($user.data.gender.startsWith("male"))Mr. 
 #if($user.data.gender.startsWith("female"))Mrs.#end $user.data.lastname
 #else$!{null}Dear Sir or Madam#end$!{null}

Tip: Remarks

 l Line 1. To formulate the salutation, the recipient's last name and gender 
must be known. In this line, the field function checks whether both exist 
for a given recipient. (If lastname is not null AND gender is not null...)

If you formulate an #if operation, use the special operator $!. Otherwise, 
if the variable is not defined, Velocity would read the variable's name as 
a string (and not its value, because there is none) and, when an expres-
sion "does equal" is formulated, the result would be false, because the 
string is unequal to a non existing value. The special operator $! sup-
presses this expression if the variable it is not defined. 

The whole expression is wrapped in quotation marks. If a field is not 
defined for a recipient, a query would deliver the result NULL. The quo-
tation marks transform this into an empty string, which can be validated 
with conditions of the type ="" (is empty) or !="" (is not empty).

 l Line 2. If the gender is male, the correct form "Mr." is chosen.
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 l Line 3. If the gender is female, the form "Mrs." is chosen, followed by the 
recipient's last name.

 l Line 4. The placeholder #else creates a fallback, which is used if the first 
condition does not match, i.e. if either the last name or the gender are 
not known. In this case, a neutral, general salutation is displayed.

If Velocity commands are inserted directly into continuous text, space 
characters after such commands are ignored. This may cause text that 
follows a Velocity command to be interpreted together with the com-
mand. The result is a syntax error. To avoid such errors, a NULL object must 
be inserted between the Velocity command and the text: $!{null}. This 
object does not generate any output but closes the preceding com-
mand.

Close Velocity-Code with the Tag #end. After this tag, insert a line break.

Velocity classes and functions
Episerver Campaign provides several classes and functions that you can use to define 
field functions.

 l $user.data
 l $bmFormat
 l $bmMimeType
 l $filter

$user.data

Query fields of a recipient list. Use this function either to insert the value of a field (such 
as a user's name) in a mailing (placeholder), or to check if the field matches a given 
value (if-then-function).

Function Velocity code

Value equals a string value $user.data.[field_name] == "string"

Value equals a numeric value $user.data.[field_name] == X

Value does not equal a string value $user.data.[field_name] != "string"
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Function Velocity code

Value starts with a string value $user.data.[field_name].startsWith 
("string")

Value does not equal a numeric value $user.data.[field_name] != X

Value is less than or equals a numeric value $user.data.[field_name] <= X

Value is greater than or equals a numeric value $user.data.[field_name] >= X

Value is greater than a numeric value $user.data.[field_name] > X

Special function: IsOnlineVersion $user.data.bmIsOnlineVersion

Use IsOnlineVersion to check whether the online version of a newsletter is currently dis-
played. The return value is true. To  hide the link to the online version, if it is already dis-
played, specify the following Velocity code:

#if($user.data.bmIsOnlineVersion)cLICK <a href="{Online-Version-Link}" 
 target="_blank">here</a> to read an online version of this newsletter.

$bmFormat 

Format a value within this expression.  You can only format dates and numeric values, 
but you can add an optional pattern or the number of decimal places (precision). The 
following code show an example of using $bmFormat:

You registered with us on $bmFormat.formatDate($user.data.created)

Function Velocity code

Format as percentage $bmFormat.-
formatPercentage

Format as currency. If the parameter includeCurrencySymbol is set to 
true, the currency symbol is displayed.

$bmFormat.formatCurrency
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Function Velocity code

Format a date $bmFormat.formatDate

Format a date and time $bmFormat.formatDateTime

Format a time $bmFormat.formatTime

Attributes for formatting numeric values

Attribute Description

pattern

 l Numeric values. Use the pattern ###,###,###.## or 000000.000.                         

Tip: # stands for a digit, 0 for leading or trailing zeros.

The dot indicates a decimal separator and can only 
appear once in the pattern. The comma is used is used 
as a grouping symbol and can appear any number of 
times, except after the decimal point where it may not 
appear.

Note: The output that this creates has 
numeric values appear with German format-
ting; that is, the grouping symbol (comma in 
the pattern) is displayed as a dot and the 
decimal separator (dot in the pattern) is dis-
played as a comma—for example 
"1.000,00". English formatting (for example 
"1,000.00") is not supported.

Examples for the value 1000:

Pattern Output

###,###,###.## 1.000

000,000,000.00 000.001.000,00
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Attribute Description

Pattern Output

##,##.0### 10.00,0

###.###.###.## ✘  invalid, there are too many dots

###.###,## ✘  invalid, the comma appears after the 
dot

 l Date values. Use the pattern dd.MM.yyyy. 
 l Time values. Use the pattern hh:mm:ss. 

For more information about formatting numbers and dates, see the Java doc-
umentation from Oracle.

precision Integer value that specifies the number of decimal places to which the output value 
should be rounded.

$bmMimeType

Query the mime type of the mailing that is currently rendered.

Mime Type Velocity code

Plain text emails $bmMimeType == "text/plain"

HTML emails $bmMimeType == "text/html"

$filter

Invoke a target group. The submitted string must match a target group ID of your 
Episerver Campaign client. To get the IDs of your target groups, contact customer sup-
port. Do not use an ID if you are not sure it matches a target group; otherwise, your tem-
plate does not work properly. The Velocity code for this function is as follows:

$filter.filterByRevisionedFilter

https://docs.oracle.com/javase/tutorial/i18n/format/simpleDateFormat.html
https://docs.oracle.com/javase/tutorial/i18n/format/simpleDateFormat.html
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Coupon system

Note: To enable this feature, contact customer support.

The coupon system lets you:

 l Include coupon codes in mailings that recipients may redeem  in your online shop.
 l Integrate blocks of coupon codes with a placeholder. 
 l Manually or automatically add coupon codes to a coupon block.
 l Display coupon codes as machine-readable bar codes.

You can manage the coupon system via the Episerver Campaign user interface. You can 
also manage the coupon system remotely using the following Episerver Campaign pro-
gramming interfaces:

 l REST API
 l SOAP API via web services CouponBlockWebservice and CouponCodeWebservice

Assigning coupon codes
During dispatch, static or dynamic coupon codes are assigned to the mailings and 
recipients (MailingToUser ID). This ensures that each coupon code of a coupon block is 
only sent once. 

Tracking coupon codes sent in a mailing
In the Managing coupon blocks window, click  Download assignments to download the 
assignment of sent coupon codes in a CSV file. The file contains the 

 l coupon block ID
 l coupon code
 l recipient ID (generally, the email address)
 l recipient list ID
 l mailing ID 
 l mailing's creation and modification dates

https://api.campaign.episerver.net/apidoc/index.html#/Coupon_blocks
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/couponblockwebservice/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/couponcodewebservice/
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Inserting coupon codes in a mailing
To send coupon codes in a mailing, insert a placeholder where the code will be dis-
played. Find the placeholder in the Details area of the Manage coupon blocks window.

{Coupon Block:12345678901}

The coupon code is displayed as plain text in the email.

If you want to send several coupons in an email, use several coupon blocks. However, if 
you insert the same placeholder several times in a mailing, only one coupon code is 
sent. 

Testing emails
By default, coupon codes in test emails are disabled, and a special placeholder with no 
function replaces the active coupon code.

To enable real coupon codes for test cases, check the box Use valid coupon codes in 
test emails in the details of a coupon block or when creating coupon blocks.

Managing coupon blocks
Coupon codes are organized using containers known as coupon blocks. You manage 
coupon blocks on a client level, so you can use the same coupon block in multiple mail-
ings in your client. 

A mailing may only contain one coupon code from the same coupon block. If you 
insert two coupon codes from the same block, the mailing displays the same code 
twice but uses only one coupon code. 

In contrast, if you want recipients to receive several different coupons in a mailing, 
include coupon codes from different coupon blocks. Also, a recipient can receive sev-
eral coupon codes from the same coupon block if they are sent in separate mailings.

Editing coupon blocks
To manage and edit coupon blocks, open the start menu and select Special > Manage 
coupon blocks.

In the list, click a coupon code to display its details.
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 l Name. Used internally by the coupon code system.
 l Field function. Use this placeholder to insert the coupon block in a mailing.
 l Type. One of the following:

 o Static
 o Generated
 o EAN-13 bar code
 o Code 128 bar code
 o Interleaved 2 of 5 bar code

 l Created. The creation date of the coupon block.
 l Last modified. The modification date of the coupon block.
 l Total coupon codes. Number of codes a coupon block contains (for static and bar 

code blocks) or how many codes were already generated (for generated blocks).
 l Free coupon codes. Number of free codes in a coupon block. For generated coupon 

blocks, the value is infinite.
 l Use valid coupon codes in test emails. Check this box to use valid coupon codes in 

your test emails.

Use these buttons to perform the following actions.

 l Create
 l Delete block
 l Delete unused codes
 l Import codes
 l Download assignments
 l Download codes
 l Edit thresholds
 l Edit bar code coupon block

Creating a coupon block
Prerequisite: If you want use static coupon blocks, you must first import them. See Import-
ing codes.
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 1. Click Create.

 2. In the Name box, enter a descriptive name for the coupon block, so you can identify 
it later.

 3. In the Type area, select a coupon block type.

 l Static. Use if you want to release a limited number of coupon codes or generate 
coupon codes from your CMS. Static coupon blocks are imported into Episerver 
Campaign in a CSV file format. See Importing codes.

 l Generated. Coupon blocks are dynamically generated by Episerver Campaign 
during dispatch and are typically unlimited. These coupons are generated with 
one coupon block.

 l EAN-13 bar code. Bar code blocks convert a 13-digit code into a machine-read-
able bar code and insert it as a graphic into a mailing. The encoding of the bar 
code conforms to the EAN-13 specification. The coupon system ensures that bar 
codes are unique and only used once. No items are encoded, but a unique 
code is assigned to each recipient. To manually import coupon codes into a bar 
code block, see Importing codes.

 l Code 128 bar code. Bar code blocks convert an alphanumeric code of any 
length into a machine-readable bar code and insert it as a graphic into a mail-
ing. The Code 128 bar code contains the full ASCII character set and auto-
matically switches between the Code 128 bar code character sets A, B, and C 
to best encode your data. 

You can also select the Code 128 bar code character set manually:
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 o Character set A. Supports the ASCII character set without lower case letters.
 o Character set B. Supports the ASCII character set without control codes.
 o Character set C. Supports pairs of digits from 00 to 99.

To manually import coupon codes into a bar code block, see Importing codes.

 l Interleaved 2 of 5 bar code. Bar code blocks convert a numeric code of any 
length into a machine-readable bar code and insert it as a graphic into a mail-
ing. The Interleaved 2 of 5 bar code is a numeric bar code that only supports 
pairs of digits from 00 to 99. To manually import coupon codes into a bar code 
block, see Importing codes.

 4. To use valid coupon codes in your test emails, check the Use valid coupon codes in 
test emails box.

 5. Click Save.

Tip: For more individual coupons you can also create bar codes 
that refer to a specific recipient list field. To do this, contact cus-
tomer support.

Deleting a coupon block
In the overview, click the coupon block you want to delete > Delete block > Delete. 
Coupons in the block that have been sent but not redeemed remain valid.

Note: When deleting a coupon block, its histories and any assign-
ments are lost.

Deleting unused codes
In the overview, click the coupon block you want to empty > Delete unused codes. 
Unused codes are deleted, but the block remains intact. Later, you can add new 
coupon codes to the block.

Note: You can only delete unused codes in static and bar code 
coupon blocks.
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Importing codes
Prerequisite: Your computer contains coupon codes  in a CSV file. The file should only 
contain one column with the codes. You should know the CSV file's encoding, column 
delimiter, escape character, and if the CSV file contains a header row.

To learn how to define the minimum number of codes for that block, see Editing 
thresholds. 

Note: Codes for EAN-13 bar code coupon blocks must consist of a 
13-digit number, digits only. Codes for Interleaved 2 of 5 bar code 
coupon blocks can consist of any number of digits, but the number 
must be even.

 1. In the overview, click the coupon block to which you want to import codes. 
 2. Click Import codes. The Upload coupon codes window opens.
 3. Click  Browse... and select the CSV file  that contains coupon codes to be imported. 
 4. Click Preview.
 5. In the File charset drop-down list, select the encoding used in the CSV file. If you are 

not sure about this, select Auto.
 6. In the Column delimiter drop-down list, select the character (semicolon, comma, 

tabulator, and so on) that separates the data fields in the uploaded file. 
 7. In the Escape character drop-down list, select the character with which each indi-

vidual data field is enclosed. Some database programs use a single quote (') or 
double quote (") around each data field when exporting.

 8. If the CSV file contains a header, in the Skip first row drop-down list, select Yes.
 9. Optionally, in the Maximum number of rows to preview drop-down list, select the num-

ber of records to display in the preview.
 10. Click  Refresh preview to reload the records.
 11. Click Import coupon codes. The last tab shows how many codes were imported.

After the import, the coupon block is ready for use.

Downloading assignments
To download a CSV file containing the already used coupon codes and their cor-
responding mailing and recipient assignments: 

 1. In the overview, click the desired coupon block.
 2. Click Download assignments.
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Downloading codes
To download codes of a coupon block: 

 1. In the overview, click the desired coupon block.
 2. Click Download codes.

Note: Due to their inherent unlimited nature, you can only down-
load the list of used coupons as a CSV file for dynamic and bar 
code coupon blocks.

Editing thresholds
If you are using static or bar code coupon blocks, you must ensure that sufficient 
coupon codes are available. Depending on the type of mailing, Episerver Campaign 
uses several security questions.

To define the threshold values, perform the following steps :

 1. In the overview of the Manage coupon blocks window, click the coupon block whose 
thresholds you want to edit.

 2. Click Edit thresholds.
 3. Define the threshold values in the Configuration area.

 l Warning threshold value 1. Enter an integer warning threshold value for trans-
actional mailings. If this threshold is reached, a notification email is sent, but the 
sending continues. You should then upload new coupon codes.

 l Termination threshold value 1. Enter an integer threshold value for transactional 
mailings. If this threshold is reached, a notification email is sent and dummy 
coupon codes with no function are used in the mailing. You must upload new 
coupon codes.

 l Warning threshold value 2. Enter the percentage of recipients of regular and 
Smart Campaign mailings for which the coupon block must still contain coupon 
codes after sending. If this threshold is reached, a notification email is sent, but 
the sending continues. You should upload new coupon codes.

 l Termination threshold value 2. Enter the percentage of recipients of regular and 
Smart Campaign mailings for which the coupon block must still contain coupon 
codes after sending. If this threshold is reached, the sending is canceled. You 
must upload new coupon codes before restarting the mailing.

 l Email addresses. Enter one or more email addresses to which a notification is sent 
if a threshold value is reached.
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 4. Click Save.

Note: Threshold usage
For triggered mailings (for example, birthday mailings), the coupon 
system uses the thresholds for regular mailings. For transactional 
mailings sent using the REST API, HTTP API or Marketing Automation, 
the coupon system uses the thresholds for special mailings.

Editing a bar code coupon block
 1. In the overview, click the coupon  block you want to edit.
 2. Click Edit bar code block.
 3. You can specify the size options of the bar code coupon block either through 

height and width or line thickness :

 l Select Height and width and enter the desired values in pixels.
 l Select Line thickness and then in the Line thickness drop-down list, select a value 

from 1 to 10 pixels.

Countdown timers

Note: To enable this feature, contact customer support.

If the countdown timer is enabled for your user account, to access the feature, open 
the start menu and select Special > Countdown timers. 

Count down the time until your offer runs out  with the countdown timer. Grab your recip-
ients’ attention and increase conversion rates.

The countdown timer  displays the number of days, minutes, hours and seconds currently 
remaining on an offer, regardless of when a recipient opens your newsletter. The count-
down timer is dynamic, agile and flexible. You can customize the timer and the graphic 
layout. 

The following topics show how to graphically design offers with a countdown timers and 
incorporate them into your messages. If you encounter problems, see Troubleshooting 
countdown timers.
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How it works
Episerver Campaign support two types of countdown timers:
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 l Non-animated countdown timer with static display of time remaining.

If you integrate a non-animated countdown timer into your mailing, when the 
recipient opens the mailing, a static image with the currently remaining time is 
generated, loaded into your mailing, and displayed.

 l Animated countdown timer with live countdown.

If you incorporate an animated countdown timer into your mailing, the counter is 
active in your top offer for 60 seconds. Animated countdown timers use the GIF 
(Graphics Interchange Format) image format. This way, the newsletters contains 
a ticking clock.

Note: If a countdown timer uses a complex graphic design for its 
background, your animation may be several megabytes, which is 
too much for a newsletter and your recipients' inbox. So, the count-
down timer file size is limited to 1.5 megabytes.

You can create consistent and attractive layouts while keeping the file size small by 
splitting a product offer into two parts that you bring back together. Save the product 
image and/or your key visual as a normal image file (JPEG or PNG) and save the 
counter as a GIF animation in Episerver Campaign.
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Preparing graphics explains how to split a product offer with a countdown timer into two 
parts then bring them together into a single graphic in your message.

Preparing graphics

Tip: If you want to insert the timer into a message without a graphic 
or photo, see Creating a countdown timer.

Requirements
To prepare a countdown timer with a background graphic or photo, you need:

 l image editing software, such as Adobe Photoshop
 l a product image or key visual
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Example of preparing graphics
To create a countdown timer with a background graphic or photo, prepare two parts 
(see How it works):

 l the product image or key visual
 l the graphic on which the timer will be placed

To prepare both parts, follow these steps.

 1. Open your product image or key visual with an image editing program.
 2. Set the width of the product image or key visual between 100 and 800 pixels. In the 

example, the image width is 776 pixels.

Note: If your message template or paragraph is limited to a 
smaller width, do not exceed it. The countdown timer is not 
scaled to the maximum value of your message template or 
paragraph.

 3. Optional: Insert additional graphic elements into your image. A blue banner and a 
headline are inserted in the example.
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 4. Export the image as a JPEG or PNG.
 5. Create the area for the countdown timer. For this area, start with a new graphic file 

or continue working with your finished product image/key visual using the file in your 
image editing program (not in the exported JPEG or PNG!). Later only export the 
countdown timer area.

Tip: Continue to work on the product image/key visual file. This 
makes it easier to see the final result and how both parts will 
work together in your message.
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Warning: When creating an animated countdown timer
For the countdown timer area, avoid using complex graphic 
designs such as patterns, photo scenes, many colors and color 
gradients. This is because  Episerver Campaign will convert the 
JPEG or PNG into a GIF animation with 60 individual images. This 
GIF animation may not exceed 1.5 MB.
Even if you use a highly compressed JPEG with a file size of a 
few KB that contains many colors, the subsequently generated 
GIF animation may exceed the maximum size of 1.5 MB.
When creating a static, non-animated countdown timer
The maximum file size for the countdown timer area is 500 KB.

 6. To test the positioning of the countdown timer, which will come later, create a test 
timer with the testing tool for your image editing program.
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You can select among the following formats:

Static countdown timers

 l Days, hours, minutes, seconds (dd:hh:mm:ss)
 l Hours, minutes, seconds (hh:mm:ss)
 l Days, hours, minutes (dd:hh:mm)
 l Hours, minutes (hh:mm)
 l Days only (dd)

Animated countdown timers

 l Days, hours, minutes, seconds (dd:hh:mm:ss)
 l Hours, minutes, seconds (hh:mm:ss)

You can use the following fonts/typefaces:

 l Arial
 l Arial bold
 l Arial italics
 l Arial black
 l Arial Unicode MS
 l Comic Sans MS
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 l Comic Sans MS bold
 l Courier New
 l Courier New bold
 l Courier New italics
 l Courier New bold and italics
 l Times New Roman
 l Times New Roman bold
 l Times New Roman italics
 l Times New Roman bold and italics
 l Trebuchet MS
 l Trebuchet MS bold
 l Trebuchet MS italics
 l Trebuchet MS bold and italics
 l Verdana
 l Verdana bold
 l Verdana italics
 l Verdana bold and italics

Warning: Note the font and hexadecimal code for your font 
color. You will need this information later.

The example uses Arial font with the color white (#FFFFFF).

 7. Optional: Insert additional graphic elements into your test timer. The example 
places a border around the timer, labels the timer with days, minutes, hours and 
seconds, and inserts the text Offer ends in:.
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 8. If you are satisfied with your layout, remove the key visual from your graphic so that 
the area for the countdown timer stands alone. You can do this in Adobe Pho-
toshop, for example, using the crop tool. The example uses the crop tool to reduce 
the graphic to the area with the timer.
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 9. Remove the test timer by deactivating or deleting the corresponding layer. If you 
inserted other graphic elements, leave them activated. The example deactivates 
the layer with the test timer in Adobe Photoshop. The border, the timer labels and 
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the lines of text are still active.

Tip: Insert the final timer later in Episerver Campaign using the 
information you recorded regarding font and font color. The 
graphical representation of the area you created will later 
serve as the background for the final timer.

 10. Export the area or background for the timer as a JPEG or PNG. Make sure that the 
file size does not exceed 20 KB (approximate value). When creating a static, non-
animated countdown timer, the maximum file size is 500 KB. 

You have now prepared both parts of the countdown timer. Creating a countdown 
timer shows how to create the final timer in Episerver Campaign and place it on your 
background graphic.

Creating a countdown timer
Prerequisite: You prepared a background image, as explained in Preparing graphics.

 1. Open the start menu and select Special > Countdown timer. The Countdown timer win-
dow opens.
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 2. Click Create. The Create countdown timer window opens.

 l Name. Enter a name for your countdown timer.
 l End time. Enter the date (left part of box) and the time (right part of box) at 

which your countdown timer will end.
 l Format. Select the timer format and if your timer is animated or non-animated. 

See How it works.
 l Separator. Enter the separator you want to use between the counter digits. By 

default, the colon (:) is used. You can use a string of up to 5 characters. If you do 
not want to use a separator between digits, enter a space.
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 l Background color. Select a background color for the timer by entering a hexa-
decimal value or using the color selection tool. If you prepared graphics for the 
countdown timer, you do not need to enter a background color. The timer is 
then automatically set to have no background color for your background 
image.

 l Background image for running countdown timer. Upload a prepared background 
image (in JPEG, PNG, BMP or GIF format, with height and width values between 
100 and 800 pixels) by clicking Upload and selecting an image. If you followed Pre-
paring graphics, upload the second part of your top offer into the area you cre-
ated for the timer. You will use the prepared product image/key visual later. 
Then, you will combine the product image/key visual and the finished count-
down timer into a single graphic and insert it into your message (see Inserting a 
countdown timer into a message).

Note: Make sure to follow the design guidelines for back-
ground images.

 l Background image for finished countdown timer. To upload a background image 
(in JPEG, PNG, BMP or GIF format, with height and width values between 100 and 
800 pixels) to be displayed in your messages when the countdown timer has run 
out. Click Upload and choose an image. If you do not, when the time runs out, 
the background image for running countdowns is displayed with digits set to 
zero.

 l Width (in px). Enter the width of the timer background. If you uploaded a back-
ground image, its width is entered.
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 l Height (in px). Enter the height of the timer background. If you uploaded a back-
ground image, its width is entered.

 l Font. Select the font and the font style for the digits of the timer. If you followed 
the example in Preparing graphics, enter the font you used for the test timer in 
your image editing program.

 l Font size. Enter the font size of the timer in pixels (px), at least 12 px. If you fol-
lowed the example in Preparing graphics: enter the font size you used for the test 
timer in your image editing program.

 l Font color. Enter the font color for the timer as a hexadecimal code or use the 
color selection tool. If you followed the example in Preparing graphics, enter the 
font color you used for the test timer in your image editing program.

 l Left text margin (in px). Enter the distance between the timer and the left edge 
of the image. Use the preview to review the desired placement of the timer.

 l Top text margin. Enter the distance between the timer and the upper edge of the 
image. Use the preview to review the desired placement of the timer.

 3. Click Save. 
 4. Click Close. The Countdown timer window opens. If you select a created countdown 

timer from the list, a preview of the countdown timer is shown.

Inserting a countdown timer into a message
You can insert into a message a countdown timer by itself, or combine it with a product 
image/key visual to make a single graphic.
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Inserting a freestanding countdown timer

Note: The following instruction shows the procedure using the Tem-
plate Kit. If you use a custom template, the steps may differ.

 1. Select your message and click Edit. The Edit content window opens. 
 2. Click New: Content paragraph to create a new content paragraph. On the right, a 

window for selecting the paragraph type opens.
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 3. Click Text/Image. The configuration window for the selected paragraph type opens.

 4. Click Insert field function   in the Text area. A window opens with a list of field func-
tions saved in your client.

 5. Select the field function of the countdown timer you want to insert into your mes-
sage. Click OK.
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 6. Click Apply.

Tip: The countdown timer does not show in real time in the pre-
view. But, you can send a test message to yourself to preview 
the countdown timer before mailing the newsletter. To do so, 
click Test message in the upper right of the Template Kit.
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Combining countdown timer with a product image/key visual
If you prepared graphics for the countdown timer (see  Prepare graphics) and created 
the counter for the countdown timer (see Create a countdown timer), you can combine 
the product image/key visual and the countdown timer into a single graphic.

Note: The following instruction shows the procedure using the Tem-
plate Kit. If you use a custom template, the steps may differ.

The basic procedure places the product image/key visual and the timer separately into 
two paragraphs positioned one above the other, with no spacing between. For the 
combining process,  create a new grouping paragraph.

 1. Select your message and click Edit.
 2. Click New: Paragraph to create a new grouping paragraph in your message. On the 

right, a window for selecting the paragraph type opens.
 3. Click Grouping paragraph.

 4. Enter 0 under Layout, in the Space between content paragraphs box. 

Note: If you forget to enter 0 here, in some cases, your product 
image/key visual and the countdown timer will not be seam-
lessly combined.
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 5. Click Apply.
 6. To insert a new content paragraph for your product image/key visual into the group-

ing paragraph, click New: Content paragraph on the left side of the preview, under 
the new grouping paragraph. On the right, a window for selecting the paragraph 
type opens.
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 7. Click Text/Image.

 8. Open the Image tab, click Browse... and select an image in the file browser to 
upload your product image/key visual. If your visual is saved externally, enter the 
URL.

 9. Center the product image/key visual by selecting one of the centering options from 
the list found under Position, for example Centered below the link.
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 10. Click Apply.
 11. To insert another new content paragraph for the countdown timer into your group-

ing paragraph, click New: Content paragraph on the left side of the preview. On the 
right, a window for selecting the paragraph type opens.

 12. Click Text/Image.
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 13. Click Insert field function   in the Text area. A window with a list opens. The list con-
tains field functions that were saved in your client.

 14. In the list, select the field function for the countdown timer that you want to insert 
into the content paragraphs and click OK.
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 15. Click Center to center the inserted field function.

 16. To save your changes, click Apply.

Note: The countdown timer does not show in real time in the pre-
view, but you can send yourself a test message.
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 17. Before sending the message to recipients, check that the image merge is successful 
by sending a test message to yourself. 

Editing, copying, and deleting a countdown timer

Editing a countdown timer
 1. Open the start menu and select Special > Countdown timer. The Countdown timer win-

dow opens.
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 2. In the overview, select a countdown timer and click Edit. The Edit countdown timer 
window opens.

 3. Make your changes (see Creating a countdown timer).
 4. Click Save. 



© Episerver 2020

Managing content | 567

Copying a countdown timer
 1. Open the start menu and select Special > Countdown timer.
 2. copy and click Copy.
 3. Optional: Edit the copy  and give it a new name.
 4. Click Save. 

Deleting a countdown timer

Warning: Do not delete countdown timers that are in use in ongoing 
mailings.

 1. Open the start menu and select Special > Countdown timer.
 2. In the overview, select the countdown timer that you want to delete and click 

Delete. 
 3. Click Delete countdown timer. 

Troubleshooting countdown timers
The following are common errors that can arise while working with the countdown 
timers.

Tip: If the issue continues after you attempted the suggested solu-
tion, contact customer support.

Issue Possible cause Solution

In the message, 
the countdown 
timer is displayed 
wider than the 
product image, 
even though the 
original file for the 
countdown timer 
has the same 
width.

The global message width for 
your Episerver Campaign tem-
plate or your paragraph is smal-
ler than the width of the 
countdown timer.

Make the global width of the message or 
the width of the paragraph the same as 
the width of the countdown timer, or 
reduce the countdown timer width.
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Issue Possible cause Solution

A gap between 
the product image 
and the count-
down timer.

A margin is defined for your con-
tent paragraphs.

Set the margin for your content para-
graphs to 0.

Animated count-
down timers are 
not animated in 
Microsoft Outlook

Microsoft Outlook (version 2007 
and above) does not support 
animated GIFs.

Open the mailing in Microsoft Outlook 
using the View in browser view.

The generated 
animated count-
down timer 
exceeds 1.5 MB 
even though the 
uploaded back-
ground image is sig-
nificantly smaller.

Episerver Campaign generates 
an animated GIF with a total of 
60 images from the single back-
ground image. The file size 
increases exponentially and 
exceeds the factor 60 
because Episerver Campaign 
adds the timer for the count-
down timer to your back-
ground image.

Reduce the file size of your background 
image. The recommended maximum size 
is 20 KB. Also, avoid using complex 
graphic designs such as patterns, photo 
scenes, many colors, color gradients, and 
so on.    

Even if you use a highly compressed 
JPEG with a file size of a few KB, if it con-
tains many colors, the subsequently gen-
erated GIF animation may exceed 1.5 
MB.

The countdown 
timer is not anim-
ated.

A non-animated time format 
was selected in the countdown 
timer's settings.

Under Countdown Timer, select the 
affected countdown timer and click Edit. 
In the Settings area, in the Format drop-
down list, select  a time format that has the 
addition (animated) and click Save.

Click2Go

Note: To enable this feature, contact customer support.

Use Click2Go to create buttons for your mailings, with no HTML expertise, directly in 
Episerver Campaign's content management system. Click2Go is integrated directly 
into the Episerver Template Kit and can be used in any paragraph type. 
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Buttons are call-to-action elements with great potential for capturing attention and dir-
ecting readers to landing pages for products, campaigns, profile pages, and so on.

Tip: Test your button's potential
To test how much attention a button captures in the context of a 
mailing, use the automated attention analyses from Episerver Cam-
paign. Attention analysis indicates whether a button's location 
captures a high level of attention and directs readers to desired 
content.

Activating Click2Go
When Click2Go is activated, content paragraphs display a new Button tab. Design the 
buttons as described below, and test them using a test email.

Inserting and designing buttons
To insert a button into a paragraph and edit it, perform the following steps:

 1. Edit the paragraph in which you want to add a button.
 2. Select the Button tab in the top tab bar. The following areas are displayed:

 l Template. In this area, you can insert two button templates into your mailing. The 
templates are provided along with the Click2Go function. 

 l Options. In the tabs (described below), you can create a new button or edit an 
available template.

 l Preview. Shows the current design of your button in real time.

Tip: When you are finished, test your buttons in a test email.

General

Parameter Description

Text Enter the button text.

URL Insert a destination URL to which your button should link.                         
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Parameter Description

Note: If you do not name a destination URL, the button will 
appear in your messages.

Alignment Set the position of your button in relation to other content elements of your mailing.

Text

Parameter Description

Font type Select the text font.

Color To define the color of your button border, click the displayed value then set the 
desired color in the selection window.

Size To set your text size, adjust the value manually or via the slider.

Bold To make your text bold, select the check box.

Italic To make your text italic, select the check box.

Underline To make your text underlined, select the check box.

Background

Parameter Description

Color To select your button's background color, click the displayed value then select the 
color in the selection window.

Image

To select a background image for the button, click  Browse... and select the image 
from your computer. Alternatively, use the Alternatively external URL box.                         

Background images may not be displayed, depending on the email software and 
the recipient's security settings.
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Parameter Description

Note: If you select a background image, specify an addi-
tional background color as a fallback, in case the back-
ground image is not displayed.

Alignment Set the position of your background in relation to the other content elements.

Repeat Select an uploaded image to be repeated in various arrangements.

Symbol

Parameter Description

Image

To select a symbol for your button, click  Browse... and select the image from your com-
puter. Alternatively, use the Alternatively external URL box.                         

Background images may not be displayed, depending on the email software and 
the recipient's security settings.

Position Specify the position of the symbol in the foreground of your button.

Margin left Set spacing for your border's left side of  by adjusting the value manually or using the 
slider.

Margin 
right

Set spacing for the border's right side by adjusting the value manually or using the 
slider.
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Padding

Parameter Description

Top

Internal spacing (padding) indicates how much spacing is between the text and the 
outer edge of the button.                         

Change this value to change the size and visual appearance of the button. You 
can individually define the internal spacing for each side.

Bottom

Left

Right

Border

Parameter Description

Width To set the width of your border, adjust the value manually or use the slider.

Color To select the color of the button border, click the displayed value then set the desired 
color in the selection window.

Radius Define the shape of your button. A higher value produces rounder corners.

Easy Copy

Note: To enable this feature, contact customer support.

Save time by using the intelligent Easy Copy feature. When creating messages, apply 
individual paragraphs (including text and images) from other messages – from any cli-
ent. The imported content can be edited and adapted  to the new message.

Note: The source message and the target message must have the 
same paragraph structure. The source paragraph must be at the 
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same structural level as the target paragraph.

To copy content from other messages to a new message, perform the following steps 
while in the edit mode of the Template Kit.

 1. To the left of the message preview area, click New: Content paragraph. The right edit 
window shows a selection of paragraph types.

 2. Click Import paragraph. A new window opens. You are asked to select the source 
content.
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 3. In the Source client drop-down list, select the client that contains the message or 
message template that you want to import.

 4. In the Source content drop-down list, select the message or message template 
which contains the content you want to import.

Tip: If you are unsure of which message or message template 
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contains the content, click a message or message template in 
the overview list to preview its content.

 5. Select the message or message template containing the content you want to 
import.

Tip: To import content from several messages or message tem-
plates, repeat steps 1 to 8 after you complete an import from a 
message.

 6. Click Next. The Select paragraphs window opens.
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 7. Select the content you want to import by checking the relevant check box.

 8. Click Import paragraphs.  You can now edit the content.

Mobile Fusion

Mobile Fusion makes your templates fit for mobile devices. Up to 50 percent of internet 
users regularly read email on a mobile device. Display size and usability of these devices 
(using a touch screen instead of a computer mouse or track pad) lead to new 
paradigms in newsletter design. Mobile Fusion lets you add a mobile version to your exist-
ing template and make it fit smart phones and computers.

From a usability perspective, smart phones and tablet PCs are quite different from a tra-
ditional computer. Their display sizes are significantly smaller, depending on the type of 
device. So, the available space should be used optimally. Scrolling should be limited to 
vertical, not horizontal. To increase usability, images should be displayed as large as pos-
sible, that is "fit-to-screen." Avoid a floating layout or columns. Finally, the newsletter 
should support the optional switch from portrait to landscape mode by rotating the 
device.



© Episerver 2020

Managing content | 577

Checklist for a mobile version of your newsletter
 l Layout's minimum width is 320 pixels
 l Additional layout for a maximum width of 480 pixels recommended
 l Adaption of the layout to full-screen mode
 l Images displayed at optimal size
 l Single-column layout preferred
 l Automatic detection of display width used to adapt the newsletter layout

Adapting your template
You can adapt any newsletter template to a mobile layout. Episerver offers a full-ser-
vice adaptation, where you get everything "from scratch." Or, send Episerver your 
mobile layout and let us implement it into your template. 

Full-service adaptation
 1. You indicate the template you want to adapt for a mobile version.
 2. Episerver creates a layout with flexible widths (two widths, flexible display according 

to display size) or another layout using fixed width.
 3. You choose a layout.
 4. Episerver implements it into the template.
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Benefits

 l You get everything from one source and benefit from Episerver's experience in tem-
plate design.

 l You can be confident that Episerver's layouts work in your template.

Implementing your own layout
 1. You indicate the template for which you want to implement a mobile version.
 2. Episerver checks if the indicated template is suitable for flexible width or fixed width 

mobile layout.
 3. You provide a layout with flexible or a fixed width.
 4. Episerver implements the layout into the template.

Note: The mobile layout's e Elements must follow the same order 
and structure as the HTML layout. For example, you cannot change 
the position of an image above text to a position within text.

Flexible vs. fixed-width
Ideally, mobile layouts are implemented with a flexible width that adapts to the display 
size  ("fit-to-screen"). The best way to achieve this is a flexible layout using two widths. 
Any width in between the two is scaled to fit automatically, so the available display 
space is used optimally. At a defined width between the two defined values, the layout 
switches from one to the other. Displays with a higher resolution use the regular HTML lay-
out.

Note: For complex template layouts, such as where text is rendered 
into an image, a flexible width layout cannot be implemented. 
Episerver offers a fixed layout width for your mobile version.

Layout                     Width                     

Flexible width 320 / 480 px

Fixed width 320 px

The above are default values. If you want different values, contact customer support.
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Optimizing newsletters for mobile devices
the Episerver Template Kit is optionally available with Mobile Fusion, which applies the 
Template Kit's flexibility to the mobile version of your newsletters. This section helps you 
design mobile newsletters and integrate them into the mobile version of your mailings.

Prerequisites
 l If you have not installed Mobile Fusion or are not currently using the Template Kit, 

contact customer support to get Mobile Fusion with the Template kit.
 l Template Kit describes paragraphs, setup and configuration of the Template Kit, 

including mobile options.
 l Mobile Fusion describes design options for the mobile layout of newsletters.
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What does the Template Kit with Mobile Fusion offer?
 l Enable or disable mobile version. If you enable the mobile version, Episerver Cam-

paign automatically generates a version of your mailing optimized for mobile 
devices; this increases the size of each emailing. See General settings.

 l Place the sidebar above/below the main body. In each paragraph, you can indicate 
whether to display the sidebar (if present) before or after the main body. See Group-
ing paragraphs.

 l Hide/display paragraphs in the mobile version. You can indicate, by paragraph, 
whether to integrate that paragraph into the mobile version. You can also indicate 
if a paragraph should appear in the mobile version only. See Content paragraphs.

 l Set paragraph width in the mobile version. You can set the width of each paragraph 
(in %) for mobile display. See Content paragraphs.

 l Set the width of paragraph separation in the mobile version. You can set the width of 
the paragraph separators (in %) in the general settings for the template. See Gen-
eral settings.

Creating mobile versions

 1. Create a click profile for the mobile version.        

You can also specify a click profile for the mobile version to later evaluate how many 
recipients clicked it. Create a click profile and select this profile by accessing the 
Mobile tab of the template's general settings > Click profile drop-down list.

Tip: Landing pages
Mobile Fusion also automatically creates mobile versions of 
landing pages and SWYN pages. The mobile versions of landing 
pages can also be adapted using the settings described here.

 2. Create the desktop version first.       

Before creating a mobile version of a mail, create the desktop version. The default 
settings for Mobile Fusion were selected for the template kit so that content para-
graphs are automatically copied to the mobile version. The sidebar is displayed 
beneath the main content area; the table of contents is hidden. You can change 
default settings later.
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 3. Hide content that should not appear in the mobile version.        

You can enable individual paragraphs for the mobile version. By default, this option 
is already active for paragraphs, except for the table of contents. To make your 
mobile newsletter more compact, remove selected paragraphs from the mobile 
version by removing the Show in mobile version check mark.

Note: Do not hide main elements such as the header, footer or 
editorial, to ensure that the mobile newsletter remains com-
plete.

 4. Create alternative paragraphs for the mobile version.

Some content paragraphs may not display correctly or as desired in the mobile ver-
sion, because the images look awkward  or the paragraph has too much text. To 
add these paragraphs to the mobile version,  create two variants—one for desktop 
viewing and one for mobile viewing. Deactivate the unused view in the settings of 
both paragraphs.

Note: Only use this option if adjustments to the mobile layout 
did not result in desired effect. Also, make sure that only one 
paragraph version appears in the newsletter. 

 5. Add paragraphs to be displayed in the mobile version only.

To send information only to recipients with mobile devices, add a paragraph at the 
corresponding position and hide this paragraph in the desktop version by clearing 
the Show in desktop version check box.

Note: Do not hide important content in the desktop version.

 6. Position the sidebar.

In the mobile version, the sidebar of a structuring paragraph is displayed above or 
beneath the main content area for display purposes. This causes the arrangement 
of elements to shift.

If you insert a table of contents or the newest messages into the sidebar, display the 
sidebar above the main area or to hide the table of contents in the mobile version. 
Test to see whether the content of the mobile version is displayed in the correct 
order. 

When using multiple structuring paragraphs in a single mail, you can configure this 
setting separately for every structuring paragraph.
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 7. Adjust the paragraph width for the mobile version.        

You can create a multi-column layout by specifying a percentage width for con-
tent paragraphs in the mobile version. This setting only takes effect if you adjust the 
width in two consecutive paragraphs so that you get 100% width. You can use this 
option to force an image to be displayed next to a specific text. 

Use a paragraph with an image and another paragraph with a text for this purpose. 
Then, specify 30% width for the image paragraph and 70% width for the text para-
graph. Only use this option for short texts and simple images or graphics, as multi-
column layouts reduce the visual quality and readability for mobile viewers.

Tips for optimizing the mobile version

 l Optimize the general settings of the template. You can select spacings, borders, 
colors and other configurations. Most  settings, except the newsletter's width and 
outer edge, are copied to the mobile version. You can also change the appear-
ance of the mobile version using these settings.

 l Test the newsletter using Outlook. The HTML and mobile preview shows a simulated 
view of the mail in email programs and on mobile devices. The actual view var-
ies depending on software and hardware. Views provided by Microsoft Outlook 
2007 or  2010 are a good indicator for the correct display of the newsletter. If 
Outlook displays correctly without errors, it is likely that other programs and web 
mailers also display the mail as intended.

 l Change to the mobile view in editing mode. You can change between the 
desktop and mobile view by making the editing window in Episerver Campaign 
smaller and decreasing the width using the cursor. When the window width is less 
than 600 pixels, the view changes to the mobile view.

 l The mobile version may not display uniformly in all email applications and can 
deviate from the preview layout or the testing emails.

Tips and possible sources of error

Desktop version

The desktop version of this newsletter is the basis for the mobile version. If the mobile ver-
sion is activated, paragraphs are copied into the mobile version by default.
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Mobile version 1

This mobile version is created from the desktop version with minor adjustments.
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Mobile version 2

In this adjusted mobile version, a table of contents is displayed. The two small para-
graphs after the editorial were positioned next to each other, both with a width of 50%.
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Mobile version with errors

This mobile version contains common errors. You should check the mobile view of your 
newsletter and, if possible, test it using mobile devices to avoid such mistakes.

The width of this paragraph is set to 50%. But the width of the following paragraph was 
unchanged. So, the first paragraph only occupies half of the available width and cre-
ates a gap. For both paragraphs to be adjacent, adjust the width of the following para-
graph so that both add up to 100%.
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Attachments

The attachments function provides an overview of attachments and images saved in 
the Episerver Campaign content database, and also lets you edit those files.

To access the content overview, open the start menu and select Campaigns > Attach-
ments.

You can perform the following actions:

 l New

Click New to import an image or attachment.

 l Edit

 1. In the overview, click an image or attachment.
 2. Click Edit. The Edit Image/Edit Attachment window opens.
 3. Enter a new file name for the image or a new file name and a description for the 

attachment.

Tip: The name you apply to the file should match the original 
file, so as not to confuse the mailing recipient.

Note: Do not use uppercase, spaces, umlauts, or special 
characters, and add the file extension. Otherwise, the 
attachment does not load correctly. Example: flowers_for_
you.pdf.

 4. If you want to change the file, that is, use another file (by uploading a new file or 
specifying another URL), click  Previous and make the change.

 5. Click Save. 
 l Delete

 1. In the overview, click an image or attachment.
 2. Click Delete.

 l Deselect

Click Deselect to deselect the image or attachment.
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Categories
Click the Image tab to display images, or the Attachment tab to display attachments.

Images
The Images overview displays the following information:

 l Name. The file name.
 l URL. Where the image is stored. If it is physically uploaded to Episerver Campaign, 

the URL is an internal URL (http.//img.example.com/...). If you selected Use URL, the 
file's original URL  is shown.

 l Width/Height. The image's dimensions (in pixels).
 l Location. Indicates whether the image is stored on Episerver Campaign (server) or 

located externally.
 l Preview. Shows a preview of the image (scaled down in most cases).

Attachments
The Attachment overview displays the following information:

 l Description. The attachment description.
 l File name. The file name.
 l URL. If you selected Use URL while importing the attachment, the file address 

appears. If the file was physically imported into Episerver Campaign, this field is 
empty.

 l Location. Indicates if the file is stored on the Episerver Campaign (server) or located 
externally.

 l Type. The file format (PDF, DOC and so on). This is the original file format as recog-
nized by Episerver Campaign when the file was added, not the format you applied 
while naming it.    

Tip: The type you apply to the file should match the original file, 
so as not to confuse the mailing recipient.

 l Size. The file size in bytes. Use discretion with the file size, so recipients are not 
annoyed by large attachments.
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Adding an image
This window lets you import images into Episerver Campaign. These are available when 
new mailings are created.

Note: The image's file format must be .gif, .jpg, .jpeg or .png.

 1. Open the start menu and select Campaigns > Attachments.
 2. Open the Image tab and click New.
 3. Select one of the following options: 

 l Upload from hard drive. Upload an image from your computer to Episerver Cam-
paign. The image is still available even if your local version no longer exists.

 l Use URL. The URL defines image's location. The image is not physically imported 
into Episerver Campaign. Mailings include only a link to the image.

Only choose this option if you are sure the image is available at the address.

 4. Click Next.

 l If you selected Upload from hard drive, click Browse and select a file from your 
computer.

 l If you selected Use URL, enter the web address where the file can be found, 
beginning with http://.

 5. Click Next.

A progress bar indicates that the file is uploaded.

 6. In the Image name box, enter a name that helps you recognize the image when cre-
ating a mailing or in the content overview.

 7. Click Save.

Adding an attachment
This window lets you import any files into Episerver Campaign. These are later available 
when new mailings are created.

 1. Open the start menu and select Campaigns > Attachments.
 2. Open the Attachment tab and click New.
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 3. Select one of the following options: 

 l Upload from hard drive. Upload a file from your computer to Episerver Campaign. 
The file is available even if your local version no longer exists.

 l Use URL. The URL defines the file's location. The file is not physically imported into 
Episerver Campaign. Mailings include only a link to the file.

Only choose this option if you are sure the file is available at the address.

 4. Click Next.

 l If you selected Upload from hard drive, click Browse... and select the desired file 
from your computer.

 l If you selected Use URL, enter the web address where the file can be found, 
beginning with http://.

 5. Click Next.
 6. In the File name box, enter a name that helps you recognize the file when creating a 

mailing or in the content overview.  Maintain the file extension (.pdf or .doc) so recip-
ients recognize the file type.

 7. In the Description box, enter a file description. 

Tip: The description is used internally and is not part of the mail-
ing.

 8. Click Save. 

Sending personalized attachments
Personalized attachments let you include attachments to particular recipients when 
sending transactional mails. For example, you can send  invoices or order confirmations.

Before sending, transmit the attachments to Episerver Campaign via HTTP API. 

Prefix or suffix subject line

Note: To enable this feature, contact customer support.

https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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This add-on automatically adds a prefix or suffix to the subject line of any mailing. For 
instance, the suffix "TEST" may be added to each test email subject line.

Uploading files

Note: To enable this feature, contact customer support.

Upload a file (such as a CSV file) manually into your Episerver Campaign client. This fea-
ture is an alternative to the automatic file exchange via FTP API, in cases where the auto-
matic exchange is not possible. 

The uploaded file can contain any content and is processed internally according to the 
file name and the processes and jobs associated with this file name. For example, 
upload product data if you use a content interface and update product details manu-
ally.

Updating mailing content prior to dispatch

Note: To enable this feature, contact customer support.

Days may pass between a mailing's creation date and its dispatch date. This delay can 
cause content to be out-of-date, such as a product that is no longer available. 

This add-on verifies the imported content in the mailing when it was created. Product 
information is validated with the help of a unique product ID. 

Also, if a product is not available at dispatch, or if  some information is incorrect, the 
add-on pauses sending.

Note: This add-on requires a content interface.
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Publish mailing

Note: To enable this feature, contact customer support.

This add-on publishes a mailing or parts of a mailing into another client or template. It is 
a useful tool for reusing content from an existing mailing in another context or client.

Video emails

Incorporating videos into a mailing is a great way to get the recipient's attention and sur-
prise them with your creativity. Videos are better than both text and still images at show-
ing a recipient what he wants to know, in very little time and without requiring a word. 
Videos convey the value of your products much better. 

For example, using a 360 degree view, you can demonstrate the features and design of 
a new product. Videos are also a great tool for obtaining higher response rates and guid-
ing recipients to specific landing pages.

Video email tips
 l An email teaser should be no longer than 20 seconds.
 l Landing page videos should be no longer than 60 seconds.
 l Rapid intercutting between images attracts greater attention.
 l Use animation in intros, animate info graphics and transitions.
 l Place a call-to-action at the end of a video.

Tools for incorporating videos into emails

Note: The Flash format is not a suitable option for videos in emails, 
because most email programs block Flash applications for security 
reasons. However, there are other ways to incorporate moving 
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images into emails.

Animated GIF
This is the best format for showing a video directly in an email, because many email pro-
grams can play GIFs without difficulty. Compared to other formats, the quality of anim-
ated GIFs is limited and they do not allow audio playback.

A comparison of advantages and disadvantages shows that animated GIFs can be used 
primarily as teasers lasting only a few seconds. To incorporate full videos, add a play-
back button to animated GIFs, linked to a landing page. The email should explain that 
there is no audio playback.

Advantages Disadvantages

 l Videos run directly in an email
 l Broadly supported by current email pro-

grams and web mailers
 l Unsupported email programs (such as 

Microsoft Outlook) display the first frame as 
a fixed image (fallback)

 l No audio
 l Limited quality (in terms of color intensity, 

image frequency)
 l No compression (i.e. file size increases 

proportionally with frame rate, each indi-
vidual image is stored)

 l No control elements

Note: The width of the GIF must be less or equal to the width of the 
content paragraph in your mailing. Example: If you are adding a 
GIF with a width of 650 pixels to a Text/Image paragraph with a con-
tent width of 600 pixels, the GIF will be compressed and lose its 
animation.

Landing page
Rather than integrating a video into an email, insert a screenshot from the video (such 
as the opening image) into a newsletter, along with a playback button that links to a 
landing page containing the video. You can couple this variant with an animated GIF. 
The recipient sees a moving image in the email with a teaser lasting several seconds. If 
he/she clicks on it, the actual video starts running in the landing page.



© Episerver 2020

Managing content | 595

Advantages Disadvantages

 l Simplest way of linking videos and 
emails

 l Supported by current formats (Flash, 
MP4, HTML5)

 l Practically unlimited video length and 
quality

 l Video and audio
 l Control elements may be used
 l Does not require videos to be adjus-

ted to your newsletter's specific 
format

 l Large videos or high click rates require a host-
ing service

 l This sort of "fake player" can irritate recipients, 
who may expect the video to run in the email

To accommodate recipients who set their email programs to suppress images, include 
a text link to the video in addition to the fake player. To avoid irritation caused when 
the video begins running in the browser rather than in the email, include a note indic-
ating that the video will run externally.

YouTube videos
Several email programs (Google Mail, Outlook, Yahoo) allow videos hosted on YouTube 
to be played back directly in an email.

Advantages Disadvantages

 l Videos are hosted on a widely 
used platform

 l Supported by many email pro-
grams (playback in the email)

 l Video URLs may not be substituted with tracking 
URLs, to ensure reliable identification

 l Identified URLs are extracted; does not allow incor-
porating the player into email

Videos recognized by email programs are displayed across or at the bottom of the 
body of an email. If the recipient clicks the link, the video generally starts running in a 
layer (Lightbox).

HTML5 video
Mobile devices in particular, like iPhones and iPads, run videos in their email programs.
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Advantages Disadvantages

 l Allows embedding of high-qual-
ity videos.

 l Audio track.
 l Displays control elements.

 l Not supported by many email programs.
 l Only useful as a supplement in combination with 

other options.

HTML5 videos can be combined with animated GIFs or a landing page to enable recip-
ients to play back videos. HTML5 video tags and an image tag with an animated GIF or 
fake player are incorporated into the email source code. The relevant variant is then 
delivered to the recipient, according to the type of email program he/she uses. Insert 
the HTML code snippet directly into the email, for example into the source code para-
graph of the Template Kit.

Testing and evaluation – Finding the right technical imple-
mentation
To give your video email strategy the greatest opportunity for success, you can test how 
well each integration method works by applying split tests to a representative sampling 
of your recipients. This is an easy way to determine the best  approach for embedding 
videos and which offers the highest conversion rates.

The chart below shows a split test with results for the variants described above.

Video embedding Split A Split B Split C

Animated GIF and landing page ✓ ✓* ✓*

Landing page with embedded video ✓ ✘ ✘

HTML5 video ✘ ✓ ✘

Youtube video ✘ ✘ ✓

Note: The animated GIF in Split B and Split C should be included as 
a fallback option; recipients who cannot display the embedding 
variant used only see an animated GIF.
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Reporting

Evaluating clicks on video links is easy using conventional tracking. Depending on the 
technique being used, you also can collect data on playback time and playback rate. 
At minimum, measure conversion and click-through rates to evaluate the effectiveness 
of your videos. In particular, assess the following steps/actions:

 l Recipient clicked on the landing page in the newsletter
 l Recipient ran video (web analysis accessibility required)
 l Time spent on landing page (web analysis accessibility required)

To assess how many recipients made a purchase after viewing a video, set up a seg-
ment in your web analysis software that links two actions:

 1. Recipient made a purchase in the product category.
 2. Incoming page (the page clicked on to reach the product page) equals video land-

ing page.

Incorporating videos into a mailing
This example uses a mailing containing an animated GIF teaser that links to a landing 
page with a full-scale, high-quality video. The animated GIF is created from a short 
sequence taken from the video and loaded into the mailing as a normal image file. This 
animated GIF is set in a text/image paragraph, together with the teaser text. The mail-
ing would appear this way in an inbox:
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The animated GIF links to a landing page. The full, high-resolution video is integrated 
into this landing page. The video itself can be hosted on YouTube, Vimeo or another host-
ing service. These services supply a snippet of code that you insert into the source code:

http://youtube.com/
https://vimeo.com/
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How to create a video mailing with an animated GIF and landing page: 

 1. The video must be in a standard format. You get best results using the widely avail-
able and high-quality MP4 format.

 2. Load the video to a hosting service (such as YouTube or Vimeo), if you are not host-
ing it yourself.

 3. Create an animated GIF to use as a teaser. Animated GIFs can be created using 
standard editing programs like Adobe Photoshop.

Note: The width of the GIF must be less or equal to the width of 
the content paragraph in your mailing. Example: If you are 
adding a GIF with a width of 650 pixels to a Text/Image para-
graph with a content width of 600 pixels, the GIF will be 
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compressed and lose its animation.

 4. Set up a mailing in the client where you want to insert the teaser.
 5. Create a landing page based on this mailing.
 6. Switch back to the mailing and insert a text/image paragraph. Upload the anim-

ated GIF in the Image tab and compose the paragraph in the usual manner.
 7. Select the landing page from the list in the Link field.
 8. If needed, add a note indicating that the video will open in an external browser win-

dow.
 9. Open the landing page and insert a source code paragraph containing the code 

snippet that embeds the video. You can get this code snippet from YouTube by 
going to the video and clicking Share and then Embed. You can get the code from 
Screencast by hovering over the video icon and then clicking  Share.

 10. Save and test the mailing.
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Recipients

This section shows how to manage active and inactive recipients, create target groups 
and send personalized content to customer segments.

 l Recipients overview. Functions for working with recipient datasets.
 l Recipient lists. Copy, edit and clear recipient lists.
 l Target groups. Generate, utilize and analyze segments.
 l Opt-in. Information on the opt-in procedure.
 l Recipient history. Display mailing progress with individual recipients.
 l Export mailing and performance data. Export response data as CSV or XML.
 l Click profiles. Create, edit and assign click profiles.
 l Returned emails. View bounces and replies.
 l Blacklist overview. Manage the blacklist.
 l Change email addresses. Change recipient ID.
 l Export recipients by category. Export recipients to a CSV file according to category.
 l Importing recipients by category. Synchronize recipients from external sources with 

Episerver Campaign.
 l Preference Center. Set up a Preference Center for profile self-administration.
 l Connect for Campaign. An add-on that connects Episerver CMS, Episerver Forms, 

and Episerver Campaign.

Recipients overview

To open the recipients overview, open the start menu and select Recipients > 
Overview.The recipients overview provides access to functions for working with recipient 
data sets.

 l Show recipient datasets. Select a recipient list.
 l Filter selected datasets. Select a target group from the Target group list and click 

Apply.
 l Search. To search for a recipient or key word within a dataset, enter a search term 

into the Free text search box and click Apply.
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 l Create recipient. 

 1. Click Create recipient. An row of input boxes appears.
 2. Enter data for the new recipient.         
 3. Click Confirm. The list is re-sorted. See also Add element.

 l Edit recipient. 

 1. Select a recipient from the list and click Edit recipient.  Editable fields change to 
input boxes.

 2. Click Submit.
 l Delete recipient. 

 1. From the list, select a recipient and click Delete recipient.
 2. Confirm.

Note: Only use Delete recipient to remove a recipient whose 
email address does not exist. Recipients who should not receive 
email from you because of a complaint should be added to 
the blacklist.

 l Blacklist recipient. See Blacklist overview.

 1. Select a recipient from the list and click Blacklist recipient.  The Blacklist recipient 
dialog box appears.

 2. Optionally, enter a blacklisting reason, such as, complaint by telephone.
 3. Click Apply.  The recipient is added to the blacklist.

 l Anonymize tracking. 

Note: To enable this feature, contact customer support.

Lets you deactivate personalized click and link tracking for a recipient. If you do, 
the person who is no longer included in action-based target groups (that is, has 
clicked link B in mailing A), even if they meet the target group's conditions.

 o To deactivate personalized tracking for a recipient, select a recipient and click 
Anonymize tracking. 

 o In the dialog box that opens, confirm.

Note: Personal action-based data is anonymized from the 
time of activation. Action-based data from the recipient his-
tory is not retrospectively anonymized. If you later 
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reactivate personalized tracking, anonymized action data 
is not restored and assigned to the recipient.

 l Download recipient. If you have permissions to download recipient lists, you can save 
recipients in a recipient list or a selected set of recipients to a CSV file by clicking 

Save   at the bottom of the list.

Warning: Take care when handling the downloaded data
A recipient list or set of recipients downloaded with this func-
tion also contains data for unsubscribed recipients, blocked 
recipients, and recipients for whom the bounce limit is 
exceeded. Do not use this dataset for sending messages or 
mailings from other clients or mailing systems. To export only 
active recipients in a recipient list, use Recipient export instead.

Importing recipients

Import a file that contains recipient data using a CSV file. If the source file is not in this 
format, or to export recipient data from your local database or CRM first, ask your IT 
department for assistance. If the source file is a spreadsheet, convert it to CSV with the 
Save as command.

Tip: Test import
Before importing, run a test import to check recipient list data and 
the correct assignment to a Episerver Campaign recipient list.

To import your recipient data, follow these steps.

Step 1: Start the process
 1. Open the start menu and select Recipients > Import.
 2. Click Browse and select the file with the recipient data.
 3. Click Next. The file is uploaded to the Episerver server.
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Step 2: Select a recipient list

 1. In the Select recipient list area, click the list to which you want to import new recip-
ients.

Note: If you want the recipients to be imported to go through 
an opt-in process, you must select an opt-in recipient list. You 
can make further settings for the opt-in process in step 4.

 2. In the File options area, specify the characters your CSV file uses to separate the 
entries.        

 l Separator. Select the character (semicolon, comma, tabulator and so on) that 
separates data fields on the lines of the uploaded file.

 l Escape character. Some database programs use a single quote (') or double 
quote (") around each data field when exporting. Select which one is used in 
the uploaded file.

 3. Click Next.

Tip: You cannot add new recipient lists. New recipients are added 
to an existing list.
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Step 3: Set the mapping
You must assign each column of the recipient list to a corresponding column in the 
imported recipient list. The left column of the Row Mapping tab lists fields of the  Episerver 
Campaign recipient list into which you are importing. The right column contains column 
headers from the imported list. 

 1. Assign fields according to their content. Typically, Episerver Campaign suggests the 
correct assignment (such as matching first name with first name). However, if first 
name in the recipient lists corresponds to name in the file, you must select the cor-
rect assignment.

 2. If you prefer to import data fields selectively (for example, only recipients' last 
names have changed), select the --- option  for fields that should not be changed. 

 3. Select the Fixed value check box to change the pop-up menu  to an entry field in 
which you can enter any text or value. This value or text is then imported into the cor-
responding field for each record. 

For example, you generate email addresses of newsletter subscribers through your 
website as well as other sources (cooperation partners and so on). If you import 
records supplied by a cooperation partner, use the Origin field to indicate the part-
ner's name or a corresponding code, so you can track the subscription's origin. You 
can also  evaluate the activity of subscribers from various sources.
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For another example, if your recipient list also contains fax and mobile numbers, 
enter a country code for these fields during import if the imported numbers do not 
contain them. The country code is automatically prepended to the telephone num-
ber, and the telephone number may be standardized (eliminating the 0 before the 
area or network code).

 4. After making the settings, click Next.

Step 4. Set import type and import options

 1. In the Select import type area, select the import type. 

Depending on the configuration of your client and your user authorization, you may 
see only some  options.

 l Simple import. Imports new recipients into your list. Existing records, unsubscribes 
or blacklisted recipients are skipped.

 l Import new recipients and update existing records. Default import type. New recip-
ients are added to the recipient list. Existing records are checked and updated 
as required. Episerver Campaign identifies recipients by recipient ID, usually 
email address. If a recipient's email address has changed, he is imported again, 
becauseEpiserver Campaign does not recognize it as an existing recipient.

 l Update only. Does not import new recipients. Only updates existing records as 
needed. If a recipient's email address changed, the recipient is skipped, 
because Episerver Campaign does not recognize it.

 l Clear recipient list before importing. Overwrite existing recipient list in Episerver 
Campaign with data from the uploaded file. You should upload your complete 
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address data.

Overwriting can be practical if recipients can unsubscribe both by clicking in 
the newsletter and through the call center. In this case, the unsubscribe inform-
ation must find its way to Episerver Campaign so that these recipients are unsub-
scribed and receive no further mailings. If your call center deletes a record from 
your database or CRM software, you can guarantee that this recipient is 
deleted by selecting Clear recipient list before importing.

 2. In the Set import options area, select one or more of the following import options:         

 l Skip first row. Often, the uploaded file has field names in the first row. Select to 
skip the table headers and start importing with the second row.

 l Import unsubscribers. If this option is available, you can import recipients who are 
already marked as unsubscribed  in your  client. Newly-imported recipients 
receive mailings right after importing them with this import option.

 l Import global unsubscribers. If this option is available, the Import unsubscribers 
option only affects the delivery channels (media types) of the selected recip-
ient list. If you activate both options, you import recipients that globally unsub-
scribed from all delivery channels.

Note: This option is only active together with the Import 
unsubscribers option.

Note: Permission is required for recipients. Do not send news-
letters to unsubscribed recipients, if no permission (opt-in) exists.

 3. Add opt-in processes if you want to import recipients from a source that is not linked 
to an automatic opt-in process, such as from a telephone campaign. Select Stand-
ard for a Single Opt-In process or DOI for a Double-Opt-In process. Imported recipients 
receive a welcome or a confirmation email with an activation link. You can select 
this option only if the confirmation mailing is set up and edited beforehand.

Note: Only import recipient lists once
If a double opt-in process is selected, imported recipients only 
appear in the list after they have clicked the activation link in 
the confirmation email. Episerver Campaign automatically 
sends this email after the import, if an opt-in process is selected. 
Only import recipients once, even if they do not appear in the 
list after the import. Otherwise, a confirmation email is sent 
each time you carry out an import.

 4. Click Import. The Import starts and the Import tab opens.
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Step 5: Import the data

When the import is finished, Save   appears next to each category for which records 

were found. Click Save    to download those records. 

The number of processed records and the import result are listed for each category:

 l Records processed. Number of processed records.
 l Records added. Number of newly added records.
 l Records updated. Number of updated records.
 l Records skipped (error in file). The column assignment did not correspond with the 

selected values in the third step. For example, a record may contain only three 
columns instead of the indicated four columns.
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 l Records skipped (error in list). Number of skipped records; because they already exis-
ted, no changes were found, or you selected the option Update only and new 
records were found in the list.

 l Records skipped (on blacklist). Recipients that are blacklisted. Depending on your cli-
ent hierarchy, there might be several blacklists. A blacklisted recipient might not 
appear in the blacklist of your client, but be blacklisted on the list of the main client.

 l Records skipped (exceeded the bounce limit). Recipients that exceeded the bounce 
limit.

 l Records skipped (prior unsubscribes). Recipients who previously unsubscribed.
 l Records skipped (prior target group). The recipients were not imported because your 

client or the confirmation email (confirmed or double opt-in) uses target groups 
that do not match.

 l Duplicates in file. Recipients only imported once to avoid duplicates in the recipient 
list.

 l Records already in recipient list. Recipients already in the recipient list are skipped to 
avoid duplicates.

 l Erroneous records. Episerver Campaign validates data  when importing them. Erro-
neous records may contain invalid characters or, in case of email addresses, a miss-
ing @ symbol or an invalid domain. Such records are not imported.

Trial import

Use trial import to  determine how many recipients in a file are recognized by Episerver 
Campaign versus how many are new.

Note: Unlike import, no changes are made to a recipient list during 
a trial import.

Step 1: Start the process
 1. Open the start menu and select Recipients >Trial import.
 2. Click Browse and select the file with the recipient data.
 3. Click Next. The file is uploaded to the Episerver server.
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Step 2: Select a recipient list

 1. In the Select recipient list area, click the list to which you want to import new recip-
ients.

 2. In the File options area, specify the characters your CSV file uses to separate the 
entries.        

 l Separator. Select the character (semicolon, comma, tabulator and so on) that 
separates data fields on the lines of the uploaded file.

 l Escape character. Some database programs use a single quote (') or double 
quote (") around each data field when exporting. Select which one is used in 
the uploaded file.

 3. Click Next.

Tip: You cannot add new recipient lists. New recipients are added 
to an existing list.
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Step 3: Set the mapping
You must assign each column of the recipient list to a corresponding column in the 
imported recipient list. The left column of the Row Mapping tab lists fields of the  Episerver 
Campaign recipient list into which you are importing. The right column contains column 
headers from the imported list. 

 1. Assign fields according to their content. Typically, Episerver Campaign suggests the 
correct assignment (such as matching first name with first name). However, if first 
name in the recipient lists corresponds to name in the file, you must select the cor-
rect assignment.

 2. If you prefer to import data fields selectively (for example, only recipients' last 
names have changed), select the --- option  for fields that should not be changed. 

 3. Select the Fixed value check box to change the pop-up menu  to an entry field in 
which you can enter any text or value. This value or text is then imported into the cor-
responding field for each record. 

For example, you generate email addresses of newsletter subscribers through your 
website as well as other sources (cooperation partners and so on). If you import 
records supplied by a cooperation partner, use the Origin field to indicate the part-
ner's name or a corresponding code, so you can track the subscription's origin. You 
can also  evaluate the activity of subscribers from various sources.

For another example, if your recipient list also contains mobile numbers, enter a 
country code for these fields during import if the imported numbers do not contain 
them. The country code is automatically prepended to the telephone number, and 
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the telephone number may be standardized (eliminating the 0 before the area or 
network code).

 4. After making the settings, click Next.

Step 4. Set import type and import options

 1. In the Select import type area, select the import type. 

Depending on the configuration of your client and your user authorization, you may 
see only some  options.

 l Simple import. Imports new recipients into your list. Existing records, unsubscribes 
or blacklisted recipients are skipped.

 l Import new recipients and update existing records. Default import type. New recip-
ients are added to the recipient list. Existing records are checked and updated 
as required. Episerver Campaign identifies recipients by recipient ID, usually 
email address. If a recipient's email address has changed, he is imported again, 
becauseEpiserver Campaign does not recognize it as an existing recipient.

 l Update only. Does not import new recipients. Only updates existing records as 
needed. If a recipient's email address changed, the recipient is skipped, 
because Episerver Campaign does not recognize it.

 l Clear recipient list before importing. Overwrite existing recipient list in Episerver 
Campaign with data from the uploaded file. You should upload your complete 
address data.
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Overwriting can be practical if recipients can unsubscribe both by clicking in 
the newsletter and through the call center. In this case, the unsubscribe inform-
ation must find its way to Episerver Campaign so that these recipients are unsub-
scribed and receive no further mailings. If your call center deletes a record from 
your database or CRM software, you can guarantee that this recipient is 
deleted by selecting Clear recipient list before importing.

 2. In the Set import options area, select one or more of the following import options:         

 l Skip first row. Often, the uploaded file has field names in the first row. Select to 
skip the table headers and start importing with the second row.

 l Import unsubscribers. If  this option is displayed, you can import recipients who are 
marked as unsubscribed in your  client. Newly-imported recipients receive mail-
ings right after importing them with this import option.

Note: Permission is required for recipients. Do not send news-
letters to unsubscribed recipients, if no permission (opt-in) exists.

 3. Add opt-in processes if you want to import recipients from a source that is not linked 
to an automatic opt-in process, such as from a telephone campaign. Imported 
recipients receive a welcome or a confirmation email with an activation link. You 
can select this option only if the confirmation mailing is set up and edited before-
hand.

Note: Only import recipient lists once
If a double opt-in process is selected, imported recipients only 
appear in the list after they have clicked the activation link in 
the confirmation email. Episerver Campaign automatically 
sends this email after the import, if an opt-in process is selected. 
Only import recipients once, even if they do not appear in the 
list after the import. Otherwise, a confirmation email is sent 
each time you carry out an import.

 4. Click Import. The Import starts and the Import tab opens.

Step 5: Import the data

When the import is finished, Save   appears next to each category for which records 

were found. Click Save    to download those records. 
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The number of processed records and the import result are listed for each category:

 l Records processed. Number of processed records.
 l Records added. Number of newly added records.
 l Records updated. Number of updated records.
 l Records skipped (error in file). The column assignment did not correspond with the 

selected values in the third step. For example, a record may contain only three 
columns instead of the indicated four columns.

 l Records skipped (error in list). Number of skipped records; because they already exis-
ted, no changes were found, or you selected the option Update only and new 
records were found in the list.

 l Records skipped (on blacklist). Recipients that are blacklisted. Depending on your cli-
ent hierarchy, there might be several blacklists. A blacklisted recipient might not 
appear in the blacklist of your client, but be blacklisted on the list of the main client.

 l Records skipped (exceeded the bounce limit). Recipients that exceeded the bounce 
limit.

 l Records skipped (prior unsubscribes). Recipients who previously unsubscribed.
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 l Records skipped (prior target group). The recipients were not imported because your 
client or the confirmation email (confirmed or double opt-in) uses target groups 
that do not match.

 l Duplicates in file. Recipients only imported once to avoid duplicates in the recipient 
list.

 l Records already in recipient list. Recipients already in the recipient list are skipped to 
avoid duplicates.

 l Erroneous records. Episerver Campaign validates data  when importing them. Erro-
neous records may contain invalid characters or, in case of email addresses, a miss-
ing @ symbol or an invalid domain. Such records are not imported.

Tip: You can download the analyzed records to filter out duplic-
ates or invalid email addresses. To do so, in the overview, click Save 

 next to the corresponding category.

Exporting recipients

Note: You need special user rights to use this function.

You can export recipients by status into a CSV file:

 l Active recipients
 l Unsubscribed recipients
 l Blacklisted recipients
 l Recipients that exceeded the bounce limit

To export recipients:

 1. Open the start menu and select Recipients > Export.
 2. Select the recipients you want to export.
 3. Click Options.

 l Active recipients. Click the recipient list whose recipients you want to export. To 
export only recipients of a specific media type, select the media type from the 
Media Type drop-down list (available for active recipients only). You can also 
limit the recipient list by selecting one or more target groups from the Target 
groups drop-down list.



© Episerver 2020

616 | Episerver Campaign User Guide 2020-04-23

 l Unsubscribed recipients. Enter a start and/or an end date.

 o If you do not enter a start or end date, all recipients in the selected status 
are exported. 

 o If you enter only  a start date, recipients from that date to the present are 
exported. 

 o If you enter only an end date, recipients from the creation of your client until 
the entered date are exported.

 l Blacklisted recipients. Click the recipient list whose recipients you want to export.
 l Recipients that exceeded the bounce limit. Enter a start and/or an end date. 

 o If you do not enter a start or end date, all recipients in the selected status 
are exported. 

 o If you enter only  a start date, recipients from that date to the present are 
exported. 

 o If you enter only an end date, recipients from the creation of your client until 
the entered date are exported.

 4. Click Finish.

Tip: You can start several exports for different statuses sim-
ultaneously, but only one export per status.

Cross-checking recipients

Episerver Campaign identifies the recipients of a mailing and which internal lists are 
used for this purpose. If you maintain recipient lists outside the Episerver Campaign envir-
onment, this information can help keep your lists consistent. If you have questions 
regarding the operation and configuration of your client, contact customer support.

Episerver Campaign validates  recipient data in the following modules and functions:

 l Importing recipient lists
 l Calculating recipients for a mailing
 l Sending out a mailing
 l Editing the blacklist
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The following lists, managed internally by Episerver Campaign, also impact the val-
idation of recipients for mailing dispatches:

 l Unsubscribe list
 l Bounce counter

Importing recipient list cross-checks

Duplicates
When you import a recipient list, Episerver Campaign filters out duplicates. Duplicates 
within imported CSV files are also checked, so only one record per recipient is impor-
ted.

Tip: If you select the Clear recipient list before importing option, the 
list is not cross-checked because it is deleted before any data is 
imported.
If you select the Import new recipients and update existing records 
option, existing records are not treated as duplicates but are over-
written with new values.

Blacklist
Imported records are cross-checked against the blacklist. Blacklist recipients, including 
those serving as a placeholders, are not imported. 

Unsubscribers
Unsubscribers are included on an unsubscriber list, which usually applies to clients 
(though not inherited). You can create unsubscriber lists based on recipient lists and per-
manently linked to a recipient list, which do not affect other recipient lists in the same 
client.

Unsubscribers are not deleted from the database and not imported a second time.

Incorrect data records
During import, Episerver Campaign checks the following email address criteria:
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 l An address must contain exactly one @ symbol.
 l An address's local element (before @) may not begin or end with a dot.
 l Two consecutive dots cannot occur
 l Blank spaces and the following special characters are not permitted: ( ) [ ] \ ; : , 

< >

 l An address's domain element (after @)  must conform to the domain name system 
rules

Imported records must also have fields in the recipient list that match columns in the 
imported list. Incorrect records are not imported.

Analyzing records that are not imported
After importing a recipient list, you can download the non-imported records as a CSV 
file for each category described above. Use this file to manage the original list.

Sending mailing cross-checks
When you initiate a mailing, recipients are selected based on the following criteria and 
algorithms:

 l Recipients on a blacklist, unsubscribers, and recipients with a bounce overflow are 
not contacted.

 l Where applicable, target groups and maximum numbers of recipients are determ-
ined.

 l Email addresses are checked for correctness (see Incorrect data records).

After a mailing is sent out, responses are analyzed. Recipient addresses that produce a 
bounce generate an automatic reply to the return address. The replies are analyzed by 
Episerver Campaign. Hard and soft bounces are counted separately for each recipient. 
A recipient who reaches the bounce limit for hard or soft bounces will not be con-
tacted again. These recipients remain on the recipient list but are skipped when mail-
ings are sent out (see Bounces).

Recipients who click the unsubscribe link are placed on the unsubscribe list. These recip-
ients still appear in the recipient list but will not be sent mailings. The unsubscribe list 
records the email, a time-stamp, and the mailing the recipient received when he/she 
unsubscribed. These records make it easier to track cancellations – in the event of a 
complaint, for instance.

https://en.wikipedia.org/wiki/Domain_Name_System
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Cross-checking bounces
A bounce is generated whenever an email fails to reach a recipient's email server or 
mailbox. It informs the sender that the email could not be delivered. 

Soft bounces
A soft bounce is generated when a mailbox is temporarily unavailable, such as when a 
mailbox is full and unable to accept more email until the user deletes some. Soft 
bounces seldom occur, because memory is usually large enough to handle a large num-
ber of emails.

Hard bounces
A hard bounce is generated when a server address or mailbox does not exist due to a 
technical problem (such as a server is down). A hard bounce is also generated if a mail-
box no longer exists, which may have several reasons:

 l The email address is entered incorrectly (even though syntactically correct).
 l The user canceled the email account.

Bounce counter and bounce limits
Bounce limits for soft and hard bounces are set when configuring the client. The stand-
ard limit is three hard bounces or five soft bounces. Once reaching this limit, the recip-
ient receives no more mailings. Bounces are counted across clients for each recipient.

 l How can I see how many bounces a recipient has generated? 

You cannot view bounces from the Episerver Campaign user interface but you can 
retrieve the number of bounces via the Episerver Campaign REST API. If you use the 
SOAP API, the getBounceCounter method also shows the number of bounces.

 l Can I view recipients who have generated a bounce overflow?

You cannot view bounced out recipients from the  Episerver Campaign user inter-
face. However, you can use the  Download bounce overflows feature to download 
bounced out recipients as a CSV file. Contact customer support for assistance. 

You can also use the Episerver Campaign REST API to get information whether a 
recipient has exceeded the bounce limit. If you use the SOAP API, the isBounceCoun-
terThresholdExeeded method also shows if a recipient has exceeded the bounce 
limit.

https://api.campaign.episerver.net/apidoc/index.html#/Responses/getBounceCounter
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/responsewebservice/getbouncecounter/
https://api.campaign.episerver.net/apidoc/index.html#/Responses/isBounceCounterThresholdExceeded
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/responsewebservice/isbouncecounterthresholdexeeded/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/responsewebservice/isbouncecounterthresholdexeeded/
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 l Can I reset the number of bounces generated by the recipient? 

You cannot reset a recipient's bounce count from the Episerver Campaign user inter-
face. To reset the bounce count, contact customer support. But you can reset the 
bounce count via the Episerver Campaign REST API, or if you use the SOAP API, the 
resetBounceCounter method also resets the bounce count to 0.

 l If an email account cannot be contacted, does it matter whether and how often I send 
mailings to it? It may be reactivated at some point.

That may be true in theory. In practice, however, mailings to unavailable or non-
existent emails are saved and analyzed by the internet service provider. If a sender 
sends too many emails to unavailable addresses, the provider places the sender on 
a blacklist and treat  those emails as spam. So, it is better to stop mailings to a recip-
ient who generates three/five bounces.

Cross-checking blacklists
Blacklists contain recipients who should not be contacted, including recipients who 
have submitted complaints, but also known spam traps and postmaster accounts which 
are standard for every email account.

Blacklist hierarchy and delegation
Depending on the how a client is structured, it can have one or more blacklists. Entries 
in a blacklist are inherited by sub-clients from main clients. If you lack authorization to 
access the main client, you cannot view its blacklists. The main client blacklists also 
apply to the sub-clients.

Placeholders
Blacklists, unlike recipient lists, can use placeholders. For example, you can block a 
domain. So while a recipient's email address is not specifically on the blacklist, a recip-
ient's domain can block the recipient.

 l Can I define a blacklist for a single recipient list?

No. A recipient list applies across clients.

 l Can I view blacklist entries in higher level blacklists?

You must have  authorization to access a higher level client.

https://api.campaign.episerver.net/apidoc/index.html#/Responses/resetBounceCounter
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/responsewebservice/resetbouncecounter/
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 l Can I prevent a blacklist from being inherited by sub-clients or define exceptions? 

No. Blacklist entries are inherited by sub-clients. You cannot circumvent this type of 
inheritance. Also, you cannot define exceptions for blacklist entries.

Cross-checking unsubscribe lists
Recipients who unsubscribe from a mailing by using an unsubscribe link or de-regis-
tration form are marked as unsubscribed. However, they are  remain on the recipient list. 
When a mailing is sent, these recipients are filtered out.

 l Can I view the unsubscribe list in my client? 

You may not view unsubscribe lists using the Episerver Campaign user interface. 
There are several ways to retrieve unsubscribers.

 1. Using the Download unsubscribers feature,  download an unsubscriber list as a CSV 
file through the user interface.

 2. If you are using the REST API, use the GET method to retrieve information about all 
unsubscribes.

 3. If you are using the SOAP API,  use the contains and containsAll methods to query 
whether one or more recipients are on an unsubscriber list.

 l Can I configure an unsubscribe list so that it only applies to one recipient list? 

Yes. You can set up an unsubscribe list based on a recipient list. Whether it makes 
sense to do so depends on the recipient list and how a client is structured. Contact 
customer support for assistance.

 l Can I use the  Episerver Campaign user interface to place a recipient on the unsub-
scribe list or remove him/her from it? 

No. Only the recipient can complete the unsubscribe process. To rescind an unsub-
scription, the recipient must re-register (by using the opt-in option, depending on 
the configuration).

 l Can I unsubscribe a recipient by deleting him/her from the recipient list? 

If you deleted  from the recipient list, the recipient no longer receives mailings from 
this list. If appearing in multiple lists, however, the recipient will continue to receive 
mailings via the lists from which the recipient is not deleted.

Note: You should not delete a recipient from the list because 
the recipient's de-registration is not recorded, so the recipient 
can be added to a recipient list again. This can result in a com-
plaint if the recipient continues to receive mailings after 

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://api.campaign.episerver.net/apidoc/index.html#/Unsubscribes/selectUnsubscribes
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/unsubscribewebservice/contains/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/unsubscribewebservice/containsall/
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unsubscribing.

 l I manage my recipient list myself and import it to  Episerver Campaign prior to each mail-
ing. What should I keep in mind when doing this? 

Make sure that you import only active recipients into the recipient list. Import unsub-
scribers into the unsubscribe list so that the cross check can take place before dis-
patch.

You also can use specially designed jobs/services to import unsubscriber lists or mul-
tiple lists. These jobs/services are not accessible via the Episerver Campaign user 
interface. The lists are transferred onto the Episerver Campaign server per SFTP and 
automatically imported to the client:

 o Importing an unsubscribe list. Import your local unsubscribe list to the unsubscribe 
list on your  client.

 o Importing recipients including unsubscribers. Import an individual recipient list that 
contains active recipients for a variety of recipient lists and unsubscribers. The 
status of a recipient, or the list to which it is being imported, must be entered in a 
separate recipient list column  to keep your lists consistent.

Tip: Contact customer support for configuration of jobs/services. 
Imported data must have a defined name and be stored in a 
defined directory per SFTP.

Recipient lists

Note: To create a new recipient list or change properties and data 
fields of existing recipient lists, contact customer support.

The Recipient list menu provides functions to edit, empty, or copy recipient lists. The over-
view area shows recipient lists for your client, and the number of recipients in each list.

Copying a recipient list
Creates a new recipient list that contains the same data fields as the selected source 
list. Only the list structure is copied, not the entries.
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Editing a recipient list
Change the name or description of a list. You can also set any recipient list as a test list. 
Use test lists only for sending test emails, not regular sending.

Note: Do not use real customer data for test lists, but use your own 
data or that of your co-workers and superiors, for example.

Clearing a recipient list
Deletes entries from a recipient list. The list itself is not deleted and can be used again.

Tip: To delete and/or unsubscribe multiple recipients from multiple 
recipient lists, use Cleanup.

Displaying recipient list details
If Separate data storage is activated in your client, you can use Details to access the set-
tings to hide or display recipient list fields with personal data for users of your client.

 1. Click Details. The Show recipient list details opens.
 2. In the list, select the recipient list field you want to hide or display for users of your cli-

ent.
 3. Click Edit. In the Shown data column, a drop-down list opens.
 4. In the drop-down list, select:

 l Master data. Display the recipient list field only to users with appropriate per-
missions.

 l Properties. Display the recipient list field to all users. 
 5. Click Submit.
 6. If necessary, repeat these steps  for additional recipient list fields.
 7. To save the changes for recipient lists, click Apply changes to all lists. To save the 

changes only for the selected recipient list, click Apply changes.

Tip: Separate data storage supports three user permissions for dis-
playing personal recipient data:
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 l View Properties fields only
 l View Master data fields and Propertiesfield separately (so a user cannot 

associate properties with a recipient)
 l View Master data and Properties fields

For details about Separate data storage and individual user permissions, contact customer 
support.

Recipient list data fields
Every recipient list contains an unlimited number of data fields. One data field is 
reserved for the recipient ID, usually the email address. You cannot edit the recipient ID 
field. Instead of the email address, you can use any other ID, such as a customer ID.

Recipient list data types
Each data field can store a certain data type, which is selected when the recipient list 
is created. According to the data type, you can perform mathematical and/or logical 
operations with the value of a data field. For example:

 l Numbered fields. Numbers can be integers (32-bit/64-bit) or floating decimals. Com-
pare the value of a field with a given value (equals/is less than/is greater than).  

 l Date fields. Compares date and time (is older than/is younger than/is prior a given 
time/date/is past a given time/date/is exactly ... old). 

 l Boolean fields. Perform is true or is false operations.
 l String fields. Congruity or incongruity of strings and characters (begins with, end with, 

does not begin with, does not end with, contains, does not contain).

The following data types and range of values are permitted for recipient list data fields:

Data 
type

Range Example

Boolean
 true/false Registration via website, interested in promotional news-

letters 

Date date

Registration date. Supported date formats:

Note: Programming interfaces 
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Data 
type

Range Example

(APIs) only support date formats 
according to ISO 8601.

Date format Description Example

yyyy-MM-dd Date with 
separator 2017-05-07 

yyyy-MM-dd 
HH:mm:ss 

Date and 
time 

2017-05-23 
09:50:04 

yyyy-MM-
dd'T'HH:mm:ss 

Date and 
time 
according 
to ISO 8601 

2017-05-
23T09:50:04 

yyyy-MM-
dd'T'HH:mm:ss,SSS
 

Date and 
time with mil-
liseconds 

2017-05-
24T08:03:59,123 

yyyy-MM-
dd'T'HH:mm:ssXXX
 

Date and 
time with 
time zone 
offset  

2017-05-
07T12:18:54+02:00 
2017-05-
07T08:18:54-02:00

Float single-precision 32-bit IEEE 
754 floating point Conversion volume, customer score 

Integer
32-bit-signed; -
2,147,483,648 - 
2,147,483,647

Age 

Long

64-bit-signed; -
9,223,372,036,854,775,808 
- 
9,223,372,036,854,775,807

Customer ID 

String unicode text up to 256 
characters Email address, first name, last name, city, postal code 
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Data 
type

Range Example

Text up to 64,000 characters Email address, first name, last name, city, postal code 

Cleaning up recipient lists
Cleanup lets you automatically delete and/or unsubscribe recipients from recipient 
lists. You upload a CSV file with the recipients you want to delete or unsubscribe, then 
select the lists.

Note: To delete and/or unsubscribe recipients, you must have the 
appropriate rights.

 1. Create a CSV file containing the IDs of the recipients you want to delete or unsub-
scribe.

Tip: Episerver Campaign identifies recipients by recipient ID, usu-
ally email address.

 2. Open the start menu and select Recipients > Cleanup.
 3. In the Upload file tab, click Browse....
 4. Select the CSV file created in step 1 and click Preview. The file is uploaded to the 

Episerver server. The Preview tab shows the uploaded recipients. 

Note: The Recipient column must contain recipient IDs. On 
import, only this column is considered. 

 5. If email addresses do not display correctly, change the Character encoding option.
 6. If the first line of the CSV file contains column names, in the Skip first row list, select 

Yes.
 7. Click Refresh preview to check your settings.

Tip: To only unsubscribe recipients, go to step 10. To only delete 
the recipients, go to step 12.

 8. Click Delete.
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 9. In the Delete recipients area, select the Delete recipients check box. In the Recipient 
lists area, select one or more recipient lists from which you want to delete the recip-
ients.

 10. Click Unsubscribe.
 11. In the Unsubscribe recipients area, select the Unsubscribe recipients from all recipient 

lists check box to unsubscribe recipients from recipient lists.
 12. Click Summary. In the Summary tab, all actions to be performed are displayed. 
 13. To make changes, click the corresponding tab and perform the appropriate steps.
 14. Click Finished. The recipients are deleted and/or unsubscribed according to your set-

tings. You receive a notification email to your email address once the process is 
complete.

Note: While the process is running, you cannot run a new one.

Tip: You may need to export the data from your recipient data-
base, CRM application or similar. If the source file is not a CSV file 
or if you want to export the recipient data from your local data-
base or CRM first, ask your IT department for assistance. If the 
source file is a spreadsheet file, you can convert it into a CSV file. 
Open the file with your spreadsheet application (for example 
Microsoft Excel), select Save as -> .csv file and save it to your local 
hard drive.

Target groups

A target group is a subset of recipients defined by specific rules and conditions. Each tar-
get group may contain several rules and conditions and a logic relation between them. 
Use target groups to send a mailing to a predefined group of recipients (such as recip-
ients in the US) or to create dynamic content and subject lines. Dynamic paragraphs let 
you show, for example, different items to male and female recipients. You can use 
dynamic subject lines to create specific attention even before a recipient has opened 
the mailing. 

You can define a target group using the following classes of conditions:

 l Action-based conditions. Criteria based on an action or event (such as click, open) 
that a recipient has performed. Those conditions apply only after a mailing is sent. 
An example for an action is: Recipient has received a specific mailing and has 
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clicked on a specific link in it.
 l Recipient list-based conditions. Determines whether recipients are contained in spe-

cific recipient lists.
 l Recipient data-based conditions. Criteria based on any field of the recipient list (such 

as City or Interest).
 l Episerver Campaign-based conditions. Determines whether recipients are currently 

passing through or already passed through Marketing Automation campaigns.
 l Target group-based conditions. Determines whether recipients are contained in 

another target group.

If your client is configured for post-click tracking, you can track actions that are made 
on your website. For example, select recipients who have bought a certain product 
from your shop or have spent a certain amount in your shop. To configure a target 
group with post-clicks, select Actions from the first drop-down list and then has created 
one or more post-clicks.

Example: Define a target group that contains male recipients in the US. You may now 
vary this target group by adding further rules, such as recipients who clicked on a spe-
cific link in the last mailing they received. Use this target group to send a special offer or 
a promotional email to selected recipients. If you apply the target group to the whole 
mailing, only the target group receives the mailing. If you apply it to a paragraph, it is 
shown only to these recipients, while the others receive the regular mailing.

Note: If you want to see the matches of a target group in the recip-
ients overview and the selected target group contains user-based 
data (for example, user actions), you get an error after clicking 
Apply. Due to data privacy reasons, you are not allowed to analyze 
a single user's data. When using this target group to send a mailing 
or to create dynamic content, it will work properly, though.

Tip: You can use segments created in Episerver Visitor Intelligence 
as target groups.

Managing target groups
To manage target groups, open the start menu and select Recipients > Target groups. 
Existing target groups appears. If you click a target group, its definition appears in the 
bottom of the window. Every target group definition is made up of one or more rules. For 
example, The email address contains "@example.com" or The first name is "Mark".

You can organize target groups in folders.
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Creating a target group
 1. Click Create.
 2. In the Client drop-down list, select the client for which you want to create a target 

group.
 3. In the Target group definition area, define the rules and conditions for the target 

group by clicking  + and performing steps described in Defining a target group.
 4. Optionally, you can execute a target group analysis.
 5. Click Properties.
 6. Enter a name and an optional description for the new target group.
 7. Click Create.

Copying a target group
 1. Select a target group you want to copy and click Copy.
 2. In the Client drop-down list, select the client to which you want to copy the target 

group.
 3. In the Target group definition area,  define the rules and conditions for the target 

group by clicking  + and performing steps described in Defining a target group.
 4. Optionally, you can execute a target group analysis.
 5. Click Properties.
 6. Enter a name and an optional description for the new target group.
 7. Click Create copy.

Note: Recipient field does not exist in target client
If the target group you want to copy contains a recipient field 
based on a rule that uses a recipient field that does not exist in the 
recipient lists of the target client, the respective name of the field 
is shown like this: ???Name???. You can still copy the target group. 
Next, open the target client and select the copied target group. 
Change the field name by selecting a field from the drop-down list 
and save the target group.

Editing a target group
 1. Select a target group you want to edit and click Edit. The Edit target group window 

opens.
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 2. In the Target group definition area,  edit the rules and conditions or add new ones for 
the target group. To edit a rule, click it and perform steps described in Defining a tar-
get group.

 3. Optionally, you can now execute a target group analysis.
 4. Click Properties.
 5. You can change the name or description of the target group, or add and edit rules 

and conditions.
 6. Click Save.

Using Visitor Intelligence segments as target group
If you have Episerver Visitor Intelligence (formerly Episerver Insight) on your website, you 
can use segments as target groups for your campaigns. See Creating a marketing seg-
ment for an instruction on how to create a segment in Visitor Intelligence based on web-
site visitor profiles. You can then use the created segments in Smart Campaigns and 
Marketing Automation.

Defining a target group
When creating a new target group, the Target group definition area is empty, except for 
a plus icon +. 

 1. Click Add + and, in the very left drop-down list, select whether you want to create a 
negative condition. Select Not if the criteria you define for it is false. To create a pos-
itive condition, leave this first drop-down field blank.

Note: Sometimes you want to formulate rules in a negative fash-
ion. Select the not option from the first drop-down list while cre-
ating a rule. For example, to find recipients not from Berlin, the 
rule would be: not Recipient list field "Location" is equal to "Ber-
lin".

 2. In the next drop-down list, select whether you want to create an action-based, cam-
paign-based, recipient list-based, recipient data-based or target group-based con-
dition. 

As another option, you can use the parentheses to hierarchically handle more complex 
definitions. Rules within parentheses are applied first and then the rules in the second 
level and so on. Use AND or OR logic relations between two conditions. To change the 
type of relation, click it. Due to correctness and logical unambiguousness, target 
groups without parentheses can only contain one type of logic relation. Thus, if you 
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click a relation, relations between the rules are changed. If you want to use different 
types of logic relations, use parentheses as in the following example.

Example

You are looking for recipients located in Berlin or Hamburg and with email accounts at 
example.com. 

(Recipient location equals Berlin OR Recipient location equals Hamburg) AND email 
address contains @example.com

The parentheses makeEpiserver Campaign select recipients from Berlin or Hamburg first. 
Then out of this subset, recipients with an example.com email account are selected.

Tip: Use drag-and-drop to sort rules and conditions or put them into 
parentheses. If you hover over a rule, a context menu appears on 
the right side. Click Add + to add a new condition at a specific pos-
ition; click Remove — to delete a condition. The Copy symbol cre-
ates a copy of a condition.

Defining a target group based on  recipient data conditions
If you selected Recipient list field in the second drop-down list, the following drop-down 
list shows fields from your recipient list. Select the field you want to query, such as ZIP 
code. 

Depending on the type of field, in the next step you can select an operator. The oper-
ator compares the content of the selected recipient field with a targeted value. The fol-
lowing table shows all available operators. You complete other rules by entering a 
matching value in the last field.

Operator Data field type

equals String, numeric field, date field, boolean

does not equal String, numeric field, date field, boolean

is greater than Numeric field

is greater than 
or equals

Numeric field

is less than Numeric field
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Operator Data field type

is less than or 
equals

Numeric field

is one of the fol-
lowing values

String, numeric field, date field
See Multiple values.

contains String

starts with String

ends with String

is empty/un-
known

String, numeric field, date field, boolean
See Empty fields (NULL values).

is not empty/un-
known

String, numeric field, date field, boolean
See Empty fields (NULL values).

in exactly X 
hours

Date field

in exactly X 
days

Date field

is anniversary
Date field
Compares the day and month of the date field entry with the current day and 
month so you can filter recurring events such as birthdays and anniversaries.

is anniversary in 
exactly X days

Date field

dates back 
exactly X days

Date field

dates back less 
than X days

Date field

dates back 
more than X 
days

Date field
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Operator Data field type

dates back less 
than X months

Date field

dates back 
more than X 
months

Date field

month is current 
month

Date field
Compares only the month of the date field entry with the current month.

day is current 
day

Date field
Compares only the day of the date field entry with the current day. However, this 
does not mean today because all dates that have the same day, will match.

Action-based conditions
If you selected Action in the second drop-down list, you can define the rule through 
recipient-specific actions or events (such as opens, clicks).  

The following actions are available: 

Action Description

has caused hard bounce
Recipients who have generated a hard bounce. In the Mail-
ing drop-down list, select either all mailings, mailings of a spe-
cific type or specific mailings.

has caused soft bounce
Recipients who have generated a soft bounce. In the Mailing 
drop-down list, select either all mailings, mailings of a specific 
type  or specific mailings.

has clicked a link

Recipients who have clicked one or more links. Select a time 
period, the desired mailings, and the corresponding links. In the 
drop-down list Count you can define the number of clicks on a 
link (exact value or minimum number, optionally with upper 
limit).

has clicked in click profile at least 
X times

Recipients who have made a certain number of clicks in a 
selected click profile. Select a time period and the desired mail-
ings. You can select the number of clicks and the desired click 
profile in the drop-down list Clicks.
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Action Description

has received mailing

Recipients to whom a mailing was sent, which means that 
the subscriber is not unsubscribed, blacklisted, or out-
bounced. Note that a recipient matching this criterion can 
still create a hard or soft bounce. To exclude these recip-
ients, create the target group as follows: has received mail-
ing AND has NOT created soft/hard bounce.

Note: If you use Mailings Classic, 
please see the note in the FAQs.

has opened mailing

Recipients who have opened mailings one or more times. 
Select a time period and the desired mailings. In the Count 
drop-down list you can define the number of openings (exact 
value or minimum number, optionally with upper limit).

has replied
Recipients who have responded to mailings. Select a time 
period and the required mailings.

has created one or more post-
clicks

Recipients who have created one or more post-clicks.

Note: Relative time period filter
In most action-based filters, you can select the Period filter Within 
the last... n Hours/Days. The relative time period filter takes into 
account the time span from the time of the calculation to the last 
relevant time stamp and calculates n further days/hours back from 
there. Example: The period filter Within the last 1 hours takes into 
account the currently started hour plus the last full hour. The 
highest possible time value of this filter is 119 min 59 s.

Mailing types 

In action-based filters, you can select  under Mailings the option Mailings of type. The mail-
ing types from the drop-down list include the following mailings:

 l Regular. Optimized mailings of an A/B test (Smart Campaigns) and mailings from Mail-
ings Classics (deprecated).

 l Special. Transactional mails.
 l Confirmation email.  Confirmations.
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 l Split. Split mailings  from Mailings Classics (deprecated). 
 l Campaign. Mailings and split mailings of a Smart Campaign (without optimized mail-

ings).

Tip: To select all mailings of an A/B test in a Smart Campaign, 
select both options Regular (to select the optimized mailing) and 
Campaign (to select the split mailings).

Post click conditions
If post-click tracking is configured for your client, actions that a recipient does on your 
website are tracked. You can create target groups using the post-click data, for 
example, from select recipients who have bought a certain item in your online shop.

You can track post-click data using the proprietary Episerver Campaign post-click track-
ing or a full-featured web analytics software. Episerver maintains partnerships with sev-
eral vendors, for example, Adobe, Webtrekk, Econda, Google Analytics and eTracker. If 
you are interested in this option, contact your Episerver account manager.

To create a target group with post-click data, perform the following steps:

 1. In the second drop-down list, select Action and in the following drop-down list, 
select has created one or more post-clicks. The input mask changes according to the 
post-click setup of your client.

 2. If you use more than one post-click or web analytics service, select the one you 
want to use from the Service drop-down list. 

Tip: The internal Episerver Campaign post-click tracking is 
called default. If you use only one service, this drop-down list will 
not appear when creating the target group. The service is dis-
played, though when you save the target group condition.

 3. In the Mailing list, you can select post-clicks that are created through a designated 
mailing. If you leave this selection empty, any mailing, or no mailing at all, respect-
ively, is taken into account.         

Tip: Post-click data that were not created through a mailing 
can be processed only if they carry a user ID identical to the 
recipient ID within Episerver Campaign. Therefore, the ID your 
customers use when logging in to your online shop should be 
the same as the recipient ID used in Episerver Campaign. 
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Usually, the email address is used as recipient ID. New cus-
tomers and customers that do not want to receive promotional 
emails can also receive system emails (such as order con-
firmations) via Episerver Campaign. If customers register for 
your newsletter, their post-click data is completely available.

 4. To delimit post-clicks to a period or date, select a type in the Period field and enter a 
date or a number of days in the calendar interface. The following scenarios are 
available:          

 l No restrictions. Post-clicks are not delimited by time.
 l From ... until .... Post-clicks must be created in the designated period. 
 l On .... Post-clicks must be created on a designated date. 
 l Not on .... This scenario excludes the selected date.
 l After or on .... Post-clicks must be created on the selected date or later. 
 l Before or on .... Post-clicks must be created on the selected date or earlier. 
 l Older than ... days. Post-clicks must be created X days ago or earlier.  

 o In regular mailings, the time range is calculated from the sending date. 
 o In system mailings, the time range is actualized every day.

 l Exactly ... days ago. Post-clicks must be created exactly X days ago.  

 o In regular mailings, the date is calculated from the sending date. 
 o In system mailings, the date is actualized every day.

 l Within the last ... days. Post-clicks must be created within the last X days. 
 l Within the last ... months. Post-clicks must be created within the last X months.
 l Today. Post-clicks must be created on the current day. 

 o In regular mailings, this day is the sending date. 
 o In system mailings, an actualization is made every day.

 l Current month. Post-clicks must be created in the current month. 

 o In regular mailings, this is month in which the mailing is sent. 
 o In system mailings, an actualization is made every day.
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 5. Select a category. 

Tip: You can define categories individually and contain a string 
(such as product name) or a float value (such as revenue). You 
can combine several categories in one target group condition 
and therefore select recipients who have bought product A 
and B or have bought products from group X for more than 500 
dollars. By combining several post-click categories you may 
create recipient segments for discounts, cross- and up-selling 
offers, and so on.

 6. If the selected category is a string, you can select one of the following operators 
from the list:         

 l equals
 l does not equal
 l contains
 l is empty
 l is not empty
 l starts with
 l ends with

 7. Enter the identifier in the field next to the operator. 

Tip: The automatic completion function helps you to exactly 
match the name you are looking for. By default, the automatic 
completion shows the first ten or fewer matches.

 8. If the selected category is a float value (for example, a product price), you can 
select one of the following operators from the drop-down list:

 l equals
 l does not equal
 l is greater than
 l is less than
 l is less than or equals
 l is greater than or equals

Optional: To aggregate post-click values, select one of the following operators from 
the drop-down list that appears to the left:

 l one occurence in
 l sum of
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 l average of
 l number of

 9. In the field next to the operator, enter a value.

Note: When the selected operator is equals, the entered value 
must match exactly the value given by the system, including 
decimal places. Follow the instructions for entering multiple val-
ues.

 10. Click Apply  .

Recipient list-based conditions
If you selected Recipient list in the second drop-down list, the system checks whether 
recipients are contained in a recipient list. Perform the following steps:

 1. In the Recipient list, click a recipient list.
 2. To add the condition to your target group, click Apply  .

Note: Episerver Campaign identifies recipients by recipient ID, usu-
ally the email address. If you are using custom recipient IDs (i.e., no 
email addresses), you have to select recipient lists that use the 
same custom recipient IDs.

Campaign-based conditions
If you selected MA campaign in the second drop-down list, the system checks whether 
recipients are currently passing through or have already passed through a specific Mar-
keting Automation campaign. You can select multiple campaigns for this condition 
also:

 1. In the drop-down list, select has passed through MA campaign X or is currently passing 
through MA campaign X.

 2. In the following drop-down list, select one or more campaigns.
 3. To add the condition to your target group, click Apply  .

Target group-based conditions
If you selected Target group in the second drop-down list, the system checks whether 
recipients are contained in a target group. Perform the following steps:
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 1. In the drop-down list, select Recipient matches target group X.
 2. In the following drop-down list, select the desired target group.
 3. To add the condition to your target group, click Apply  .

Use this condition to add target groups that are used many times (such as Men, Women, 
...) as a component to other, more complex target groups. Thus, you only have to 
define these component target groups once and can reuse them whenever they are 
needed.

Note: When defining target groups with a target group-condition, 
take care that they do not exclude each other reciprocally. For 
example, the target group you want to create matches recipients 
from the Greater London area. To do so, you define a condition 
that matches the respective postal codes. If you add a target 
group-based condition to this target group matching recipients 
from Northern England, these two conditions would exclude each 
other reciprocally and there would be no matching recipients in 
this target group.

Selecting multiple values
If you select is one of the following values, you can enter multiple values in one text box. 
For example, if you want to copy values from a CSV file:

 1. Select the operator is one of the following values.
 2. Enter the values, for example, comma-separated.
 3. Open the drop-down list, click the gear symbol (Separate multiple values) and in the 

box, enter the used delimiter symbol.
 4. Click Apply  . The entered values are now handled as single values.

Managing empty fields 
There are generally three types of fields.

 l Fields which contain a value (Place of residence = "Berlin")
 l Fields which contain no value and are empty (Place of residence = "")
 l Fields which are unknown (Place of residence = unknown)

For example, if you acquired additional newsletter subscribers through an external 
action (such as a sweepstakes) and imported these into your recipient list, some will not 
contain information for Place of residence. If you want to select recipients in your tar-
get group who do not live in Berlin, the condition would be as follows:
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With this, recipients are selected who have entered a place of residence other than Ber-
lin (such as Boston). However, the rule does not consider null values (unknown or no 
place of residence) because the Episerver Campaign logic assumes that it cannot be 
determined whether the recipient resides in Berlin or not.

However, with another rule, you can modify the target group so that recipients whose 
places of residence are unknown are also selected. To do this, add the rule .Recipient 
list field "City" is empty/unknown and link both rules with or:

Thus, you include recipients without an explicit place of residence by using the query is 
empty/unknown.

Analyzing a target group
The target group analysis lets you check a target group for correct functionality. You 
can check how many recipients from recipient lists the target group definition 
matches. You can also change the definition, if necessary, before sending the mailing.

 1. Open the start menu and select Recipients > Target groups.
 2. Select a target group and click Analysis. The Edit Target Group window opens show-

ing the target group definition.
 3. In the Analysis area, in the Recipient list drop-down list, select one or more recipient 

lists for which you want to perform the target group analysis.

Note: Ensure that all selected recipient lists have at least one 
media type in common. If several lists with more than one 
media type in common are selected, then select which media 
type represents the delivery method. For example, if you want 
to send emails, then select the media type Email.

 4. If you use a default target group but you do not want this to be included in the cal-
culation, select  Disable default target group for this calculation.

 5. Click Calculate. The calculation is started in the background. If the analysis is com-
pletely calculated, the graphical analysis is displayed.
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The analysis contains the following information:

 l Recipients. Displays all recipients of the selected recipients lists that match the 
target group. The recipients are sorted by the following categories:

 o ready. Matches the target group and ready for dispatch. You can send mail-
ings to these recipients.

 o bounced. Matches the target group but is not ready for dispatch, because 
they are too many bounces.

 o blacklisted. Matches the target group but is not ready for dispatch, because 
they are blacklisted.

 o unsubscribed. Matches the target group but is not ready for dispatch, 
because they are unsubscribed.

 l Recipient lists (ready). Displays the number of recipients of the corresponding 
recipient lists that match the target group and can send a mailing to; recipients 
that create too many bounces, that are blacklisted, or unsubscribed are not 
taken into account here.

Tip: If you want to change the target group, because it does 
not match the desired number of recipients, edit the definition 
and perform the analysis again.

 6. If the Example recipients feature is enabled in your client, after the analytical cal-
culation you can display sample recipients (up to 100 datasets) that meet the tar-
get group definition. To do so, click Example recipients. A window with up to 100 
sample recipients opens.

Note: To enable the Example recipients feature, you need the 
consent of your recipients to view and use personal data. If you 
have this consent, complete a declaration of release for the 
use of personal tracking data, sign it, and send it to customer 
support. This form is available from customer support.

Counting recipients in several lists and list order
If a recipient is contained in several recipient lists, the recipient is counted only once. 
The order of the recipient lists is crucial for the final result, too.

Example:
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 l Recipient list Premium customers with a total of four recipients: Peter Marston, Mark 
Smith, Lea Harris, Sarah Howard

 l Recipient list Default customers with a total of four recipients: Peter Marston, Mark 
Smith, Julia Green, Sarah Howard

Perform the following steps:

 1. Create a target group women.
 2. First, select the recipient list Premium customers and then the recipient list Default cus-

tomers. On the left, the analysis shows that mailings can be sent to only three recip-
ients (Lea, Sarah, Julia); the recipient Sarah Howard is contained in both recipient 
lists so is listed once. On the right, two recipients (Lea, Sarah) of the recipient list 
Premium customers and one recipient (Julia) of the recipient list Default customers 
match the target group:

 3. Swap the order of the two recipient lists and perform the analysis again. The two 
recipients (Julia, Sarah) of the recipient list Default customers and one recipient 
(Lea) of the recipient list Premium customers match the target group:
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Also, you can use the target group analysis to evaluate your recipient lists. For 
example, you can quickly get the number of women contained in your recipient list. 
To do so, create the target group definition The value of the field Salutation equals 
Mrs. and perform a target group analysis for a recipient list. However, perform such 
evaluations only on single recipient lists because recipients that are contained on 
multiple recipient lists are only counted once (as described above).

Opt-in

The opt-in method forms the basis for operating legally compliant email and omni-
channel marketing campaigns. An opt-in method requires recipients to give a sender 
explicit permission to send them advertising mails. For this, the recipient:

 l actively agrees to receiving advertising emails by, for example, ticking a box, or
 l separately states that this acceptance relates solely to the receipt of advertising 

emails, or
 l agrees to a declaration that clearly defines the scope (Who is the advertiser? What 

is being advertised? How often?).

This topic provides detailed information about the opt-in procedure and the double 
opt-in to ensure you have evidence that permission was given.

Note: The following information is not legally binding.             

Legal basis
In accordance with paragraph 7, section 2 UWG (the German Unfair Competition Act), 
sending advertising emails to consumers without their prior express consent  is con-
sidered  an unreasonable nuisance and unfair competition.

To protect consumers from receiving unwanted email (spam), legally compliant email 
and omnichannel marketing are based on permissions. The sender must have the con-
sumer’s consent to receive emails (for example, newsletters).

If a recipient has given permission via an opt-in method, the sender has valid proof of 
consent in the event of a complaint by the recipient.

Should legal action arise, the opt-in must be demonstrable in a court of law. Precise ver-
sion management of the opt-in processes is advisable for use in practice.
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Exceptions
Transactional mails do not generally require an opt-in. For example, registration and 
order confirmation emails may be sent without an opt-in. However, this only applies if 
the transactional mails do not contain additional advertising.

Omnichannel marketing: Separate opt-ins
In accordance with mandatory documentation requirements of data protection legis-
lation,  ensure that you collect and record a separate opt-in for each advertising 
medium (telephone, text message, email and so on).

The opt-in text must exclusively seek consent for sending promotional material and – as 
opposed to generic "general consent" for types of advertising  – the text must precisely 
describe the promotional materials. For example, you should differentiate between a 
regular newsletter and a reminder message that is sent when a customer does not 
respond to an offer.

Validity of the permission
An opt-in may expire as established by current case law. This is generally be the case if 
you do not contact a recipient for over one year. The previously given consent will no 
longer apply if you begin contacting the recipient again after this period.

To prevent opt-ins from expiring,  contact recipients regularly.

Opt-in method types
 l Double opt-in method

Note: Episerver recommends the use of this opt-in method.

The double opt-in method is a procedure in which the end user consents to receiv-
ing emails from the sender before any promotional emails are sent. Recipients 
receive an email with a double opt-in link, which they must click to confirm their 
newsletter registration.

Their addresses are only added to the recipient list after they click the link. This 
method is intended to ensure that end users are not signed up for services against 
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their will by third parties. This not only aggravates the end users but also forces them 
to tediously unsubscribe from the services.

Reasons to useEpiserver Campaign to manage double opt-ins

 o The entire process is managed from a single source.
 o Almost the entire subscription process can be managed by a single system.

By comparison, managing the process using an external system requires recipient 
data to be synchronized and/or imported prior to every dispatch, which is a lot 
more work.

 l Single opt-in method

Warning: Episerver does not recommend use of this opt-in 
method.

Using the single opt-in method, an end user agrees to receive emails from the 
sender. Their email address is then entered into the recipient list. Unlike the double 
opt-in method, confirmation links are not sent. From a legal standpoint, the single 
opt-in method is not recommended because it cannot be assumed that recipients 
have entered their email addresses into the recipient list themselves.

 l Confirmed opt-in method

Warning: Episerver does not recommend the use of this opt-in 
method.

In the confirmed opt-in, an end user agrees to receive emails from the sender. The 
recipient receives an email confirming that their data is recorded, and that they will 
receive newsletters by email. This method suffers the same problems as the single 
opt-in method, except that the recipients are directly informed that their data was 
entered into a recipient list.

Implementing the double opt-in method with Episerver 
Campaign

Setup
If you want to use the double opt-in method, contact customer support, who sets up the 
opt-in process and creates the confirmation mailing that contains information about 
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the subscription. You can adapt this mailing as you like, and it must include the double 
opt-in link (using the field function {Double Opt-in Link}). This link refers to the confirmation 
page, which is provided by Episerver or hosted by you.

If you want to use the new Opt-in processes feature to create confirmation mailings your-
self, contact customer support.

Adapting your website
In the next step, you update your website so that the opt-in process you set up is ini-
tiated when a new recipient subscribes to the newsletter using the form. If you are using 
the REST API, you can add one or multiple recipients to a recipient list. You can also set up 
the connection using the add2 or addAll3 methods, using the SOAP API, or using the sub-
scribe operation in the HTTP API. The opt-in process IDs required for this are available in 
the  API overview.

Examples
 1. Newsletter subscription
 2. Confirmation email
 3. Confirmation

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://api.campaign.episerver.net/apidoc/index.html#/Recipients/addRecipient
https://api.campaign.episerver.net/apidoc/index.html#/Recipients/addRecipients
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/recipientwebservice/add2/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/recipientwebservice/addall3/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/services-and-operations/subscribe/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/services-and-operations/subscribe/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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Frequently asked questions about the double-opt-in 
method
1. How do I explain the additional steps to new subscribers when they sign up for the news-
letter?

 l Information. After new subscribers enter their information,  clearly inform them that 
an additional step is required to activate the newsletter subscription ("We have 
added your email address to our list. To activate ... "). Explain  why this step is neces-
sary. For example, "to prevent other people from subscribing using your email 
address" or "to validate your email address".

 l Link. Instruct recipients to activate their subscription after entering their information. 
If possible, provide a link to their mailbox for activating the subscription. You can use 
the domain parts of the email address to determine which email provider the recip-
ient is using and to create a link to the specific service. Example: If the new sub-
scriber has an xxxx@example.com address, then you can display a "Go to my email 
inbox" link that takes them to the login page at www.example.com.

 l When to send the confirmation email. You should send the confirmation email as soon 
as possible after the sign up, so it can be activated quickly. The recipient may oth-
erwise forget the reason for the confirmation email or lose interest in the newsletter.

2. What should I be aware of when setting up the activation email?

 l Subject. Ensure that your activation email has a meaningful subject line that directly 
prompts the user to take action. For example, "Please confirm your email address".       

 l Sender.The sender name is often the first thing that a person sees and should be 
recognizable. You should use a consistent sender name for emails, including the 
activation email. Give your potential subscriber an option to reply to the activation 
email (avoid using a noreply@...email address).       

 l Presentation. The activation email should avoid using large blocks of text and com-
plicated layouts. Your recipient needs to click the confirmation link. Help them  by 
providing concise and accurate instructions along with a clearly visible con-
firmation link.     

 l Spam suspicion. Inform new subscribers that emails from new and previously 
unknown senders may land in their spam/junk mail or unknown mail folders. If the 
recipient cannot find the confirmation email, they should check these folders.

3. What problems can arise when using the confirmation link in an activation email?

 l Short length. Make sure that the confirmation link is not too long. Otherwise, there is 
a danger that it may get broken across two lines and no longer work. In case this 
happens, you should offer a solution to your subscribers, for example, "If the link does 
not work, copy both lines into the address bar of your browser." You should further 
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ensure that the confirmation link stands out from the other text in the message, even 
if the email preview area is small.

 l Correct link. A further potential source of problems is a confirmation link that does 
not work. This can happen if the link contains a special character, which causes 
Outlook or Thunderbird to incorrectly highlight it and thus send the user to a blank 
page. Another frequent link problem is forgetting to use the HTML anchor tag prop-
erly. Check that the confirmation link is correct.

4. How can I avoid any possible problems with the sign up process?

 l Address book entry. Tell new subscribers to add your email sender address to their per-
sonal address book or list of secure senders. You can say something like "To ensure 
that you receive our newsletter...". This will ideally be supplemented with a link to 
instructions for common email programs and webmail providers to help with this 
step. You can also provide a vCard that can be used with some email programs to 
add your contact data to the address book with a single mouse click.

 l Help / contact options. Give the user options for providing feedback or contacting 
you (email address, chat, free phone number, "not working" button) in case of prob-
lems with registration or confirmation. This can also be an important feedback chan-
nel for identifying problems or areas for improvement in the process. A more 
elegant solution is to provide contact information for a personal adviser or customer 
support representative , if this would be appropriate or possible.

 l Resending. Provide the recipient the option of having the activation email resent in 
the event that it has not arrived within the first few minutes or the recipient is unable 
to find it.

Best practices for permission-based email marketing
This document examines the double opt-in process, which lets you get consent from 
your recipients and provides documentation to prove that consent was given. Episerver 
provides the best practices for putting together an opt-in mailing.

What is an initial opt-in?
With the initial opt-in, you can use a standardized procedure to obtain the permission of 
your recipients and verify the provided email addresses.

The address data that you provided is imported into Episerver Campaign within the 
framework of the initial opt-in. An automatic system email is sent to these addresses. 
The recipients of this email can click the provided link to confirm their agreement to 
receive your newsletter. Each subscriber who gives permission in this way is added to the 
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recipient list in Episerver Campaign. Your recipient list will only include subscribers who 
have explicitly requested the newsletter.

As the sender of the newsletter, you profit from an initial opt-in because you are in pos-
session of your recipients' consent to receive marketing communications in case of 
complaint.

Best practices for putting together the opt-in mailing
When composing a professional opt-in mailing, take note of the following:

Inbox

Every mailing has certain content elements that your recipients will notice at first 
glance in their inbox. You should draft your opt-in mailings in a way that your recipients 
know what they are dealing with:

 l Clear sender identification (email address and sender name)
 l Clear and enticingly formulated subject line
 l Pre-header with additional subject line and link to online version

Contents

The content elements of your opt-in mailing should entice the recipients to click. They 
must be absolutely free of advertising:

 l The confirmation link must be clearly recognizable even when images are deac-
tivated

 l Branding: logo placement at most (ideally without linking)
 l Clear formulation of the mailing objective but without the character of an advert-

isement
 l Best practice: It should be understandable from the text that the recipient is being 

asked to reconfirm the subscription to the newsletter
 l Stress the option to unsubscribe at any time in every mailing
 l 3-4 confirmation links should be placed (visible and clearly identifiable), for example 

within the text of the message and as a button
 l No advertising content
 l No links to social media channels
 l No unnecessary links but rather a clear focus on the confirmation link
 l Clear and enticing formulation of the confirmation link: "Yes, I want to continue to 

receive the newsletter."
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 l Explanation of what happens if the confirmation link is not clicked
 l Reference to the source of the original subscription

Footer

Provide  information about the company and data protection:

 l Full legal imprint
 l Reference to data protection
 l Link to the data protection provisions found on your homepage
 l Mention the addressee's email address in the footer

Your opt-in mailing in detail

Enticing subject line

The subject line of your opt-in mailing must be free of advertisements yet enticing at the 
same time:

 l Renew your newsletter subscription now.
 l Please confirm your subscription to the new [Company] newsletter now.

HTML format

Here is an example of an opt-in mailing in HTML format:
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Text format

There must be a text version of your opt-in mailing. Here is an example:
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Creating subscription and unsubscribe forms
This topic explains how to create forms for users subscribing to and unsubscribing from 
newsletters. The appendix provides model texts, error messages, and sample forms you 
can use for reference.

To begin,  provide Episerver with the information specified below. On request, Episerver 
creates customized subscription and unsubscribe forms for you. To do so, contact cus-
tomer support.

Required data
To subscribe to a newsletter, you typically need at least a user's email address. Gen-
erally, you want to additional information from a user, to address recipients personally. 
When requesting information, distinguish between required and optional fields.
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To comply with legal provisions, you must also specifically identify any personal inform-
ation that is required to make use of a service (only applies to email addresses), and any 
personal information collected with or without the user's knowledge. With respect to 
your subscription form, this means:

 l The only required field is the recipient's email address.
 l Other fields are optional (because they are not absolutely necessary to receive a 

newsletter). The personal information collected in them is provided voluntarily. 
These may include a user's interests, age and place of residence (or zip code). The 
user can select from a list of interests by clicking check boxes. Age and zip code 
can be selected from a list. This information does not require the recipient's declar-
ation of consent. If you want to make these required fields, include a reference to 
the rules on data privacy protection.

 l Personal information collected without a recipient's knowledge that occurs through 
that recipient's actions (click data), for example, by opening a newsletter, requires 
the recipient's consent.

Note: Each data field in a form must have a corresponding 
recipient list field  to which the data is imported.

Creating the design and text
The design of form pages should be as simple and clear as possible. Ideally, the user 
should not need to use the scroll bar to reach the bottom of a page. This means that 
the fields used in a form, data protection notices, and the Send button should be 
arranged so that they display in the most commonly used screen and font sizes without 
needing to scroll.

If the form is to be integrated into your web page, for example, your shop site, specify 
your frame size (width in pixels). In this case,  make sure that your website's HTML code 
supports scroll bars; otherwise, the form may not display correctly.

Using an HTML template

A good idea is to send Episerver the pages as HTML templates. You need a separate 
template for each page (for example, subscribe page, unsubscribe page).

If you use this option, texts (except error messages) must be included in the template in 
their final form. In addition, specify the error messages to be displayed if a field is not 
completed or filled out incorrectly.

If you want to provide the template as a graphic, send the text in a separate text file.
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Displaying error messages

Indicate which error messages should appear and where they should be displayed. For 
example:

Error Error message
Where to be dis-

played

No email address 
entered Please enter an email address. Next to email input 

field                     

Consent not provided You must confirm that you want to receive this 
newsletter. Next to check box                     

Required field not com-
pleted Please complete all required fields. Next to the applic-

able field                     

Note: Error messages should appear as text directly above, alongside, or 
below the applicable field in a form. Alternately, they may appear at the 
top of a page, with a reference to the applicable field. 

It is best if error messages are placed as close as possible to the ref-
erenced field, so their meaning is clear. Highlight the relevant field in 
color. Specify the font size, color and other style elements (background 
color, frames and so on) to be used in error messages, or provide 
Episerver with a graphic template.

Specifying confirmation texts

Specify text to display on the confirmation page (after registration is completed). Spe-
cify a sample layout (see above).

Setting up a confirmation email
If subscriptions use a confirmed or double opt-in process, you need to send a con-
firmation email to the recipients. Episerver can set up this email in your Episerver 
Campaign client so that it is sent automatically when a subscription is submitted. You 
can manage the content of this email through Episerver's systems. You can change the 
texts at any time.

To set up a confirmation email, specify the following information:
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 l Type of email (text, HTML or multi-part)
 l Name and email address of sender
 l Subject
 l Personalization (for example, salutation)

Handling user-provided data
Recipient data is forwarded to a recipient list in Episerver Campaign. Only data for 
which a corresponding field exists in the recipient list can be recorded.

You should first decide if you want to use an existing recipient list in your client. Which 
fields are available are determined by the fields in those recipient lists.

To create a new recipient list, tell customer support the recipient list name and which 
fields it should contain. In general, the following apply:

Form field type Recipient list field type

Free-form text Text

Pop-up menu Text (with set values)

Age, zip, and so on Numerical

Check box Boolean (possible values are true and false)

Option Text, numerical or boolean

Sample text and forms
The following are sample texts and forms. You may use the texts either as they appear or 
in modified form.

Data privacy notice on use of personal information provided voluntarily

Your personal information will only be stored if you provide it to us voluntarily, 
 for example, when registering, completing a survey or as part of a contract. 
 By providing this information to us, you are indicating your consent to the storage, 
 use and processing of this information. We will not disclose your information 
 to third parties without your consent. You may withdraw your consent to the storage 
 and disclosure of your personal information at any time.
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Data privacy notice on the use of data collected without the user's know-
ledge and stored in aggregate form

To personalize our newsletters and better address your specific interests, 
 we analyze and store your clicks on links in our newsletters. 
 We guarantee that the analysis and use of this information is carried out 
 only in aggregate form and that under no circumstances will this information 
 be transferred to third parties. By subscribing, you are indicating your consent 
 to the collection of this information. You can cancel your subscription at any time. 
 Your data will be deleted in its entirety upon cancellation.

Data privacy notice on the undisclosed collection of personal information

To personalize our newsletters and better address your specific interests, 
 we analyze and store your clicks on links in our newsletters. We guarantee 
 that the analysis and use of this information is carried out only in aggregate 
 form and that under no circumstances will this information be transferred to third parties. 
 By subscribing, you are indicating your consent to the collection of this information. 
 You can cancel your subscription at any time. 
 Your data will be deleted in its entirety upon cancellation.

Error messages

 l Please enter an email address.
 l Please enter a correct email address.
 l Please complete all required fields.
 l Please indicate that you accept the data privacy provisions and the terms of par-

ticipation.

Confirmation page

 l Simple "Thank you" page: Thank you for your subscription to our newsletter, which will 
be sent to example@example.com.

 l "Thank you" page (confirmed opt-In): We are delighted to periodically provide you 
with information about what's new at www.example.com. You will receive an email 
shortly confirming your subscription. You may of course cancel the newsletter at any 
time. You will find an unsubscribe link at the bottom of each newsletter.

 l "Thank you" page (double opt-In): We are delighted to periodically provide you with 
information about what's new at www.example.com. You will receive an email 
shortly asking you to confirm your subscription. To confirm your subscription, please 
click the activation link contained in this email. You may of course cancel the news-
letter at any time. You will find an unsubscribe link at the bottom of each newsletter.

 l Unsubscribe page: You have been unsubscribed from our newsletter.
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Sample form

Send last mailing after double opt-in

Note: To enable this feature, contact customer support.

This add-on sends the last regular newsletter to newly registered recipients after they 
complete the double opt-in process.

Unsubscribers

This topic describes how Episerver Campaign processes mailing unsubscriptions, and 
how to manage unsubscribers and insert an unsubscribe link into a mailing.

Consequences of a mailing unsubscription
If a recipient unsubscribes from your newsletter by clicking on the unsubscribe link or 
using the unsubscribe form, Episerver Campaign writes the recipient in a system-internal 
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unsubscribe list.

The recipient's data record is not deleted from your recipient list; it is duplicated and 
copied to the system-internal unsubscribe list.

Note: By default, the system-internal unsubscribe list is linked to all 
recipient lists of a client. The unsubscribe list is not inherited by 
other clients in your user account.

If you want to link the system-internal unsubscribe list to only one recipient list in your cli-
ent, contact customer support to change the configuration.

How it works
For each sending, Episerver Campaign compares your recipient list with the system-
internal unsubscribe list, then excludes recipients on the unsubscribe list. Episerver Cam-
paign takes this approach so you can continue to analyze periods when the unsub-
scriber was active. To remove unsubscribers from your recipient list, manually delete 
them from your recipient list using the Cleanup feature.

If subscribing to the newsletter again, the recipient is deleted from the system-internal 
unsubscribe list after confirming the double opt-in. The recipient begins to receive mail-
ings again.

Tip: Unsubscribes or new subscriptions are also possible via, REST API, 
SOAP API and HTTP API.

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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Querying a system-internal unsubscribe list
In the Episerver Campaign user interface, you cannot see the system-internal unsub-
scribe list. However, you can query unsubscribers as follows. But you can use the REST API 
to retrieve information about all unsubscribes. If you are using the SOAP API, use the con-
tains and containsAll methods to query whether one or more recipients are on an unsub-
scriber list.

You can also export unsubscribers as CSV files. See Exporting recipients.

Deleting unsubscribers from a recipient list
Use Cleanup to delete unsubscribers from a recipient list.

Inserting an unsubscribe link into a mailing
If you use the Episerver Campaign's unsubscribe logic, Episerver sets up a field function 
to insert the unsubscribe link into your mailing. You can integrate the unsubscribe link in 
your mailing in two ways:

 l Display the unsubscribe link URL: For example: To unsubscribe from the newsletter, 
click here: example.com/unsubscribe/123456abcdefg.

 l Link the unsubscribe link to a word or phrase, such as To unsubscribe from the news-
letter, click here.

Displaying the URL of the unsubscribe link
 1. Move to the editor window of the mailing and click on the name of the paragraph 

that will contain the unsubscribe link (such as text/image paragraph or footer para-
graph).             

https://api.campaign.episerver.net/apidoc/index.html#/Unsubscribes/selectUnsubscribes
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/unsubscribewebservice/contains/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/unsubscribewebservice/contains/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/unsubscribewebservice/containsall/
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 2. In the editor, insert the note for unsubscribing the mailing, such as To unsubscribe 
from the newsletter, click here:.

 3. To insert the URL of the unsubscribe link directly, click where you want to insert the 

URL and click Insert field function  .                      
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 4. Select from the list the field function for the unsubscribe link and click OK.
 5. Click Apply. The field function is displayed in curly brackets: {Unsubscribe Link}. When 

the mailing is sent, Episerver Campaign resolves the field function and inserts the URL 
of the unsubscribe link into the mailing individually for each recipient.
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Linking the unsubscribe link to a word or phrase
 1. In the mailing's editor window, click the name of the paragraph that will contain the 

unsubscribe link (for example text/image paragraph or  footer paragraph). 
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 2. In the editor on the right side, insert the note for unsubscribing the mailing, such as 
To unsubscribe from the newsletter, click here.

 3. Highlight the word or phrase  to be linked to the unsubscribe link, such as here.
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 4. Click Link  .

 5. Enter the URL field {Unsubscribe Link} in curly brackets. In the drop-down list Protocol, 
the type changes automatically to <other>.                       
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 6. Click OK.
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 7. Click Apply.               

Changing the confirmation page URL

Note: For this feature you need administrator rights in Episerver Cam-
paign.

To change the URL of the confirmation page the unsubscribe link points to, do the fol-
lowing:

 1. Open the start menu and select Administration > Unsubscribe link.
 2. In the input field, make your changes to the URL of the confirmation page.

Note: The URL must begin with the http:// or https:// protocol. 
Make sure that the confirmation page is accessible at any 
time.

 3. Click Save.
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FAQs
 l Can I add a recipient to the unsubscribe list or remove a recipient from the unsubscribe 

list using Episerver Campaign?

No. The unsubscribe process can only be carried out by the recipient himself. To can-
cel unsubscription, the recipient has to subscribe to the newsletter again (depend-
ing on the configuration with opt-in).

 l Can I unregister a recipient by deleting the recipient from the recipient list?

If deleted from a recipient list, the recipient receives no more mailings via this list. If 
existing on more than one list, the recipient continues to receive mailings via other 
recipient lists from which he or she has not been removed.

Warning: This procedure is not recommended, as the deletion is 
not recorded and the recipient can be accidentally added to 
a recipient list again, for example when importing recipients. 
The legal consequence can be a warning if the recipient 
receives mailings despite unsubscribing.

 l I maintain my recipient list by myself and import it to Episerver Campaign before each 
sending. What do I have to consider?

Make sure that you import only active recipients into the recipient list. Import unsub-
scribers into the unsubscribe list so that the cross check can take place before dis-
patch.

You can import unsubscribe lists or multiple lists via specially set up jobs/services. 
These jobs/services cannot be accessed via the Episerver Campaign user interface. 
The corresponding lists are transferred to the Episerver Campaign server via SFTP and 
automatically imported into the client:

 o Import unsubscribe list.  Import your local unsubscribe list into the unsubscribe list 
of your Episerver Campaign client.

 o Import recipients including unsubscribers. Import a single recipient list that con-
tains active recipients from different lists and unsubscribers. Enter the status of 
the recipient or the list into which you want to import in a separate column of 
the recipient list. In this way, you always have consistent lists.

To configure the jobs/services, contact customer support. You must have a defined 
name for the files that you want to import. You also must upload the files in a 
defined directory via SFTP.
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 l What are list unsubscribe headers?

By using list unsubscribe headers in a newsletter, recipients can unsubscribe from a 
mailing via the user interface of their email program (such as Gmail or Outlook). 
Searching for the unsubscribe link in a mailing is not necessary this way. 

Recipient history

Note: To enable this feature, contact customer support.

Use the recipient history to view the message history (Mailings Classic and Smart Cam-
paigns), the Marketing Automation history and the campaign analysis (Smart Cam-
paigns), view the opening and click behavior of your recipients and the third-party ID. This 
lets you see which email, which SMS, which push message you have sent and to whom it 
was sent. 

For example, if a recipient contacts you to say that a newsletter was not received, you 
can investigate the reason why. In the recipient history, enter the recipient’s data to 
see an overview of their communications. Using this information, you can check to see 
whether the recipient has perhaps inadvertently unsubscribed. You might see that the 
newsletter is sent and you should ask the recipient to check in their spam folder for the 
newsletter. You can even check to see if the recipient is currently in a Wait node and will 
receive the expected newsletter later on in the day.

You also can see how each recipient reacted to your communication with them: which 
messages they opened, and which links they clicked.

Note: Recipient history is not available for print messages.
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Showing message history
 1. Open the start menu and select Recipients > Recipient history.

 2. In the Search recipient based on drop-down list, select the type of information to use 
to find the message history for the recipient. You can use the recipient ID, email 
address, mobile phone number or a push token. 

 3. In the next field, enter the recipient ID, email address, mobile phone number or push 
token to search for.
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 4. You can limit the time period for which the message history is displayed by entering 
start and end dates under Define reporting period (optional). If you do not enter a start 
and end date, the entire message history for the recipient is shown.

 5. By default, recipient lists within the entered data sets for your client is searched. If 
you want to limit the search to specific recipient lists, use the Search in drop-down 
list and select the check box next to each recipient list you want to search.
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 6. When you have completed the fields, click Start search.

Tip: The search may take several minutes depending on the 
number of recipient lists being searched. The message "Load-
ing, please wait..." is displayed at the bottom right in the status 
bar to indicate that a search is being executed.

When the search has completed, the message history for the recipient is shown. The 
list starts with the most recent message.

The message history provides the following information:

 l recipient ID
 l recipient lists in which the recipient can be found
 l mailing IDs of messages sent to this recipient
 l media types of the messages sent (email, SMS, Mobile Push)
 l start times of the messages
 l mailing types (regular, special, temporary (test messages) or campaign)
 l mailing name
 l subject
 l send date
 l number of openings
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 l number of clicks in the messages 

Note: To display the number of openings and clicks, the users 
of your client must have permission to view action data. If 
your users want this permission, contact customer support.

 l send status
 7. To view the content of a message, click Show mailing. Depending on the media 

type selected, you can select a display option from the drop-down list to the left of 
the button. For example, if the media type is Email, you can choose to display the 
message as either HTML or plain text. 

Note: The current message content is displayed. Older versions can-
not be reconstructed. Therefore, the displayed message may differ 
from the message that a recipient previously received if the mes-
sage is subsequently modified.

Showing consent history
A consent is an email of the mailing type Confirmation email in which a recipient 
provides consent by clicking a confirmation link. The consent has a version and time 
stamp, so you can see when it was registered.

To access archived consent information:

 1. Open the start menu and select Recipients > Recipient history.
 2. Identify recipients for whom you want to view confirmation emails. For example, use 

the Email address criterion to search for a recipient.
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 3. Under Message history, search for a message of the Mailing type Confirmation email.

 4. Click Show sent mail. The consent email appears.

 5. Use the HTML and Text tabs to see the selected email in its HTML and text version  as it 
was sent at the time stated. Click Header to get detailed information about the 
header data of the email. The tab Opt-in Details provides information about when 
the opt-in request was sent and when it was confirmed.

 6. Optionally download the consent email.
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Showing opening and click behavior
The recipient history can show you the messages that the recipient opened and the 
links that the recipient clicked in the message. 

Note: To display the number of openings and clicks, the users of 
your client must have permission to view action data. If your users 
want this permission, contact customer support.

To display the opening and click behavior of recipients for individual messages, perform 
the following steps: 

 1. In the Message history tab, select the message for which you want to see the open-
ing and click behavior.

Tip: The number of opens and clicks is shown in the message his-
tory list in the Opens and Clicks columns.

If opening and click data is available for the selected message, then Show opens 
and clicks is enabled.

 2. Click Show opens and clicks.

A new list expands showing the action data type (open or click), the time, the mail-
ing name, the mailing ID, which links were clicked, and the media types.
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 3. To see the message associated with the opening and click behavior, click Show mail-
ing. Depending on the media type selected, you can select a display option from 
the drop-down list to the left of the button. For example, if the media type is Email, 
then you can choose to display the message as HTML or plain text. 

Showing campaign analysis
If a message in message history is part of a campaign or Smart Campaign, you can dis-
play the associated campaign analysis. 

 1. In the Message history tab, click the message for which you want to view the cam-
paign analysis.
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 2. Click Show campaign analysis. 

A new window opens with the campaign analysis, showing the 

 l net number of recipients
 l the bounce rate
 l unique unsubscribe rate
 l unique opening rate
 l unique click rate
 l effective unique click rate of the selected campaign
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Showing Marketing Automation history
 1. Next to the Message history tab, click the Marketing Automation history tab. The Mar-

keting Automation history is displayed in a list that shows the recipient ID, campaign 
ID, start date, campaign name, recipient status, and a preview of the history.

 2. To get an ordered overview of the recipient's entire history, select the cor-
responding Marketing Automation campaign from the list by clicking the entry. The 
action list for the Marketing Automation campaign opens, showing  recipient 



© Episerver 2020

Recipients | 679

actions within the Marketing Automation campaign and the associated date. 

Display Event Example

Started in "..." 
node #...

The recipient has started in the specified node. 
The corresponding node ID is shown after the # 
symbol.

Started in "New recip-
ient" node 
#123456789

Started in cam-
paign "..." (#...)

The recipient is delegated within a campaign to 
another campaign. The corresponding cam-
paign ID is shown after the # symbol.

Started in campaign 
"More offers for you" 
(#123456789)

Forwarded to 
"..." node #...

The recipient is forwarded to the specified 
node. The corresponding node ID is shown after 
the # symbol.

Forwarded to "Wait" 
node #123456789

Wait until...
The recipient is waiting or has waited in a Wait 
node until the specified time.

Wait until 2016-09-01 
11:15:31

... message "..." 
(#...) sent to 

The message is sent to the recipient. The mes-
sage media type (Email, SMS or Mobile Push), the 

Email message "Wel-
come" 
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Display Event Example

recipient

name of the message and the message ID 
(after the #) is shown.                                         

To view the message content, select the cor-
responding entry and click  Show mailing. 
Depending on the media type selected, you 
can select a display option from the drop-down 
list to the left of the button. 

For example, if the media type is Email, you can 
display the message as HTML or plain text.

(#123456789) send 
to recipient

Message ... sent 
to recipient 
(details no 
longer avail-
able)

The message is sent to the recipient. The sending 
time is displayed. Further details cannot be dis-
played, as these are no longer available.                                          

This message usually relates to test messages 
that were sent and whose content is not per-
manently stored by Episerver Campaign.

Message 2016-09-01 
11:15:31 sent to 
recipient (details no 
longer available)

completed in 
node #...

The recipient passed through the campaign 
and is completed. The corresponding node ID is 
shown after the # symbol.

completed in node 
#123456789

Not completed 
in node #...; 
Error: "..."

The recipient did not pass through the cam-
paign. The corresponding node ID is shown after 
the # symbol. The error is displayed as a numer-
ical code:

-
1

Default error   (a possible reason could be a 
mailing dispatch error)

1 The recipient is on the blacklist.
2 The recipient is on an unsubscribe list.
3 The recipient has exceeded the bounce limit.
4 The recipient was not found.
5 The recipient is already existing.
6 Invalid mailing status

Not completed in 
node #123456789; 
Error: "1"

Recipient 
edited: ...

The recipient is edited in Marketing Automation 
in the Change recipient node. The cor-
responding change is shown.

Recipient edited: The 
value of the "Cus-
tomer status" field 
changed to 
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Display Event Example

"Premium customer"

Recipient not 
modified - 
Recipient is not 
in the recipient 
list "..." (#...) 
defined in the 
"Change recip-
ient" node

The recipient has not been edited in the Change 
recipient node because the recipient is not in 
the specified recipient list. The recipient list ID is 
shown after the # symbol.

Recipient not mod-
ified - Recipient is not 
in the recipient list 
"Existing customers" 
(#123456789) 
defined in the 
"Change recipient" 
node

Copied to recip-
ient list "..." (#...)

The recipient has already been copied to the 
specified recipient list. The recipient list ID is 
shown after the # symbol.

Copied to recipient 
list "Premium cus-
tomers" 
(#123456789)

Recipient not 
copied – the 
recipient is 
already con-
tained in recip-
ient list "..." (#...)

The recipient is not copied to the recipient list 
because they are already in the specified recip-
ient list. The recipient list ID is shown after the # 
symbol.

Recipient not copied 
– the recipient is 
already contained in 
recipient list "Existing 
customers" 
(#123456789)

Recipient not 
copied – the 
copy option 
was not selec-
ted

The recipient is started in a parallel Marketing 
Automation campaign via the Start in node. The 
additional option First copy to is not selected.

Recipient not copied 
– the copy option 
was not selected

Updated in 
recipient list "..." 
(#...)

The recipient is copied to a recipient list that has 
an existing entry for that recipient. The recipient 
dataset is updated in the target recipient list. 
The ID of the target recipient list is shown after 
the #.

Updated in recipient 
list "Existing cus-
tomers" 
(#123456789)

Updated in 
recipient list "..." 
(#...( and 
deleted in "..." 
(#...)

The recipient is copied to a recipient list that has 
an existing entry for that recipient. The recipient 
dataset is updated in the target recipient list. 
The recipient dataset is deleted from the source 
recipient list. The names and ID (after the #) for 
the corresponding recipient lists are shown.

Updated in recipient 
list "Active cus-
tomers" 
(#123456789) and 
deleted in "Inactive 
customers" 
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Display Event Example

(#1122334455)

Matched target 
group "..." (#...)

The recipient is assigned to a target group. The 
ID of the target group is shown after the #.

Matched target 
group "Women" 
(#123456789)

Showing the third-party ID
In the Third-party ID tab, you can find the pseudonymized ID of the selected recipient.

To view the third-party ID, click Third-party ID next to Marketing Automation history.

The Third-party ID tab provides the following information:

 l Recipient ID. ID of the recipient selected in Search recipient based on.
 l Email address. Email address of the recipient.
 l Third-party ID. Pseudonymized ID of the recipient.

Exporting mailing and performance data

Note: To enable this feature, contact customer support.

This add-on lets you export mailing and performance data to further process it in an 
external system. The data is exported to a CSV or XML file. 

The export runs at a defined interval, such as daily at midnight or once a week. You can 
download exported data via SFTP from a secure server.
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Click profiles

Link tracking is the most important tool for measuring the performance of campaigns 
and creating customized remailings. Click profiling creates target groups and allows 
reports to be generated. The clicks users make are the basis of click profiling. For 
example, email recipients who frequently click Blu-ray offers can be segmented via a 
click profile then supplied with targeted and highly relevant information.

Click profiling lets you create profiles – manually or automatically and independent of 
individual mailings or links – that are associated with the tracked links in your mailings. 
When created, tracking links are tagged. 

Tip: Click profiling complements tracking link management – and 
its functions remain preserved. You can still edit links in a mailing 
individually via the Tracking tab in the Edit mailing wizard. 
Determine whether the link in the HTML and text version should be 
tracked and enter a description of the link.

To start the function, open the start menu and select Recipients > Click profiles.
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Creating and editing click profiles
 1. Open the start menu and select Recipients > Click profiles.
 2. Click Create.
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 3. Enter a name and an optional description.
 4. Optional: In the Folder drop-down list, select a folder in which to save the new click 

profile.
 5. Click Finish.

To edit a click profile, select it from the list and click Edit.

To assign links to the newly created profile, see Assigning click profiles.

To create a rule-based profile and automatically assign links, see Assigning rule-based 
click profiles automatically.

Assigning click profiles
 1. To assign links manually to one or more click profiles, open the start menu and select 

Recipients > Click profiles. 
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 2. Select the desired click profiles and click Assign.

 3. In the Assign click profiles window, in the Mailings drop-down list, select one ore more 
mailings to display links from these mailings in the Tracking links list.

 4. In the Tracking links list, select one or more links that you want to assign to a profile. 
The Click profiles drop-down list below this list shows profiles. If you already selected 
a profile in the overview window, it is displayed.

 5. You can change, add or remove profiles.
 6. To save the assigned links, click Add.

Removing an assigned click profile
 1. In the Click profiles window, click Assign and select one or more mailings. 
 2. Select a link.
 3. Click Remove to unassign the profiles from that link. Automatically assigned profiles 

cannot be removed.
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Tip: If you unassign a profile, it is only removed from the link. The pro-
file itself cannot be deleted.

Assigning click profiles when editing a mailing
 1. From the list in the Tracking tab, select a link and click in the Profiles field. 
 2. Select one or more profiles from the selection window and click OK.

If you use a mailing template that is configured accordingly, you see a Click profiles tab 
in the editor window of a paragraph. To assign a profile to links of a paragraph, select 
the check box next to the desired profile.

Tip: Manually assign rule-based profiles
You also can assign rule-based profiles manually to a link that does 
not match the rule using the function described in the previous 
paragraph. These links may be considered the exceptions to the 
rule. Reciprocally, rule-based profiles cannot be removed from a 
link that does match the rule.

Rule-based assignment

Rule-based click profiles automatically assign tracking links. To enable this, the link URL is 
analyzed according to the character strings it contains or on the basis of regular expres-
sions. The rules for automatic assignment are configured during the creation or editing 
of a click profile. Two fields are allocated for this purpose. 

 l Rule. Contains details of the character string the URL of a link must contain, or what 
rules the construction of a URL must follow, so that a profile can be assigned. You 
can use wildcards (?, *) to track link URLs with specific recurring character 
sequences to be categorized. You can also use regular expressions.

 l Rule type. The rule and rule type must match together for rule-based assignments to 
function. 

Test rule-based click profiles to ensure the desired result is achieved. Rule-based click 
profiles can be adjusted at any time, and assignments are automatically updated. 

Tip: Rule-based assignments cannot be removed. If you change a 
rule, assignments are updated. This means that links that are no 
longer applicable will are not shown in the corresponding profile.
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Wildcard example

The following link is to be analyzed with a wildcard click profile:

www.example.com/new_article/xy/ref=1234

If tracking links to the newest articles in your online shop contain .../new_article/... in 
the URL, you would formulate the following wildcard rule to automatically tag the link:

*/new_article/*

Regular expression example

Regular expressions let you formulate sets and subsets of character strings with the help 
of syntactic rules. For example, you can define that a URL contains or does not contain 
specific characters. Regular expressions also allow the filtering of number ranges. They 
treat URLs as a character sequence (string) and analyze them according to the formal 
criteria of the regular expression.

The following link is to be analyzed with a regular expression. In contrast to the URL in the 
previous example, this link does not contain a section that can be analyzed using a rule. 
But you can solve the problem using a number range filter:

www.example.com/xy/ref=1234

In this case, the regular expression examines letter code and the article reference:

.*[x-z][x-z]/ref=12[0-9][0-9]

 l A dot and an asterisk (.*) stand for any characters.
 l Square brackets ([]) denote a range. In this case, the letters x, y, or z can be in the 

first or second position. 

 o The expression filters xx, xy, xz, yx, yy, yz, zx, zy and zz.
 o This expression filters numbers from 1200 to 1299. The first two numerals must be 1 

or 2. The numerals in third or fourth place can range from 0-9. Four numerals must 
exist.
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Responses

Responses are messages sent back to the sending server (in this case, the Episerver Cam-
paign server) for various reasons. 

Responses are classified by filters. In the Response type drop-down list, you can select to 
show autoresponders, hard bounces, soft bounces, replies, keyword SMS, or types. Hard 
bounces, soft bounces, and autoresponders are shown for the sake of completeness. 
There is no need for action on your part, as Episerver Campaign automatically takes 
care of them.

To display responses, perform the following steps:

 1. Open the start menu and select Responses  > Overview.
 2. Click the Mailings box.
 3. Select one or more mailings.
 4. Click OK.
 5. In the Response type list, select one of the following response types:

 l All. Responses from all categories.
 l Hard bounce. Unreachable email addresses. This occur if recipients change pro-

viders/web mailers. You should not manually erase these recipients because 
Episerver Campaign stops sending them emails after the third hard bounce. This 
threshold can be altered for your account/client.

 l Soft bounce. Temporarily unavailable email accounts. This can occur if a recip-
ient mailbox reaches its capacity, and can only accept new email after  some is 
deleted. You should not manually edit soft bounces because the addresses may 
be reachable again.

 l Autoresponder. Automatic reply email, such as On holiday until May 26.
 l Keyword SMS. Incoming SMS that can be assigned to a running SMS process. See 

SMS processes.
 l Reply. Replies from mailing recipients. The standard Episerver Campaign setting  

is that such replies are not sent to you but to the system. If you want to receive 
these replies in your email account, contact customer support.    

Tip: Filters for the response type
Episerver Campaign filters are set to specify a response with 
maximum likelihood as a hard bounce, soft bounce, 
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autoresponder, or keyword SMS. If an email cannot be 
assigned to one of these categories, it is moved to the Reply 
category so that no real reply is lost. You may also find 
autoresponders and undelivered email in this category.

 l Spam. Spammers do not send from their own mail servers but from computers of 
unsuspecting users. Worms or Trojans (malware) infiltrate user's computers, 
where they can be misused to send spam. If your mailing is sent to a recipient 
whose computer is infiltrated, it automatically sends spam to the mailing return 
address. The Episerver Campaign server's spam filter places the spam  in the 
spam category.

 6. Click Show. The Overview area displays responses.

 l Received column. The sending date of the email. Bounces and autoresponders 
are usually sent the same day the mailing is sent. Responses can be sent several 
days afterwards.

 l Type column. The response type.
 l Recipient column. The sender of the email.
 l Recipient details tab. Details of a response, including email address, recipient 

registration date,  and other data.
 l Display reply. To display the text of the email of the recipient:

 a. Click the Reply tab. 
 b. Click  Open in new window to increase the size. 
 c. Click  Print.The browser's print dialog box opens automatically. 
 d. Confirm the print dialog.

Blacklist overview

When a recipient is placed on a blacklist, the recipient will receive no more email from 
you via Episerver Campaign, even if the recipient registers to receive mailings again. 
This ensures that your recipient lists have no dissatisfied recipients. And, a clean recip-
ient list with just a few complaints has a positive impact on the deliverability of your mail-
ings.

To display the blacklist, open the start menu and select Blacklist > Overview. You can per-
form the following actions for the blacklist.
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Adding a recipient to a blacklist
 1. Click Add. A blank line is added to the list.
 2. Enter the email address of a recipient. 
 3. You may enter a reason for blacklisting (for example, complaint).
 4. Click Apply.

Adding to a blacklist automatically 
If a recipient marks an unwanted email as spam, Episerver Campaign is notified by the 
email service provider, and the recipient is added to the blacklist.

Typical reason of a automatic blacklist entry:

type=automatic;rule=FBL: AOL;mailing=12345678;m2u=987654321

Editing a blacklist entry

Note: You cannot edit automatic blacklist entries.

 1. To change the reason for blocking,  click the entry you want to edit.
 2. Click Edit.
 3. Edit the content of the Reason box.
 4. Click Apply.

Deleting a blacklist entry

Note: You cannot delete automatic blacklist entries.

 1. Click the entry you want to remove from the blacklist.
 2. Click Delete.
 3. Confirm the deletion. The recipient is deleted from the blacklist and can receive 

your mailings again.

Using wildcards
Instead of entering a complete email address, you can use wildcards in the blacklist 
entries.
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 l Use the asterisk (*) as placeholder for one or more characters. For example, to block 
email addresses from a specific domain such as example.com, specify *@example.com.

Note: Searching the blacklist may result in multiple entries. For 
example, axel@example.com and *@example.com may both 
be on the blacklist. If axel@example.com is removed from the 
blacklist, Axel would still not receive mails because the 
example.com domain is blocked.

 l Use the question mark (?) as placeholder for a single character. For example,  you 
are not sure about how a name is spelled correctly, such as Mar? for Mark, Marc, or 
Mary.

 l You can use placeholders in the domain part of an email address. For example, 
abuse@* blocks email addresses starting with abuse. This account name is usually con-
figured by companies and providers as a default email account for customer com-
plaints. If somebody registers for your newsletter with such an email address, it can 
be both annoying and cause serial problems and damage your internet reputation.

Importing blacklists
When you initially import recipients into Episerver Campaign, or if you frequently import 
recipients from a local list, you should also import a blacklist. This function lets you 
import a CSV file with blacklisted recipients or wildcard blacklist entries into your client. 
A blacklist entry can be a complete email address or contain placeholders. See also: 
Wildcards.

To import a blacklist, perform the following steps:

Prerequisite: A CSV file that contains blacklist entries.

 1. Open the start menu and select Open the start menu > Blacklist > Import.
 2. Click Browse... and select a CSV file from your computer that contains the blacklist 

entries.
 3. Click Import options. The Preview area shows entries encountered in the CSV file. The 

Rule column must contain the respective email addresses or wildcards to be black-
listed. Only this first column is imported.

 4. If the columns are not displayed correctly, select an encoding type from the File 
charset list by changing the separator and escape characters.

 5. If the first line of the CSV file contains a table head with column designations, select 
Yes in the Skip first row drop-down list.

 6. Click Refresh preview to check your settings.
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 7. Click Reason. Optionally, you can enter a reason for blacklisting the imported 
entries. The reason you enter here applies to all imported entries.

 8. Click Finished.

Importing and exporting a blacklist

Note: To enable this feature, contact customer support.

This add-on automatically imports a CSV file to update the blacklist entries. The file is 
transmitted via SCP (Secure Copy Protocol) and stored on a server provided by 
Episerver. The import to your client is handled automatically. You receive a success noti-
fication after each import. The import does not delete existing blacklist entries.

The automatic blacklist export writes blacklist entries to a CSV file and stores it on a 
server provided by Episerver. You can download it automatically or manually from this 
server.

You can configure import and export separately.

Cleaning up blacklists

Note: This function deletes blacklist entries by reason. If you want to 
delete a single email address or a blacklist rule (wildcard), use the 
delete entry function.

To remove blacklist entries, perform the following steps:

 1. Open the start menu and select Blacklist > Cleanup.
 2. In the Reason field, enter the reason why you want to delete entries, such as com-

plaint. Use the asterisk * placeholder for multiple characters, and a question mark ? 
for a single character.

 3. Click Count to see how many entries with this reason exist.
 4. Click Confirm deletion.
 5. Click Delete blacklist entries.
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Custom blacklists

Note: To enable this feature, contact customer support.

This optional feature allows you to exclude mailing recipients who are not part of the 
global blacklist.

You can create multiple custom blacklists and fill them manually or via CSV data 
import. Then, use a Block node to add custom blacklists to a campaign in Smart Cam-
paigns or to a transactional mail. As a result, you specify which recipients besides the  
global blacklist should not receive a mailing. 

Creating a custom blacklist
 1. Open the start menu and select Blacklist > Custom blacklists.

 2. Click Create.
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 3. Enter a name for the custom blacklist.
 4. Select one of the hash algorithms supported by Episerver Campaign. If the entries in 

your blacklist don't use hash algorithms, select None.

Note: As long as your custom blacklist is empty, you may change 
the hash algorithm anytime.
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 5. Click Submit to create the custom blacklist.

Note: You can delete all entries in a custom blacklist by clicking 
Clear.
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Adding and editing recipients manually
 1. Open the start menu and select Blacklist > Overview.

 2. Under Blacklist selection, click Custom blacklist and select  the blacklist you want to 
edit.
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 3. Edit the custom blacklist by clicking the Add, Edit and Delete buttons. For more 
information, see Blacklist overview.

Importing blacklists
To import entries from a CSV file into a custom blacklist, perform the following steps.

 1. Open the start menu and select Blacklist > Import.

 2. Under Upload, click the Browse... button and select a CSV file on your local hard disk.
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 3. Click Import options to upload the file.
 4. Under Blacklist selection, click Custom blacklist. 
 5. Select the custom blacklist to which you want to import the CSV file.

 6. Under Specify the hash algorithm used in the import file, select your CSV file's hash 
algorithm. Select None if your CSV file entries  use no hash algorithm.
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Note: The CSV file's hash algorithm  must match the hash 
algorithm of the selected blacklist. If not, an error appears. Cor-
rect your selection under Specify the hash algorithm used in the 
import file. Or, under Custom blacklists, change the hash 
algorithm of the custom blacklist. You may also create a new 
custom blacklist with the correct hash algorithm.

 7. Under Character encoding and CSV options, you can change CSV file options. For 
more information, see Import blacklists.

 8. Click the  Reason button. You can optionally enter a reason for blacklisting the impor-
ted entries. The reason  applies to all imported entries.

 9. Click Finished.

Changing email addresses

Note: To enable this feature, contact customer support.

Usually, the email address is used as a unique ID to identify a recipient. Episerver Cam-
paign uses this unique ID in various functions carried out during recipient import, mailing 
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dispatch. and so on. Therefore, you cannot change a recipient's email address. 
However, customer support can supply an add-on that lets you change a recipient's 
email address in sub-clients.

Exporting recipients by category

Note: To enable this feature, contact customer support.

This function lets you automatically export recipient data by category into CSV files.

 l Active recipients
 l Blacklisted recipients
 l Post-clicks (requires web analytics software with an export function)
 l Recipients that exceeded the bounce limit 

An individual CSV file is created for each category. Alternatively, you can create a mul-
tiple lists with flags for each category. 

Importing recipients by category

Note: To enable this feature, contact customer support.

If you maintain distribution lists in an external system, this add-on lets you synchronize 
your external distribution list with Episerver Campaign recipient lists. The add-on  lets you 
automatically import recipients into your  client.

You can import the following categories in individual CSV files or as multiple lists with 
markers for each category:

 l Recipients
 l Unsubscribers
 l Blocked recipients
 l Post-clicks (requires a web analysis program with an export function)
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Preference Center

The Preference Center lets recipients set their own preferences and update personal 
information. Do this through a form that you incorporate into your web presence as a 
standalone element, or integrate into a template using an iFrame.

Recipients can access the page via a website link or in a mailing, then edit their per-
sonal information. The information is transferred by REST API, SOAP API or HTTP API  to 
Episerver Campaign and stored in the recipient data. You can use the generated data 
to create lifecycle marketing campaigns and tailor-made mailings.

For example, mailing recipients can make the following settings in the Preference 
Center:

 l Updating personal information (email address, name, postal address)
 l Specifying interests
 l Selecting topics (channels)
 l Setting up the frequency of receiving mailings (for example, bi-weekly, monthly)

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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Requested data
Data that a recipient enters in his/her profile is considered voluntarily disclosed personal 
information. As long as this information is submitted voluntarily and not disclosed to third 
parties, there is no limit on the type of data you can request. 

Ensure data minimization and transparency:
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 l The recipient should readily understand the purpose of the data request.
 l Only request information that you need and that serves to optimize the service you 

are providing to the recipient.
 l Indicate which information is mandatory and which is voluntary. See Legal com-

pliance.

If you are already conducting email marketing through Episerver Campaign, you can 
use the recipient lists in your client to see what recipient-based data is currently avail-
able. Users can edit this data in the Preference Center. 

To optimize the content of your mailings, recipients should be provided with additional 
options. For example, you may want to furnish a listing of various areas of interest and 
allow the recipient to select one or more. Alternatively, you could offer several chan-
nels for the recipient to subscribe to. Through dynamic marketing, you can place spe-
cific content in mailings associated with each channel, content that only subscribers to 
those channels receive, while withholding content from channels to which the recipient 
has not subscribed. 

Legal compliance
The data protection notice must contain information about the collection, storage, use 
and transfer of data. It must also reference the user's right to have data deleted and the 
obligation of the party collecting the data to provide information about that data. The 
text of a data protection notice need not be included on the form page itself. You can 
include a link to the appropriate page. 

Although not mandatory, you should emphasize that none of the information collected 
is disclosed to third parties. The same applies to notifications about data security pro-
tection.

In email marketing, collect data from required email address fields only if it is essential 
for the purpose of distributing mailings; other fields, like Recipient name, should not be 
required. You should indicate the purpose for which personal information collected 
through the Preference Center is used. For example, you should emphasize  that names 
are collected solely for the purpose of personalizing mailings. If you request address 
information, indicate that it is collected to provide news about offers limited to a spe-
cific geographic area and so on. There are no limits on the information you can collect 
except for email addresses and information must be provided voluntarily.

Exchanging data 
The exchange of data between the Preference Center and Episerver Campaign is car-
ried out via REST API or SOAP API. When a recipient opens the Preference Center through 
a mailing, the recipient ID is transmitted and the recipient data contained in the 

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
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Episerver Campaign database is imported. When the recipient edits his/her profile, the 
updated data is transmitted back to Episerver Campaign.

Note: You can also use HTTP API for the Preference Center except 
that you cannot  import recipient data into a web form. For 
example, you can forward the mailing ID and recipient ID (usually 
the email address) from a mailing, and record the recipient data in 
the database, but the recipient cannot view his/her old data.

If you link to the Preference Center from your website, you cannot identify the recipient 
ID. In this case, the recipient must first enter a recipient ID (usually the email address). 
The same rule applies: If you are using REST API or SOAP API, you can import recipient 
data, which you cannot do using HTTP API.

Form fields
Depending on the type of fields used, you can configure the Preference Center form 
fields in different ways. Fields into which text is entered are set up as text fields. These 
include the fields Email Address and Name. You can set up fields with fixed values as lists 
or check boxes. Fields that list interests or topics should allow for multiple selections. If 
only a single item may be selected (such as frequency of mailings), use either a drop-
down list or a radio button. The available fields are:

Caption Type
Required 

field
Standard

Email address 
(required)                    single-line text field                     ✓ —                     

Last name                     single-line text field                     ✘ —                     

First name                     single-line text field                     ✘ —                     

Salutation                     radio button, drop-down list                     ✘ —                     

Date of birth                     data field with selection window                     ✘ —                     

Age                     drop-down list (for example, B. 20-30, 30-40)                     ✘ —                     

Interests                     list with check boxes                     ✘ —                     

https://world.episerver.com/documentation/developer-guides/campaign/http-api/


© Episerver 2020

706 | Episerver Campaign User Guide 2020-04-23

Caption Type
Required 

field
Standard

Mailing frequency 
(standard)                    

radio buttons (for example,  weekly, bi-
weekly, monthly)                     ✘ yes                     

Other fields, as reques-
ted                     

radio buttons, text fields, drop-down lists, 
check boxes                     ✘ —

Displaying error messages
Error messages should appear as text directly above/alongside/beneath the applicable 
form. Alternatively, these messages may also appear at the top of the page, ref-
erencing the applicable field. The field being referenced should be highlighted in color. 
The following provides several sample error messages:

Error Error message

No email address entered                     Please enter an email address.

Consent not provided                     You must indicate that you want to receive this newsletter.

Required information not entered                     Please complete all required fields.

Design/templates tips
Keep form pages simple and clearly arranged. Ideally, the user should not have to scroll 
to reach the bottom of a page. Fields in a form and the Send button should be arranged 
to display on standard screens and in commonly used font sizes without using the scroll 
bar.

If Episerver creates and integrates a Preference Center for you, it is set up as a separate 
page. You can link directly to this page or integrate it into a template using an iframe. If 
you choose the latter option, you need to coordinate page width and height with cus-
tomer support to make sure the content displays correctly.

To create a web form, provide Episerver with a template in HTML format or a layout tem-
plate and the accompanying error messages.
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Security tips

Password protection
To protect recipient data from misuse, access to the Preference Center must be pass-
word protected. Make sure that users can only access the Preference Center (their 
data) after they verify authorization.

Changing email addresses
To prevent misuse, users should not be able to freely change their email address. The 
procedure used for changing email addresses could look like the following:

 1. The recipient enters a new email address, which is saved temporarily.
 2. A double opt-in process is initiated for the new email address.
 3. The address is changed only after the recipient confirms the change. If not con-

firmed, the original email address is restored.





© Episerver 2020

Analytics | 709

Analytics

This section describes Episerver Campaign’s analysis tools to gather statistics after dis-
patch, or check and optimize your mailings before you send them. If you want to use 
third-party analysis tools, see Web analytics integrations.

 l Performance Dashboard (Beta). Create a graphical overview of your marketing activ-
ities.

 l Deep Analytics. Create cross-client analyses with more than 30 measurement vari-
ables.

 l Reports. Analyze mailing statistics.
 l Live Analytics. Create RFM analyses.
 l Deliverability preview. Check displays and spam suspicion with the most important 

email providers before dispatch.
 l Post-click tracking. Analyze actions of recipients on your website.
 l Visual link analysis. Graphically display link clicks.
 l Visual link analysis of post-clicks. Graphically display sales volume and number of 

orders generated via a link.
 l Attention analysis. Create heat maps.
 l Activity overview. Display marketing activities within a defined period.

Performance Dashboard (Beta)

The Performance Dashboard gives you an overview of your mailing activities. Customize 
the Performance Dashboard and use it for example for graphically appealing present-
ations. 
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To open the Performance Dashboard, open the start menu and select Analytics > Per-
formance Dashboard (Beta).

Tip: All users of a client have the same access permission to the Per-
formance Dashboard.

You can display the following widgets in the Performance Dashboard:

 l KPI chart (time-based). A simple diagram to illustrate a KPI. KPI charts consist of a 
graphically highlighted key figure and a diagram behind it.

 l Basic chart (time-based). Has more configuration options than a KPI chart and is espe-
cially suitable for analysis and comparison of different KPIs (2 dimensions).

 l Basic chart (mailing-based). Two-dimensional basic chart that, unlike the time-based 
basic chart, allows analysis based on selected mailings.

 l Bubble chart (mailing-based). Display of different KPIs as colored bubbles (3 dimen-
sions).

By default, the following widgets are displayed:

 1. KPI charts Recipients, Opens, Clicks, Returned emails and Unsubscribes
 2. Basic chart Dispatch overview with a complete overview of all KPIs
 3. Basic chart Clicks, returned emails and unsubscribes
 4. Basic chart Unsubscribes
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You can customize and export each widget directly in the Performance Dashboard over-
view or configure it individually in edit mode. 

Tip: Hover over a specific day or mailing in the graph to view the 
corresponding KPIs and metrics.

Widget features
You can customize the chart settings of each widget directly in the Performance Dash-
board to show or hide data series, set time periods, and zoom in on areas. You can also 
export widgets as an image file, PDF or CSV.

Showing or hiding data series

Note: This function is not available for the widget type KPI chart.

To show or hide series in diagrams with several KPIs, click on the respective series titles in 
the right list.



© Episerver 2020

712 | Episerver Campaign User Guide 2020-04-23

Setting time periods

Note: This function is only available for widget types KPI chart and 
Basic chart (time-based).

The KPIs displayed in the widgets KPI chart and Basic chart (time-based) are absolute 
values and refer to all messages of a client in the selected time period. 

To set the time period:

 1. Hover over the widget for which you want to change the time period. A drop-down 
list appears.      

 2. Select one of the following options: 

 l Last 7 days. Data source are the last seven days.
 l Last 14 days. Data source are the last 14 days.
 l Last month. Data source is the last month. Example: On April 17, the period goes 

back to March 17.
 l Last year. Data source is the entire last year. Example: On April 17, 2019, the 

period goes back to April 17, 2018.
 l Overall. Data source is the entire period recorded in the client.
 l Custom period. Define a time period.
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Zoom

Note: This function is not available for the widget type KPI chart.

The zoom function lets you zoom in on areas in the widget type Basic chart, and 
enlarge and display bubbles more precisely in the widget type Bubble chart.

To use the zoom function:

 1. Move the cursor to the start or end point where you want to zoom in.
 2. Hold the left mouse button and move to the left or right to define the area you want 

to zoom in.

 3. Repeat step 2 to zoom in closer.
 4. Click Reset Zoom to reset the chart to the original setting.
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Exporting widgets

You can export widgets as an image file, PDF or CSV file. Do the following:

 1. Click the hamburger menu in the upper right corner of the widget you want to 
export.

 2. Select one of the following file formats from the drop-down list: PNG, JPEG, 
SVG, CSV or PDF. 

Tip: Downloaded image files have the double image format of the 
displayed widget. When you export a CSV file, the data sources 
shown in the graph are sorted either by date (for time-based 
graphs) or by recipient number (for mailing-based graphs).

Edit mode
In edit mode, you can customize, move, delete or add widgets, or rebuild your Per-
formance Dashboard from scratch.

To open edit mode, click Edit.
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The following options are available in edit mode:

 1. Restore default. All changes made to the Performance Dashboard are discarded 
and the default is restored.

 2. Add widget. In the Widget type drop-down list, select KPI chart, Basic chart (time-
based), Basic chart (mailing-based) or Bubble chart. Make the desired settings for 
the new widget and click Apply. The new widget will insert either below or between 
the existing widgets, depending on its size and on the space available on the Per-
formance Dashboard.

 3. Cancel. Your changes will be discarded. You return to the Performance Dashboard 
overview.

 4. Apply. Your changes are applied. You return to the Performance Dashboard over-
view.

 5. Edit, Copy, Delete . Hover over a widget. The following options are dis-
played:

 l Edit  . The Edit widget  window opens. See Editing Widgets.

 l Copy  . The Copy widget window opens. Customize the copy (See Editing Wid-
gets) and click Apply. The copied widget will insert either below or between the 
existing widgets, depending on its size and on the space available on the Per-
formance Dashboard.

 l Delete  . The selected widget is deleted.
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Customizing widgets
In edit mode, you can customize widgets and change their position and size:

 l Change position. Hold the left mouse button and drag a widget to a free space.
 l Change size. Drag the right side or bottom side of a widget to change the height or 

width of the widget. The lower right corner allows you to adjust the height and width 
of a widget at the same time.
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Editing widgets
You can edit either a new, an existing or a copy of a widget. 

In edit mode, double-click a widget or hover over a widget and click Edit  . A window 
opens with the settings of the respective widget type: KPI chart, Basic chart (time-based) 
, Basic chart (mailing-based) or Bubble chart.

KPI chart settings

In edit mode, double-click a widget or hover over a widget and click Edit  . 
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You can make the following settings:

 l Title. Title of the KPI chart. It is displayed centered in a predefined font size. Leave 
the field blank if you do not want to display a title.

 l Value type. Define the output type of your data source.   

 o Sum. Sums up the data of the selected data source. (Example: A total of 955,000 
messages were opened.)

 o Average. Calculates the average of the selected data. (Example: An average of 
120,000 messages were opened per day.)

 o Minimum. Displays the lowest value of the data source of a day within the selec-
ted time period. (Example: The minimum number of open mails is 465.)

 o Maximum. Displays the highest value of the data source of a day within the selec-
ted time period. (Example: The maximum number of open mails is 511,000.)

 l Value style. Define the style in which the key figure is to be displayed. Click Edit and 
in the Edit style window, select the property you want to edit from the drop-down list. 

Click Plus   to add the property to the style set.
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 o Font color. Define the font color by entering a hexadecimal value preceded by # 
(for example #000000). Alternatively, you can specify a color value using the color 
selector.

 o Opacity. Set a value between 0 and 1 for the opacity of the key figure.
 o Background color. The background is displayed in the form of a colored stripe 

behind the key figure. Define the font color by entering a hexadecimal value 
preceded by # (for example #000000). Alternatively, you can specify a color value 
using the color selector.

 o Text-align. Place the key figure on the left, centered or to the right of the widget. 
By default, the key figure is centered.

 o Border. In the text field, enter a CSS standard frame definition, such as 2px dotted 
orange for a 2 pixel wide, orange dotted frame.      

 o Padding. Specify a pixel value to change the vertical position of the key figure, 
for example, 20px (the higher the pixel value, the lower the position of the key fig-
ure).

 o Font size. The font size is calculated automatically.  Changes do not affect the 
output.

 l Data source. Select the KPI you want to create a KPI chart for. The KPIs are absolute 
values and refer to the messages stored in your client.

 o Recipients. Number of recipients to whom messages are sent.
 o Clicks. Clicked Links. 
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 o Opens. Opened messages.
 o Returned emails. Messages that return to the sending mail server (including reply, 

autoresponder, hard and soft bounce).
 o Unsubscribes. Registered unsubscribes.

 l Chart color.  Color of the chart displayed in the background of the KPI chart. Define 
the font color by entering a hexadecimal value preceded by # (for example 
#000000). Alternatively, you can specify a color value using the color selector.

Note: For better readability, the diagram color is slightly trans-
parent. This results in color changes (for example red becomes 
pink).

 l Chart type.

 o Area-spline. Line chart with rounded corners and colored area.
 o Area. Line chart with colored area.
 o Line. Line chart.
 o Spline. Line chart with rounded corners.

 l Time period options.

 o Add time period. Add a custom time period.

 n Title. Enter a name for the newly created period.
 n Type. Select whether you want the time period to be absolute or dynamic.
 n From/To (Absolute). Specify a start date and an end date.
 n From/To (Dynamic). Starting from the current date, specify a time period in 

days. Use minus values to go back in the past.

 o Click Minus   to remove periods from the selection.
 o Preselected time period. Specify which period is to be displayed by default.
 o Display time period selection. Show or hide the drop-down list for time period 

selection in the Performance Dashboard overview.

Basic chart settings (time-based)

In edit mode, double-click a widget or hover over a widget and click Edit  .
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You can make the following settings:

 l Chart title. Title of the chart. It is displayed centered in a predefined font size. Leave 
the field blank if you do not want to display a title.

 l Chart type. 

 o Bar. Display as bar chart.
 o Line. Display as line chart.
 o Column. Display as column chart.

 l Axis title. Title of the Y-axis of the diagram. Leave the field blank if you do not want to 
display a title.

 l Title color. Select a color for the axis title. Define the font color by entering a hexa-
decimal value preceded by # (for example #000000). Alternatively, you can specify a 
color value using the color selector.

 l Display on opposite side. By default, the axis title is on the left side. Enable this option 
to display the axis title on the right side.

 l Data source. Select the KPI you want to create a KPI chart for. The KPIs are absolute 
values and refer to the messages stored in your client.

 o Recipients. Number of recipients to whom messages are sent.
 o Clicks. Clicked Links. 
 o Opens. Opened messages.



© Episerver 2020

722 | Episerver Campaign User Guide 2020-04-23

 o Returned emails. Messages that return to the sending mail server (including reply, 
autoresponder, hard and soft bounce).

 o Unsubscribes. Registered unsubscribes.

 l Series title. Enter a significant name for the created chart.
 l Series type. Select the display format of the chart.

 o Area. Line chart with colored area.
 o Area-Spline. Line chart with rounded corners and colored area.
 o Column. Column chart.
 o Line. Line chart.
 o Spline. Line chart with rounded corners.
 o Scatter. Values are displayed as separate points.

 l Dash type. Select the desired dash type from the drop-down list.
 l Color. Select a color for the displayed chart. Define the font color by entering a 

hexadecimal value preceded by # (for example #000000). Alternatively, you can spe-
cify a color value using the color selector.

 l Display series. Disable this option to hide the graph. You can reactivate a hidden 
data series in the Performance Dashboard overview at any time.

 l Add data series. Click Add data series to add another graph.
 l Add axis definition. Click Add axis definition to add another Y-axis to the graph. The 

scale of the new Y-axis depends on the data series you create under this axis defin-
ition.

 l Time period options.

 o Add time period. Add a custom time period.

 n Title. Enter a name for the newly created period.
 n Type. Select whether you want the time period to be absolute or dynamic.
 n From/To (Absolute). Specify a start date and an end date.
 n From/To (Dynamic). Starting from the current date, specify a time period in 

days. Use minus values to go back in the past.

 o Click Minus   to remove periods from the selection.
 o Preselected time period. Specify which period is to be displayed by default.
 o Display time period selection. Show or hide the drop-down list for time period 

selection in the Performance Dashboard overview.
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Basic chart settings (mailing-based)

In edit mode, double-click a widget or hover over a widget and click Edit  .

You can make the following settings:

 l Title. The title of the bubble chart. It is displayed centered in a predefined font size. 
Leave the field blank if you do not want to display a title.

 l Mailings.

 o Number of regular mailings. Enter the number of most recently created regular 
mailings that you want to display. Transactional mails, test mails, and con-
firmation mails are excluded.

 o Select mailings. Select one or more mailings. You can select transactional mails 
as well as regular mailings.

 o Group by campaign. Select the check box to group the selected mailings accord-
ing to the assigned campaign.
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 l Axis definition.

 o Axis title. Title of the Y-axis of the diagram. Leave the field blank if you do not 
want to display a title.

 o Title color. Select a color for the axis title. Define the font color by entering a 
hexadecimal value preceded by # (for example #000000). Alternatively, you can 
specify a color value using the color selector.

 o Display on opposite side. By default, the axis title is on the left side. Enable this 
option to display the axis title on the right side.

 o Data source. Select the KPI you want to create a KPI chart for. The KPIs are abso-
lute values and refer to the messages stored in your client.

 n Recipients. Number of recipients to whom messages are sent.
 n Opens. Opened messages.

 n (absolute). Total number of opens.
 n (unique). Total number of unique opens. Multiple opens by a recipient are 

seen as a unique open.
 n (absolute) in %. Percentage of total opens in relation to the number of 

recipients.
 n (unique) in %.Percentage of unique opens in relation to the number of 

recipients.

 n Clicks. Clicked links.

 n (absolute). Total number of clicks.
 n (unique). Total number of unique recipients that clicked an arbitrary link in 

a mailing. It does not matter how often and which link was clicked.
 n (absolute) in %. Percentage of total clicks in relation to the number of 

recipients.
 n (unique) in %. Percentage of unique clicks in relation to the number of 

recipients.

 n Bounces. Messages for which bounces have been registered, including soft 
and hard bounces.

 n (absolute). Total number of bounces.
 n (unique). Total number of unique bounces.
 n (absolute) in %. Percentage of total bounces in relation to the number of 

recipients.
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 n (unique) in %. Percentage of unique bounces in relation to the number of 
recipients.

 n Soft bounces. Messages for which soft bounces have been registered.

 n (absolute). Total number of soft bounces.
 n (unique). Total number of unique soft bounces.
 n (absolute) in %. Percentage of total soft bounces in relation to the num-

ber of recipients.
 n (unique) in %. Percentage of unique soft bounces in relation to the num-

ber of recipients.

 n Hard bounces. Messages for which hard bounces have been registered.

 n (absolute). Total number of hard bounces.
 n (unique). Total number of unique hard bounces.
 n (absolute) in %. Percentage of total hard bounces in relation to the num-

ber of recipients.
 n (unique) in %. Percentage of unique hard bounces in relation to the num-

ber of recipients.

 n Returned emails. Messages that return to the sending mail server (including 
reply, autoresponder, hard and soft bounce).

 n (absolute). Total number of returned emails.
 n (unique). Total number of unique returned emails.
 n (absolute) in %. Percentage of total returned emails in relation to the num-

ber of recipients.
 n (unique) in %. Percentage of unique returned emails in relation to the 

number of recipients.

 n Unsubscribes. Registered unsubscribes.

 n (absolute). Total number of unsubscribes.
 n (unique). Total number of unique clicks on an unsubscribe link.
 n (absolute) in %. Percentage of total unsubscribes in relation to the number 

of recipients.
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 n (unique) in %. Percentage of unique clicks on an unsubscribe link in rela-
tion to the number of recipients.

 o Series title. Enter a significant name for the created chart.
 o Series type. Select the display format of the chart.

 n Area. Line chart with colored area.
 n Area-Spline. Line chart with rounded corners and colored area.
 n Column. Column chart.
 n Line. Line chart.
 n Spline. Line chart with rounded corners.
 n Scatter. Values are displayed as separate points.

 o Dash type. Select the desired dash type from the drop-down list.
 o Color. Select a color for the displayed chart. Define the font color by entering a 

hexadecimal value preceded by # (for example #000000). Alternatively, you can 
specify a color value using the color selector.

 o Display series. Disable this option to hide the graph. You can reactivate a hidden 
data series in the Performance Dashboard overview at any time.

 o Add data series. Click Add data series to add another graph.
 o Add axis definition. Click Add axis definition to add another Y-axis to the graph. 

The scale of the new Y-axis depends on the data series you create under this axis 
definition.

Bubble chart settings

In edit mode, double-click a widget or hover over a widget and click Edit  .
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You can make the following settings:

 l Title. The title of the bubble chart. It is displayed centered in a predefined font size. 
Leave the field blank if you do not want to display a title.

 l Mailings.

 o Number of regular mailings. Enter the number of most recently created regular 
mailings that you want to display. Transactional mails, test mails, and con-
firmation mails are excluded.

 o Select mailings. Select one or more mailings. You can select transactional mails 
as well as regular mailings.

 o Group by campaign. Select the check box to group the selected mailings accord-
ing to the assigned campaign.

 l X, Y, Z axis values.

 o Recipients. Number of recipients to whom messages are sent.
 o Opens. Opened messages.
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 n (absolute). Total number of opens.
 n (unique). Total number of unique opens. Multiple opens by a recipient are 

seen as a unique open.
 n (absolute) in %. Percentage of total opens in relation to the number of recip-

ients.
 n (unique) in %.Percentage of unique opens in relation to the number of recip-

ients.

 o Clicks. Clicked links.

 n (absolute). Total number of clicks.
 n (unique). Total number of unique recipients that clicked an arbitrary link in a 

mailing. It does not matter how often and which link was clicked.
 n (absolute) in %. Percentage of total clicks in relation to the number of recip-

ients.
 n (unique) in %. Percentage of unique clicks in relation to the number of recip-

ients.

 o Bounces. Messages for which bounces have been registered, including soft and 
hard bounces.

 n (absolute). Total number of bounces.
 n (unique). Total number of unique bounces.
 n (absolute) in %. Percentage of total bounces in relation to the number of 

recipients.
 n (unique) in %. Percentage of unique bounces in relation to the number of 

recipients.

 o Soft bounces. Messages for which soft bounces have been registered.

 n (absolute). Total number of soft bounces.
 n (unique). Total number of unique soft bounces.
 n (absolute) in %. Percentage of total soft bounces in relation to the number of 

recipients.
 n (unique) in %. Percentage of unique soft bounces in relation to the number of 

recipients.

 o Hard bounces. Messages for which hard bounces have been registered.
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 n (absolute). Total number of hard bounces.
 n (unique). Total number of unique hard bounces.
 n (absolute) in %. Percentage of total hard bounces in relation to the number of 

recipients.
 n (unique) in %. Percentage of unique hard bounces in relation to the number 

of recipients.

 o Returned emails. Messages that return to the sending mail server (including reply, 
autoresponder, hard and soft bounce).

 n (absolute). Total number of returned emails.
 n (unique). Total number of unique returned emails.
 n (absolute) in %. Percentage of total returned emails in relation to the number 

of recipients.
 n (unique) in %. Percentage of unique returned emails in relation to the number 

of recipients.

 o Unsubscribes. Registered unsubscribes.

 n (absolute). Total number of unsubscribes.
 n (unique). Total number of unique clicks on an unsubscribe link.
 n (absolute) in %. Percentage of total unsubscribes in relation to the number of 

recipients.
 n (unique) in %. Percentage of unique clicks on an unsubscribe link in relation to 

the number of recipients.

 l Display of the x and y axis.

 o Linear. The axis values are displayed linearly - in successive steps.
 o Logarithmic. The axis values are displayed exponentially.

 Deep Analytics

Deep Analytics is a report suite that you can configure to measure the success of your 
campaigns and evaluate mailings in detail. Select measures and group them by time 
period, recipient segment, click profile, and other factors. 
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To start Deep Analytics, open the start menu and select Analytics > Deep Analytics. The 
Introduction page appears initially, containing information about the functionality of 
Deep Analytics.

Manage reports and report templates in the Overview tab. It shows report templates on 
the upper section, and executed reports in the lower section. 

Tip: Up-to-date data
When you execute a Deep Analytics report, it aggregates up-to-
date data. The report's measures may vary slightly from those  in the 
mailing overview, because the data is not aggregated at each 
request, but in fixed chronological intervals.

Benefits of Deep Analytics
 l Detailed reports based on raw data
 l Seamless integration with Microsoft Excel and CSV-based (comma-separated val-

ues) pivot tables and visualizations
 l Set automatic execution of Deep Analytics. Enter a time interval, upload a 

Microsoft Excel template, and receive the finished report in your layout (such as a 
pivot table) recurrently by email

 l Automated emailing of reports
 l Consolidate multi-faceted data from your newsletters and campaigns
 l Evaluate your measures to focus on  boosting sales
 l "Click together" and prioritize more than 30 parameters in over 500 combinations of 

measures and groupings
 l Create complex nested structures with target groups, click profiles or specific fields 

of data in your email distribution list. Data can also be depicted according to time: 
year, month, day, or calendar week.

 l Execute reports at intervals and email them to recipients, informing managers and 
colleagues about email marketing measures

 l Evaluate all sub-clients in a main client simultaneously, without merging data from 
clients

 l Restrict analysis to a mailing type or recipient segment. Evaluate split mailings indi-
vidually.

 l Compare performance against previous analysis reports
 l Monitor and control target groups across several clients to observe the devel-

opment of recipient groups, and to evaluate target group-specific campaigns
 l Return KPIs (key performance indicators) such as return on investment or sales per 

recipient
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Tip: Pivot tables in Excel
Excel-based pivot tables support easy data preparation and visu-
alization – enabling fast monitoring of performance figures. Large 
amounts of data can be reduced to a manageable level to aid 
the analysis. If you need help creating pivot tables or their visu-
alization, contact customer support.

Creating a report template
To create a new report template, in the Overview tab, click New. The wizard guides you  
through the process of creating a report template in four steps:

 l Step 1. Introduction. Helpful information            
 l Step 2. Report data. Select report data, measures and groupings            
 l Step 3. Report template. Upload report template and configure automatic exe-

cution            
 l Step 4. Sending options. Configure automatic dispatch of the report            

Note: To delete a report template, click a report template in the 
Report templates list then click Delete. Deleting or changing a tem-
plate does not affect already executed reports. Reports that are 
executed from deleted templates are shown as Not assigned to a 
template in the list.

Step 1. Introduction
The Introduction tab contains information about creating report templates. If you are 
already familiar with Deep Analytics, select Do not show this tab again in the lower left 
corner. Click Report data.

Step 2. Report data settings
The Report data tab lets you define which data is evaluated in a report. You can specify 
recipients, mailings, measures, and groupings.
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Recipients and mailings

In the Recipients and Mailings area, define recipient segments, mailings, and clients that 
you want to analyze. If you do not perform the following steps, relevant data is used for 
the report.

 1. To analyze recipients by target group, click Add   below Consider all recipients.
 2. In the list, select a target group and click OK  .
 3. Repeat these steps to use multiple target groups for this report.

Note: Selected target groups are applied to selected clients 
when the report is executed. This may lead to unwanted results 
if a target group uses filter rules that do not match recipients in 
selected clients. See the following mailing example to learn 
more.

 4. To analyze certain mailings, click Add   below Mailings to be included in the report.
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 5. To create an exclusive condition (such as is not, contains not, has not), in the left 
drop-down list, select not.

 6. In the next drop-down list, you can select the following options. 

 l ( ... ). Create nested conditions by clicking the parentheses.
 l Client. Only available if you have access to more than one client. By default, the 

client to which you are logged in is selected.
 l Folder. Only mailings from specific folders.
 l Mailing. Only specific mailings.
 l Mailing type. Select one or more mailing types:

 o Regular. Optimized mailings of an A/B test (Smart Campaigns) and mailings 
from Mailings Classics (deprecated).

 o Special. Transactional mails.
 o Confirmation email.  Confirmations.
 o Split. Split mailings  from Mailings Classics (deprecated) .
 o Campaign. Mailings and split mailings of a Smart Campaign (without optim-

ized mailings).

Tip: To select all mailings of an A/B test in a 
Smart Campaign, select both options Regular (to select the 
optimized mailing) and Campaign (to select the split mail-
ings).

 l Start date. Select the start date in the next step.
 l Reporting period.  A reporting period lets you specify the time frame from which 

data is collected and used for the analysis. By default, only mailings started in 
the given period are analyzed. If you remove this filter, also opens, clicks, unsub-
scribes, responses  and post-clicks that are created from mailings started prior to 
the reporting period but were only opened, clicked, unsubscribed, and so on 
within the given period, are analyzed. For the mailings and recipients measures, 
this difference is irrelevant.

 7. In the next drop-down list, click the value for the selected filter option.
 8. To combine several conditions, click Add    to add a new condition. Between two 

conditions, an AND or OR logic relation appears, which you can change by clicking 
it. 

Note: Due to correctness and logical disambiguation, target 
groups without parentheses can contain only one type of logic 
relation. Thus, if you click a relation, relations between the rules 
are changed. If you want to use different types of logic 
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relations, use parentheses.
Parentheses group rules hierarchically to handle them with pri-
ority, like in a mathematical equation. Rules within the par-
entheses are applied first, followed by rules in the second level, 
and so on. Parentheses are especially useful if a complex con-
dition is planned and different logic terms (AND or OR) will be 
used.

 9. Click OK  .

Measures

A measure is defined as a numerical measure of a user interaction or characteristic of 
your mailing. Measures have the following characteristics:

 l Measures are expressed in form of a number.
 l Measures are stand-alone entities. If you look at a metric in a stand-alone fashion, it 

provides information about the overall performance of your mailing.
 l Measures form the columns of a report structure.
 l You can combine  measures in a report.

Tip: For a  description of available measures, see Measures.

In the Measures area, define measures to be evaluated for this report:
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 1. Click Add measure... .
 2. Select a measure from the menu.

 3. Repeat these steps for measures you want to analyze.

Tip: You can drag and drop a measure to the desired position if you 
want to change it.

Groupings

Groupings (dimensions) have the following characteristics:

 l Groupings are non-numerical data fields.
 l Unlike measures, groupings are not stand-alone entities, i.e., they are not generally 

meaningful when viewed individually.
 l Groupings, when coupled with measures, provide meaningful context to the data.
 l Groupings are used to segment a measure.
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Tip: For a  description of grouping, see Groupings.

In the Grouping area, select groupings with which the measures will be matched:

 1. Click  Add grouping... .
 2. Select a grouping from the menu.

 3. In the list, select a value (for example, HM TargetGroup) if you want to specify the 
grouping more exactly.

 4. Repeat these steps for groupings the report will evaluate.

Time-based reports

To arrange recipient-specific actions (such as, opens) for a mailing according to the 
start date of the mailing (mailing-time-based analysis), select the All groupings by time 
are based on the start date of the mailing check box. If you clear the check box, recipient-
specific actions are arranged separately according to when they occurred (time-
action-based analysis).
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 l Mailing "New Year Newsletter" was started on 01/01/2018. 
 l Mailing "Information Newsletter" was started on 06/02/2018.
 l Time-action-based analysis (check box cleared):    

Calendar week Mailing Opens (absolute)

01/2018 New Year Newsletter 5

03/2018 New Year Newsletter 5

04/2018 New Year Newsletter 10

06/2018 Information Newsletter 5

08/2018 Information Newsletter 5

09/2018 Information Newsletter 5

 l Mailing-time-based analysis (check box selected):    

Calendar week Mailing Opens (absolute)

01/2018 New Year Newsletter 20

06/2018 Information Newsletter 15

Removing doublings

You can remove double counts from the Click profile, Link, and Target group groupings 
automatically. For example, a recipient in the target groups Men and Age 30-40 years is 
counted twice if you use both target groups in a report. Thus, the sum line contains 
doublings. To prevent this, select the Remove doubling check box in the grouping, so the 
report shows only one match for an arbitrary (applicable) target group of a recipient.

 l The recipient belongs to the target groups "Men" and "Age 30-40 years".
 l If you clear the Remove doubling check box, the following is shown in the report:

  Target Group Recipients (absolute)

Men                     1                     
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  Target Group Recipients (absolute)

Age 30-40 years                     1                     

Sum line                     2                     

 l If you select the Remove doubling check box, the following is shown in the report:

  Target Group Recipients (absolute)

Men                     1                     

Age 30-40 years                     0                     

Sum line                     1                     

Combinations

You can combine multiple groupings to get multidimensional reports. For example, 
select the groupings Mailing and Target group to get a report that shows measures per 
mailing and for each target group.

User-defined arrangement

The arrangement of groupings affects the result of the report. You can drag and drop 
selected groupings to the desired position. If you commute the groupings Mailing and 
Target group, you get an evaluation of target groups and each target group is eval-
uated according to mailings.

Tip: Calculation of rates
To calculate rates (as percentages), such as open or click rates, 
make sure to select a grouping that delivers meaningful report 
data. For example, to get the open rate (as percentage) of a mail-
ing, the Mailing grouping must be selected. In the same way, the 
open rate by target group can be displayed. However, open rates 
in a time-based report do not deliver meaningful values.
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Step 3. Report template settings

To configure the automatic execution and sending of your template, perform the fol-
lowing steps after adding measures and groupings:

 1. In the New report window, in the Report data tab, click Save as report template.
 2. In the Name box, enter the name of the report template.
 3. In the Folder list,  select a folder to which you want to save the report template. To 

use an Excel template, click  Browse... and select a template. If no template is 
uploaded, the Episerver default template is used.

 4. In the Interval area, click the interval for the generation of reports from this tem-
plate. If you change the interval, make sure that the last execution has run at least 
one hour ago. 

 l Manually. Reports can only be executed manually.
 l Weekly. Select the day of the week and the time of day when the report should 

be executed.
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 l Monthly. Select the day of the month and the time of day when the report 
should be executed.

 5. In the Reporting Period area, click ...

 l Since last execution to define that the report contains only data added since the 
last execution of the report. The selected interval is already taken into account 
for the first execution. If you select the Weekly interval, a reporting period of one 
week is used for the first execution. If you change the weekly execution interval, 
such as from Monday to Wednesday, the next execution uses the reporting 
period beginning Wednesday of the previous week.

 l No restrictions to define that available data is evaluated each time the report is 
being executed. By using this option, the amount of data to be evaluated can 
be very large. The execution of such reports may take some time.

 6. Click Sending options.

Tip: Reporting period
Reporting period lets you specify the time frame from which data 
used in the analysis is derived. The No restrictions option relates only 
to the previously-defined global report parameters and measured 
data. If you evaluate openings in a report and define that only mail-
ings started in 2018 should be considered, openings for mailings of 
the year 2018 are counted. The Incremental option evaluates data 
added since the last execution of the report.

Step 4. Sending options

Tip: If you do not want to send the reports via email, leave these 
fields empty.
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To send the report via email, perform the following steps:

 1. In the Recipients box, enter the email addresses of the recipients. Separate multiple 
email addresses with a comma.

 2. In the Subject box, enter the subject of the email.
 3. In the Message text box, enter the message text of the email. Executed reports are 

attached as Excel files to the emails.
 4. Click Save.
 5. Close the window. The new report template appears in the upper section of the 

Deep Analytics – Overview window.

Executing ad hoc report
After performing the step 2 and step 3 to create a report template, you can execute the 
report without configuring or saving it as a template:
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 1. Click Execute report now.
 2. To use an Excel template, click  Browse... and select a template. If you do not 

upload an Excel file, the default template is used.
 3. In the Reporting period area, select

 l Specify period and specify the reporting period, a start date and an end date for 
the period you want to analyze.

 l No restrictions to define that all available data is analyzed at execution of the 
report. Note that by using this option the amount of data to be analyzed can be 
very large in the course of time. The execution of such reports may take some 
time.

 4. Click Sending options and follow the steps under Sending options.
 5. Click Start execution. After execution, the report is shown in the overview window 

and can also be downloaded as an Excel or CSV (comma-separated values) file.
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Measures

The following measure groups contain  measures that are displayed when you click a 
group. 

Mailing measures

Parameter Description

Number of mailings 
(absolute)                     Total number of outgoing mailings                     

Total volume                     Number of recipients + Number of responses (total, non-unique) less 
skipped recipients                      

Recipient measures

Parameter Description

Unique recipients                     Number of unique recipients. If a recipient receives multiple mailings, the 
recipient is only counted once.                   

Recipients (absolute)                     Total number of recipients                     

Recipients minus 
bounces (absolute)                     

Total number of recipients whose email addresses did not produce a 
bounce (message of non-deliverability)                     

Recipients minus 
bounces (%)                     

Percentage of recipients whose email addresses did not produced a 
bounce (message of non-deliverability)                     

Open  measures

Parameter Description

Unique opens (abso-
lute)                     

Total number of unique opens. Multiple opens by a recipient are seen as 
one single open.                     
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Parameter Description

Opens (absolute)                     Total number of opens                     

Unique open rate (%)                     Percentage of unique opens in relation to the number of recipients minus 
bounces                     

Open rate (%)                     Percentage of total opens in relation to the number of recipients minus 
bounces                     

Unique gross open 
rate (%)                     Percentage of unique opens in relation to the total number of recipients                     

Gross open rate (%)                     Percentage of total opens in relation to the total number of recipients                     

Click measures

Parameter Description

Unique clicks                     Number of unique recipients that clicked an arbitrary link in a mailing. It does not 
matter how often and which link was clicked.                     

Clicks (absolute)                     Total number of clicks                     

Click rate (%)                     Percentage of total clicks in relation to the number of recipients minus bounces                     

Unique click rate 
(%)                     

Percentage of unique clicks in relation to the number of recipients without 
bounces                     

Unique gross click 
rate (%)                     Percentage of unique clicks in relation to the total number of recipients                     

Gross click rate 
(%)                     Percentage of total clicks in relation to the total number of recipients                     

Effective unique 
click rate (%)                     Percentage of unique clicks in relation to the unique opens                     
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Response measures

Parameter Description

Unique responses 
(absolute)                     Total number of unique responses                     

Unique response rate 
(%)                     

Percentage of unique responses in relation to the number of recipients 
minus bounces                     

Unique autoresponder 
(absolute)                     Total number of unique autoresponder messages                     

Unique autoresponder 
rate (%)                     

Percentage of unique autoresponder messages in relation to the num-
ber of recipients minus bounces                     

Unique replies (abso-
lute)                     Total number of unique replies                     

Unique reply rate (%)                     Percentage of unique replies in relation to the number of recipients minus 
bounces                     

Unique bounces (abso-
lute)                     Total number of unique bounces                     

Unique bounce rate (%)
                     Percentage of unique bounces in relation to the number of recipients                     

Unique hard bounces 
(absolute)                     Total number of unique hard bounces

Unique hard bounce 
rate (%)                     

Percentage of unique hard bounces in relation to the total number of 
bounces                     

Unique soft bounces 
(absolute)                     Total number of unique soft bounces

Unique soft bounce 
rate (%)                     

Percentage of unique soft bounces in relation to the total number of 
bounces                     
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Unsubscribe measures

Parameter Description

Unique unsubscribes 
(absolute)                     Number of unique clicks on the unsubscribe link                     

Unique unsubscribe 
rate (%)                     

Percentage of unique clicks on the unsubscribe link in relation to the num-
ber of recipients minus bounces                     

Unique net unsub-
scribe rate (%)                     

Percentage of unique clicks on the unsubscribe link in relation to the total 
number of recipients                     

Post-click measures

These measures are available only if post-click tracking is configured for your client. If 
you select the Post-click... measure, a new window opens where you can define the 
measure. To do this, perform the following steps:

 1. Enter a name.
 2. Select a service. (If you use only one service, it is already selected.)
 3. Select whether the measure you want to create is a number (count), a sum or an 

average.

 l If you select Sum or Average, select a post-click value from the drop-down list. If 
you do not want to filter this value further,  save the definition.

 l If you select Count, no filters are added.
 4. To add filters,  in the Filter area, click Add  and select an operator. The operators 

depend on whether the selected post-click represents a number or a string value.
 5. Enter a reference value to compare the post-click value with. This comparison is 

executed according to the operator selected in the previous step.
 6. Click Submit .
 7. To add more filter values, click Add  and repeat the previous steps.
 8. Click Save. The newly created post-click measure appears in the New report window 

in the Report data tab.

Tip: Entering multiple values
If you select is one of the following values, you can enter multiple val-
ues in one text box; for example, if you want to copy values from a 
CSV file:
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 1. Select the operator is one of the following values and enter the values, for 
example, comma-separated.

 2. Open the drop-down list, click Separate multiple values and in the box, 
enter the used delimiter symbol.

 3. Click Submit . The entered values are now handled as single values.

Groupings

The following data is available for a Deep Analytics report, which let you group your 
data:

Parameter Group by

Date or time                     Date or time.                     

Domain                     Recipient domain.                     

Recipient list Recipient lists.

Recipient list field                     Various fields in recipient lists.                     

Click profile       Used click profiles.                     

Link                     Links used in the mailing.                     

Link type Link types used in the mailing.

Mailing                     Your mailings. 

Client                     Clients you are allowed to access.                     

Folder                     Folders in which you store mailings.                     

Subject

Subject lines used in mailings. 

Note: Only the standard subject line is con-
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Parameter Group by

sidered. Additional target group-controlled 
subject lines are ignored.

Target group                     Recipients who belong to specific target groups.                     

Email program/Browser                     Email programs and browsers used by recipients.                     

Operating system                     Operating systems used by recipients.                     

Device type Device types used by recipients.

Media type                     Media type.                     

Contact frequency                     Number of messages received by a recipient within a reporting period.                     

 Executing a report
 1. In the Overview tab, in the Report templates area, click a report template on which 

the new report will be based.
 2. Click Execute report now.
 3. To use an Excel template, click  Browse... and select a template. If you select noth-

ing here, the Episerver Campaign default template is used.
 4. In the Reporting period area, select an option:                   

 l Specify period. Specify the reporting period for which data will be evaluated.
 l Since last execution. Data added since the last execution of the report.  The 

selected interval is already considered for the first execution. If the report is 
executed weekly, a reporting period of one week is used for the first execution. 
If you change the weekly execution interval, such as from Monday to Wed-
nesday, the next execution uses the reporting period beginning Wednesday of 
the previous week.

 l No restrictions. All available data. The amount of data  can be very large and its 
execution may take some time. 

 5. Click Sending options.
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 6. If you want to send the report via email:

 a. In the Recipients box, enter the email address of recipients (separate email 
addresses with a comma).

 b. In the Subject box, enter the email subject.
 c. In the Message Text box, enter the email message text. 

 7. Click Start execution. When the report is executed, you can display and download it 
in the list in the lower section.

Displaying and downloading a Deep Analytics 
report
 1. In the Report templates area of the Overview tab, select a report template. The area 

Executed Reports displays reports that have been executed from the selected tem-
plate. 

To display a report that is not executed from a template, click Not assigned to a tem-
plate in the Report Templates area. 

 2. In the Executed Reports area:

 l To display the report as a pivot table, click Show as pivot table.
 l To display the report in a standard HTML table without formatting, select a report 

and click Show as table. 
 l To download the report as a chart using Microsoft Excel, click Download as Excel 

file. 

Tip: The Excel format provides many possible ways of report-
ing and displaying data. You may use your own Excel tem-
plate or the Episerver default template to create analyses 
and display data in charts or pivot tables. To learn more, 
see Data evaluation using Microsoft Excel.

 l To download the report in a CSV (comma-separated values) file, click Download 
as CSV file. See also: Opening a CSV file in Microsoft Excel. 

Opening a CSV file in Microsoft Excel
Episerver Campaign creates CSV (comma-separated values) files in UTF-8 without BOM. 
Microsoft Excel incorrectly interprets the format as ISO-88591. To correctly open CSV files 
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in Excel, perform the following steps:

 1. Open a blank Excel workbook.
 2. In the Data tab, click Get Data > From File > From Text/CSV.
 3. Select the file to open and click Import.
 4. In the File origin area, select 65001: Unicode (UTF-8) and Semicolon in the Delimiters 

area.
 5. Click Load.

Evaluating data with Microsoft Excel
The Excel format allows rich formatting, calculations, and output in pivot tables and in a 
chart. 

To use your own Excel template, download the default template, customize it then 
upload it. This Excel template contains the report data in the first worksheet grouped by 
the selected groupings. The second worksheet contains a copy of the data without sum 
fields. Use this worksheet to reference data you want to display in other tables or charts 
(for example, pivot tables).

In general, the following standards apply when formatting the Excel templates:

 l Supported file formats. Episerver Campaign supports the Excel '97 format (file suffix 
.xls) and Excel 2007 (file suffix .xlsx). However, Episerver does not guarantee support of 
functions and formatting of these two formats.

 l Data export and data format. Exported data is exported into the first table with sum 
fields and second worksheet table without sum fields. Do not change these work-
sheets; otherwise, the correct export of the data fails. The format of the header 
page is completely adopted, but not the content. The data formats of the first data 
row (row 2 in the Excel worksheet) are adopted. Thus, values can be formatted and 
the formatting can be changed.

 l Evaluations. You can perform evaluations on the second and subsequent work-
sheets. Because an unlimited number of rows may be added when executing the 
report, chart data, pivot tables and formulas must be designed for a very large num-
ber of data rows. This especially applies to reports without time restriction.

 l Pivot tables. Automatic updates must be turned on startup. You find this option under 
PivotTable Options > Data > Refresh data when opening the file.

Tip: Upon request, Episerver creates Excel templates with pivot 
tables, charts and using the layout of your choice. Contact cus-
tomer support.
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Aggregating data with pivot tables
To organize and display large amounts of data  created with Deep Analytics, use pivot 
tables in the online view and the downloadable Excel templates. Pivot tables can show 
what is important without losing details. In a pivot table, you can change the ori-
entation and grouping of the data, and the hierarchical order of groups and cat-
egories. You can use one pivot table to display different kinds of scenarios. 

Raw data is stored in the background. If you group data or omit categories in the table 
or chart display, no data is eliminated, and you can return to display data at any time.

Example
The following example demonstrates how to use pivot tables for exact analysis of 
desired data and details, using different criteria in the same report. By grouping, sorting 
and omitting data, you can capture reports at a glance. You do not lose any data, 
though. If you need to show more details, unfold the table and re-order groups and cat-
egories.

The following image shows an analysis of recipients, opens, and clicks by mailing.

You can re-analyze the data by clicking the plus icon + next to the grouping and 
without creating a new table – to the year, month, calendar week and day of the 
week.
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Click Fields & Filters and drag and drop groupings, measures, lines and columns. Note 
that the grouping Mailing has disappeared, and the analysis is now time-based.

Finally, click Refresh, to create a new analysis:
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Reports

Reports lets you analyze the mailings' most important statistics. Your account has one or 
more report templates. If you need a custom analysis, you can create a new report and 
save it as a template to use for subsequent mailings.

Executing reports
 1. To access the report overview, open the start menu and select Analytics > Reports.
 2. In the overview  in the Manage Reports window, click the mailing in the Mailings list for 

which you want to execute a report. If you select multiple mailings, the results are 
comparable within the report.

 3. In the Templates area, click the template you want to use.
 4. Click Show. The Show Report window opens.

Tip: You can also select mailings (by selecting the check box in the 
table header), Last mailing, Last 2 mailings, Last 3 mailings, or Last 5 
mailings. This is useful if you want to save the report as a template 
and use it for other mailings. If you select the relative information 
just mentioned, the report displays correct data.
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Creating and editing report templates
Your account includes one or more descriptive report templates, with which you can 
analyze the main characteristics of your mailings. You can also create your own report 
templates.

 1. To create a new report or report template, open the start menu and select Analytics 
> Reports. The Manage Reports window appears.

 2. In the Templates area, click New.

Note: To edit a report template, in the Templates area, click the 
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template you want to edit then Edit.

Note: To open an already executed report template, click the 
tab User defined on the upper left, next to Mailing.

 3. In the Title box, enter a significant name for the new report.
 4. To use a report as template for other mailings, check the Template box.
 5. In the Type of chart list, select how the report data will be displayed: 

 l Aggregated. Selected indicators are displayed as aggregated numbers. For 
example, the total number of clicks or the total open rate within a time period.

 l Time elapsed. Indicators are displayed per hour, day, week, and month.
 6. Click Chart. 

The Create Chart window opens.

Selecting measures and mailings
 1. In the Data source area > Category drop-down list, select the measure you want to 

analyze.         
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You can use the following measures for your report:

 l Unsubscribes
 l Number of recipients
 l Clicks
 l Opens
 l Returned emails
 l Post Click —  if your client is set up accordingly

These measures can be shown in the following configurations:

Configuration Description

Absolute
Total number of clicks, opens, and so on. The indicator is called Clicks or 
Opens.
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Configuration Description

As a per-
centage

The information is provided as a percentage.

Based on 
domains 
(cumulative)

Displays how many events (clicks, and so on) were activated by recipients 
whose email addresses indicate a specific domain (such as 
example.com). In this way, you can recognize how many active recipients 
are from various providers.

Based on 
domains as a 
percentage 
(cumulative)

Same as above, but as a percentage.

Based on 
domains (sep-
arated)

Divides the display of measured events based on the recipient email 
addresses.

Based on 
domains as a 
percentage 
(separated)

Same as above, but as a percentage.

By profile

This option is only available to display the clicks by click profile. Unique or 
total clicks can be displayed. A unique click in a profile means that the 
recipient has clicked once on any link in this profile. Several unique clicks on 
different links of that profile produce only one unique click in the profile.

 2. For each measure that you add, a tab is displayed in the upper area of the window 
next to Data source. Click this tab to make additional settings for each measure, 
such as changing the bar name or color.             

Tip: Depending on data source, more options are available, 
such as limiting the links to be tracked when counting clicks.

 l To remove a measure, click the x on the tab. 
 l To change the arrangement of bars in the chart, use the arrows on the tabs to 

move them right or left. You can change the order of the bars in the same way.
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 3. Click the Mailings list, then select check boxes next to mailings you want to analyze. 
If you select more than one mailing, the results are compared in the same chart. 
Click OK when finished.

 4. Click Add. In the Preview tab, a bar with the respective data is displayed.
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Configuring charts
In the right area of the window, you can define the chart type you want to use and 
labels, size, and background color. Afterwards, click Refresh to see how your settings 
affect the graph and table view then click Save.

You have the following options to customize your charts:

 l General
 l Chart
 l X axis
 l Y axis

General

Option Description

Chart type

Click the chart type you want to use: 

 l Bar chart. Compare recipients, opens, clicks and unsubscribes.
 l Area chart. Display two indicators on a time-elapsed base to 

compare both.
 l Line graph. A time-elapsed chart type to display the progress 

of an indicator over a certain period.
 l Pie chart. Displays a percentage distribution of  items or values.

Title Enter the chart title.
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Option Description

Data orientation Display the table in the Data tab horizontally or vertically.

Use URL as link description Display links with their URL, to reveal what is behind each link.

Show captions Show or hide captions.

Width, Height, Trans-
parency, border color

Define the chart's layout further.

Show border, Border color Select to frame the chart.

Chart

The Chart tab lets you customize the layout of your chart:

Option Description

Orientation Display the chart horizontally or vertically.

Background color Select the background color.

Chart border color Select the frame color.

Show bar border, border color Select to frame each bar of the chart.

Caption orientation Displays captions of the bars horizontally or vertically.

X axis

Option Description

Show Show or hide the X axis.

Title Enter a title for the X axis.

Show grid lines Show or hide the grid lines.
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Option Description

Grid line color, grid line style Define the style further.

Y axis

Option Description

Show Show or hide the Y axis.

Title Enter a title for the Y axis.

Show captions Show or hide labels.

Axis marks Show or hide axis marks.

Show grid lines Show or hide grid lines.

Grid line color, grid line style Define the style further.

Deleting a report template
To delete a report template, in the Templates area, click the report template  > Delete.

Saving a new report
The New Report window displays analyses created for this report.

You can add any number of additional analyses to your report. Click on Chart and cre-
ate a new diagram as described under Selecting measures and mailings. Then, save the 
report template via Save or Save As to add the diagram to the report template.

For the Graphics and data tab, the complete analysis is shown (including images and 
text); for the Graphics or Data tabs, only those display formats are shown. 
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You can perform the following actions on every analysis:

 l Edit. Change the settings. 
 l Delete. The analysis is erased from the report. 
 l Up. The analysis is moved up in the report. 
 l Down. The analysis is moved down in the report. 

If one of the charts in the report is time-elapsed (option Type of chart), use the tabs over 
the chart to switch among hour, day, week, or month modes. With the Start date and 
End date fields, you can set the exact time period to be displayed. To recalculate the 
chart, click Apply . If Apply to all is clicked instead,  the charts in the report are also recal-
culated based on the new time period.

To save the report, click Save.
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Live Analytics

Live Analytics lets you create RFM analyses in real time from the entire recipient data-
set, or a subset of recipients. Live Analytics stores recipient action data from mailing lists 
then analyzes that data from the previous 12 months. The data is updated daily.

Live Analytics ensures high performance for the analysis of large quantities of data. Run-
ning analyses show an up-to-date image of the customer lifecycle, preferences, sales 
volume, and recipients' purchases.

RFM analysis
RFM analysis is an effective procedure for the analysis, prediction, and optimization of 
the customer base. RFM stands for the following three parameters, indicators of the 
probability that a customer will react to a marketing campaign in the future:

 l Recency. When a customer's most recent action  was made, including purchases, 
aborted orders, or a product view.

 l Frequency. The frequency with which a customer performed the above actions.
 l Monetary. The sales volume a customer generated; only the purchase action is ana-

lyzed.

You can increase profitability and ROI (return on invest) of your campaigns with the 
combination of these three parameters. Each recipient is assigned to an RFM segment. 
You can view the entire recipient base as well as individual segments, further constrain 
them, and define them as a target group for a campaign.

Live Analytics packages
You can run up to three Live Analytics analyses simultaneously using the standard pack-
age. If you need more analyses, contact customer support to expand it.

To start Live Analytics, open the start menu and select Analytics > Live Analytics. The Live 
Analytics window shows running analyses in the selected display (pie, line or bar chart).
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You can arrange analyses in the desired order using drag and drop. To do this:

 1. Move the pointer over an analysis in the blue bars on the upper edge until the 

pointer switches to the drag and drop symbol .
 2. Drag the analysis to the desired position.

Then, perform the following actions:

 l Create. See Create and edit Live Analytics analysis.
 l Detail. See Live Analytics detail view. 

 l Edit. Move the pointer over the analysis and click Edit analysis . Then, see Create 
and edit Live Analytics analysis.

 l Delete. Move the pointer over the analysis, click  Delete analysis   then Delete.
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Creating a Live Analytics analysis
 1. To create a new analysis, in the Live Analytics, window click Add  . The Create ana-

lysis window opens.

Note: To edit an already existing analysis in the Live Analytics 
window, move the pointer over the desired analysis and click 

Edit analysis . The Edit analysis window opens.

 2. Drag the desired Live Analytics analysis items from the left action area to the Lim-
itations (to perform a pre-selection of the analyzed recipients) and Charts areas.

 3. To edit an analysis item, move the pointer over the desired item in the Limitations or 

Charts area and click Edit chart  .
 4. To change the chart type of an analysis item, move the pointer over the desired 

item in the Charts area and click the desired chart symbol for pie, line, or bar charts.

 l  Pie chart. Each piece of the pie represents one recipient segment for a 
period, frequency, or sales volume. Click a piece to constrain the selection to 
this segment.

 l  Line chart. Each point of the line represents one recipient segment for a 
period, frequency or sales volume. Click a point to constrain the selection to this 
segment.
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 l  Bar chart. Each bar represents one recipient segment for a period, fre-
quency or sales volume. Click a bar to constrain the selection to this segment.

 5. Configure the analysis items as described in Analysis items.
 6. To remove an analysis item, move the pointer over the item and click Delete chart 

.

 7. You can arrange the analysis items in the desired order, both under Limitations and 
Charts. To move an item, move the pointer over the item. The pointer switches to 

the Move symbol . Click and drag the item to the desired position.
 8. Click Apply.
 9. In the Name field, enter a name for the analysis and click Apply. The analysis is shown 

in the overview. If no analysis data is available, a notification appear. When the 
computation of the analysis data is concluded, the charts and data are displayed.

Note: Limitations

 l An analysis must include at least one chart.
 l An analysis can include multiple charts.
 l Invalid parameters or missing configurations are displayed when you add 

an analysis item as a constraint or chart.

Analyzing Live Analytics items
Analysis items form dimensions that you can use as a limitation or chart in an analysis. 
Restrictions apply to the use of analysis items as a limitation.

The following table shows analysis items and their options. Click an analysis item  to read 
about its use and configuration.

Analysis 
item

Description Constraint Chart

 
Recipient 
list 

Constrains recipients to one or more recipient lists or analyzes 
recipients sorted according to recipient lists. ✓ ✓

 
Constrains recipients to a recipient list with a specific value or 
analyzes recipients sorted according to the values of a recip- ✓ ✓
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Analysis 
item

Description Constraint Chart

Recipient 
list field 

ient list field.

 Tar-
get group 

Constrains recipients to one or more target groups or analyzes 
recipients sorted according to target groups.

Note: Target groups must have been 
created in the  Target groups func-
tion.

✓ ✓

 Mon-
etary 
value

Analyzes recipients sorted according to sales figures within the 
past 12 months. ✘ ✓

 Last 
action 

Analyzes recipients sorted according to the time period of 
their last action (purchase, product view, abandoned shop-
ping cart) within the last 12 months. 

✘ ✓

 Fre-
quency

Analyzes recipients sorted according to the frequency of an 
action (purchase, product view, abandoned shopping cart) 
within the last 12 months. 

✘ ✓

Limitations
A limitation limits the data to be analyzed with the aid of an analysis item. You can add 
or remove limitations in running analyses. You can also create analyses without lim-
itations. 

To use an analysis item, drag it from the left action area to the  Limitations and Charts 
areas. You can make limitations in the analysis by using to the following analysis items:

 l Recipient lists. Select recipient lists  to include in the analysis.
 l Recipient list fields. Select a recipient list field and a value range to include only 

recipients with these attributes in the analysis.
 l Target groups. Select  target groups to include in the analysis.

Tip: If you make no limitations, all active recipients of your client 
are considered for the analysis. You can deactivate selected 
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limitations later in the detail view of an analysis.

Chart
In a chart, the value range of an analysis item is displayed segmented, according to the 
selected dimension. The segment can be carried out according to time, frequency, 
sales volume, grouping or defined values.

Tip: For items that use charts: you can change the chart type at 
any time, even in running analyses.

 Recipient list 

Limitation

 1. Drag the analysis item from the left action area to the Limitations area.
 2. Enter an optional name for the limitation. If you are using multiple analysis items of 

the same type, names help you differentiate them.
 3. In the list, select the desired recipient lists.
 4. Click Close.

Chart

 1. Drag the analysis item from the left action area to the Charts area.
 2. Enter an optional name for the chart. If you are using multiple analysis items of the 

same type, names help you differentiate them.
 3. In the list, select the recipient lists.         If you enter multiple recipient lists, you receive a 

segmented evaluation in the chart. 
 4. Click Close.
 5. Move the pointer over the added analysis item and click the desired chart symbol:      

.
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 Recipient list field 

Limitation

 1. Drag the analysis item from the left action area to the Limitations area.
 2. Enter an optional name for the limitation. If you are using multiple analysis items of 

the same type, names help you differentiate them.
 3. In the list, select the desired recipient list field (for example, country, age, 

modified). Depending on the file type, you can configure discrete values, value 
ranges, or intervals:        

 l Text fields. Enter a value to use as the filter for the selected recipient list field, 
such as France. 

 o You must enter the value exactly as specified in the recipient list (including 
capitalization).

 o To filter the recipient list field by up to 10 filters, click Add  and enter 
another value. Repeat for values that you want to use as filters.        

 l Numeric fields. In the list, select whether you want to display a multiple selection, 
an interval, or a threshold value. 

 o If you selected Multiple values can be selected, proceed as described in Text 
fields. 

 o If you selected Interval or Threshold option, in the Unit field, enter a unit (for 
example, years) and a lower or upper limit in the following fields. 

 o If you define a threshold value, also select whether you want to filter values 
above or below the threshold value.

 l Date fields. In the list, select a date field (such as modified) by which you want to 
segment the evaluation. Select the time interval later, in the detail view of the 
analysis.

 4. Click Close.

Chart

 1. Drag the analysis item from the left action area to the Charts area.
 2. Enter an optional name for the chart. If you are using multiple analysis items of the 

same type, names help you differentiate them.
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 3. In the list, select the desired recipient list field for example, country, age, modified. 
Depending on the file type, you can configure discrete values, value ranges or inter-
vals:          

 l Text fields. In the box below, enter a value  to use as the filter for the selected 
recipient list field, such as France. 

 o Enter the value exactly as specified in the recipient list (including cap-
italization). 

 o To filter the selected recipient list field by up to 10 filters, click Add     and 
enter another value. Repeat this step for values that you want to use as fil-
ters. 

 o If you enter multiple values here, you receive a segmented evaluation in the 
chart.         

 l Numeric fields. Define the value ranges (intervals) that you want to display in the 
chart, starting with the smallest segment. In the box after Values lesser than or 
equal to, enter a numerical value, such as 10. Then, click Add     and add the 
next higher value range, such as 20, 50, 100. Repeat until you define all value 
ranges.        

 o You can define up to 10 values ranges per chart.
 o If you enter multiple value ranges here, you receive a segmented evaluation 

in the chart.

 l Date fields. In the Reporting period list, select an evaluation period for the data: 
within the last 7 days, 8 weeks, 12 months, or 10 years.  You can also display values 
outside the selected evaluation period by checking the Show values beyond the 
reporting period box. In the chart, an additional segment for previous events and 
an additional segment for recipients without a corresponding event (Remain-
ders) are displayed.

Example: If you selected the reporting period the last 12 months for the recipient 
list field Last changed, with activated Show values beyond the reporting period 
option, 14 segments are displayed in the diagram. 

 o one each for the last 12 months
 o another for recipients whose datasets last changed more than 12 months 

ago
 o one for recipients whose datasets have not changed since being created.

 4. Click Close.
 5. Move the pointer over the added analysis item and click the desired chart symbol:      

.
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 Target group 

Limitation

 1. Drag the analysis item from the left action area to the Limitations area.
 2. Enter an optional name for the limitation. If you are using multiple analysis items of 

the same type, names help you differentiate them.
 3. In the list, select the desired target groups.
 4. Click Close.

Chart

 1. Drag the analysis item from the left action area to the Charts area.
 2. Enter an optional name for the chart. If you are using multiple analysis items of the 

same type, names help you differentiate them.
 3. In the list, select the desired target group(s).         If you enter multiple target groups, you 

receive a segmented evaluation in the chart.
 4. Click Close.
 5. Move the pointer over the added analysis item and click the desired chart symbol:      

.

 Monetary value

Note: You cannot use this item as a limitation.

Chart

 1. Drag the analysis item from the left action area to the Charts area.
 2. Enter an optional name for the chart. If you are using multiple analysis items of the 

same type, names help you differentiate them.
 3. If you are using multiple post-click services, select a post-click service in the list 

below it. If you are only using one post-click service, this list is not displayed.



© Episerver 2020

772 | Episerver Campaign User Guide 2020-04-23

 4. In the Revenue field list, select the post-click value that tracks sales. The name of this 
value can be different depending on the post-click service and configuration, such 
as revenue, sales, and so on.

 5. Define the value ranges (intervals) that you want to display in the chart, starting with 
the smallest value. In the box after Values less than or equal to, enter a numerical 
value, such as 10. Then click Add  and add the next higher value range, such as 20, 
50, 100. Repeat this step until you define the desired value ranges.        

 l You can define up to 10 values ranges per chart.
 l If you enter multiple value ranges, you receive a segmented evaluation in the 

chart.
 6. Click Close.
 7. Move the pointer over the added analysis item and click the desired chart symbol:      

.

 Last action 

Note: You cannot use this item as a limitation.

Chart

 1. Drag the analysis item from the left action area to the Charts area.
 2. Enter an optional name for the chart. If you are using multiple analysis items of the 

same type, names help you differentiate them.
 3. If you are using multiple post-click services, in the drop-down list, select a post-click 

service. If you are only using one post-click service, this list is not displayed.
 4. Select the desired period in the Reporting period list.
 5. Optionally, you can display values outside the selected evaluation period by activ-

ating the control box Show values beyond the reporting period. An additional seg-
ment with recipients whose most recent action took place further in the past than 
the selected period of time, and a segment with recipients that performed no 
action (Remainders) are displayed in the diagram.

Example: If you selected the evaluation period within the last 7 days, then for the 
activated option Show values beyond the reporting period, nine segments are dis-
played in the diagram.

 l one each for the last 7 days
 l one for actions taken more than 7 days ago
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 l one with recipients who performed no action (Remainders).
 6. Click Close.
 7. Move the pointer over the added analysis item and click the desired chart symbol:      

.

 Frequency 

Note: You cannot use this item as a limitation.

Chart

 1. Drag the analysis item from the left action area to the Charts area.
 2. Enter an optional name for the chart. If you are using multiple analysis items of the 

same type, names help you differentiate them.
 3. If you are using multiple post-click services, in the drop-down list, select a post-click 

service. If you are only using one post-click service, this list is not displayed.
 4. Define the value ranges (number of actions) to display in the chart, starting with the 

smallest segment, for example, 0. Then click + and add the next higher value range, 
for example, 2, 5, 10. Repeat until you define all desired value ranges.         

 l You can define up to 10 values ranges per chart.
 l If you enter multiple value ranges here, you receive a segmented evaluation in 

the chart.
 5. Click Close.
 6. Move the pointer over the added analysis item and click the desired chart symbol:      

.

Live Analytics detail view
The detail view shows limitations selected in the analysis accompanied by recipient seg-
ments as a chart. The upper right corner of the window shows the total number of recip-
ients of segments and the analysis parameters. Use the Save as target group button to 
save the selected segments as a target group.
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Displaying recipients
In the left column, at the top in each detail view of an analysis, use the Show drop-down 
list to choose between display options:

 l Potential recipients. Potential recipients of the selected segments; that is, recipients 
from the recipient lists that correspond to the defined criteria. If you change the lim-
itations of an analysis or select individual segments, the number of potential recip-
ients is adjusted in real time. This number can include recipients who currently 
receive no mailings because they unsubscribed from the newsletter, exceeded the 
bounce limit, or are blacklisted.

 l Contacted recipients. Recipients in the current selection who received at least one 
mailing. This does not mean that a campaign was sent with the segment shown in 
the analysis; it  means that recipients were addressed using the same recipient lists 
and target groups as in the current analysis.
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Activating limitations
The selected limitations are displayed in the left column. Refine or expand the dis-
played analysis by activating or deactivating limitations:

 l Entire limitation. Clear to exclude the entire limitation.
 l Individual segments of a limitation. Clear to exclude a segment from an analysis.
 l Interval or threshold value for numeric values. To adjust the limitation interval or 

threshold value, move the slider for an interval or threshold value limitation.
 l Time interval for date fields. To set or adjust the time interval, click the left date field 

and enter a starting date using the calendar. Then, click the right date field and 
enter an end date.

Note: Limitations

 l If you select some limitations (not all), the number of potential recipients 
in an analysis decreases or remains the same.

 l If you select a limitation but the number of potential recipients does not 
change,  the limitation is not relevant for the analysis.

 l If you select all limitations, the number of potential recipients increase, 
because all recipients from your client are considered.

Displaying ad-hoc segmentation
To receive the selected recipient segment, click a bar, point, or slice of the pie in a 
chart. The display of analysis data in the upper right changes to display the potential 
recipients and contacted recipients in the selected segment. If you created multiple 
charts in an analysis, the display changes in these charts too. Only recipients from the 
segment selected in the first chart are still displayed there.

You can now refine the selection of recipients by selecting an additional segment in 
these charts. After each selection, the display of the other charts adjusts to the refined 
selection.
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Tip: The order in which you make the selection does not matter. 
You can start with any chart then select a segment in the other 
charts.

Example: Recipient segment from an RFM analysis:

 1. Recipients whose most recent action (purchase, product view, abandoned shop-
ping cart) took place in the last 6 weeks  are selected.
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 2. These recipients are further limited to ones who performed one or two actions in the 
last 12 months. Purchases, product views and abandoned shopping carts are eval-
uated here too.

 3. These recipients are limited to those whose purchases exceeded €150 in the last 12 
months.

Saving a segment as a target group
After you select the desired recipient segment, you can save it as a target group  to 
address these recipients in a campaign.

Note: If a recipient is included in multiple categories, the potential 
recipients displayed in Live Analytics may differ from the actual 
number of recipients. If you want to calculate the exact number of 
potential recipients, use the analysis feature in the Create target 
group window (see also Target group analysis).

To save a segment as a target group, perform the following steps:

 1. Hover over the gray field in the upper right corner in which the analysis data is dis-
played. The field becomes active and highlighted.

 2. Click Save as target group. The Create target group window opens.
 3. In the Target group definition area, in the Client list, select the client for which you 

want to create the target group.
 4. Click Properties.
 5. Optionally, select a folder in which you want to save this target group.
 6. The name of the target group is generated according to the scheme Created from 

[analysis title] on [date] at [time]. If you want to give it a distinct name, delete this and 
enter the desired name.

 7. Optionally, enter a description of the target group.
 8. Click Create.
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You can now select the target group in a regular campaign (in the menu item Smart 
Campaigns), or in an automated campaign (in the menu item Marketing Automation) 
and create a campaign for these recipients.

Deliverability preview

Note: This feature is currently only available in Germany, Austria and 
Switzerland, but will be available in other countries soon.

The deliverability preview lets you check your mailing before dispatch, whether the con-
tents are displayed correctly and whether your mailing has been classified as spam by 
the most popular email providers. Episerver works together with an external software ser-
vice provider to analyze and create the deliverability preview.

Creating a deliverability preview

Note: Deliverability previews have additional costs. For more inform-
ation, contact customer support.

Prerequisite:

 l Test recipient list (see Recipient lists)

To create a deliverability preview:
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 1. Open the start menu and select Analytics > Deliverability preview.
 2. Click Create.

 3. In the Select mailing drop-down list, select the mailing for which you want to create 
a deliverability preview.

 4. In the Select test recipient drop-down list, select a recipient list.

Note: Only use test lists and no real customer data. See also 
Recipient lists.

 5. In the Name field, enter a name for the deliverability preview.
 6. Click Create.

Tip: The analysis and creation of the deliverability preview may 
take several minutes.

 7. Click Close.
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Viewing a deliverability preview
 1. Open the start menu and select Analytics > Deliverability preview.
 2. In the  Select preview drop-down list, select a deliverability preview.

Tip: The results may not display immediately. In the Select Pre-
view drop-down list, you can check the progress of each ana-
lysis under Status.

The deliverability preview has two tabs:

 l Display
 l Spam suspicion

Display
The Display tab lets you preview how the graphics and fonts in your mailing are dis-
played by the most popular email providers and browsers.
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To filter the results, enter a search term in the Filter results... field.

Tip: For example, enter iPad to check the appearance on Apple 
iPads, or enter Gmail for the Gmail email provider.

Click a thumbnail to display the respective image. For some images, you can change 
the format from Portrait (vertical) to Landscape (horizontal). Click the desired format in 
the upper left corner of the image.
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Spam suspicion
The Spam suspicion tab provides an overview of whether your mailing has been clas-
sified as spam by the most popular email providers.

 l The red icon  indicates that your mailing has been classified as spam.

 l The green icon  indicates that your mailing has arrived at the respective email 
provider.

 l The violet icon  indicates that no result is available yet.

If available, the spam score  is also displayed and you can view further information on 
the spam filters by hovering over the info symbol  . See also: Notes on spam filters of 
each client.

— Notes on spam filters of each client—

Client Description

Inbox folder test

Gmail 

Gmail's spam filter is part of the standard Gmail service. Gmail is supported in all 
browsers and in several mobile applications. The test uses Gmail's default spam filter 
settings.

In Gmail, recipients can manage  incoming messages using filters that allow them 
to automatically label, archive, delete, star or forward an email, or keep it from 
entering the spam folder in the future. They can also add senders to the address 
book to prevent future emails to be sent to the spam folder. These options are 
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Client Description

not considered for this test.

Note: Gmail's spam filters also work in IMAP clients.  IMAP 
clients can be used on iPhone, iPad, Android, Kindle Fire, 
Thunderbird, Apple Mail, Outlook 2003, Outlook Express 
and others. This means that your email might have to pass 
a combination of two filters to access the inbox. Gmail 
recommends turning off any additional anti-spam or junk 
mail filters within those clients to improve performance. 
However, this is not enabled by default and some clients 
might not allow different spam settings for several 
accounts.

Outlook.com
 

Outlook.com's spam filter is part of the Hotmail service. The test uses Hotmail's 
default spam filter settings. Recipients can add senders to their address book to pre-
vent that future emails are sent to the spam folder. This option is not considered for 
this test.

Outlook 
2003, 2007, 
2010, 2013, 
2016, 2019

Outlook's spam filters are part of the respecting Outlook desktop client of version 
2003, 2007, 2010, 2013, 2016 or 2019. The test uses Outlook's default spam filter set-
tings.

Yahoo!

Yahoo!'s spam filter is part of the Yahoo! service. The test uses Yahoo!'s default 
spam filter settings. Recipients can add senders to their address book to prevent 
that future emails are sent to the spam folder. This option is not considered for this 
test.

Fastmail
Fastmail's spam filter is part of the Fastmail service. Recipients can add senders to 
their address book to prevent that future emails are sent to the spam folder. This 
option is not considered for this test.

GMX
GMX's spam filter is part of the GMX service. The test uses GMX's default spam filter 
settings. Recipients can add senders to their address book to prevent that future 
emails are sent to the spam folder. This option is not considered for this test.

Hushmail

Hushmail's spam filter is part of the Hushmail service. The test uses Hushmail's default 
spam filter settings. Recipients can add senders to their address book to prevent 
that future emails are sent to the spam folder. This option is not considered for this 
test.
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Client Description

Mail.com

Mail.com's spam filter is part of the Mail.com service. The test uses Mail.com's default 
spam filter settings. Recipients can add senders to their address book to prevent 
that future emails are sent to the spam folder. This option is not considered for this 
test.

Google 
Apps

Google purchased this service formally known as "Postini" and merged all of the 
functionality into its Google Apps offering. Since then, few information in regards to 
reasons for SPAM is available. Google Apps now only reports if an email is con-
sidered "Spam" or "Phishy". If an email is marked as "Phishy" it will also be marked as 
"Spam".

Apple Mail 
10, 11

Apple Mail's spam filters are part of the respecting Apple Mail desktop client of ver-
sion10 or 11. The test uses Apple Mail's default spam filter settings.

Anti-spam filter test

Spam Assas-
sin

The rating system of Spam Assasin consists of positive or negative scores, with pos-
itive values indicating "spam" and negative values indicating "ham" (non-spam mes-
sages). By default, Spam Assassin considers a score over 5 to reflect a probable 
spam message. However, this can be changed to a lower or higher value depend-
ing on the recipient's spam restriction preferences. 

 l Score < 5 is recommended

Symantec 
Cloud

Symantec MessageLabs Email Security.cloud service combines advanced email 
antivirus, antispam, and content filtering capabilities in a solution that requires no on-
site hardware or software. 

 l Score < 7 is recommended

Barracuda

Barracuda is a Gateway Appliance which eliminates spam and virus intrusions while 
safeguarding an organization's reputation through content inspection based on 
policy for both inbound and outbound email.

Barracuda Spam scores are as follows:

 l Score < 3.5 is recommended
 l 3.5 – subject line gets modified.
 l 6– message gets blocked.
 l 10 – message gets quarantined.

Cloudmark
Cloudmark's spam filter is offered as an email client plug-in and gateway service. 
The test uses the default spam filter settings that is standard in either the plug-in or 
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Client Description

gateway service.

Symantec 
Messaging 
Gateway 
(formerly 
Brightmail)

Symantec Messaging Gateway service combines advanced email antivirus, anti-
spam, and content filtering capabilities in either a hosted solution or a virtual appli-
ance.

Validation test 

SPF

Sender Policy Framework (SPF) is an email validation system designed to prevent 
email spam by detecting email spoofing by verifying sender IP addresses. SPF allows 
administrators to specify which hosts are allowed to send mail from a given domain 
by creating a specific SPF record (or TXT record) in the Domain Name System (DNS).

DKIM

DomainKeys Identified Mail (DKIM) is a method for associating a domain name to an 
email message, thereby allowing a person, role, or organization to claim respons-
ibility for the message. The association is set up by means of a digital signature which 
can be validated by recipients.

Note: Episerver cannot view nor influence the parameters used to 
check the spam suspicion. The results of this analysis do not guar-
antee that your mailing will lead to the same ratings of a real mail-
ing dispatch. The reputation of Episerver Campaign as an email 
service provider is not considered in the analysis.

Tip: To learn how to optimize your mailing, see Deliverability basics.

Post-click tracking integration

Note: This topic is for administrators and developers with admin-
istration access rights in Episerver Campaign.
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Post-click tracking lets you analyze actions by email recipients on your website. You 
can  see if a customer placed or canceled an order, viewed a product, and based mar-
keting actions on this information. 

To integrate post-click tracking and use collected data in email marketing, every visitor 
action  must be assigned to a recipient with an email address. Post-click tracking and 
target groups include these functions:

 l Date and time range selection. Configure post-click filters  so that only post-clicks  gen-
erated in a defined time range or at a specific date are matched.

 l Autocomplete for product names. Input fields for product names or similar, are 
designed as drop-down lists or with an autocomplete function, to ensure correct 
entries when creating target groups.

 l Mailing-independent customer actions. Import post-click data not assigned to a mail-
ing, but with an email address. For example, if a new customer orders for the first 
time providing an email address, order details are available as post-clicks in the tar-
get group module when this customer registers for a newsletter.

 l Universal interface for integrating web analytics software. Integrate almost any web 
analytics software in a unidirectional way, such as Google Analytics, eTracker, 
Adobe Analytics and Webtrekk.

Note: To correctly associate post-click tracking with a recipient list, 
recipients must have at least a mailing ID and a recipient ID.

Setting up the integration

In your Episerver Campaign client
If post-click tracking is set up together with your client configuration, you can use one or 
more post-click services (this is either Episerver's post-click tracking or the web analytics 
software you are using) in one client. If you are not sure that post-click tracking is con-
figured in your client, contact customer support. For each post-click service, the desired 
categories to be tracked are defined. Typical categories are purchased products, 
viewed product, product group or numeric values like product price or revenue. Use 
these categories to define target groups or evaluate the success of mailings.

On your website
The proprietary post-click tracking uses tracking pixels, a transparent image file (GIF) of 
one pixel width and height, which is loaded from a server when a customer clicks on a 
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link. Loading of the file will not be noticed, and when done, the URL of the tracking pixel 
and attached parameters are submitted to the post-click tracking server. 

The parameters represent the defined categories, the mailing ID (except for customer 
actions where no mailing is necessary), and the recipient ID,  usually the email address. 
Integrate the tracking pixel on an appropriate page, such as  the "thank you" page dis-
played after placing an order. The post-click tracking server stores the data in a data-
base  available to Episerver Campaign, together with the detected click time.

One tracking pixel can transmit up to 19 values (nine string values and ten numeric val-
ues). One parameter is reserved as an identifier, ensuring that each post-click is only 
tracked once, such as when a page is reloaded.

Tip: If you use Google Tag Manager to implement tracking pixels 
on your website, you can set up a data transfer to Episerver Cam-
paign by using post-click tracking. See  Google Tag Manager.

Storing the SSL certificate
If the site where the tracking pixel is implemented uses an SSL certificate, the post-click 
tracking also needs this. To order and store the certificate on Episerver's server, provide 
Episerver with the following:

 l A domain. Domain name, such as example.com, for which the certificate is issued.
 l A contact person from your IT department. First name, last name, company name, 

address, CIP code, phone number, email address and fax address (if available).
 l A contact person for organizational issues. First name, last name, company name, 

address, CIP code, phone number, email address and fax address (if available).
 l An administrative email address. For administering the certificate, must have the 

same domain part as the domain the certificate is issued for. Example: If your 
domain is newsletter.example.com, the email address must be one of 
admin@example.com, administrator@example.com, hostmaster@example.com, 
or webmaster@example.com. Note that only the local parts admin, administrator, 
hostmaster or webmaster are allowed.

Technical implementation

A tracking pixel consists of an image URL, which is added to your website:

<img src="{url}" width="1" height="1" alt="" border="0">

The placeholder {url}  must be replaced by the actual URL, to which the submitted para-
meters are attached.
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Example: Replace news.example.com with your URL.

http://news.example.com/pc?mg=1234567890&bi=0&service=default
  &fvalue1=[product ID]
  &fvalue2=[number of items]
  &fvalue3=[price]
  &gvalue1=[category1]
  &gvalue10=[order number+product ID]

Parameters

 l mg (mailing group) submits the ID of your Episerver Campaign client. If you do not 
know your client ID, contact customer support.

 l bi (browser identifier) is set to 0 by default. The user agent of the browser is used. If 
you have a proprietary implementation identifying the user agent, you can submit 
the value with this parameter.

 l service identifies the post-click service to be used. In this example, the proprietary 
Episerver Campaign post-click tracking (default) is used.

 l fvalue1 to fvalue10 can be used to submit ten different numeric values (example 
names in brackets).

 l gvalue1 to gvalue9 can be used to submit categories (string values).
 l gvalue10 is reserved for the identifier, for example shopping cart ID. If multiple track-

ing pixels are used for each product, this identifier must also contain the product ID, 
to differentiate the tracking pixels.

Note: The identifier is an indispensable parameter that assures the 
creation of unique post-click data. Missing or incorrect identifiers 
may cause data loss or incorrect sales figures.

Use cases

A common use case is tracking of sales figures like revenue, number of bought items, 
order number, and shopping cart ID. Place a tracking pixel on the order placement 
page. Only one tracking pixel is necessary. The URL, including attached parameters, is 
as follows:

/pc?mg=1461858149&bi=0&service=default&fvalue1=20.0&fvalue2=3&fvalue3=8866442211&gvalue1=
 mark.spencer@example.com&gvalue10=1234567890

 l /pc?mg=1461858149&bi=0&service=default&fvalue1=20.0 = Revenue
 l &fvalue2=3 = Number of bought items
 l &fvalue3=8866442211 = Order number
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 l &gvalue1=mark.spencer@example.com = Customer's email address
 l &gvalue10=1234567890 = Shopping cart ID

For more data, you can load a tracking pixel for each item bought. The URL used for the 
tracking pixel is identical for each tracking pixel; only the attached parameters are dif-
ferent. With this setting, post-click data for product ID, product name, and price, can 
be submitted. The tracking pixel URL is the same as in the example above. An additional 
parameter with the product ID (fvalue) and/or the product name (gvalue) is submitted.

Working with post-click data

Note: Third party web analytics programs
To create reports and analyses with third party web analytics pro-
grams, use the web interface of the respective program. See the 
respective user documentation for reporting options.

Analyzing and monitoring mailing campaign success
Use Episerver Campaign Deep Analytics to add a post-click measure to a report:

 1. Create or edit a report template or an ad-hoc report, see Deep Analytics.
 2. In the Report data tab, click  + Add measure.... and then Post click....
 3. In the Name box, enter a name for the post-click measure.
 4. If using more than one service (provider), select the provider from the Service drop-

down list.
 5. In the Value drop-down list, select whether the measure you want to create is a num-

ber, a sum or an average.
 6. If you have selected Sum or Average in the previous step, select a post-click value 

from the drop-down list. If you do not want to filter this value further, the definition 
can be saved. If you have selected Number in the previous step, no filters can be 
added.

 7. To add filters, in the Filter area, click Add +.
 8. In the Category drop-down list, click a post-click value/category and select an oper-

ator. Options depend on whether the selected post-click is a number or a string 
value.

 9. Enter a reference value to compare the post-click value with.
 10. Click Apply ✔ .
 11. To add further filters values, click  Add + and repeat the previous steps.
 12. Click Save. 
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 13. Continue editing the template/ad-hoc report as described in the user doc-
umentation, and execute the report.

Example: Create the post-click measure Men's fashion revenue

 1. In the Value drop-down list, click Sum and then in the of drop-down list, click 
Revenue.

 2. In the Filter area, click Add +.
 3. In the Category drop-down list, click Shop category and select the equals operator.
 4. Enter the reference value Men's fashion.
 5. Click Apply ✔ .
 6. Click Save.

Note: The example requires that a parameter with the shop cat-
egory is passed in your tracking pixel.

Filtering target groups with post-clicks
Do the following to create a target group with a post-click filter:

 1. Open the start menu and select Recipients > Target groups.
 2. Click Create.
 3. In the Name box, enter a name for the target group and in the Target group area, 

click Add +.
 4. In the second drop-down list, click Action. 
 5. In the following drop-down list, click has created post-click.
 6. If using more than one service (provider), select the provider from the Service drop-

down list.
 7. To only consider post-clicks created from mailings, select the mailing(s) from the 

Mailing drop-down list. If no mailing is selected, both mailings and actions not  cre-
ated from a mailing (customer actions) are considered.

 8. Select a date or time in the Period drop-down list to select only post-clicks  created 
within a defined time range or at a certain date. Time entered as a number of days 
("Exactly 30 days ago") refer to the current day.

 9. In the Category drop-down list, click a post-click value/category and select an oper-
ator.

 10. Enter a reference value to compare the post-click value with.
 11. Click Apply ✔ .
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 12. To add further filters values, click  Add + and repeat the previous steps.
 13. Click Create.

Example: Create the target group "Buyers—Men's fashion"

To define a target group that contains buyers of men's fashion of the first quarter of 2020, 
do the following in the Create target group window:

 1. In the Name box, enter Buyers—Men's Fashion and in the Target group area, click 
Add +.

 2. In the second drop-down list, click Action and in following drop-down list, click has 
created post-click.

 3. In the Period drop-down list, click From...until... and select the period from 1 January 
2020 to 31 March 2020.

 4. In the Category drop-down list, click Shop category and select the equals operator.
 5. Enter the reference value Men's fashion.
 6. Click Apply ✔ .
 7. Click Create.

Note: The example requires that a parameter with the shop cat-
egory is passed in your tracking pixel.

Visual link analysis

The Visual Link Analysis shows how often each link in a mailing is clicked. The analysis 
data is displayed directly over a screenshot of the original mailing to reveal correlations 
that might not be obvious, such as if recipients tend to click links in a certain area.
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To create a visual link analysis, perform the following steps: 

 1. Open the start menu and select Analytics > Visual link analysis. The Visual link analysis 
window opens.

 2. Click the Mailings box and the mailing you want to analyze.
 3. In the Show click rate drop-down list, click the type of clicks you want to analyze: 

 l All clicks. Each click is counted, including multiple clicks from the same recip-
ient.

 l Unique clicks. Multiple clicks from the same recipient on one URL are only coun-
ted once. If a recipient clicks on different links to the same URL (such as text and 
image), this is one unique click also, because not the link itself, but the URL to 
which it links, is decisive.

Note: Calculation of the unique click rate
The unique click rate for each link is calculated in relation to 
the total number of unique clicks on each link in the mailing. 
This differs from the unique click rate of the whole mailing, as 
given in the mailing report.
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In the Visual Link Analysis, one recipient can generate one 
unique click for each link in the mailing. The total number of 
unique clicks is usually higher than the total number of unique 
clicks as given in the mailing reports, because some recipients 
click various links in the mailing. The percentage of unique 
clicks for each link is calculated in relation to this number. Note 
that  unique clicks in the overall mailing report and unique 
clicks in the visual link analysis are not identical, since they are 
calculated differently.

 4. In the Reference parameter list, click the reference value you want to use to display 
the attractiveness of the individual links:         

 l Percent of all recipients. Shows the clicks on a link in relation to recipients of the 
mailing.

 l Percent of all (unique) clicks. Shows the clicks on a link in relation to unique clicks 
on links of the mailing.

 l Percent of all recipients/(unique) clicks. Shows the clicks on a link in relation to 
unique clicks on links in the mailing and in relation to recipients of the mailing.

 5. If your client is set up for post-click tracking, in the Additional data list, you can select 
the post-click option. It shows the post-click actions created from each link, such as 
the number of items bought. The data shown in this option depends on the kind of 
data tracked via post-click tracking.

 6. Click Show. The visual link analysis is started.
 7. To show only elements assigned to specific target groups, click Target groups, select 

one or more target groups, and click Submit selection. In the background, a screen-
shot of the mailing is shown. Over each link, the respective numbers (clicks and per-
centages) are shown. 

Tip: You can switch between versions of your mailings by clicking 
the appropriate tab (HTML, Mobile and Text). Optionally, you can 
save the analysis result by clicking Save result as image.
The box also has a color indicator: White means a link has not been 
clicked; yellow indicates a low click rate, orange medium click 
rate, while red means frequent click rate.

Note: Multiple links with the same link target
Multiple links to the same URL, such as an image and a text link, are 
not analyzed separately. That is, the total number of clicks/unique 
clicks is shown for each link item to the same URL. You cannot 
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determine if recipients preferred clicking an image or a text link to 
the  URL.

Visual link analysis of post-clicks

Note: To enable this feature, contact customer support.

The visual link analysis feature displays a graphical representation of post-clicks. You can 
configure several post-click parameters, such as item price, item number, or total price. 
The selected parameters are displayed as a sum, average, or quantity. This allows vari-
ous analyses to be visualized, such as:

 l Total revenue generated by a link
 l Average revenue generated by a link
 l Number of orders resulting from a link
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Attention analysis

Test the usability of your mailings, templates or drafts before sending them out. The 
attention analysis provides a graphic that indicates if crucial elements (logo, call-to-
action, promotional offers) are placed to immediately draw a viewer's attention. 

To access Attention Analysis, open the start menu and select Analytics > Attention ana-
lysis. The overview shows how many analyses you created, and a list of created and 
requested analyses.
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What is attention analysis?
Attention analysis forecasts the first seconds of viewing a mailing. Like any image, upon 
first glance, an email scanned by the human eye. During scanning, the focus rests sev-
eral times on the fixation points. Image information is processed subconsciously at this 
time. The Episerver Campaign attention analysis is not a semantic analysis; that is, it 
does not analyze the meaning of words, the content of images, and so on. It analyzes 
visual, physical stimuli and deduces how much attention each item and area of the 
image receives. The result helps to optimize size, color, and placement of items to 
make them more eye-catching. 

Attention analysis is applicable for mailings and landing pages. Each analysis consists of 
more than 50 image properties, such as colors, brightness, contrast, size, position, color 
saturation, outlines, and textures. This data is processed to forecast the viewing beha-
vior. The forecast model was designed using attention signatures of real, test persons. 
WhiteMatter Labs develops and verifies this model constantly.

The first impression counts
It is a daily challenge to optimize mailings to achieve higher conversion rates. A recip-
ient spends only a few seconds looking at and reading an email newsletter, which is the 
time you have to arouse interest, communicate crucial information, and create stim-
ulus to click a link. The path from the inbox to the To payment button in an online shop 
consists of many steps to optimize. You should consider each step carefully to make 
email marketing an advanced and powerful marketing tool. Attention analysis let you 
analyze and optimize what used to be a blind spot for marketers – the initial and sub-
conscious attention a recipient pays to an email newsletter.

 l What is perceived in the first seconds after opening a mailing? 
 l Where does the recipient look first, and which items most attract attention ? 

Before a recipient reads the text and looks at the images of an email, complex neur-
onal processes control the attention and determine later behavior. Whether a recipient 
finds an email interesting and continues reading does not depend on the actual con-
tent alone, but on the appearance of an email, on perception paths, and the eye-
catching potential of its items. Attention analysis analyzes, based on a scientific model 
and mathematical algorithms, how a recipient perceives an email in the very first 
moments, spots where eyes his fixate, and which areas catch attention.

Revolutionary testing
Attention analysis is based on the EyeQuant Software developed by WhiteMatter Labs. 
WhiteMatter Labs is a spin-off founded by Prof. Dr. Peter König, one of the leading 
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European neuroscientists from the University of Osnabrueck. WhiteMatter Labs makes 
the results of long-term fundamental research usable in marketing.

Until this time, analyzing user behavior meant conducting expensive eye tracking stud-
ies with large sample sizes. With EyeQuant, real test persons are no longer necessary. 
Neuroscientific models allow forecasting of viewing patterns within seconds. The atten-
tion analysis is specifically developed to analyze newsletters, websites, and related 
items. The seamless integration in Episerver Campaign lets you run Attention Analysis as 
an part of a continuous optimization process for mailing campaigns:

 l Evaluation of different design drafts at the first stage
 l Pre-test of templates, landing pages and micro sites
 l Testing of special design elements in the course of perception

Validity
The forecast model of attentional deployment is based on a statistical evaluation of 
more than 15,000 tested images. The viewing behavior of more than 300 test persons is 
analyzed to create attentional signatures and to calibrate the model. A comparative 
study with empirical eye tracking data on the predictive power has found a high cor-
relation of both – empirical data and computed data. While eye tracking studies 
reached a predictive accuracy (that is, correlation of forecast and effective eye move-
ment) of approximately 90%, automatically created attention analyses reached about 
85%.

Predictive power (in percent)
red = EyeQuant model
gray = Eye tracking study
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Analyzing a screenshot

Note: Attention analyses have additional costs. For more inform-
ation, contact customer support.

 1. In the Attention analysis window, click New analysis. The New attention analysis win-
dow opens.

 2. Click Screenshot upload and then Select.
 3. Click Browse... and select the screenshot from your local hard disk.
 4. Optionally, enter a description of the analysis and click Preview.
 5. If you are satisfied with the screenshot shown in the preview, click Start analysis.

 l Maximum file size: 5 MB 
 l Supported formats: PNG, JPEG, BMP and GIF 
 l The image is scaled automatically. This may result in very small images, 

for instance if the original page orientation is an extreme portrait.
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Analyzing an existing mailing or landing page

Note: Attention analyses have additional costs. For more inform-
ation, contact customer support.

 1. In the Attention analysis window, click New analysis. The New attention analysis win-
dow opens.

 2. Click Mailing then Select.
 3. In the mailing overview, select the mailing you want to analyze. To analyze a land-

ing page, you must also select the mailing with which it is associated.
 4. In the Mailing part to analyze area, in the list, select the mailing or the landing page. If 

you have not created any landing pages for your mailing, the mailing is the only 
option in this list.

 5. Optionally, enter a description of the analysis and click Preview.
 6. If you are satisfied with the screenshot shown in the preview, click Start analysis. After 

a few seconds, the analysis is available. You can select between the following 
modes:

 l Perception map. The first layer of the attention analysis shows which areas gain 
most attention in the first moments of perception. These areas should contain 
logos, specially formatted product information, and so on. Small areas mean 
more focused attention, while larger areas indicate a more dispersed attention. 
Images with little contrast in color and brightness probably disperse the initial 
attention more widely.
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 l Attention map. The second layer analyzes the attentional potential of the ele-
ments in the overall context of the mailing. Red and yellow areas indicate a high 
attentional potential, while blue and turquoise areas indicate a low attentional 
potential. Items with red and blue parts have a high attentional potential, 
because they are perceived as one item. As said above, a high contrast 
between an item and the background leads to a more focused attention.
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Tip: Attention analysis is based upon universal laws of perception. 
But some aspects, such as the perception of an image from above 
left to below right, are cultural patterns so only apply to occidental 
viewers.

Displaying a previously-generated analysis
 1. Open the start menu and select Analytics > Attention analysis. The overview displays 

generated analyses.
 2. To view the result, click an analysis in the Analyses list, then either  Perception map or 

Attention map.

Interpreting results
Attention analysis gives useful indicators on how to optimize mailings or landing pages:
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 l Are products you want to promote in the newsletter eye-catchers?
 l Is the product information (description, image, price) properly placed and 

grouped?
 l Are the calls-to-action integrated in the perception path, so a viewer can follow 

them easily?

Too much attention might have a negative impact on the mailing performance:

 l Less important items might be more eye-catching than other, more important 
items.

 l The viewer might be distracted by too many items with a high attentional potential.
 l Very eye-catching items might appear too blatant for certain recipients.

Optimizing options
 l Strong contrasts of fore- and background attract the attention. Contrasts can be 

achieved through brightness (black/white) and through colors.
 l Complementary colors (for example red/green) create a higher contrast and more 

attention than colors that lie closer in the color space.
 l Images are more eye-catching when the background is masked and uncolored 

(high figure-background contrast).
 l The general attention path in the occident goes from the top left to the lower right. 

You can follow this pattern or break it up intentionally using an eye-catching item.
 l The left upper corner gains high attention. Usually, logos are placed here.
 l A second area that gains particular attention lies between the left upper corner 

and center. This area is often the viewer's point of entry.
 l Grouping eye-catching items with less eye-catching ones (relative positioning) can 

heighten the attention for all items. For example, to make an item more eye-catch-
ing, place it close to an item that receives a lot of attention.

 l To heighten attention for an item, place it in a "calm" environment.
 l Less is more. Few eye-catching items may be better than too many. The more eye-

catching items you place in your newsletter, the more they compete against each 
other.

Optimization example

This sample newsletter, at first glance, is clearly structured and well-arranged. The title is 
eye-catching, but the attention analysis shows that only one of the three promoted 
products below receives some attention. The product price, although in red, is not 
focused on by the viewer:
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Initial design

The analysis perception map shows a focus on the first product shown.
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This is an optimized version of the same newsletter. Some changes are made: The price 
is positioned closer and top-left to the product. Instead of the red font, an inverted font, 
similar to the title, is used. These changes cause a significant shift of attention:

Optimized

The perception is equally distributed on the three products – a focus is on the prices.
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Activity overview

Note: To enable this feature, contact customer support.

The activity overview shows mailings for a defined period. The view's information helps 
you evaluate marketing activities, such as which customer dialogs you have sent, are 
currently sending, and are about to send. Transactional mails, registration confirmations 
and running Marketing Automations are also supported.

If your company has subsidiaries, branches, or affiliate companies, you can plan, steer, 
and control campaigns from your branches and associated companies using the activ-
ity overview.

The activity overview display has four areas:

 l Area 1. Select one or more clients.
 l Area 2. Select the period.
 l Area 3. Filter mailings  by mail type, media type, and mailing status.
 l Area 4. The activity overview shows a content preview of a selected mailing, opens 

a campaign analysis, switches to the edit window of a selected element or 
pauses/deactivates a campaign or a mailing.
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Area 1: Select client
 1. Open the start menu and select Analytics > Activity overview. The Activity overview 

window opens.
 2. In the Select clients list, choose one or more clients  to display in the overview.

 l The client you to which are logged in is selected. To stop analyzing this client, 
clear the corresponding check box.

 l If you want to select clients of your user account, select the check box on the 
upper left, in the list header.

Area 2: Select period
To select the period for which to display marketing activities, perform one of the fol-
lowing steps.

 l Click a button: last 30 days, last 14 days, last 7 days, current week, next 7 days, next 14 
days or next 30 days.

 l Select the Start date and End date with the date selector.
 l Drag the date slide to the desired start and end dates.

Note: Entering a time period has no effect on the action data 
displayed (openings, clicks, bounces, subscription can-
cellations) nor on the number of recipients shown in the trans-
actional mail and registration confirmation overviews. The 
action data displayed and the number of recipients represent 
the value for the entire time period in which a transactional 
mail or registration confirmation is, or was, active.

Area 3: Filter mailings and campaigns
To filter for campaigns and messages, media type, or mailing status, perform the fol-
lowing steps:

 l Campaigns and messages. Select mailings or Marketing Automation campaigns.

Tip: Transactional mails  include Marketing Automation mailings. 
To include mailings from Marketing Automation campaigns in 
the activity overview, check the box next to Transactional mails.
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 l Media types. Select media types to include in the activity overview.
 l Mailing status. Select the mailing statuses to include in the activity overview. 

Area 4: Open activity overview and other features
If you selected at least one client, mailing type, media type and mailing status, the 
activity overview appears in area 4. The activity overview is automatically updated if 
you change settings in areas 1, 2 or 3.

The following buttons let you perform actions on the overview.

 l Preview. Mark the mailing that you want the content preview to show and click Pre-
view.

 l Analysis. Mark the campaign for which you want to open the campaign analysis and 
click Analysis.

 l Edit. Mark the element for which you want to open the edit window  and click Edit.                  

Note: This function only applies to mailings that have not been 
sent yet.

 l Pause.

 o Smart Campaigns: In the Smart Campaigns messages overview, select messages in 
status Sending. Click Pause. Paused mailings can only be restarted in the Smart 
Campaigns overview of the corresponding client.

Note: Mailings that have not started yet will only be dis-
played if the corresponding campaign has a Wait- or A/B test 
node with a send date within the selected time period.

 o Marketing Automation: In the Marketing Automation campaigns overview, select 
campaigns in status Running. Click Pause. Paused Marketing Automations can 
only be restarted in the Marketing Automation overview of the corresponding cli-
ent.

Note: The time period you selected in area 2 will be ignored 
when filtering Marketing Automation campaigns.

 l Deactivate. In the Smart Campaigns messages overview, select mailings in status Activ-
ated. Click Deactivate.
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Note: When deactivating a mailing, the complete campaign 
the mailing belongs to and all of the campaign's mailings will 
change status to Activation required. The campaigns can only 
be reactivated in the Smart Campaigns overview of the cor-
responding client.
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Integration and interfaces

This section describes Episerver Campaign’s integration options and interfaces. You can 
find information on how to link your online shop, CRM, web analytics program or 
product database with Episerver Campaign. Also, this section explains how to control 
Episerver Campaign from an external system.

 l Episerver platform. Supporting the entire digital marketing chain.
 l E-Commerce. Link to e-commerce systems.
 l Web analytics. Link to web analytics applications.
 l CRM. Link to CRM systems.
 l Translation interface. Create multilingual mailings.
 l Closed-loop Interface. Link to data warehouses.
 l File exchange via SCP. Load files onto the Episerver server via SCP( Secure Copy Pro-

tocol).
 l Webhooks (Beta). Real-time export of event data.
 l API overview. Access specific information required for integrations.
 l REST API. Configure and use the REST API (Episerver Campaign Developer Guide).
 l SOAP API. Configure and use the SOAP API (Episerver Campaign Developer Guide).
 l HTTP API. Configure and use the HTTP API (Episerver Campaign Developer Guide).
 l SMTP API. Control dispatch via SMTP API (Episerver Campaign Developer Guide).

Episerver Platform

The Episerver Digital Experience platform offers an intuitive user interface for marketers 
and merchandisers who deliver campaigns. You can create, plan, and execute cam-
paigns for multiple channels in one place. Episerver supports the entire digital marketing 
chain: from content creation, and omnichannel messaging, to campaign launch and 
follow-up.

Episerver CMS
Create campaign websites and landing pages, using multi-publish features for content 
items such as online forms, text, and media. Preview content components prior to 

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/
https://world.episerver.com/documentation/developer-guides/campaign/smtp-api/
https://www.episerver.com/products/platform/all-episerver-products/
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launch, and schedule the publishing for a set time.

Episerver Commerce
The Episerver Commerce integration lets you import the latest product data into Cam-
paign, and make catalog content available when adding product recommendations 
to mailings. The content interface paragraph imports product data such as offer texts 
and product images, from your e-commerce system into the Template Kit. 

To get the product data into Episerver Campaign, you set up a periodic transfer of the 
latest product data from Episerver Commerce. For more information, see Commerce-
Campaign integration on Episerver World.

Episerver Connect for Campaign 
With this extension, you can connect Episerver Campaign with Episerver CMS and 
Episerver Forms, to collect visitor data entered in website forms, and pass that on to be 
used in  mailings. For more information, see Connect for Campaign on Episerver World.

Episerver Visitor Intelligence
Episerver Visitor Intelligence is a user interface for viewing and filtering visitor profiles, 
and creating customer segments that you can use in your omnichannel marketing cam-
paigns. The Visitor Intelligence information is based on tracking of online visitor beha-
vior, such as viewing content or products. For more information, see Visitor Intelligence 
on Episerver World.

Episerver Email Product Recommendations and Triggered 
Messages
You can use Episerver Email Product Recommendations and Triggered Messages to cre-
ate triggers for sending automated personalized emails through Episerver Campaign. 
These transactional mails are initiated by on-site actions of an email recipient, for 
example abandoning a shopping cart on an e-commerce site. For more information, 
see Personalization on Episerver World.

https://world.episerver.com/documentation/developer-guides/commerce/commerce-campaign-integration/
https://world.episerver.com/documentation/developer-guides/commerce/commerce-campaign-integration/
https://world.episerver.com/add-ons/connect-for-marketing-automation/connect-for-campaign/
https://world.episerver.com/documentation/developer-guides/insight/
https://world.episerver.com/documentation/developer-guides/personalization/
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E-commerce integrations

E-commerce integration lets your Episerver Campaign client go hand-in-hand with your 
web shop and product management system. You can synchronize recipient data and 
import product data directly into your mailing template, using the power of Episerver's 
sending infrastructure. Registration of new recipients and management of your product 
data are carried out as usual in your e-commerce system. Data is synchronized auto-
matically and imported into your Episerver Campaign client, making it easy to manage 
cross- and up-selling offers in mailings, or to design remarketing campaigns with per-
sonalized recommendations.

Episerver Commerce
Manage product content and discounts from one user interface, and import catalog 
content into Episerver Campaign. With the Campaign-Commerce integration you can 
import the latest product data into Episerver Campaign, and access catalog content  
when adding product recommendations to mailings. See Episerver platform.

Other e-commerce systems

Integration
Magento 

1
Magento 

2
Shopware Spryker

Recipient management via Episerver Cam-
paign ✓ ✓ ✓ ✘

Recipient status synchronization ✓ ✓ ✓ ✘

Product data import ✓ ✓ ✓ ✘

Opt-in process via Episerver Campaign ✓ ✓ ✓ ✓

Unsubscribe management via Episerver Cam-
paign ✓ ✓ ✓ ✓
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Integration
Magento 

1
Magento 

2
Shopware Spryker

Transactional emails via Episerver Campaign ✓ ✓ ✓ ✓

  Setup Setup Setup Setup

Magento 1 integration

Note: The Magento 1 integration is no longer supported with 
updates. Updates will only be made for the Magento 2 integration.

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 1.

If you are using Magento 1 as e-commerce platform, you can integrate this with 
Episerver Campaign and manage customer data via Episerver's email marketing plat-
form. The entire recipient management, from registration to the opt-in process through 
to updating of the recipient data and unsubscriptions, is done in Episerver Campaign. 
The Magento 1 integration allows for sending of transactional mails and regular email 
campaigns via Episerver's server. You can also import product data into Episerver Cam-
paign to display products in remarketing campaigns and recommendations.

Supported versions

Magento CE Magento EE

1.7 ✓ 1.12 ✓

1.8 ✓ 1.13 ✓

1.9 ✓ 1.14 ✓
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Installation
The installation should be carried out by an administrator or Dev operator. For the integ-
ration, you need to install the Episerver Campaign extension in Magento. You need at 
least PHP 5.3 and phpseclib 0.3.6 on your Magento server (the official distribution from 
Version 0.3.6.). You can install this via PEAR: http://phpseclib.sourceforge.net/pear.htm.

Install the Episerver Campaign extension via the file system. You need an FTP con-
nection to your server to transfer the installation package.

 1. Unpack the ZIP archive containing the installation onto your local PC.
 2. Establish an FTP connection to your Magento server.
 3. Copy the app folder to your Magento server.

Note: Test the installation and configuration first in a non-pro-
duction (live) environment.

Configuring in Episerver Campaign
When setting up your Episerver Campaign extension, certain data should be available 
for the configuration. If you are operating several store views, stores and/or websites 
with a Magento installation, see Configuring multiple-clients.

Log in to your Episerver Campaign client and select the required client. Copy the fol-
lowing IDs and codes:

 l Client ID. Open the start menu and select Administration > API overview > REST API tab.
 l Authorization code. Open the start menu and select Administration > API overview > 

Recipient lists tab. Select the required recipient list and click Manage authorization 
codes. If no code is set up for the selected list, click Create authorization code.

 l Opt-in ID. Open the start menu and select Administration > API overview > Opt-in pro-
cesses tab. Select the opt-in process that you want to use for the Magento store 
(see following section).

 l Opt-in link. Edit the system mailing you are using for the registration confirmation 
(opt-in) of customers from your Magento shop and replace the default field function 
for the opt-in link: {Double-Opt-In-Link} with the parameterized string: {Double-Opt-In-
Link}?id={bmecssid}&code={bmecsscc}

Customer support will further configure in Episerver Campaign. Episerver needs the fol-
lowing information from your Magento shop:

http://phpseclib.sourceforge.net/pear.htm
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 l The IP address of your Magento shop. This is stored in your client.
 l Forwarding email address. Should be an administrative email address to where ARF 

reports, bounces, spam, auto-replies and responses are sent.
 l The transmission domain of your shop. Must be delegated to Episerver and stored in 

your client as a transmission domain. 

Importing recipient data
When setting up the integration, customer support sets up a recipient list with the stand-
ard fields from Magento in your Episerver Campaign client. The recipient list contains 
the following fields:

Field name
Data 
type

Description

email String Email address

salutation String User's title

firstname String First name

lastname String Last name

language String ISO code for the language from the StoreView via which the user has 
registered.

street String Street address

zip String Postcode or international ZIP code

city String City

state String State

country String Country

Apart from the mandatory email address and automatic language, fields are optional. 
To receive the data, create an expanded subscription form or an edit-profile form and 
integrate this into your shop pages.
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Adding and exporting additional recipient data fields
In Magento, you can add recipient data called customer attributes to save with the 
default recipient data and export the data to Episerver Campaign. Customer attributes 
let you adapt your sales approach. You can use customer attributes like any other 
default value to personalize newsletters or to create highly customized customer seg-
ments. 

Note: The function to add customer attributes (steps 1-7) is not avail-
able in Magento Community Edition. Instead, there are third-party 
extensions available that add this functionality to the browser.

 1. Select Customers > Attributes > Manage Customer Attributes. 
 2. Click Add New Attribute and define first the Attribute Properties.
 3. In the field Attribute Code, enter a unique internal name.
 4. In the Input Type drop-down list, select the desired data type.

Note: The export to Episerver Campaign only supports the field 
types Text Field, Text Area, Date and Yes/No.

 5. Define the further settings for the customer attribute.
 6. Click the Manage Label/Options tab and define the titles for the customer attribute, 

as you want them to be displayed in the admin back end and in the different lan-
guages of your shop. You must enter a title in the Admin field. If you leave the other 
fields empty, the Admin value is used for them as a default value.

 7. Click Save Attribute.
 8. Select System > Configuration > optivo broadmail.
 9. Open the HTTP-API panel and, in the the Customer Attributes to optivo list, select cus-

tomer attributes you want to export to Episerver Campaign. Use CTRL to select mul-
tiple attributes.

 10. Click Save Config. The selected attributes are sent to Episerver Campaign at every 
HTTP API request.

 11. To process the sent data, communicate the field names and types of the customer 
attributes to customer support who configure the recipient lists in your Episerver Cam-
paign client. When this is done, you can access the customer attributes in Episerver 
Campaign as a recipient field and can be used to create personalized content or 
target groups based on these data.
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Importing product data into a template
If you are configuring the product data export in Magento, you need a correspondingly 
equipped mailing template with a content interface to integrate the imported data 
into your mailings (for example in the form of recommendations or cross and upselling 
offers). 

Note: An individual template and the content interface are addi-
tional functions, subject to a charge, and are not part of the stand-
ard scope of supply for the Magento integration. For more 
information, contact customer support.

The Magento integration transfers the following product data to Episerver Campaign:

Field name Data type Description

id Long Product ID

name String Product title

category String Product category (final path)

description String Product description

short_description String Short description of the product

sku String Item number

product_url String URL to product landing page

price String Product price

special_price String Special price

special_from_date String Offer valid from

special_to_date String Special valid until

base_image String Product image
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Field name Data type Description

small_image String Downsized product image

thumbnail String Thumbnail image

Configuring in Magento
Open the system configuration tool in Magento, then, in the optivo menu, select the 
menu item optivo broadmail. 

Tip: If a 404 error message (Page not found) appears, log out and 
log back in again.

General

Open the General area and complete the fields using the data that you copied from 
your Episerver Campaign client in the previous step:

 l Client ID. Client ID
 l Client Name. Optionally, enter the name of your Episerver Campaign client. This is 

used for orientation purposes, because the client ID can be difficult to remember.
 l Authorization Code. Authorization code
 l Opt-in ID. Opt-in ID
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HTTP API

Open the HTTP-API area, enter the confirmation page URL for the double opt-in, and 
enter the confirmation page URL for the unsubscription process in the second field.

Tip: The CMS page for the confirmation (Newsletter Confirm Page) 
or unsubscription (Newsletter Unsubscribe Page) can also be a 
CMS page created specially for this case.

SMTP API

Open the SMTP-API area and select whether you want to use the Episerver Campaign 
SMTP-API to send transaction mails. If you have select Yes here, enter the appropriate 
data in the following fields:

 l User name of the API user. Provided by customer support.
 l Password of the API user. Provided by customer support.

You also have to configure the Store Email Addresses in Magento. Open the Store Email 
Addresses menu item and, for the email addresses specified here, specify the domain 
you have delegated to Episerver during the SMTP setup.
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FTP API

Open the FTP-API (Product Export) area and select whether you want to activate the 
product data export as per Episerver Campaign. If you select Yes here, fill in the fol-
lowing data fields with the corresponding information:

 l User name of the API user. This is provided by customer support.
 l Private key is encrypted. Select Yes from the list of options.
 l Private key. A key pair must be generated for data exchange via SFTP. See  FTP access 

via SCP. Enter the private key here and inform Episerver of the public key.
 l Daily Export at. Select the time at which the daily product data export should take 
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place.

Transactional mail address

In the System configuration, in the General menu, select the Store email addresses menu 
item. Open the mailing address that you want to use for your transactional mails via 
Episerver Campaign and enter a sender name and a sender address. The mailing 
address Sales representative is used as standard for transactional mails (for example, 
order confirmations). You can also configure a different mailing address (such as Adap-
ted email 1). To store this mailing address for transactional mails, go to the Sales emails 
menu item in the Sales area, and select the corresponding mailing address for each 
sales campaign.
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Note: The transmission domain for the transactional mails must be 
delegated to Episerver and also be stored in your Episerver Cam-
paign client as a transmission domain. The administration of the del-
egated domains is carried out by Episerver. Do not use your shop's 
main domain (example.com), but instead set up a subdomain for 
transactional mails (transactions.example.com) and delegate this 
subdomain.

Configuring transactional mails
You can configure and send a transactional mail for shop actions (orders, shipments, 
changes to customer and shipping data and so on) using Episerver Campaign. Adjust or 
set up corresponding templates in your Magento shop to do this. To create a template:

 1. Select System > Transactional mails. Transactional mail templates are now displayed 
in a table. 

Note: The Template Type column shows whether a template is 
configured for sending using the Magento shop (template 
type: HTML) or using Episerver Campaign (template type: 
optivo). You can change the template type so that templates, 
that are configured for sending via the Magento shop, are sent 
using Episerver Campaign. To do so, go to step 6.

 2. Click Insert New Template and from the Load default template area, select a tem-
plate; empty templates cannot be created with Magento.

 3. Select an area schema from the list below. This schema determines the formatting 
of prices and dates.

 4. Click Load template to copy the content.
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 5. In Template Information, enter a name for the template. This name is only used intern-
ally.

 6. Select the send with optivo broadmail check box. The two new fields optivo authcode 
and optivo bmmailid are now displayed.

 7. In optivo authcode, enter the authorization code for the recipient list that should be 
used for the transactional mail.

 a. Open the start menu and select Administration > API overview > Recipient lists.
 b. Select the required recipient list and click Manage authorization codes. A new 

window opens that displays a list of authorization codes for the selected recip-
ient list.

 c. Copy the ID of the desired authorization code and enter it into the cor-
responding field in Magento. If no authorization code is currently available, click 
Create authorization code to generate a new code.

 8. In optivo bmmailid, enter the ID of the transactional mail in Episerver Campaign that 
you want to send with this transaction. The transactional mail must be set up in your 
Episerver Campaign client beforehand; see Transactional mails.

 9. Remove the HTML code from the Template content field.
 10. Enter recipient parameters to transfer with this template to Episerver Campaign 

using the following format:

[parameter]={{var order.getOptivoBillingData('[variable]')}}

Note: Replace the string [parameter] with the name of the para-
meter in Episerver Campaign, and replace the string [variable] 
with the name of the variable used by Magento for the order 
object. For example, the line lastname={{var order-
.getOptivoBillingData('lastname')}} sends the last name of the 
recipient to Episerver Campaign. See  Recipient and billing data 
for a list of recipient parameters.

 11. To add a parameter, start a new line.
 12. In addition to the variables provided by the function getOptivoBillingData, you can 

also send the shop-specific standard variables to Episerver Campaign to use them in 
the transactional mail. Use the following format to do this:

[parameter]=[variable]

Note: For each variable to be transferred, a corresponding field 
[parameter] is required in the target recipient list in Episerver 
Campaign. To insert a variable, click Insert Variable... and 
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select the desired variable from the list. For example, the line: 
resetPassword={{htmlescape var=$customer.password}} sends a new 
password to the resetPassword field. This lets you send a trans-
actional mail to a recipient who has requested a new pass-
word.

 13. Likewise, enter order items that you want to send with this template to Episerver 
Campaign using the following format:

orderPositions={{var order.getOptivoProducts('product_id','sku','name','price','qty_
ordered)}}

The five standard parameters (product ID, order number, name, price and quantity) 
are sent using the above format. If you do not require one of these parameters, you 
can remove it from the schema. If you want to send additional order parameters, 
you need to program a custom template. See Order details for a list of available 
order parameters and notes about templates.

Note: To carry out the programming, you need PHP knowledge 
and knowledge of the Magento object model.

 14. Click Save Template.

Note: The template is not activated when saved; that is, no 
transactional mails are sent using it.
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 15. To activate the template and link it to an action, select System > Configuration.
 16. Locate the Sales section in the menu on the left and click Sales Emails. This displays 

actions that trigger a transactional mail to be sent.
 17. Open the panel for the desired action and select the desired template from the 

drop-down list (there is a template for each registered user and guest).
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Configuring multiple clients 
Magento and Episerver Campaign provide the option of displaying multiple clients. 
Configure each individual client exactly as described in the configuration sections. 
Ensure that the clients are allocated correctly in Episerver Campaign and Magento. 

For each client, you need the client ID, client name, authorization code and opt-in ID. 
You can configure the confirmation pages for the opt-in and the unsubscription con-
firmation separately for each client, or you can use the same URLs for clients. The con-
figuration for the SMTP-API and the FTP-API is global, and only needs to be carried out 
once.

Note: To ensure that the clients are correctly allocated in Episerver 
Campaign and Magento, contact customer support to help you 
with the configuration.

Selecting a client in Magento

Clients are depicted in Magento via websites, stores and store views. See User Guide 
from Magento. The client selection section is at the top left-hand side of the con-
figuration.

Integrating the subscription form
Subscription to your newsletter is performed via the online registration form on your shop 
pages. The registration data is transferred to Episerver Campaign by means of an HTTP 
request. The standard template for the subscription form can be integrated onto any 
CMS page. Connection to Episerver Campaign is automatic when you are using the 
standard template. For standard newsletter subscriptions, only the email address is 
requested in the standard form. Magento also automatically transfers to Episerver Cam-
paign the language in which new subscribers are registered in the Magento shop. You 
can use this information to send newsletters in different languages, for example.

https://magento.com/resources/technical


© Episerver 2020

828 | Episerver Campaign User Guide 2020-04-23

To request additional recipient data, you need an extended subscription form. For this 
type of form, you need extended programming knowledge in HTML. See Importing recip-
ient data for information about the data that you can request and process with the 
integration.

Integrating the subscription form on a CMS page
 1. In the top menu bar, go to the CMS menu item.
 2. In the Pages overview, go to the Manage content menu item.
 3. Select Add new page or edit an existing CMS page.
 4. In the Editor field, enter the following code fragment:

{{block type="core/template" template="newsletter/subscribe.phtml"}}

 5. Click Save, or Publish.
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Integrating the subscription form on category pages
 1. In the top menu bar, go to the Catalog menu item.
 2. In the Categories overview, go to the Manage categories menu item.
 3. Select the required category and a client (optional), and go to the Own design tab.
 4. Enter the following code fragment in the Editor field. Your subscription may have a 

different column layout and positioning, so adjust accordingly.

<!-- Newsletter Box -->
 <reference name="right">
 <block type="newsletter/subscribe"
 name="right.newsletter"
 template="newsletter/subscribe.phtml"/>
 </reference>

This code fragment integrates the subscription form into the right-hand layout 
column. If you want to integrate the newsletter into the left-hand column, replace 
the tag

<reference name="right"> with the tag <reference name="left">
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and replace the attribute name="right.newsletter" with name="left.newsletter".

Depending on the integration and to ensure a correct display on different end 
devices, you also may make changes in CSS.

 5. Click Save, or Publish.

Note: Additional integration options
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This section listed only the possible integration options  from the 
back-end. The integration can also take place almost everywhere 
via the Magento template system. These changes require design 
experience and access to the Magento installation file system.

Error handling

Activating Magento logging

By default, general logs are written to the system.log file, and errors and exceptions to 
the exception.log file. You can change these file names at var/log/.

Activate writing log files in Magento for error analysis. 

 1. Select  System > Configuration.
 2. Click Progress and then Developer.

 3. Set the Enabled option to Yes.

Activating developer module

To analyze errors and ensure that effective logging is taking place, activate the 
developer mode in Magento via .htaccess or directly in the index.php of Magento:
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The log file for the Episerver Campaign extension is located in the /var/log/ directory 
within the Magento installation. The name of the log file is optivo_broadmail.log.

Conflicts with other Magento extensions

There may be conflicts between the Episerver Campaign extension and other exten-
sions if these extend the same Magento core functions. In particular, conflicts may 
occur in connection with other Magento extensions that also provide newsletter, SMTP 
or similar functions to the Episerver Campaign extension.

Furthermore, local code adjustments in the code pool local can lead to additional by-
effects or side effects in the interplay.

During error analysis, pay attention to which extensions and in-house developments are 
integrated in the Magento installation.

Tip: To prevent these types of conflicts and integration mal-
functions, first install your Magento platform with the Episerver Cam-
paign extension and other extensions being used onto a test 
system. Then, reproduce a range of different test scenarios there 
before carrying out the installation in a production environment.

Recipient and billing data  

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 1.

If you are using Magento 1 as e-commerce platform, you can integrate this with 
Episerver Campaign. The following recipient data is provided by Magento and, using a 
transactional mail template, can be sent to Episerver Campaign. When configuring the 
template, the variables from Magento are each assigned to a recipient list field in 
Episerver Campaign. If you want to transfer variables that do not have a corresponding 
field in your transactional recipient list, contact customer support.
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Field name Date type

entity_id Integer

parent_id Integer

customer_address_id Integer

quote_address_id Integer

region_id Integer

customer_id Integer

fax String

region String

postcode String

lastname String

street String

city String

email String

telephone String

country_id String

firstname String

address_type String

prefix String

middlename String
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Field name Date type

suffix String

company String

vat_id String

vat_is_valid Boolean

vat_request_id Integer

vat_request_date String

vat_request_success Boolean

giftregistry_item_id Integer

country String

salutation String

Order details

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 1.

If you want to send more than the five standard order parameters (product ID, order 
number, name, price and quantity) provided by the function getOptivoProducts to 
Episerver Campaign, you can use a custom template that aggregates and calculates 
the required variables. This template is linked using the line:

{{layout area="frontend" handle="optivo_email_order_items" order=$order}}

and defined in the file items.phtml.

Note: To program the template, you need relevant PHP skills and 
good knowledge of the Magento object model or order items. 
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Any changes must be applied only after consultation with customer 
support.

Field name Data type

item_id Integer

order_id Integer

parent_item_id Integer

quote_item_id Integer

store_id Integer

created_at Date

updated_at Date

product_id Integer

product_type String

product_options String

weight Float

is_virtual Boolean

sku String

Name                     String

Description                     String

applied_rule_ids String

additional_data String
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Field name Data type

free_shipping Boolean

is_qty_decimal Boolean

no_discount Boolean

qty_backordered Float

qty_canceled Float

qty_invoiced Float

qty_ordered Float

qty_refunded Float

qty_shipped Float

base_cost Float

price Float

base_price Float

original_price Float

base_original_price Float

tax_percent Float

tax_amount Float

base_tax_amount Float

tax_invoiced Float

base_tax_invoiced Float
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Field name Data type

discount_percent Float

discount_amount Float

base_discount_amount Float

discount_invoiced Float

base_discount_invoiced Float

amount_refunded Float

base_amount_refunded Float

row_total Float

base_row_total Float

row_invoiced Float

base_row_invoiced Float

row_weight Float

gift_message_id Integer

gift_message_available Integer

base_tax_before_discount Float

tax_before_discount Float

ext_order_item_id String

weee_tax_applied String

weee_tax_applied_amount Float
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Field name Data type

weee_tax_applied_row_amount Float

base_weee_tax_applied_amount Float

base_weee_tax_applied_row_amnt Float

weee_tax_disposition Float

weee_tax_row_disposition Float

base_weee_tax_disposition Float

base_weee_tax_row_disposition Float

locked_do_invoice Boolean

locked_do_ship Boolean

price_incl_tax Float

base_price_incl_tax Float

row_total_incl_tax Float

base_row_total_incl_tax Float

hidden_tax_amount Float

base_hidden_tax_amount Float

hidden_tax_invoiced Float

base_hidden_tax_invoiced Float

hidden_tax_refunded Float

base_hidden_tax_refunded Float
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Field name Data type

is_nominal Integer

tax_canceled Float

hidden_tax_canceled Float

tax_refunded Float

event_id Integer

giftregistry_item_id Integer

base_tax_refunded Float

discount_refunded Float

base_discount_refunded Float

gw_id Integer

gw_base_price Float

gw_price Float

gw_base_tax_amount Float

gw_tax_amount Float

gw_base_price_invoiced Float

gw_price_invoiced Float

gw_base_tax_amount_invoiced Float

gw_tax_amount_invoiced Float

gw_base_price_refunded Float
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Field name Data type

gw_price_refunded Float

gw_base_tax_amount_refunded Float

gw_tax_amount_refunded Float

qty_returned Float

Magento 2 integration

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 2.

If you are using Magento 2 as e-commerce platform you can integrate this with 
Episerver Campaign to take advantage of your e-commerce and customer com-
munication marketing activities. 

With the Magento 2 integration, customers can subscribe/unsubscribe to newsletters dir-
ectly in your shop. The integration transfers customer data received during registration 
to Episerver Campaign so that you can use the information to personalize emails. You 
can also automatically send transactional mails like order confirmations and invoices. 
When registered customers change their data in the shop, customer data is syn-
chronized. The integration also lets you transfer the product catalog to Episerver Cam-
paign daily.

The Magento 2 integration supports multiple clients, and the connection of several 
shops to Episerver Campaign.

Feature range and supported versions
The Magento 2 integration provides the following features for Magento 2.0, 2.1, 2.2 and 
2.3 (Community Edition). 

 l Newsletter subscription and unsubscription                     
 l Transactional mails via HTTP API and SMTP API
 l Export product catalog into Episerver Campaign
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Setting up in Episerver Campaign
To set up the Magento 2 integration, contact customer support to get the integration 
software package.

Provide Episerver with the following information:

 l The version number of your Magento 2 system.
 l The recipient list structure for your newsletter recipients. Let Episerver know if you 

want to add additional fields.

The Magento 2 integration offers two ways to send transactional mails via Episerver Cam-
paign:

 1. Via the HTTP API. When you want to use the Episerver Campaign templates for your 
transactional mails. Episerver requires the transaction recipient list for your trans-
actional mails. Episerver provides a default template for the transaction recipient 
list structure that is suitable for many applications/scenarios. Episerver can discuss 
with you whether the standard template meets your requirements. See Transactional 
mails via HTTP API.

 2. Via the SMTP API. When you want to use the Magento 2 templates for your trans-
actional mails and Episerver Campaign only for sending. If you want to use the SMTP 
API, provide the IP address of your web shop for configuration purposes. See Trans-
actional mails via SMTP API. 

 l For product catalog export to Episerver Campaign, you need a user account on the 
Episerver server. If you do not have a user account, contact customer support. 
Provide a public key and a key fingerprint to securely transfer the data. See File 
exchange via SCP.

 l If you are running multiple shops (including sub-shops and shops that are localized in 
other languages), let Episerver know the number of shops you want to connect to; 
see Advanced configuration. 

 l If you are integrating multiple shops, you may need:    

 o Separate clients for the individual web shops.
 o A separate client for your transactional mails.
 o Setup of a recipient-list-based newsletter subscription.

Installation

Note: This topic is for administrators and developers with 
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administration access rights in Magento 2.

This topic describes how to install the Magento 2 integration, if you are using Magento 
as e-commerce platform with Episerver Campaign. 

Installing the integration package

Note: To prevent problems and conflicts, first install and test the 
Magento 2 integration on a test system.

When you have received the integration software package (ZIP archive) from customer 
support, install it in Magento 2 as described in the following.

 1. Unzip the ZIP archive.
 2. Upload the unpacked folder to the directory app/code/Optivo/Broadmail in your 

Magento 2 system.
 3. Clear the cache of the Magento 2 system.
 4. Verify the successful upload of Magento 2 integration with the following console 

command:

 php bin/magento module:status

If the upload is successful, the Magento 2 integration is displayed in the List of dis-
abled modules.

 5. Use the following console command to activate the Magento 2 integration:

php magento module:enable Optivo_Broadmail

Installing an update

If you receive an updated version of the integration from customer support, do the fol-
lowing to install the upgrade:

 1. Unzip the ZIP archive.
 2. Upload the unpacked folder to the directory app/code/Optivo/Broadmail in your 

Magento 2 system.
 3. Use the following console command:

php bin/magento setup:upgrade
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Uninstalling the integration package

Do the following to uninstall the Magento 2 integration: 

 1. Disable the Magento 2 integration by using the following console command:

php bin/magento module:disable Optivo_Broadmail

 2. Clear the cache with the following console command:

php bin/magento cache:clean

 3. Delete the Magento 2 integration files.

Configuring the newsletter

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 2.

This topic describes how to configure the newsletter subscription/unsubscription fea-
ture, if you are using Magento 2 as e-commerce platform with Episerver Campaign. It 
also shows how to transfer other recipient data to Episerver Campaign, data that is not 
included in the standard configuration of the Magento 2 integration.

Configuration steps

 1. Configure the opt-in mailing (registration confirmations) in Episerver Campaign, and 
then use a field function to reference the confirmation link to your shop.

 2. Create two landing pages in Magento 2, one to display a successful newsletter sub-
scription confirmation, and one to display a successful unsubscribe confirmation.

 3. Store the client ID, the authorization code for the API access, and the ID of the opt-in 
process the shop.

 4. Optional: Expand the recipient list structure, to transfer other recipient/customer 
data that is not included in the standard configuration of the Magento 2 integration.
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Configuring the opt-in mailing

 1. Log in to Episerver Campaign.
 2. Open the start menu and select Campaigns > Confirmations.

 3. Select the opt-in mailing (which customer support has already prepared and stored 
in your client for the connection to your shop) by marking the relevant mailing in the 
list.

 4. Click Edit.

 5. On the Email node, click Properties  .
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 6. Click Edit content.

 7. In the paragraphs that contain the registration confirmation link, click Text/image.
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 8. In the Text area, click Source.

 9. Replace the existing link with the following code lines/field functions:

{Double-Opt-In-Link}?id=${user.data.bmecssid}&code=${user.data.bmecsscc}

You will find the link to be replaced in the <a> tag between the quotation marks.

Example

The following link is contained in the <a> tag in the source code:

<a href="http://srv2.de/subscribe.html">Complete registration</a>
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Replace the link between the quotation marks as follows:

<a href="{Double-Opt-In-Link}?id-
d=${user.data.bmecssid}&code=${user.data.bmecsscc}">Complete registration</a>

Note: The parameters id and code enable the Magento 2 integ-
ration to map to the data sets in your shop.

 10. Click Apply > Close > Save and close.

Creating landing pages

 1. Log in to Magento 2 with administrator rights.
 2. Select Content > Pages.
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 3. Click Add New Page. 

 4. In the Page Title field, enter a name for the landing page.

Note: Assign unique names to the landing pages, for example 
Episerver Campaign opt-in confirmation or Episerver Campaign 
opt-out confirmation.
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 5. Click Content. 

 6. In the Content Heading box, enter the title that you want to display on the landing 
page.
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 7. In the text box, enter the text that you want to display on the landing page.

 8. Optional: If required, change other settings on the form, such as layout adjustments 
under Design.

 9. Click Save Page. 

 10. Repeat steps 3–9 for the second landing page you want to create.

Storing authorization code, opt-in, and client IDs

Note: Do not confuse the recipient list for your newsletter recipients 
with the transaction recipient list for your transactional mails. Cus-
tomer support will set up two different types of recipient lists for the 
sending of newsletters and the sending of transactional mails (for 
example order confirmations, invoices).
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 l Authorization code. For the Episerver Campaign recipient list (created for you by cus-
tomer support and saved in your client). You can locate the authorization code in 
your Episerver Campaign client in the API overview. Open the Recipient lists tab and 
select the relevant recipient list. Click Manage authorization codes and copy the 
authorization code from the list. If no authorization code is available for the selec-
ted recipient list, click Create authorization code.

 l opt-in ID. To see the opt-in ID, open the Episerver start menu and select Admin-
istration > API overview > Opt-in processes.

 l client ID. To see the client ID, open the Episerverstart menu and select Administration 
> API overview > REST API.

 1. To store the parameters, log in to Magento 2 with administrator rights.
 2. Select Stores > Configuration.

 3. Select Episerver > Episerver Campaign.
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 4. In General Settings, enter the following data:

 l Client ID. Enter the client ID.
 l Client Name. Enter a name for the client. You can choose any name for the cli-

ent. However,  use the same name as in Episerver Campaign.
 l Authorisation Code. Enter the authorization code.
 l Opt-In ID. Enter the opt-in ID.
 l Debug Mode. Select Yes.
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 5. In the HTTP API area, from the Landing page for newsletter subscription confirmation 
drop-down list, select the landing page that you created for the newsletter regis-
tration in Magento 2.

 6. In the HTTP API area, from the Landing page for newsletter unsubscribe confirmation 
drop-down list, select the landing page that you created for the newsletter unsub-
scription in Magento 2.
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 7. Save your changes.

Note: Coded values (Client ID, Private key) must be entered 
anew with each saving process. Otherwise the coded value is 
coded anew.

Transferred attributes in the standard configuration
The Magento 2 integration only transfers the email addresses of customers who sub-
scribe to the newsletter with their email address, but are not logged into their customer 
account. The data listed in the following table is transferred for customers who are 
logged into the customer account.

If a customer or an administrator changes the customer data in the shop system, the 
changes are automatically transferred to the Episerver Campaign recipient list. 
Changes to customer data entered in a recipient list in Episerver Campaign are not syn-
chronized with your shop system by Magento 2 integration. For this reason, change cus-
tomer data in your Magento 2 system to keep the information synchronized.

 l Email. Email address of the customer/recipient                     
 l Salutation. Title                     
 l Firstname. First name                     
 l Lastname. Last name                     
 l Language. Language of the shop set up in Magento 2 in which the customer has 

registered                     
 l Street. Street                     
 l Zip. Postal code                     
 l City. City                     
 l State. State                     
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 l Country. Country                     
 l bmecssid. ID generated by Magento 2 integration and used for identification during 

communication with Episerver Campaign
 l bmecsscc. Confirmation code generated by Magento 2 integration and used for 

identification during communication with Episerver Campaign
 l store_id. ID of the web shop in which the customer has registered                     
 l dob. Date of birth
 l group_id. Customer group

Expanding the recipient list structure and transferring additional recipient data

You can transfer other recipient/customer data from Magento 2 to Episerver Cam-
paign, in addition to the standard attributes. To set up the transfer, you need to:

 l Request additional recipient list fields.
 l Enable the additional recipient data in Magento 2.

Note: The additional attribute fields in Magento 2 must be pro-
grammed in accordance with the specifications of Magento 2. 
Additional attribute fields that have not been programmed 
according to the Magento 2 specifications cannot be transferred 
to Episerver Campaign.

Requesting additional recipient list fields
To request additional recipient list fields, contact customer support and let Episerver 
know which additional recipient list fields you require for user-defined attributes. Cus-
tomer support will expand your list of recipients with the additional recipient list fields as 
per your requirements.

Enabling the transfer of additional recipient data
After customer support adds the requested recipient list fields, activate the transfer of 
the corresponding recipient data via HTTP API in Magento 2. 
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 1. Log in to Magento 2 with administrator rights.
 2. Select Stores > Configuration.

 3. Select Episerver > Episerver Campaign.

 4. In the HTTP API area, in the Configure additional customer attributes to transmit list, 
select the additional recipient data that you want to transfer to Episerver Cam-
paign in addition to the standard attributes.
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Tip: Hold down CTRL to select multiple attributes at the same 
time.

 5. Save your changes.

Configuring transactional mails via HTTP API

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 2.

This topic describes how to configure sending of transactional mails via HTTP API with 
Magento 2. For transactional mails via the SMTP API, see Transactional mails via SMTP API.

How it works

Sending of transactional mails via HTTP API uses these templates:

 l A Sender template in Magento 2, which sends the variables of the transaction (for 
example customer name, ordered products) via the HTTP API.

 l A Recipient template in Episerver Campaign, which uses field functions to insert sent 
variables into relevant locations. This creates the finished transactional mail with lay-
out.
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Sending and receiving the content of the variables takes place using the transaction 
recipient list as a buffer.

 1. The Magento 2 template sends the variables.
 2. The variables are written to the transaction recipient list: each variable into the rel-

evant recipient list field.
 3. Using field functions, Episerver Campaign copies the template with the individual 

variables from the transaction recipient list and places it in the desired location in 
the transactional mail.

Configuration steps

 1. Set up a transaction recipient list.
 2. Create the template in Episerver Campaign.
 3. Create and activate the template in Magento 2.
 4. Configure transactional mails and transfer Magento 2 variables.

Step 1. Setting up a transaction recipient list

To set up the transaction recipient list. contact customer support. Plan in advance which 
variables you want to transfer from Magento 2 into Episerver Campaign for your trans-
actional mails.

List the Magento 2 variables for which you require a corresponding recipient list field in 
your transaction recipient list. Also, let Episerver know the naming of the recipient list 
fields.

Note: The scope of the transaction recipient list is limited. For this 
reason, you should request generic names for the recipient list 
fields, for example  custom_string_1, custom_string_2, custom_
date_1 and so on.
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Step 2.  Creating a template in Episerver Campaign

Create the template and add the desired transactional mail texts (the unchangeable, 
static texts that are to be sent to recipients) and insert field functions in the places where 
the content of the Magento 2 variables should be.

Field functions
Field functions are placeholders that refer to a specific recipient list field in your trans-
action recipient list. The variables and content of the variables sent from Magento 2 are 
written into the relevant recipient list fields in your transaction recipient list. The field 
functions you place load relevant content from the referenced recipient list field in the 
next step.

Example

Set up a transactional mail text that greets each customer using the last name and the 
order date. For this you need these variables: salutation, lastname and orderdate.

The content of the variables is first written to a relevant recipient list field of the trans-
action recipient list (from Magento 2 via the HTTP API). To access these recipient list 
fields, insert the individual field functions into the Episerver Campaign template and 
place the name of the recipient list field in curly brackets. To import the variable con-
tents, the static text and field functions in the Episerver Campaign template could look 
like this:

Hello, {salutation} {lastname}! 
 Thank you for your online order from {orderdate}.

The example will appear in the sent transactional mail as follows:

Hello, Mr. Miller! 
Thank you for your online order from August 3.
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Adding static texts and field functions to a template
 1. Log in to Episerver Campaign.
 2. Open the start menu and select Campaigns > Transactional mails.
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 3. Click Create.

 4. From the left action pane, drag the Recipients node into the workspace.

 5. In the Recipient lists drop-down list in the context menu, select your transaction recip-
ient list.     
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Note: Customer support has set up a separate transaction recip-
ient list for you. Make sure you use this transaction recipient list, 
instead of a regular recipient list. To see if a recipient list is a 
transactional recipient list, check the column Transaction API.

 6. From the left sidebar, drag the message node for the desired media type (email,  
SMS) into the workspace.

 7. In the Name box in the context menu, enter a name for your transactional mail (for 
example Order confirmation).     

 8. In the context menu for the messages node, click Edit content.
 9. In the Template list, select the desired template and confirm your selection by click-

ing Next.
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 10. Configure  the template for the transactional mail according to your requirements. 
Enter a subject and insert the static texts that recipients will receive, into the con-
tent paragraphs. Insert the relevant field function for the recipient list field of the 
transaction recipient list into places where variables from the Magento 2 template 
should appear (see example above).

 11. Click Apply.
 12. Click Close.
 13. Connect the Recipients node with the message node.

 14. Click Save and close.
 15. Select the mailing in the overview and click Start to activate your transactional mail 

and to start the sending process.

Step 3.  Creating and activating the template in Magento 2

Create a template in Magento 2 that sends the variables to Episerver Campaign via 
HTTP API.
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Prerequisites
 l Authorization code. For your transaction recipient list in to Episerver Campaign. 

Open the start menu and select Administration  > API overview > Recipient lists tab and 
select the desired transaction recipient list. Click Manage authorization codes and 
copy the authorization code from the list. If no authorization code is available for 
the selected recipient list, click Create authorization code.

 l Mailing ID. For the template in Episerver Campaign. 

Open the start menu and select Campaigns > Transactional emails. Copy the relevant 
mailing ID of the template in the list in column ID.

Configuration options
With Magento 2, you have two template configuration options  for transferring variables:

 1. Use a template included in the standard Magento 2 installation and customize it to 
fit your needs. If you choose this option, the template's HTML code loads in the tem-
plate content field. The code contains the available variables, for example {{trans 
"%name," name=$customer.name}} (for addressing customers by their names). Clean up the 
template around the HTML code and reduce the template to the variables. In the 
next step, map the corresponding recipient list fields of your transaction recipient list 
in Episerver Campaign. See  Mapping: Here’s how you do it.

 2. Create an empty template and manually insert the variables to be sent to Episerver 
Campaign via the HTTP API.

Do the following to create a template, add the variables and map these to the recip-
ient list fields of your transaction recipient list.
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 1. Log in to Magento 2 with administrator rights.
 2. Select Marketing > Email Templates.

Note: If you already created templates that are sent to 
Episerver Campaign, these appear as the template type 
Episerver.

 3. Click Add New Template.
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 4. In the Template Information area, fill in the fields:

 l Template Name. Enter a name for the new template.
 l Template Subject. Leave empty. 

Note: The subject is automatically entered later using the 
subject from the template created in Episerver Campaign.

 l Episerver Campaign. Select Enabled.
 l Authcorisation Code. Enter the authorization code for the transaction recipient 

list in Episerver Campaign.
 l bmMailingId. Enter the mailing ID of the template in Episerver Campaign.

 5. In the Template Information box, enter which variables from Magento 2 should be 
transferred to which recipient list field of the transaction recipient list in Episerver 
Campaign. To add a variable, click Insert Variable...
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 6. Select the desired variable by clicking it.
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 7. Map the inserted variable with the corresponding recipient list field in Episerver Cam-
paign. If required, click Insert Variable... to add further variables.
How to do the mapping

Magento 2 integration from Episerver Campaign uses the following structure for 
mapping:

Name of the recipient list=name of the Magento 2 variables

Enter the mapping assignment for each variable line by line, and separate the indi-
vidual variables/mapping instructions with a line break.

Example:

lastname={{config path="trans_email/ident_custom1/name"}}
url={{config path="web/secure/base_url"}}

Map with both example lines and transfer:

 l Value of the Magento 2 variables {{config path="trans_email/ident_custom1/name"}} 
into the transaction recipient list field lastname
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 l Value of the Magento 2 variables {{config path="web/secure/base_url"}} into the 
transaction recipient list field url

 8. Click Save Template.
 9. After you create the template, activate it and map an event (for example an order 

process, or newsletter registration). At which point in the admin interface you map 
and activate the template to an event depends on the type of the event.

Example: To map and activate the template to the event type Order, do the fol-
lowing:

 a. Select Stores > Configuration. 
 b. Select Sales > Sales Emails. 
 c. Activate the template by selecting it in the Order area in the New Order Con-

firmation Template drop-down list.
 d. Save your changes.

Step 4.  Configuring transactional mails and transferring Magento 2 variables

To transfer customer orders and billing and delivery addresses to the template in 
Episerver Campaign, using the template in Magento 2, you need additional con-
figuration, and create  a special field function (for order access) in your Episerver Cam-
paign client.

Note: Magento 2 provides the customer orders and billing and 
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delivery addresses as HTML code. This needs to be changed to 
simple text so that Episerver Campaign can process the inform-
ation.

Converting HTML code to simple text

The following functions in the Magento 2 integration are for converting the HTML code 
into simple text:

getEpiserverBillingData( )

With getEpiserverBillingData( ), you get access to the individual parameters of the billing 
address. This feature is available via the following instruction, used in an example for the 
salutation of the customer:

{{var order.getEpiserverBillingData('salutation')}}

You transfer the return value of the function call (parameter salutation) into the recip-
ient list field salutation as simple text with the following mapping:

salutation={{var order.getEpiserverBillingData('salutation')}}

getEpiserverBillingData( ) parameters

No. Parameter Description

1 salutation Title

2 firstname First name

3 middlename Middle name

4 lastname Last name

5 company Company

6 email Email address

7 telephone Telephone number

8 suffix Extension
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No. Parameter Description

9 fax Fax number

10 street Street

11 postcode Postal code

12 city City

13 region Region/state

14 country Country

getEpiserverShippingData() 

With getEpiserverShippingData( ), you receive access to the individual parameters of the 
customer's delivery address. The feature is available via the following mapping, in this 
example for the customer's last name:

{{var order.getEpiserverShippingData('lastname')}}

You transfer the return value of the function call (parameter lastname) into the recipient 
list field lastname as simple text with the following mapping:

lastname={{var order.getEpiserverShippingData('lastname')}}

getEpiserverShippingData() parameters

No. Parameter Description

1 salutation Title

2 firstname First name

3 middlename Middle name

4 lastname Last name

5 company Company

6 email Email address
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No. Parameter Description

7 telephone Telephone number

8 suffix Extension

9 fax Fax number

10 street Street

11 postcode Postal code

12 city City

13 region Region/state

14 country Country

getEpiserverOrderData() 

With getEpiserverOrderData( ), you access the customer's orders.

Note: Accessing orders differs from accessing the billing and the 
delivery addresses, as you transfer a list with several parameters 
into a single recipient list field, instead of transferring individual 
parameters.

The function is available via the following instruction (in this example, product ID, stor-
age unit, product name, quantity ordered and price):

{{var order.getEpiserverOrderData('product_id','sku','name','qty_ordered',
 'price')}}

You transfer a string with the order information specified in the order_positions_csv into 
the recipient list field with the following mapping:

order_positions_csv={{var order.getEpiserverOrderData('product_id',
 'sku','name','qty_ordered','price')}}

getEpiserverOrderData( ) parameters



© Episerver 2020

874 | Episerver Campaign User Guide 2020-04-23

No. Parameter

1 increment_id

2 state

3 status

4 coupon_code

5 shipping_description

6 is_virtual

7 store_id

8 base_discount_amount

9 base_discount_canceled

10 base_discount_invoiced

11 base_discount_refunded

12 base_grand_total

13 base_shipping_amount

14 base_shipping_canceled

15 base_shipping_invoiced

16 base_shipping_refunded

17 base_shipping_tax_amount

18 base_shipping_tax_refunded

19 base_subtotal
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No. Parameter

20 base_subtotal_canceled

21 base_subtotal_invoiced

22 base_subtotal_refunded

23 base_tax_amount

24 base_tax_canceled

25 base_tax_invoiced

26 base_tax_refunded

27 base_to_global_rate

28 base_to_order_rate

29 base_total_canceled

30 base_total_invoiced

31 base_total_invoiced_cost

32 base_total_offline_refunded

33 base_total_online_refunded

34 base_total_paid

35 base_total_qty_ordered

36 base_total_refunded

37 discount_amount

38 discount_canceled
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No. Parameter

39 discount_invoiced

40 discount_refunded

41 grand_total

42 shipping_amount

43 shipping_canceled

44 shipping_invoiced

45 shipping_refunded

46 shipping_tax_amount

47 shipping_tax_refunded

48 store_to_base_rate

49 store_to_order_rate

50 subtotal

51 subtotal_canceled

52 subtotal_invoiced

53 subtotal_refunded

54 tax_amount

55 tax_canceled

56 tax_invoiced

57 tax_refunded
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No. Parameter

58 total_canceled

59 total_invoiced

60 total_offline_refunded

61 total_online_refunded

62 total_paid

63 total_qty_ordered

64 total_refunded

65 base_shipping_discount_amount

66 base_subtotal_incl_tax

67 base_total_due

68 shipping_discount_amount

69 subtotal_incl_tax

70 total_due

71 base_currency_code

72 discount_description

73 global_currency_code

74 order_currency_code

75 shipping_method

76 store_currency_code
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No. Parameter

77 store_name

78 customer_note

79 created_at

80 updated_at

81 total_item_count

82 shipping_incl_tax

83 base_shipping_incl_tax

84 coupon_rule_name

After the transfer to Episerver Campaign, the individual parameters in the recipient list 
field of your transaction recipient list are separated by a semicolon. If multiple products 
are transferred, the individual products are separated by a line break. The string written 
in the recipient list field corresponds to the structure of a table that is saved in the CSV 
format.

Creating a special field function for order data

If you want to use order data in a transactional mail, you must create a new special field 
function in your client. This must use the template engine of Episerver Campaign to 
transfer the string to HTML, as described in the following.
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 1. Log in to Episerver Campaign.
 2. Open the start menu and select Administration > Field functions.

Note: If the Field functions menu item is not available in your cli-
ent, contact customer support.

 3. Click Add.

 4. Under General, in the Name box, add a concise name for the new field function, for 
example CSVOrderObjects.
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 5. In the Type drop-down list, select Velocity.

 6. In the Content area > Default replacement tab > Default replacement box, enter the fol-
lowing code:

<table>
 <tr>
   <td>Product ID</td><td>SKU</td><td>Name</td><td>Quantity</td>
   <td>Price</td>
 </tr>
 #set ("csvContent = "csv.readFromString("user.data.order_positions_csv))
 #foreach("row in "csvContent)
 <tr>
#foreach("item in "row)
   <td> "item </td>
#end
 </tr>
 #end
 </table>
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 7. Click Save.

Insert the field function at the desired location in the Episerver Campaign template. 
When the transactional mail is sent and the recipient list field order_positions_csv con-
tains a CSV context object, a simple HTML table is displayed in the sent transactional 
mail.

Note: See Field functions how to customize the layout of the 
table as desired (HTML knowledge is required).

Configuring transactional mails via SMTP API

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 2.

This topic describes how to configure sending of transactional mails via SMTP API with 
Magento 2. For transactional mails via the HTTP API, see Transactional mails via HTTP API.
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Prerequisites

You need an SMTP API user account for the SMTP connection between Episerver Cam-
paign and your shop. To set up the account, contact customer support. You will receive 
a user name and password for the SMTP API.

 1. Log in to Magento 2 with administrator rights.
 2. Select Stores > Configuration.
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 3. Select Episerver > Episerver Campaign.

 4. In the SMTP API area:

 l Use Episerver Campaign SMTP API. Select Yes.
 l Username. Enter your SMTP API user name.
 l Password. Enter your SMTP API password.

 5. Save your changes.
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Configuring the catalog export

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 2.

This topic describes how to configure the catalog export, when using Magento 2 as e-
commerce platform with Episerver Campaign. You can for example transfer  pro-
motional texts and product images, and use this data in your newsletters. See Content 
interface paragraph.

The Magento 2 integration exports your catalog into a CSV file (comma-separated val-
ues), and automatically transfers the catalog to the Episerver server via a secure SFTP 
connection at specific time intervals. 

Prerequisites

You need an SSH key pair and an SFTP user account to set up a secure connection.

Creating an SSH key pair

Follow these instructions to create a key pair:

 l FTP access via SCP for Windows
 l FTP access via SCP for MacOS/OS X

Requesting an SFTP user account

When you have created the key pair, do the following to request a user account:

 1. Contact customer support. Providing the name of the CSV file with your product 
catalog.

 2. Email your public key (the file with the .pub extension) to customer support.
 3. Send your key fingerprint in a separate email to customer support.

Note: For security reasons, always send your public key and key fin-
gerprint in two separate emails.

When your account is configured, you receive your user account information by email.
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Activating the catalog export in Magento 2

In the following steps, you activate the catalog export and save your private SSH key. 

 1. Log in to Magento 2 with administrator rights.
 2. Go to Stores > Configuration in the menu bar on the left. 

 3. In the left pane, select Episerver > Episerver Campaign.

 4. In the FTP API (Product data export) area, in the Use  Episerver Campaign product data 
export drop-down list, select Yes.
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 5. In the Username box, enter the user name of your SFTP user account.

 6. If you want to protect your SSH key with a password, select Yes in the Private key is 
encrypted drop-down list, and add a password in the Password box.
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 7. In the Private key box, enter your private key.

 8. Under Time for daily export (hh:mm:ss), select the time your product catalog should 
be exported.
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 9. Save your changes.

Note: Coded values (Client ID, Private key) must be entered 
anew with each saving process. Otherwise the coded value is 
coded anew.

Note: The product catalog export fails if the Cron Jobs functionality is 
incorrectly configured in Magento 2. This functionality is part of the 
standard installation. See the Magento 2 documentation for 
details.

Configuring shops and adapting messages

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 2.

This topic describes how to configure shops, connect templates and clients, and adapt 
front-end messages, when using Magento 2 as e-commerce platform with Episerver Cam-
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paign. You can set up a specific client in Episerver Campaign that is only used for send-
ing transactional mails.

Configuring multiple shops individually

The settings for the "Default" shop will also apply to other shops  set up in a Magento 2 
installation. However, the Magento 2 integration lets you connect multiple shops and 
store views individually with different templates and different clients in Episerver Cam-
paign. For example, this allows you to run multi-language shops and send order or news-
letter subscription confirmations in the individual language of the recipient.

Do the following to configure this:

 1. Log in to Magento 2 with administrator rights.
 2. Go to Stores > Configuration via the menu bar on the left.

 3. From the drop-down list under Store View, select the shop/store view you want to 
configure. Confirm your selection.
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 4. Click OK.
 5. In the left pane, click Episerver > Episerver Campaign.

 6. Clear the check boxes for the configurations that you want to change for the store. 
The grayed entry is activated and can be edited.
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 7. Change the configuration.

Note: To send out newsletter registration confirmations or trans-
actional mails in other languages, you must first create these in 
their respective language. See Configuring the newsletter and 
Transactional mails via HTTP API.

 8. Save your changes.
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Adapting front end messages

To translate or change front end messages  displayed to website visitors, for example 
when logging in, you can edit the integration text files. Front end messages are located 
in the directory src/i18n. The files are simple text files that follow the Magento 2 stand-
ard.

Tip: Install and test the Magento 2 integration on a test or staging 
system before you use it in production. If you are planning a test 
phase, report the URLs of the test system to customer support, to ref-
erence the subscribe and unsubscribe links during the test phase.

Troubleshooting

Note: This topic is for administrators and developers with admin-
istration access rights in Magento 2.

This topic describes how to manage  integrated-related issues when using Magento 2 as 
e-commerce platform with Episerver Campaign, how to get help with problems during 
installation and configuration, and how to activate error logging, and known issues.

Installation issues

If problems occur during the installation and configuration of Magento 2 integration, 
contact customer support and provide the following information:

 l The version number of the Magento 2 system you are using.
 l The output of the command phpinfo().
 l A description of when and in what context the error occurred.

Note: Conflicts may occur with other expansion modules for 
Magento 2. If you cannot determine, limit, or resolve the conflicts, 
provide Episerver with a list of the modules you use.

Activating error logging

Error logging displays operating status of the integration and any errors that occurred.
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 1. Log in to Magento 2 with administrator rights.
 2. Select Stores > Configuration.

 3. Select Episerver > Episerver Campaign
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 4. In the General settings area, in the Debug Mode drop-down list, select Yes.

 5. Click Save Config.

The Magento 2 integration saves errors in the var/log/optivo_broadmail.debug.log file. If 
you cannot fix a problem yourself, send the lines that were recorded after the error 
occurred to customer support. 

Entries in the error log have the following structure:

[2017-06-30 10:25:03] optivoLogger.DEBUG: processFallbackQueue:start [] []
[2017-06-30 10:25:03] optivoLogger.DEBUG: processFallbackQueue:maxRetries 10 [] []
[2017-06-30 10:25:03] optivoLogger.DEBUG: processFallbackQueue:process 1 entries [] []
 ...
[2017-06-30 10:25:03] optivoLogger.DEBUG: _checkResponse [] []
[2017-06-30 10:25:03] optivoLogger.DEBUG: a:7:{s:8:"response";s:207:"HTTP/1.0 404 Not Found

Known issues

The following errors in Magento 2 can affect the Episerver Campaign integration:

Problem                     Possible cause                     Solution                     

Version 2.1.0. In the back end (under Customer Inform-
ation in the tab Newsletter), you cannot unsubscribe cus-
tomers by clearing the Subscribed to Newsletter check 
box.                     

Documented 
Magento 2 error.                      

Unsubscribe cus-
tomers via Mar-
keting > Newsletter 
Subscribers by delet-

https://github.com/magento/magento2/issues/6313


© Episerver 2020

896 | Episerver Campaign User Guide 2020-04-23

Problem                     Possible cause                     Solution                     

ing the cor-
responding cus-
tomer from the list.                     

Versions 2.0.7 and 2.1.0.

 l At checkout, the customer cannot specify a 
new default address or change their address.

 l If customers have not stored an address in their 
customer account, they can create a new 
address at the checkout. This is, however, com-
mitted as a shipping address and not as a billing 
address – despite the existing option to use the 
same address for billing and shipping.

Both errors affect the correct transfer of address 
information of the customer into transactional mails.

Currently 
unknown.

No solution currently 
available.

All versions. Magento displays the message You have 
registered for the newsletter on the confirmation page 
only after a delay.

Error in the 
Magento 2 sys-
tem, not an error 
in the Magento 2 
integration from 
Episerver Cam-
paign.

No solution currently 
available.

Spryker integration

Note: This topic is for administrators and developers with admin-
istration access rights in Spryker.

If you are using Spryker as an e-commerce platform, you can integrate Episerver Cam-
paign to connect e-commerce and mailing activities.

With the Spryker integration, you can reliably manage your advertising consent: your 
customers can sign in to your newsletter directly in your Spryker shop  and unsubscribe 
simply by clicking the unsubscribe link in the newsletter.

The Spryker integration provides the following features:
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 l Newsletter subscription and unsubscribes
 l Transactional mails via HTTP API

Setting up Episerver Campaign
To set up the Spryker integration in your client, contact customer support.

Preparing recipient lists

Provide Episerver with the names of your Episerver clients. Customer support adapts the 
recipient lists to the Spryker integration.

Note: A recommended client setup uses two separate clients: one 
for sending newsletters and the other for sending transactional 
mails. Episerver offers a standard template for the required recip-
ient lists that is suitable for many applications and scenarios. To 
check  if the standard template meets your requirements, contact 
customer support.

Referencing opt-in emails to Spryker
After customers have subscribed to the newsletter in your Spryker shop, Episerver Cam-
paign sends a registration confirmation with a confirmation link that completes the 
newsletter registration process. To reference the confirmation link to Spryker,  adjust the 
field function  in the confirmation link.

 1. Log in to Episerver Campaign.
 2. Open the start menu and select Campaigns > Confirmations.
 3. Select the confirmation mailing that Episerver  customer support has set up in your cli-

ent and that is to reference to your Spryker shop.
 4. Click Edit.
 5. In the Edit confirmation mailing window, hover over the message node and click Prop-

erties  .
 6. Click Edit content.
 7. In the Edit content window, click the name of the paragraph that contains the con-

firmation link.

 8. In the right Content area, in the Text field, click Source  .
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 9. Replace the opt-in link with the following code: {Double-Opt-In-Link}?id={subscriber_
key}

Note: If you ordered a new confirmation mailing from customer 
support, the mailing is empty. Edit the mailing and insert the 
desired content. Use the code above for the double opt-in link.

 10. Click Apply > Close > Save and close.

Setting up Spryker
Requirements:

 l Credentials from your Episerver client.
 l Authorization codes of the recipient lists you are going to use. Open the start menu 

and select Administration > API overview > Recipient lists > Manage authorization codes.
 l Mailing IDs of the transactional mails you are going to use. Open the start menu and 

select Campaigns > Transactional Mails.

Tip: If you are missing the ID column  in the Transactional mails 
window, click the down arrow v in the upper right corner of the  
table header and activate the ID check box.

When you have the necessary information from Episerver Campaign, follow the steps on 
the Spryker documentation website.

Subscribe and unsubscribe process

Note: This topic is for administrators and developers with admin-
istration access rights in Spryker.
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After you completed the steps described under Spryker integration, customers can sign 
up for newsletters using the newsletter form in your shop. This topic describes which data 
fields are to be transmitted to Episerver Campaign and how to reference the unsub-
scribe link in your newsletter to your Spryker e-commerce platform.

Transmitting registration data to Episerver Campaign

The registration data is transmitted via HTTP request to Episerver Campaign. The fol-
lowing data fields are transmitted: 

Field name
Data 
type

Description Mandatory field

email String
Recipient's email 
address – also the 
recipient's unique ID

✓

salutation String Title (Mr/Ms) of the 
recipient ✘

firstname String Recipient's first name ✘

lastname String Recipient's last name ✘

customer_shop_locale String
Language of the shop 
via which the cus-
tomer has registered

✓        (transferred auto-
matically)      

spryker_id String Spryker-internal shop 
customer ID ✘

customer_shop_url String Shop URL of the cus-
tomer

✓        (transferred auto-
matically)      

customer_login_url String Login URL of the cus-
tomer

✓        (transferred auto-
matically)      

subscriber_key String Individual key of user 
in Spryker Commerce

✓        (transferred auto-
matically)      
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Referencing the unsubscribe link to Spryker

Recipients of a commercial mailing must have the possibility to easily unsubscribe, see 
Deliverability best practices. Usually this is guaranteed by an unsubscribe link  located in 
the footer of the newsletter. To redirect the unsubscribe link to Spryker, adjust the field 
function  in the unsubscribe link.

Note: This example refers to a message template. You must change 
the unsubscribe link in all mailings that have already been created 
but not yet sent.

 1. Open the start menu and select Campaigns > Message templates.
 2. Select the message template you want to edit, and click Edit. 
 3. In the Edit message template window, in the left Edit area, click the name of the para-

graph that contains the unsubscribe link.

 4. In the right Content area, in the Text field, click Source  .
 5. Replace the unsubscribe link with the following code: {Unsubscribe Link}?Subscriber_

key={subscriber_key}

 6. Click Apply > Close > Save and close.

Sending transactional mails

Note: This topic is for administrators and developers with admin-
istration access rights in Spryker.

The Spryker integration lets you send out transactional mails using Episerver Campaign's 
efficient server infrastructure. The sending is done via HTTP-API directly from Spryker.

You can use transactional mails to respond to customers' actions in your shop, such as 
order confirmations, or to send system emails, which include:
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 l Login confirmation
 l Password changes and confirmation
 l Order confirmations

Configuring transactional mails in Episerver Campaign

Sending of transactional mails requires a template in Episerver Campaign, which uses 
field functions to insert sent variables into relevant locations. This creates the finished 
transactional mail with layout, and sends it to the recipient. The sending and receiving 
of the content of the variables takes place using the transaction recipient list as a buf-
fer. 

 1. The Spryker integration sends the variables.
 2. The variables are written into the transaction recipient list: each variable into the rel-

evant recipient list field.
 3. Using field functions, Episerver Campaign copies the template with the individual 

variables from the transaction recipient list and places it into the desired location in 
the transactional mail.

Recipient list fields in Episerver Campaign's transaction recipient list

By default, the transaction recipient list contains the following fields.

Field name Data type Description

email String Email (required)

salutation String Title

firstname String First name
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Field name Data type Description

lastname String Last name

spryker_id String Spryker ID

customer_shop_locale String Language setting in customer shop

customer_shop_url String Customer shop url

customer_login_url String Customer login url

customer_reset_link String Customer reset link

language String Language

order_number String Order number

order_comment String Order comment

order_orderdate String Order date

order_subtotal String Order Subtotal

order_discount String Discount on order

order_tax String Tax on order

order_grand_total String Total sum of order

order_total_delivery_costs String Delivery costs

order_total_payment_costs String Payment costs

subscriber_key String Individual key of user in Spryker Commerce

Creating a template in Episerver Campaign

Create a template and add the desired transactional mail texts (the unchangeable, 
static texts that are to be sent to recipients). Insert field functions in places where you 
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want to show content of the Spryker variables.

About field functions
Field functions are placeholders that refer to a specific recipient list field in your trans-
action recipient list. The variables and content of the variables sent from Spryker are writ-
ten into the relevant recipient list fields in your transaction recipient list. Your field 
functions load relevant content from the referenced recipient list field in the next step.

Example

Set up a transactional mail text that welcomes each customer using the last name and 
the order date. For this you would need the variables salutation, lastname and order_
orderdate. 

The content of the variables is first written to a relevant recipient list field of the trans-
action recipient list (from Spryker via the HTTP API). To access these recipient list fields, 
insert the individual field functions into the Episerver Campaign template and place the 
name of the recipient list field in curly brackets. To import the variable contents, the 
static text and field functions in the Episerver Campaign template could look like this: 

Hello, {salutation} {lastname}!  

Thank you for your online order from {oder_orderdate}. 

The example will appear in the sent transactional mail as follows: 

Hello, Mr. Miller!  Thank you for your online order from August 3.  

To create the template:
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 1. Open the start menu and select Campaigns > Transactional mails.

 2. Click Create.

 3. Drag the Recipients node from the left action area to the workspace area on the 
right.
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 4. In the Recipient lists drop-down list, select your transaction recipient list. 

Note: Customer support sets up a separate transaction recipient 
list. Be sure you use this transaction recipient list, instead of a 
regular recipient list. To see if a recipient list is a transactional 
recipient list, check the column Transaction API.

 5. From the left action pane, drag a message node with the media type Email into the 
workspace.
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 6. In the Name box, assign a concise name to your transactional mail (for example, 
Order confirmation).

 7. In the context menu for the messages node, click Edit content.
 8. In the Template drop-down list, select the desired template and confirm your selec-

tion by clicking Next.
 9. Configure the template for the transactional mail according to your requirements. 

Enter a subject and insert the static texts that you want recipients to receive, into 
the content paragraphs. Insert the relevant field function for the recipient list field of 
the transaction recipient list into places where variables from Spryker should appear 
(see the previous example in this topic).

 10. Click Close.
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 11. Connect the Recipient node with the message node.

 12. Click Save and close.
 13. To activate your transactional mail and start the sending process, select the mailing 

in the  Transactional mails overview and click Start.

Configuring transactional mails in Spryker 

To set up transactional mails in Spryker, follow the steps on the Spryker documentation 
website. 

Web analytics integrations

Episerver Campaign supports preconfigured interfaces for most web analysis products. 
Functionality and tracking data aggregation options  vary between tools. Data transfer 
is usually bi-directional, so that mailing, recipient, and tracking data is available in both 
Episerver Campaign and the web analysis software. The raw data Episerver Campaign 
receives from the web analysis software is available in the Target Groups, Marketing Auto-
mation, and  Deep Analytics modules.

https://documentation.spryker.com/industry_partners/performance/episerver/episerver-installation-configuration.htm
https://documentation.spryker.com/industry_partners/performance/episerver/episerver-installation-configuration.htm


© Episerver 2020

908 | Episerver Campaign User Guide 2020-04-23

Log in to the client interface of the web analysis software to set up and configure the 
integration. Customer support sets up the integration for your Episerver Campaign cli-
ent.

Web analysis systems

Integrations
Adobe 

Analytics
econda etracker

Google 
Analytics

intelliAd Webtrekk

Campaign tracking ✓ ✓ ✓ ✓ ✓ ✓

Purchased 
products ✓ ✓ ✓ ✘ ✘ ✓

Viewed products ✓ ✓ ✓ ✘ ✘ ✓

Abandoned shop-
ping carts ✓ ✓ ✓ ✘ ✘ ✓
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Integrations
Adobe 

Analytics
econda etracker

Google 
Analytics

intelliAd Webtrekk

Revenue ✓ ✓ ✓ ✘ ✘ ✘

Remarketing cam-
paigns* ✓ ✓ ✓ ✘ ✘ ✓

Recommendations ✘ ✓ ✘ ✘ ✘ ✘

User-defined seg-
ments** ✓ ✘ ✘ ✘ ✘ ✓

  Setup Setup Setup Setup Setup Setup

Note: * Remarketing campaigns support only bi-directional integ-
rations.
** User-defined segments are configured once at the initial integ-
ration setup, and submitted with each data transfer to Episerver 
Campaign.

Data generation
Web analytics software tracks any website visitor action, from entry to the exit point. 
Actions are aggregated to get click paths, segments or funnels. Additional actions, 
such as viewed or purchased products and abandoned carts, are enriched with 
product data (ID, price, category, number of purchased items and so on). Finally, this 
data is correlated with a recipient in your Episerver Campaign client. This can be done 
in two ways:

 l The entry point is a click on a link in a mailing. The email address of the recipient is 
known and is associated with every action the recipient carries out (Post-click track-
ing). Until the recipient leaves the website, actions are associated with this email 
address.

 l The customer logs in or registers with an email address. Actions  are tracked and stored 
with a temporary ID. If the visitor uses an email address to log in or register, you can 
associate these actions with the email address retroactively (user event tracking). If 
the visitor's browser  accepts cookies, you can store and associate actions even if 
the visitor leaves the current session and returns later.
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Triggered campaigns
Use web analysis software to trigger automated campaigns where a mailing is sent to a 
recipient based on criteria matching:

 l Remarketing. Recipients that viewed a certain product or have put it in the shopping 
cart receive a mailing with recommendations for similar products. This can be com-
bined with a coupon code for these products.

 l Cross and upselling. Customers who have ordered a certain product receive an 
order confirmation with complementary products.

 l Reactivation. Inactive customers receive an incentive mailing with recom-
mendations according to their customer history. These can be combined with a 
coupon code valid for a limited time.

Regular campaigns
Integrate a web analysis software into regular mailings to increase relevance for recip-
ients:

 l Recommendations based on recipient history. Generate product recommendations 
that take into account previous purchases, as recipients pay more attention to per-
sonalized offerings with products of interest. Mailings with personalized recom-
mendations have a higher conversion rate than other mailings.

 l Recommendations based on products from same price segment. Analyze the preferred 
price range for  a recipient, and send  product recommendations from the same 
price segment, to increase conversion rate.

Adobe Analytics integration

Note: This topic is for administrators and developers with admin-
istration access rights in Adobe Analytics.

Adobe Analytics integration lets you use Episerver Campaign and product data from 
Adobe Analytics in mailing campaigns. Adobe Analytics collects visitor activity data  
that you can use to create fine-tuned segments in Episerver Campaign, such as spe-
cifically addressing customers with abandoned shopping carts in a remarketing cam-
paign.

The Adobe Analytics integration allows bi-directional exchange of mailing and action 
data. To access exchanged data, you first need to implement Adobe Analytics  on your 
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website. The Adobe Analytics data is updated daily in Episerver Campaign, available 
for use in regular mailings, transactional mails and for Marketing Automation.

Data generation

Key mailing data

The output channel from Episerver Campaign to Adobe Analytics is used to send key 
mailing data (KPIs). Data is sent in the background each day.

Note: When data is sent, there may be a delay before it appears in 
Adobe Analytics.

Classifications (fixed mailing data):

 l Mailing ID
 l Mailing name
 l Mailing description
 l Media code (see Grouping your mailings in Episerver Campaign)
 l Date sent

Events

 l Date of creation (when the action occurred)
 l Number of emails sent
 l Number of emails delivered (calculated value)
 l Openings and clicks (only absolute values -not unique- are transferred)
 l Clicks (only absolute values -not unique- are transferred)
 l Canceled subscriptions
 l Soft bounce
 l Hard bounces
 l Total number of bounces (calculated value)

Recipient segments
Using the feedback channel, you can create segments  based on visitor activities, and 
send these to Episerver Campaign. A segment comprises events that match defined cri-
teria, for example a product purchase.
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The following segments are defined by the integration:

 l Product purchase. (Product Purchases (broadmail)) Includes site visitors with a recip-
ient ID  and  an event of type Order.

 l Product view. (Product Views (broadmail)) Includes site visitors with a recipient ID 
and  an event of type Product View.

 l Abandoned shopping cart. (Product Abandonment (broadmail)) Includes site visitors 
with a recipient ID  and  an event of type Cart Addition, but without a corresponding 
Order event.

 l PostClicks. Generic non-configurable segment containing site visitors with a recip-
ient ID, a mailing ID, a Mailing-to-user ID, a date, and a media code. This segment is 
available for creating target groups in Episerver Campaign as the criterion has cre-
ated one or more post-clicks.

Custom-defined segments can also be sent to Episerver Campaign. See Exporting seg-
ments and using them in Episerver Campaign.

Setting up the integration
The initial steps are done in Adobe Analytics by Adobe. For bi-directional data 
exchange, you also need an Adobe Analytics user account with administrator rights. 
Contact Adobe customer support (additional charges may apply).

Linking the Data Connector

When the integration is set up in Adobe Analytics, link the Data Connector in Adobe Ana-
lytics with Episerver Campaign and activate the integration.

 1. Log in to Adobe Analytics with your user name.
 2. In the menu bar, hover over the Admin option to display the drop-down list.
 3. Click Data Connectors.
 4. Hover over optivo broadmail to open the context menu.
 5. Click Add new. Accept the terms and conditions.
 6. In the pop-up window, select the report suite to use.
 7. In the field below, enter a name to use for the integration Data Connector.
 8. Confirm  by clicking Create and Configure This Integration. 

Configuring the Data Connector

In the Configure tab, you specify a range of variables for the Episerver Campaign integ-
ration, together with custom fields. You can allocate both types to the conversion vari-
ables (eVar) and success events (Event) in Adobe Analytics.
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 1. In the drop-down lists under SiteCatalyst eVar and SiteCatalyst Event, select the con-
version variables and success events from Adobe Analytics  to allocate to the 
Episerver Campaign integration variables.

Note: The Episerver Campaign variables  in the Configure tab 
under Metrics marked with a red star *, must be allocated to a 
conversion variable or success event from Adobe Analytics.

 2. If needed, enable the Rename the chosen SiteCatalyst metric and enter a new 
name.
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Implementing Adobe Analytics on your website

 1. Select your preferred reporting suite in Adobe Analytics.
 2. Define the success events and conversion variables.
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 3. Embed the script generated by Adobe into each page on your website. In the 
JavaScript code, assign relevant variables that apply for each context. Dynamic val-
ues are assigned depending on the e-commerce system or website administration 
software used:

Example

s.products=";Hoody_Women_1;1;49.95" /* Assigns the product variables. */
 s.events="prodView" /* Set the event */ 
 s.eVar4="HoodyWomen1" /* Context parameter*/
 –var date = new Date (); 
 s.eVar5=date.toGMTString(); /* Date of action parameter */

Setting up the integration in Episerver Campaign

To set up the integration within Episerver Campaign, contact customer support. The 
integration setup by Adobe for your Adobe Analytics user account is required here.

Exporting and using segments

Configuring segments

Before you can export segments to Episerver Campaign, create and activate the seg-
ments in Adobe Analytics; see the Adobe Analytics user documentation about how to 
do this.

 1. Log in to Adobe Analytics with your user name.
 2. In the menu bar, hover over the Admin option to display the drop-down list. 
 3. Click Data Connectors. 
 4. Hover over optivo broadmail to open the context menu.
 5. In the context menu, click the integration created during installation of the Data 

Connector. 
 6. Click the Configure tab.
 7. In the lower part of the window, click the Data Settings tab. 
 8. Select the segments  to export by selecting the check box for the desired segment.
 9. Click Save at the bottom of the window to confirm.

In the Configure tab under Data Settings > Partner Segments, you can find the segments 
PostClicks, Product Abandonment (broadmail), Product Views (broadmail) and Product 
Purchases (broadmail). These are predefined in the Data Connector for Episerver Cam-
paign. If needed, you can prevent the Product Abandonment (broadmail), Product Views 
(broadmail) and Product Purchases (broadmail) segments from being sent by clearing 
the check box next to the relevant segment.
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Standard variables

The Adobe Analytics integration sends a range of standard variables to Episerver Cam-
paign. This includes data from for example Product Variable, containing up to four values 
(see Adobe Analytics Implementation Guide):

 l Item number or context
 l Order
 l Quantity
 l Price

Optional: Additionally, you can use the following custom variables (fields):

 l Custom Float 1–4
 l Custom Text 1–4

Note: To use custom fields, additional client configuration is 
required. Contact customer support.

See Configuring the Data Connector to learn how to assign these custom variables in 
Adobe Analytics after adapting the recipient lists.

See Creating target groups in Episerver Campaign to learn how to create target groups 
using data sent from custom variables.

Note: In Episerver Campaign, you have access to the exact values  
defined in Adobe Analytics for each segment.

Data security

Personal data security is guaranteed for both output and return channels. Mailing links  
are expanded with anonymized recipient and campaign data. This  prevents para-
meters from being associated with a recipient, either directly or by fraud via third 
parties. The return channel re-associates the anonymized data with the mailing recip-
ients and campaigns.

Standard segment parameters

Use these standard parameters for each segment to create target groups in Episerver 
Campaign: 

https://helpx.adobe.com/analytics/kb/analytics-standard-implementation-guide.html
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 l Mailing ID. ID of the mailing from which the action originated.
 l Recipient ID. ID of the recipient who started the action.
 l Mailing to user ID. Unique ID associating a recipient with a mailing.

Note: Mailing ID, Recipient ID, and Mailing to user ID are required 
and cannot be modified.

 l Date. Field for date and time zone in international format.

Use a valid date format, for example:

EEE MMM dd YYYY HH:mm:ss 'GMT'Z // Javascript Date.toString()
EEE, dd MMM yyyy HH:mm:ss 'GMT' // Javascript Date.toGMTString()

 l Context. Field for important information about relevant usage context, for example 
item number.

 l Action. This parameter is no longer used, do not associate it with a variable in Adobe 
Analytics.

Configuring conversion variables and success events

 1. Log in to Adobe Analytics with your user name.
 2. In the menu bar, hover over Admin and click Report Suites.
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 3. Select Edit settings > Conversion > Conversion Variables.

 4. Configure the conversion variables (eVar) and click Save. You are then given the 
name and number of the eVar.
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 5. Note the name and number of the variables. You will map these with Episerver Cam-
paign integration variables later.
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To define success events, do as described above, selecting Success Events instead.

Adobe Analytics provides the events and conversion variables below. See Adobe Ana-
lytics help for details.

Type Name Data collection Description

Event 
(counter)

Hard 
Bounces*

Automatically imported 
by Episerver Campaign

Number of permanently undeliverable 
emails.

Event 
(counter)
                     

Soft 
Bounces*

Automatically imported 
by Episerver Campaign

Number of emails that are temporarily 
undeliverable.                     

Event 
(counter)
                     

Clicked* Automatically imported 
by Episerver Campaign

Number of recipients that clicked a link in 
the email.                     

Event 
(counter)
                     

Opens* Automatically imported 
by Episerver Campaign

Number of recipients that opened the 
email.                     

Event 
(counter)
                     

Sent* Automatically imported 
by Episerver Campaign Number of emails sent.                     

Event 
(counter)
                     

Unsubscribed
*

Automatically imported 
by Episerver Campaign

Number of recipients that opened the 
email but then clicked the unsubscribe 
link to stop receiving emails.                     

eVar                     Recipient ID*

Recorded using email 
link parameters and 
automatic collection 
methods or using a 
JavaScript plug-in.                     

The ID of the recipient: Using this ID, 
actions such as product purchases, 
abandoned carts and so on can be 
clearly assigned and later used for 
remarketing campaigns.                     
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Type Name Data collection Description

eVar                     Mailing ID*

Recorded using email 
link parameters and 
automatic collection 
methods or using a 
JavaScript plug-in.                     

ID of the mailing: This ID is a unique string 
value. Each mailing has its own unique ID.                     

eVar Mailing To 
User ID*

Recorded using email 
link parameters and 
automatic collection 
methods or using a 
JavaScript plug-in.

This unique ID links a specific recipient to 
a mailing.

eVar Media Code*

Recorded using email 
link parameters and 
automatic collection 
methods or using a 
JavaScript plug-in.

A media code can be specified for 
each mailing in Episerver Campaign. This 
can be used for additional descriptions 
or groupings.

eVar                     Action Date* Recorded via 
JavaScript plug-in.                     

You can enter a date for a particular con-
text here:                         

 l a purchase date
 l the date on which a product was 

viewed
 l the date on which a purchase was 

abandoned
ISO 8601  date formats are accepted. 
Date formats may also be imported that 
are normally created by the Date
().toString() and Date().toUTCString() 
JavaScript functions.                     

eVar                      Context                     Recorded via 
JavaScript plug-in.                     

You can freely enter context information 
here that is sent to Episerver Campaign. 
This will mostly be an item number.                     

eVar                      Type of 
Action                     

deprecated (no longer 
used)                      

Note: Episerver Campaign integration variables indicated with a 
red star * must be assigned to a conversion variable or event in 
Adobe Analytics.

http://www.w3.org/TR/NOTE-datetime


© Episerver 2020

922 | Episerver Campaign User Guide 2020-04-23

Creating target groups for use with Adobe Analytics

To use the transferred analytics data, you must first create target groups in Episerver 
Campaign. 

 1. Open the start menu and select Recipients > Target groups.
 2. Click Create.
 3. In the Target group definition area, click Add +.
 4. In the second drop-down list, select Action and in the third list, select has created one 

or more post-clicks.
 5. If you are using multiple post-click services, select web analytics in the Service drop-

down list.
 6. In the Mailing drop-down list, select mailings to which the data is related. If nothing is 

selected, all mailings are analyzed.
 7. Select a date or time in the Period drop-down list to only select post-clicks created 

within a defined time range or at a certain date. Time entered as a number of days 
("Exactly 30 days ago") refer to the current day.

 8. In the drop-down list Category, select a predefined category and an operator (for 
example equals) and a comparison value. 

Example: To select all recipients who purchased a product, click Action and  in the 
field to the right, enter purchase. Ensure  correct spelling so it is identical to the 
name used by Adobe.

 9. Click Apply ✔ . This target group rule will select recipients who have purchased any 
type of product. To refine the target group to recipients who purchased a specific 
product, add another rule.

 10. In the Target group definition area, click Add +.
 11. Select the Product name category and enter a product name. This field uses auto 

complete, matching products are displayed as you type. This entry must be 
identical to the entry  in the database to find matches. If unsure, use the auto com-
plete suggestion.

 12. Add additional rules to this target group. You can combine the Adobe Analytics 
web analytics data with other recipient and campaign data, make sure to test the 
created target group before first use. In the Analysis area, select a recipient list and 
click Calculate.

 13. Click Apply ✔ .
 14. Open Properties and enter a name for the target group. Optionally, enter a descrip-

tion.
 15. Click Create.
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Processing analytical data

Evaluating email channel in Adobe Analytics

You can evaluate data sent from Episerver Campaign in Adobe Analytics. Emails sent 
via Episerver Campaign contain three additional HTTP parameters: mid, rid and m2u. 
You can use these parameter names in Marketing Channel Processing Rules, after ensur-
ing that no other parameters with these names are sent via other channels. See the  
Adobe documentation for information about automatic assignment of interactions to 
marketing channels in Adobe Analytics.

Grouping mailings in Episerver Campaign

When you create a mailing, you can specify a media code in the Web analysis tab in 
Mailings Classic to be used for grouping multiple mailings in Adobe Analytics. In Smart 
Campaigns, you can specify a media code in the message node settings. For example, 
assigning mailings within a multi-stage campaign to the same media code, lets you 
evaluate these mailings together. No further configuration is necessary.
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Troubleshooting the Adobe Analytics integration
The table below lists common errors when working with the Adobe Analytics integ-
ration.  If the problem continues after trying the suggested solution, contact Episerver 
customer support or Adobe customer support.

Problem Possible cause Resolution

Data sent from 
Episerver Cam-
paign is not avail-
able in Adobe 
Analytics.

Adobe Analytics is experiencing 
a data processing delay.

Wait at least 4 days and check again to 
see if the data has become available in 
Adobe Analytics. If the problem con-
tinues, contact Adobe customer sup-
port.

Data from Adobe 
Analytics is not 
being sent to 
Episerver Cam-
paign or is incom-
plete.

Some segments have not been 
activated for transfer in Adobe 
Analytics.

Activate the segments  for them to be 
sent. See Exporting and using segments.

Data transfer fails 
or you are unable 
to set up the data 

You do not have an Adobe Ana-
lytics user account with admin 
rights.

Contact Adobe to set up an Adobe 
Analytics user account with admin 
rights.
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Problem Possible cause Resolution

transfer.

Data transfer fails 
or is incomplete.

Required Episerver Campaign 
integration variables indicated 
with a red star * have not been 
assigned to a conversion vari-
able or event.

Allocate required variables, see Con-
figuring the Data Connector 

Data transfer fails. Adobe Analytics integration has 
not been enabled. Contact customer support.

Adobe Analytics 
contains no data 
about visitors to 
your site.

The variables have not been 
implemented, or are imple-
mented incorrectly, on some 
pages of your website.

Implement and/or correct the vari-
ables on each page of your website. 
See Implementing on your website.

Google Analytics integration

Note: This topic is for administrators and developers with admin-
istration access rights in Google Analytics.

The Google Analytics integration allows for the allocation of email recipients and web-
site visitors, to use the evaluation capabilities of Google Analytics to measure the results 
of email marketing campaigns. The Google Analytics integration offers a central plat-
form for the evaluation of online campaigns, as click rates recorded by Episerver Cam-
paign can be evaluated alongside financial success of campaigns.

Setting up the integration
You need a Google Analytics user account to access the Google Analytics interface. 
To set up the integration in your   client, contact customer support. No mailing setting 
adjustments are needed, all mailing data is  automatically transferred to Google Ana-
lytics.
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Transferring data
The integration uses an automatic, generic link extension which adds parameters used 
by Google Analytics for the allocation of campaigns to links used in the mailing. 
Google Analytics uses cookies to identify returning visitors. Recipients who initially 
accessed the website via an email campaign, are identified as email campaign visitors 
also when returning via  the website.

Using the link extension, global shipping data is transferred to your Google Analytics 
account after dispatch of a mailing. You can view and influence the data aggregation 
analysis in Google Analytics.

These parameters are used for link extension and data transfer:

 l utm_source
 l utm_medium
 l utm_campaign
 l utm_term
 l utm_content

Use these standard parameters to automatically transfer data, for example:

 l Date of creation
 l Mailing ID
 l Mailing name
 l Mailing description
 l Mailing type
 l Recipient list fields

Examples: 

 l To transfer the mailing type Newsletter to Google Analytics, use the utm_source para-
meter. 

 l To transfer the mailing type, use the utm_medium parameter, and for the mailing 
name, the utm_campaign parameter. 

You can also combine two data sets and transfer them together using one standard 
parameter. The mailing name and the corresponding creation date can for example 
be combined using the utm_campaign parameter. For other combinations and more 
information, contact Episerver customer support.
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Viewing and using data
When a client is linked with Google Analytics, data synchronization is automatic and  
invisible to the website visitor. See below how to access and view the data  in Google 
Analytics.

Dashboard

The dashboard lets you view important configurable statistics.

 

Campaigns

Under Campaigns, you can view website hits generated by email campaigns.
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Campaign details 

Click the campaign title to view available values in order of time.
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Source of access

Website hits generated by a mailing are labeled by source and medium, corresponding 
to the company name and medium, for example webtracktive/email.



© Episerver 2020

930 | Episerver Campaign User Guide 2020-04-23

 

Google Tag Manager integration

Note: We are currently revising the documentation for the Google 
Tag Manager integration and will place it at your disposal as soon 
as possible. Thank you for your patience.

Step 1. Creating variables for saving the recipient ID

Note: We are currently revising the documentation for the Google 
Tag Manager integration and will place it at your disposal as soon 
as possible. Thank you for your patience.
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Step 2. Configuring actions

Note: We are currently revising the documentation for the Google 
Tag Manager integration and will place it at your disposal as soon 
as possible. Thank you for your patience.

Step 3. Publishing changes

Note: We are currently revising the documentation for the Google 
Tag Manager integration and will place it at your disposal as soon 
as possible. Thank you for your patience.

intelliAd integration

Note: This topic is for administrators and developers with admin-
istration access rights in  intelliAd.

The  intelliAd integration lets you evaluate and optimize email campaigns together with 
other online channels. In addition to the email channel,  intelliAd can analyze search 
engine marketing, affiliate marketing and price search engines. Clicks from newsletters 
are tracked and assigned to an email channel, and displayed in the campaign over-
view.

The integration uses link masking to redirect links in a tracked mailing via the intelliAd 
server. The masked links are automatically generated and include multiple parameters 
enabling them to be assigned to a specific client. You  generate an ID string in intelliAd 
and enter it in the intelliAd tab when creating the mailing. When clicking on a masked 
link, the recipient will first be redirected to the intelliAd tracking server (without noti-
cing). The tracking server analyzes the parameters included in the extension and saves 
them in the database. The recipient is then redirected to the actual target page.
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Setting up the integration
You need an intelliAd account but the integration does not require any direct data 
exchange between Episerver Campaign and intelliAd. In Episerver Campaign, intelliAd 
is integrated into the mailing creation process. 

Extending links
These parameters are added to each mailing link:

 l intelliAdcustomerId. Identifies the intelliAd customer.
 l marktId. Identifies Episerver Campaign as the source of the link.
 l channelId. Identifies the marketing channel, usually email or newsletter, for mailing 

links.
 l campaignId. Identifies a campaign in intelliAd. Multiple channels can be combined 

into a single campaign.

Note: This ID does not belong to a Marketing Automation cam-
paign in Episerver Campaign.

 l adGroupId. Identifies an AdGroup.
 l subId. Generated from the mailing ID and the subject of the mailing.

Configuring the mailing for tracking
When creating a mailing, enter the ID string in the intelliAd tab  in your intelliAd account. 
The ID string consists of six blocks of numbers using this format:

9353935333236323131303-100-4363735313236323131303-101-101-101

Each block of numbers encodes one of the link parameters specified above with the 
exception of the subId parameter, which is generated from Episerver Campaign. The 
intelliAd tracking is activated when an ID string is saved for a mailing. Links in the mailing 
are created when the email is delivered, using this format :

http://t23.intelliad.de/index.php
    ?redirect=http://www.beispiel.de/shop/products/raincoat-blue
    &cl=12345
    &bm=100
    &bmcl=123
    &cp=111
    &ag=222
    &subid=12345|FirstNewsletter|ProductLink
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Note: The redirect parameter includes the original URL and is URL-
encoded. In this example, breaks are added and encoding is omit-
ted for readability reasons.

Links without tracking
By default, the following links are not tracked via intelliAd.

 l Link to the online version
 l Unsubscribe link
 l double opt-in link
 l Links to landing pages
 l SWYN links

Analyzing intelliAd performance
Sign in to intelliAd and select the channel optivo broadmail in the dashboard. The 
timeline displays clicks in the selected channel, and you can filter results according to 
the criteria you defined. 
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CRM integrations

The Episerver Campaign CRM integrations lets you manage campaigns and select 
leads and contacts as  in your CRM system, and work with mailing creation and dispatch 
in Episerver Campaign. You can send personalized content  and measure campaign per-
formance directly in CRM, and based on the data, design multistage and re-mailing 
campaigns. 

See the CRM Guide for an introduction to working with Episerver Campaign and CRM sys-
tems.

CRM systems

Theme Integration                     
Microsoft 
Dynamics 

CRM                     

Salesforce
                     

SAP

DOI Round-Trip                     

Automatic synchronization of unsub-
scribes                      ✓ ✓ ✓

Send DOI                     ✓ ✘ ✘

Import DOI                     ✓ ✓ ✘

Multiple DOI per entity                     ✓ ✓ ✓

Flexible DOI mapping — Multi client map-
ping                     ✓ ✓ ✓

Campaigns 

Selections in CRM                     ✓ ✓ ✘

Start campaign                     ✓ ✓ ✘

Assign Episerver Campaign reactions                     ✓ ✓ ✘

Transmission of custom fields                     ✓ ✓ ✓

Recipients

Synchronization of recipient lists ✓ ✓ ✓

Use Marketing Automation ✓ ✓ ✓

Use Smart Campaigns functions ✓ ✓ ✓

Custom fields                     ✓ ✓ ✓
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Theme Integration                     
Microsoft 
Dynamics 

CRM                     

Salesforce
                     

SAP

Admin

Flexible client mapping ✓ ✓ ✓

Scalability ✓ ✓ ✓

Support newest versions                     ✓ ✓ ✓

Full featured admin interface ✓ ✓ ✘

Messaging

Send transactional-mails                     ✓ ✘ ✘

Omni-channel support (E-Mail, SMS, 
Mobile Push) ✓ ✓ ✓

Bounce management ✓ ✓ ✓

Platform spe-
cific

Support PersonAccounts (Salesforce) ✘ ✓ ✘

Support managed packages ✓ ✘ ✘

CRM integration guide
This section provides an introduction to working with Episerver Campaign, and integ-
rations with CRM systems. 

You can integrate email service providers with campaign management, and CRM and 
business and customer intelligence systems. 

Episerver Campaign provides email sending,    and SMS, as well as synchronized advert-
ising consents and recipient lists.

 l  Campaign management. With its closed-loop interface, Episerver Campaign auto-
matically captures transfer of recipient data and return of response data, for 
example opt-out and bounces, for flexible management of recipient data  from the 
CRM system. You can enrich mailing openings, clicks, bounces, and unsubscriptions, 
so these events become available as leads or contacts in CRM.

 l Opt-in management. You can exchange double opt-in information 
between Episerver Campaign and a third-party system. Advertising consents can 
refer to many types of media, for example  email, and SMS.

 l Synchronize recipient data. Episerver Campaign’s entire range of features is available 
with the synchronization of recipient lists. Marketing Automation or Smart Cam-
paigns are independent of a CRM system, and can return bounces and unsub-
scriptions.
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Managing campaigns with CRM system integrations

CRM (customer relationship management) systems generally have the ability to define 
campaigns. Leads and contacts are added to a campaign – sometimes indirectly via 
marketing lists or dynamically via machine-learning algorithms – and campaign activ-
ities are subsequently defined and executed. Using the closed-loop service, you can 
transfer members of a campaign to Episerver Campaign. With additional meta-inform-
ation (Client ID and/or opt-in ID and mailing ID), the appropriate mailing is triggered in 
Episerver Campaign. Events that follow the campaign, such as openings, clicks, 
bounces or unsubscriptions, are then made available to the CRM system. See Closed-
loop Interface.

Personalizing and formatting a recipient

Note: Contact customer support to help you define the recipient list 
format - the columns containing information transferred to Episerver 
Campaign.

The recipient list must contain the desired personalization information. For example,  to 
use recommendations from CRM, place the product information in the recipient list. To 
use a personalized greeting and/or complimentary close (so the contact’s sales owner 
appears as point of contact in the salutation),  transfer the corresponding sales owner 
fields.

You can also add recipient list fields to response data, making it easier to assign events 
in CRM, such as open or click. For example, providing two fields in the recipient list for  
identifier of entities, these can be transferred back in the response data.

Example: A contact has a unique ID <contact-id> and each campaign has a unique iden-
tifier <campaign-id>. Both fields are added to the recipient list, and the entities are trans-
ferred to Episerver Campaign. When clicking the link in the sent email, the recipient 
receives the result with the corresponding <contact-id> and <campaign-id>, so you can 
assign events to a contact or a campaign response. 

The displayed fields  depend on the CRM system. Typical identification fields may be 
<contact-id>, <lead-id>, <campaign-id>, <campaign-member-id>, <member-id> or <list-
id>.
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Protocols and feedback

You can  use either SFTP or SOAP protocols for data transfer. SOAP transfers the data via 
XML (extensible markup language); you have better performance with sending CSV files 
via SFTP,  especially for large campaigns with several hundred thousand campaign mem-
bers.

When a campaign is sent, Episerver Campaign can create feedback messages such as 
an email notification. Episerver Campaign can also call up SOAP services and sys-
temically display the processing and send status.

Process sequence

After the CSV file is delivered or data transfer is completed through the SOAP service, 
no further action is required on the part of the CRM or the requesting party. The fol-
lowing process automatically takes place in Episerver Campaign:

 1. After successful transfer, the recipient data is automatically loaded into a recipient 
list. The recipient lists used for this purpose are subject to a check by the closed-loop 
services and have the Z_CampaignUserList prefix. Lists with this prefix are auto-
matically created and managed. These special lists may not be used for other pur-
poses – neither through interfaces nor through Episerver Campaign’s front-end. 
These lists may not be used, filled nor otherwise addressed using an Episerver Cam-
paign API (application programming interface) method.

 2. After the recipient data is fully imported, the specified mailing will automatically be 
copied. If you start a campaign from the CRM system via the closed-loop service, 
you will also find a sent mailing in the mailing overview.

 3. After the mailing is sent, results are recorded, prepared and made available. These 
include opens, clicks, bounces and unsubscriptions. Bounces and unsubscriptions 
are directly linked to an email address and should be saved at the appropriate entit-
ies in CRM. For instance, there is no point in continuing to send messages to an email 
address that has bounced out. If someone unsubscribes, then this must be saved in 
the appropriate contact and/or lead and, if necessary, in an advertising consent.

Note: Recipient lists match database tables. These are generally 
generated individually according to your requirements in a format 
specified by customer support. This format is static and may not be 
changed without consulting customer support.

broadmail_ID parameter

The broadmail_ID denotes a mailing. The advertising channel (email, SMS) also appears 
on the mailing. Therefore, the broadmail_ID can also be used to trace back the 
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medium. In addition to the mandatory broadmail_ID, the CRM system can also issue a 
numerical wave-ID for a mailing, with which the mailing wave is identified. If a mailing is 
sent in multiple steps, then the mailing identity can be inferred using the wave_ID. The 
broadmail_ID and the wave_ID must be unique Grouping different mailings into one mail-
ing wave is not possible. Furthermore, the recipient’s email address is a mandatory field 
in the recipient list.

Example: The following code block shows an implementation example of how a cam-
paign with two recipients can be started by Episerver Campaign using SOAP services. 
The surrounding category provides the necessary member variables, for instance, the 
closedLoopWebservice object makes available the methods documented in the SOAP 
API.

/**
  * Use case: Initialise and start campaign
  * The following class is an implementation on how to start a campaign
  * via Closed Loop Webservice.
  */
 private class ImportRecipientsAndStartCampaign extends UseCase {
  
     @Override
     void runExceptional() throws Exception {
         // create a waveId, fix the template mailing
         _waveId = _closedLoopWebservice.prepareNewWave(
                     _session.getSessionId(), TEMPLATE_CAMPAIGN_ID);
         // The recipient field names can be different for every client
         // and are defined once during the configuration process in
         // optivo broadmail. Within the example code we used
         // recipientFieldNames are for demo purposes with most common
         // used fields.
         String[] recipientFieldNames =
             { "salutation"
             , "firstname"
             , "lastname"
             , "title"
             , "birthday"
             , "mobile"
             , "fax"
             , "email"
             , "street"
             , "zipcode"
             , "city"
             , "state"
             , "country"
             , "extentityid"
             , "extcampaignid"};
         String[][] recipientFieldValues =
             {
               { "Mr."
               , "John"
               , "Doe"
               , "Phd"
               , "17.2.1956"
               , "0049307680780"
               , "004930768078199"
               , "it-demo-mr@example.com"
               , "Wallstrasse 16"
               , "10179"
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               , "Berlin"
               , "Berlin"
               , "Germany"
               , "SAP-321XWZ654987"
               , "SAP-987ABG654223"
               }
             , { "Mrs."
               , "Jane"
               , "Doe"
               , "Phd"
               , "17.2.1952"
               , "0049307680780"
               , "004930768078199"
               , "it-demo-mrs@example.com"
               , "Wallstrasse 16"
               , "10179"
               , "Berlin"
               , "Berlin"
               , "Germany"
               , "SAP-321XWZ654988"
               , "SAP-987ABG654223" } };
         _closedLoopWebservice.importRecipients(
             _session.getSessionId()
             , _waveId
             , recipientFieldNames
             , recipientFieldValues);
         // initialise the point in time the campaign will start to
         // generate response data
         _since = _closedLoopWebservice.getCurrentTime(
             _session.getSessionId());
         _closedLoopWebservice.importFinishedAndScheduleMailing(
             _session.getSessionId(), _waveId);
     }
 }

You can request the mailing status after transferring a campaign. The following cat-
egory shows the methods that need to be invoked.

/**
  * Use case: Receive campaign status.
  * Use this code to ask campaign status from optivo broadmail. This
  * makes sense after calling the use case "Initialise and start campaign"
  */
 private class DetermineCampaignStatus extends UseCase {
  
     @Override
     void runExceptional() throws Exception {
         if (_waveId <= 0) {
             throw new IllegalStateException("waveId not positive.");
         }
  
         // Since the campaign is copied before it is started, we
         // have to translate the wave id to the campaign id that
         // was actually sent ...
         long campaignId;
         do {
             campaignId = _closedLoopWebservice.getMailingIdByWaveId(
                 _session.getSessionId(), _waveId);
             if (campaignId <= 0) {
                 sleepOneMinute();
             }
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         } while (campaignId <= 0);
  
         // customise this to your needs. After a campaign switched to
         // status SENT, the status will be immutable
         while (true) {
             String campaignStatus = _mailingWebservice.getStatus(
                 _session.getSessionId(), campaignId);
             if ("DONE".equals(campaignStatus)) {
                 break;
             }
             if ("PAUSED".equals(campaignStatus) || "CANCELED".equals(
                 campaignStatus))
             {
                 throw new RuntimeException(
                     "Campaign is " + campaignStatus);
             }
  
             String campaignName = _mailingWebservice.getName(
                 _session.getSessionId(), campaignId);
             // Log status for messages of campaign too.
             long[] messageIds = 
                 _splitMailingWebservice.getSplitChildIds(
                     _session.getSessionId(), campaignId);
             for (long messageId : messageIds) {
                 String messageStatus = _mailingWebservice.getStatus(
                     _session.getSessionId(), campaignId);
                 String messageName = _mailingWebservice.getName(
                     _session.getSessionId(), messageId);
             }
             sleepOneMinute();
         }
     }
  
     private void sleepOneMinute() throws InterruptedException {
         Thread.sleep(TimeUnit.MINUTES.toMillis(1));
     }
 }

You can also show your campaign manager the available templates. The following 
example shows a query for the Smart Campaigns.

/**
  * Use case: Read available campaigns for closed loop scenario
  * This is a usability method. You can show available Smart Campaigns
  * to your campaign manager. Scenario for smart campaigns only.
  */
 private class GetCampaignData extends UseCase {
  
     @Override
     void runExceptional() throws Exception {
         String campaignType = "regular";
         String campaignStatus = "ACTIVATION_REQUIRED";
         long[] campaignIds = _mailingWebservice.getIdsInStatus(
             _session.getSessionId(), campaignType, campaignStatus);
         for (long campaignId : campaignIds) {
             String campaignName = _mailingWebservice.getName(
                 _session.getSessionId(), campaignId);
             String description = _mailingWebservice.getDescription(
                 _session.getSessionId(), campaignId);
             long[] messageIds =
                 _splitMailingWebservice.getSplitChildIds(
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                     _session.getSessionId(), campaignId);
             for (long messageId : messageIds) {
                 String messageName = _mailingWebservice.getName(
                     _session.getSessionId(), messageId);
                 String messageDescription =
                     _mailingWebservice.getDescription(
                         _session.getSessionId(), messageId);
             }
         }    
     }
 }

Processing response data

Response data processing must be implemented when a campaign is being executed. 
Bounces, unsubscriptions and replies are part of these processes. You have the choice 
of using Episerver Campaign’s features for managing unsubscriptions or implementing 
proprietary processes in CRM. Processing unsubscriptions and replies is mandatory due 
to applicable rules on advertising consents and competition law.

Unsubscribing via Episerver Campaign

An unsubscribe link must be included in every email. If the link points to Episerver Cam-
paign, the recipient is added to the unsubscribed list in Episerver Campaign, and 
receives no more email. The unsubscribed list in Episerver Campaign has precedence 
over additional mailings. This means that recipients do not receive emails even if they 
are included in a CRM selection which is transferred to Episerver Campaign. The unsub-
scription can only be revoked using a new double opt-in process.

If the recipient has unsubscribed using the Episerver Campaign processes, the unsub-
scription is sent back to the CRM using the closed-loop interface. The CRM system must 
process the unsubscriptions obtained in this manner and save them in applicable entit-
ies. The transferred selections may not contain any recipients that have effectively 
revoked their advertising consent.

If an unsubscription is performed via another method, such as through the customer cen-
ter in a shop system, then these unsubscriptions do not necessarily have to be sent to 
Episerver Campaign, provided that the unsubscriptions are actively saved in the ref-
erentially-leading system. In any case, it must be ensured that active unsubscriptions are 
not included in selections and campaigns sent to Episerver Campaign.

Unsubscribing via third-party systems

If you use your own unsubscription links, Episerver Campaign will not receive any inform-
ation about unsubscriptions. Forwarding is not possible. In this case, the systemic respons-
ibility for properly using advertising consents lies fully with CRM.
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Reply emails

Recipients can answer emails and express additional requests such as an unsubscription. 
Either of these returned emails are processed in the Episerver Campaign’s user inter-
face, or forwarded to the inbox of your choice, as configured in Episerver Campaign.

Data formats

Each field in the recipient list can be filled via the closed-loop interface or HTTP API. The 
data format in the transferred files can be mapped to fields in the recipient list, irre-
spective of the set-up of the closed-loop interface. Therefore, the format of the recip-
ient list does not necessarily match the one that the closed-loop interface expects. 
Contact  customer support for exact data formats.

Conversely, the HTTP API can directly fill fields in the recipient list. The names of the HTTP 
parameters here must directly match the ones stated in the recipient list. See HTTP API.

Event emails

Event emails are typically  triggered by a certain event. For instance, this can be a regis-
tration, or an order placement or cancellation. This type of email can ideally be sent 
over the HTTP API. Here, you can save a decided recipient list suitable for sending these 
special mailings. You can  link as many mailings as you want to this recipient list and send 
result-based emails individually. This type of integration is also suitable for Marketing 
Automation campaigns  triggered based on events and points in time.

Implementation example

The following code block shows an example of how response data can be retrieved.

/**
  * Use case: Get response data
  * This use case shows how to receive and process reponse data.
  * Response data are fetched within a certain interval, usually
  * 1-4 h, and processed according to your system needs.
 */
 private class GetResponseData extends UseCase {
  
     @Override
     void runExceptional() throws Exception {
         long until = _closedLoopWebservice.getCurrentTime(
             _session.getSessionId());
         int numberOfRows = 1000;
         int startRow = 0;
  
         String[][] recipients;
         do {
             recipients = _closedLoopWebservice.getRecipients(
                 _session.getSessionId(),

https://world.episerver.com/documentation/developer-guides/campaign/http-api/
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                 _since, until, startRow, numberOfRows);
             processData(recipients);
             startRow += numberOfRows;
         } while (recipients.length >= numberOfRows);
  
         startRow = 0;
         String[][] clicks;
         do {
             clicks = _closedLoopWebservice.getClicks(
                 _session.getSessionId(),
                 _since, until, startRow, numberOfRows);
             processData(clicks);
             startRow += numberOfRows;
         } while (clicks.length >= numberOfRows);
  
         startRow = 0;
         String[][] opens;
         do {
             opens = _closedLoopWebservice.getOpens(
                 _session.getSessionId(),
                 _since, until, startRow, numberOfRows);
             processData(opens);
             startRow += numberOfRows;
         } while (opens.length >= numberOfRows);
  
         startRow = 0;
         String[][] links;
         do {
             links = _closedLoopWebservice.getLinks(
                 _session.getSessionId(),
                 _since, until, startRow, numberOfRows);
             processData(links);
             startRow += numberOfRows;
         } while (links.length >= numberOfRows);
  
         startRow = 0;
         String[][] responses;
         do {
             responses = _closedLoopWebservice.getResponses(
                 _session.getSessionId(),
                 _since, until, startRow, numberOfRows);
             processData(responses);
             startRow += numberOfRows;
         } while (responses.length >= numberOfRows);
  
         startRow = 0;
         String[][] unsubscribes;
         do {
             unsubscribes = _closedLoopWebservice.getUnsubscribes(
                 _session.getSessionId(),
                 _since, until, startRow, numberOfRows);
             processData(unsubscribes);
             startRow += numberOfRows;
         } while (unsubscribes.length >= numberOfRows);
  
         startRow = 0;
         String[][] mailingUnsubscribes;
         do {
             mailingUnsubscribes = 
                 _closedLoopWebservice.getMailingUnsubscribes(
                     _session.getSessionId(),
                     _since, until, startRow, numberOfRows);
             processData(mailingUnsubscribes);
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             startRow += numberOfRows;
         } while (mailingUnsubscribes.length >= numberOfRows);
  
         _since = until;
     }
  
     // customize this method according to your needs. This
     // includes creating campign reactions or upsert subscription-
     // or bounce status to your entities.
     private void processData(String[][] values) {
         if (values.length == 0) {
             // process no values here
         } else {
             for (String[] click : values) {
                 // process your business logic/campaign reactions here
             }
         }
     }
 }

The following code demonstrates how a recipient’s bounce status can be reset.

/**
  * Use case: Reset bounce status
  * This is an example of how to reset the bounce status
  * of a recipient.
  */
 private class ResetBounceStatus extends UseCase {
  
     @Override
     void runExceptional() throws Exception {
         resetBounceCounter(EMAIL_ADDRESS);
     }
  
     private void resetBounceCounter(String emailAdress)
         throws WebserviceException {
         _responseWebservice.resetBounceCounter(
             _session.getSessionId(), emailAdress);
     }
 }

Managing opt-ins

 Episerver lets you display multi-channel advertising consents, which can also be syn-
chronized with different fields in the CRM (customer relationship management) system 
provided it has this feature. This lets a contact or a lead issue multiple different advert-
ising consents for different newsletters, to get an overview of consents  for channels in 
your CRM.
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How it works

You can connect multiple clients  in Episerver Campaign from your CRM. The advertising 
consents in CRM are already saved or you already performed the necessary adjust-
ments for them. In either case, the CRM provides a full view of recipients, and changes 
to the advertising consents from third-party systems carry over.

For example, the advertising consents can be represented by Boolean fields or a check 
box at the contact, lead, or account entities. They can refer to a channel (email, SMS) 
and/or a certain newsletter. The CRM does not have to make any content-related dis-
tinctions, and can immediately handle the consents. The types of consents (contact, 
lead, account) must be the same for relevant entities (Boolean value check box or tick 
box). The types of consents required depend on your campaign plans and data struc-
ture. You are responsible for depicting it in your CRM.

Events such as unsubscriptions or bounces relate to a specific advertising consent. For 
the systems involved to be consistently aware of the  consent and related medium, you 
must save the appropriate information in CRM. The easiest way is using a table with the 
advertising consents you are using. In this table, each row represents an advertising con-
sent where you can assign the consent using a unique identification. If you need to pro-
cess an unsubscription from Episerver Campaign, the transferred identification is used to 
determine the affected advertising consent. You can also delete advertising consents 
for the appropriate media type for a contact or lead in case of a hard bounce. An 
email address bouncing has nothing to do with a specific advertising consent.

Data structure

This list shows a data structure for advertising consents:

 l opt-in-ID. Generic field for a unique ID issued by CRM (not visible, quasi an AUTO-
INCREMENT field, sequence or GUID).

 l description. Unique name displayed to the user and used for identification (visible).
 l media-type. The user can select email, email and SMS in this drop-down list (visible).
 l broadmail-client-id. Reference to a client-ID in Episerver Campaign configured in 

CRM (visible).
 l reference-bounce. Reference to a bounce field (visible). If empty, then no bounce is 

managed for the channel. Mandatory for email channel.
 l reference-opt-in. Reference to an advertising consent in the contact, lead, or 

account entity. You can save the contact or lead field that needs to be admin-
istrated.

Instead of saving tables and references, you can archive the logic in code or XML files 
for simple applications. The data model in this example shows what advertising con-
sents may look like when linking advertising consent to a client in Episerver Campaign.
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CRM-ID Name Reference field
Ty-
pe

Client Reference bounces

AS103457612-
04                     

Fan 
news-
letter                     

crm.-
custom.lead.fan-
opt-in                     

Em-
ail                     

1034452341-
2435                     

crm.-
custom.lead.fan-
bounces                     

FG104571456-
12104                     

Premiu-
m fur-
niture                     

crm.-
cus-
tom.lead.premium-
opt-in                     

Em-
ail                     

1435109825-
1023                     

crm.-
cus-
tom.lead.premium-
bounces                     

SMS10016784-
235                     

SMS 
ticker                     

crm.-
custom.lead.sms-
ticker-opt-in                     

SM-
S                     

1456123461-
025                     

crm.-
custom.lead.sms-
ticker-bounces                     

Controlling campaigns and transferring data

If a campaign needs to be sent from CRM, select the advertising consent and the mail-
ing template. You can determine the client to use in Episerver Campaign by using the 
data model for advertising consents.

The technical connection of the closed-loop services must be expanded by additional 
fields in this scenario. The following additional parameters are transferred to Episerver 
Campaign, in addition to the data of the determined recipient list: consent description, 
opt-in ID and media type. The opt-in ID and the media type are sent back to CRM as a 
component of the closed-loop circle for bounces, unsubscriptions, and so on. When an 
unsubscription or bounce occurs, CRM enters the cancellation of the advertising con-
sent or the bounce into the appropriate entity (i. e. lead, contact) accordingly. Using 
the transferred parameters, you can tell which contacts/leads/accounts and which 
advertising consent are affected. You also can carry out additional actions through the 
media-type field, as described above.

Changing bounce or subscription status

Episerver Campaign blocks an email address from sending more messages when there 
are too many bounces. You can change the bounce status of a recipient in CRM, for 
example when the recipient has ensured that the error would be resolved after a tem-
porary problem. The usual design patterns for implementing this functionality as part of 
CRM are save interceptors or observers with which you can respond to data changes. 
This is only an example, if required the CRM will use its own design pattern for this case.

The bounce counter is set per client in Episerver Campaign. Therefore, unlock clients in 
which the bounce counter was exceeded. You must save the appropriate information 
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to CRM or, alternatively, reset the bounce counter in configured clients. To do this, use 
the resetBounceCounter method from the responseWebservice, carefully following the 
instructions in the documentation on changing the media type.

To set the subscription status, use the advertising consent to determine the correct cli-
ent, then trigger a new DOI process for the subscription in question. Unless the unsub-
scriptions are also processed in Episerver Campaign, you should manage the DOI 
process using Episerver Campaign also. In this case, an unsubscription is re-delivered 
after a successful DOI.

Synchronizing recipient data

Data such as reports, marketing lists, or comparable filters in recipient lists, contained in 
CRM (customer relationship management) , should be individually copied into Episerver 
Campaign, for example with a daily transfer.

To manage campaigns in Episerver Campaign, copy the recipient data from your CRM 
into the regular recipient lists. Depending on requirements and the CRM data structure, 
you can define fixed export formats. CRM users can filter contacts, leads and/or 
accounts through reports or marketing lists, which are automated and regularly trans-
ferred to Episerver Campaign. Using a CMS database, you can fill recipient lists in clients  
in Episerver Campaign, and use the data for Smart Campaigns and other Episerver Cam-
paign features.

Implementation

 l Relate the selection of recipients to precisely one advertising consent. 
 l Do not mix advertising consents. 
 l Specify the desired fields with customer support beforehand. 
 l Transfer technical fields: opt-in-id, description, media-type, entity-type (contact, 

lead, account, ...), entity-id (ID of the contact/lead/account from CRM).

Incremental export processes have proved less robust. You should clear the list daily 
using the clear method from RecipientWebservice, and fully re-fill it using the addAll3 
method from RecipientWebservice. 

Unsubscriptions and bounces from Episerver are imported into CRM before the data 
transfer using two CSV files (bounces and unsubscriptions), requested by Episerver Cam-
paign via SOAP. This prevents unsubscribed and bounced out subscribers from being re-
added to the recipient list during the copy process.

https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/responsewebservice/resetbouncecounter/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/recipientwebservice/clear/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/recipientwebservice/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/recipientwebservice/addall3/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/recipientwebservice/
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Response data

Response data is asynchronously prepared through regular, ongoing jobs (once a day 
by default). Shorter intervals can also be configured depending on your requirements. 
The lifetime of the response data is set between 14 and 30 days. The recipient list is 
recycled after a certain period of time when using the closed-loop interface. Response 
records are still available, but can no longer be clearly categorized.

If recipient data from synchronized recipient lists is used for campaigns in Episerver Cam-
paign, then the respective campaign context is unknown in CRM and it does not make 
sense to make information such as opens or clicks available to CRM in the feedback 
channel. This data can be made available if the CRM can process it.

In contrast, bounces and unsubscriptions refer to entities such as contact, lead, or 
account in CRM. This data is made available and needs to be processed by CRM. The 
applicable bounce status or the advertising consent must be then set to the applicable 
entities.

If a response data flow is configured, then the response data is exported for a client’s 
mailings, which you can import into CRM. It does not matter whether an email is sent via 
the HTTP API, as a campaign email via closed-loop, or as a standalone mailing in 
Episerver Campaign. The opens and clicks are ignored for campaign responses that did 
not have any campaign in the CRM.

Concluding information

 l Blacklists use the email address as a primary criterion. If an email address is entered 
into the blacklist, then no emails are sent to the address. You can manage blacklists 
using Episerver Campaign’s front-end.

 l All features can be used in parallel in Episerver Campaign. Note the limitations for 
the recipient lists.

 l Use UTF-8 as  data format.
 l Use unique file names, including when delivering campaign data.
 l If you use the file API, use the header rows to make troubleshooting  easier.

Salesforce add-on

Note: This topic is for administrators and developers with admin-
istration access rights in Salesforce.
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With the Salesforce add-on, you can send mailings from Salesforce, and use contact 
and lead data to automatically personalize the content. You can transfer customer-
specific fields (up to the third level) to recipient lists, and personalize salutations for 
leads and contact owners. After the mailing is sent, you  receive response data such as 
openings, clicks, outbounces, direct replies and unsubscriptions for each recipient.

Features and supported versions
The following features are supported for Enterprise, Unlimited, and Performance Edi-
tions:

 l Campaign management.
 l Transfer of recipient data.
 l Transfer of returned emails and response data: Openings, clicks, direct replies.
 l Synchronization of unsubscriptions and bounces. 
 l Support for contacts, leads, and personal accounts.
 l Administration of advertising permissions for the marketing channels of email and 

text message.
 l Import of advertising permissions (double opt-in) submitted via Episerver Campaign.
 l Synchronization of contacts, leads, and personal accounts with Episerver Campaign 

recipient lists.

Setup
To set up the Salesforce add-on, contact customer support. Provide Episerver with the fol-
lowing information:

 l Your SOAP API user name in Episerver Campaign. If you do not have a SOAP API user 
account, contact customer support. Use a separate email address that is not used 
for logging into Episerver Campaign.

 l Any additional CRM data in addition to the standard data you want to be trans-
ferred to the Episerver Campaign recipient list. See Configuring the integration. 

 l The client IDs for the integration. To see the client ID, open the Episerver Campaign 
start menu and select Administration > API overview > SOAP API.

Installation
The Salesforce add-on is delivered as an Unmanaged Package. Install this package inde-
pendently in your Salesforce Org according to the standard Salesforce approach. If you 
need help with the installation, contact customer support. After the installation is com-
plete, you can access the Salesforce add-on features via the following tabs:
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 1. Mandators (Episerver Campaign): Store the access data for your Episerver Campaign 
clients in this tab.

 2. Administration (Episerver Campaign): This tab contains  options for configuring, start-
ing, and stopping the data exchange between Episerver Campaign and Salesforce. 

 3. Opt-Ins (Episerver Campaign): Configure and manage the advertising permissions 
for your leads, contacts, and personal accounts in this tab.

 4. DOI Stage Objects (Episerver Campaign): In this tab, manually assign double opt-in 
advertising permissions (see Manual assignment of double opt-ins) that cannot be 
automatically linked to a lead, contact, or personal account. This is the case if a 
data set – for example an email address – exists multiple times in Salesforce and is 
therefore not unambiguous.

Configuring advertising permissions

Note: This topic is for administrators and developers with admin-
istration access rights in Salesforce.

The Salesforce add-on supports the administration of advertising permissions for the mar-
keting channels of email and text message  in your Salesforce Org. It is also possible to 
import double opt-ins from Episerver Campaign.

The configuration of advertising permissions consists of the following steps:

 1. Create Boolean reference fields (true/false) for the marketing channels you use 
(email, text message) for your leads, contacts, and personal account. The ref-
erence fields will later be displayed in the personal information of your leads, con-
tacts, and personal accounts as check boxes (Advertising permission present or 
Advertising permission not present).

 2. In Salesforce, configure your Episerver Campaign clients.
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 3. Assign the created reference fields to an advertising permission with the cor-
responding marketing channel.

 4. Enable automatic import to import completed double opt-ins from Episerver Cam-
paign.

 5. Alternatively, you can assign double opt-ins manually. 

Creating reference fields

 1. Go to the Setup area in Salesforce.                
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 2. In the left menu bar, click Objects and Fields > Object Manager.                 

 3. In the Object Manager window, select the entity that you want to create a new ref-
erence field for, such as Contact.
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 4. In the Object Manager window of the selected entity, click Fields & Relationships.                 
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 5. Click New.                 

 6. In the New Custom field window, select the Checkbox option under Data Type.                 

 7. Click Next.
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 8. Enter a name for the new field in the Field Label field, for example Newsletter.                 

 9. Under Default value, leave the option on Unchecked.
 10. The selected field name will automatically be added in the Field name field. Option-

ally, enter another field name.
 11. Optional: Enter a description in the Description field.
 12. Optional: Enter a help text in the Help Text field.
 13. Click Next.                 
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 14. Configure the field level security according to your requirements.                 

 15. Click Next.                 
 16. Add the page layouts according to your requirements or remove unneeded page 

layouts.                 

 17. Click Save.
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Repeat the steps for the other marketing channels you use and for the corresponding 
entities (leads, contacts, personal accounts).

Tip: Create identical fields for leads, contacts, and personal 
accounts. In this way, advertising permissions will be automatically 
transferred if a lead becomes a contact, for example. If you cre-
ate different fields, you need to use Rules to transfer the advertising 
permission (such as from a lead that has become a contact).

Storing client IDs and SOAP API user data

Note: If you do not have a SOAP API user account, contact cus-
tomer support.

 1. Log in to Salesforce CRM.
 2. Open the Mandators (Episerver Campaign) tab.                 

 3. Click New to create an Episerver Campaign client in Salesforce.                 

Tip: If you would like to change the settings of a previously cre-
ated client, click  the respective client and then Edit. The list 
views in Salesforce may hide clients. If necessary, click All in the 
list views.
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 4. In the Episerver Campaign Client window, specify the following fields:

 a.  Name. Name of the client (as it should be displayed in Salesforce). You can 
chose the name freely. For greater clarity, use the same name as in Episerver 
Campaign.

 b.  Client ID. Client ID. To see the client ID, open the Episerverstart menu and select 
Administration > API overview > REST API.

 c.  API User. Your SOAP API user name.
 d.  Password. Your SOAP API password.
 e.  Active. Select the check box.

 5. Click Save.

Repeat these steps for  additional clients to connect to Salesforce CRM.

Assigning reference fields

 1. Open the Opt-Ins (Episerver Campaign) tab.                 

 2. In the Opt-Ins (Episerver Campaign) window, click New.                 
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 3. In the Configure advertising permission window, specify the following fields:

 a. Name. Name for the advertising permission (for example Product newsletter).
 b. Mandator. Episerver Campaign client to which the advertising permission is to be 

assigned.
 c. Opt-In Type. In the drop-down list, select the marketing channel for which the 

advertising permission applies (for example Email).
 d. Reference field. In the drop-down list, select the reference field that you want to 

assign the advertising permission to (the Boolean field that you have created 
the advertising permission for, see Creating reference fields).

 4. Click Save.

Importing opt-ins from Episerver Campaign

 1. Select the check box Episerver Campaign Synchronization.                 

 2. In the DOI list Id field, enter the ID of the recipient list containing the double opt-ins. 
To see the recipient list ID, open the Episerverstart menu and select Administration > 
API overview > Recipient lists.                 



© Episerver 2020

960 | Episerver Campaign User Guide 2020-04-23

 3. In the DOI process Id field, enter the ID of the opt-in process. To see the opt-in ID, 
open the Episerver start menu and select Administration > API overview > Opt-in pro-
cesses.                 

 4. Click Save.

Manual assignment of double opt-ins

If a double opt-in advertising permission via Episerver Campaign has not been assigned 
– because it has multiple contacts or leads for the same email address, for example – 
you need to assign it manually. Perform the following steps:

 1. Open the DOI Stage Objects (Episerver Campaign) tab.                 

The DOI Stage Objects (Episerver Campaign) window shows you the advertising per-
missions that were unable to be assigned automatically.
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 2. To see detailed information about an advertising permission, click the unassigned 
advertising permission.

 3. To assign the advertising permission, click the downward-pointing triangle on the 
upper right.                 

 4. Select Assign DOI manually in the drop-down list.                 
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 5. Under Select Contact or Lead, search for the person to whom you want to assign the 
double opt-in advertising permission.                 

 6. Click Assign DOI.                 

Repeat the steps for every advertising permission that has not been assigned.

Tip: Check regularly whether marketing permissions are unable to 
be assigned and then assign them manually. This keeps your data-
base updated at all times.

Configuring data fields

Note: This topic is for administrators and developers with admin-
istration access rights in Salesforce.

Transferring default data fields 

You can use contact data of leads or contacts  to personalize mailings and for target 
group segment in Episerver Campaign. See Field functions and Target groups.

By default, the following data is sent from Salesforce to Episerver Campaign:
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Field name Data type Description

email String Email address of the contact or lead

salesforceid String Unique ID for the contact/lead in Salesforce

sfcampaignid String Unique ID of the Salesforce campaign

entity_type String Contains the type of the Lead, Contact, or Personal Account 
type 

optinname String Name of the opt-in

optintype String Media type of the opt-in

salutation String Recipient's salutation

firstname String Recipient's first name

lastname String Recipient's last name

title String Recipient’s title (for example Dr., Prof. and so on)

mobilephone String Recipient's mobile telephone number

fax String Recipient's fax number

street String Recipient’s street and house number from the Lead type

postalcode String Recipient’s postal code from the Lead type

city String Recipient’s place of residence from the Lead type

state String Recipient’s state from the Lead type

country String Recipient’s country from the Lead type

birthdate Date Recipient’s date of birth from the Contact type

mailingstreet String Recipient’s street and house number from the Contact type
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Field name Data type Description

mailingpostalcode String Recipient’s postal code from the Contact type

mailingcity String Recipient’s city from the Contact type

mailingstate String Recipient’s state from the Contact type

mailingcountry String Recipient’s country from the Contact type

Transferring additional fields

In addition to the standard setup, you can transfer other Salesforce data fields to 
Episerver Campaign. The Salesforce add-on can directly access linked data sets (Sales-
force objects up to the third level). For example, the contact person who manages the 
contact or lead in your organization, or the name of the department head, in addition 
to contact or lead data and attributes. 

This lets you, for example, customize greetings, so that a contact or lead is greeted by 
the member in your organization that manages the lead or contact.

To set up the transfer, first configure the additional data fields in Salesforce. Then, con-
tact Episerver customer support to request the addition of these fields to your recipient 
lists.

Configuring additional data fields

 1. Log in to Salesforce CRM.
 2. Open the Administration (Episerver Campaign) tab.                 

The Administration (Episerver Campaign) window opens. In the fields area, you can 
find the data fields that can be transferred to Episerver Campaign, separated by 
leads, contacts, and personal accounts.
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 3. When data synchronization is enabled, you can disable data synchronization by 
clicking Stop scheduler next to Scheduler control.                 

 4. In the lists on the left under Lead, Contact, or Personal Account, select the data field 
that you want to transfer to Episerver Campaign. To select multiple data fields at the 
same time, hold down the CTRL key on your keyboard.               
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Note: The lists on the left contain Salesforce objects that can be 
transferred. Lists on the right contain objects that are currently 
transferred.

 5. To add one or more data fields, click the right arrows >>.                 

 6. Optional: Select a data field and click Up or Down to change the order in which the 
data fields are transferred.                 
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 7. Click Save.                 

Under Resulting field list for Episerver Campaign, the list of data fields that are to be 
transferred are expanded by the newly-added data fields. If you want to discard 
your changes and return to the default settings, click Reset to default.

Tip: Keep this window open, as it is needed when Requesting 
additional fields to be added to recipient lists.

Since all  Salesforce objects cannot be displayed in the Lead, Contact and Personal 
Accounts lists at the same time, you can use a filter to hide data fields or data field 
groups to display other  Salesforce objects. If data fields that you want to transfer  are 
missing from the list, you can hide the data field group Owner:
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 1. Be sure to save all changes to the data fields to be transferred.

Warning: When you edit and apply the filter, unsaved changes 
to the data fields are lost. Save any changes prior to editing the 
filter.

 2. In the Filter field, add the entry Owner, separated by a comma; do not use spaces.

 3. Click Apply filter and save. Data fields that start with Owner are now hidden and pre-
viously invisible Salesforce objects are displayed.

 4. Locate the desired field  and add it to the data fields to be transferred using the 
arrow button >>.
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Requesting additional fields to be added to recipient lists

 1. Under Resulting field list for Episerver Campaign, highlight the entire, comma-sep-
arated list of data fields  to be transferred.                 

 2. Copy the highlighted list to the clipboard.
 3. Insert the copied list into the message text of an email and send  to  customer support. 
 4. When you receive the confirmation email, click Start scheduler in the  Administration

(Episerver Campaign) tab to enable automatically data synchronization.

Once data exchange is enabled, the additional data fields are automatically trans-
ferred to Episerver Campaign. You can use the corresponding Salesforce objects to per-
sonalize your mailings via field functions.

Sending campaign mailings

Note: This topic is for administrators and developers with admin-
istration access rights in Salesforce.

With the Salesforce add-on, you can send  mailings via Episerver Campaign from your 
Salesforce CRM. After the mailing is sent, response data (openings, clicks, direct replies, 
unsubscriptions and outbounces) are automatically imported into Salesforce from 
Episerver Campaign.
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Note: Response data can not be transferred for campaigns ini-
tiated directly in Episerver Campaign or the activities of marketing 
automation.

These are the steps to send a mailing:

 1. Prepare a Smart Campaign with at least one mailing in Episerver Campaign.
 2. Create a CRM campaign in Salesforce and add members.
 3. Start the dispatch of the Episerver Campaign mailing in Salesforce.

Preparing a Smart Campaign in Episerver Campaign

The Smart Campaign set up requires at least  these nodes:

 l Recipients node, to which you assign the Master recipient list of the closed-loop inter-
face. This is set up by the Episerver customer support, when your client is configured.

 l Wait node, to enable the Wait until import has been finished option.
 l Message node, containing the mailing to be sent. The Salesforce add-on supports 

these media types: Email, SMS.

To configure a Smart Campaign, do the following:

 1. Log in to Episerver Campaign.
 2. Open the start menu and select Campaigns > Smart Campaigns.
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 3. In the Campaigns window, click Create.

 4. Drag the Recipients node from the left action area to the working area on the right.

 5. Select the master recipient list in the Recipient lists drop-down list of the context 
menu. Make sure you use the master recipient list provided with the Salesforce integ-
ration setup.
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 6. Drag the Wait node from the left action area to the working area on the right.
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 7. In the context menu, enable the option Wait until import has been finished.

 8. Drag a message node (email, SMS) from the left action area to the working area on 
the right.

 9. Click Edit content, select a template and insert your message content into the mail-
ing. Design your Smart Campaigns mailing as usual, using available tools and fea-
tures. See Edit mailing content.
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 10. Click Close.

 11. Connect the campaign nodes.
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 12. Click Save and Close, enter a campaign name and click Save.

Note: Do not activate and send the campaign mailing. If you do, 
you cannot start and send it from Salesforce anymore. If you start 
and send the mailing from Salesforce  later, the mailing is auto-
matically duplicated. You can delete the original in Episerver Cam-
paign after it is sent.

Creating a CRM campaign and adding members

The CRM campaign in Salesforce controls the Smart Campaign created in Episerver 
Campaign. With the CRM campaign, you trigger the mailing dispatch in Episerver Cam-
paign and transfer the selected contacts and leads (members of the CRM campaign) 
into the Episerver Campaign recipient list.

Use the regular features in Salesforce to create a CRM campaign and assign members. 
The following steps shows an example of how to do this.

 1. Log in to Salesforce CRM.
 2. Click Campaigns.



© Episerver 2020

976 | Episerver Campaign User Guide 2020-04-23

 3. Click New.

 4. Enter the desired campaign information and description.                 

 5. In the Advertisement Consent field, enter the advertising permission that you want to 
assign to the campaign.                 
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 6. In the Episerver Mandator field, select the client in which you have prepared the mail-
ing that is to be sent. (In the example, the client's name is Episerver Campaign). 
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 7. Click Save.                 

 8. In the Campaign Members area, click on Add Contacts or Add Leads or Add Person 
Accounts.                 
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 9. Select the contacts or leads or personal accounts that you want to add to the cam-
paign.                 
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 10. Click Next.                 

 11. Click Submit.                 

The <Your campaign name> Campaign window opens again. Keep this window open 
as it is needed in the next step: Starting the mailing dispatch in Salesforce.

Starting the mailing dispatch in Salesforce

 1. In the <Your campaign name> Campaign window, click on the downward-pointing tri-
angle on the upper right side and select the Start mailing option.                 
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 2. In the Episerver Campaign window, check under Opt-In that the correct advertising 
permission has been selected. Use the drop-down list to change the advertising per-
mission if necessary.                

 3. Click Load mailing IDs.               

The Mailing ID drop-down list loads the mailing ID of the mailings you prepared. For 
multiple mailings, the IDs for these are loaded.

 4. For multiple mailings, select the ID for the desired mailing from the Mailing ID drop-
down list. To see the mailing IDs, open the start menu and select Campaigns > Smart 
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Campaigns and copy the relevant mailing ID from the ID column of the campaigns 
overview.

 5. Click Start mailing (in Salesforce). The contacts/leads that you added to your CRM 
campaign as members are transferred to Episerver Campaign.               

 6. To check the current dispatch status for the mailing, click Back.                 

The <Your campaign name> Campaign window opens.

 7. Check the sending status in the Details tab. A selected check box indicates that the 
mailing was sent successfully.               
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Copying data sets in recipient lists

Note: This topic is for administrators and developers with admin-
istration access rights in Salesforce.

The Salesforce add-on adds two Apex classes to Salesforce Process Builder with which 
you can copy and synchronize the data sets of contacts, leads, and personal accounts 
with your Episerver Campaign recipient lists:

 l Upsert Recipient. Updating recipients or adding new recipients. 
 l Delete Recipient. Deleting leads, contacts, and personal accounts from an Episerver 

Campaign recipient list.

Requirements

Episerver  customer support must prepare your Episerver Campaign recipient lists for the 
Salesforce synchronization. Provide information about the client in which  you want to 
use recipient lists for the Salesforce synchronization.
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Generating processes and using Apex classes

Once customer support has prepared the desired recipient lists, set up processes in 
Salesforce to automatically copy contacts, leads, and personal accounts in Episerver 
Campaign recipient lists. For example, you can set up processes that filter customers 
according to a certain status and transfer them to a corresponding  recipient list, such 
as new customers in a recipient list that only contains new customers.

For contacts, leads, and personal accounts in this example,  a Boolean reference field 
(true/false) called Premium Customer was created first that you will need for configuring 
the process. See Creating reference fields.

Setting up processes

 1. Go to the Setup area in Salesforce.

 2. In the left menu bar, click Process Automation > Process Builder.
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 3. In the My Processes window, click New.

 4. In the Process Name field, enter a name for the process, such as Premium Customers.

 5. Enter a name under API Name, such as Premium_Customers.
 6. Optional: Enter a description in the Description field.
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 7. Select A record changes in the The process starts when drop-down list.

 8. Click Save.
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Adding criteria and defining Apex classes

 1. Click Add object in the flowchart.

 2. In the Choose Object and Specify When to Start the Process window, select the entity 
in the Object drop-down list that you want to set up the process for: Lead, Contact, or 
Person Account.
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 3. Under Start the process, enable when a record is created or edited.

 4. Click Save.
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 5. Click + Add criteria.

 6. In the right window, enter a name for the criterion in the Criteria Name field, such as Is 
Premium Customer.
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 7. Under Criteria for Executing Actions, select Conditions are met.

 8. Under Set conditions, select the Premium Customer reference field from the drop-
down list under Field and confirm your selection.
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 9. Set the Operator to Equals, the Type to Picklist, and the Value to Primary.
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 10. Under Conditions, select the All of the conditions are met (AND) option.

 11. Click Save.
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 12. Click Add action under Immediate actions in the flowchart.

 13. In the Select and Define Action window, select the Apex entry from the Action Type 
drop-down list.
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 14. Enter a name under Action Name, such as Add Premium Customer.
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 15. Select the Upsert Recipient entry from the Apex Class drop-down list.

Note: You need to configure three variables for the Upsert Recip-
ient Apex class: recipientId, recipientListId, and sfOptInId.

 16. Under Set Apex Variables, click Add Row three times.
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 17. In the first drop-down list under Field, select the recipientId variable and set the type 
to Field Reference. Depending on the desired entity type, select the Lead Id, the 
Contact Id, or the Personal Account Id in the Value field. 

 18. In the second drop-down list under Field, select the RecipientListId variable and set 
the value to the ID of the Episerver Campaign recipient list to which the Premium 
Customers are to be copied. To see the recipient list ID, open the Episerverstart 
menu and select Administration > API overview > Recipient lists.
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 19. In the third drop-down list under Field, select the sfOptInId variable and set the value 
to the Salesforce ID of the created advertising permission. The type will auto-
matically be set to String; do not make any changes here.

 20. Click Save.
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Deleting recipients from one recipient list and adding them to another recip-
ient List

For example, a Premium Customer has achieved high revenues and qualified as a Plat-
inum Customer. You want to delete this customer from the premium list and add it to 
the platinum list.

To delete recipients from one recipient list and add them to another, set up the Delete 
recipient class (which deletes the customer from the premium list) along with the Upsert 
Apex class (which adds the customer to the platinum list). Configure the Delete recipient 
Apex class only with the recipientId and recipientListId parameters. See steps 18 and 19 in 
the previous section.
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Enabling synchronization of deleted contacts, leads, and personal 
accounts

To completely delete deleted contacts, leads, and personal accounts from your  recip-
ient list in your Salesforce database as well, do not set up a separate process in Sales-
force. The Salesforce add-on takes care of synchronizing your deleted Salesforce data 
sets if you enable automatic synchronization of deleted contacts, leads, and/or per-
sonal accounts. Perform the following steps:

 1. Open the Administration (Episerver Campaign) tab.

 2. In the Administration (Episerver Campaign) window, click Start scheduler under Syn-
chronization of deleted recipients.

Tip: Click End to interrupt synchronization of the deleted data sets. 
This may be necessary, for example if the configuration is faulty, 
and you need to correct it.
Click Start under Synchronize manually to perform (one-time) 
manual data synchronization. A manual start allows you to limit the 
period of access between Salesforce and Episerver Campaign in 
the log files, thereby helping to diagnose any errors.
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Import response data to Salesforce

Note: This topic is for administrators and developers with admin-
istration access rights in Salesforce.

This topic describes how to automatically import the response data of your recipients 
(openings, clicks, unsubscribes, bounces, and direct replies) to Salesforce.

After sending a campaign, you need to enable synchronization of the response data by 
starting the data exchange. Once you have enabled synchronization, you will be able to 
view the response data and use it for additional marketing activities.

Starting data exchange

If you have set up at least one client in Salesforce (see Configuring advertising per-
missions), start the data exchange between Salesforce and Episerver Campaign. Per-
form the following steps:

 1. Log in to Salesforce CRM.
 2. Open the Administration (Episerver Campaign) tab.                 

The Administration (Episerver Campaign) window opens.

 3. Under Response data synchronization > Scheduler control, click Start scheduler.    
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The Start scheduler button will be grayed-out when data synchronization is enabled. 
In addition, the icon next to Response Data Sync Scheduler will light up green.

Tip: Click Stop scheduler to interrupt synchronization of the deleted 
data sets. This may be necessary, such as if the configuration is 
faulty and you need to correct it.
Click Start data synchronization under Synchronize manually to per-
form (one-time) manual data synchronization. A manual start 
allows you to limit the period of access between Salesforce and 
Episerver Campaign in the log files, thereby helping to diagnose 
any errors.

Viewing response data

After an  mailing has been sent, the Salesforce add-on automatically imports the 
response data from your contacts and leads to your CRM. The detail pages of the CRM 
campaigns, campaign members, and contacts/leads provide you with access to the 
following data:

 l Dispatch status of the mailing
 l Openings
 l Clicks
 l Bounces
 l Unsubscribes
 l Direct replies

Note: The response data of your contacts/leads is not transferred to 
Salesforce in real time. This data import may be delayed by several 
hours.
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Microsoft Dynamics CRM integration

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.

With the  integration you can send campaigns from Microsoft Dynamics CRM via 
Episerver Campaign. Send large information volumes securely via email and SMS.

Add contacts and leads to a campaign, and use contact data for automatic per-
sonalized mailings in Episerver Campaign. Start campaign mailings in Microsoft Dynam-
ics, and receive reports with sent and returned  response data (opens, clicks, direct 
replies, outbounces and unsubscribes).

You can copy CRM (customer relationship management) marketing lists into Episerver 
Campaign recipient lists, and automatically include new CRM contacts in a Marketing 
Automation campaign to for example send welcome and birthday mailings.

Features and supported versions

Feature                     
Microsoft 

Dynamics 365                     
Microsoft Dynamics 

CRM 2016                     
Microsoft Dynamics 

CRM 2015                     

Episerver Campaign man-
agement                     ✓ ✓ ✓

Transfer of recipient data                     ✓ ✓ ✓

Copy marketing lists into 
Episerver Campaign ✓ ✓ ✓

Transfer of returned emails/re-
sponse data                     ✓ ✓ ✓

Synchronize unsubscribes and 
outbounces                     ✓ ✓ ✓

Note: Microsoft's Mainstream Support for Microsoft Dynamics CRM 
2015 ended on January 14, 2020.
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Setup
To set up the Microsoft Dynamics integration, contact customer support.

Provide Episerver with the following information:

 l Your SOAP API user name in Episerver Campaign. If you do not have a SOAP API user 
account, contact customer support. Use a separate email address that is not used 
for logging into Episerver Campaign.

 l Any additional CRM data in addition to the standard data you want to be trans-
ferred to the Episerver Campaign recipient list. See Configuring additional fields for 
the recipient list. 

 l The client IDs for the integration. To see the client ID, open the Episerverstart menu 
and select Administration > API overview > REST API.

 l The IDs of the corresponding recipient lists, if you want to synchronize marketing lists 
with Episerver Campaign. Alternatively, customer support can create new recipient 
lists. To find recipient list IDs, open the start menu and select Administration > API over-
view > Recipient lists.

See Troubleshooting and maintenance if there are issues with the integration. 

These instructions apply to  the Microsoft Dynamics 365 online version. Procedures are 
similar for on-premises versions.

Installation

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.

This topic describes how to install the Microsoft Dynamics CRM integration, if you are 
using this with Episerver Campaign. 

Installing the software package

 1. Install the software package  you received from customer support in Microsoft Dynam-
ics CRM.

 2. Log in to Microsoft Dynamics CRM with administrator rights.
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 3. Open the settings and click Solutions in the Customization menu.

 4. Click Import and select the file  to upload.

 5. Select the compressed software package ZIP file and click Next. When uploaded, 
package information including name, publisher, and type is displayed.
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 6. Click Next.
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 7. Select Enable any SDK message processing steps included in the solution.

 8. Click Import. When completed you can download the log files. The CRM settings 
now has an additional Episerver Campaign area.

The integration provides two CRM roles:

 l Episerver Campaign Administrator. For administering the integration and modifying 
settings.

 l Episerver Campaign User. For working with campaigns via Episerver Campaign.
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Installing an update

The difference compared to an initial installation is that you will be notified that the 
uploaded file is an update for an installed solution. To keep your integration settings, 
user accounts, passwords, and response data, activate the option Maintain cus-
tomizations (recommended).

Extended recipient list connector

The current version of Microsoft Dynamics 365 cannot address more than 100,000 recip-
ients per campaign. The extended recipient list connector for Episerver Campaign is an 
external Windows service that lets you avoid this limitation. Contact customer support for 
the installation file and further documentation.

Multi client setup 

The Microsoft Dynamics CRM integration allows you store up to three Episerver Cam-
paign clients in one organization. A reverse mapping from multiple Microsoft Dynamics 
CRM organizations to one Episerver Campaign client is not possible.

Configuration

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.

This topic describes how to set up  the Microsoft Dynamics CRM integration, if you are 
using this with Episerver Campaign. 

The configuration includes these steps:

 1. Enter SOAP API user data.
 2. Enter client IDs.
 3. Start response data workflows.
 4. Assign Episerver Campaign test lists
 5. Create advertising consents and link to client.

To transfer fields not included in the standard configuration, you must also configure the 
additional fields for your Episerver Campaign recipient list.
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Entering SOAP API user  data

Communication and data exchange between Microsoft Dynamics and Episerver Cam-
paign uses the SOAP API. To link CRM with Episerver Campaign via the interface, you 
must enter your SOAP API user data in Microsoft Dynamics. 

Note: If you do not have a SOAP API user account, contact cus-
tomer support.

 1. Log in to Microsoft Dynamics CRM with administrator rights.
 2. Go to Settings > Episerver Campaign > API data. The integration adds a new Episerver 

Campaign section to your CRM (Customer Relationship Management) settings.

 3. Click New.
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 4. For API User, enter your SOAP API user name.
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 5. For API Password, enter your SOAP API password.

 6. Click Save & Close.

Entering client IDs

To run campaigns, specify which Episerver Campaign client you want to use in CRM for 
sending. 

 1. Go to Settings > Episerver Campaign > Episerver Campaign > Clients.

 2. Click New.
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 3. For Client ID, enter the ID of the client to use for sending campaigns.

Tip: You can find the client ID in the Episerver Campaign start 
menu under API overview > REST API.
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 4. For Description, enter the name of the client.

Note: The name of client is displayed at top right in the menu 
bar in Episerver Campaign.
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 5. For API User, select your SOAP API user. See Enter SOAP API user data.

 6. Click Save & Close. To add more clients, repeat the steps for each additional client. 

Starting response data  workflows

To feed campaign response data from contacts and leads in Episerver Campaign into 
CRM,  start the response data workflows for each individual client. The workflows query 
and import recipient response data in 60-minute intervals.

These workflows are available for each response type:

Workflow Response type

Episerver: Get opens Mailing opened                     

Episerver: Get clicks Link clicked in the mailing                     

Episerver: Get responses Direct reply to the mailing                     

Episerver: Get unsubscribes Newsletter unsubscribes                     

Episerver: Get outbounces Outbounce (the recipient has exceeded the bounce limit)                     

Do the following to start workflows:
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 1. Select the clients to start workflows for.  If the  list of clients does not open, go to Set-
tings > Episerver Campaign > Episerver Campaign Clients.

 2. Click Run Workflow. 
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 3. Select a workflow and click Add.

 4. Click OK to confirm. 
 5. Repeat steps 1–4 for each workflow.

You can see workflow activity in the Information view for the client. Click the cor-
responding client ID in the list to open it. Under access data, you can see when the 
workflow was last run, and timestamp for the most recently imported data.

Assigning Episerver Campaign test lists

To check the campaign mailings before dispatch, you can send them to a Episerver 
Campaign test list. To do this, you must assign the Episerver Campaign test list in 
Microsoft Dynamics CRM. Do the following:

 1. Go to Settings > Episerver Campaign > Episerver Campaign > Clients.
 2. Click Client.
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 3. Click Add Testlist record.

 4. Enter a name for the test list.

 5. Enter the recipient list ID of the test list. To see the recipient list ID, open the Episerver-
start menu and select Administration > API overview > Recipient lists.



© Episerver 2020

1018 | Episerver Campaign User Guide 2020-04-23

Tip: If you are missing the ID column, click the down arrow v in 
the upper right corner of the table header and activate the ID 
check box.

 6. Click Save and close the window.
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Tip: To assign more test lists, repeat the steps for each additional 
test list.

Creating consents and linking to client

To send mailings, you need advertising consent from contacts and leads. The consent 
protects recipients from unwanted  omnichannel marketing. See also Opt-in. The integ-
ration checks two fields in Microsoft Dynamics for each contact and lead, to see if con-
sent is given or withdrawn, and will not transfer  recipients without consent.

Furthermore, you record the bounce status for the contact, lead or account, which 
makes a statement about the functionality of the advertising agreement.

Perform the following steps:

 1. Creating a bounce status field
 2. Adding the bounce status field to a form
 3. Creating advertising consent and associating the bounce status field

Creating a bounce status field

 1. Log in to Microsoft Dynamics CRM with administrator rights.
 2. Go to Settings > Customizations.

 3. Click Customize the System.
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 4. Use the side navigation to go to Components > Entities > Contact or Lead or Account > 
Fields.
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 5. Click New.
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 6. Specify the following fields:

 l Display Name. Enter an intuitive name, for example EpiOutbounce E-Mail.
 l Name. Click into any other field. The entry is automatically copied to the Name 

box (without spaces or special characters), with the prefix new_ added. Change 
the automatically created entry in the Name box, such as changing it to new_
epioutbounce eMail. Do not use spaces or special characters. Note the entry in 
the Name box, you will need this later for the advertising consent.
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 l Field Requirement: Select Optional.
 l Searchable: Select Yes.
 l Field Security. Select Disable.
 l Auditing. Select Enable.
 l Description. Optional: Enter a field description.
 l Data Type. Select Two Options. A field containing the options No and Yes appears.
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 l Field Type. Select  Simple.
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 7.  Click Save and Close. 

Adding the bounce status field to a form

 1. Use the side navigation to go to Components > Entities > Contact or Lead or Account > 
Forms.
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 2. Click the form for which you want to add the advertising consent presence field.

 3. Click the area, for example Marketing, where the field for presence of advertising 
consent should appear. When the area is selected, the surrounding dashed line 
becomes solid.
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 4. On the right, open the Field Explorer and browse for the field you created for the 
advertising consent presence. 

Tip: You can filter the number of fields shown.
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 5. Double-click the advertising consent field to add it to the selected area.

 6. Click Safe.
 7. Click Publish.
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Creating advertising consent and associating the bounce status field

 1. In Microsoft Dynamics, go to Settings > Episerver Campaign > Advertising Consents.             

 2. Click New.

 3. For Opt-in-ID, enter a unique identifier. Do not use special characters or characters 
with accents. The Opt-in-ID should be intuitive, for example Opt-
inProductNewsletterEmailContact. It will display, for example, when selecting  
advertising consent for sending a campaign.
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 4. Optional: For Description, enter a description for the advertising consent.
 5. For Type, select the communication channel (email, SMS ) to which the advertising 

consent applies.

 6. For Entity, select the customer type (Contact or Lead or Account) for which the advert-
ising consent is used.
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 7. For Reference Bounce Field, enter the name of the field indicating the functionality of 
the advertising consent. This is the name that automatically had new_ added when 
creating the field.

 8. For Episerver Campaign client, select the client used for sending the advertising con-
sent by clicking the magnifying glass symbol.    

Note: The allocation of a client to an advertising consent can-
not be changed.
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 9. Click Save & Close. The new advertising consent is displayed in the overview list.

Repeat steps 1–9 to add more advertising consents for the same channel. Additional 
advertising consents can refer back to the bounce status field that was already cre-
ated. This applies to the entire channel, for example an Email channel.

You have successfully created an advertising consent. Irrespective of whether the 
agreements are obtained through an opt-in process in Episerver Campaign or from 
another source, you will find the assignment of the advertising consents to the individual 
contacts, leads or accounts under the menu item Opt-in Histories.

In the Opt-in History Assigned View overview, you can see the advertising consents gran-
ted. If the advertising consent is withdrawn again, the entry can be deleted, or an Opt-
out entry is created on basis of the unsubscribe response data. In this case, CRM uses the 
time stamp to recognize the current status of the withdrawn advertising consent. In 
both cases, no more mailings that require the corresponding consent are sent to this 
data record.
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Connecting the advertising consent to an Episerver Campaign opt-in pro-
cess

On the configuration page of the advertising consent, you find another Opt-in area 
where you can can connect the created advertising consent to the opt-in process in 
Episerver Campaign. This enables you to send opt-in mailings with a confirmation link via 
Episerver Campaign.

Prerequisites:

 l You completed configuring the integration, including an advertising consent.
 l You created an opt-in process. You require the ID of the opt-in process and the ID of 

the opt-in recipient list used in the process.

To connect an advertising consent to a double opt-in process:

 1. In the Opt-in area, in the Synchronize Double Opt-in field, select Yes.

 2. In the Opt-in Recipient List ID field, enter the ID of the recipient list that is used in the 
opt-in process. To see the recipient list ID, open the Episerverstart menu and select 
Administration > API overview > Recipient lists.
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 3. In the Opt-in Process ID field, enter the ID of the Opt-in process from Episerver Cam-
paign. To see the opt-in ID, open the Episerver start menu and select Administration > 
API overview > Opt-in processes.

 4. Optional: In the Konfiguration DOI field, enter a XML configuration that assigns inform-
ation from the contact fields to the recipient list fields in the opt-in recipient list.
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Note: The entry in <optinsource> is freely customizable.  Note that 
the root node is named <episerver> here.
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 5. Click Save & Close.

You have successfully combined an advertising consent in CRM with an opt-in process in 
Episerver Campaign. You can now trigger the sending of an opt-in mailing via Episerver 
Campaign by clicking the Send Opt-in Mail button in the respective entity.

Customizing the campaign activity  form

To complete the configuration, update the campaign activity form adding fields from 
the Microsoft Dynamics integration. These fields are usually added when the integration 
is installed. However, depending on your CRM configuration, this step may have been 
missed.

The integration has these fields:

No. Field name

1                     Recipients sent to Episerver Campaign

2                     Sent successful                     

3                     Recipient Packages created                     



© Episerver 2020

1038 | Episerver Campaign User Guide 2020-04-23

No. Field name

4                     Mailing Description                     

5                     Mailing ID                     

6                     Mailing ID by Wave ID                     

7                     Mailing name                     

8                     Mailing Status                     

9                     Episerver Campaign client                     

10                     Recipient Packages sent                     

11                     Preprocessed recipients                     

12                     Wave ID                     

13                     Advertising Consent                     

Do the following:

 1. In Microsoft Dynamics, go to Settings > Customizations.
 2. Click Customize the System.
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 3. Select Components > Entities > Campaign Activity > Forms.

 4. Click Campaign activity in the list to open the Campaign Activity form.
 5. In the field explorer, from the Filter drop-down list, select Custom Fields and clear the 

Only show unused fields check box. The 13 fields from the Microsoft Dynamics Integ-
ration are shown.
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 6. Drag the 13 fields into the Episerver Campaign area of the structure view of the form.

 7. Click Save and Close. 

Transferring data fields

When transferring data fields from the CRM to Episerver Campaign, a distinction  is made 
between data fields transferred by default and additional optional fields that must be 
configured.

Note: The integration transmits all values as a string, regardless of 
which data type is created in CRM.

Data fields transferred by  default

The default settings for the integration send the following data from Microsoft Dynamics 
to Episerver Campaign:
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Field name Date type Description

entityType                     String                     Indicates whether this is a lead or a contact                     

salutation                     String                     Title                     

firstname                     String                     First name                     

lastname                     String                     Last name                     

fullname                     String                     First name and last name                     

mobile                     String                     Mobile phone number (required for SMS campaigns)                     

email                     String                     Email (required for email campaigns)                     

street                     String                     Street                     

city                     String                     City                     

state                     String                     State                     

zip                     String                     Zip code                     

country                     String                     Country                     

Configuring additional fields for the recipient list

This configuration applies to both campaign management and synchronization of recip-
ient lists and advertising consents (clients). Remember to consider this during planning 
to avoid costly reconfiguration and additional work. The field configurations must be 
identical for both leads and contacts. Changing only one type will cause the other to fail 
to send.

Options for custom configuration of  recipient lists:

 l Remap a custom CRM field and write it to an existing standard field in the  recipient 
list.

 l Transfer a custom CRM field to an additional field not  in the standard configuration 
of the recipient list .
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Remapping CRM fields
 1. In Microsoft Dynamics, go to Settings > Episerver Campaign > Mappings.

 2. Click New.
 3. For Entity, select the type Contact.

 4. In the Map From box, enter the name of the field in  CRM.
 5. For Map To, select the standard field in the recipient list into which the value of the 

CRM field should be written. For example, if you created a field called new_custom_
country, then you can copy the value of this field into the Country field in the recip-
ient list. The standard CRM Country field is no longer transferred to Episerver Cam-
paign.
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 6. Click Save.

Repeat steps 1–6 for type Lead (at step 3, select Lead under Entity). 

Transferring CRM fields
Prior to transferring, contact customer support to add the additional fields  to your recip-
ient list. In the request, provide the fields in a consecutively numbered list starting at 1, 
including numbering and field names. Note the numbering and field names (do not 
change them), you will need these for the configuration.

Do the following when the  fields have been added: 

 1. Go to Settings > Episerver Campaign > Episerver Campaign Mappings in 
Microsoft Dynamics CRM.

 2. Click New.
 3. For Entity, select Contact.
 4. In the Map From box, enter the name of the CRM field.
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 5. For Map To, select Custom.

 6. In the Field box, enter the name of the additional recipient list field requested.

 7. In the Position box, enter the position number of the additional recipient list field. The 
position numbers are oriented to the order of the additional recipient list fields 
requested.

 8. If the Map From field is of the OptionSet type, use OptionSet Language to select the 
language to use to transfer the values.
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 9. Click Save.
 10. Repeat steps 2–10 for type Lead (at step 4, select Lead under Entity).

Sending mailings

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.

This topic describes how to send campaign mailings directly from Campaign Activity in 
Microsoft Dynamics CRM, when using this with Episerver Campaign. After the mailing is 
sent, response data (opens, clicks, direct replies, unsubscribes and outbounces) is auto-
matically imported into CRM from Episerver Campaign.

Prerequisites

 l Configuration of the integration completed. See Configuration.
 l Campaign mailing prepared in Episerver Campaign.  If you are using the closed-loop 

interface, add the Wait node to your  campaign and select Wait until import has been 
finished so that mailings are only sent once the import of recipients is complete. See 
Smart Campaign nodes.

 l The ID of the campaign mailing to be sent. Make a note of the mailing ID as this is 
required to send the mailing from CRM.
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Configuring marketing lists and CRM campaigns

Before sending a campaign mailing via Episerver Campaign, you must do the following 
in Microsoft Dynamics CRM:

 l Create a marketing list with leads and contacts who will receive the mailing. 

Note: Contacts and leads for which you do not have advertising 
consent will not receive the mailing, even if they  are in the mar-
keting list.

 l Create a CRM campaign and add the marketing list.

Creating a marketing list

 1. In Microsoft Dynamics CRM, go to Marketing > Marketing Lists.

 2. Click New. The integration supports both static and dynamic list types. The name for 
the marketing list and its options (such as Currency) are not relevant for sending mail-
ings via Episerver Campaign.

 3. When done, click Save.
 4. Click the plus icon + for Members to add desired contacts or leads to the marketing 

list.      
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 5. When done, click Save. 

Creating a CRM campaign and adding the marketing list

 1. In Microsoft Dynamics CRM, go to Marketing > Campaigns.

 2. Click New.
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 3. In the Name box, enter a name for your campaign. 

 4. In the Currency box, specify a currency for the campaign. 

 5. Click Save.
 6. In the Marketing Lists area, click the plus icon +, select the desired marketing list and 

click Add.
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 7. Click Save. Keep the window open for the next step.
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Preparing campaign activity for dispatch

 1. Click the plus icon + in the Campaign Activities area.

 2. In the Subject box, enter a subject for your campaign activity.
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 3. Under Channel, select Episerver Campaign. 

 4. Under Advertising Consent in the new options area, click Search and select the cor-
responding advertising consent.
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 5. Click Save.

 6. Click Select Campaign.
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 7. Select the mailing to be send and click Select Mailing.

 8. Close the Select Mailing window and reload the Campaign Activity screen. The mail-
ing ID is now assigned to the campaign activity. 

Checking mailing content before dispatch

Check the mailing content before dispatch by sending the mailing to a Episerver Cam-
paign test list. Do the following:

Prerequisite: You must assign a Episerver Campaign test list in Microsoft Dynamics CRM. 
See Assigning Episerver Campaign test lists.
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 1. On the Campaign Activity screen, select a Episerver Campaign test list.
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 2. Click Test Message.

 3. Select the mailing you want to send to the test list.

Note: The list shows all mailings that are related to campaigns in 
the status Activation required in Episerver Campaign. You must 
know the names of the corresponding mailings. The mailing 
name does not necessarily correspond to the campaign name. 
In the case of A/B tests, mailings typically have different names 
than the campaigns.
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 4. Click Select test mailing to send the mailing.
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Starting and monitoring dispatch workflows

Starting the workflow

 1. Click Run Workflow in the campaign activity screen in Microsoft Dynamics CRM.

 2. Select Episerver: Send campaign activity to Episerver Campaign and click Add. Do not 
start the workflow Episerver: Start mailing in Episerver Campaign. This is automatically 
called by the integration.
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Contacts and leads from the marketing list are transferred to Episerver Campaign 
via the interface through Recipient packages, and the Mailing status changes from 
Planned to Transmitting.

Monitoring workflow activity

 1. In Microsoft Dynamics CRM, go to Settings > System Jobs.

 2. Under View, open My System Jobs from the drop-down list. You can see the current 
workflow status under Status Reason.
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Note: If an error is displayed under Status Reason, click the cor-
responding workflow to see details.

Sending transactional mails

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.

This topic describes how to send transaction mails in Episerver Campaign from Microsoft 
Dynamics CRM using a workflow in CRM. After sending, response data (opens, clicks) are 
automatically transferred into CRM.

Prerequisites

 l Configuration of the integration completed, see Configuration.
 l Campaign mailing prepared in Episerver Campaign.
 l The ID of the campaign mailing to be sent. You can find the ID under Transactional 

mails in Episerver Campaign. Select the column ID in the drop-down list to the right.
 l The authorization code of the recipient list used by the transactional mailing.

https://world.episerver.com/documentation/developer-guides/campaign/http-api/security/
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Configuring transactional mailings and workflows

Before sending a transactional mailing from Episerver Campaign, you need to configure 
the transactional mailing in Microsoft Dynamics CRM. You can send these mailings to 
contacts, accounts or leads even without advertising consent. You also need to define 
a workflow  to trigger the transactional mailing. 

Configuring the transactional mailing

 1. Switch to Settings > Configurations in Microsoft Dynamics CRM.

 2. Click New.
 3. Enter a name for the configuration.
 4. In the Value field, define the configuration using an XML format. The fields <authCode> 

and <bmMailingID> are mandatory.

For  <authCode>, enter the authorization code for the transactional mailing's recipient 
list. For <bmMailingId>, enter the mailing ID of the transactional mailing.

Other fields can be optionally linked, as long as the information is available in CRM.

<root>
 <authCode>authorization.Code</authCode>
 <bmMailingId>mailing.ID</bmMailingId>
 <firstname>object.firstname</firstname>
 <lastname>object.lastname</lastname>
 <salutation>object.salutation</salutation>
 </root>

When sending from another entity except contact, lead or account, a lookup ref-
erences to the connected bmRecipientId. Furthermore, data fields in contact, lead or 
account are integrated via lookups.

<root>
 <authCode> Authorisierungs-Code </authCode>
 <bmMailingId> Mailing-ID </bmMailingId>
 <bmRecipientId>object.new_exampleentityfor.emailaddress1</bmRecipientId>
 <dynamicsId>object.new_exampleentityfor.contactid</dynamicsId>
 <first_name>object.new_exampleentityfor.firstname</first_name>
 <last_name>object.new_exampleentityfor.lastname</last_name>
 </root>

You can find the name of the lookup element that is inserted between the object 
and the field name (for example, contactid) in the Fields overview. Search for the 
name of the field in which the lookup for contact, lead, or account is performed. In 
the example, the name is  new_exampleentityfor.
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 5. Click Save & Close. 

Note: The configuration can be updated and saved  if needed.
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Configuring the workflow

 1. Switch to Settings > Processes in Microsoft Dynamics CRM.

 2. Click New.
 3. Enter a name in Process name.
 4. Under Category, select Workflow.
 5. As Entity, select Contact, Lead or Company.
 6. Keep the selection Run this workflow in the background.
 7. Select New blank process, if you are not using an existing workflow as template, 
 8. Click OK.                     

 9. Under Activate As define if the workflow is to be created as process or as template.
 10. Under Available to Run, select the dependencies of the process. For manual start, 

select As an on-demand process.
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 11. Under Workflow Job Retention, define if the workflows should be automatically 
deleted after completion.

 12. Under Options for Automatic Processes, define who can start the process.
 13. Under Start when, define which action should trigger automatic dispatch. If nothing 

is selected, the dispatch is started manually in CRM.
 14. Select Add Step > Episerver Campaign > Send Transaction Mail.

 15. Click Set Properties.
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 16. In the Value column, search for and select the previously created configuration.

 17. Click Save and Close.

Checking return values of the process

You should add error handling steps, configuring how the process should handle dif-
ferent return values of incorrectly sent transactional mails. Transactional mailings are 
sent using the sendtransactionmail operation of the HTTP API. Here is an example for can-
celing an unsuccessful process.

 1. In the Process window in Microsoft Dynamics CRM, click Add Step > Check Condition.
 2. Click <condition> (click to configure).
 3. Click Select.
 4. Click Send Transaction Mail.
 5. Click Service Response in the second drop-down list.
 6. Click Does Not Begin With in the third drop-down list.
 7. Click Enter value and enter the return value enqueued.

https://world.episerver.com/documentation/developer-guides/campaign/http-api/services-and-operations/sendtransactionmail/
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 8. Click Save and Close.

 9. Click Select this row and click Add Step.
 10. Select Add Step > Stop Workflow.
 11. Select Canceled in the status drop-down list.
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 12. Click Set Properties.
 13. Click in the Value column.
 14. In the drop-down list, select Look for:> Send Transaction Mail.
 15. In the drop-down list, select Service Response.
 16. Click Add.
 17. Click OK.
 18. Click Save and Close.                 

 19. Under Process  in the menu bar, click Convert to a real-time workflow.
 20. Click Activate, and Activate in  the Process Activate Confirmation dialog box.
 21. In the Process window, click Close.
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Send out transactional mailing

The workflow is now fully created, activated and starts according to the preconfigured 
action or may be triggered manually. A transaction mailing is started manually from the 
entity specified in the process.

 1. Select Run Workflow in the entity.

 2. The Lookup Record dialog box opens. Select the workflow of the transaction mailing 
and click Add.
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 3. The dialog box Confirm Application of Workflow opens. Click OK.

Copying marketing lists

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.
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With the  Microsoft Dynamics CRM integration you can copy contacts and leads from a 
marketing list to an Episerver Campaign recipient list on a daily or weekly basis. You can 
then use this data to send welcome or birthday mailings in a Marketing Automation 
campaign.

The copying is one-way from CRM to Episerver Campaign.  Unsubscribes and out-
bounces are updated back into CRM. Other data will not be updated in CRM if 
changed in Episerver Campaign.

Prerequisites

To configure a corresponding recipient list in the relevant client, contact customer sup-
port. Furthermore, you must configure the marketing list for the copying process and start 
the workflow for automatic copying.

Note: The recipient list format is the same as  for  campaign man-
agement. If you need additional fields in your  recipient list, contact 
customer support before configuring copying of marketing lists.

Configuring the marketing list for the copying process

After the recipient list is configured, do this in Microsoft Dynamics CRM:

 1. Open the Marketing area and click Marketing Lists.
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 2. Select the marketing list to synchronize and click Edit.

 3. Click Yes in the field next to the Episerver Campaign Recipient list.
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 4. Click Yes in the field next to Transmission active.

Note: Transmission active must be set to Yes for the copying to 
start. If needed, you can  disable the copying later by setting 
the field to No, without losing the configuration.

 5. Under Advertising Consent, select the marketing permission to be used as criterion 
when selecting contacts and leads to transfer. Click the magnifying glass symbol in 
the field and select the relevant marketing permission.



© Episerver 2020

1074 | Episerver Campaign User Guide 2020-04-23

 6. In the Recipient List ID box, enter the ID of the Episerver Campaign recipient list into 
which the marketing list is to be copied.

Tip: To see the recipient list ID, open the Episerverstart menu 
and select Administration > API overview > Recipient lists.
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 7. Under Interval, select  the time interval for the copying (daily or weekly) by clicking in 
the field.

 8. When done, click the disc symbol at the bottom right to save. 

If the copying process is running successfully, the Transmission Status field will show Run-
ning. If there is an error, the status field will show Error. See Maintenance and Troubleshoot-
ing) for  error messages.
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Starting and monitoring copying workflows

Starting the workflow

 1. Click Run Workflow in the campaign activity screen in Microsoft Dynamics CRM.
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 2. Select Episerver: Send marketing list to Episerver Campaign and click Add.

Monitoring workflow activity

You can view the current status of the workflow at any time under Settings > System > Sys-
tem Jobs.

If the workflow fails, the time for Nächste Übertragung (Next Transmission) is automatically 
changed to the next day or week. To export the marketing list before the next auto-
matic export after resolving the error, click in the field next to Nächste Übertragung (Next 
Transmission) and select the date and time.
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Feeding response data to Microsoft Dynamics CRM

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.

This topic describes how to send recipient response data back to Microsoft Dynamics 
CRM, when integrating this with Episerver Campaign. By default, the response data is 
accessed hourly.

The response data includes: 

 l Mailing opened
 l Link clicks in the mailing 
 l Direct replies to the mailing 
 l Unsubscribes (opt-outs)
 l Bounced recipient email addresses

Note: To display unsubscribes (opt outs) and outbounces, the 
required fields must first be configured. See Configuring the integ-
ration.
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Unsubscribe (opt out)

When an unsubscribe is registered in Episerver Campaign, this information is transferred 
to Microsoft Dynamics. As a result, the lead or contact's advertising consent gets an 
opt-out entry in the opt-in history. If the most recent entry for an advertising consent 
according to the time stamp is an opt-out entry, the contact or lead no longer receives 
a newsletter. Furthermore, with a current opt-out entry, there will be no transmission of 
recipient data when the marketing list checks for the existence of advertising consent 
during synchronization.

If the contact or lead has given his advertising consent for more than this newsletter, all 
other subscriptions remain active.

Outbounce

Note: The display of outbounces requires the configuration of the 
field in the form. See Creating consents and linking to client.

If Episerver Campaign detects that an email is no longer reachable, the outbounce 
status is changed from No to Yes. This status applies to all advertising consents on the 
channel and across allclients – regardless of whether the outbounce was registered in 
every client.
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Opens, clicks, and direct replies

When a campaign is run, opens and clicks are imported as replies/campaign responses, 
and assigned to the campaign in CRM (saved in the campaign). The import dif-
ferentiates between these response categories:

 l Open
 l Click 
 l Reply
 l Autoresponder
 l Unsubscription

Use these categories for further segment in CRM.
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Note: Opens, clicks and replies are only imported for mailings sent 
using campaign management. Opens and clicks from a copied mar-
keting list are not returned to the CRM.

Troubleshooting and maintenance

Note: This topic is for administrators and developers with admin-
istration access rights in Microsoft Dynamics.

This topic describes how to troubleshoot and maintain the Microsoft Dynamics CRM 
integration for Episerver Campaign. The following is included:

 l Checking workflows for activity and errors.
 l Common error messages.
 l Reducing storage space used by the integration.
 l Managing divergent time stamps.
 l Service updates for Microsoft Dynamics 365 Online

Checking workflows for activity and errors

Active and running workflows are shown in the CRM settings under System jobs. You can 
apply a filter for the Episerver Campaign workflows under Entity. There are these cat-
egories:

 l API data
 l Recipient Packages
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 l Client
 l Mapping

Regularly check the Client and Recipient Packages workflows for errors. See Workflow error 
messages. 

Do the following to check workflow activity for a client:

 1. In Microsoft Dynamics CRM, open the settings and click Clients under Episerver Cam-
paign.

 2. Double click the client. The following is under Information, providing  the time of the 
last data import:

 l Last clicks date.
 l Last opens date.
 l Last responses date.
 l Last unsubscribes date.
 l Date of last bounce limit overruns.
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If one or more imports were done more than an hour ago, the workflow is no longer 
active. This can be due to insufficient resources within the CRM, or a network prob-
lem.

 3. Click Run Workflow and select the workflow to restart. If the problem persists after 
restart, contact your system administrator.
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Viewing workflow error messages

If a workflow did not run successfully, Status Reason under Settings > System > System Jobs 
shows the message Failed.

 1. Click the name of the corresponding system job to see  a detailed description of the 
error.

 2. Resolve the error.
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 3. If you are unable to resolve the error, click Details to see the trace for the workflow. 

 4. Copy the trace text and error message with the time stamp for the error, and con-
tact customer support providing the information.

Common error messages

Error message                     Description                     

The specified mailing is not assigned to the 
mandator.                     

You have selected a mailing for the campaign that is 
not assigned to the same client as the selected mar-
keting permission.                     

The number of flat recipient field values (57) 
is not a multiple of the number of recipient 
field names (18).                     

The configuration of the fields to be transferred does 
not match the recipient list fields of the Episerver 
Campaign client.                     

Reducing used disk space

Reducing used disk space is optional. The integration operation will not be affected if 
this is not done. However, you will save storage resources and have a better overview of 
workflows.

The following options are available:
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 l Delete recipient packages no longer required.
 l Delete completed workflow jobs.

Deleting recipient packages no longer required

 1. In Microsoft Dynamics CRM, open Settings and click Recipient Packages under 
Episerver Campaign.

 2. Click the  arrow next to Active Episerver Campaign Recipient Packages. 

 3. In the drop-down list, select Old Episerver Campaign Recipient Packages.

 4. Select the recipient package to delete and click Delete. 

Deleting completed workflow jobs

By default, Microsoft Dynamics keeps completed workflow jobs. To configure auto-
matic deletion of completed workflow jobs, do the following:

 1. Open the settings and click Processes under Process Center.
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 2. Click the arrow next to the title. 

 3. In the drop-down list, select the corresponding option, such as Activated Processes.

 4. Click the workflow for which the job should be automatically deleted after com-
pletion. 

 5. Under Workflow Job Retention, select Automatically delete completed workflow jobs (to 
save disk space).
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Note: To select the check box you may have to deactivate the 
workflow for a short period. When you have selected the check 
box, reactivate the workflow.

 6. Click Close. 

Managing divergent time stamps

The behavior of the date fields in Microsoft Dynamics CRM can lead to divergent time 
stamps in CRM and Episerver Campaign. When using date fields with time spe-
cifications, use the User Local field type, as this will consider the time zone set for the 
user during data synchronization. 

Do the following to check the data format in the field settings:
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 1. In Microsoft Dynamics CRM, locate the affected date and time field.

 2. Edit the field, and check the properties to see if the field is defined as User Local.

If the field is defined as Time-Zone Independent, it will not consider the time zone set 
in CRM. Episerver Campaign, will convert the  time  for display to the time zone of the 
user, so that deviations may occur. 

Once the field has been saved in CRM as Time-Zone Independent, it can no longer 
be changed. In this case, the field should be deleted and recreated.
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Service updates for Microsoft Dynamics 365 Online

Microsoft releases service updates for Microsoft Dynamics 365 Online on different 
times without an announcement. Service updates might affect the functionality of 
the Microsoft Dynamics CRM integration for Episerver Campaign. Episerver cannot 
exclude possible malfunctions in advance. For more information about service 
updates, see Microsoft Support.

Translation interface

Note: To enable this feature, contact customer support.

The semi-automatic translation interface for Episerver Campaign lets you  create and 
send mailings in multiple languages. You select the mailing, source and target lan-
guage, order the translation and Episerver Campaign notifies you as soon as the mailing 
is ready for dispatch in the desired language versions. 

How it works
Episerver Campaign creates an XML file with the content for translation and sends it via 
email to the translation service provider you specified. 

When the translation is ready, Episerver Campaign generates a new mailing from it in 
the target language. As soon as all requested language versions are available, the mail-
ing can be sent.

Setup
Episerver customer support sets up the translation interface for you. Provide the following 
information:

 l Users who are to access the translation interface
 l Email address to which translation orders are to be sent. This can be a translation 

agency or a colleague from your company.

Tip: You can specify a different email address for each lan-
guage.

https://support.microsoft.com/en-us/help/2925359/microsoft-dynamics-crm-online-releases
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Ordering translations
 1. Open the start menu and select Special > Mailing-Übersetzung starten (Start mailing 

translation).
 2. Under Mailing, select the desired mailing.
 3. Select the source and the target language. Use multiple selection (CTRL + left 

mouse button) to select multiple target languages.

Tip: You can add a comment to your translation order and spe-
cify, for example, whether and how image names and URL 
addresses are to be translated.

 4. Confirm the order by selecting the check box.
 5. Click Übersetzung starten (Start translation). Episerver Campaign sends an email with 

the content to be translated to the translation agency. The XML file contains inform-
ation about the source language and the target language.

 6. The translation service provider sends back an email with the translated texts.         The 
service provider must enter the translations in the XML file sent by Episerver Cam-
paign and return it to Episerver Campaign as an email attachment.

 7. Episerver Campaign checks the translation for formal correctness and com-
pleteness.         If errors occur, the process is terminated and an error message is sent to 
all parties. If the translation is technically correct, the original mailing is copied and 
all text modules are exchanged for the new texts in the XML file.

 8. The persons in charge specified by you receive a success message and the trans-
lated mailing is ready for dispatch.
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Tip: If your recipient list contains information about the lan-
guage of the recipients, you can control the recipients of the 
respective language version using a recipient data-based target 
group.

Closed-loop interface

The Closed-loop interface is used for bi-directional handling of actions and data 
exchange between Episerver Campaign and external systems. 

Installation
Contact Episerver customer support regarding setup of the Closed-loop interface, and 
terms and conditions that apply when accessing this type of non-anonymized action-
based data.

Tip: Because the response data consists of non-anonymized 
action-based data, you have to indemnify and hold Episerver harm-
less in advance from any potential liabilities and third-party claims 
which may result from making this functionality available to you.

How it works 
The external system (the customer's system integrated with Episerver Campaign) auto-
matically triggers mailings in Episerver Campaign. Action-based mailing data is logged 
in Episerver Campaign and returned to the external system. This response data can be 
further  processed within a third system, for example a data warehouse.

The Closed-loop interface consists of these modules: 

 l The import module automatically transfers recipient data like product recom-
mendations from for example a data warehouse system, to Episerver Campaign, 
and automatically triggers mailings. 

 l The response data export module transfers action-based mailing data such as open-
ings, clicks, responses, unsubscribes, back to an external system. 

The interface modules  can be configured and used independently of each other.
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A service processes received data within Episerver Campaign. When a file is stored on 
the server, various jobs are being executed: Recipients are imported, mailings are cre-
ated and sent, and a status notification is sent. The response data export module is 
responsible for the return channel. This module exports statistical data to the customer's 
system. The log data can be integrated into the data warehouse.



© Episerver 2020

1094 | Episerver Campaign User Guide 2020-04-23

Exchanging data 
The data exchange is done using an SFTP server set up at Episerver, and recipient data is 
transferred to that server. Response data is available for download from the same 
server. 

Running transfers must have a temporary file name to avoid incomplete file exchange, 
see Data transfer troubleshooting. Naming conventions are described below.

Note: The data exchange does not respect strict separation of cli-
ents. All user data can be transferred through one SFTP account. 
You can set up client-specific SFTP accounts  if required for security 
reasons. Alternatively, you can set up separate sub-directories in 
one client. In both cases, the recipient data import module must 
then commit one file per client/directory.

Transferring recipient data
Recipient data can be transferred at any time to  the Episerver Campaign SFTP server as 
previously described. 

The name convention of the transferred files must be as follows:

YYYYMMDDHHMMSS_subscribers.csv

The recipient file is a CSV file with the following properties:

 l Phrase and field lengths are variable within the limits of the recipient list.
 l A semicolon (;) is used as separator.
 l Line feed is used for line breaks.
 l Quotation marks ("") are used as field boundaries. To designate quotation marks 

within a field, wrap them in quotation marks.
 l The file does not contain declarations regarding columns and field lengths.
 l Empty fields (NULL) remain empty in a data set. The number of field separators must 

be constant.

Recipient data is processed automatically every 10 minutes. The SFTP server of Episerver 
Campaign provides log files for download within 30 days after creation.

Note: According to the specifications, fields of the main recipient 
list must be committed. Fields supposed to not contain any value 
are committed as empty columns. Existing fields and the field 
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sequence are fixed. Do not change them without the consent of 
both parties.

Using personalization and recommendations
It is possible to enhance the delivered recipient data with personalization, for example 
by adding product recommendations to the mailing.

One or more fields reserved for a product ID are added to the CSV file with the recipient 
data. Product information (such as title, description, image-URL) for  recommended 
products is transferred in a second CSV file. Product information is inserted into the mail-
ing using field functions and a placeholder. Assigning product IDs to recipients is done 
by the customer.

With web analysis software, recommendations are available via a CSV file.  Other recom-
mended products are assigned to each product. Product information is rendered into 
the mailing using a special field function, similar to the process described above. You 
do not need to assign products to a recipient, as this is automatically done by the  web 
analysis software in accordance with the initial configuration.

Note: To add personalized content, you need a new template. 
Contact customer support.

Creating source mailings and sending mailings
As a basis for the campaign you are going to send, a source mailing has to be created.  
A so called Master List serves as recipient list for the source mailing. Placeholders ref-
erencing a specific field of the recipient list are inserted into the mailing paragraphs. 
Using these placeholders you can individually assign and insert product data and other 
information into the mailing. 

To send multiple newsletters, or send newsletters at the same time, you have to create 
multiple source mailings. The source mailing is never sent and must remain in status New 
or respectively Activation required. Do not activate the mailing, otherwise the copy can-
not be created. Instead the system automatically creates a copy of it and  sends that, 
so  the source mailing can be reused.

When a file containing recipient data is stored in the corresponding directory on the 
SFTP server, the mailing is sent. Every 10 minutes, a Cron job checks this directory for new 
files. If a new file exists, it is imported into the recipient list of the corresponding client, 
and assigned to the source mailing using the parameter BROADMAIL_ID. 

There are different ways to add content to a mailing:
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 l Directly from the file. The content is imported along with the recipient data in a CSV 
file. This method is only applicable for texts and hyperlinks.

 l Referenced content. URLs in the imported CSV files are used to reference the con-
tent. When sending the mailing, the content is retrieved from the external server of 
the customer through the content interface. You can add   texts, pictures, attach-
ments, and hyperlinks types of content to a mailing.

When the data is imported, the mailing is automatically sent, and gets a unique ID.

You can send test emails using the Closed-loop interface by storing test data  instead of 
real  data on the server. The CSV file must have the same structure as the file containing 
the real recipient data. Every time a test email is sent, a new mailing is created in 
Episerver Campaign.

Note: Mailings are triggered only by storing a file on the server con-
figured for the Closed-loop interface. You cannot send mailings by 
using the Episerver Campaign user interface.

You can customize the source mailing for different newsletters. Only change the source 
mailing after the previous mailing is sent. Additionally, ensure that the correct mailing ID 
of the source mailing is used in the recipient CSV file.

Troubleshooting data transfer
If a problem occurs transferring the data, a notification is sent to an  email address con-
figured beforehand. An error file is generated and the transfer stopped. During imple-
mentation you can configure the exact interface behavior  in case of an error. When 
the implementation is completed, you can switch off this setting.

If an error occurs, the interface must be restarted in accordance with the error file. 
These are the cases:

 l Data import failed.
 l Error when mailing is started after data import.

Errors during data transfer are handled by customer support, since these can only be 
resolved manually.

Monitoring and sending status
After a recipient data import, the status of the process  is sent via email and registered in 
a log file. This assures that actions within the interface are properly logged and doc-
umented in Episerver Campaign.

Structure of the main recipient list
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Column 
name

Data type Example Remarks

Email                     Varchar
(255)                     

user@example.com Email address of the user.                     

broadmail_
ID                     

Bigint/Long
                     

44018617811 Mailing ID in Episerver Campaign (broadmail_ID).
                     

WAVE_ID                     Bigint/Long
                     

46623317811

Identifies the selection/sending wave for unam-
biguous assignment of user actions. This para-
meter is optionally set by the external system 
when importing the recipient data.                     

Salutation                     Varchar
(255)                     Field from existing recipient list.                     

First name                     Varchar
(255)                     Field from existing recipient list.                    

Last name                     Varchar
(255)                     Field from existing recipient list.                     

Note: The list configuration described above is an example. More 
fields can be added if required for personalization purposes. 
Contact customer support beforehand, and document them in the 
interface setup.

Specifying response data
Response data is generated daily from the log files, and is available for download at a 
configured time via an SFTP server within Episerver Campaign. The files contain the most 
recent data. The files containing the mailing data are available for download for 30 
days after starting the mailing. 

The response data consists of 7 CSV files. Each of these can be read as a table as 
described in the following  entity relationship (ER) diagram. See detailed type inform-
ation  for each file below.

Note: File names can be configured. The names used in the fol-
lowing sections are examples.
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Sent mailings
YYYYMMDD_mailings.csv contains mailings sent in the referenced period.

Column name Data type Example Remarks

id                     Bigint/Long
                     

51106527229 Mailing ID in Episerver Campaign

mailingGroupId Bigint/Long 44018617811 Client ID in Episerver Campaign (broad-
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Column name Data type Example Remarks

mail_ID)

started                     DateTime                     2007-10-24 
12:07:55 Start time of the mailing                     

finished                     DateTime                     2007-10-24 
12:09:55 End time of the mailing                     

Sending Log
YYYYMMDD_mailingrecipients.csv contains recipient-related data. The sending log refers 
to the mailings contained in the file YYYYMMDD_mailings.csv.

Column name Data type Example Remarks

mailingId                     Bigint/Long
                     

51106527229 Mailing ID in Episerver 
Campaign

userId                     Varchar
(255)                     

user@example.com Email address of the 
recipient                     

created                     DateTime                     2007-10-24 12:07:55 Sending date                     

response.category
                     

Varchar
(20)                     

 l unknown – The recipient sent a 
response to the mailing.

 l bounce – Soft bounce
 l temporary_bounce – Soft 

bounce
 l fatal_bounce – Hard bounce
 l autoresponder – Autorespon-

der

Delivery status                     

Links
YYYYMMDD_links.csv contains links from the mailing. Data is only available for links with 
activated link tracking.
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Column name Data type Example Remarks

mailingId Bigint/Long 51106527229 Mailing ID in  Episerver Campaign

id Bigint/Long 44018617936 Link ID in  Episerver Campaign

Name                     Varchar(255) Imprint Name of the link

url Varchar(255) http://www.example.com Link target (URL)

Clicks
YYYYMMDD_clicks.csv contains mailing clicks generated by recipients, within the ref-
erenced period. Clicked links/URLs can be found in the file YYYYMMDD_links.csv.

Column name Data type Example Remarks

mailingId                     Bigint/Long                     51106527229 Mailing ID in Episerver Campaign

userId                     Varchar(255)                     user@example.com Email address of the recipient                     

linkId                     Bigint/Long                     44018617936 Link ID in Episerver Campaign

created                     DateTime                     2007-10-24 12:07:55

Date and time of the click.                         

Note: There 
can be mul-
tiple clicks 
from one 
recipient 
within one 
second.

Opens
YYYYMMDD_opens.csv contains mailings opened by recipients  in the referenced period.
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Column 
name

Data type Example Remarks

mailingId                     Bigint / 
Long                     

51106527229 Mailing ID in Episerver Campaign

userId                     Varchar
(255)                     

user@example.com Email address of the recipient                     

created                     DateTime                     2007-10-24 
12:07:55

Time and date when the mailing was opened by 
a recipient.                         

Note: One recipient can 
open a mailing several 
times. In this case, each 
opening generates a sin-
gular data set.

Unsubscribes
YYYYMMDD_unsubscribes.csv contains unsubscribes by recipients in the referenced 
period.

Column name Data type Example Remarks

mailingId                     Bigint/Long                     51106527229 Mailing ID in Episerver Campaign

userId                     Varchar(255)                     user@example.com Email address of the recipient                     

created                     DateTime                     2007-10-24 12:07:55 Date and time of the unsubscribe                     

Responses
YYYYMMDD_responses.csv contains emails  returned to the sender address from any user 
within the referenced period.

Column name Data type Example Remarks

mailingId                     Bigint/Long 51106527229 Mailing ID in Episerver Campaign.                      
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Column name Data type Example Remarks

mailingToUserId
                     

Varchar
(255)                     

25951836752 Encoded assignment of the recipient.                     

userId                     Varchar
(255)                     

user@example.com Email address of the recipient.                     

category                     Varchar
(20)                     

 l unknown – The 
recipient sent 
a response to 
the mailing.

 l bounce –  Soft 
bounce.

 l temporary_
bounce –  Soft 
bounce.

 l fatal_bounce –  
Hard bounce.

 l autoresponder –  
Autorespon-
der.

Delivery status.                     

created                     DateTime                     2007-10-24 12:07:55 Date and time of the response.                     

Transferring files through SCP

This topic describes options for transferring data files to an Episerver server. This data 
exchange  is needed  for various integrations of external systems with Episerver Cam-
paign.

To upload or download files securely between your computer and the Episerver server, 
you use  Secure Copy Protocol (SCP), which protects data from third-party access dur-
ing transmission. 

To use SCP, you install an SCP program on your computer, then provide access data for 
the server and an authentication key. After establishing an encrypted server con-
nection, you can securely exchange files.
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These options are available:

 l Configuring SCP transfer for macOS/OS X
 l Configuring SCP transfer for Windows

Configuring SCP for macOS/OS X
This topic explains how to configure and use secure encrypted data transfer with 
macOS (previously OS X) via Secure Copy Protocol (SCP). File transfer is often needed 
for data exchange when integrating external systems with Episerver Campaign.

Configuration steps
 1. Creating a key pair
 2. Downloading and installing Cyberduck
 3. Downloading and installing Cyberduck
 4. Establishing an SCP server connection
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Step 1: Creating a key pair

 1. From the Utilities folder, open Terminal.

 2. Enter ssh-keygen and press Enter.

 3. Enter a file path and file name for the key pair. For example, to save the key pair to 
your desktop in a file called key, enter /Users/<name of your user folder>/Desktop/key. 
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Press Enter to confirm.

By default, Terminal suggests the hidden .ssh folder in your user folder as the file loc-
ation, and the id_rsa as the file name. Unless changed, the key pair is saved in that 
directory using that file name. The private key is given the id_rsa file name, while the 
public key is assigned the .pub extension. In this example, the public key name is id_
rsa.pub.

Note: To see the name of your user folder, click Go>User folder in 
the MacOS Finder menu. Finder opens a window with the user 
folder name  at the top.
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 4. In the Enter passphrase dialog box, enter your password (not visible).

Note: Remember your password, you need it later to establish a 
server connection.

 5. Re-enter your password and press Enter.
 6. The key fingerprint is shown in the Terminal window following The key fingerprint is:. 

Copy the key fingerprint to a text document and save it.
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Step 2: Configuring a user account for SCP access

 1. Email your public key (file with .pub extension) to Episerver customer support.
 2. In a  separate email, send your key fingerprint to Episerver customer support.

Note: For security reasons, do not send the public key and key 
fingerprint  together.

 3. Episerver customer support configures the account, and sends you an email with 
your user account data.

Step 3: Downloading and installing Cyberduck

Cyberduck is a free program used for establishing a connection to the server.

 1. Using a browser, go to https://cyberduck.io.
 2. Click Download Cyberduck for Mac.
 3. When the download finishes, open the folder with Cyberduck. No specific install-

ation is required.
 4. Optional: move Cyberduck to a permanent folder, such as Programs or Utility pro-

grams.

Step 4: Establishing an SCP server connection

 1. Open Cyberduck.
 2. To create a bookmark for connecting to the server, click the plus icon + at the bot-

tom. 

https://cyberduck.io/
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 3. Click the top options menu and select SFTP (SSH File Transfer Protocol).
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 4. Fill out the information as follows.

 l Nickame: Enter a name to the bookmark.
 l Server: Enter the address ftpapi.campaign.episerver.net.
 l Username: Enter name as provided by Episerver.
 l Open More options and enable Use Public Key Authentication.
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 5. Go to your private key folder and select the private key.

Note: Do not confuse the private key with the public key. For 
the Use Public Key Authentication option,  use your private key.

 6. Click Choose on the bottom-right.
 7. Close the bookmark configuration dialog box by clicking the red close button. 
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 8. To establish a server connection, double-click the saved bookmark.

 9. When  prompted for a password, enter the one from Step 1: Creating a key pair. 

Configuring SCP for Windows
This topic explains how to set up secure file transfer via Secure Copy Protocol (SCP) for 
Windows using WinSCP. File transfer is often needed for data exchange when integ-
rating external systems with Episerver Campaign.

Configuration steps
 1. Downloading and installing WinSCP
 2. Creating a key pair
 3. Transmitting keys to Episerver
 4. Establishing a WinSCP connection

Step 1: Downloading and installing WinSCP

 1. Click http://winscp.net/eng/download.php.
 2. Click Download.
 3. Run the setup program.

http://winscp.net/eng/download.php
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Step 2: Creating a key pair

 1. Run the PuTTYGen program (part of WinSCP).

 a. Parameters: Select RSA (Episerver only supports RSA).
 b. Number of bits in a generated key: Enter 2048.
 c. Click Generate.

 2. Make random computer mouse movements across a gray field to generate key val-
ues. A progress bar  indicates the progress.
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When generation is completed, the keys are displayed.
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 3.  Fill in the fields as follows: 

 a. Key comment: Enter a description such as "Episerver Campaign-<your_com-
panyname>".

 b. Key passphrase: Enter a password. For security reasons, use at least an eight-digit 
word containing letters, numbers and special characters.

 c. Confirm passphrase. Enter the password again.
 4. Click Save public key.
 5. Click Save private key.
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Step 3: Transmitting keys to Episerver

 1. Copy the public key and email it to Episerver customer support. 
 2. Copy the key fingerprint and email it separately to Episerver customer support.

Note: For security reasons, do not send the public key and key 
fingerprint  together.

 3. Episerver sends a confirmation when your SCP (Secure Copy Protocol) access is act-
ive. 

Note: Protect your keys from unauthorized access. If lost, imme-
diately contact Episerver and generate a new key pair as 
described above.
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Step 4: Establishing a WinSCP connection

 1. Launch the WinSCP program.
 2. In the login window, click New Site.

 3. Fill out the information as follows.

 l Host name: Enter ftpapi.campaign.episerver.net.
 l User name: Enter name as provided by Episerver.

 4. Click Advanced...
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 5. Select Environment > SFTP and enable Allow SCP fallback.

 6. Select SSH > Authentication, click Browse (...) in Private key file and select the pre-
viously generated private key.                 
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 7. Click OK.
 8. Click Save, enter a name for the connection, and click OK.
 9. In the WinSCP login window, select the connection name and click Login.

Real-time export of event data via webhooks 
(Beta)

This topic describes how to manage webhooks using the REST API documentation on 
Episerver World to export event data in real time. As soon as a user performs an action, 
such as opens or clicks, you immediately receive the corresponding event data.

https://api.campaign.episerver.net/apidoc/index.html#/Webhooks
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Using the Episerver Campaign REST API, you can create webhooks, retrieve webhook 
information, activate, deactivate and delete webhooks.

Creating a webhook
Prerequisite: You must set up the REST API in your client. See REST API on Episerver World.

 1. Open the operation Create a webhook and click Try it out.

 2. Enter the following information in the corresponding mandatory fields:

 l clientID. Your client ID. To see the client ID, open the start menu and select 
Administration > API overview > REST API.

 l targetUrl. The URL to which the event data is to be sent.

Prerequisites:

 o URL must be accessible and able to receive data via HTTP POST requests 
from the IP address 193.169.180.1 at any time

 o current HTTPS version and standard port 443 for HTTPS connections

 l type. The type of the event data to be sent.

Note: Real-time export of event data is currently possible for 
opens and clicks.

 l format. The data format in which the event data is to be sent.

Note: The following data format is currently available: JSON.

https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://api.campaign.episerver.net/apidoc/index.html#/Webhooks/createWebhook


© Episerver 2020

1120 | Episerver Campaign User Guide 2020-04-23

 3. To create the webhook, click Execute. If the creation was successful, you receive 
the HTTP response status code 201.

 4. To retrieve information of the created webhooks, execute the operation Get inform-
ation about all webhooks.

You can find the following information in the Response body:

 l id. Webhook ID
 l type. Type of the event data
 l status. Webhook status
 l format. Data format of the event data
 l created. Creation date of the webhook
 l modified. Modification date of the webhook

https://api.campaign.episerver.net/apidoc/index.html#/Webhooks/selectWebhooks
https://api.campaign.episerver.net/apidoc/index.html#/Webhooks/selectWebhooks
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Tip: You need the webhook ID for activating, deactivating and 
deleting the webhook.

Activating a webhook
To export event data in real time, you must activate the corresponding webhook. Do 
the following:

 1. Open the operation Activate a webhook and click Try it out.

 2. Enter the following information in the corresponding mandatory fields:

 l clientID. Your client ID. To see the client ID, open the start menu and select 
Administration > API overview > REST API.

 l webhookId. The ID of the webhook you want to activate. You can retrieve the 
webhook ID with the operation Get information about all webhooks.

https://api.campaign.episerver.net/apidoc/index.html#/Webhooks/activateWebhook
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 3. To activate the webhook, click Execute. If the activation was successful, you 
receive the HTTP response status code 200.

As soon as a mailing recipient performs an action, Episerver Campaign sends the cor-
responding event data via a HTTP POST request to the target URL. The event data is sent 
in batches consisting of a maximum of 100 events each.

Note: After successful data receiving, the target URL must return 
the HTTP response status code 200. Otherwise the export is retried 
every 10 seconds. If no data can be delivered three days after the 
event is created, the event is discarded.

Example of event data (opens) in JSON format:

{
   "type":"open",
   "recipientId":"123456789005",
   "userListId":123456789003,
   "remoteAddress":"0.0.0.0",
   "clientId":123456789001,
   "mailingId":123456789004,
   "created":1564590054000,
   "subscriptionId":1234567,
   "mailId":"3IHQ2XT8-38PY7WFQ-XKNQSY",
   "device":"desktop",
   "operatingSystem":"Windows 10",
   "browser":"Firefox 64.1"
 }

Deactivating a webhook
If you no longer want to export event data, you must deactivate the webhook. The web-
hook still exists and you can reactivate it later. Do the following:
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 1. Open the operation Dectivate a webhook and click Try it out.

 2. Enter the following information in the corresponding mandatory fields:

 l clientID. Your client ID. To see the client ID, open the start menu and select 
Administration > API overview > REST API.

 l webhookId. The ID of the webhook you want to activate. You can retrieve the 
webhook ID with the operation Get information about all webhooks.

 3. To deactivate the webhook, click Execute.

Deleting a webhook
For example, if you no longer need a webhook or want to create new webhooks, but 
the creation limit per client is reached, you can delete webhooks. Do the following:

Note: You can only delete deactivated webhooks. See Deactiv-
ating a webhook.

https://api.campaign.episerver.net/apidoc/index.html#/Webhooks/deactivateWebhook
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 1. Open the operation Delete a webhook and click Try it out.

 2. Enter the following information in the corresponding mandatory fields:

 l clientID. Your client ID. To see the client ID, open the start menu and select 
Administration > API overview > REST API.

 l webhookId. The ID of the webhook you want to activate. You can retrieve the 
webhook ID with the operation Get information about all webhooks.

 3. To delete the webhook, click Execute.

API overview

The API overview provides access to specific data like URLs, IDs and authorization codes 
required when integrating Episerver Campaign using for example REST and SOAP APIs.

To open the API overview, open the start menu and select Administration > API overview.

See also API documentation on Episerver World:

 l REST API
 l SOAP API

https://api.campaign.episerver.net/apidoc/index.html#/Webhooks/deleteWebhook
https://world.episerver.com/documentation/developer-guides/campaign/rest-api/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
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 l HTTP API
 l SMTP API

Information in the API overview

REST API
The ID of the client you are logged in to and a link to the REST API user guide.

SOAP API
The ID of the client you are logged in to and a link to the SOAP API user guide.

HTTP API
Here you find a link to the HTTP API user guide with more information and examples.

Post-click tracking
 l Standard basic URL. The default URL for the tracking of post-clicks.
 l User event basic URL. The URL for the tracking of post-clicks that are not related to a 

mailing.

Recipient lists
Overview of the recipient lists in your client, and information required for the HTTP and 
SOAP APIs. 

You can also manage authorization codes for recipient lists:

 1. Select a recipient list in the listing.
 2. Click Manage authorization codes. 

https://world.episerver.com/documentation/developer-guides/campaign/http-api/
https://world.episerver.com/documentation/developer-guides/campaign/smtp-api/
https://world.episerver.com/documentation/developer-guides/campaign/REST-API/
https://world.episerver.com/documentation/developer-guides/campaign/SOAP-API/
https://world.episerver.com/documentation/developer-guides/campaign/http-api/


© Episerver 2020

1126 | Episerver Campaign User Guide 2020-04-23

 3. Click Create authorization code to add a new code for the recipient list. Or, select an 
authorization code in the list and click Deactivate authorization code, to deactivate 
it.

Target groups
Target groups are available in your client, with information required for the HTTP and 
SOAP APIs.

Opt-in processes
Opt-in processes are available in your client, with information required for the HTTP and 
SOAP APIs.

Special mailings
Special mailings are available in your client, with information required for the SMTP API.
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Service and support

This section provides contact details of the Episerver customer support if you have any 
questions or problems. You can also find out about Episerver's wide range of services 
such as training or the full-service dispatch.

 l Customer support. Contact details of the Episerver customer support.
 l Full-service dispatch. Mailing dispatch by Episerver.
 l Trainings. Recorded video trainings and individual trainings.

Customer support

Your coun-
try

Product Email Telephone Availability

Germany, 
Austria, 
Switzerland

Episerver 
Campaign campaignsupport@episerver.com

+49 (0)30-76 80 
78 400                     

Monday to 
Friday, 9 
a.m. to 6 
p.m. (CET)

Any other

support@episerver.com See the support portal

All others Any

Full-service dispatch

If you want to send mailings to your customers at regular intervals but do not have time 
to import new recipients, create new mailing content, and run a quality check before 
sending a mailing, use Episerver's full-service mailing dispatch. Supply Episerver with 

mailto:campaignsupport@episerver.com
mailto:support@episerver.com
https://support.episerver.com/hc/en-us


© Episerver 2020

1128 | Episerver Campaign User Guide 2020-04-23

addresses, the latest content, and your newsletter template, and Episerver takes care 
of the rest, including reporting after the process is finished. To ensure quality, Episerver 
sends a test mailing for your approval prior to the actual dispatch.

And, you can use the layout for subsequent newsletters – just supply Episerver with 
updated content. 

Needed information
Episerver needs the following information to generate a full-service mailing dispatch:

 l Recipient data and test recipients as a CSV file (containing at least an email address)

 o For a personalized mailing, include a salutation or title, first and last name, and 
other desired criteria.

 o If target groups are being used, include supplementary columns (for example, 
only distribute to recipients who specified "mobile device" when registering, or 
addresses whose code that starts with 49)

 l Newsletter template as an HTML file or graphic.
 l Subject line for the mailing.
 l Sender (such as Your Company Product News) and return address (such as news-

@example.com).

Note: You need to delegate the sending domain to Episerver 
beforehand. This can take up to 72 hours;Episerver cannot con-
trol the time required. Also, you cannot use a domain del-
egated to Episerver for any other purpose (for example, as a 
log-in page), because the selection would produce no 
response. If you cannot delegate a sending domain, contact 
customer support.

 l Email address for replies.
 l Current content, where it differs from the template.
 l Planned dispatch date.

To avoid complaints about unsolicited emails, observe these  guidelines:

 l You received an opt-in for all addresses, confirming the recipients' desire to receive 
promotional emails.

 l Episerver may require confirmation of this approval.

https://www.episerver.com/products/platform/campaign/domaindelegation/
https://www.episerver.com/products/platform/campaign/domaindelegation/
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Lead time
Plan sufficient lead time to ensure that you can send mailings on schedule. When 
Episerver has all necessary information, Episerver creates a timetable containing:

 l Date for sending a test mailing
 l Date by which correction requests must be submitted
 l Date by which corrections are incorporated and a second test mailing is sent
 l Date by which mailing must be approved
 l Date for sending actual mailing

Allow approximately five working days to evaluate the test mailing, incorporate cor-
rection requests, and provide final approval.

What Episerver does for you
After you supply Episerver with information and the planned sending date, Episerver 
does the rest. This includes:

 l Scheduling. Sends you a schedule showing when

 o the mailing is ready for testing
 o your correction requests must be submitted
 o corrections are incorporated
 o your final approval is needed

 l Address check. Checks for problem addresses before  importing recipients. If a sig-
nificant number of addresses may be a problem, Episerver contacts you.

 l Importing addresses. Compiles a recipient list that matches your address list, then 
imports recipients.

 l Creating the mailing. Creates a multi-stage mailing based on your newsletter tem-
plate. Any graphics included in the template increase your cost. So, it is best to 
include graphics as HTML files in the newsletter template.

 l Modifying content. Incorporates the new text and images if current mailing content 
differs from the template.

 l Testing and quality control. Tests mailing before it is sent to test recipients. Episerver 
checks whether major providers and freemailers (T-Online, web.de, GMX , and so 
on) deliver the mailing to intended in-boxes, or if spam filters catch any of them, 
and whether the contents are displayed correctly.

 l Sending test emails. When your mailing passes quality control, it is sent to the sup-
plied test recipients. You screen the content one last time. After that, either send 
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Episerver your correction requests, or notify Episerver by email your approval of the 
mailing.

 l Incorporating corrections. Incorporates your changes into the mailing and sends it to 
test recipients a second time.

 l Mailing to a distribution list. When Episerver receives your final approval, the mailing is 
sent to recipients on the distribution list as scheduled.

 l Sending report. Within two work days of the sending date, you receive an initial 
report containing the following information (in both diagrams and data). You get a 
final report within ten work days.

 o Recipients
 o Emails opened

 n unique opens
 n opens over time

 o Opening rate (%)
 o Clicks

 n unique clicks
 n clicks over time
 n total clicks by link

 o Click-rate (%) and effective unique click-rate (%)
 o Number of returned emails and returned email rate (%)
 o Number of unsubscriptions and unsubscribe rate (%)

Trainings

Let the professionals educate you - live or via recorded video training. Episerver offers a 
range of regular and customized training formats aimed at both beginners and exper-
ienced users. If you would like individual training, please contact customer support.
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Individual trainings

Web-based
With an individual, web-based training you will learn how to use the software in a very 
short time. The training courses are held for up to five participants with the help of the 
web learning software Zoom. Episerver uses realistic scenarios to teach the basic func-
tions of Episerver Campaign. If you would like to add more topics to the training, you 
can discuss the content with the trainer in advance and make an appointment.  The 
training courses last from one and a half hours to a maximum of two hours. The par-
ticipants need a telephone and Internet access for the briefing.

On-site
This training format is suitable for getting to know the software intensively and for con-
veying special scenarios. Episerver develops a training program with tasks and gives an 
intensive introduction into the use of Episerver Campaign. The standard modules 
include recipient import and administration, creating and sending mailings, creating 
and interpreting reports.  On request, we can integrate content and exercises into the 
training that correspond to your specific application scenarios. After the training, all par-
ticipants receive handouts. The training is designed for a maximum of five participants. 
Premises, a projector, a computer for the trainer and, if possible, one computer for 
each participant (all computers must have an Internet connection) are provided by 
you.





Episerver Customer-Centric Digital
Experience Platform (DXP)™

The Episerver Customer-Centric Digital Experience Platform (DXP)™ unifies digital content,
commerce and marketing in one platform, including omnichannel solutions for intelligent cam-
paigns. The platform uses artificial intelligence and behavioral analytics to deliver personalized
experiences everywhere. With our secure, reliable platform you can quickly increase engage-
ment, revenue and productivity, while getting the fastest time to value.

About Episerver
At Episerver, we believe digital transformation is a journey. We have been guiding customers for
more than 20 years in providing standout digital experiences. Today our network of 880 partners, in
30 countries, supports 8,000 customers and over 30,000 websites. Founded in 1994, Episerver has
offices in the US, UK, Sweden, Australia, Germany, Denmark, Finland, Norway, Poland, the Neth-
erlands, Spain, South Africa, Singapore, Vietnam and the UAE.

For more information, visit episerver.com.
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https://www.episerver.com/
https://www.episerver.com/

	Basics
	Introduction
	Features, licenses and releases
	Images and screenshots
	Notes
	Copyright notice
	What's new?

	Getting started
	What is a campaign?
	Setting up Episerver Campaign
	Creating a simple campaign
	More features

	Log in and out
	Activating the user account
	Login
	Logout

	Menu bar
	Start menu
	Current mailings

	Lists and folders
	Customizing the list view
	Exporting records
	Updating lists
	Modifying elements
	Printing lists
	Using folders

	Users
	Managing users by clients
	Managing clients for users
	Revoking user permissions for a client

	Permissions
	Roles
	Creating a role
	Editing a role
	Deleting a role
	Showing usages

	Clients
	Client hierarchy
	Single versus multiple clients
	Client setup
	Setting up sub-clients and additional clients

	Deliverability basics
	Delivery vs. deliverability
	Key figures of deliverability
	Marketing opt-in
	Sender reputation
	Email authentication
	List management and hygiene
	Deliverability best practices
	Email content best practices
	CSA guidelines
	IP warming
	Email authentication and encryption

	Exclusive IP addresses
	ISO 27001 certification
	Episerver Campaign's safety management
	Your advantages
	What does ISO/IEC 27001:2013 mean?
	Who certifies all this and how is the process conducted?

	Service description
	Omnichannel marketing
	Episerver Campaign management
	Content management
	Segmentation
	Analysis tools
	Integrations and additional functions
	Dispatch and deliverability
	Security and availability
	Recipient management
	System user and permission management
	User interface
	Service


	Campaigns
	Smart Campaigns
	Campaigns and messages
	Campaign type
	Campaign status
	Actions
	Creating and editing a campaign
	Smart Campaigns nodes
	Editing message content

	Omnichannel campaigns
	Mobile Push
	SMS

	Marketing Automation
	Marketing Automation campaigns for a better customer engagement
	Marketing Automation packages (only DACH)
	Creating and editing a campaign
	Marketing Automation nodes
	Campaign report
	Marketing Automation guide

	Transactional mails
	Transactional mails overview
	Creating a transactional mail
	Editing a transactional mail

	Confirmations
	Selecting a media type
	Viewing status
	Registration confirmation actions
	Opt-in processes

	Message templates
	Template actions
	Configuring message templates

	Sending a split mailing
	Split dispatch in Smart Campaigns
	Split dispatch in Mailings Classic

	Send time optimization
	Why should you automate optimization?
	How it works
	Benefits
	Setting up time optimization
	Configuring send time optimization in the Wait node
	Configuring send time optimization in the A/B test node
	Analyzing mailing send times

	Validating mailing prior to dispatch
	Examples

	Sending automatic notification after dispatch
	Sending S/MIME-signed emails
	Setting up S/MIME certificates
	Importing S/MIME certificates
	Deleting S/MIME certificates

	Mailings Classic
	Mailing action buttons
	Information area
	Step 1. Name and description
	Step 2. Recipients and sender
	Step 3. Subject and content
	Step 4. Tracking
	Step 5. Test email
	Step 6. Sending options


	Managing content
	Editing mailing content
	Paragraphs
	Working with the rich text editor
	Changing view
	Action buttons
	Edit directly (HTML)

	Template Kit
	Designing a newsletter
	General settings
	Setting the pre-header
	Setting the header
	Setting the footer
	Grouping paragraphs
	Content paragraphs
	Standard layout example
	Alternate layout example
	Using a recipient list as a mapping reference
	Using a mapping file as a mapping reference
	Status variables
	Present variables
	Value variables
	Status variables
	Present variables
	Value variables
	Status variables
	Present Variables
	Value-Variables

	Field functions
	Adding a field function to a mailing
	Field function use cases
	Editing field functions
	Template engines
	ODR – Dynamic Rendering
	Velocity

	Coupon system
	Assigning coupon codes
	Tracking coupon codes sent in a mailing
	Inserting coupon codes in a mailing
	Testing emails
	Managing coupon blocks

	Countdown timers
	How it works
	Preparing graphics
	Creating a countdown timer
	Inserting a countdown timer into a message
	Editing, copying, and deleting a countdown timer
	Troubleshooting countdown timers

	Click2Go
	Activating Click2Go
	Inserting and designing buttons

	Easy Copy
	Mobile Fusion
	Checklist for a mobile version of your newsletter
	Adapting your template
	Flexible vs. fixed-width
	Optimizing newsletters for mobile devices

	Attachments
	Categories
	Adding an image
	Adding an attachment
	Sending personalized attachments

	Prefix or suffix subject line
	Uploading files
	Updating mailing content prior to dispatch
	Publish mailing
	Video emails
	Video email tips
	Tools for incorporating videos into emails
	Incorporating videos into a mailing


	Recipients
	Recipients overview
	Importing recipients
	Step 1: Start the process
	Step 2: Select a recipient list
	Step 3: Set the mapping
	Step 4. Set import type and import options
	Step 5: Import the data

	Trial import
	Step 1: Start the process
	Step 2: Select a recipient list
	Step 3: Set the mapping
	Step 4. Set import type and import options
	Step 5: Import the data

	Exporting recipients
	Cross-checking recipients
	Importing recipient list cross-checks
	Sending mailing cross-checks
	Cross-checking bounces
	Cross-checking blacklists
	Cross-checking unsubscribe lists

	Recipient lists
	Copying a recipient list
	Editing a recipient list
	Clearing a recipient list
	Displaying recipient list details
	Cleaning up recipient lists

	Target groups
	Managing target groups
	Creating a target group
	Copying a target group
	Editing a target group
	Using Visitor Intelligence segments as target group
	Defining a target group
	Analyzing a target group

	Opt-in
	Legal basis
	Opt-in method types
	Implementing the double opt-in method with Episerver Campaign
	Frequently asked questions about the double-opt-in method
	Best practices for permission-based email marketing
	Creating subscription and unsubscribe forms
	Send last mailing after double opt-in

	Unsubscribers
	Consequences of a mailing unsubscription
	How it works
	Querying a system-internal unsubscribe list
	Deleting unsubscribers from a recipient list
	Inserting an unsubscribe link into a mailing
	Changing the confirmation page URL
	FAQs

	Recipient history
	Showing message history
	Showing consent history
	Showing opening and click behavior
	Showing campaign analysis
	Showing Marketing Automation history
	Showing the third-party ID

	Exporting mailing and performance data
	Click profiles
	Creating and editing click profiles
	Assigning click profiles

	Responses
	Blacklist overview
	Adding a recipient to a blacklist
	Adding to a blacklist automatically
	Editing a blacklist entry
	Deleting a blacklist entry
	Using wildcards
	Importing blacklists
	Importing and exporting a blacklist
	Cleaning up blacklists
	Custom blacklists

	Changing email addresses
	Exporting recipients by category
	Importing recipients by category
	Preference Center
	Requested data
	Legal compliance
	Exchanging data
	Form fields
	Displaying error messages
	Design/templates tips
	Security tips


	Analytics
	Performance Dashboard (Beta)
	Widget features
	Edit mode

	Deep Analytics
	Benefits of Deep Analytics
	Creating a report template
	Executing a report
	Displaying and downloading a Deep Analytics report
	Opening a CSV file in Microsoft Excel
	Aggregating data with pivot tables

	Reports
	Executing reports
	Creating and editing report templates

	Live Analytics
	RFM analysis
	Live Analytics packages
	Creating a Live Analytics analysis
	Analyzing Live Analytics items
	Live Analytics detail view

	Deliverability preview
	Creating a deliverability preview
	Viewing a deliverability preview

	Post-click tracking integration
	Setting up the integration
	Working with post-click data

	Visual link analysis
	Visual link analysis of post-clicks
	Attention analysis
	What is attention analysis?
	The first impression counts
	Revolutionary testing
	Validity
	Analyzing a screenshot
	Analyzing an existing mailing or landing page
	Displaying a previously-generated analysis
	Interpreting results
	Optimizing options

	Activity overview
	Area 1: Select client
	Area 2: Select period
	Area 3: Filter mailings and campaigns
	Area 4: Open activity overview and other features


	Integration and interfaces
	Episerver Platform
	Episerver CMS
	Episerver Commerce
	Episerver Connect for Campaign
	Episerver Visitor Intelligence
	Episerver Email Product Recommendations and Triggered Messages

	E-commerce integrations
	Episerver Commerce
	Other e-commerce systems
	Magento 1 integration
	Magento 2 integration
	Spryker integration

	Web analytics integrations
	Web analysis systems
	Data generation
	Triggered campaigns
	Regular campaigns
	Adobe Analytics integration
	Google Analytics integration
	Google Tag Manager integration
	intelliAd integration

	CRM integrations
	CRM systems
	CRM integration guide
	Salesforce add-on
	Microsoft Dynamics CRM integration

	Translation interface
	How it works
	Setup
	Ordering translations

	Closed-loop interface
	Installation
	How it works
	Exchanging data
	Transferring recipient data
	Using personalization and recommendations
	Creating source mailings and sending mailings
	Troubleshooting data transfer
	Monitoring and sending status
	Specifying response data

	Transferring files through SCP
	Configuring SCP for macOS/OS X
	Configuring SCP for Windows

	Real-time export of event data via webhooks (Beta)
	Creating a webhook
	Activating a webhook
	Deactivating a webhook
	Deleting a webhook

	API overview
	Information in the API overview


	Service and support
	Customer support
	Full-service dispatch
	Needed information
	Lead time
	What Episerver does for you

	Trainings
	Individual trainings



